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Welcome
Welcome to the Metasys® system Help. This Help system contains user information for the Metasys software. This
section describes the organization of the Help system and offers tips for using it effectively. For information on using
Metasys software, start with the Site Management Portal User Interface section.

If you have configured the database and read this Help topic and still do not know where to start, see the Getting
Started section. See the System Overview section for a brief overview of system components that contain Help. For
other documentation related to the Metasys system, see the Related Documentation section.

Getting Started
What if you only need to use a few selected features of the Metasys system? Or, what if you’re not sure where to
start exploring the network?

Start here.

You probably want to see details about something on your network and maybe edit it or command it for optimum
network performance. The hours of operation for your building might change, and you may need to edit a schedule
or create exceptions for days when the schedule deviates from normal.

You might also need to create trends, alarms, or totalizations for something on your network. And, you may want to
create reports containing this data to check the history of your system. To select which items you would like to see
presented in the navigation tree, create a new user view.

For basic user information (moving through the items in the tree), see the Site Management Portal User Interface
section. For graphics information, see User Graphics Tool (UGT) and Graphics+ sections.

Related Documentation
Use the following table to find information available outside this Help system:

Table 1: Related Documentation
LIT or Part NumberSee DocumentFor More Information On
LIT-12011832Metasys System Configuration Guide

Note: This document replaces the Metasys
System Extended Architecture
Overview Technical Bulletin
(LIT-1201527)

Metasys System

LIT-1201612Metasys System Extended Architecture
Glossary Technical Bulletin

Metasys System Terms and Acronyms

LIT-12011742Launcher HelpHow to use the Metasys Launcher

LIT-1201578Network and IT Considerations for the IT
Professional Technical Bulletin

Network Information Including Internet Security
Risks

LIT-12011279Network and IT Guidance for the BAS
Professional Technical Bulletin

LIT-12011521ADS, ADX, and SCT Installation and Upgrade
Instructions Wizard1

Application and Data Server (ADS), Extended
Application and Data Server (ADX), and System
Configuration Tool (SCT) Installation andUpgrade

LIT-1201645ADS/ADX Commissioning GuideConfiguration of an ADS/ADXWithin theMetasys
System.

This document includes information on
configuration of an ADS/ADX Site Director,
repositories, time synchronization, printing, and
dial-up connections

LIT-1201645ADS/ADX Commissioning GuideHow to Set Up Time Management on the Metasys
System LIT-1201519NAE Commissioning Guide

LIT-1201645ADS/ADX Commissioning GuideHow to Configure the Split ADX
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Table 1: Related Documentation
LIT or Part NumberSee DocumentFor More Information On
Part No. 24-10067-1Metasys SystemExtended Architecture License

Information
License Information for the Metasys system

LIT-1201654Software License Activator Technical BulletinLicensing for the ADS/ADX, Export Utility, and
Advanced Graphics Application Software

LIT-12011527Export Utility Installation InstructionsInstallation of Export Utility Software

LIT-1209522Export Utility HelpUse of the Export Utility to Extract Historical Data
to Formats Such asMicrosoft® Excel and Access

LIT-12011525Advanced Graphics Application Installation
Instructions

Installation of the AdvancedGraphics Application
and SVG Viewer

LIT-12018502Advanced Graphics Application HelpConfiguration and Use of the AdvancedGraphics
Application to Create Graphics with Dynamic
Capabilities

LIT-12011685Graphic Generation Tool Installation
Instructions

Installation of the Graphic Generation Tool

LIT-120116972Graphic Generation Tool HelpConfiguration and Use of the Graphic Generation
Tool to Create Graphics+ Files

LIT-120117082Graphics+ Runtime HelpUse of Graphics+ Files at the Site Director

LIT-1201534SCT Technical BulletinUse of the SCT regarding offline archive
databases setup and basic setup of an N2
network online

LIT-1201528Security Administrator System Technical
Bulletin

How to Create and Edit Users and Roles,
Configure User Profiles, Assign System Access
Permissions, Assign All Items Navigation View
Permissions, and Unlock User Accounts

LIT-12011327Metasys for Validated Environments, Extended
Architecture Technical Bulletin

Metasys for Validated Environments (MVE),
Extended Architecture

Part No. 24-10051-0NAE55/NIE55 Installation InstructionsHow to Install the NAE55 and NIE55

Part No. 24-10050-6NAE35/NAE45 Installation InstructionsHow to Install the NAE35 and the NAE45

LIT-12011530NxE85 Installation InstructionsHow to Install the NxE85

LIT-12011568LCS85 Commissioning GuideHow to Commission the LCS85

LIT-1201519NAE Commissioning GuideHow to Set Up an Network Automation Engine
(NAE) for Network Connectivity, and How to Set
the Basic NAE Parameters, Including the Serial
Printer Dynamic Data Access (DDA)

LIT-12011044NxE85 Commissioning GuideHow to Set Up and Commission an NAE85/NIE85

LIT-12011524NAE/NIE Update Tool Technical BulletinHow to Install and Use the NAE/Network
Integration Engine (NIE) Update Tool

LIT-1201990NxE Information and Configuration Tool
Technical Bulletin

How to Install and Use the NAE Configuration
Tool

LIT-1201532NAE/NCE Protocol Implementation
Conformance Statement Technical Bulletin

NAE55 Compliancewith ANSI/ASHRAEStandard
135-2008, BACnet® Protocol

This document includes the Protocol
Implementation Conformance Statement (PICS)
and BACnet Interoperability Building Blocks
(BIBBs) for the NAE55.
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Table 1: Related Documentation
LIT or Part NumberSee DocumentFor More Information On
LIT-1201672NIE Series Protocol Implementation

Conformance Statement Technical Bulletin
NIE Compliance with ANSI/ASHRAE Standard
135-2008, BACnet Protocol.

This document includes the PICS and BIBBs for
the NIE.

LIT-12011528Metasys SystemExtendedArchitectureRemote
Access Installation Instructions

How to Install and Use the Metasys system
Extended Architecture Remote Access
Application for Dial-Up Connections

LIT-1201663Metasys SystemExtended Architecture Secure
Data Access DLL Technical Bulletin

How to Use Web Service Technology for Secure
Access to the Metasys System

LIT-1201535N1 Migration with NIE Technical BulletinThe Concepts and Procedures to Perform an N1
Migration with an NIE

LIT-1201683N2 Integration with the NAE Technical BulletinHow to Integrate an N2 Network in the Metasys
System with the NAE

LIT-1201531BACnet Controller Integration with NAE/NCE
Technical Bulletin

How to Set Up an NAE55 as a BACnet System
Integrator in a Metasys System Network

LIT-1201668LONWORKS Network Integration with NAE and
LCS Technical Bulletin

How to Set Up an NAE as a LONWORKS® Network
Integrator

LIT-12011288DLLR Technical BulletinThe Operation of and Setting upMetasys System
Demand Limiting and Load Rolling

LIT-120113122Metasys Advanced Reporting System HelpMetasys AdvancedReporting System andEnergy
Essentials

LIT-12011521ADS, ADX, and SCT Installation and Upgrade
Instructions Wizard1

How to Install the Metasys Advanced Reporting
System

LIT-12011539Energy Essentials Installation InstructionsHow to install Energy Essentials

LIT-1201645ADS/ADX Commissioning GuideHow to Configure the Metasys Advanced
Reporting System

LIT-1201645ADS/ADX Commissioning GuideHow to Configure Microsoft SQL Server Report
Services to Work with the Metasys Advanced
Reporting System

LIT-12011034MS/TPCommunications Bus Technical BulletinMaster-Slave/Token-Passing (MS/TP)
Communications and Field Controllers

1 Use the wizard to generate instructions specific to your system.
2 This LIT number represents a print-friendly version of the Help.

System Overview
The major components of the Metasys system are:

Engine: The term engine is used in the Metasys system to describe a family of devices, including the NAE, NIE,
and Network Control Engine (NCE):

• The NAE is a Web-enabled, Ethernet-based supervisory controller that monitors and supervises networks of
field-level building automation devices that typically control HVAC equipment; lighting; security; fire; and building
access. The NAE provides features including alarm and event management, trending, archiving, energy
management, scheduling, and password protection through its embedded Site Management Portal. Different
models and options support various communications protocols including BACnet over IP, BACnet MS/TP, N2
Bus, N2, and LONWORKS network devices. The NAE55 Series supports a comprehensive set of supervisory
features and functions for large facilities and technically advanced buildings and complexes. The NAE35 and
NAE45 Series extend the power of the NAE to the smaller buildings (or small areas of larger buildings) and
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enables the wider distribution of supervisory functions in larger facilities. The NAE85 supports large BACnet/IP
integrations.

• TheNCE combines the network supervisor capabilities and IP network connectivity of an NAE with the Input/Output
(I/O) point connectivity and direct digital control capabilities of a Metasys Field Equipment Controller (FEC). The
NCE provides a cost-effective solution designed for central plants and large built-up air handler applications. All
NCE models provide IP Ethernet network connectivity, the Site Management Portal, and the network supervisory
functions featured on network automation engines, including the BACnet IP integration. Depending on the model,
an NCE supports either a BACnet MS/TP trunk, an N2 Bus trunk, or a LONWORKS Network trunk.

• TheNIE is a Web-enabled supervisory controller for integration of Metasys N1 Networks. The NIE is a specialized
version of the NAE and is designed to provide for the migration of existing N1 networks into the Metasys system.
The NIE provides the same Site Management Portal as the NAE. Unlike the NAE, the NIE does not support
integration of BACnet MS/TP or BACnet IP, N2, and LONWORKS networks. Two models of the NIE are available.
The NIE55 supports smaller N1 networks, while the NIE85 supports large N1 integrations.

ADS/ADX (Server): The Application and Data Server is a software package that provides long-term storage of alarm
and event messages, trend data, and user transactions. The ADS/ADX typically coordinates multiple user access
from Web browsers to the network. The Extended Application and Data Server provides extended user access and
historical data storage capabilities. An ADS/ADX provides access to the user interface and may serve as the location
for user graphics.

The ADX can also be installed in a split configuration with the ADX software/user interface on one computer (the
Web/Application server computer) and the historical trend data on another computer (the Database server computer).

SCT: The System Configuration Tool assists in all phases of engineering, installing, and commissioning of devices
that make up the Metasys system. The SCT can be used offline to create archive databases that can be downloaded
to an Engine or Server. The SCT also allows you to upload and archive databases that were created or edited online
from an Engine or Server. Using the SCT, you can view and configure multiple sites in one archive.

Starting at Release 6.0, SCT allows you to maintain both 5.2 and 6.0 engines in the site's archive. The Site Director
for the archive has to be upgraded to 6.0, but all non-Site Director engines for the site can be left at 5.2 and can still
be modified offline in SCT and downloaded at Release 5.2. Within the site's archive, a mix of 5.2 and 6.0 engines
can be maintained.

The SCT has the same look and feel as the Engine and Server Site Management Portal. The SCT also provides a
Simulation feature, which allows you to simulate a functioning Engine and test the database’s control logic prior to
downloading it.

Metasys system configuration requires that you define a single device as the Site Director. The Site Director device
may be a network engine or server (ADS/ADX), and its primary role is to coordinate multiple user access from the
Web browser to the network. If an ADS/ADX exists in the system, it is defined as the Site Director automatically.
When communicating directly to Metasys system servers or network engines, you are in the online mode. For
information on the online, offline, and simulation modes of operation, see the modes section.

Printing the Help
Printing Specific Help Topics
To print a specific Help topic:

1. Click the Print button in the Help or click the Options button and select Print.

2. If the Contents tab is currently active, choose between printing the selected topic only or the selected heading
and all sub-topics. The content prints.

If another tab is active, select a printer and the Help prints the current content displayed on the right side.

Note: Information in drop-down lists prints only if you have the list open on the screen. Popup content does not
print in the popup window.

21Metasys System Online Help PDF



Printing the Entire Help System
The entire Help system is available for printing in Adobe® PDF format.

To print the entire Help system:

1. If necessary, download Adobe Reader (required to view the PDF file) from the Adobe Reader site.

2. Go to the QuickLIT Product Information Web site or insert the QuickLIT CD.
3. In the tree on the left, browse to Metasys System > General System Information.
4. On the right side of the window, click Metasys System Help. The Help PDF opens in Adobe Reader.
5. On the File menu of Adobe Reader, select Print.

Note: This file is large (approximately 700 pages). Allow plenty of time for downloading and printing.
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Site Management Portal User Interface
You can interact with the entire Metasys system from any location running a supported web browser. Microsoft
Internet Explorer Version 8.0 or 9.0 are recommended. Other browsers, such as Apple Safari, Mozilla Firefox, or
Google Chrome may also be used but are not fully supported. After you log on to the Metasys system, you are able
to perform the following operations:

Note: The term Site Management Portal (SMP) refers to the user interface of the online Metasys engines and
servers as well as the offline System Configuration Tool (SCT), unless otherwise indicated.

• navigate through the system
• create user views
• create summary definitions and tailored summaries
• manage events
• record and display trend data
• diagnose network and device communication problems
• monitor and command systems and points
• edit or modify items
• schedule activities
• create and view graphics
• create, simulate, and activate control system logic

For more information on the specific features of your Metasys system, see the features listed in the table of contents
in this Help file. For more information on menus, see Menus.

For information on the Ready Access Portal UI, refer to the Ready Access Portal Help (LIT-12011342).

Site Management Portal User Interface Concepts
Launcher
In previous versions of the Metasys system, the Site Management Portal (SMP) and the SCT required the installation
of a public Java Runtime Engine (JRE) on the local client computer. Starting at Release 6.0, the Metasys system
no longer relies on the public Java Runtime Engine (JRE). A user installs a new application called the Launcher,
which supports a private internal JRE that is not exposed to possible security risks.

The Launcher manages a list of all supervisory engines, ADS/ADX servers, and SCT computers at your facility. You
can also add the Ready Access Portal, Metasys Advanced Reporting System, and any web address to its managed
list of web sites. You can access any release of the Metasys system with the Launcher, but opening the SMP or
SCT UI at Release 5.2 or earlier requires the public JRE on the client computer.

To install the Launcher application:

1. Open your web browser and enter the URL for the Site Management Portal. Examples:

http://MAIN-ADX1/metasys

http://10.10.15.100/metasys

The Windows Launcher Download screen appears (Figure 1).
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Figure 1: Windows Launcher Download Screen

2. Click Download or Download locally if Internet access is unavailable or the Download option fails. The File
Download - Security Warning dialog box appears asking if you want to run or save the Launcher.msi file.

3. Click Run. The Launcher installation file is dowloaded to your computer.
4. After the 26 Mb file is downloaded, another Security Warning dialog box appears. Click Run to start the installation.

The Johnson Controls Launcher 1.0 Setup wizard appears.
5. Click Next and follow the steps in the Launcher Setup wizard to complete the installation. For details, refer to

the Launcher Installation Instructions (LIT-12011783).
6. After installation, close the web browser. By default, the Launcher screen appears after installation (Figure 2).
7. Refer to the Adding a New SMP or SCT Device Profile and Adding a New Other Profile sections of the Launcher

Help (LIT-12011742) for instructions on how to manage a list of all engines, ADS/X, SCT, Ready Access Portal,
Metasys Advanced Reporting System, or any generic Web site links that require a login.

Figure 2: Launcher
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Login
Note: We strongly advise that you do not access the Metasys Site Management Portal UI from a computer running

a server class operating system. By default, Windows Internet Explorer Enhanced Security Configuration is
enabled on server class operating systems and may block the Launcher download page from which you
install the Launcher application for access to the Site Management Portal. Open the Site Management Portal
UI from a computer that is not running a server class OS.

The Metasys system supports Active Directory® service and single sign-on (SSO). Therefore, when you launch the
device that is configured as the Site Director of the extended Metasys network, three possible login scenarios occur:

• If the Active Directory service feature is disabled, the Metasys login screen appears. Enter your Metasys user
name and password to gain access to the Metasys Site Management Portal (SMP) user interface.

• If the Active Directory service and SSO features are enabled and you are logged in to your Windows desktop
as an Active Directory service user with access to the Metasys system, the login screen does not appear and
you automatically have access to the Metasys SMP user interface.

• If the Active Directory service feature is enabled, but you are not logged in to your Windows desktop as an Active
Directory service user with access to the Metasys system (or if the Active Directory service feature is enabled
and SSO is disabled), the login screen appears. From that screen, you can access the Metasys system by
entering your Metasys user name and password, and by selecting Metasys Local from the Login To drop-down
menu; or by entering an Active Directory service user name and password, and by selecting the Active Directory
service domain from the Login To drop-down menu.

The first time you log on to the site or device, the Metasys Terms and Conditions appear. Scroll through and read
the entire Terms and Conditions text. If you agree with the terms, click Accept at the end of the text. If you do not
agree, click Cancel to return to the login screen.

A progress bar appears to show the status of the login.

Note: If the Site Director is not available, you may want to directly connect to an Engine device. In this scenario,
Active Directory service login is not supported (both automatic login and user name/password login), and
you must use a Metasys user name and password to connect. The security configuration for an Engine device
may be set up differently than in the Site Director.

Department of Defense Enhancements
During ADS/ADX installation, a US Department of Defense (DoD) Banner option is available. If the DoD Banner was
selected, a special log-in feature is enabled that satisfies the requirements for a mandated DoD Information Assurance
Certification and Accreditation Process (DIACAP). The DoD Banner option includes three enhancements:

• appearance of a custom Department of Defense banner before log in
• record of the last logged in user
• record of IP address for each valid and invalid user logon attempt

Department of Defense Banner
A custom DoD warning statement (Figure 3) appears each time you access the Site Management Portal.
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Figure 3: United States DoD Warning Statement

The statement contains information critical to any Metasys user accessing the BAS at a Department of Defense
facility. You must click OK to consent to the statement before reaching the login screen. The standard Metasys
system login screen appears after you click OK. If the Active Directory service and SSO features are enabled, Active
Directory logs you in without asking for the user name and password.

When the Metasys system login screen appears, you have up to 30 seconds to login. If 30 seconds passes with no
login activity, the login screen clears and the DoD banner screen returns. The banner also reappears after you log
off the Metasys system or the system logs you off because of user inactivity.

Last Login Information
With the DoD enhancements in place, the main screen of the SMP user interface indicates the last time and date
that the user successfully logged in (Figure 4). If the user has never logged in, Never appears in the Last Login field.

Note: This feature only applies if the Site Director is an ADS/ADX.
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Figure 4: Last Logged in User

Record of User Access with IP Address
With the DoD enhancements in place, the Audit Viewer in the Metasys software records each change that occurs
in the Metasys system. The User column in the Audit Viewer records the name of each user who logged in (authorized
user) or tried to log in (unauthorized user). The Post Value column records the IP address of the client computer
used to access the Metasys system. See Figure 5.

Figure 5: Users and IP Addresses Recorded by Audit Viewer
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Metasys Modes
Metasys software can operate in three different modes: online (Site Management Portal UI), offline using the SCT,
and Simulation (SCT). When you are connected to the Engine or ADS/ADX, you can perform online mode operational
activities such as monitoring and commanding. When you are connected to the SCT only, you can perform offline
mode system configuration tasks such as configuring point objects and features. The SCT has the ability to simulate
custom logic programs in the Logic Connector Tool (LCT) in Simulation mode.

Online Mode
When you are connected to the Engine or ADS/ADX, you can perform online operational activities such as monitoring
and commanding equipment. You can also perform online database configuration activities, such as defining field
controllers or adding points. This function is referred to as online mode or online Site Management Portal (SMP) UI.
The online mode is available to users with the Access Type of Standard Access or Basic Access. See the Access
Types section.

Any changes you make to the system configuration are made online to the system and need to be uploaded to be
stored in the archive database.

Offline Mode
SCT is a standalone software program installed on a PC, including the ADS/ADX server, that allows you to configure
the servers and network engines without being connected to the live Metasys system server and network engines;
this function is called the offline mode. In offline (system configuration) mode, use SCT to set up the system database.
You must load configuration changes created in offline mode to the Engine for the settings to take effect. See
Database Uploading, Downloading, Upgrading Device and Synchronization.

Two features are available only with SCT: ActionQ and Database Uploading, Downloading, Upgrading Device and
Synchronization. You can only add servers and network engines in offline mode. Simulation mode can be started
only using SCT.

The offline mode is available to users with the Access Type of Standard Access. See the Access Types section.

Simulation Mode
The SCT can simulate custom logic in the LCT. In Simulation mode, the LCT establishes a connection to a simulated
device and accesses simulated data. Simulation mode can only be started from offline mode. Simulation mode
allows you to experiment with the configuration and settings before you load it into the Engine. Simulation is not
available on the ADS/ADX.

The simulation mode is available to users with the Access Type of Standard Access. See the Access Types section.

See the Simulation section for more information.

Access Types
Metasys system administrators determine the type of access a user has to the Metasys system through user accounts
in the Security Administrator tool. There are three access types: Standard Access, Basic Access, and Tenant Access.

Standard Access
Standard Access allows the Metasys local system user or Active Directory service user to access all authorized
features of the online Site Management Portal (SMP) UI and the SCT.

Note: If you have Standard Access and the Advanced Reporting privilege, you can use the Metasys Advanced
Reporting System.

Basic Access
Basic Access provides users with access to a limited set of user interface capabilities based on their assigned
permissions. Basic Access allows the Metasys local system user or Active Directory service user to access only
authorized features of the online Site Management Portal (SMP) UI. Typically, a Basic Access user is not allowed
to make any configuration changes. Metasys system administrators can also assign the Basic Access type to Active
Directory service users who have been added to the Metasys system. Basic Access meets the user interface
requirements for most building operators.
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Tenant Access
Tenant Access allows the local user to access a single dashboard view as defined by a system administrator in the
Ready Access Portal UI.

Screen Layout and Frames
The screen contains four frames and provides a consistent look and feel in every mode (online, offline, or simulation).
Your access to certain features depends on the mode in which you are operating and your assigned access type
and privileges.

Note: If the navigation frame or a display frame is active, the header bar of the active frame or pane is highlighted.
The Menu and Status frames are not highlighted even when you click in them.

Figure 6: Basic Screen Layout
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Table 2: Site Management Portal (SMP)UI Screen Frames
DescriptionNameNumber
Displays the menu bar and the logged-in user name together with the previous time and date
that he logged in (in this case, MetasysSysAgent logged in on Thursday, March 22, 2012 at
11:13:22 CST). Active Directory service user names display as the fully qualified user name
(for example, user@engineering.jci.com).

For more information on menus, see Menus. Log out or exit from the system using buttons in
the menu frame.

Menu1

Presents data or information in the user-selected panel layout. In the example above, the Display
Frame contains two Display Panels. The top Display Panel shows information about the Site
Director named DoD ADX (the device is selected in the navigation tree and the name of the
device appears at the top of the Display Panel). The bottom Display Panel contains a Tailored
Summary called Engine Summaries associated with the Configuration and Diagnostics Display
Frame user navigation tree. See the section for more information on the Display Frame.

Display2

Displays navigation trees that organize items in the system. The All Items tree generates
automatically when you configure the system database. You can create one or several user
navigation trees (also referred to as user views) for defining your own navigation concept.

For more information on the navigation tree, see the Navigation Tree section.

Navigation3

Displays information about current user actions and the current time/time zone of the server
that you are logged into (supervisory device or Site Director). Status bar icons indicate system
status. In the screen above, the status bar indicates that all alarms are snoozed.

Status4

Navigation Tree
The navigation frame can display several navigation trees in online mode (Standard Access or Basic Access). The
All Items navigation tree is generated during system configuration and represents the network layout of your system.
You can add additional user-defined navigation trees (also referred to as user views) that provide navigation
capabilities for viewing particular parts of your system.

Note: The navigation trees that appear for a particular user, including the All Items tree, are defined by the system
administrator when the user's access permissions are created.

Navigation trees support standard browsing concepts such as the plus sign (+) for expanding items in the tree and
the minus sign (-) for collapsing or hiding items in the tree. The maximum number of items that you can nest under
an item in the All Items tree is 7. User-defined trees have no restrictions on the number of nested items.

To see more details on an item in the navigation tree, drag and drop the item or double-click the item in the navigation
tree. The navigation frame also supports scroll bars and both right-click and left-click options.

You can display User Views as either a set of tabs (default) or a drop-down list. This interface helps with large jobs
that have many User Views, as the tabs can occupy a large percentage of the viewable navigation screen area.
Configure the Default navigation display in the General Display Settings on the Display Settings Tab of the Metasys
Preferences.

Click the button to detach the navigation frame. You can minimize and maximize the navigation frame, but if you
click the X button, the frame is restored to its default position.

Items
The Metasys system uses the term item as a generic reference to an object or selection in the Navigation Tree.
Items in the All Items navigation tree include the site, devices, control systems (logic), graphics, objects, integrations,
schedules, files, trend studies, field points, user-defined navigation trees, and other system data. Each item can
have another item under it, and so on as the system hierarchy continues. Items have right-click pop-up menus that
provide commanding and viewing options. A symbol represents each item in the navigation tree, and status symbols
indicate the status of each item.
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Status Symbols
Status symbols show the status of items in the system on the user interface. For example, these status symbols
appear in the navigation tree, in a column on Summary views, and in a column on the Global Search Viewer’s Search
Results table. The following table shows examples of the status indicators and the mode in which they may appear.

Table 3: Status Indicators

Mode1,2StatusIndicator
Description

Indicator

OnlineAlarm: Item (or an item under this item in the tree) is in an alarm
state.

Red Exclamation Point

OnlineWarning: Item (or an item under this item in the tree) is in a warning
state.

Blue Exclamation Point

OnlineUnreliable Alarm: Item (or an item under this item in the tree) may
be in alarm which is in an unreliable state.

Note: The Unreliable Alarm icon appears when the alarm state
of the object is Unreliable, and only applies to objects that
have alarming defined through an alarm extension, intrinsic
alarming, or an event enrollment object. If the object’s
Reliability attribute causes its Status to be Unreliable, but
the object does not have alarming defined, its Alarm State
is Normal and the icon is not shown.

Red Exclamation Point
and Red Question Mark

OnlineOffline: Item is offline

Note: Field devices with the Disable Automatic Alarming attribute
set to True display a red X when they are offline. See the
appropriate object in the Object Help for details on this
attribute.

Note: When an Sensor/Actuator (SA) Bus device, for example,
an Input/Output Module (IOM) or sensor, goes offline, an
alarm is generated and the device is identified in the Site
Management Portal (SMP) UI by the red exclamation point
instead of the red X.

Red X

OnlineCommunications Error:Unable to read item status - error occurred
when attempting to retrieve the item’s current state

Blue X

OfflineItem has been edited since it was last loaded to the Engine.Green Arrow

Online

Offline

Local Site Director: Device is the Local Site Director.Blue Triangle

1 In Simulation mode, status indicators only appear in the Summary views in the display frame. The indicators do not appear in
the navigation tree in this mode.

2 Online mode includes both Standard Access and Basic Access types unless noted otherwise. If the items under an item have
different states, the parent item displays only the icon for the state of highest priority (of Unreliable Alarm, Alarm, and Warning
states). Unreliable Alarm is the highest priority, followed by Alarm and Warning.

User-Defined Navigation Trees
User-defined navigation trees (also referred to as user views, user navigation views, and user-defined trees) allow
you to organize items and folders for specific users or functions.

See the User Views section for details on user views.

Unlicensed Items Trees
An Unlicensed Items Tree appears and becomes the default tree if your Metasys system contains unlicensed
ADS/ADX software. If you license the software and refresh the tabs, the Unlicensed Items Tree disappears.
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Display Frame
The Display Frame can be divided into up to four display panels. When viewing an item in a display panel, the name,
status, and default attribute (usually the present value) of the item you display appear at the top of the display panel.
Each display panel can contain different tabs, depending on the item selected from the navigation tree, and each
tab shows different information. Dynamic attributes displayed in a panel automatically refresh when changes are
detected.

The default display panel is the first empty panel or last unlocked panel if all displayed panels are filled. Display
panels are locked while in Edit mode, or may be locked using the Lock button of the selected display panel. If all
available panels are locked, you cannot display an additional item in any of the display panels.

You can resize each display panel by dragging its borders, or using an available splitter bar. With some items, an
Edit button appears (except in Simulation mode), allowing you to edit the item’s configuration attributes. Editing in
online mode with Basic Access is limited to Schedules and Calendars, and no Edit button appears for any other
items.

You can drag and drop items into a display panel and navigate among them using the Back and Forward display
panel buttons. The display panel holds a maximum history of five items.

If you run any of the predefined reports found in the Query Menu, the result of the query appear in an available panel
in a spreadsheet format. Sort the report results by clicking on the column heading, and resize columns by dragging
column borders. When you scroll down through the column, the headers remain visible.

The data presented in a report comes from a snapshot of the system at the time you request the report. The displayed
data does not automatically refresh and does not support an Edit mode. You can manually refresh the report through
the Action Menu.

Display Frame Layout
The user interface allows you to define your own display frame layout. Six options are available:

Figure 7: Panel Layout Options

To change the way the panels are arranged, see Changing the Display Panel Layout. If you have a multi-panel
display and you change to a layout with fewer panels, the locked items/newest items in the view stay, depending
on how many panes are available in the new layout. The other panels close (they do not reappear if you switch back
to the multi-pane view).

To resize the panels, drag the borders of the panel until it reaches the desired size. To make one panel (in a
multi-panel arrangement) take up the entire Display frame temporarily, click the maximize button. To restore a
maximized panel in a multi-pane view, click the restore button. A panel can also be maximized/restored by double
clicking its header bar.

Display Panel Tabs
Each display panel contains tabs that vary depending on the item displayed.

For example, most of the point objects, such as the Outdoor Air Temperature (OAT) contain the following tabs:
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Table 4: Tabs
DescriptionTab
Becomes available when you define an Alarm Extension for a point. The New and Delete buttons allow you to
add or delete Alarm Extensions for the point. The Basic and Advanced radio buttons allow you to filter the
attribute display in this tab. The Edit button allows you to change configurable attributes.

Alarm

Becomes available when you define a point object. The Focus tab shows operation attributes available for the
object type to which the object belongs. Please note that the Basic and Advanced radio buttons allow you to
filter the attribute display in this tab. The Edit button allows you to change configurable attributes.

Focus

Becomes available when you define a point object that has a reference to a physical input or output. The
Hardware tab shows hardware-related attributes available for the object type to which the point object belongs.

Hardware

Becomes available when you define a BACnet instrinic alarm for a point. The Intrinsic Alarming Defined attribute
is explained in Trend Extension Attributes section. The BACnet Alarm tab shows BACnet Alarm-related attributes
available for the object type to which the point object belongs. The Basic and Advanced radio buttons allow you
to filter the attribute display in this tab. The Edit button allows you to change configurable attributes.

BACnet Alarm

Becomes available when you create a Totalizator Extension. New and Delete buttons allow you to add or delete
Totalization Extensions for the point. The Edit button allows you to change configurable attributes.

Totalization

Becomes available when you create a Trend Extension for a point object. New and Delete buttons allow you
to add or delete Trend Extensions for the point. The Chart view allows you to view data samples in a graphical
format and retrieve new trend data. The Table view of the Trend Extension allows you to view the trend’s data
samples in a table format. The Definition view of the Trend Extension allows you to view and edit the attributes
of the trend extension object.

Trend

Becomes available when you create an Averaging Extension for a point object. The New button allow you to
add Averaging Extensions for the point.

Averaging

Becomes available when you create a Load Extension for a point object. The New button allow you to add Load
Extensions for the point.

Load

Other items may contain fewer or more tabs. For example, the item representing the Engine/ADS/ADX contains the
following tabs:

• Focus
• Summary
• Diagnostic
• Communication
• Network
• Email
• Pager
• SNMP
• Alarm
• Trend
• Printer

For information on the tabs available in the system, see the Object and Feature Tabs section.

Display Panel Buttons
Table 5 shows the display panel buttons.
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Table 5: Display Panel Buttons
DescriptionButton
Allows you to edit attributes for the displayed item. The values you can edit vary depending on the
displayed item. Select the Save button to save your changes.

Note: This button does not appear in Simulation mode.

Note: This button does not appear if the user has Basic Access mode permission. It appears grayed
out if the user has Standard Access mode, but does not have Modify Items permission for the
object being viewed.

Note: The term edit refers to changing items using the Edit button. See the Editing Items section. The
term modify refers to changing items using the Modify menu item and the Modify dialog box. See
the Modify Dialog section.

Displays the content previously displayed in that panel. Each panel can have a display history of up to
5 items.

Displays the content of the next panel saved in the history.

Locks the selected display panel (prevents another item from being dropped in this panel and overwriting
it). A locked panel can be resized. This button toggles between locked and unlocked.

Maximizes the active panel to the full size of the Display Frame. You can also maximize the pane by
double clicking the header bar. The other panels reappear if you click the restore button.

Restores the panels to their original size and position. You can also restore the pane by double clicking
the header bar.

Closes just the currently displayed view in the display panel.

Closes all of the views in the display panel (including views stored in history).

Displays commonly used information about the displayed item.

Displays all the information the system contains pertaining to the displayed item.

Tailored Summaries
Tailored Summaries appear in the display frame, and allow you to view, command, and modify large quantities of
similar data in a tabular format. Tailored summaries are essentially summary views of Metasys system items. For
more information on this feature, see the Tailored Summaries section.

Alarms Window
The Alarms Window (also referred to as Metasys - Events or Alarm Bar) displays the newest, highest priority alarm
message. Only alarms defined in the Fault Ack Required and Normal Ack Required attributes of the alarm extension
or the BACnet alarm definitions are eligible to appear in the Alarms Window. In addition, only those alarms for which
you have the Manage Item Events category-based permission appear in the Alarms Window. The alarm message
includes the name of the item in alarm, the current status, date and time when the alarm occurred, alarm priority,
the present value of the item, and a description related to the alarm condition (if applicable). The color of the Alarms
Window is based on the Alarm’s Priority level and is configured on the Alarm Settings Tab of the Metasys Preferences.

The number of alarm messages that require acknowledgement appear above the View Item button. Use the Alarms
Window buttons to perform actions related to the displayed alarm message. For more information on alarms and
events, see Alarm and Event Management. When no alarm messages need acknowledgement (or all alarms are
snoozed), the Alarms Window disappears. No matter which mode the system is in, you can minimize the window,
but it automatically restores itself if a new alarm occurs.

In an Engine that is not the Site Director, acknowledged or discarded alarm and event messages do not appear
acknowledged or discarded in the ADS/ADX.
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To enable or disable the display of the Alarms Window, see Enabling or Disabling Alarm Pop-ups.

To have an audible sound notify users of changes occurring in the Alarms Window, select User Profile from the
Tools menu, check Enable Audible Alarm, and click OK. However, a user with administrator rights must use the
Security Administrator Tool to set this property for any Active Directory service users who were added to the Metasys
system. Make sure the Windows® operating system audio controls are not muted and the volume is loud enough
to hear. An audible alarm sounds as long as an alarm is detected (if alarms are not snoozed or at least one
unacknowledged alarm is pending for the logged-in user). The alarm sound interval (15 seconds by default) is
configurable from the Preferences dialog box.

The Alarms Window does not appear when you are using the SCT in offline (configuration) mode.

The current navigation view does not limit or affect the Alarm notification, only the user’s permissions for managing
item events can. Therefore, it is possible for a user to receive an alarm for an item that does not exist in the currently
displayed navigation view.

Alarms Window Buttons
The Alarms Window (also referred to as Metasys - Events or Alarm Bar) contains buttons to acknowledge, snooze,
view, and discard alarm messages.

Table 6: Alarms Window Buttons
DescriptionButton Text
Acknowledges events and stops the event from appearing on the Alarms Window.Ack

Sends the currently displayed alarm message away for 5 minutes, allowing any pending next highest
events to appear in the Alarms Window. After 5 minutes, the alarm appears in the Alarms Window again
(if it is the highest priority event). To change the amount of time the Alarms Window snoozes, see Engine
Device Object.

Snooze

Puts the entire Alarms Window to sleep for 5 minutes. For the next 5 minutes, the Alarms Window
disappears, even if high priority alarms or events occur. To change the amount of time the Alarms Window
snoozes, see Engine Device Object.

Snooze All

Shows the Focus tab of the object in alarm in the Display Frame.View Item

Displays the graphic associated with the alarm extension of the item in alarm in the available display
frame. This button is displayed only if a graphic has been defined for the object.

View Graphic

Deletes the alarm with acknowledgement.Discard

Minimizes the Alarms Window to the Windows task bar. If a new alarm occurs, the Alarms Window
appears again as the top window.

Minimize

For more information on alarm and event management, see the Alarm and Event Management section.

Status Bar Icons
Icons in the Status bar indicate system activity (Table 7).

Table 7: Status Bar Icons/Text
DescriptionIcon/Text
This icon appears if the Metasys software is sending or receiving view data to or from the ADS/ADX/Engine.

This icon appears when diagnostic information for the Metasys system user interface is available. If you click this
icon, the User Interface Diagnostics window appears.

This icon appears white if no events are currently in the AlarmsWindow. When this icon is flashing red, the Alarms
Window contains events. If you click the icon, the Alarms Window appears in front of the other windows. A dashed
box appears around this icon when the alarm pop-ups are disabled. If you click the icon, alarm pop-ups are
automatically re-enabled, and the Alarms Window appears if applicable.

The status bar of the Site Management Portal (SMP) UI displays the date, time, and time zone of the device to
which you are logged-in. Due to the time it takes to retrieve the time from the device, the status bar time may lag
slightly behind the device’s actual time. If the device reports an unsupported time zone, the SMP UI defaults to .

Time Zone/
Date/Time
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User Interface Diagnostics Window
The User Interface Diagnostics window reports conditions within the system that may affect the operation of the
user interface, but which require no immediate user acknowledgment or action. When the Metasys system logs a
diagnostic message to the UI Diagnostics window, it includes the time when the condition was detected. Diagnostic
messages are logged to the UI Diagnostics window for various reasons, including the following:

• An attempt to connect to a device on the Metasys network failed.
• The device you are logged into is temporarily busy and cannot provide updated data.
• The data provided by the device is in an invalid format such as non-XML.
• An unexpected event occurred in the user interface.

When the system detects any of the above conditions, a new diagnostic message appears at the bottom of the
message list. Whenever the UI Diagnostics window is open (even if cleared), an icon appears in the status bar.
When the user clicks on the UI Diagnostics icon, the UI Diagnostics window moves to the front of all other windows.
If the UI Diagnostics window is closed, it opens automatically when a new diagnostics message is logged. Click
Clear to clear the window contents without closing the window.

Click Close to close the window.

Viewing Item Data
Item data is the information associated with an item such as the attributes of an object. Access the information
associated with an item by viewing it in a display frame. See the Displaying Information About an Item section for
more information.

Reports
Use the predefined report feature to query a single Engine, multiple Engines, or the entire site (all Engines on the
site) for alarm, offline, disabled, and override conditions. To generate a report, select one or multiple Engines or the
site in the navigation tree and select the desired report from the Query Menu. The query executes for the selected
Engine or site. When you select multiple Engines or the site in the navigation tree, the report feature queries each
supervisory device and combines the results in one report.

Do not confuse these predefined reports (alarm, offline, disabled, and override) with the Scheduled Reports option
available in the Query menu. For information on scheduled reports, see theScheduled Reports section. For information
on the Global Search and Object List options, see the Global Search section.

The query results in a report in the display panel. The report shows the time the query was initiated, the report status,
and the report results. The stop button allows you to cancel a running query at any time. The Copy button allows
you to copy the report content to the clipboard. The figure below shows an example of an Offline Report. See the
Running Reports topic for information on how to run a query.
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Figure 8: Offline Report Screen

Table 8 describes the information provided by each report.

Table 8: Reports
DescriptionReport
Lists all items in alarm state in the selected site or devices.

For each item in alarm state, the report displays the item type icon, item name, item description, alarm
type, and the value of the item when it entered alarm state.

Alarm

Lists all items in offline state in the selected site or devices.

For each offline item, the report displays the item type icon, item name, and item description.

Offline

Lists all disabled items in the selected site or devices.

For each disabled item, the report displays the item type icon, item name, and item description.

Disabled
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Table 8: Reports
DescriptionReport
Lists all items currently overridden by the operator.

For each overridden item, the report displays the item type icon, item name, status, item description,
and the current value of the item. See the status column to determine whether an operator overridden
item should be released.

Operator Override

Lists all items currently overridden by the supervisory device.

For each overridden item, the report displays the item type icon, item name, status, item description,
and the current value of the item. See the status column to determine whether a supervisory overridden
item should be released.

SupervisoryOverride

Commands
Use commands to force an item to perform a specific action. For example, ON and OFF commands for a binary
output make a fan run or stop, and the Enable and Disable commands in the Trend extension start and stop the
collection of samples.

For information on which commands an item supports, see the appropriate topic in the Object Help.

For information on how to send a command to a single item, see Commanding an Item in the Commands Dialog
section.

For information on sending a command to multiple items, see Commanding Multiple Items (Global Command) in
the Commands Dialog section.

Pop-up Menus
Pop-up menus provide an efficient way to quickly access important item information. Pop-up menus are also referred
to as right-click menus. To access pop-up menus, right-click an item in the navigation tree. Content of the menu
depends on the type of selected item and your level of authorization. For example, point object pop-up menus usually
show the options View, Command, and Show Extensions. For Engines, pop-ups usually show View, Event Viewer,
Audit Viewer, Commands, Show Extensions, Alarm Report, Offline Report, Disabled Report, Operator Override
Report, Supervisory Override Report, and Remove from Site.

Timed Inactivity Logout
Timed logout automatically logs you out of the Metasys system after a predefined time of inactivity. The system
closes open databases, discards unsaved changes and view settings, and logs out the user. Users who logged in
with a Metasys user name, and users who were automatically logged in via Active Directory service see the login
screen at timed logout. If this system has the DoD Banner option installed, the DoD banner screen appears at timed
logout.

If an Active Directory service user wants to access the Metasys system again through automatic login, close the
login screen and navigate to the Metasys URL. Otherwise, you can enter your Active Directory service user name
and password and select your Active Directory service domain at the login screen to regain access to the Metasys
system. Use the Security Administrator System to set this and other security features.

When the DoD banner screen appears at timed logout, you must click OK to consent to the statement before returning
to the login screen. The login screen waits 30 seconds for you to enter your credentials. If 30 seconds pass with no
login activity, the login screen clears and the DoD banner screen returns.

Electronic Signatures and Annotations for MVE Only
MVE sites have settings in the Site Object for enabling annotation and electronic signature functionality. You can
set the MVE site to require only annotations, only electronic signatures, both annotations and signatures, or neither
annotations nor signatures. Non-MVE sites may optionally define and use annotations; however, electronic signatures
are specific to MVE sites.
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When enabled, electronic signatures challenge users whenever they attempt to make a change to the system. Before
the system performs the user’s request, they must supply a signature and state a reason for the change. The
mechanism the Metasys system uses for expressing that signature is a reauthentication challenge, in which users
must reenter the password they used to log onto the Metasys system using either their Metasys password or their
Active Directory service password. This process is recognized as an electronic signature.

In addition to collecting the electronic signature, the Metasys system may also require the user to enter or select an
annotation. Annotations are statements that further describe the change being requested. After the password is
verified and an annotation is selected, the user request is performed.

You can configure electronic signatures and annotations at the device and object levels. You cannot delete annotations
on an MVE site. For information on enabling these settings, see Configuring Annotation and Electronic Signature
Requirements in the Site Object in MVE. For additional information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Site Management Portal User Interface Steps
Changing the Display Panel Layout
To change the Display Panel layout, on the View menu, select Panel Layout and choose one of the six layouts.

Acknowledging, Snoozing, and Discarding Events
To acknowledge, snooze, and discard events, click the appropriate button on the Alarms Window (also referred to
as Metasys - Events or Alarm Bar).

Note: You also can view the item or associated graphic.

Note: You also may use the Event Viewer to view and take action on events. See Alarm and Event Management
for more information about the Alarm and Event feature.

Enabling or Disabling Alarm Pop-ups
The Alarms Window is also referred to as Metasys - Events or Alarm Bar.

To enable the alarm pop-ups feature of the Alarms Window, select the Enable Alarm Pop-Ups check box from the
View menu.

To disable the alarm pop-ups feature of the Alarms Window, remove the selection from the Enable Alarm Pop-Ups
check box from the View menu.

Note: You can perform this task only if you have permission to disable the alarm pop-ups feature.

Note: A dashed box appears around the alarm status bar icon, , when the alarm pop-ups are disabled. If
you click the icon, alarm pop-ups are automatically re-enabled, and the Alarms Window appears if applicable.

Note: By default, alarm pop-ups are enabled every time you log into the system.

Running Reports
You must be in online mode to run a report. Follow the steps in this procedure to run one of the predefined reports
(alarm, offline, disabled, operator override, and supervisory override). To schedule a report on an ADS/ADX, see
Creating a New Scheduled Report in the Scheduled Reports section.

To run a report:

1. Select the single supervisory device (Engine or ADS/ADX), multiple supervisory devices, or the entire site in the
navigation tree that you want to query.

2. From the menu bar, click Query and select the type of report you want to run (Alarm Report, Offline Report,
Disabled Report, Operator Override Report, or Supervisory Override Report). The Report Viewer appears in the
default display panel.

Note: If you did not select a supervisory device or site, a message box appears. Click OK, select a supervisory
device or site, and repeat Step 2.

3. View the results of the report.
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Printing
1. Select the Navigation Tree or display panel you wish to print.

Note: You must select either the navigation tree or a display panel to enable Print. If you selected a display
panel, the entire contents of the visible display panel prints out. If you selected the navigation tree, all
visible parts of the tree print out (even parts of the tree that you need to scroll to view). Collapsed parts
of the tree (not visible in the tree) do not print. You cannot print the contents of the Alarms Window.

2. Select Page Setup from the Item Menu if you wish to change the paper, orientation, or margin size. Click OK
when done.

3. Select Print Preview from the Item Menu to see what the printout looks like. Click Print or click OK and go on to
Step 4.

4. On the Item Menu, select Print.

Note: If the panel you selected is not printable, Print is disabled.

Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE
For sites with MVE installed, configure the following attributes in the Site object for MVE annotations and electronic
signatures:

• Annotation Include
• Annotation Exclude
• Annotation Alarm Priority Threshold
• Signature Include
• Signature Exclude
• Signature Alarm Priority Threshold

These settings appear only on MVE sites. See the Site Object section for details on these attributes.

You can require annotations, electronic signatures, both, or neither on an MVE site. Non-MVE sites may optionally
define and use annotations; however, electronic signatures are specific to MVE sites. For information on annotation
and electronic signature preferences, see Annotation Settings Tab and Electronic Signature Settings Tab in the
Preferences section. Also see Audit Message Annotations in Audit Trails for information on the fields in an annotation.

For additional information, refer to theMetasys for Validated Environments, Extended Architecture Technical Bulletin
(LIT-12011327).

Working with Items
In addition to the procedures in this section, see also Creating items and Exiting.

Navigating to an Item
To navigate to and select an item, click the plus (+) and minus (-) signs in the Navigation Tree to expand and collapse
folders until the desired item appears on the tree.

Note: Use the Ctrl or Shift key to select multiple items.

Note: For information about how to display information about the item, see the Displaying Information About an
Item section.

Displaying Information About an Item
To display information about an item you selected in the navigation tree:

Do one of the following and click the desired tab:

• Drag and drop the item from the navigation tree into a display panel.
• Select an item in the navigation tree, open the View Menu and click Selected Item. The data displays in the

default display frame.
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• Double-click the item in the navigation tree; it displays in the default display panel.
• Right-click an item in the navigation tree or a feature in the display panel (such as Global Search or a Tailored

Summary) and select View.

Note: When you display information in a panel that already contains data, the older data is replaced and added to
the panel history. To access up to five previously displayed items in the panel history, click the back button
in the display panel.

Note: If all available panels are locked and you try to display information about an item, a message appears stating
that all panels are locked. Click OK and unlock a panel to display other item information.

Editing Items
Note: To edit items in the User Graphics Tool (UGT), see User Graphics Tool (UGT).

Note: In online mode with Basic Access, you can edit only the Schedule and Calendar objects.

Note: The term edit refers to changing items using the Edit button as described in this procedure. The term modify
refers to changing items using the Modify menu item and the Modify dialog box. See theModify Dialog section.

To edit the attributes of an item:

1. View the details of the item in a display panel.
2. Select the desired item tab (for example, Focus).

Note: Some items contain an Advanced radio button. If you select this button, additional attributes appear.
3. Click Edit.
4. Edit the attributes as needed.

Note: If you place your cursor over an edit field, the ToolTip provides information about the valid format or range
for that value. ToolTips also appear for strings.

5. Click Save.

For information on using the Modify dialog box to modify single or multiple items, see the Modify Dialog section.

Commanding Items
Note: You must be in online mode to issue commands to items.

To send a command to an item in a graphic, see the User Graphics Tool (UGT) section.

To send a command to a single item, see Commanding an Item in the Commands Dialog section.

To send a command to multiple items, see Commanding Multiple Items (Global Command) in the Commands Dialog
section.

Annotating Objects/Items
Note: In online mode with Basic Access, you cannot add an annotation to an object or item.

This feature allows you to enter follow-up comments for actions taken on this object or item, such as what the user
did to fix a problem, what was fixed, or when an override was released.

To annotate objects/items:

1. Select the object/item to annotate in the navigation tree (All Items or User View).

Note: You cannot add an annotation for a folder.
2. On the Action menu, select Add Annotation.
3. Select or type annotation text. Annotation text can be from 1 to 255 characters.

Note: The Predefined Annotations List on the Add Annotation dialog box contains annotations saved in your
system preferences. If you have not defined annotations in your system preferences, the drop-down list
is empty.

4. Click OK to save the annotation.
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See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE.

Viewing Annotations for Objects/Items
To view annotations for objects/items:

1. Select the object/item to view in the navigation tree (All Items or User View).

Note: Folders cannot have annotations.
2. On the Action menu, select View Annotations.

See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE.

Deleting Objects/Items
Note: In online mode with Basic Access, you can delete only Schedule and Calendar objects.

To delete objects/items:

1. Select the object/item you want to delete in the All Items navigation tree. This option is not available in user
views.

2. On the Edit menu, select Delete Items.

Note: You cannot select an object/item in the display frame and delete it from the system. You can only delete
objects/items by selecting them in the navigation tree.

Note: After deleting objects/items in the online mode, perform an upload to store the updated system configuration
in the archive. After deleting objects/items in offline mode using the SCT, perform a download to update
the online configuration of the device.

Note: For information on removing offline devices from the Site Director device list, see theAction Menu,Remove
From Site section.

Logging Out
Save changes before logging out. Logging out closes all open windows (except the login screen and Help) associated
with the session, including the Alarms Window. If your system is configured with a timed logout, the system times
out after a specific period of inactivity. For more information on exiting, see Exiting.

To log out, click the Logout button in the menu bar.

If you are an Active Directory service user who accessed the Metasys system via automatic login and want to access
the Metasys system again in the same manner, close the login screen and navigate to the Metasys URL. Otherwise,
you can enter your Active Directory service user name and password and select your Active Directory service domain
at the login screen to regain access to the Metasys system.

Note: If you are currently editing an object/item in a display panel, the Metasys software aborts the logout process
and displays a dialog box notifying you that you cannot exit or log out while in Edit mode. You must exit Edit
mode by saving or cancelling your changes before you can log out of the application.

Exiting
Save changes before exiting. Exiting closes all open windows (except the Help) associated with the session, including
the Alarms Window, and login screen. For more information on logging out, see the Logging Out topic.

To exit, click the Exit button in the menu bar.

Note: If you are currently editing an object/item in a display panel, the Metasys software aborts the exit process
and displays a dialog box notifying you that you cannot exit or log out while in Edit mode. You must exit Edit
mode by saving or cancelling your changes before you can exit the application.
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Preferences
The Metasys system provides customized preferences for the UI. The preferences allow you to configure how the
UI behaves, including the sounds and colors, the startup views, alarm priorities, and the ability to add links to external
applications that can be accessed from within the UI.

Some of the preferences defined in the Metasys Preferences dialog box also apply to the Ready Access Portal UI.
The Metasys Preferences Dialog Box section calls out such preferences.

Note: Preferences do not persist after an upgrade unless you take manual steps to save the settings before you
begin a system upgrade. Refer to the ADS/ADX Commissioning Guide (LIT-1201645) or the NAE
Commissioning Guide (LIT-1201519) for details.

Preferences Concepts
System and User Preferences
Preferences are divided into two categories: system preferences and user preferences.

System Preferences
System preferences apply to all users who log in to the site or device. System preferences affect the performance
and operation of the system and require authorization to configure. Changes to the audible alarm notification is an
example of a system preference.

Only the users defined in the Users Authorized to Edit System Preferences section are authorized to configure
system preferences.

To synchronize system preferences within a site or to reuse the system preferences on another site, refer to the
Configuring and Managing Preferences appendix of the NAE Commissioning Guide (LIT-1201519) or ADS/ADX
Commissioning Guide (LIT-1201645).

User Preferences
User preferences apply to a specific Metasys system user. User preferences define how the information is displayed
in the UI, and do not affect the operation for other users of the system. The colors and marker styles of a trend
display are examples of user preferences.

To synchronize user preferences within a site or to reuse the user preferences on another site, refer to theConfiguring
and Managing Preferences appendix of the NAE Commissioning Guide (LIT-1201519) or ADS/ADX Commissioning
Guide (LIT-1201645).

Users Authorized to Edit System Preferences
Any user whose account is assigned to the Administrator role is authorized to configure system preferences.

Metasys Preferences Dialog Box
The Metasys Preferences dialog box is accessed through the Tools menu (Configure Preferences) and allows you
to configure system and user preferences. Users authorized to edit system preferences can edit all preference fields
using the Metasys Preferences dialog box. See Users Authorized to Edit System Preferences. Unauthorized users
can edit only user preferences.

Some of the preferences defined in the Metasys Preferences dialog box also apply to the Ready Access Portal UI.
The following table calls out the tabs with such preferences. See the specific tab section for details.

Click the tab name in the table for a description of the Metasys Preferences tabs. For more information on the modes
of operation, see Metasys Modes. The Authorization Required column means you must be authorized to edit some
or all of the preferences located on that tab.

43Metasys System Online Help PDF



Table 9: Metasys Preferences Dialog Box Tabs
Authorization
Required

Applies to
Ready
Access
Portal UI

Mode Visible InTab

Simulation1Offline SCTOnline
(Basic
Access)

Online
(Standard
Access)

XXXInformation Tab

XXXXAlarm Settings Tab

XXTrend Settings Tab

XXXXXGraphic Settings Tab

XXX2XXDisplay Settings Tab

XXXApplications Tab

XXElectronic Signature
Settings Tab3

XXAnnotation Settings Tab

1 Simulation mode uses the default preferences. Preferences are not configurable in Simulation mode.
2 Only settings that apply to the SCT are available.
3 This tab appears only for MVE installations.

Information Tab
The Information tab displays messages regarding the current state of the preferences. This tab does not contain
configurable preferences.

Alarm Settings Tab
The Alarm Settings tab allows you to configure up to 10 alarm priority groups, each with a unique sound and a unique
color. The groups are based on the priority of the alarm. The Alarm Settings tab also allows you to specify the alarm
sound interval. The alarm settings are system settings and therefore can be edited only by Users Authorized to Edit
System Preferences.

These alarm settings apply to the Site Management Portal UI (online mode). The alarm color preferences also apply
to the Ready Access Portal UI.

The alarm sound files can be Audio (.au) or Wave (.wav) files.

Alarm sound files must be placed manually into the audio folder. Refer to the Configuring and Managing Preferences
appendix of the NAE Commissioning Guide (LIT-1201519) or ADS/ADX Commissioning Guide (LIT-1201645) for
details. The Metasys system validates that the audio file exists on the device and is in a supported format. If the
audio file does not exist or is not a supported format, the UI marks the audio file red. If the specified sound file for a
particular range of alarm priorities is missing, the UI uses the default system beep for those alarm priorities. The UI
uses the specified sound files for other alarm priorities if their sound files exist.

The Alarm Settings tab controls the sounds made by the Metasys system when an alarm is received; however, the
sound settings of the client computer control the volume of the audible alarms.

Note: The client computer can only play sound files if a sound card is installed on it. If the UI does not detect an
installed sound card, it uses the default system beep, regardless of whether sound files are specified and
available.

Note: To hear alarm notifications, you must also have Enable Audio Alarm selected in your User Profile.

The following table describes the attributes of the Alarm Settings tab.
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Table 10: Alarm Settings Tab
DescriptionField Name
Sets the audible alarm beeping time delay in seconds.Alarm Sound Interval

Specifies whether the system uses sound files with the four level alarming feature or the system
uses the default system beep.

Use Default System Beep

When true, the event viewer displays the event with a background color that is a slightly translucent
version of the color specified for the priority level. The color that appears in the Alarm window is
not affected by this field.

Event viewer uses
translucent colors

Allows you to add and define up to 10 total priority levels.Insert Button1

Allows you to remove priority levels.Delete Button

Indicates the range of priorities of each priority level. The number of priorities is adjustable, but
in each case, the first priority begins at 0 and the next range begins one number higher than where
the previous range stopped, up to 255.

For example, the following describes the priority ranges if you had 4 priority levels:
• The Level 1 range starts at priority 0 and ends at the number configured here.

The default Level 1 range is 0–39.
• The Level 2 range starts at priority Level 1 + 1 (39 + 1 = 40) and ends at the number configured

here.
The default Level 2 range is 40–79.

• The Level 3 range starts at priority Level 2 + 1 (79 + 1 = 80) and ends at the number configured
here.
The default Level 3 range is 80–139.

• The Level 4 range starts at priority Level 3 + 1 (139 + 1 = 140) and ends at the number
configured here.
The default Level 4 range is 140–255.

Priority

Indicates the sound file that plays for each priority level when an alarm comes in. The default files
for levels 1 through 4 are alarm1.wav, alarm2.wav, alarm3.wav, and alarm4.wav, respectively.

Audio File1,2

Allows you to customize the background color and text color for each priority level. The color you
specify here appears in the alarms window and in the event viewer.

Color

1 If you click the Insert button, you can add priority levels. In this case, you can have more than four priority levels.
2 The sound files on a device are only used by the UI when you are directly logged in to that device. If a sound file is missing

from the device, the Metasys system uses the default system beep in its place.

Trend Settings Tab
The Trend Settings tab allows you to configure the number of trends to display, the number of samples to display,
and other trending chart options. The following table describes the attributes of the Trend Settings tab.

Table 11: Trend Settings Tab
DescriptionField Name
Indicates the maximum number of new and historical trend samples shown in a Trend Display or Trend
Study. This attribute allows you to reduce the amount of memory used by the UI for each trend. The
range is 100–6,000. The default value is 6,000.

Maximum samples to
display

Indicates the initial number of trends that are marked Visible within the Trend Viewer or Trend Study.
The range is from 1 to the value of the Maximum number of visible trends attribute. The default value
is 6.

Number of initial
visible trends

Indicates the maximum number of trends that can be marked Visible within the Trend Viewer or Trend
Study. The range is from 1 to 10. The default value is 10.

Maximum number of
visible trends

Indicates the default background color of trend charts. The default color is light gray.

Click to access the Select a Color dialog box. The Select a Color dialog box allows you to select
a custom color from three color palettes and to preview the color for the attribute.

Default chart
background color
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Table 11: Trend Settings Tab
DescriptionField Name
Indicates the default color of the grid lines of trend charts. The default color is white.

Click to access the Select a Color dialog box. The Select a Color dialog box allows you to select
a custom color from three color palettes and to preview the color for the attribute.

Default chart grid
color

Allows you to select what type of gridlines appear on the chart. You can choose: None, X and Y, X
Only, and Y Only. The default value is None.

Default line style

Indicates whether the trend legend is collapsed when the Trend Viewer or a Trend Study is initially
opened. This attribute allows you to maximize screen space for viewing trend charts. The default value
is False.

Legend initially
collapsed

Indicates the line on the chart to which the settings apply.Line

Allows you to customize the color of the line.

Click to access the Select a Color dialog box. The Select a Color dialog box allows you to select
a custom color from three color palettes and to preview the color for the attribute.

Line Color

Opens a drop-down menu and allows you to select a marker type for the line.Line Marker

Graphic Settings Tab
The Graphic Settings tab allows you to configure the status colors, fan colors, and state colors that appear in standard
and dynamic graphics, along with alarm flashing settings. These settings apply to the Site Management Portal UI
(online mode), SCT, and the Ready Access Portal UI. The status color settings may also be used by summaries or
other views (Tailored Summaries, for example), to provide a consistent indication of an object’s status.

The following table describes the attributes of the Graphic Settings tab.

Table 12: Graphic Settings Tab
DescriptionField Names/Attribute
Click this button to access the Select a Color dialog box. The Select a Color dialog box allows you
to select a custom color from three color palettes and to preview the color for the attribute.

The Status Colors apply to value boxes, cells in Tailored Summaries, basic shapes (circle, triangle,
and square), and the Room Status symbol used in floor plan based graphics. See the Analog Alarm
Extension for details on how these states are calculated.

Status Colors

Specifies the color used to indicate a status of Normal. The default color is white: RGB(255,255,255).Normal

Specifies the color used to indicate a status of Out of Service. The default color is light brown:
RGB(153,79,12).

Out of Service

Specifies the color used to indicate a status of Overridden. The default color is orange:
RGB(255,142,25).

Overridden

Specifies the color used to indicate a status of Trouble, Low Warning, High Warning, or
Sensor/Actuator Bus (SAB) Device Warning. The default color is yellow: RGB(255,255,0).

Trouble/Warning

Specifies the color used to indicate a status of Offline. The default color is black: RGB(0,0,0).Offline

Specifies the color used to indicate a status of an inaccessible value (for example, communications
failed). The default color is gray: RGB(190,190,190).

Value Inaccessible

Specifies the color used to indicate a status of High Alarm, Low Alarm, Alarm, or SAB Device Alarm.
The default color is red: RGB(255,0,0).

Alarm

Specifies the color used to indicate a status of Above Setpoint. The default color is pink:
RGB(191,0,95).

Above Setpoint

Specifies the color used to indicate a status of Below Setpoint. The default color is blue: RGB(0,0,255).Below Setpoint

Specifies the color used to indicate an Unoccupied status. The default color is dark gray:
RGB(150,150,150).

Unoccupied
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Table 12: Graphic Settings Tab
DescriptionField Names/Attribute
The Fan Status colors allow you to customize the fan status color of the attribute that appears in
system graphics. The Fan Status colors apply only to fans.

Fan Status

Defines the background color used for a fan symbol when its bound object’s value indicates the fan
is stopped.

Stopped is defined as State 0 (for binary/multistate objects) or as zero (for analog objects).

The default color is red: RGB(255,0,0).

Stopped

Defines the background color used for a fan symbol when its bound object’s value indicates the fan
is running.

Running is defined as State 1+ (for binary/multistate objects) or as non-zero (for analog objects).

The default color is green: RGB(0,153,51).

Running

The Default State Colors settings allow you to customize the default state color of the attribute that
appears in system graphics. The Default State Colors apply to basic shapes (circle, triangle, square)
that are bound to a binary/multistate object. These default state colors can be changed for each
shape after it is added to a graphic.

Default State Colors

Specifies the color used for the State 0 setting of a dynamic graphic symbol. The default color is
white: RGB(255,255,255).

State 0

Specifies the color used for the State 1 setting of a dynamic graphic symbol. The default color is
green: RGB(0,153,51).

State 1

Specifies the color used for the State 2 setting of a dynamic graphic symbol. The default color is
red: RGB(255,0,0).

State 2

Specifies the color used for the State 3 setting of a dynamic graphic symbol. The default color is
blue: RGB(0,0,255).

State 3

Specifies the color used for the All Other States setting of a dynamic graphic symbol. The default
color is light gray: RGB(204,204,204).

All Other States

The Simple Symbol Flash settings allow you to customize simple UGT shapes (such as circles and
squares) to flash when their bound object is in alarm.

Simple Symbol Flash
Settings

Defines the type of flashing applied to basic shape symbols:

• Disabled (No Flashing)
• State Color/Alarm Color (Flashes between the State Color and Alarm Color)
• State Color/Alternate Color (Flashes between the State Color and Alternate Color)

The default value is 0: Disabled (No Flashing).

Flash Type

Defines the color used when flashing between the current color and an alternate flash color. The
default color is white: RGB(255,255,255).

Alternate Flash Color

Defines the flash rate for graphics symbol flashing. The range is from 100 to 1,000 ms. The default
value is 250 ms.

Flash Rate

Display Settings Tab
The Display Settings tab allows you to configure other properties related to the UI display. These settings apply to
the Site Management Portal UI (online mode) and the SCT. In addition, the New entry timeframe setting applies to
the Ready Access Portal UI.

The following table describes the attributes of the Display Settings tab.
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Table 13: Display Settings Tab
DescriptionField Name

View Settings

Specifies how often (in minutes) the local time is synchronized with the server time. The range is 5–60
minutes. The default value is 30 minutes.

Server time
synchronization
interval

Indicates whether the Command window hides the unauthorized commands for the logged in user.
The default value is False, in which case the unauthorized commands are grayed out.

Hide unauthorized
commands

Indicates the amount of time audits/events are considered new (based on their time of occurrence in
the Metasys system). The default value is 15 minutes. New audits/events are marked with a blue star
in the Event Viewer and Audit Viewer.

New entry timeframe

Indicates the maximum number of rows displayed in the Global Search results view if the Site Director
is an NAE. The range is 10–500 and the default value is 100.

In the Site Director is an ADS/ADX, the range is 10–2,000 and the default value of 1,000.

Note: Increasing the number of results in global search may have a negative impact on performance.

Maximum results in
global search

Print Settings

Specifies the default paper size (Letter or A4) to be used for printing. The default value is Letter.Default paper size

General Display Settings

Indicates whether the Advanced View is the default view when opening an item in the display panel
or a wizard. The default value is False.

If the user is not authorized to access the Advanced View, the Advanced View is not shown.

Default to Advanced
View

Indicates whether extended labels are displayed in the navigation tree on login. The default value is
False.

Extended Labels
enabled on Login

Specifies which types of commands are shown by default when the Command window opens. The
options are All Commands (default), Primary Commands, Secondary Commands, and Alarming
Commands.
Note: We recommend using Primary Commands as the default command set to reduce errors by

lower level operators.

Default command set

Indicates the initial display mode shown in the scheduling feature:
• Today’s Schedule (default)
• Weekly Schedule
• Exception Schedule
• Scheduled Items

Default schedule
display

Specifies the User View navigation display as either a set of tabs (Tabbed) or a drop-down list (List).
The default is Tabbed.

Note: List is recommended if the system has many user views, as this takes up less space in the
navigation tree pane.

Default navigation
display

Specifies that upon login, the navigation tree collapses to the left (True or False). The default is False.Collapse navigation
frame on login
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Table 13: Display Settings Tab
DescriptionField Name
Specifies the Display Frame Layout that is displayed at login. The default panel layout is Single Panel.Default display panel

layout

Defines up to four startup views, which are automatically displayed at login. The number of views that
can be displayed is based on the Default display panel layout.

Note: Aliased graphics do not display properly if selected as a startup item. Specify the main graphic
instead.

Click to access the Select Item dialog box. Select the item you want to appear in the panel upon
login and click OK.

Note: Login time is increased when startup views are specified.

Startup item 1–4

Applications Tab
The Applications tab allows you to specify links to external applications, such as a spreadsheet or Microsoft Word
document, that can be launched from the Tools menu or from within graphics. The following table describes the
attributes of the Applications tab.

Table 14: Applications Tab
DescriptionField Name
Allows you to add a new external application that can be accessed from within the Site Management Portal
(SMP) UI. Once you click Add, the lower pane allows you to enter application information. If you are
authorized to change system preferences, an Add Application dialog box appears first and allows you to
specify whether the application is to be a system or user preference.

Note: If you are not authorized to change system preferences, the application is automatically added as
a user preference.

For more information, see System and User Preferences.

Add button

Removes the selected application from the list.Remove button

Enter the name of the application as you want it to appear on the Tools menu or within graphics.Application Name

Enter the full path of the application, including the command line arguments. The path is based on the local
file system (where you are browsing from), not on the path of the device you are logged in to. The application
path can also use any mapped network drives.

Click to access a Browse dialog box and select the application and path.

To launch a specific file, select the path to the application that opens the file, followed by a space and the
path to the specific file in quotation marks. Use the following format:

C:\Application Path\Application.exe “C:\filename path\filename.extension”

For example, to launch a Microsoft Word document named Worksheet_01:

C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE "C:\Documents and
Settings\username\Desktop\Worksheet_01.doc"

Note: The Application you add is specific to the computer you are using when you add it. The application
may not launch from a different computer unless the application exists on that computer in the
same location.

Application Path

Indicates whether the application appears on the Tools menu in the SMP UI. Select True (default) to have
the application appear on the Tools menu. Select False if you do not want it to appear on the Tools menu.
See Tools Menu.
Note: You must log off the SMP UI and then log back on for new items to appear in the Tools menu.

Tools Menu
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Table 14: Applications Tab
DescriptionField Name
Indicates whether the application can be hyperlinked to and launched by a button in a standard graphic.
The application name you specify appears on the Hyperlink Information Application drop-down menu for
buttons in graphics. See Buttons. Select True to enable this functionality. Select False (default) if you do
not want the application to be available for graphics.

Note: This hyperlink capability is supported in the Graphics+ as well as the User Graphics Tool (UGT).

Graphics

Allows the application to be launched from a navigation key.

For example, if you add the Calculator to the Tools menu and specify the letter C as the mnemonic, you
can access the Calculator in the following way:

From the SMP UI, press Alt+T to access the Tools menu. Press C to highlight Change Password. Press
C again to highlight the Calculator application. Press Enter to start the Calculator application.

Mnemonic

Specifies whether the application is available for the system or the user. This is specified when you first
click Add to add a new application to the list. Once specified, this attribute cannot be changed.

Type

Electronic Signature Settings Tab
The Electronic Signature Settings tab appears only for MVE installations. This tab allows you to define reasons for
electronic signature requirements.

MVE sites have settings in the Site Object for enabling annotation and electronic signature functionality. You can
set the MVE site to require only annotations, only electronic signatures, both annotations and signatures, or neither
annotations nor signatures. Non-MVE sites may optionally define and use annotations; however, electronic signatures
are specific to MVE sites.

You can configure electronic signatures at the device and object levels. Table 15 describes the attributes of the
Electronic Signature Settings tab.

Table 15: Electronic Signature Settings Tab
DescriptionField Name
Enter a new reason for electronic signature requirement, to be added to the list of predefined reasons.
The text can be from 1 to 255 characters in length. Click Add to save the new reason.

Predefined reasons are Approval, Author, Required, Cause, and Operator Action. These reasons can be
edited or deleted.

Reason Text

Displays the list of predefined reasons. Select a reason and click Delete to remove the reason from the
list. The Move Up and Move Down buttons allow you to reorder the list.

Predefined Reason
List

For additional information, refer to theMetasys for Validated Environments, Extended Architecture Technical Bulletin
(LIT-12011327).

Annotation Settings Tab
The Annotations Settings tab allows you to define customized annotations to select when acknowledging and
discarding events.

MVE sites have settings in the Site Object for enabling annotation (and electronic signature) functionality. You can
set the MVE site to require only annotations, only electronic signatures, both annotations and signatures, or neither
annotations nor signatures. Non-MVE sites may optionally define and use annotations; however, electronic signatures
are specific to MVE sites.

We recommend that you define custom annotations specific to your needs, in addition to the predefined annotations.
When the new Annotation Settings are saved in an MVE system, the new annotation selections are available to
users when they electronically sign for changes.

You can configure annotations at the device and object levels. See Audit Message Annotations in Audit Trail for
details on annotation fields. Also see Configuring Annotation and Electronic Signature Requirements in the Site
Object in MVE.
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Table 16 describes the attributes of the Annotation Settings tab.

Table 16: Annotation Settings Tab
DescriptionField Name
Enter a new annotation to be added to the list of predefined annotations. The text can be from 1 to 255
characters in length. Click Add to save the new annotation.

Predefined annotations can be edited or deleted.

Annotation Text

Displays the list of predefined annotations. Select a reason and click Delete to remove the annotation from
the list. The Move Up and Move Down buttons allow you to reorder the list.

Predefined
Annotation List

For additional information, refer to theMetasys for Validated Environments, Extended Architecture Technical Bulletin
(LIT-12011327).
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Menus
The menu layout is the same in the Online, Offline, and Simulation modes. The mode of operation determines which
items appear in the menus. For more information on the modes of operation, see Metasys Modes.

Menu Concepts
Metasys Modes
See the Metasys Modes topic in the Site Management Portal User Interface section.

Authorized Menu Items
Access to particular menu items not only depends on the mode of operation (Metasys Modes), but also on the
defined System Security and Authorization (Access Control) that provides users with appropriate levels of access
to the Metasys system. Use the Security Administrator System to set Authorization and System Security.

In each menu table, a check in the Authorization Required column means you must be authorized to perform that
action for that particular item. See the table in the Item Menu section.

Item Menu
Click the menu item below for a description of the menu item. For more information on the modes of operation, see
Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 17: Item Menu
Authorization
Required1

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XNew Archive Ctrl+N

XOpen Archive Ctrl+O

XClose Archive Ctrl+F4

XCreate Archive Copy

XDelete Archive

XExport Item

XImport Item

XXXXPage Setup

XXXXPrint Preview

XXXXPrint Ctrl+P

1 System Access-Based Privileges gives users with Standard Access the following privileges: Access to SCT, Configure and
Simulate using the SCT, Passthru mode, and Import Integration. Gives Users with Basic Access permission to use Passthu
mode. Basic Access and Tenant Access users do not have access to the SCT.

Close Archive
Menu Selection: Item > Close Archive

Closes an open archive in the SCT.

Edit Menu
Click the menu item below for a description of the menu item. For more information on the modes of operation, see
Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.
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Table 18: Edit Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XCopy Ctrl+C

XPaste Ctrl+V

XXX1XDelete Items Delete

1 When in online mode with Basic Access, you can delete only Schedule and Calendar objects.

Copy
Menu Selection: Edit > Copy

Copies the selected item to the clipboard in the SCT.

For details on copying and pasting items, see Paste Item Wizard.

Paste
Menu Selection: Edit > Paste

Pastes the clipboard contents to the user-specified location in the SCT.

For details on copying and pasting items, see Paste Item Wizard.

Delete Items
Menu Selection: Edit > Delete Items

Deletes (removes) one or more items selected in the All Items navigation tree from the site.

For details on deleting items, see Deleting Objects/Items.

View Menu
Click the menu item below for a description of the menu item. For more information on the modes of operation, see
Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 19: View Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXXSelected Item

XXXXEvent Viewer

XXAudit Viewer

XXXTrend Viewer

XScheduled Reports1

XActionQ

XXXXChange Results

XUpgrade Log

XXXXExtended Labels

XProduct Version Labels

XXXXValidation
Labels/Settings2
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Table 19: View Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXEnable Alarm Pop-Ups

XXXXPanel Layout

XXXXSingle Panel

XXXXTwo Panel Horizontal

XXXXTwo Panel Vertical

XXXXThree Panel Horizontal

XXXXThree Panel Vertical

XXXXFour Panel

1 Available on the ADS/ADX only.
2 This selection is Validation Labels in the online UI (MVE only) and Validation Settings in the SCT UI.

Upgrade Log
Menu Selection: View > Upgrade Log

Use this viewer to see the results of archive database upgrade activities. The Upgrade Log View in the SCT displays
log message types that are selected from the type options (Information, Warning and/or Error). A valid time range

is selected in the Date Range area and can be reset by pressing the button. Available archives can be

selected in the Archives area.

The entries are displayed in table format with type, date, archive, version, message, and source columns. Warning
entries are highlighted in yellow and errors entries are highlighted in red. To sort the rows in ascending or descending
order, click the column headings. Highlight and double-click an to entry bring up the View Upgrade Log Entry dialog
box. Navigational arrows allow you to navigate through entries forward and backward and from beginning to end.

Click the button to copy one or more selected entries; copied entries can be pasted into Excel, WordPad

or other similar application. Click the button to delete selected entries in the upgrade log. Before purging

entries, a dialog box appears warning you that this option clears all entries in the upgrade log and cannot be undone.

To refresh the upgrade log view, right-click the panel header and click Refresh; or click the Action menu and click
Refresh. Refresh also expands any columns that are not accommodating the text within.

Extended Labels
Menu Selection: View > Extended Labels (select the check box)

Toggles the display of the item labels in the All Items navigation tree or user navigation tree from standard to extended.
An extended label shows the BACnet object name that was defined when the object was initially created in braces
next to the standard label. This is the name used in the object's Fully Qualified Reference. The Metasys object name
may be the same as the BACnet object name, or it may have been edited as a label that is more recognizable to
the user.

Example:

Standard Label = N2 Trunk1

Extended Label = N2 Trunk1{N2-1}

Product Version Labels
Menu Selection: View > Product Version Labels (select the check box)
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Toggles the display of the item labels in the All Items navigation tree or user navigation tree from standard to product
version. A product version label shows the software revision of servers and engines in parentheses next to the
standard label.

Example:

Standard Label = NAE-Building-1

Extended Label = NAE-Building-1 (6.0)

Note: Starting at Release 6.0, SCT allows you to maintain both 5.2 and 6.0 Engines in the sites archive. The Site
Director for the archive has to be upgraded to 6.0, but all non-Site Director engines for the site can be left at
5.2 and can still be modified offline in the SCT and downloaded at Release 5.2.

Enable Alarm Pop-Ups
Menu Selection: View > Enable Alarm Pop-Ups (select the check box to enable/disable alarm pop-ups)

For the current user session, this item determines if the pop-up Alarms Window (also referred to as Metasys - Events
or Alarm Bar) automatically displays when an alarm is detected.

Clicking the alarm icon in the status bar re-enables alarm pop-ups and displays the current alarm, if any.

If you disable the alarm pop-up window and you have the audible alarm option enabled, the audible alarm sounds
when an alarm is detected. See the Alarms Window section in the Site Management Portal User Interface.

Validation Labels/Settings
Menu Selection: View > Validation Labels (in the online UI), View > Validation Settings (in the SCT UI) (select the
check box)

In the SCT, this setting toggles the display of the item labels in the All Items navigation tree or user navigation tree
to show extra label information for MVE. When selected, this menu item also displays the Validation Settings attribute
section for objects on the Focus/Configuration tab.

This setting has no effect in the online UI (the validation labels are always visible).

Action Menu
In addition to the four modes of operation that determine the items appearing in menus, the Action menu is context
specific. Different item specific options appear in the Action menu based on what is currently selected in the navigation
tree. Also, different feature specific options appear in the Action menu based on the active panel or feature displayed
in the selected display panel.

The following table lists the menu items for the Action menu. For details on which options appear with certain items
or features selected, see:

• Action Menu - Item Specific
• Action Menu - Feature Specific

Click one of the following menu items for a description of the menu item. For more information on the modes of
operation, see Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 20: Action Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXCommand1

XXModify2

XXImport Definition3

XXExport Definition3
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Table 20: Action Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXXShow Extensions

XStart Simulation

XRename

XView Annotations4

XXAdd Annotation4

XXXXRefresh

XXXXRefresh Current Tab

XXXXRefresh All Tabs

XXXAck

XXXDiscard

XXXImport Integration

XXRemove From Site

1 The commands in the Command dialog require authorization.
2 The attributes in the Modify dialog require authorization.
3 Available for the Summary Definitions folder in the All Items tree.
4 Available on the ADS/ADX only.

Rename
Menu Selection: Action > Rename

Renames the selected Engine device in the SCT.

Note: When renaming an ADS/ADX, the name must match the host name of the PC on which the ADS/ADX will
be installed.

Note: This rename option may take a while to complete because it changes the database references to the device.

View Annotations
Menu Selection: Action > View Annotations

Displays the existing annotations for the selected item in the Audit Viewer, Event Viewer, Tailored Summary, Global
Search results, Navigation Tree, and so on.

Add Annotation
Menu Selection: Action > Add Annotations

Adds an annotation for the selected item in the Audit Viewer, Event Viewer, Tailored Summary, Global Search
results, Navigation Tree, and so on.

Discard
Menu Selection: Action > Discard

Clears selected entries from the audit log when the Audit Viewer is displayed.

Refresh
Menu Selection: Action > Refresh

Refreshes the data displayed in the active frame or panel in the Event Viewer, Audit Viewer, Trend Viewer, and
Scheduled Reports.
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Refresh Current Tab
Menu Selection: Action > Refresh Current Tab

Refreshes the data displayed in the current tab of the active frame or panel.

Refresh All Tabs
Menu Selection: Action > Refresh All Tabs

Refreshes the data displayed in all tabs of the active display panel or the navigation frame.

Ack
Menu Selection: Action > Ack

Acknowledges the selected event(s) currently displayed in the Event Viewer.

Discard
Menu Selection: Action > Discard

Discards the selected event(s) currently displayed in the Event Viewer. Discards selected entries from the audit log
when the Audit Viewer is displayed.

Import Definition
Menu Selection: Action > Import Definition

This command imports the pre-built summary definition that is stored on the computer and is only available when
the Summary Definitions folder is selected in the All Items tree. After importing a definition, the imported Summary
Definitions appear in the Summary Definitions folder in the All Items tree.

Note: You also can import Summary Definitions that were previously exported. See the Exporting a Summary
Definition section.

Export Definition
Menu Selection: Action > Export Definition

This command exports the summary definition that is stored in the Summary Definitions folder in the All Items tree
to a location on the computer. You can now share the Summary Definition with others and import it to other sites as
desired.

Note: If you import the Summary Definition to another site, you may need to update the key data references. See
Importing a Summary Definition for more information.

Import Integration
Menu Selection: Action > Import Integration

This command is only available when an Integration under an engine is selected in the All Items tree. After adding
an Integration, you can select the integration in the navigation tree and use this menu selection to add existing
devices and points under the integration.

Remove From Site
Menu Selection: Action > Remove From Site

Removes (deletes) the selected Engine device or ADS/ADX server from the Site. The selected Engine or ADS/ADX
must be offline to use this option. You also can remove a device from the site in a Tailored Summary with Engine
device data.

Action Menu - Item Specific
The following table describes the different menu items that appear in the Action menu based on what is currently
selected in the navigation tree. Click each item for a description. For more information on the modes of operation,
see Metasys Modes.
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Table 21: Action Menu - Item Specific
Contents In ModeItem1

SimulationOffline (SCT)Online (Basic
Access)

Online (Standard
Access)

• Modify
• Rename

• Add Annotation
• View Annotations

• Modify
• Add Annotation
• View Annotations
• Remove From Site

ADS Device Object

• Command
• Show Extensions

• Modify
• Show Extensions
• Import Integration

• Command
• Add Annotation
• View Annotations

• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions
• Import Integration

Integration

• Command• Command
• Add Annotation
• View Annotations

• Command
• Add Annotation
• View Annotations

Site Object

• Command
• Show Extensions

• Modify
• Show Extensions
• Start Simulation
• Rename

• Command
• Add Annotation
• View Annotations

• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions
• Remove From Site

Supervisory Device (Engine)

• Command
• Show Extensions

• Modify
• Show Extensions

• Command
• Modify2

• Add Annotation
• View Annotations

• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions

All Other Objects

1 The Refresh Current Tab and Refresh All Tabs menu items appear in the Action menu for all of these items.
2 Available for only Schedule and Calendar objects.

Action Menu - Feature Specific
The following table describes the different menu items that appear in the Action menu based on the active panel or
feature displayed in the selected display panel. Click each active panel or feature for a description. For more
information on the modes of operation, see Metasys Modes.
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Table 22: Action Menu - Feature Specific
Contents In ModeActive Panel/Feature1

SimulationOffline (SCT)Online (Basic
Access)

Online (Standard
Access)

• Refresh• Refresh• Refresh
• Add Annotation2

• View Annotations2

• Ack
• Discard

Event Viewer

• Refresh
• Clear Audit Log

• Refresh
• Add Annotation2

• View Annotations2

• Clear Audit Log

Audit Viewer

• RefreshActionQ

• RefreshScheduled Reports2

• Command
• Modify
• Add Annotation2

• View Annotations2

• Command
• Modify
• Add Annotation2

• View Annotations2

• Show Extensions
• Remove From

Site4

• Import Integration5

Tailored Summary3

• Refresh
• Command

• Refresh
• Command

• Refresh
• Command

Trend Viewer

• Refresh• Refresh• RefreshGlobal Search Viewer

Change Results Viewer6

1 The Refresh, Refresh Current Tab, and Refresh All Tabs menu items appear in the Action menu for all other features or active
panels.

2 Available on the ADS/ADX only.
3 The menu options available are item specific (that is, they depend on the type of item selected in the Tailored Summary table

and Key Data table).
4 Available for an Engine only.
5 Available for a Tailored Summary with trunk/integration data (for example, trunk diagnostics).
6 There are no Action menu options for this feature .

Insert Menu
Click one of the following menu items for a description of the menu item. For more information on the modes of
operation, see Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.
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Table 23: Insert Menu
Authorization
Required1

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXSite

XXSupervisory Device

XXMetasys Server

XXXIntegration

XXXField Device

XXXField Point

XXXFolder

XXXControl System

XXX2XObject

XXXGraphic

XXXTrend Study

XXXUser View

XXXSummary Definition

1 System Access-Based Privileges gives users with Standard Access the following privileges: Access to SCT, Configure and
Simulate using the SCT, Passthru mode, and Import Integration. Gives Users with Basic Access permission to use Passthu
mode. Basic Access and Tenant Access users do not have access to the SCT.

2 In online mode with Basic Access, the Insert Object wizard is limited to the Schedule and Calendar objects.

Tools Menu
Click one of the following menu items for a description of the menu item. For more information on the modes of
operation, see Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 24: Tools Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXXUser Profile

XXXXChange Password

XXXXAdministrator

XXXConfigure Preferences

XXXAll Items Organizer

XDatabase

XCreate Backup

XRestore Backup

XRe-index

XManage Archive

XXXXField Device Tools1

XXXXHVAC PRO (N2)
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Table 24: Tools Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXXGX-9100 (N2)

XXXXXTMConfiguration (N2)

XXXXDX Commissioning
(N2)

XXXXN2 Device Loader (N2)

XXXXCCT (MSTP)2

XSecurity Copy

XDiagnostics

XArchive Reports

XXXOther Applications as
Specified in Configure
Preferences

1 The Field Device Tools menu selection replaces the N2 Tools menu selection available at Release 2.0 and earlier.
2 To use the Controller Configuration Tool (CCT) in Ethernet passthru mode, open CCT from the Tools > Field Device Tools >

CCT (MS/TP) menu option.

User Profile
Menu Selection: Tools > User Profile

Launches the current user’s properties for managing the user’s language, default navigation view, and other profile
settings.

Change Password
Menu Selection: Tools > Change Password

Changes the current user’s password. The password you select must meet the requirements for complex passwords.
For details, refer to the Network and IT Guidance for the BAS Professional Technical Bulletin (LIT-12011279).

Administrator
Menu Selection: Tools > Administrator

Launches the Security Administrator System. This menu item is only available for users in the ADMINISTRATOR
role. Within the Security Administrator System, Administrators manage user accounts by creating roles/profiles;
setting user passwords; assigning category-based, system-level, and navigation view permissions/access; and
performing other duties. For details, see Related Documentation.

Configure Preferences
Menu Selection: Tools > Configure Preferences

Launches the Metasys Preferences dialog box.

The Metasys system provides customized preferences for the UI. The preferences allow you to configure how the
UI behaves, including the sounds and colors, the startup view, and the ability to add links to external applications
that can be accessed from within the UI.

All Items Organizer
Menu Selection: Tools > All Items Organizer

Launches the Metasys All Items Organizer.
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Allows an authorized user to specify the order of any items in the All Items tree. The user can order all devices below
the site (for example, NxEs) and nodes within devices.

On a device (Release 5.2 or later) that is not a site director, the user can order the items within that device only. You
cannot order nodes within devices at Releases earlier than 5.2.

Create Backup
Menu Selection: Tools > Database > Create Backup

Creates a backup file for the active archive database. If needed, the archive database can be restored using the
Tools > Database > Restore Backup menu option. See the Restore Archive Wizard.

The backup file is always named <archive>.backup, where <archive> is the name of the open archive visible at the
top of the SCT navigation tree. Do not rename the backup file (renaming a backup file causes a subsequent restore
to fail). To save different versions, copy the backup file to different subdirectories.

The default path is one of the following:

Windows XP® Operating System (OS): C:\Documents and Settings\All Users\Application Data\Johnson
Controls\MetasysIII\DatabaseFiles

Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles)

Re-index
Menu Selection: Tools > Database > Re-index

Using the Re-index feature improves SCT performance against large archive databases. The Re-index feature
removes fragmentation from the archive database. A clock appears during the re-indexing process.

Note: Re-index works against any size archive and is especially recommended for sites containing more than 100
NxEs.

Archive Reports
Menu Selection: Tools > Diagnostics > Archive Reports

Launches the two-tab Archive Report window in the SCT. Each tab generates a different archive report. The Statistics
tab generates a .csv file of statistical archive data from the archive(s) selected in the archive list. The References
tab generates a .csv file of unbound reference data from the archive(s) selected in the archive list.

Query Menu
Click one of the following menu items for a description of the menu item. For more information on the modes of
operation, see Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 25: Query Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXAlarm Report1

XXXOffline Report1

XXXDisabled Report1

XXXOperator Override
Report1

XXXSupervisory Override
Report1

XXGlobal Search

XXOpen Object List2
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Table 25: Query Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXSave Object List2

XXDelete Object List2

XXNew Scheduled Report3

1 The content of this report is filtered based on authorization.
2 Available on the Site Director only.
3 Available on the ADS/ADX only.

Help Menu
Click one of the following menu items for a description of the menu item. For more information on the modes of
operation, see Metasys Modes. For a description of the Authorized Required column, see Authorized Menu Items.

Table 26: Help Menu
Authorization
Required

Mode Visible InMenu Item
SimulationOffline (SCT)Online (Basic

Access)
Online

(Standard
Access)

XXXXMetasys Help F1

XXXXMetasys Graphics Help

XXXXAbout Metasys

Metasys Help
Menu Selection: Help > Metasys Help

Launches the Metasys system Help.

Metasys Graphics Help
Menu Selection: Help > Metasys Graphics Help

Launches the Metasys Graphics+ Runtime Help.

About Metasys
Menu Selection: Help > About Metasys

Displays the Metasys software version, Graphics+ runtime software version, copyright, current user name, URL
connection, and maximum runtime memory information for the Metasys system. The Maximum Runtime Memory
indicates how much memory is set for Java technology as a means of troubleshooting Java problems. The default
Maximum Runtime Memory is 989 MB. Click the Terms & Conditions button to view terms and conditions information.

Right-Click Menus
The contents of the menus vary depending on the item or feature selected. The contents are either feature-specific
based on the active panel or item-specific based on the selected item in the navigation tree.

For details on how to access right-click menu items using the equivalent menu bar selection, see Right-Click Menus
and Menu Bar Equivalents.

Right-Click Menus - Item Specific
Click one of the following items below for a description of the item. For more information on the modes of operation,
see Metasys Modes.
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Table 27: Right-Click Menus - Item Specific
Contents In ModeItem

SimulationOffline (SCT)Online (Basic Access)Online (Standard
Access)

• View• View
• Edit

- Copy Ctrl+C
- Paste Ctrl+V
- Delete Items

• Modify
• Import Definition1

• View
• Import Definition1

• View
• Modify
• Import Definition1

Folder

• View
• Event Viewer

• View
• Edit

- Copy Ctrl+C
- Paste Ctrl+V
- Delete Items

• Modify
• Rename

• View
• Event Viewer

• View
• Modify
• Command
• Event Viewer
• Audit Viewer
• Add Annotation2

• View Annotations2

ADS

• View• View
• Modify
• Copy Ctrl+C
• Delete Items

• View• View
• Modify

User Views

• View
• Command

• View
• Paste Ctrl+V
• Delete Items

• View
• Command

• View
• Command
• Add Annotation2

• View Annotations2

Site

• View
• Event Viewer
• Command
• Show Extensions
• Alarm Report
• Offline Report
• Disabled Report
• Operator Override

Report
• Supervisory Override

Report

• View
• Edit

- Copy Ctrl+C
- Paste Ctrl+V
- Delete Items

• Modify
• Rename
• Show Extensions

• View
• Event Viewer
• Command
• Alarm Report
• Offline Report
• Disabled Report
• Operator Override

Report
• Supervisory Override

Report

• View
• Event Viewer
• Audit Viewer
• Command
• Modify
• Add Annotation2

• View Annotations2

• Show Extensions
• Alarm Report
• Offline Report
• Disabled Report
• Operator Override

Report
• Supervisory Override

Report

Supervisory
Device (Engine)
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Table 27: Right-Click Menus - Item Specific
Contents In ModeItem

SimulationOffline (SCT)Online (Basic Access)Online (Standard
Access)

• View• View
• Modify
• Copy Ctrl+C
• Delete Items
• Export Definition

• View• View
• Modify
• Export Definition

Summary
Definition
Object

• View
• Command
• Show Extensions

• View
• Edit

- Copy Ctrl+C
- Paste Ctrl+V
- Delete Items

• Modify
• Show Extensions

• View
• Command
• Modify4

• View
• Command
• Modify
• Show Extensions
• Add Annotation2

• View Annotations2

All Other
Objects3

1 Available for the Summary Definitions folder in the All Items tree.
2 Available on the ADS/ADX only.
3 For Trend or other extensions, the View and Show Extensions menu items display for the parent item, not for the extension

itself.
4 Available for only Schedule and Calendar objects.

Right-Click Menus - Feature Specific
Click one of the following active panels or features for a description of the active panel or feature. For more information
on the modes of operation, see .

Table 28: Right-Click Menus - Feature Specific
Contents In ModeActive Panel/Feature

SimulationOffline (SCT)Online (Basic
Access)

Online (Standard
Access)

• Refresh
• Discard
• Add Annotation

Audit Viewer

• Refresh
• Discard
• Ack
• View Item

• Refresh
• View Item

• Refresh
• Discard
• Ack
• View Item
• Add Annotation

Event Viewer

• Refresh
• View

• Refresh
• View

• Refresh
• View

Report Viewer
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Table 28: Right-Click Menus - Feature Specific
Contents In ModeActive Panel/Feature

SimulationOffline (SCT)Online (Basic
Access)

Online (Standard
Access)

• Refresh
• Open Object List
• Save Object List
• View
• Command

• Refresh
• Open Object List
• Save Object List
• View
• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions

Global Search Viewer

Change Results Viewer

• Refresh
• Move Up
• Move Down
• Sort Ascending
• Sort Descending

• Refresh
• Move Up
• Move Down
• Sort Ascending
• Sort Descending

All Items Organizer

• View
• Event Viewer
• Command
• Modify
• Add Annotation
• View Annotations
• Alarm Report
• Offline Report
• Disabled Report
• Operator Override

Report
• Supervisory

Override Report

• Refresh Current
Tab,

• Refresh all Tabs,

• View
• Event Viewer
• Audit Viewer
• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions
• Alarm Report
• Offline Report
• Disabled Report
• Operator Override

Report
• Supervisory

Override Report
• Import Integration

Tailored Summaries
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Table 28: Right-Click Menus - Feature Specific
Contents In ModeActive Panel/Feature

SimulationOffline (SCT)Online (Basic
Access)

Online (Standard
Access)

• Refresh,

• View
• Command
• Background Color
• Y-Axis Scale
• X-Axis Scale
• Gridlines

- None
- X and Y
- X Only
- Y Only

• Chart Type
- Points Line
- Area
- Bar
- Points
- Line

• Stacked Y-Axis

• Refresh,

• View
• Command
• Background Color
• Y-Axis Scale
• X-Axis Scale
• Gridlines

- None
- X and Y
- X Only
- Y Only

• Chart Type
- Points Line
- Area
- Bar
- Points
- Line

• Stacked Y-Axis

• Refresh,

• View
• Command
• Modify
• Event Viewer
• Audit Viewer
• Add Annotation
• View Annotations
• Background Color
• Y-Axis Scale
• X-Axis Scale
• Gridlines

- None
- X and Y
- X Only
- Y Only

• Chart Type
- Points Line
- Area
- Bar
- Points
- Line

• Stacked Y-Axis

Trend Viewer

• Refresh Current
Tab

• Refresh All Tabs
• Command
• Show Extensions

• Modify
• Refresh Current

Tab
• Refresh All Tabs
• Show Extensions

• Refresh Current
Tab

• Refresh All Tabs
• Command

• Modify
• Refresh Current

Tab
• Refresh All Tabs
• Command
• Show Extensions

Tabbed Item Viewer
(Display Panel Tabs)

1 The View, Commands, and Show Extensions menu items are item specific.
2 With the header of the display panel selected.
3 Available on the ADS/ADX only.
4 With an item in the report, Legend, Trend Items table, or results table selected.
5 The menu options available are item specific (that is, they depend on the type of item selected in the Tailored Summary table

and Key Data table).
6 Available for an Engine only.
7 Available for a Tailored Summary with trunk/integration data (for example, trunk diagnostics).
8 With an item in the Legend selected.
9 With the Chart selected.

Right-Click Menus and Menu Bar Equivalents
The following table shows the menu items that may appear in a right-click menu and their equivalent in the menu
bar.
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Table 29: Right-Click Menus and Menu Bar Equivalents
Menu Bar Item=Right-Click Menu Item
View > Audit Viewer=Audit Viewer

Action > Command=Command

Action > Modify=Modify

Edit

Edit > Copy=Copy

Edit > Paste=Paste

Edit > Delete Items=Delete Items

View > Event Viewer=Event Viewer

Query > Alarm Report=Alarm Report

Query > Offline Report=Offline Report

Query > Disabled Report=Disabled Report

Query > Override Report=Override Report

Action > Show Extensions=Show Extensions

Action > Refresh=Refresh

Action > Refresh All Tabs=Refresh All Tabs

Action > Refresh Current Tab=Refresh Current Tab

View > Selected Item=View

Action > Rename=Rename

Action > Remove From Site=Remove From Site

Action > Add Annotation=Add Annotation

Action > View Annotations=View Annotations
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Wizards
Wizards make complex tasks easy and guide you through creating and configuring objects and features. A wizard
typically consists of a series of steps, each corresponding to a screen presented to the user.

A wizard may appear when you select an option from the Insert menu and when you prompt certain actions such
as copying and pasting an item in the Navigation Tree. For example, a wizard appears when you select Object from
the Insert menu. Wizards that are available in different modes (for example, any combination of online, offline, or
simulation) appear the same.

Wizards Concepts
Types of Wizards
The following table lists the wizards in the system.

Table 30: Types of Wizards
Insert Object - Event EnrollmentNew Archive Wizard (SCT only)

Insert Object - Generator Load ControlOpen Archive Wizard (SCT only)

Insert Object - Global DataCopy Archive Wizard (SCT only)

Insert Object - GroupDelete Archive Wizard (SCT only)

Insert Object - InterlockExport Archive Wizard (SCT only)

Insert Object - LoopImport Wizard (SCT only)

Insert Object - MVExtension Wizard (SCT only)

Insert Object - Multiple CommandInsert Site Wizard (SCT only)

Insert Object - NotificationInsert Supervisory Device Wizard (SCT only)

Insert Object - Optimal StartInsert Metasys Server Wizard (SCT only)

Insert Object - Pulse MeterInsert Integration Wizard

Insert Object - ScheduleInsert Control System Wizard

Insert Object - Signal SelectInsert Object - AV

Insert Object - Solar ClockInsert Object - Accumulator

Insert Graphic WizardInsert Object - Auto Shutdown

Insert Trend Study WizardInsert Object - BV

Create New User View WizardInsert Object - Calendar

Create New Summary Definition WizardInsert Object - DLLR

Restore Archive WizardInsert Object - Data Broadcast

Manage Archive WizardInsert Object - Electric Demand Control

Passthru WizardInsert Object - Electric Demand Monitoring

Security Copy WizardInsert Field Device Wizard

Paste Item WizardInsert Point Wizard

Insert Folder Wizard

Wizard Navigation Buttons
The buttons in Table 31 are common to most of the wizards and allow you to move through wizard screens.

Table 31: Common Wizard Navigation Buttons
DescriptionButton
Closes the wizard without saving any data. This button is always active.Cancel

Takes you back one screen in the wizard. This may not be the last screen viewed, since you can move between
screens. This button is active on all screens except the first.

< Back
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Table 31: Common Wizard Navigation Buttons
DescriptionButton
Takes you to the next screen in the wizard. If the current screen requires user input or you are on the last screen
in the wizard, the Next button is disabled.

Next >

If available, presents a summary screen for the wizard. If your input is required in any previous screen, the Last
button is disabled. The Last button takes the user to the last wizard screen, which is the summary screen. Once
the summary screen is displayed, the Last button is replaced by the Finish button.

Last

Exits the wizard and saves the data. Selecting Finish is the normal method of exiting a completed wizard. If any
prior screens require your input, this button is disabled. If a wizard has a summary screen, the Finish button is
not available until the summary screen is displayed.

Finish

Wizards Steps
Creating Items with Wizards
1. Select the item to create. The corresponding wizard appears. If more than one type of item is available, select

the desired type. Click Next.
a. Menu Selection: Action > Show Extensions

Launches the Extension Wizard to create extensions to objects that support them.
b. Menu Selection: Tools > Manage Archive

Launches the Manage Archive Wizard within SCT. The following options are available within the archive
databases, Upload from Device, Download to Device, Synchronize and Upgrade Device.

c. Menu Selection: Tools > Security Copy

Launches the Security Copy Wizard within SCT.
d. Menu Selection: Tools > Database

Launches the Restore Archive Wizard, in the SCT.
e. Menu Selection: Insert > Site, Supervisory Device, Metasys Server, Integration, Field Device, Field Point,

Folder, Control System, Object, Graphic, Trend Study, User View, and Definition Summary

Launches the Site, Supervisory Device, Metasys Server, Integration, Field Device, Field Point, Folder, Control
System, Object, Graphic, Trend Study, User View, and Definition Summary Wizards individually, in the SCT
to add new objects.

f. Menu Selection: Insert > Integration, Field Device, Field Point, Folder, Control System, Object, Graphic,
Trend Study, User View, and Definition Summary

Launches the Integration, Field Device, Field Point, Folder, Control System, Object, Graphic, Trend Study,
User View, and Definition Summary Wizards individually, to add new objects.

2. Select the destination for the new item and click Next.

Note: All items appear in the wizard, not just valid destinations. When you click an item that is not a valid
destination for the item being added, an error message appears on the right side of the wizard and the
Next button is disabled.

Note: Items in the navigation tree load on a per device basis instead of all at once. When you click a device for
the first time, an hourglass cursor appears while the device’s child items load in the navigation tree. This
functionality saves time on large sites as it allows you to load only the data for the desired devices.

3. Complete the information on the wizard screens, using the navigation buttons to move through the screens. The
screens vary depending on the item you are creating. See the Using Wizards section for information specific to
each wizard.

4. Select Finish on the summary page to create the item. If an error occurs, a message displays and the wizard
returns to the summary page. If the item supports extensions, the Extension Wizard displays after the item is
successfully created.
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Using Wizards
Click the wizard type in the Types of Wizards table or browse the following topics for information on using wizards,
including:

• menu selections for accessing each wizard
• descriptions
• tips
• related information

New Archive Wizard
Menu Selection: Item > New Archive

Creates a new archive database in the SCT.

Tip: The Create Site dialog box appears after creating the new archive asking if you want to create a site in the
new archive. Selecting Yes invokes the Insert Site wizard.

See Insert Site Wizard.

Open Archive Wizard
Menu Selection: Item > Open Archive

Opens an existing archive database in the SCT.

Archives appear locked when someone else is accessing that archive. If a user has an archive open and closes the
UI incorrectly (not clicking the Exit or Logout button), the database will appear locked to all users with a different
username/password. To reverse the lock, a user with the same username/password as the user who closed the UI
incorrectly must open that archive, then close the UI properly.

Copy Archive Wizard
Menu Selection: Item > Create Archive Copy

Creates a copy of the existing and currently open archive database in the SCT.

The copy is intended as a second backup in case the original backup file is deleted. Do not rename the backup file
because the file does not restore properly using a different name (it is case sensitive). If you want to rename a
backup file, create a copy of the archive and give it the new name before you create a backup. You cannot rename
the backup after it is created.

Delete Archive Wizard
Menu Selection: Item > Delete Archive

Removes (deletes) an existing archive database from the SCT.

Export Archive Wizard
Menu Selection: Item > Export Item

In the SCT, exports the selected item and its child objects displayed beneath it in the navigation tree in the source
selection. The items can be imported into another archive database, see the Import Wizard section for more
information.

1. Select the item in the navigation tree in the Source selection.

2. In the File Name selection, add a new file name or select an existing file name of the file to which the data will
export and check the Overwrite check box.
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Figure 9: Export Archive Wizard

The exported data file is stored in the following default directory:

• Windows XP OS: C:\Documents and Settings\All Users\ApplicationData\Johnson
Controls\MetasysIII\DatabaseFiles

• Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles)

Click the Details button for a Notice Information dialog box which displays the Reference, Class, Class Version,
Parent Exists and Objects Exists information.

3. In the Summary Selection click Finish to confirm the export configuration information.

Import Wizard
Menu Selection: Item > Import Item

In the SCT, imports a previously exported archive file, to overwrite the selected item and its child objects displayed
beneath it in the navigation tree into the currently open archive database. See the Export Archive Wizard.

1. Select the item and its child objects displayed beneath it the navigation tree in the Site Management Portal UI,
select Item > Import Item.

2. The import Wizard dialog box appears, select the file to import and click Import.
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Figure 10: Import Archive Wizard

An exported data file must be stored in the default directory:

• Windows XP OS: C:\Documents and Settings\All Users\ApplicationData\Johnson
Controls\MetasysIII\DatabaseFiles

• Windows 7 OS, and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles)

Click the Details button for the Notice Information dialog box which displays the Reference, Class, Class Version,
Parent Exists and Objects Exists information.

3. A Verify Overwrite dialog box appears to confirm overwriting the selected item and its child object in the navigation
tree.

Note: Importing a Site Director device into a database with existing User Views is not supported and may cause
loss of User View data.

Extension Wizard
Note: You cannot add or delete extensions in Simulation mode.

Menu Selection: Actions > Show Extensions (menu option is available only when an item that supports extensions
is selected)

Adds features, such as trending, alarming, averaging, loading and totalization, to an item. Extension types include:

• Resource File - Adds a resource file to a field device or integration, if supported.
• Trend - Adds trending capabilities to an item.
• Totalization - Adds totalization capabilities to an item.

Note: Select either the Event Totalization or Runtime Totalization radio button if they appear on the right side
of the Select Attribute screen of this wizard. If these selections do not appear, the attribute you selected
uses Analog Totalization.

• Alarm - Adds attributes for generating alarm and event messages to an item. See the Alarm and Event
Management feature for information.

• Averaging - Adds averaging capabilities to an item.
• Load - Adds the load capability of the Energy Management feature. You can add only one load extension to an

object.

See the Extensions section.
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Insert Site Wizard
Menu Selection: Insert > Site

Inserts a site into the archive database in the SCT.

Tip: The Create Device? dialog box appears after inserting a site asking if you want to create a device in the site.
Selecting Supervisory Device and clicking OK invokes the Insert Device wizard. Selecting Metasys Server
and clicking OK invokes the Insert Metasys Server wizard. Select None and OK if you do not want to add a
device at this time.

See one of the following sections for more information:

• Related Documentation
• Site Object

Insert Supervisory Device Wizard
Menu Selection: Insert > Supervisory Device

Inserts a supervisory device: NAE35, NAE45, NAE451L, NAE55, NAE85, NCE25, NIE55, or NIE85 into the archive
database in the SCT.

Note: When inserting an NIE29 device, select NCE25. When inserting an NIE39 device, select NAE35. When
inserting an NIE49 device, select NAE45.

Note: Some products/models mentioned in this document are available only to specific markets. Refer to the
Application and Data Server (ADS) Lite for Europe (E) Product Bulletin (LIT-12011690) and the Application
and Data Server (ADS) Lite for Asia (A) System Product Bulletin (LIT-12011694) for availability.

On the Configure screen of this wizard, click any tabs that may appear for further device configuration.

See one of the following sections for more information:

• Related Documentation
• Alarm and Event Management
• Engine Device Object

Insert Metasys Server Wizard
Menu Selection: Insert > Metasys Server

Inserts a Metasys server (ADS/ADX, ADS-L-A, ADS-L-E) into the archive database in the SCT.

Note: Some products/models mentioned in this document are available only to specific markets. Refer to the
Application and Data Server (ADS) Lite for Europe (E) Product Bulletin (LIT-12011690) and the Application
and Data Server (ADS) Lite for Asia (A) System Product Bulletin (LIT-12011694) for availability.

Tip: The first Metasys server you add to the site becomes the Site Director. The Site Director coordinates all Web
browser communication to the Metasys network. You can only have one Site Director per site. Any subsequent
Metasys servers are primarily used for archiving historical data.

Tip: On the Configure screen, select each tab for further configuration options.

See one of the following sections for more information:

• Alarm and Event Management
• ADS Device Object

Insert Integration Wizard
Menu Selection: Insert > Integration

Integrates the following types of buses or networks into the NAE, NIE, or NCE:

• BACnet - Inserts a BACnet integration into the NAE or NCE.
• Field Bus - Inserts an MS/TP network integration for the NAE or NCE.
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• LON Trunk - Inserts a LONWORKS network into the NAE or NCE.
• N1 Migration - Inserts an N1 Migration trunk into the NIE.

Note: Be sure to configure the Network Name attribute of the N1 Migration. Once you insert the N1 Migration,
you cannot edit the Network Name attribute. The workaround is to delete the existing N1 Migration and
insert a new N1 Migration ensuring you enter the desired Network Name before completing the Insert
Integration Wizard.

• N2 Trunk - Inserts an N2 trunk into the NAE or NCE.
• VND Integration - Inserts a vendor integration into the NAE, NIE or NCE.
• Wireless Supervisor - Inserts a Wireless Sensor System integration into the system. (You can have only one

Wireless Integration per NAE or NCE.)
• XL5K IntegrationInserts a Honeywell Excel 5000 (XL-5000) network integration for the NIE. (You can have only

one XL5K Integration object per NIE.) - Inserts a Honeywell Excel 5000 (XL-5000) network integration for the
NIE. (You can have only one XL5K Integration object per NIE.)

Tip: Select the Hardware tab (if it appears) on the Configure screen for further configuration.

After adding an integration, you can select the integration in the navigation tree and click Action > Import Integration
to add existing devices and points under the integration.

See one of the following sections for more information:

• Related Documentation
• N2 Master Datalink Object (N2 Trunk)
• BACnet Integration Object
• MS/TP Field Bus Integration Object
• LON Integration Object
• N1 Migration Object
• VND Integration Object
• Wireless Receiver Supervisor Object
• XL5K Integration Object

Insert Field Device Wizard
Menu Selection: Insert > Field Device

Inserts one of the following types of field device objects under the selected integration:

• BACnet Integration - BACnet Integration Object (Non-FEC BACnet Device)
• MS/TP Field Bus Integration - MS/TP Field Device Object (FEC Family BACnet Device) BACnet Device Object

(Non-FEC BACnet Device)
• LONWORKS Network Integration (LON Trunk) - LON Controller Object
• N1 Migration - N1 Migration Object
• N2 Integration (N2 Trunk) - N2 Controller Object (for example, AHU and VMA)
• VND Controller (Vendor) - 3rd party vendor controller, offered through Systems Integrations Services (SIS)

• Wireless Supervisor Integration - Wireless Receiver Object
• XL5K (Excel 5000/XL-5000) Integration - Honeywell XL5000 Controller Object

To insert a field device select the menu selection:

1. In the Destination selection, select the parent item for your new item.

2. In the Definition selection:
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Select Assisted Device Definition and click the Invoke Auto Discovery button to discover existing controllers
or devices on the network. This is available in the Site Management Portal (SMP) only.

Note: In the Wizard Auto Detect Utility window, if Results are from a previous discovery appears next to
the Close button, the displayed results are from the last time a discovery was run. These cached
results may not reflect all items currently on the network. To clear the old results and perform a new
auto discovery, click Restart. Click any column header to sort discovered devices.

a.

b. Select Manual Device Definition and select the desired address from the menu.
3. In the Identifier selection, enter a unique identifier.
4. In the Configure selection, click any tabs that may appear for further device configuration.

5. Click Finish to confirm the field device configuration.

Note: If the navigation tree does not automatically update for defined points after adding a field device using
Auto Discovery (+ sign appears next to device in tree) select Refresh All Tabs on the Action Menu to
update.

See one of the following sections for more information:

• Related Documentation
• N2 Master Datalink Object (N2 Trunk)
• BACnet Integration Object
• MS/TP Field Bus Integration Object
• LON Integration Object
• N1 Migration Object
• VND Controller
• Wireless Receiver Object
• XL5K Integration Object

Insert Point Wizard
Menu Selection: Insert > Field Point

Inserts one of the following types of field points into a field device under an integration:

• N2 Trunk

Analog Input Object (AI), Analog Output Object (AO), Accumulator Objects, Binary Input Object (BI), Binary
Output Object (BO), Multistate Input Object (MI), Multistate Output Object (MO)

• BACnet

All field points listed for the N2 trunk plus Analog Value Object (AV), Averaging Extensions, Binary Value Object
(BV), Calendar Object, Electric Demand Control Object, Electric Demand Monitoring Object, Event Enrollment
Object, Generator Load Control Object, Group Object,Life Safety Point Object, Life Safety Zone Object, Multistate
Value Object (MV), Notification Class Object, Schedule Object, Trend Log

• MS/TP Field Bus Integration

Accumulator Objects, Analog Input Object (AI), Analog Output Object (AO), Analog Value Object (AV), Binary
Input Object (BI), Binary Output Object (BO), Binary Value Object (BV), Multistate Value Object (MV), Calendar
Object, Schedule Object, Notification Class Object, Trend Log

• LON Trunk

Analog Input Object (AI), Analog Output Object (AO), Accumulator Objects, Binary Input Object (BI), Binary
Output Object (BO), Multistate Input Object (MI), Multistate Output Object (MO), Generic Integration Object (GIO)

Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still supported in existing
databases, even after upgrading to the next software release.
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• N1 Migration

All field points listed for the N2 trunk plus Generic Integration Object (GIO) and N1 PID Loop Object.
• VND Integration (Vendor)

Analog Input Object (AI), Analog Output Object (AO), Accumulator Objects, Binary Input Object (BI), Binary
Output Object (BO), Multistate Input Object (MI), Multistate Output Object (MO)

• Wireless Supervisor Integration

Wireless Sensor Object
• XL5K (Excel 5000/XL-5000) Integration

XL5K Integration Object

Tip: On the Select Definition Mode screen, select Assisted Point Definition to automatically discover existing points
on the network.

Tip: Or on the Select Definition Mode screen, select Manual Point Definition.

Tip: When adding a LONWORKS point manually, the Target Reference appears blank. Manually type the path for
the Target Reference (path into the controller for the data being mapped by the object) in the text box on the
Select Data Source screen.

Tip: Select the Hardware tab on the Configure screen for further configuration.

See one of the following sections for more information:

• Related Documentation
• N2 Master Datalink Object (N2 Trunk)
• BACnet Integration Object
• MS/TP Field Bus Integration Object
• LON Integration Object
• N1 Migration Object
• VND Integration Object
• Wireless Sensor Object
• XL5K Integration Object

Insert Folder Wizard
Menu Selection: Insert > Folder

Inserts a folder into the navigation tree of the system for grouping and categorizing items and information in the
navigation tree.

See the Folder object section for more information.

Insert Control System Wizard
Menu Selection:Insert > Control System

Inserts a control system into the site. See Logic Connector Tool (LCT) for more information on control systems and
the Logic Connector Tool.

Insert Object Wizard
The Insert Object wizard inserts one of the following object types:

• Insert Object - AV

Menu Selection: Insert > Object

Inserts an Analog Value Object into the site.
• Insert Object - Accumulator
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Menu Selection: Insert > Object

Inserts a Flex Accumulator object into the site. See Accumulator Objects.
• Insert Object - Auto Shutdown

Menu Selection: Insert > Object

Inserts an Auto Shutdown Object into the site.

Note: On the Configure screen, click the button to select an object from the Select Item dialog box. Then
select the desired Control attribute from the drop-down menu.

• Insert Object - BV

Menu Selection: Insert > Object

Inserts a Binary Value Object into the site.
• Insert Object - Calendar

Menu Selection: Insert > Object

Inserts a Calendar Object into the site.

See Scheduling for more information on applying scheduling capabilities.
• Insert Object - DLLR

Menu Selection: Insert > Object

Inserts a DLLR Object into the site.
• Insert Object - Data Broadcast

Menu Selection: Insert > Object

Inserts a Data Broadcast Object into the site.

Note: On the Configure screen, click the button to select the input reference object from the Select Item
dialog box. Then select the desired attribute to reference from the drop-down menu.

• Insert Object - Electric Demand Control

Menu Selection: Insert > Object

Inserts an Electric Demand Control object into the site. See the IEIEJ BACnet System Objects section for
information.

• Insert Object - Electric Demand Monitoring

Menu Selection: Insert > Object

Inserts an Electric Demand Monitoring object into the site. See the IEIEJ BACnet System Objects section for
information.

• Insert Object - Event Enrollment

Menu Selection: Insert > Object

Inserts an Event Enrollment Object into the site.

See Event Enrollment Configuration Examples for examples on how to configure this object.
• Insert Object - Generator Load Control

Menu Selection: Insert > Object

Inserts an Generator Load Control object into the site. See the IEIEJ BACnet System Objects section for
information.

• Insert Object - Global Data
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Menu Selection: Insert > Object

Inserts a Global Data Sharing Object into the site.
• Insert Object - Group

Menu Selection: Insert > Object

Inserts a Group Object into the site.

Note: Click the Add button to select the items belonging to this group from the Select Item dialog box.

Note: Click the item in the group list and use the up and down arrows to move the item in the list.

Note: Click the item in the group list and click Remove to remove the item from the group.
• Insert Object - Interlock

Menu Selection: Insert > Object

Inserts an Interlock Object into the site.

Note: On the Configure screen, click the Interlock Definition and Action Tables tabs for further configuration.

Tips for the Interlock Definition tab of the Configure screen:

- Click the Add button to add items to the list from the Select Item dialog box.
- Click the check box next to an item in the list and click Delete to remove the item from the list.
- Select the type of logic to use for the items in the list from the Logic menu. See the Interlock Object’s Logic

attribute description for the types of logic.

Tips for the Action Tables tab of the Configure screen:

- Check the All Commands Priority check box if you wish to use the same priority for all commands in the
action tables. Clear the All Commands Priority check box to enable individual priority selection for the
commands in the action tables.

- For the Actions for Condition: True and Actions for Condition: False tables, click the Add button to add
items to the table from the Select Item dialog box.

- For the Actions for Condition: True and Actions for Condition: False sections, click the check box next
to an item in the table and click Delete if you want to remove the item from the table.

• Insert Object - Loop

Menu Selection: Insert > Object

Inserts a Loop Object into the site.
• Insert Object - MV

Menu Selection: Insert > Object

Inserts a Multistate Value Object into the site.
• Insert Object - Multiple Command

Menu Selection: Insert > Object

Inserts a Multiple Command Object into the site.

Note: On the Configure screen, click the Action Tables tab for further configuration.

Note: Select or enter the desired value for the Relinquish Default. Edit the States Text and Number of States
attributes on the Focus tab.

Note: Check theAll Commands Priority check box if you wish to use the same priority for all commands. Clear
the All Commands Priority check box to enable individual priority selection for the commands.
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Note: For each of the Actions for Condition (State 0 - State N) tables, click the Add button to add items to
the table from the Select Item navigation tree.

Note: For each of the Actions for Condition (State 0 - State N) tables, click the check box next to an item in
the table and click Delete to remove the item from the table.

See the Multiple Command Object section for more information.
• Insert Object - Notification

Menu Selection: Insert > Object

Inserts a Notification Class Object into the site.

Note: On the Configure screen, click the Recipient List tab for further configuration.

Note: Click the Add button to add a BACnet device as a recipient item to the list. The Notification Recipient
dialog box appears. See the Tips for the Notification Recipient section that follows.

Note: Click the check box next to an item in the list and click Remove if you want to remove the item from the
list.

Note: Click the check box next to an item in the list and click Details to view that item’s Notification Recipient
dialog box information.

Note: Select an item in the list and use the up and down arrows to change the order of the item in the list.

Tips for the Notification Recipient:

- To send a notification to a specific BACnet device, select the OID radio button and enter the object identifier
for that device in the Device OID box. Enter the Process ID.

- To send a notification to a specific address, select the Address radio button and enter the IP Address, Network
Number, UDP Port, and Process ID. See the Recipient List attribute of the Notification Class object for details.

- Select the check boxes for the days that the notifications should be sent. To define the times when the
notification is active, slide the arrows on the time bar to define Start and Stop times.

For more information, see the BACnet Integration Object and Alarm and Event Management forMetasys Systems
Integrated with BACnet Devices.

• Insert Object - Optimal Start

Menu Selection: Insert > Object

Inserts an Optimal Start Object into the site.

Note: On the Configure screen, click the button to select the object from the Select Item dialog box and
then select the desired attribute for the Cooling Setpoint, Heating Setpoint, and Zone Temperature.

• Insert Object - Pulse Meter

Menu Selection: Insert > Object

Inserts a Pulse Meter Object into the site.
• Insert Object - Schedule

Menu Selection: Insert > Object

Inserts a Schedule Object into the site.

See Scheduling.
• Insert Object - Signal Select

Menu Selection: Insert > Object

Inserts a Signal Select Object into the site.
• Insert Object - Solar Clock
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Menu Selection: Insert > Object

Inserts a Solar Clock Object into the site.

Insert Graphic Wizard
Menu Selection: Insert > Graphic

Inserts a graphic into the site. See the User Graphics Tool (UGT) section for more information on how to generate
graphics with the User Graphics Tool.

Insert Trend Study Wizard
Menu Selection: Insert > Trend Study

Inserts a trend study into the site.

Tip: With the Trend Study tab selected on the Configure Screen, select the or button to add or delete trend
items.

Tip: Select the Configuration tab on the Configure screen for further configuration.

See one of the following sections for more information:

• Trend Studies
• Trend Extensions

Create New User View Wizard
Menu Selection: Insert > User View

Inserts a user navigation view (also referred to as user view, user-defined navigation tree, and user-defined tree)
item into the All Items navigation tree. In online mode, the user view appears as a separate tab in addition to the All
Items navigation tree if the user has permission for the user view. In online and offline modes, the user view appears
in the User Views folder under the Site in the All Items tree.

Assign permissions to user views using the Security Administrator System in the online mode. You cannot assign
permissions to user views in the SCT.

See the User Views section for more information on user views.

Tip: On the Configure screen, click the Configuration tab for further configuration.

Create New Summary Definition Wizard
Menu Selection: Insert > Summary Definition

Inserts a Summary Definition into the system. The Summary Definition object is used by the Tailored Summary
feature. See the Summary Definition Object and the Tailored Summaries sections for more information on this object
and feature.

Restore Archive Wizard
Menu Selection: Tools > Database > Restore Backup

Restores a backup (archive) database that was created using the Tools > Database > Create Backup menu option
in the SCT.

The default path is:

• Windows XP OS: C:\Documents and Settings\All Users\Application Data\Johnson
Controls\MetasysIII\DatabaseFiles

• Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles).

Manage Archive Wizard
Menu Selection: Tools > Manage Archive

Uploads, downloads, upgrades devices or synchronizes databases. See Database Uploading, Downloading,
Upgrading Device and Synchronization for more information on the Load process in the SCT.
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Passthru Wizard
Modes: Available in online and offline modes only

Menu Selection: Tools > Field Device Tools

Accesses tools such as HVAC PRO, GX-9100, XTM Configurator, DX Commissioning, N2 Device Loader, and CCT.

Note: The Field Device Tools menu selection replaces the N2 Tools menu selection available at Release 2.0 and
earlier.

Tip: You must have N2 Tools and the SCT installed on the same PC that is running Passthru with HVAC PRO,
GX-9100, XTM Configurator, DX Commissioning, or N2 Device Loader passthru.

Tip: You must have CCT and the SCT installed on the same computer that is running the CCT passthru. To use
the CCT in Ethernet passthru mode, open CCT from the Tools > Field Device Tools > CCT (MSTP) menu
option.

Tip: The Passthru wizard does not always appear when you are connected to the NAE or ADS/ADX online if you
are already logged on to the site. The selected tool loads automatically after selecting it from the Tools menu.

Tip: On the Passthru Site Login screen of the wizard, enter your username and password as defined by your User
Profile. By default, your username and password should automatically appear. If desired, click Test Login to
check if your login parameters are valid to access the tools.

Security Copy Wizard
Menu Selection: Tools > Security Copy

Restores the security database. See the Security Copy section for more information.

Paste Item Wizard
Menu Selection: Edit > Copy, then Edit > Paste

Copies an item from the navigation tree such as an AV object, field device, or supervisory device and pastes it into
another location in the navigation tree in the SCT.

Tip: You can copy an item and paste it into another equivalent node in the navigation tree or you can copy an item
and paste it into the same node on the tree, but you must select a new name for the item. For example, you
can copy an NAE from Site 1 and paste it into Site 1 or Site 2 if you rename it NAE 2. You cannot paste an
NAE under an NAE, field device, or object (you must paste it under a Site).

Tip: When you copy and paste a field point, the new point automatically receives a unique hardware address.

Tip: You can copy a user view and paste it into another site. For example, use this option when adding an ADS to
a site that previously had an engine defined as Site Director.
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Extensions
Extensions add features, such as trending, alarming, and totalization, to an item.

Click one of the following for more information on extensions:

• For information on searching for extensions, see the Global Search section.
• For information on commanding extensions, see Commanding Extensions.
• For more information on managing extension attributes as part of a tailored summary, see the Summary Definition

Object section.

Alarm Extensions
Alarm extensions monitor an attribute of an object and send alarms using the Alarm and Event Management feature.
There are two types of alarm extensions, Analog Alarm and Multistate Alarm. Use the Analog Alarm extension to
monitor attributes with real values. Use the Multistate Alarm extension to monitor attributes with True or False, or
Multistate data types.

For general information on Metasys system objects, see the Object Help section.

Alarm Extensions Concepts
Analog Alarm Extension
The Analog Alarm extension adds the alarming capability for attributes with real values, such as the Present Value
of an Analog Input Object. This extension detects an alarm based on up to four limits and can be configured to report
that alarm. It also sets the Alarm State attribute of the object to which it is added. The Analog Alarm Extension is
also used in conjunction with the Graphic Setting Preferences which are used to establish color choices for alarm
conditions in graphics.

For example, you can configure the Analog Alarm extension to issue an alarm if the temperature in a room falls
below 15.6˚C (60˚F).

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Analog Alarm extension, see Analog Alarm Attributes.

Multistate Alarm Extension
The Multistate Alarm extension adds the alarming capability for an attribute with True or False, or Multistate data
types, such as the Present Value of a Binary Input Object.

The Multistate Alarm extension detects the alarm with respect to a difference from a defined normal state and sets
the Alarm State attribute of the object to which it is added. In addition, you can configure the Multistate Alarm extension
to report alarms and True or False and/or Multistate events.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Multistate Alarm extension, see Multistate Alarm Attributes.

Normal State
Normal state occurs when the alarm extension is in an acceptable, expected condition, as indicated by the attribute
point to which it is added.

Warning State
Warning state occurs when the analog alarm extension transitions from Normal into the high or low warning conditions.

Alarm State
Alarm state occurs when the extension transitions into the high alarm, low alarm, or unreliable conditions.

AO/BO Feedback
The Alarm extensions provide feedback in points to prevent the detection of alarm conditions that are really false
alarms. For the Analog Alarm Extension, this feedback is done through the configuration of the Setpoint Reference
attribute. For the Multistate Alarm Extension, this feedback is done through the configuration of the Command
Reference attribute. When you reference other attributes using the Setpoint Reference or Command Reference
attributes, the alarm analysis works differently.
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Analog Points:

For example, add an Analog Alarm extension to an Analog Input Object (zone temperature). Define the Present
Value of the Analog Input Object as the Input Reference and define the Present Value of an Analog Output Object
(setpoint) as the Setpoint Reference of the Analog Alarm extension.

If you edit the Setpoint ( Present Value attribute of the Analog Output Object), the Warning Reference attribute of
the Analog Alarm extension of the Zone Temperature Analog Input Object changes to the same value. The Reference
Delay Time of the Analog Alarm extension resets at this same time, preventing a false alarm condition from being
detected.

Binary or Multistate Points:

For example, add a Multistate Alarm extension to a Binary Input Object or Multistate Input Object. Define the Present
Value of a Binary Input (fan status) or Multistate Input as the Input Reference, and define the Present Value of a
Binary Output Object (command state) or Multistate Output Object as the Command Reference of the Multistate
Alarm extension.

If you edit the Command State ( Present Value attribute of the Binary Output Object or Multistate Output Object),
the Normal State attribute of the Multistate Alarm extension of the Fan Status Binary Input Object or Multistate Input
Object changes to the same value. The Reference Delay Time of the Multistate Alarm extension resets at this same
time, preventing a false alarm condition from being detected.

Delay Timer Interaction
There are two timers used to delay the analysis or reporting of an alarm. These timers are used to allow normal
functions to occur before an object’s behavior appears abnormal and generates an alarm. The first timer is theAlarm
State: Reference Delay Timer, which allows a preset amount of time to pass between commanding an object and
making sure that the commanded object has obeyed the command before considering an alarm condition to be
present. The second timer is the Alarm State: Report Delay Timer, which prevents the analysis of an object’s
condition until the preset time has passed after that object has appeared to obey a command.

The length of the reference delay time is a combination of the reference delay time and the report delay time settings.
If you change the warning reference, both delays go active and if the reference delay time is greater than or equal
to the report delay time, then the total delay is the sum of both timer settings; however, if the reference delay time
is less than the report delay time, then the delay is equal to the report delay time setting.

The delay timers of the alarm extensions interact as follows:

Note: If no Warning Limits are defined, the Reference Delay Time and Reference Delay Timer Active attributes do
not apply.
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Figure 11: Delay Timer Interaction

User ActionNameCallout

Commands the Warning reference to change, moves the setpoint and the corresponding
High and Low warnings.

Warning reference
command

1

Interval starts when the Warning Reference changes.Reference Delay Timer2

Starts if high of low warning is exceeded.Report Delay Interval3

Input reference is analyzed for alarm conditions.After Report Delay
Interval

4

See the Multistate Alarm Delays Examples section.

See the Analog Alarm Attributes and the Multistate Alarm Attributes for more information.

Multistate Alarm Delays Examples
When attaching alarm extensions to Binary objects, we recommend that the Alarm extension be attached to a Binary
Input Object (BI). When the Binary Output Object (BO) is commanded On, the command is seen by the command
reference of the BI. This triggers the Alarm State: Reference Delay Timer and changes the Normal state of the
associated BI. The Reference: Input of the BI should change to match the new Normal state during the time set by
the Alarm State: Reference Delay Timer. If it does not, the BI immediately goes into Alarm upon expiration of the
Reference Delay Time. If the BI Reference: Input does change to match the new Normal state, then the Alarm State:
Report Delay Timer starts. The Alarm State: Report Delay time does not delay delivery of a previously generated
report. It delays the analysis of the BI object for an alarm condition until the Report Delay time has passed. Once
the Report Delay time passes, the BI is analyzed for Alarm conditions.

For example, with a BO controlling a fan and a BI with an Alarm Extension set using the BO as an Input reference,
two possible conditions are affected by the Alarm State delay timers:

1. Fan On and Operating Normally - In the following figure, a fan has been commanded On and is operating
normally. In this case, when the BO commands the Fan On, the Normal State of the BI changes to On and the
Reference Delay Time starts. Within the interval set by the Reference Delay Time, the Input Reference of the
BI changes to On and the Report Delay time starts. After the Reference Delay Time and Report Delay Time have
passed, the BI is analyzed for Alarm conditions.
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Figure 12: Fan On and Operating Normally

User ActionNameCallout

Fan is commanded On from BO.BO Command1

BI Normal State switches to On.BI Normal State2

Reference Delay Timer interval starts when BI Normal State switches to On.Alarm State: Reference
Delay Timer

3

BI Input switches On during the Reference Delay Timer interval.BI Input4

Report Delay interval starts when BI Input switches to On.Alarm State: Report
Delay

5

BI is analyzed for alarm conditions.After Report Delay
Interval

6

2. Fan Is Commanded On but the Fan Is Not Working - In the following figure, the fan is commanded on but
does not turn on due to a problem. In this case, the BO commands the Fan On, the Normal State of the BI
changes to On, and the Reference Delay Time starts. However, the Input Reference of the BI never changes to
On because the Fan does not turn on. Therefore, the Alarm State: Report Delay Timer never starts. After the
interval set by the Alarm State: Reference Delay Time, the BI goes into an Alarm condition.
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Figure 13: Fan Is Commanded On but the Fan Is Not Working

User ActionNameCallout

Fan is commanded On from BO.BO Command1

BI Normal State switches to On.BI Normal State2

Reference Delay Timer interval starts when BI Normal State switches to On.Alarm State: Reference
Delay Timer

3

BI Input does not turn On during the Reference Delay Timer interval due to problem with
Fan.

BI Input4

After Reference Delay Timer interval. BI is analyzed and goes into Alarm.Alarm State: Report
Delay

5

Analog Alarm Attributes
The Analog Alarm Extension contains attributes common to Metasys system objects. For details, see Common
Object Attributes.

The following table lists the attributes specific to the Analog Alarm extension. The list of Attribute names are displayed
in the Focus Window of the Site Management Portal view of the Alarm Extension. Click the attribute name in the
table for a description of the attribute.

Note: Also, see Status.

Table 32: Analog Alarm Attributes
SCT
Configuration
Attribute4

Global
Modify3

Tailored
Summary
Pick2

Values/
Options/Range

Initial
Value

Notes1Data TypeAttribute Name

Reference

YYName

YDescription

YObject Type
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Table 32: Analog Alarm Attributes
SCT
Configuration
Attribute4

Global
Modify3

Tailored
Summary
Pick2

Values/
Options/Range

Initial
Value

Notes1Data TypeAttribute Name

Normal,

Low Warning,

High Warning,

Low Alarm,

High Alarm

NormalDROne value from a
set

Present Value

Real valueInput

Alarm State

YYTrueCWTrue or FalseEvent Enable

YFalseCWTrue or FalseReport Delay Active

YYY0–65,535 seconds0CWNumberReport Delay

Status

YEnabled

See Reliability.

Uses Reliability
(Set 503).

Input
Unreliable

MultistateReliability

Time

DateDate

Error Log

Alarm/Warning Thresholds

YYYNullAttribute
Reference

High Alarm Limit

CNWReal valueHigh Alarm Limit

NullNumberCooling Setpoint

NullNumberHeating Setpoint

YYYCNWReal valueLow Alarm Limit

Single Setpoint Mode

YYYNullCWAttribute
Reference

Setpoint Reference

YYY0.00CWReal valueWarning Reference

Heating/Cooling Setpoint Mode

YYYNullAttribute
Reference

Cooling Setpoint
Reference

YYYNullAttribute
Reference

Heating Setpoint
Reference

YYYNullAttribute
Reference

Occupancy
Reference

YYYSet redirected to
Unoccupied_Set
Attribute

1CWMultistateUnoccupied State

Engineering Values
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Table 32: Analog Alarm Attributes
SCT
Configuration
Attribute4

Global
Modify3

Tailored
Summary
Pick2

Values/
Options/Range

Initial
Value

Notes1Data TypeAttribute Name

Item Reference

Version

CAttribute
reference

Input Reference

YYYPositive value0.00CWReal valueDifferential

YYYPositive valueCNWReal valueHigh Warning Offset

YYYPositive valueCNWReal valueLow Warning Offset

YYFalseTrue or FalseReference Delay
Timer Active

YYY0–65,535 seconds0CWNumberReference Delay
Time

Alarm Setup

YAck not pending,
Ack pending

FalseTrue or FalseAlarm Ack Pending

YYYAck not required,
Ack required

FalseCWTrue or FalseAlarm Ack Required

YTimeAlarm Time

YDateAlarm Date

YYYSee Event Priority.70CWNumberAlarm Priority

YAck not pending,
Ack pending

FalseTrue or FalseWarningAckPending

YYYAck not required,
Ack required

FalseCWTrue or FalseWarning Ack
Required

YTimeWarning Time

YDateWarning Date

YYYSee Event Priority.120CWNumberWarning Priority

YAck not pending,
Ack pending

FalseTrue or FalseNormal Ack Pending

YYYAck not required,
Ack required

FalseCWTrue or FalseNormal Ack Required

YTimeNormal Time

YDateNormal Date

YYYSee Event Priority.200CWNumberNormal Priority

YYYCNWTextAlarm Message Text

YYObject Type =
Graphic

NullCNWObject ReferenceGraphic

YYMaximum 256
characters

CWTextGraphic Alias

BACnet

Object Name

89Metasys System Online Help PDF



Table 32: Analog Alarm Attributes
SCT
Configuration
Attribute4

Global
Modify3

Tailored
Summary
Pick2

Values/
Options/Range

Initial
Value

Notes1Data TypeAttribute Name

YUsername is BACnet
Object Name

YObject Identifier

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable
2 Y - Can be used in the Tailored Summary User View. See the Defining User Views with Summary Definitions section for

information about recommended groupings of Summary Definitions in a Tailored Summary.
3 Y - Can be mass edited from a Tailored Summary or Global Search Results.
4 Y - Viewable in SCT Alarm Extension Focus Window.

Analog Alarm Extension Attribute Details

Alarm Ack Pending
Indicates whether an event concerning a transition into the Alarm state is waiting for acknowledgement.

Back to Analog Alarm Attributes.

Alarm Ack Required
Indicates whether a transition into the Alarm state creates a message that requires acknowledgement.

Back to Analog Alarm Attributes.

Alarm Date
Indicates the last date this extension transitioned into the Alarm state. Each time this transition occurs, a message
is created and this date is updated.

Back to Analog Alarm Attributes.

Alarm Message Text
Indicates the text you assigned to give further information in the event of an alarm. Only status changes to an alarm
state add the alarm message text reference.

Back to Analog Alarm Attributes.

Alarm Priority
Indicates the priority assigned to the Alarm state.

Back to Analog Alarm Attributes.

Alarm Time
Indicates the last time this extension transitioned into the Alarm state. Each time this transition occurs, a message
is created and this time is updated.

Back to Analog Alarm Attributes.

Cooling Setpoint
Indicates the actual monitored Cooling Setpoint value based on the Setpoint Reference mapping. You can either
define the Cooling Setpoint and High Alarm Limit or the Setpoint Reference.

Back to Analog Alarm Attributes.

Cooling Setpoint Reference
When specified, indicates the Above Setpoint limit. You must define both the Cooling Setpoint Reference and
Heating Setpoint Reference, or leave both blank. If the Cooling Setpoint Reference is defined, the High Warning
Offset is added to the Cooling Setpoint Reference value to calculate the High Warning Limit.
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The Heating and Cooling Setpoint References are typically mapped to the Actual Heating and Cooling Setpoints
created for all FEC based VAV and Terminal Unit control applications. The High and Low Warning Offsets are added
to these references to calculate the High and Low Warning Limits. These reference points are used in conjunction
with the Room Control Module Graphics Symbol to provide indication of above and below setpoint conditions.

Back to Analog Alarm Attributes.

Date
Indicates the date of the last change in the Present Value or Reliability reported by this extension.

Back to Analog Alarm Attributes.

Differential
Indicates that if the Input is in High Alarm Limit (or HighWarning Offset), it must decrease by a value of the Differential
before the extension returns to High Warning (or Normal). If the Input is in Low Alarm Limit (or LowWarning Offset),
it must increase by the Differential before the extension returns to Low Warning (or Normal). This Differential prevents
nuisance alarms due to a value that is cycling near an alarm (or warning) limit.

Back to Analog Alarm Attributes.

Event Enable
Determines if an alarm condition is reported back to the event viewer and if alarm pop-ups are created.

Back to Analog Alarm Attributes.

Graphic
Indicates the graphic associated with the extension.

Note: Do not set the Graphic attribute for an alarm extension to an aliased graphic. Aliased graphics do not display
properly when displayed from the Alarms Window or Event Viewer.

Back to Analog Alarm Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this extension
or the controller containing this extension.

Back to Analog Alarm Attributes.

Heating Setpoint
The Heating and Cooling Setpoint References are typically mapped to the Actual Heating and Cooling Setpoints
created for all FEC based VAV and Terminal Unit control applications. The High and Low Warning Offsets are added
to these references to calculate the High and Low Warning Limits. These reference points are used in conjunction
with the Room Control Module Graphics Symbol to provide indication of above and below setpoint conditions.

You can either define the Cooling Setpoint and Low Alarm Limit or the Setpoint Reference.

Back to Analog Alarm Attributes.

Heating Setpoint Reference
Indicates the value of the Below Setpoint limit. You must define both the Cooling Setpoint Reference and Heating
Setpoint Reference, or leave both blank.

Back to Analog Alarm Attributes.

High Alarm Limit
Specifies the actual High Alarm Limit. If blank, the limit is not used.

Back to Analog Alarm Attributes.
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High Warning Offset
Indicates the value added to the Warning Reference or Setpoint Reference variable to determine the actual High
Warning Limit. If blank, the offset is not used and warning analysis is disabled. Both the High Warning Offset and
Low Warning Offset must be defined, or both must be blank.

Back to Analog Alarm Attributes.

Input
Indicates the last value received from the Input Reference.

Back to Analog Alarm Attributes.

Input Reference
Specifies the object and attribute monitored by this alarm extension. The reliability of the Input Reference is monitored
and sets the Reliability attribute of this extension. It also can be reported in an alarm message.

Back to Analog Alarm Attributes.

Low Alarm Limit
Specifies the actual Low Alarm Limit. If blank, the limit is not used.

Back to Analog Alarm Attributes.

Low Warning Offset
Indicates the value subtracted from the Warning Reference or Setpoint Reference variable to determine the actual
Low Warning limit. If blank, the offset is not used and warning analysis is disabled. Both the High Warning Offset
and Low Warning Offset must be defined, or both must be blank.

Back to Analog Alarm Attributes.

Normal Ack Pending
Indicates if an event in transition to the Normal state is awaiting acknowledgement.

Back to Analog Alarm Attributes.

Normal Ack Required
Indicates whether a transition into the Normal state creates a message that requires acknowledgement.

Back to Analog Alarm Attributes.

Normal Date
Indicates the last date this extension transitioned into the Normal state.

Back to Analog Alarm Attributes.

Normal Priority
Indicates the priority assigned to the Normal state.

Back to Analog Alarm Attributes.

Normal Time
Indicates the last time this extension transitioned into the Normal state. Each time this transition occurs, a message
is created and this time is updated.

Back to Analog Alarm Attributes.

Occupancy Reference
When mapped, provides a specific graphic preference color indication of a zone’s occupancy status. When the
reference is in an unoccupied state, warning states are not displayed; only alarm states are displayed. This capability
is typically used in conjunction with the Room Status symbol graphic floorplan.

Back to Analog Alarm Attributes.
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Present Value
Represents the current value of the extension.

Back to Analog Alarm Attributes.

Reference Delay Time
Specifies the amount of time that the Input has to move within the Warning Limits after a Warning Reference change
before the object reports the warning. The Normal state is reported until the Reference Delay Time expires. If the
Reference Delay Time is changed, any current timer is cancelled and reset to the new Reference Delay Time.

Back to Analog Alarm Attributes.

Reference Delay Timer Active
The Reference Delay Timer Active is True while the alarm extension waits for the Input value to respond to the
Warning Reference change.

Back to Analog Alarm Attributes.

Reliability
Indicates the Reliability of the Analog Alarm extension. Reliability changes due to communication errors between
the Analog Alarm extension and the Input Reference or Setpoint Reference. When unreliable due to communication
problems, any further execution of the main logic of the Analog Alarm extension is cancelled and no report is issued.

The reliability also indicates when the Input or Setpoint Reference becomes unreliable. When reliability changes
due to the Input being unreliable, an event is issued if reporting is enabled. The exception is Comm Loss reliability,
which results in the same behavior as the communication problems described above.

If a Setpoint Reference, High Alarm Limit, and Low Alarm Limit are defined, and the setpoint’s value is outside of
the range defined by the limits, then the Analog Alarm becomes unreliable and an event message is generated (if
reporting is enabled).

Back to Analog Alarm Attributes.

Report Delay
Indicates the number of seconds that the extension waits before generating a warning or alarm after the Input value
moves outside of the Heating or Cooling Setpoint or warning limit. This condition applies only to changes from the
Normal state. After this time, the Input value is reevaluated. If the value is still outside the limit, a report generates.
The Report Delay does not apply to High or Low Alarms, which are reported immediately.

Back to Analog Alarm Attributes.

Report Delay Active
The Report Delay Active is True while the alarm extension waits for the alarm or warning to stabilize.

Back to Analog Alarm Attributes.

Setpoint Reference
A Setpoint Reference or Warning Reference is established for controllers that only provide a Single Setpoint value.
The value established by either one of these references is used in conjunction with the High Warning Offset and
Low Warning Offset to establish the High Alarm Warning Limit and Low Alarm Warning Limit.

Back to Analog Alarm Attributes.

Status
The Common Object Attributes section details this attribute. Of the three states that can be assumed by this attribute
(Disabled, Unreliable, and Normal), two of these, Disabled and Normal, are managed outside the scope of this
extension. A complete list of relevant states follows (listed in hierarchical order from highest to lowest):

• Disabled: Enabled attribute value is False.
• Unreliable: Reliability attribute is not reliable.
• Normal: Expected operating condition.
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Back to Analog Alarm Attributes.

Time
Indicates the time of the last change in the Present Value or Reliability reported by this extension.

Back to Analog Alarm Attributes.

Unoccupied State
Indicates the value of the Occupancy Reference (if defined), that is considered the Unoccupied State.

Back to Analog Alarm Attributes.

Unoccupied State Set
Indicates the set used to select the Unoccupied State. If Occupancy Reference is defined, the Unoccupied State
Set uses the same value.

Back to Analog Alarm Attributes.

Warning Ack Pending
Indicates whether an event concerning a transition into the Warning state is waiting for acknowledgement.

Back to Analog Alarm Attributes.

Warning Ack Required
Indicates whether a transition into the Warning state creates a message that requires acknowledgement.

Back to Analog Alarm Attributes.

Warning Date
Indicates the last date this extension transitioned into the Warning state. Each time this transition occurs, a message
is created and this date is updated.

Back to Analog Alarm Attributes.

Warning Priority
Indicates the priority assigned to the Warning state.

Back to Analog Alarm Attributes.

Warning Reference
A Setpoint Reference or Warning Reference is established for controllers that only provide a Single Setpoint value.
The value established by either one of these references is used in conjunction with the High Warning Offset and
Low Warning Offset to establish the High and Low Warning limits.

Back to Analog Alarm Attributes.

Warning Time
Indicates the last time this extension transitioned into the Warning state. Each time this transition occurs, a message
is created and this time is updated.

Back to Analog Alarm Attributes.

Analog Alarm Extension Examples
The Analog Alarm extension adds the alarming capability for attributes with real values, such as the Present Value
of an Analog Input Object. This extension detects an alarm in two different modes: the Single Setpoint method, or
the Cooling/Heating Setpoint Method.

Single Setpoint Mode
The Single Setpoint Mode uses up to four configurable limits to report an alarm. This method also sets the Alarm
State attribute of the object to which it is added. You can configure Single Setpoint Mode using either a mapped
setpoint reference or a fixed number set in the warning reference. For example, you can configure the Analog Alarm
extension to issue an alarm if the temperature in a room falls below 15.6˚C (60˚F).
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The Analog Alarm Object determines its new alarm state based upon receipt of a change. The new alarm state is
based on the:

• Newly reported value and reliability
• Current alarm state (present value)
• Differential
• Defined alarm and warning limits.

Once you set the High and Low Alarm Limits, the High Warning Limit is calculated by adding the High Warning
Offset to the Cooling Setpoint Reference Value. The Low Warning Limit is calculated by subtracting the Low
Warning Offset from the Heating Setpoint Reference Value.

• Value reported by the Setpoint Reference (if defined) written to Warning Reference Value
• Delay Timer Active
• Reference Delay Timer Active

Figure 14: Single Setpoint Mode

Figure 14 shows the Present Value of the Analog Alarm as it changes.

The Delay Time period begins when the Warning Reference changes. The Input Value is not calculated during this
time. The Input is normal at the end of the Reference Delay Time, so the Present Value stays normal.

The Report Delay period begins when the Present Value transitions to any state from the Normal state, or the value
of the Command Reference changes. Transitions to and from states other than Normal are reported immediately.
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Cooling/Heating Setpoint Mode
Using the Cooling/Heating Setpoint Mode, the object calculates up to seven different statuses based on the Cooling
Setpoint Reference and the Heating Setpoint Reference. You can also define an optional Occupancy Reference to
suppress the status of the extension and display an unoccupied status indication color unless there is a high or low
alarm.

Figure 15: Cooling/Heating Setpoint Mode

Figure 15 shows the Present Value of the Analog Alarm as it changes.

The Delay Time period starts when the Cooling Setpoint Reference or Heating Setpoint Reference value changes.
Since at the end of the Reference Delay Time the Input is in Low Warning state, the Present Value is in a Low
Warning state.

The Report Delay period starts when the Present Value transitions to any Alarm or Warning state from a Normal,
Above Setpoint or Below Setpoint state, or if the value of the Command Reference changes. All other State Transitions
are reported immediately.

Multistate Alarm Attributes
The Multistate Alarm Extension contains attributes common to Metasys system objects. For details, see the Common
Object Attributes.

The following table lists the attributes specific to the Multistate Alarm extension. Click the attribute name in the table
for a description of the attribute.
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Note: Also, see Status.

Table 33: Multistate Alarm Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Ack not pending, Ack pendingFalseTrue or FalseAlarm Ack Pending

Ack not required, Ack requiredFalseCWTrue or FalseAlarm Ack Required

DateAlarm Date

CNWTextAlarm Message Text

See Event Priority.70CWNumberAlarm Priority

TimeAlarm Time

CWTextAlarm Values

FalseTrue or FalseCapture Changes

See Command Reference.CWAttribute ReferenceCommand Reference

DateDate

TrueCWTrue or FalseEvent Enable

Object Type = GraphicNullCNWObject ReferenceGraphic

Maximum 256 charactersCWTextGraphic Alias

Derived from Input Reference, the object
to which the Multistate Alarm extension
has been attached.

Real valueInput

CAttribute ReferenceInput Reference

Ack not pending, Ack pendingFalseTrue or FalseNormal Ack Pending

Ack not required, Ack requiredFalseCWTrue or FalseNormal Ack Required

DateNormal Date

See Event Priority.200CWNumberNormal Priority

TimeNormal Time

Derived from Input Reference, the object
to which the Multistate Alarm extension
has been attached.

State 0CWOne type from setNormal State

Normal, Alarm, HoldNormalDROne value from a
set

Present Value

0–65,535 seconds0CWNumberReference Delay Time

FalseTrue or FalseReference Delay Timer Active

See Reliability. Uses Reliability (Set 503).Input UnreliableMultistateReliability

0–65,535 seconds0CWNumberReport Delay

FalseCWTrue or FalseReport Delay Active

TimeAlarm Time

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable

Multistate Alarm Extension Attribute Details

Alarm Ack Pending
Indicates whether an event concerning a transition into the Alarm state is waiting to be acknowledged.

Back to Multistate Alarm Attributes.
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Alarm Ack Required
Indicates whether a transition into the Alarm state creates a message that requires acknowledgement.

Back to Multistate Alarm Attributes.

Alarm Date
Indicates the last date this extension transitioned into the Alarm state. Each time this transition occurs, a message
is created and this date is updated.

Back to Multistate Alarm Attributes.

Alarm Message Text
Indicates the text you assigned to give further information in the event of an alarm. Only status changes to an alarm
state cause the alarm message text reference to be added.

Back to Multistate Alarm Attributes.

Alarm Priority
Indicates the priority assigned to the Alarm state.

Back to Multistate Alarm Attributes.

Alarm Time
Indicates the last time this extension transitioned into the Alarm state. Each time this transition occurs, a message
is created and this time is updated.

Back to Multistate Alarm Attributes.

Alarm Values
Associates an alarm state with a specific priority and text. Multiple states can be defined for each alarm, but each
state must be unique and no state can be set to the current alarm extension normal state. The text and priority are
customizable. Alarm Priority and Alarm Message Text are used as defaults when custom text and priority values
are not defined.

Back to Multistate Alarm Attributes.

Capture Changes
If True, this attribute forces an event notification to be generated for each change of the object input state. If the
input goes from one alarm state to another alarm state or back to normal, an event notification is generated.

Back to Multistate Alarm Attributes.

Command Reference
If specified, the value of this referenced attribute is treated as the normal state by the alarm extension. The normal
state then follows a feedback value.

For example, define the Present Value of a Binary Input Object (fan status) as the Input Reference and define the
Present Value of a Binary Output Object (command state) as the Command Reference.

For more information on how this attribute works with regard to AO/BO point feedback, see AO/BO Feedback.

Back to Multistate Alarm Attributes.

Date
Indicates the date of the last reported condition.

Back to Multistate Alarm Attributes.

Event Enable
Indicates that this value must be True for the extension to report a warning message.

Back to Multistate Alarm Attributes.
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Graphic
Indicates the graphic associated with the extension.

Note: Do not set the Graphic attribute for an alarm extension to an aliased graphic. Aliased graphics do not display
properly when displayed from the Alarms Window or Event Viewer.

Back to Multistate Alarm Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this extension
or the controller containing this extension.

Back to Multistate Alarm Attributes.

Input
Indicates the multistate value processed for alarms by the extension as defined by the Input Reference. The value
of the Input is compared to the Normal State.

Back to Multistate Alarm Attributes.

Input Reference
Specifies the object and attribute monitored by this alarm extension. The last value received from Input Reference
is written to the Input attribute. The reliability of the Input Reference is monitored and sets the Reliability attribute
to this extension. It is also reported in an alarm message.

Back to Multistate Alarm Attributes.

Normal Ack Pending
Indicates whether an event concerning a transition into the Alarm state is waiting to be acknowledged.

Back to Multistate Alarm Attributes.

Normal Ack Required
Indicates whether a transition into the Normal state creates a message that requires acknowledgement.

Back to Multistate Alarm Attributes.

Normal Date
Indicates the last date this extension transitioned into the Normal state. Each time this transition occurs, a message
is created and this date is updated.

Back to Multistate Alarm Attributes.

Normal Priority
Indicates the priority assigned to the Normal state.

Back to Multistate Alarm Attributes.

Normal Time
Indicates the last time this extension transitioned into the Normal state. Each time this transition occurs a message
is created and this time is updated.

Back to Multistate Alarm Attributes.

Normal State
Indicates the attribute value to which the Input is compared. If the Input value is different from the Normal State, an
alarm state occurs.

Back to Multistate Alarm Attributes.

Present Value
Represents the current value of the extension.

Back to Multistate Alarm Attributes.

99Metasys System Online Help PDF



Reference Delay Time
Specifies the feedback delay in seconds. The purpose of the Reference Delay Time is to allow time for equipment
to start or stop before the status is compared to the command.

When a Binary Output Object (BO) (supply fan command) is commanded On, the Normal State for the associated
Binary Input Object (BI) (supply fan status) alarm extension is also On. After the Reference Delay Time, the current
state of the BI is compared to the Normal State. If the BI is still Off, an alarm is detected. The Reference Delay Time
is also used when the BO is commanded Off.

Back to Multistate Alarm Attributes.

Reference Delay Timer Active
The Reference Delay Timer Active is True while the alarm extension waits for the equipment to start or stop.

Back to Multistate Alarm Attributes.

Reliability
Indicates the reliability of the Multistate Alarm extension. Reliability changes due to communication errors between
the Multistate Alarm extension and the Input Reference or Command Reference. When unreliable due to
communication problems, any further execution of the main logic of the Multistate Alarm extension is cancelled and
no report is issued.

The reliability also indicates when the Input or Command Reference becomes unreliable. When reliability changes
due to the Input being unreliable, an event is issued if reporting is enabled. The only exception is Comm Loss
reliability, which results in the same behavior as the communication problems described above.

Back to Multistate Alarm Attributes.

Report Delay
Indicates the delay between detecting an alarm and actually reporting the alarm. The purpose of this delay is to
make sure that the alarm is stable. If a status feedback device is fluctuating, an alarm is detected numerous times.
The alarm must be True at the end of the duration of the Report Delay before the alarm is reported.

Back to Multistate Alarm Attributes.

Report Delay Active
The Report Delay Active is True while the alarm extension waits for the alarm to stabilize.

Back to Multistate Alarm Attributes.

Status
The Common Object Attributes section details this attribute. A list of relevant states follows (listed in hierarchical
order from highest to lowest):

• Disabled: Enabled attribute value is False.
• Unreliable: Reliability attribute is not reliable.
• Normal: Expected operating condition.

Back to Multistate Alarm Attributes.

Time
Indicates the time of the last reported condition.

Back to Multistate Alarm Attributes.

Alarm Commands
The following table lists the commands supported by the Alarm Extensions. Click the command name for a description
of the command.
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Table 34: Alarm Extension Commands
ParametersCommand Name

Cancel Delay Time

Alarm Commands

Alarm Command Details

Cancel Delay Time
Cancels Reference Delay Timer if active. Cancelling the delay time on an Alarm extension causes a warning if the
value is in this state.

Back to Alarm Commands.

Cancel Report Delay
Cancels the Report Delay Timer if active. Cancelling the report delay time on an Alarm extension causes a warning
or alarm if the value is in this state.

Back to Alarm Commands.

Totalization Extensions
Totalization Extensions track an attribute over time. There are three types of totalization extensions:

• Analog Totalization - Tracks and records analog attribute values over time.
• Event Totalization - Tracks the number of events/transitions of an attribute over time.
• Runtime Totalization - Tracks the total time that an attribute resides in a specified state.

For general information on Metasys system objects, see the Object Help section.

For more information on managing time in the Metasys system, see the NAE and ADS commissioning documents
listed in the Related Documentation table in the Welcome section.

Totalization Extensions Concepts
Analog Totalization
The Analog Totalization extension tracks and records the usage of any consumable monitored through an analog
attribute. Some examples of consumables include electricity, gas, steam, and chilled water.

These three essential parameters determine the Analog Totalization extension’s mode of operation:

• the Input Reference to be monitored
• the Timebase on which the computation is based
• the Low CutOff Value that the input must meet or exceed

Use the Analog Totalization extension to determine the usage of the given consumable. For example, you can
determine the amount of gas or steam used by the facility for a given month. Also, use Analog Totalization to
determine how many kilowatt/hours were used in a week or to totalize a calculated value (for instance, degree days).

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Analog Totalization extension, see Analog Totalization Attributes.

Event Totalization
The Event Totalization extension tracks the number of binary events or pulses over time, meaning it counts the
number of transitions that occur at an input reference. Unlike other types of totalization, event totalization increases
the value each time the event occurs, instead of calculating the value once each minute.
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These three essential parameters determine the Event Totalization extension’s mode of operation:

• the Input Reference to be monitored
• the types of Transitions or events to be recorded
• the Value Per Pulse (event) to be recorded

You can use this extension to determine the number of changes in an input value, which may be helpful in maintaining
and monitoring equipment. For example, use Event Totalization to determine how many times a motor started, how
often a sensor was in alarm, or how many cars entered a parking lot.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Event Totalization extension, see Event Totalization Attributes.

Runtime Totalization
The Runtime Totalization extension tracks the time that elapses while a designated input, such as a binary or
multistate value, matches a specified state.

These two essential parameters determine the Runtime Totalization extension’s mode of operation:

• the Input Reference being monitored
• the Reference (state) that identifies active runtime

Use this extension to track the amount of time that a piece of equipment, such as a fan or a pump, is operational.
This extension also determines the amount of time a point is in alarm or the runtime of fixed loads (such as lighting)
for energy consumption and tenant billing.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Runtime Totalization extension, see Runtime Totalization Attributes.

Analog Totalization Attributes
The Analog Totalization extension contains attributes common to Metasys system objects. For details, see Common
Object Attributes.

The following table lists the attributes specific to the Analog Totalization extension. Click the attribute name in the
table for a description of the attribute.

Note: Also, see Status.

Table 35: Analog Totalization Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Uses Display Precision (Set 0)10thsCWOne value from a setDisplay Precision

See Executing.

Active

Totalize Limit

Inactive

ActiveOne type from a setExecuting

CAttribute referenceInput Reference

CWReal valueLow CutOff Value

CDRWReal valuePresent Value

Uses Reliability (Set 503)ReliableOne value from a setReliability

False

True

FalseWTrue or FalseReset2

DateReset Date

TimeReset Time
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Table 35: Analog Totalization Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

False

True

FalseCWTrue or FalseRollover

0–4,294,967,2950NumberRollover Count

Minimum Value > 01.0CWReal valueScale Factor

Seconds

Minutes

Hours

HoursCWOne type from a setTimebase

Limit > 0CNWReal valueTotalize Limit

IP

SI

CWOne value from a setUnits

Real valueValue Before Reset

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable
2 This attribute does not appear in a view, but may be scheduled, trended, and so on.

Analog Totalization Extension Attribute Details

Display Precision
Indicates the rounded position and the number of decimal places to display for this extension.

Back to Analog Totalization Attributes.

Executing
Reflects the status of this extension.

• Active: The extension is calculating and has not reached the Totalize Limit.
• Totalize Limit: The extension has reached the limit and has stopped calculating because Rollover is set to

False.
• Inactive: The extension is unreliable or disabled and is not calculating.

Back to Analog Totalization Attributes.

Input Reference
Specifies the object and attribute monitored by this extension. If this attribute is unreliable or falls below the Low
CutOff Value, totalization is temporarily suspended.

Back to Analog Totalization Attributes.

Low CutOff Value
Defines a minimum input value: Values beneath this minimum input value are not totalized. This attribute eliminates
sensor errors associated with the low readings of flow sensors.

Back to Analog Totalization Attributes.

Present Value
Represents the current value of the extension.

Back to Analog Totalization Attributes.

Reliability
Represents the reliability of the Present Value. If the Input Reference becomes unreliable, the totalization extension
monitoring the input becomes unreliable.

Back to Analog Totalization Attributes.
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Reset
Forces the extension into a reset condition. (Terminates any ongoing calculations, restores the Present Value to
initial state, and, for each triggerable attribute, forces a COV report.)

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Analog Totalization Attributes.

Reset Date
Represents the date of the last Reset condition of the extension.

Back to Analog Totalization Attributes.

Reset Time
Represents the time of the last Reset condition of the extension.

Back to Analog Totalization Attributes.

Rollover
Defines the special action the totalization extension must take when the Present Value reaches the Totalize Limit
value. If the Rollover attribute is set to False, the Analog Totalization extension ceases further operation when the
Present Value equals or exceeds the Totalize Limit value. If it is True, it resets the present Value to 0.0 and resumes
a new cycle of totalization.

Back to Analog Totalization Attributes.

Rollover Count
When the Rollover attribute is True, this value increases each time Present Value reaches a value equal to or
greater than the Totalize Limit value.

Back to Analog Totalization Attributes.

Scale Factor
Indicates the value used to scale the totalized value to either a larger or smaller value than otherwise results.

Back to Analog Totalization Attributes.

Status
The Common Object Attributes section details this attribute. Of the three states that can be assumed by this attribute
(Disabled, Unreliable, and Normal), two of these, Disabled and Normal, are managed outside the scope of this
extension. A complete list of relevant states follows (listed in hierarchical order from highest to lowest):

• Disabled: Enabled attribute value is False.
• Unreliable: Reliability attribute is not reliable.
• Normal: Expected operating condition.

Back to Analog Totalization Attributes.

Timebase
Establishes the time frame on which the calculated totalization value is based.

Back to Analog Totalization Attributes.

Totalize Limit
Defines a threshold value that the Present Value must meet or exceed for the totalization extension to take special
action. When the Rollover attribute is set to False, the totalization process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the totalization process starts over.

Back to Analog Totalization Attributes.

Units
Indicates the measurement units of this extension.

Back to Analog Totalization Attributes.
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Value Before Reset
Indicates the value of the Present Value at the time of the last reset operation.

Back to Analog Totalization Attributes.

Event Totalization Attributes
The Event Totalization extension contains attributes common to Metasys system objects. For details, see Common
Object Attributes.

The following table lists the attributes specific to the Event Totalization extension. Click the attribute name in the
table for a description of the attribute.

Note: Also, see Status.

Table 36: Event Totalization Attributes
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

Uses Display Precision (Set 0).1sCWOne value from a setDisplay Precision

See Executing.

Active

Totalize Limit

Inactive

ActiveOne type from a setExecuting

CAttribute referenceInput Reference

CDRWReal valuePresent Value

States Text attribute identifies the
enumeration set for this attribute.

State 0CWOne type from a setReference

Uses Reliability (Set 503).ReliableOne value from a setReliability

False

True

FalseWTrue or FalseReset2

DateReset Date

TimeReset Time

False

True

FalseCWTrue or FalseRollover

0–4,294,967,2950RWNumberRollover Count

Minimum Value > 01.0CWReal valueScale Factor

See States Text.StatesCWOne type from a setStates Text2

CNWReal valueTotalize Limit

Entering State

Count All

Entering StateCWOne type from a setTransition

IP

SI

CWOne value from a setUnits

Real valueValue Before Reset

1CWReal valueValue Per Pulse

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable
2 This attribute does not appear in a view, but may be scheduled, trended, and so on.
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Event Totalization Extension Attribute Details

Display Precision
Indicates the rounded position and the number of decimal places to display for this extension.

Back to Event Totalization Attributes.

Executing
Reflects the status of this extension.

• Active: The extension is calculating and has not reached the Totalize Limit.
• Totalize Limit: The extension has reached the limit and has stopped calculating because Rollover is set to

False.
• Inactive: The extension is unreliable or disabled and is not calculating.

Back to Event Totalization Attributes.

Input Reference
Specifies the object and attribute totalized by this extension. If this attribute is unreliable, totalization is temporarily
suspended.

Back to Event Totalization Attributes.

Present Value
Represents the current value of the extension.

Back to Event Totalization Attributes.

Reference
Defines the value that is processed for totalization by the extension as defined in the Input Reference attribute.

Back to Event Totalization Attributes.

Reliability
Represents the reliability of the Present Value. If the Input Reference becomes unreliable, the totalization extension
monitoring the input becomes unreliable.

Back to Event Totalization Attributes.

Reset
Forces the extension into a reset condition. (Terminates any ongoing calculations, restores the Present Value to
initial state, and for each triggerable attribute, forces a Change of Value (COV) report.)

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Event Totalization Attributes.

Reset Date
Represents the date of the last Reset condition of the extension.

Back to Event Totalization Attributes.

Reset Time
Represents the time of the last Reset condition of the extension.

Back to Event Totalization Attributes.

Rollover
Defines the special action the totalization extension takes when the Present Value reaches the Totalize Limit value.
If the Rollover attribute is set to False, the Runtime Totalization extension ceases further operation when the Present
Value equals or exceeds the Totalize Limit value. If the attribute is set to True, it resets the present Value to 0.0 and
resume a new cycle of totalization.

Back to Event Totalization Attributes.
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Rollover Count
When the Rollover attribute is True, this value increases each time Present Value reaches a value equal to or
greater than the Totalize Limit value.

Back to Event Totalization Attributes.

Scale Factor
Indicates the value used to scale the totalized value to either a larger or smaller value than would otherwise result.

Back to Event Totalization Attributes.

States Text
Indicates the displayed strings for the Present Value.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Event Totalization Attributes.

Status
The Common Object Attributes section details this attribute. A list of relevant states follows (listed in hierarchical
order from highest to lowest):

• Disabled: Enabled attribute value is False.
• Unreliable: Reliability attribute is not reliable.
• Normal: Expected operating condition.

Back to Event Totalization Attributes.

Totalize Limit
Defines a threshold value the Present Value must meet or exceed for the totalization extension to take special
action. When the Rollover attribute is set to False, the totalization process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the totalization process starts over.

Back to Event Totalization Attributes.

Transition
Describes the behaviors of the transitions to be counted. If the value is 0, it counts the transition of entering a given
reference. If the value is 1, it counts all state transitions.

Back to Event Totalization Attributes.

Units
Indicates the measurement units of this extension.

Back to Event Totalization Attributes.

Value Before Reset
Indicates the value of the Present Value at the time of the last reset operation.

Back to Event Totalization Attributes.

Value Per Pulse
Indicates the unit value of the Input Reference for pulse totalization. For the event totalization, the value is 1.

Back to Event Totalization Attributes.

Runtime Totalization Attributes
The Runtime Totalization extension contains attributes common to Metasys system objects. For details, see Common
Object Attributes.

The following table lists the attributes specific to the Runtime Totalization extension. Click the attribute name in the
table for a description of the attribute.

Note: Also, see Status.
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Table 37: Runtime Totalization Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Uses Display Precision (Set 0).10thsCWOne value from a setDisplay Precision

See Executing.

Active

Totalize Limit

Inactive

ActiveOne type from a setExecuting

CAttribute referenceInput Reference

CDRWReal valuePresent Value

States Text attribute identifies the
enumeration set for this attribute.

State 1CWOne type from a setReference

Uses Reliability (Set 503).ReliableOne value from a setReliability

False

True

FalseWTrue or FalseReset 2

DateReset Date

TimeReset Time

False

True

FalseCWTrue or FalseRollover

0–4,294,967,2950RWNumberRollover Count

See States Text.StatesCWOne type from a setStates Text2

Seconds, minutes, hours, daysHoursCWOne type from a setTimebase

HoursCNWReal valueTotalize Limit

No UnitsCWOne value from a setUnits

Real valueValue Before Reset

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable
2 This attribute does not appear in a view, but may be scheduled, trended, and so on.

Runtime Totalization Extension Attribute Details

Display Precision
Indicates the rounded position and the number of decimal places to display for this extension.

Back to Runtime Totalization Attributes.

Executing
Indicates the execution status of this extension:

• Active: The extension is calculating and has not reached the Totalize Limit.
• Totalize Limit: The extension has reached the limit and has stopped calculating because Rollover is set to

False.
• Inactive: The extension is unreliable or disabled and is not calculating.

Back to Runtime Totalization Attributes.

Input Reference
Specifies the object and attribute totalized by this extension. If this attribute is unreliable or changes from the
Reference (state) to another state, totalization is temporarily suspended.

Back to Runtime Totalization Attributes.
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Present Value
Represents the current value of the extension.

Back to Runtime Totalization Attributes.

Reference
Defines the value that is processed for totalization by the extension as defined in the Input Reference attribute.

Back to Runtime Totalization Attributes.

Reliability
Represents the reliability of the Present Value. If the Input Reference becomes unreliable, the totalization extension
monitoring the input becomes unreliable.

Back to Runtime Totalization Attributes.

Reset
Forces the extension into a reset condition. (Terminates any ongoing calculations, restores the Present Value to
initial state, and for each triggerable attribute, forces a COV report.)

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Runtime Totalization Attributes.

Reset Date
Represents the date of the last Reset condition of the extension.

Back to Runtime Totalization Attributes.

Reset Time
Represents the time of the last Reset condition of the extension.

Back to Runtime Totalization Attributes.

Rollover
Defines the special action the totalization extension takes when the Present Value reaches the Totalize Limit value.
If the Rollover attribute is set to False, the Runtime Totalization extension ceases further operation when the Present
Value equals or exceeds the Totalize Limit value. If it is True, it resets the present Value to 0.0 and resumes a new
cycle of totalization.

Back to Runtime Totalization Attributes.

Rollover Count
When the Rollover attribute is True, this value is incremented each time the Present Value reaches a value equal
to or greater than the Totalize Limit value.

Back to Runtime Totalization Attributes.

States Text
Indicates the displayed strings for the Present Value.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Runtime Totalization Attributes.

Status
The Common Object Attributes section details this attribute. A list of relevant states follows (listed in hierarchical
order from highest to lowest):

• Disabled: Enabled attribute value is False.
• Unreliable: Reliability attribute is not reliable.
• Normal: Expected operating condition.

Back to Runtime Totalization Attributes.
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Timebase
Establishes the time frame on which the calculated totalization value is based.

Back to Runtime Totalization Attributes.

Totalize Limit
Defines a threshold value the Present Valuemust meet or exceed for the totalization extension to take special action.
When the Rollover attribute is set to False, the totalization process ceases further operation. When it is set to True,
Present Value is cleared to 0, and the totalization process starts over.

Back to Runtime Totalization Attributes.

Units
Indicates the measurement units of the Present Value, Totalize Limit, and Value Before Reset attributes.

Back to Runtime Totalization Attributes.

Value Before Reset
Indicates the value of the Present Value at the time of the last reset operation.

Back to Runtime Totalization Attributes.

Totalization Commands
The following table lists the commands supported by the Totalization Extensions. Click the command name for a
description of the command.

Table 38: Totalization Commands
ParametersCommand Name

Disable

Enable

Reset

Access level = SuperviseReset Rollover

Totalization Extension Command Details

Disable
Locks out all outputs and prevents functionality of the Totalization extension and temporarily suspends totalization.

Back to Totalization Commands.

Enable
Forces a Reset on the Totalization extension and returns it to normal operation.

Back to Totalization Commands.

Reset
Terminates any ongoing calculations, restores the present value to its initial state, creates a reset date and time
stamp; and for each triggerable attribute, forces a COV report.

Back to Totalization Commands.

Reset Rollover
Resets the Rollover Count attribute.

Back to Totalization Commands.
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Trend Extensions
The Trend Extension monitors and records the changes in the behavior of an individual attribute over time, thereby
assisting you with diagnosing various system-wide behavioral characteristics. The Trend extension collects sample
values at timed intervals or only upon changes in the given value. Trend data is still collected if the object is unreliable.
The Trend extension continues to log data using the previous value preceded by ???.

For example, use a Trend extension to collect data from the Analog Input object of a controller on the N2 Bus, which
reports information such as outdoor air temperature or room air temperature.

Trend extensions are different from Trend Studies because Trend Studies query both the ADS and Engine for
historical data (Trend Extensions query only the Engine).

Note: Although multiple trend extensions can be added to an object on an NxE, these extensions will be combined
as a single trend if sent to an Historical Data Repository. This may not yield the expected result. To use
multiple trends on a single object in an Historical Data Repository, create duplicate AV or BV objects that
map to the point in question, then create a new trend on the parallel AV or BV.

For trend performance information, refer to the Metasys System Extended Architecture Overview Technical Bulletin
(LIT-1201527).

For general information on Metasys system objects, see the Object Help section.

Trend Extensions Concepts
Views
There are three views in the Trend Extension: Chart View, Table View, and Definition View.

Table 39: Views
DescriptionViewButton
Allows you to view trend data in a chart format.Chart View

Allows you to view trend data in a table format.Table View

Allows you to view the trend extension attributes.Definition View

Trend Extension Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data. You can zoom,
unzoom, and pan within the Chart view. You can also specify the X-axis and Y-axis ranges.
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Table 40: Chart View
DescriptionNameButton
When initially displayed, the Trend Extension view shows the data samples
currently in the local trend buffer. Click the Update button to retrieve and
display new data samples (for example, any trend buffer data later than the
currently displayed samples). The Update button adds the new samples to
the display without removing the old samples.

Note: Gaps may appear in the data if the trend buffer has rolled over since
the last update. If you wish to clear the Trend Extension view and
re-display only those samples currently in the trend buffer, use the
Refresh Current Tab menu option (right-click or Action menu).

Update

Toggles the mouse behavior for the chart between zoom mode and normal
mode.

While in zoom mode:

• drag the mouse over an area of the chart to zoom in on that area.
• click Zoom to exit zoom mode and restore the mouse to normal mode.
• left-click to zoom out one level.

When you exit zoom mode, the chart remains at the current zoom level. Use
the Restore button to fully zoom out on the chart.

Note: You cannot pan while the mouse is in zoom mode.

Note: You can also zoom and unzoom in normal mode by using the Shift
key and the mouse. To zoom, hold the Shift key down while dragging
the mouse across the chart. To zoom out one level, left-click the mouse
while holding the shift key down.

Zoom(Zoom)

(Normal)

Allows you to return to an unzoomed view and switches the mouse back to
normal mode if the chart’s zoom mode is active.

Restore

Allows you to pan the view of the chart vertically or horizontally by dragging
the mouse across a zoomed chart. Panning is not available for unzoomed
charts or when zoom mode is active. To pan left or right, drag the mouse over
the X-axis. To pan up or down, drag the mouse over the Y-axis.

Pan

Displays the data using lines and point markers. This is the default.Points Line

Displays the data using an area chart.Area

Displays the data using a bar chart.

Note: Only use the bar chart when the number of data samples can
reasonably be expected to display as bars. If too many data samples
exist when you click this option, the display becomes unstable and
fails to properly update the screen. To recover, select any other display
option.

Bar

Displays the data using markers, with no lines.Points

Displays the data using lines, with no markers.Line

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click in the panel to
display the menu.
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Table 41: Chart View Right-Click Menu
DescriptionMenu Item
Opens the Select a Color dialog box and allows you to configure the background color.Background Color

Allows you to select what type of gridlines to appear on the chart. You can choose: None, X and
Y, X Only, and Y Only.

Gridlines

Allows you to select what type of chart to display. You can choose: Points Line, Area, Bar, Points,
and Line.

Chart Type

Trend Extension Table View
The Table view of the Trend extension allows you to view the trend’s data samples in a table format. You can copy
the trend data to the clipboard for pasting into other applications such as Microsoft Excel.

Table 42: Table View
DescriptionNameButton/Field
When initially displayed, the Trend Extension view shows
the data samples currently in the local trend buffer. Click
the Update button to retrieve and display new data
samples (for example, any trend buffer data later than the
currently displayed samples). The Update button adds
the new samples to the display without removing the old
samples.

Note: Gaps may appear in the data if the trend buffer
has rolled over since the last update. If you wish
to clear the Trend Extension view and re-display
only those samples currently in the trend buffer,
use the Refresh Current tab menu option
(right-click or Action menu).

Update

Allows you to copy selected trend data to the system
clipboard for pasting into other applications such as
Microsoft Excel.

You can also use Ctrl + C to copy data.

Copy to Clipboard

Trend Extension Definition View
The Definition view of the Trend Extension allows you to view and edit the attributes of the trend extension object.
For more information on the Definition view attributes, see the Trend Extension Attributes section.

Trend Buffer
The trend buffers reside in the NAE and store the trend samples for the NAE. The number of samples stored in each
individual trend buffer is user-configurable (see Trend Extension Attributes). When the buffer gets full, you can
choose to have the new trends overwrite the old ones or to have the trending stop. Whether the trends are overwritten
or trending stops, you can configure the system to issue an alarm when the buffer gets full. You can also configure
to transfer samples to a configured ADS.

Table 43 shows the relationship between the buffer size and the sample interval. Determine the sample interval, in
seconds, by converting minutes to seconds. Determine the buffer size by examining the interval, in seconds, against
the desired time period size to retain data.

Table 43: Buffer Size and Sample Interval Relationship
Buffer for Previous Time PeriodInterval

(Sec.)
Interval
(Min.) 3 Days2 Days1 Day16 Hrs.8 Hrs.4 Hrs.2 Hrs.1 Hr.

4,3202,8801,44096048024012060601

2,1601,44072048024012060301202
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Table 43: Buffer Size and Sample Interval Relationship
Buffer for Previous Time PeriodInterval

(Sec.)
Interval
(Min.) 3 Days2 Days1 Day16 Hrs.8 Hrs.4 Hrs.2 Hrs.1 Hr.

864576288192964824123005

43228814496482412660010

288192966432168490015

144964832168421,80030

7248241684213,60060

36241284217,200120

Trend Sampling
Trend sampling for the trend buffer occurs periodically (samples taken after a set time expires) if you set the Sample
Interval to a value higher than zero. To sample based on COV reporting of the object, set the Sample Interval attribute
to zero. You can stop or start sampling manually (using the Enable or Disable command) or control the start and
stop with Interlocking a Trend Extension or scheduling (see Trend Scheduling). With interlocking, the trend samples
are taken when a defined event occurs. If you use the scheduling feature, trend samples are taken at certain times
on certain days.

Trend Extension Attributes
Alarm Extensions contains attributes common to Metasys system objects. For details, see CommonObject Attributes.

The following table lists the attributes specific to the Trend extension. Click the attribute name in the table for a
description of the attribute.

Table 44: Trend Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

False, False, FalseCWSeries of True or
False states

Acked Transitions

1–5,000144CNumberBuffer Size

Operational, Buffer FullOperationalOne state from a setBuffer State

CWReal valueClient COV Increment

Units = Seconds3,600CWNumberCOV Resubsc Interval

True, FalseCWSeries of True or
False states

Event Enable

Normal, FaultOne state from a setEvent State

Set of valuesEvent Time Stamps

CAttribute referenceInput Reference

FalseCWTrue or FalseIntrinsic Alarming Defined

0NumberLast Notify Record

FalseCWTrue or FalseLog Enable

Polled, COV, TriggerPolledOne type from a setLogging Type

Units = 100ths of a second60,000CWNumberLog Interval

1CWNumberNotification Class

Limited to Notification Class on the
same device.

CWObject referenceNotification Object Reference
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Table 44: Trend Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

130 (90% of Buffer
Size)

CWNumberNotify Threshold

EventsCWOne type from a setNotify Type

0–5,000

See Record Count.

0CDWNumberRecord Count

0NumberRecords Since Notify

FalseCWTrue or FalseRepository Enabled

0–604,800

Units = Seconds

See Sample Interval.

600CWNumberSample Interval

0–5,0000NumberSamples Not Sent to ADS

CWDate/TimeStart Time

Series of True or
False states

Status Flags

CWDate/TimeStop Time

See Stop When Full.FalseCWTrue or FalseStop When Full

NumberTotal Record Count

1–5,000130 (90% of Buffer
Size)

CWNumberTransfer Setpoint

CWTrue or FalseTrigger

1 C - Configurable, D - Default Attribute for Display, W - Writable

Trend Extension Attribute Details

Acked Transitions
Conveys three separate flags that each indicate if the most recent To Offnormal, To Fault, or To Normal event
transitions have been acknowledged (if the transition requires acknowledgement).

Back to Trend Extension Attributes.

Buffer Size
Specifies the maximum number of records the buffer may hold.

Back to Trend Extension Attributes.

Buffer State
Indicates whether the buffer is full or operational when the Stop When Full attribute is set to False.

Back to Trend Extension Attributes.

Client COV Increment
Specifies the increment used to determine that a change of value occurred (when this trend object collects data by
COV). If the referenced object and attribute support COV reporting, then this attribute may have a Null value. In this
case, the value of the trended object for COV increment is used. This value only applies to trended values of the
real value (floating point) type.

Back to Trend Extension Attributes.
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COV Resubsc Interval
Specifies the number of seconds between COV resubscriptions (when this trend object collects data by COV). This
attribute is only used when the trended object is a BACnet Integration point on the IP network. The Subscribe COV
requests specify twice during this interval for the actual subscription. The first subscription is issued when the trend
object begins operation or when enabled.

Back to Trend Extension Attributes.

Event Enable
Determines whether notifications are enabled for To Fault and To Normal events. A To Normal transition occurs
when the value of the Records Since Notify attribute is equal to or greater than the value of the Notify Threshold
attribute. A To Fault transition occurs when an attempted COV subscription fails. The To Normal transition must be
enabled and set by default. The Read and write methods ensure that this value cannot be set to False.

Back to Trend Extension Attributes.

Event State
Determines whether an active event state is associated with this extension. The value is set to Normal when there
is no intrinsic alarming defined for this object. If intrinsic alarming is enabled (Enable Intrinsic Alarms = True), then
this value is either Normal or Fault (problem occurred with the object subscribing for Change of Value [COV]s). This
attribute appears on the view when the site is defined as a BACnet site.

Back to Trend Extension Attributes.

Event Time Stamps
Conveys the times of the last event notifications for To Offnormal, To Fault, and To Normal events. Time stamps of
type Time or Date have FF if no event notification of that type has generated since the object was created.

Back to Trend Extension Attributes.

Input Reference
Defines the attribute of the object being sampled. This attribute is used for consistent references to an object or
attribute. The Input Reference and the name of the object and attribute you want to trend must match exactly.

Back to Trend Extension Attributes.

Intrinsic Alarming Defined
Enables (True) or disables (False) BACnet intrinsic alarming for this object. When disabled, writing to any of the
intrinsic alarming attributes returns a Write_Access_Denied error. When disabled, reading the intrinsic alarming
attributes returns the default value of each attribute.

Back to Trend Extension Attributes.

Last Notify Record
Indicates the sequence number associated with the most recently collected record whose collection triggered a
notification (that is, it caused the value of the Records Since Notify attribute to be equal to or greater than the value
of the Notify Threshold attribute). If no notification has occurred since logging began, the value of this attribute is
0.

Back to Trend Extension Attributes.

Log Enable
Indicates and controls whether (True) or not (False) logging is enabled.

Back to Trend Extension Attributes.

Logging Type
Specifies the method for which the referenced property is logged (Polled, Change of Value [COV] , or Trigger).

Back to Trend Extension Attributes.
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Log Interval
Specifies the periodic time in seconds for which the referenced property is logged.

Back to Trend Extension Attributes.

Notification Class
Specifies the notification class used for handling and generating event notifications for this object. Notification occurs
based on the value of the Records Since Notification attribute. The Notification Class attribute implicitly refers to a
Notification Class object that has a Notification Class property with the same value. If the class number references
a non-existent Notification object, no Notification occurs.

When the Notification Class attribute is written online, the Notification Object Reference is updated to the Object
Reference of the Notification Class object with that instance number, if found. If the Notification Class object for a
Johnson Controls® proprietary object is not found, the reference is left blank.

If both the Notification Object Reference and the Notification Class attributes are written simultaneously online (or
both are configured and downloaded), the Notification Class attribute value is set to the value that was written to
the Notification Object Reference, and the Notification Class value in the write message is ignored.

Back to Trend Extension Attributes.

Notification Object Reference
Specifies the Notification Class object used to route alarms for the object being configured (via tree selection). When
the Notification Object Reference is written, the value of the Notification Class attribute is updated to reflect the
referenced object’s instance number. The value of the Notification Object Reference attribute is restricted to Notification
Class objects on the same device as the alarming object. Validation only occurs during a write, not during a create
(the download does not fail).

Back to Trend Extension Attributes.

Notify Threshold
Indicates when notification occurs based on the value of the Records Since Notification attribute.

Back to Trend Extension Attributes.

Notify Type
Conveys if the notifications generated by the object are Events or Alarms. This attribute is required if the object
supports intrinsic reporting.

Back to Trend Extension Attributes.

Record Count
Represents the number of samples recorded since the creation of the trend extension or the last time the buffer was
cleared, when the Stop When Full attribute is set to True.

Represents the position of the next sample recorded, when the Stop When Full attribute is set to False.

A value of zero for this attribute deletes all records in the log buffer and resets Samples Not Sent to ADS and Total
Record Count to zero. If the buffer overflows, the Record Count resets to zero.

Back to Trend Extension Attributes.

Records Since Notify
Indicates the number of records collected since the last notification occurred or since logging began if no notification
occurred.

Back to Trend Extension Attributes.

Repository Enabled
Enables transferring of the trend sample data to the ADS/ADX when this attribute is set to True and the buffer fills
to the level specified by the Transfer Setpoint attribute.
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Note: If you create multiple trend extensions on a single point and send it to an Historical Data Repository, then
setting Repository Enabled to true will cause the Trend Viewer and/or Trend Study to display a combination
of 15 minute and 1 minute samples. If Repository enabled is set to False then the Trend viewer displays only
the data from the selected Trend Extension. To use multiple trends on a single object in an Historical Data
Repository, create duplicate AV or BV objects that map to the point in question, then create a new trend on
the parallel AV or BV.

Back to Trend Extension Attributes.

Sample Interval
Specifies the periodic time in seconds for which the referenced property is logged. If this attribute is zero, samples
are recorded using COV reporting.

Note: If you want to takes samples on a COV, set the value of this attribute to 0 seconds.

Note: Otherwise, configure the Sample Interval at 60 seconds or higher to prevent loss of trend data and reduction
in performance of the Engine and ADS/ADX devices that receive samples from the configured trend.

Back to Trend Extension Attributes.

Samples Not Sent to ADS
Represents the total number of samples requiring delivery to the ADS/ADX repository during the next transfer.

Back to Trend Extension Attributes.

Start Time
Specifies the time and date to enable logging when the Enable attribute is set to True. If the Start Time contains any
wildcard values, then the conditions to enable logging based on time are ignored. When the Trend object is inactive
due to the current time being outside of the Start Time or Stop Time, the Status attribute reflects this state (assuming
it is the highest priority status). If you define a Stop Time that is before the Start Time, the Trend object is disabled.

Back to Trend Extension Attributes.

Status Flags
Indicates the general status of the object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden from the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Trend Extension Attributes.

Stop Time
Specifies the time and date to disable logging. If the Stop Time contains any wildcard values, then the conditions to
disable logging based on time are ignored. Logging is disable if the Stop Time is prior to the Start Time. When the
Trend object is inactive due to the current time being outside of the Start Time or Stop Time, the Status attribute
reflects this state (assuming it is the highest priority status). A change in the active/inactive state due to the Start
Time/Stop Time value has no impact on the Enable attribute. If the Trend object was disabled due to the Stop Time,
the Trend object attempts to send the trend samples to the server. If you define a Stop Time that is before the Start
Time, the Trend object is disabled.

Back to Trend Extension Attributes.

Stop When Full
Specifies whether logging ceases when the buffer is full. When set to True, logging ceases and all accumulated
samples remain in the buffer.
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When set to False, logging continues. If the Repository Enabled attribute is set to False, the previously recorded
samples are overwritten. If the Repository Enabled attribute is set to True and the buffer fills to the level specified
by the Transfer Setpoint attribute, the previously recorded samples are sent to the ADS/ADX. The buffer must be
cleared for logging to continue.

Back to Trend Extension Attributes.

Total Record Count
Represents the total number of records collected by the Trend Extension since creation. When the value of Total
Record Count reaches its maximum possible value of 0XFFFFFFFF, the next value it takes is zero. Once this value
has wrapped to zero, its semantic value (the total number of records collected) is lost, but its use in generating
notifications remains.

Back to Trend Extension Attributes.

Transfer Setpoint
Represents the amount of buffer memory (in number of samples) that must fill before the trend extension requests
a transfer of the current samples to the ADS/ADX for permanent storage. The value cannot be greater than the
buffer size when Repository Enabled is true.

Back to Trend Extension Attributes.

Trigger
Causes the collection of data when changed from False to True, Enable is set to True, and the trend is within the
Start/Stop times. When data collection completes, this attribute resets to False. This attribute does not trigger Johnson
Controls COVs.

Back to Trend Extension Attributes.

Trend Extension Commands
The following table lists the commands supported by Trend Extensions. Click the command name for a description
of the command.

Table 45: Trend Extension Commands
ParametersCommand Name

Clear

Disable

Enable

Execute

Route

Trend Extension Command Details

Clear
Clears all samples in the buffer.

Back to Trend Extension Commands.

Disable
Stops collection of samples.

Back to Trend Extension Commands.

Enable
Resumes collection of samples.

Back to Trend Extension Commands.
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Execute
Takes a single sample.

Back to Trend Extension Commands.

Route
Routes all trends that have not been previously sent to the ADS/ADX, if defined.

Back to Trend Extension Commands.

Load Extensions
The Energy Management feature consists of two major components: one Demand Limiting/Load Rolling (DL/LR)
object, and one or more Load extensions. A Load extension is added to an output object (only one load extension
per object) to specify that the object should be controlled by Energy Management. Each Load extension object is
configured with the load (energy) rating of its output, and the attribute value or state to write to its output object when
the Load object is shed.

The DLLR object determines how much energy needs to be reduced, based on its configuration and the energy rate
from a meter, if the demand limiting strategy is defined. The DLLR object orders as many Loads as needed to shed
to reduce the energy usage by the required amount. The Loads can be on the same supervisory device as the DLLR
object, or on another supervisory device, but must be within the same site. Each shed Load writes its configured
Output Shed Command attribute value to the Present Value attribute of its output, which decreases energy usage.

For information on the features and operation of DLLR, refer to the DLLR Technical Bulletin (LIT-12011288).

The Demand Limiting/Load Rolling (DLLR) Object chapter contains information relevant to the DLLR Object.

Load Extension Attributes
There are three types of Load Extension objects: Binary, Multistate, and Analog. The following table describes the
attributes of these objects.

Table 46: Load Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Active Timer setNoneOne type from a setActive Timer

0NumberActual Shed Level

CNWObject ReferenceAlarm Reference for
Ineligibility

Comfort Override setInactiveCWOne type from a setComfort Override

Current Available Energy
Savings

Uses Display Precision (Set 0).10thsCWOne value from a
set

Display Precision

Synchronized to the output object’s
Display Precision.

CWOne value from a
set

Display Reference

1–65,5350WNumberDuty Window

Load Eligibility setOne type from a setEligibility

Normal, FaultOne state from a setEvent State

0NumberExpected Shed Level

CAttribute referenceInput Reference

DateLast Shed Date

TimeLast Shed Time

FalseWTrue or FalseLoad Locked
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Table 46: Load Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

1–1010CWNumberLoad Priority

CWArray of structuresLoad Rating

TrueWTrue or FalseLog Enable

1–65,535

Undefined = 65,535

Units = Minutes

15CNWNumberMaximum Shed Time

1–65,535

Units = Minutes

5CWNumberMinimum Release Time

1–65,535

Units = Minutes

5CWNumberMinimum Shed Time

Comfort Override Type setRelease
Immediately

CWOne type from a setOn Release

Set is specified by output’s States Text
attribute.

One type from a setOutput Shed Command

Uses BACnet Shed State set.InactiveOne state from a setPresent Value

Units setkWCWOne type from a setRate Units

Uses Reliability (Set 503).ReliableOne value from a
set

Reliability

1–65,5350WNumberRequested Shed Level

Shed Command setNoneWOne type from a setShed Command

1–65,5350WNumberShed Duration

Uses Shed Level Descriptions set.Shed All LoadArrayShed Level Descriptions

1–65,5351CWArrayShed Levels

Shed Status setReleasedOne type from a setShed Status

Load Ineligibility setOne type from a setShed Ineligibility

Shed Strategy set0CWOne type from a setShed Strategy

CWNumberTime Remaining

BACnet Date Time structureWStructureStart Time

In Alarm, Fault, Overridden, Out of
Service

False, False, False,
False

Series of True or
False values

Status Flags

IP

SI

CWOne value from a
set

Units

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

Load Extension Attribute Details

Active Timer
Indicates which Load timer is in effect: Minimum Shed, Maximum Shed, Minimum Release, or None. The Time
Remaining attribute indicates how much time remains for the active timer.

Back to Load Extension Attributes.
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Actual Shed Level
Indicates the level of power shed when a shed request is active. When the Present Value attribute value is Shed
Compliant, the Actual Shed Level equals the value of the Shed Levels array element; otherwise, it equals zero (0).

Back to Load Extension Attributes.

Alarm Reference for Ineligibility
Prevents the Load from being shed if the reference is in alarm. This is an optional reference to an object that can
be set to any object, including the output object. For example, if the referenced object is a room temperature sensor,
and the object goes into alarm (a room becomes too warm), it prevents the supply fan (the Load object) from being
shed. If the Load object is already shed when the referenced object goes into alarm, the shed expires as it would
normally but cannot be shed again until the referenced object exits the alarm state.

Back to Load Extension Attributes.

Comfort Override
Configures the Comfort Override command behavior for this load. From time to time, you may need to override a
load to turn on lights in a normally empty conference room or provide more airflow to a zone. The Comfort Override
command is meant for this purpose. You can issue this command directly from DLLR’s Load Summary to release
loads if they are shed, and prevent them from being shed. The load cannot be shed again until the Release Comfort
Override is issued.

This attribute can be set to the following values:

• Inactive - No comfort override is in effect.
• Override And Release Immediately - Comfort overrides the Load immediately and prevents it from being shed.

If the Load is currently shed, the output write is immediately released.
• Override But Release After Timer Expires - Comfort overrides the Load immediately and prevents it from

being shed. If the Load is currently shed, the output write is released after the Load’s Minimum Shed Time
expires. If the Minimum Shed Time has already expired when the command is issued, the output write is
immediately released.

This attribute is synchronized to the Comfort Override/Release Comfort commands.

Back to Load Extension Attributes.

Current Available Energy Savings
Indicates how much energy would be saved if the Load were shed now.

Back to Load Extension Attributes.

Display Precision
Indicates the rounded position and the number of decimal places to display for this extension.

Back to Load Extension Attributes.

Display Reference
Indicates the current display precision of the load’s output object.

Back to Load Extension Attributes.

Duty Window
Indicates the time window for determining shed compliance.

Back to Load Extension Attributes.

Eligibility
Indicates to DLLR whether the Load can be shed and identifies for which strategy or strategies (DL, LR, or both) it
can be shed.

Back to Load Extension Attributes.
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Event State
Determines whether an active event state is associated with this extension. The value is set to Normal when there
is no intrinsic alarming defined for this object. If intrinsic alarming is enabled (Enable Intrinsic Alarms = True), then
this value is either Normal or Fault (problem occurred with the object subscribing for COVs). This attribute appears
on the view when the site is defined as a BACnet site.

Back to Load Extension Attributes.

Expected Shed Level
Indicates the level of power that the Load object expects to shed when a shed request is active or pending. When
the Present Value attribute value is Shed Request Pending or Shed Compliant, the Expected Shed Level equals
the value of the Shed Levels array element; otherwise, it equals zero (0).

Back to Load Extension Attributes.

Input Reference
Specifies the object and attribute monitored by this extension. The reliability of the Input Reference is monitored and
sets the Reliability attribute of this extension.

Back to Load Extension Attributes.

Last Shed Date
Indicates the date on which the Load was last shed (since download).

Back to Load Extension Attributes.

Last Shed Time
Indicates the time at which the load was last shed (since download).

Back to Load Extension Attributes.

Load Locked
Specifies whether the Load is locked. A Load that is locked while released cannot be shed until the Load lock is
released. A Load that is locked while shed remains shed until the Load lock is released. This attribute is synchronized
with the Lock/Unlock commands.

Back to Load Extension Attributes.

Load Priority
Indicates how critical the Load’s output is and determines the order in which loads are shed. You can define up to
10 load priorities: Priority 1 through Priority 10. Loads at Priority 10 are first to shed; loads at Priority 1 are the last
to shed. The configured Load Priority is shown with the load on the DLLR object’s Load Summary. The shedding
order is from top to bottom as listed in the Load Summary when the Load Priority column is sorted with the lowest
priority loads listed first.

Note: Even though the capacity for 10 priority levels is provided, you can implement fewer than 10 levels; for
example, Priority 1 through Priority 4, with Priority 4 loads shed first, and Priority 1 loads shed last.

Back to Load Extension Attributes.

Load Rating
Defines how much energy is saved when the Load is shed. This attribute specifies the information that DLLR needs
to control the load. This includes a Shed to value, the value to which DLLR commands the output when the load is
shed. Also required is at least one Shed from/Energy Savings pair, which indicates the amount of energy that
would be saved when the output is commanded from the Shed From value to the Shed To value. For binary outputs,
only one Shed From/Energy Savings pair is needed, since it can have only two possible states (Shed To and Shed
From). For multistate and analog output objects, there can be multiple Shed From/Energy Savings pairs, since they
can have many possible values, and differing amounts of energy might be saved depending on the value the output
had when the shed occurred. The option for adding multiple load ratings helps improve the accuracy of the shed
process.
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Note: Enter Energy Savings amounts in decreasing order, with the highest amount listed first. Enter the same Shed
to value in all rows.

Consider an example of a fan that should be shed to 60%. The first Shed from entry is 100%, because the most
energy would be saved when shedding from this state. The second Shed from entry is 90%, the third entry is 80%,
and so on. The entries might look like this:

Figure 16: Define Load Rating

Also, consider an example of a three-speed fan that can have the following states: High, Medium, Low, and Off. The
operator decides to set the fan to Low when the Load is shed. In this case, the first Shed from entry is High because
the most energy would be saved when shedding from this state. The second Shed from entry is Medium. A Shed
from entry for Off is not required because no energy is saved by shedding from Off to Low. The entries might look
like this:

Table 47: Load Rating Entries
Energy SavingsShed ToShed From
5.0 kWLowHigh

3.2 kWLowMedium

Back to Load Extension Attributes.

Log Enable
Indicates whether the Load object responds to shed requests.

Back to Load Extension Attributes.

Maximum Shed Time
Specifies the maximum number of minutes that a load can be shed before it is automatically released. If the Maximum
Shed Time value is not defined, the default value of 65,535 is used. The range is 0 to 65,535 minutes. It is possible
for the Load to be released before this time. A Load does not remain shed longer than the maximum shed time
unless the load has been locked shed.

Back to Load Extension Attributes.
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Minimum Release Time
Specifies the minimum number of minutes that a load must be released from shed before it can be shed again.
Although DLLR does not shed a load before this time expires, a load can be manually shed before this value expires.

Back to Load Extension Attributes.

Minimum Shed Time
Specifies the minimum number of minutes that a load must be shed before it can be automatically released. A load
can be manually released before this value expires.

Back to Load Extension Attributes.

On Release
Specifies how soon the Load should be released when a Release Load command is issued or when the Shed
command attribute is set to Release. If this attribute is set to Release Immediately, the load releases immediately
even if its Minimum Shed Timer is active. If this attribute is set to Release After Timer Expires, the load remains
shed until the Minimum Shed Time expires. If a release is issued but the Load remains shed until the Minimum Shed
Time expires, the Load’s Shed Status attribute indicates this using one of the following states. The state that is used
depends on whether the Load was shed for demand limiting or load rolling.

• Shed For DL - Release Issued
• Shed For LR - Release Issued

Back to Load Extension Attributes.

Output Shed Command
The state that is written to the output’s Present Value attribute when the Load is shed. DLLR does not shed the Load
if the output’s Present Value equals the Output Shed Command value, as no energy would be saved.

Back to Load Extension Attributes.

Present Value
Indicates the current Load shedding state of the Load object.

Back to Load Extension Attributes.

Rate Units
Specifies the energy units used for the Load Rating Energy Savings display.

Back to Load Extension Attributes.

Reliability
Represents the reliability of the Present Value. If the Input Reference goes unreliable, the extension monitoring the
input goes unreliable.

Back to Load Extension Attributes.

Requested Shed Level
Controls the desired level of Load shedding for one shed. Specifying a value greater than the value configured in
the Shed Levels attribute sheds to the Shed Levels value. Specifying a value less than the value configured in the
Shed Levels attribute (such as zero) cancels a shed.

The DLLR object writes this attribute to one, and sheds the Load object. Once the shed completes, the Load object
resets this value to zero.

If the Load object sheds via a non BACnet method, such as the Shed command, the Load sets this attribute to one,
and returns it to zero after the shed completes.

Back to Load Extension Attributes.
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Shed Command
Indicates the current shed/release state of the Load. This attribute also offers the option of shedding or releasing a
Load.

• Release - Releases the Load. The On Release attribute determines when the Load is released. If the Load is
already released, there is no change.

• Shed - Immediately sheds a released Load regardless of its Minimum On Time. If the Load is already shed,
there is no change.

Back to Load Extension Attributes.

Shed Duration
Indicates the number of minutes to shed the Load. Writing this attribute to a value less than the current time minus
the Start Time attribute value cancels a shed.

The DLLR object sets this attribute to shed the load. After the shed completes, the Load sets it to zero.

If the Load object sheds via a non BACnet method, such as the Shed command or Shed Command attribute, it sets
this value to the Max Shed Time and returns it to zero when the shed completes. If no Max Shed Time is defined,
the Load sets this value to its maximum value (0xFFFF), which is the maximum number of minutes that a Load can
shed without being locked shed.

Back to Load Extension Attributes.

Shed Level Descriptions
Provides a description of the shed level supported by the Load object.

Back to Load Extension Attributes.

Shed Levels
Specifies the shed levels used for the Requested Shed Level attribute. Set this attribute to a value of one (1) for the
DLLR to automatically shed the Load. If this attribute is set to another value, the DLLR does not shed or release the
Load; although the Load can be shed and released manually or by another feature, and is automatically released
upon expiration of its Maximum Shed Time, unless the Load is locked shed.

Back to Load Extension Attributes.

Shed Status
Indicates if the Load is shed or released, and, if shed, which strategy was used to shed the Load (DL or LR).

Back to Load Extension Attributes.

Shed Ineligibility
Indicates whether a load is eligible to be shed at the current time, and, if ineligible, the cause of ineligibility.

Back to Load Extension Attributes.

Shed Strategy
Indicates which strategy is permitted to shed the Load (DL, LR, or both).

Back to Load Extension Attributes.

Time Remaining
Indicates how much longer a Load timer is in effect. The Active Timer attribute indicates which timer is in effect.

Back to Load Extension Attributes.

Start Time
Indicates the date and time that the Load sheds. Writing this attribute to a wildcard releases a shed load.

The DLLR object sets this attribute to shed the Load. Once the shed completes, the Load object sets the value to
date and time wildcards (NONE_FFFF).
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If the Load object sheds via a non BACnet method, such as the Shed command, it sets this attribute to the current
time, and returns it to NONE_FFFF after the shed completes.

Back to Load Extension Attributes.

Status Flags
Indicates the general status of the object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden from the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Load Extension Attributes.

Units
Indicates the measurement units of this extension.

Back to Load Extension Attributes.

Load Commanding
Objects with a Load extension and intended for use with the DLLR feature permit the following operator or scheduled
commands.

Table 48: Commands Available to Load Objects
DescriptionParametersCommand
Sheds the load immediately. The output is written at priority 13
(LR) if the load’s Shed Strategy is set to Load Rolling Only.
Otherwise, it is written at priority 11 (DL). When this command is
issued, the output is commanded regardless of whether DLLR is
in Shed or Monitor Only mode.

Type 1

Percent, Level, or Amount

Value

New shed value

Shed

Releases the load, which releases the command at the priority at
which it was previously written by the shed command (11 or 13).
The On Release attribute defined in the Load object determines
whether the release occurs immediately when the command is
issued, or waits for the Minimum Shed timer to expire.

NoneRelease Load

Releases a shed load that is resulting in occupant discomfort. This
command releases the shed and prevents a future shed until the
Release Comfort Override command is issued. You can either
select to release the load immediately when the command is
issued, or only after the Minimum Shed Timer expires. The default
if no parameter is selected is to release the load immediately.

Release Immediately

Release After Timer Expires

Comfort Override

Releases the Comfort Override command and allows the load to
be shed.

NoneRelease Comfort
Override

Locks the load in its current shed or released state. The load
remains in this state until an Unlock (or Disable) command is
issued.

NoneLock

Releases a Lock command. If the load was locked shed and its
Maximum Shed Time expired, it now releases.

NoneUnlock
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Table 48: Commands Available to Load Objects
DescriptionParametersCommand
Disables the load, which causes it to release its output command
immediately if it is shed, and clears any Lock or Comfort Override
commands that have been issued. While disabled, the load is not
eligible to be shed.

NoneDisable

Enables the load, which permits it to be controlled by DLLR.NoneEnable

1 Select only the Level command and use the default value of 1. The Percent and Amount command options are intended for
future use.

Load Command Interactions
Table 49 illustrates command interactions that pertain to Load objects.

Table 49: Load Command Interactions
ExplanationLoad Command Not

Allowed
Load Command(s)
Currently in Effect

Load cannot be shed because it is already shed.ShedShed

Lock must be removed with Unlock command.Comfort Override

or

Release Load

Shed + Locked

Comfort Override must be released with Release Comfort Override
command.

ShedComfort Override

Lock must be removed with Unlock command.ShedReleased + Locked

Comfort Override must be released with Release Comfort Override
command.

Lock must be removed with Unlock command.

ShedReleased + Locked

and

Comfort Override

Resource File Extensions
The Resource File extension represents an actual physical file that gets placed in the System Configuration Tool’s
database or in the file system (Flash Memory of an Engine device). The resource file is an extension of another
object called the parent object. The parent objects for Resource File extensions can be field devices.

After completing the , the wizard prompts you to add a resource file extension. The resource file extension allows
you to define the attributes representing a defined resource file and allows you to populate resource files for
integrations. For example, you can define a set of resource files to support communication with field devices. The
resource file notifies its parent object when any changes are made to the extension.

Note: When using an HVAC PRO file as a resource file, be sure you use the long print file format because it provides
the Metasys system with more information than the short print file format. For example, the long print file
format imports the units of measure while the short print file format uses defaults based on the HVAC PRO
units setting. For analog values, it uses the default units of Deg F or Deg C (based on the Metric versus
English units specified in the PRN file). If you use a short form PRN file, the User Interface displays a warning
message stating that you have selected a short format PRN file that does not contain units information. The
warning message indicates that the Metasys system uses the default setting which may not match the original
units.

For more information on resource file extensions, see Resource File Attributes.

For general information on Metasys system objects, see the Object Help section.
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Resource File Attributes
Resource File Extensions contain attributes common to Metasys system objects. For details, see Common Object
Attributes.

The following table lists the attributes specific to the Resource File extension. Click the attribute name in the table
for a description of the attribute.

Table 50: Resource File Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

CDateDate

Category = File

See the File Name section.

CSet of related valuesFile Name

Units = Bytes0CNumberFile Size

Size = 80

Category = Default

CWTextInformation

CTimeTime

1 C - Configurable, N - Value Not Required, W - Writable

Resource File Extension Attribute Details

Date
Indicates the modified date as read from the selected file.

Back to Resource File Attributes.

File Name
The following table Indicates the file containing resources located within the host computer. Click the element name
in the table for a description of the element of the File Name attribute.

Table 51: Resource File - File Name Elements
Values/Options/RangeInitial ValueData TypeElement Name
Available in a future releaseFalseTrue or FalseExportable

Object referenceObject References

FalseTrue or FalseReferences

Size = 100

Category = Default

TextRelative Path

Back to Resource File Attributes.

File Name: Exportable
Indicates whether you can export the file. If True, you can export the file. If False, you cannot export the file. This
element of the File Name attribute is to be available in a future release.

Back to File Name.

Back to Resource File Attributes.

File Name: Object References
Indicates the object references embedded in the file.

Back to File Name.

Back to Resource File Attributes.

File Name: References
Indicates whether the file has references. If True, the file has references. If False, the file has no references.
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Back to File Name.

Back to Resource File Attributes.

File Name: Relative Path
Indicates the file name of the file relative to the directory containing the MOI file for the device.

Back to File Name.

Back to Resource File Attributes.

File Size
Indicates the size, in bytes, as read from the selected file.

Back to Resource File Attributes.

Information
Indicates the text you assigned to provide further information about the resource file. This attribute can be written
to from an integration server after reading the resource file.

Back to Resource File Attributes.

Time
Indicates the modified time as read from the selected file.

Back to Resource File Attributes.

Averaging Extensions
The Averaging extension calculates the average, minimum, and maximum value of an attribute over a specific interval
(for example, space temperature over 24 hours). The extension is able to sample Boolean, Integer, Unsigned,
Enumerated, or Float attribute value types for any extendable objects within a BACnet device.

For more information on averaging extensions, see Averaging Attributes.

For general information on Metasys system objects, see the Object Help section.

Averaging Attributes
Averaging Extensions contain attributes common to Metasys system objects. For details, see Common Object
Attributes.

The following table lists the attributes specific to the Averaging extension. Click the attribute name in the table for a
description of the attribute.

Table 52: Averaging Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Units of the extended attributeNaNDRReal valueAverage Value2

The only acceptable value that can be
written to this property is zero using
the Clear command.

WNumberAttempted Samples3

Any value > 0

Floating point value of the Display
Precision.

0.01CWReal valueCOV Increment4

Uses Display Precision (Set 0).100thsCWOne value from a
set

Display Precision4

CAttribute referenceInput Reference

Units of the extended attribute-INFRReal valueMaximum Value2
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Table 52: Averaging Extension Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

If Average Value, Minimum Value, or
Maximum Value is Unreliable, the
timestamp is Undefined.

Invalid DateTimeDate and timeMax Value Timestamp

Units of the extended attributeINFRReal valueMinimum Value2

If Average Value, Minimum Value, or
Maximum Value is Unreliable, the
timestamp is Undefined.

Invalid DateTimeDate and timeMin Value Timestamp

Set of related valuesObject Property Ref

Uses Reliability (Set 503).ReliableOne value from a
set

Reliability4

Units of the extended attributeNo UnitsOne value from a
set

Units4

NumberValid Samples

Units = seconds

Range: 900–360,060

3,600CWNumberWindow Interval3

Range: 2–20015CWNumberWindow Samples3

1 C - Configurable, D - Default Attribute for Display, W - Writable, R - Affected by Extension’s Reliability
2 If any of these variables are Unreliable and a BACnet read is performed on these attributes, the values returned are NaN, -INF,

and INF for Average Value, Minimum Value, and Maximum Value. If these values are Unreliable and a BACnet read is not
performed, the attributes return zero.

3 If written or changed, all samples in the sampling buffer become invalid (set to zero, NaN, -INF, or INF), which makes them
Undefined for the UI.

4 This attribute does not appear in a view, but may be scheduled, trended, and so on.

Averaging Extension Attribute Details

Average Value
Indicates the sum of all valid samples in the sampling buffer divided by the number of samples in the buffer. This
attribute is set to NaN with its Reliability set to Unreliable until a sample is taken and Attempted Samples, Window
Samples, or Window Interval is written.

Back to Averaging Attributes.

Attempted Samples
Indicates the total number of samples in the buffer. The only acceptable number that can be written to this attribute
is zero. After Window Samples or Window Interval is written, until a sample is taken, this attribute is set to zero.

Back to Averaging Attributes.

COV Increment
Specifies the minimum change in Present Value required for the object to report a change in the Average Value,
Minimum Value, and Maximum Value attributes.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Averaging Attributes.

Display Precision
Defines the decimal rounding and the decimal places to display for the Present Value and associated attributes.
Average Value, Minimum Value, and Maximum Value use the same display precision.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Averaging Attributes.
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Input Reference
Defines the object and attribute pair to be sampled. The sampled object must be on the same device as the Averaging
object.

Back to Averaging Attributes.

Maximum Value
Indicates the highest value of the valid samples in the buffer. After Attempted Samples, Window Samples, or
Window Interval is written, until a sample is taken, this attribute is set to -INF with its Reliability set to Unreliable.

Back to Averaging Attributes.

Max Value Timestamp
Indicates the date and time that the Maximum Value has changed in the sampling buffer.

Back to Averaging Attributes.

Minimum Value
Indicates the lowest value of the valid samples in the buffer. AfterAttempted Samples, Window Samples, or Window
Interval is written, until a sample is taken, this attribute is set to -INF with its Reliability set to Unreliable.

Back to Averaging Attributes.

Min Value Timestamp
Indicates the date and time that the Minimum Value has changed in the sampling buffer.

Back to Averaging Attributes.

Object Property Ref
Designates the particular object and attribute referenced by the Averaging object. This is a BACnet Device Property
Reference structure type attribute that specifies bind information from the object/attribute defined by the Input
Reference attribute. The binding information consists of the Device Identifier, Object Identifier, Array Index, and
Property Identifier of the trended property. An on-box object returns nothing for the Device Identifier. The Device
Object configures this attribute during object creation. Changing Object Property Ref may change Input Ref, and
changing Input Ref may change Object Property Ref. Since Object Property Ref is based on Input Ref, and Input
Ref does not support Array Index, Object Property Ref does not support Array Index either.

Back to Averaging Attributes.

Reliability
Indicates whether the Average Value, Minimum Value, and Maximum Value attributes are Unreliable. After Attempted
Samples, Window Samples, or Window Interval is written, until a sample is taken, this attribute is set to Unreliable.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Averaging Attributes.

Units
Indicates the units of the mapped attribute of the extended object. Average Value, Minimum Value, and Maximum
Value use the same units.

This attribute does not appear in a view, but may be scheduled, trended, and so on.

Back to Averaging Attributes.

Valid Samples
Indicates the number of samples in the sampling buffer that are valid. A sample is marked invalid if a read error
occurs when reading requested attributes from the host object. The number of invalid samples can be determined
by subtracting Valid Samples from Attempted Samples. If the difference is greater than zero, it indicates an error
during sample collection. After Attempted Samples, Window Samples, or Window Interval is written, until a sample
is taken, this attribute is set to zero.

Back to Averaging Attributes.
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Window Interval
Indicates the period of time in seconds over which the Minimum Value, Maximum Value, and Average Value are
calculated. Samples are taken at a specific sample rate, which cannot be less than 4 seconds. The sample rate is
calculated by dividing the Window Interval by the number of samples as defined in the Window Samples attribute.
The default value is 3,600 seconds.

Back to Averaging Attributes.

Window Samples
Indicates the number of samples to be taken during the Window Interval and saved to the local sampling buffer. A
maximum of 200 samples can be saved. After reaching the limit, the oldest samples in the buffer are overwritten
with the newest samples. If the sampling rate is not a whole number, it is rounded up to the nearest integer.

Back to Averaging Attributes.

Averaging Commands
The following table lists the commands supported by the Averaging Extensions. Click the command name for a
description of the command.

Table 53: Averaging Extension Commands
ParametersCommand Name

Enable

Disable

Clear

Averaging Command Details

Enable
Clears the sampling buffer and restarts the sampling process. This command has the same effect as the Clear
command.

Back to Averaging Commands.

Disable
Stops the sampling process.

Back to Averaging Commands.

Clear
Writes zero to the Attempted Samples attribute, clears the sampling buffer, and restarts the sampling process. This
command has the same effect as the Enable command.

Back to Averaging Commands.

Extensions Steps
Creating Extensions
Note: You cannot create an extension in online mode with Basic Access.

You can add only one load extension to an object.

To create extensions:

1. Select the item from the Navigation Tree and select Show Extensions from the Action Menu.

Note: Alternatively, you can create extensions when prompted upon completion of a wizard, or when the item
is in the Display Frame by selecting the tab for the extension and clicking new.

2. Select New for the type of extension that you want to create. The corresponding Extension Wizard appears.
3. Select the attribute that you want to associate with the item.
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4. Complete the information on the wizard screens. The screens vary depending on the type of extension you are
creating. See the Wizards section for help on using wizards.

5. Select Finish on the summary page to create the extension.

Viewing Extensions
To view extensions:

1. Drag and drop the object into the Display Frame.
2. Click the tab along the top for the desired extension.

Editing Extensions
Note: You cannot edit an extension in online mode with Basic Access.

To edit extensions:

1. View the extension.
2. Select the tab for the extension.
3. Select the extension you want to edit.

Note: For trend extensions, make sure you select the Definition View button to display the trend’s attributes.
4. Click Edit.
5. Make your changes.
6. Click Save.

Copying and Pasting Extensions
Note: You can perform this procedure only in the System Configuration Tool (Offline Mode). You must first create

extensions before you can copy and paste them from one item to another. See Creating Extensions for details
on how to create extensions.

To copy and paste existing extensions:

1. Select the item from the Navigation Tree that contains the existing extensions that you want to copy, and select
Show Extensions from the Action Menu. The Extension wizard appears.

Note: Alternatively, you can right-click the item in the navigation tree and select Show Extensions from the
menu that appears.

2. Select the check box for one or more of the existing extensions that you want to copy.
3. Click Copy Checked Extensions.
4. Click Done.
5. Select the item from the navigation tree that you want to receive the copied extensions, and select Paste from

the Edit Menu.

Note: Alternatively, you can right-click on the item in the navigation tree and select Edit > Paste from the menu
that appears.

When you paste an extension, the extension retains the name of the copied extension and appends it with a
number.

Deleting Extensions
Note: You cannot delete an extension in online mode with Basic Access.

Note: For a trend extension that is configured to automatically transfer data to an ADS/ADX (Repository Enabled
= True), be sure to route unforwarded data to the ADS/ADX before deleting the trend extension. If you do
not, unforwarded trend data is lost.

1. To delete extensions (using the Navigation Tree):
a. Select the item from the navigation tree and select Show Extensions from the Action menu.
b. Select the check box of the extension you want to delete.
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c. Click delete.
2. To delete extensions (when the item is in the Display Frame):

a. View the extension.
b. Select the tab for the extension.
c. Select the extension.
d. Click Delete.

Searching for Extensions
You can search for Alarm, Trend, or Totalization extensions using the Global Search feature. This allows you to find
up to 100 extension objects and view their current values.

Commanding Extensions
You can command Alarm, Trend, or Totalization extensions from an Extension View or from the Global Search
Viewer. You can also command Trend extensions from a Trend Viewer or Trend Study view.

Single Extension
To command a single extension object:

1. Right-click the extension object you wish to command.
2. Select Commands from the right-click menu. The Commands dialog box appears.
3. Choose the command to send.
4. Click Send.

See the Commands Dialog section for more information.

Multiple Extension
To command multiple extension objects together (Global Commanding):

1. Use the Global Search feature to find the extension objects (Alarm, Trend, or Totalization). You may also open
a saved Object List containing extension objects. See Interlocking a Trend Extension for more information.

2. Select the extensions you wish to command (must be of the same type).
3. Select Commands from the Action menu. The Global Commands dialog box appears.
4. Choose the command to send.
5. Click Send.

See the Commands Dialog section for more information.

Interlocking a Trend Extension
To interlock a Trend Extension:

1. Create a trend extension. See the Creating Extensions and the Trend Extensions sections for information.
2. Create an Insert Object - Interlock that references the trend extension. See the Insert Insert Object - Interlock

section.
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User Views
User views (user-defined navigation trees) contain references to selected items found in the All Items navigation
tree (the default navigation tree). For example, you could create a user navigation tree with all the AIs grouped
together, or a navigation tree that contains only points for a certain area of a building. User views are useful for
restricting access for certain users and grouping commonly used items/graphics together. User Views are necessary
to apply the Ready Access Portal UI, as only User Views assigned to individuals are visible from this UI. You can
use the user view edit capabilities to easily consolidate small user views into a larger view, or to break large user
views into multiple smaller views. Specify the User View navigation display as either a set of tabs (Tabbed) or a
drop-down list (List) in the Default navigation display preference in the Display Settings Tab in the Preferences
section. We recommend list view if the system has many user views, as list view takes up less space in the navigation
tree pane. User views provide a mechanism for viewing Tailored Summaries. See the User Views with Tailored
Summaries and the Tailored Summaries sections for more information.

User views are easy to create. The system supports drag-and-drop functionality of items from the Global Search
Results table to add them as references in a User View. To do this, view both the Global Search Viewer and the
User View in the display frame (using a multiple panel view). Click Edit in the User View. Then drag the desired
items from the Search Results table to the User View. The system also supports drag-and-drop functionality to add
references to items from the navigation frame (User View [online] or All Items tree) to a User View in Edit mode. In
addition, to add an entire tree (only from the navigation frame) to a User View, press the Ctrl key and drag and drop
the tree to a User View in Edit mode.

For more information on the wizard used to create a user view, see the Create New User View Wizard section. For
more information on the object created by this wizard, see User Navigation Tree.

The Security Administrator System allows administrators to assign user view permissions to specific users (in the
Online UI only). For information on the Security Administrator System, see Related Documentation.

User Views Concepts
User View Behavior by Mode
User views appear and function differently, depending on what mode you are in (Table 54).

Table 54: User Views in Modes
Behavior NotesLocation in UIMode
• create, edit, and delete user views
• copy and paste user views
• drag and drop the user view into the Display frame for editing

• User Views folder in the All
Items navigation tree

Offline (SCT)

• drag and drop the user view into the Display frame for
viewing

• click a user view tab to display the user view as an actual
tree in the navigation frame. In this tree, you can view and
navigate to items.

• assign permissions to the user views (via Security
Administrator System)

• User Views folder in the All
Items navigation tree

• User View tab
• Security Administrator System

Online (Basic Access)
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Table 54: User Views in Modes
Behavior NotesLocation in UIMode
• create, edit, and delete user views
• drag and drop the user view into the Display frame for editing
• click a user view tab to display the user view as an actual

tree in the navigation frame. In this tree, you can view and
navigate to items.

• assign permissions to the user views (via Security
Administrator System)

• User Views folder in the All
Items navigation tree

• User View tab
• Security Administrator System

Online (Standard
Access)

• User Views folder in the All
Items navigation tree

Simulation

User View Authorization
User view authorization is based on the security privileges assigned to your user account by a Metasys Administrator.
Authorization uses navigation permissions and category-based permissions.

Your navigation permissions determine which user views display in the navigation frame of the online UI. Only the
user views assigned to you or your assigned security roles appear. When a user view is created online, navigation
permissions for the view are automatically assigned to the user who created the view. When a user view is created
offline in the SCT and then downloaded to the site, no navigation permissions are assigned. In this case, the user
view does not display in the navigation frame for any users. The Metasys system Administrator must assign
permissions to all users and/or roles requiring the navigation view.

Your category-based permissions determine if you are allowed to create, view, edit, or delete a user view from a
particular object category (for example, HVAC). Category-based permissions are separate from navigation permissions.

Note: A User View can contain objects assigned to categories that a user does not have permissions for. In this
case, the objects will appear in the User View navigation tree, but the user will be unable to access any
information from these objects.

Alarm notification is not limited or affected by the current user view, only by the user’s permissions for managing
item events. Therefore, it is possible for a user to receive an alarm for an item that does not exist in the currently
displayed user view.

For more information on assigning permissions for navigation views, see Related Documentation.

User View Structure
User views provide graphical, functional, and geographical organizations of your Metasys system. For example, you
might create a user view comprised only of nested references to graphics. Or you may organize your user view with
separate levels for campus, building, floor, room, and so on. You may even create a separate user view for each
user, to provide that user a focused view into the system or to restrict the user’s access.

The structure, or hierarchy, of a user view is based on the following general rules:

• User view folders (folders created in the user view) may contain any number of additional child folders or
other references. For example, you can add multiple Summary Definition objects for the Tailored Summary
feature to a user view folder.

• When you add a reference to a folder from the All Items view into a user view, you cannot nest anything under
it.

• Graphic references may contain any number of additional graphic references.
• With the exception of graphics, references may only be nested under user view folders (that is, a non-graphic

reference cannot be a child of a reference). References do not need to be nested to exist in the User View.
• Any item may be referenced any number of times within the user view hierarchy.
• When creating user views for the Ready Access Portal UI, keep in mind that Ready Access Portal users navigate

their site using only user views.
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• To take advantage of the alert filtering capabilities in the Ready Access Portal UI, create a dedicated user view
to use with only the alert filters. For example, add folders with an Engine under each folder that is named for the
location the Engine serves.

• In the Ready Access Portal UI, add the device and schedules in a user view so that the link for a device summary
works, and a selected schedule appears in a summary function.

Tree View Tab
The Tree View tab appears when you are adding a user view with the Create New User View Wizard or when you
display an existing user view for editing.

Table 55 shows the buttons in the Tree View tab and when to use them. All the functions represented by buttons in
Table 55 are also accessible via the right-click menu. Table 56 describes the functionality available in the Tree View
tab.

Table 55: Tree View Tab Buttons/Right-Click Menu
DescriptionButton NameButton Icon
Adds one or more items to the user view. When you add a reference to an item
that has children in the navigation tree, the children are not included in the user
view.

Add Reference(s)

Adds an entire user view, an entire folder hierarchy, or single item reference to
a user view. When you add an item using this button, you add the item and all
of its children to the user view.

Add Tree(s)

Creates a new folder in the user view. Use this button to add a folder to a user
view.

New Folder

Repairs or updates site, Engine, or ADS/ADX identifiers in the references of
items stored in the user view. The references are used to identify the items in
the view, and updates from this feature do not affect the items themselves. You
cannot use this feature to find and replace field device identifiers within
references. See Find and Replace.

Find and Replace

Removes anything you select from the user view. The Remove button removes
not only what you select, but all children of the item you select.

Remove

Moves a selected user view item up in the user view. This button changes the
order of items in the navigation tree but does not nest items. See Drag and Drop
in the Table 56.

Move Up

Moves a selected user view item down in the user view. This button changes
the order of items in the navigation tree but does not nest items. See Drag and
Drop in the Table 56.

Move Down

Sorts the items in the user view in ascending, alphanumeric order. You can sort
items at any level in the user view (for example, the folders directly under the
User View or the contents of a folder). The items are sorted only one level down
(not subsequent levels).

Sort Ascending

Sorts the items in the user view in descending, alphanumeric order. You can
sort items at any level in the user view (for example, the folders directly under
the User View or the contents of a folder). The items are sorted only one level
down (not subsequent levels).

Sort Descending

Changes the label used for an item within a specific user view. Changing the
label for an item in the user view does not affect the item’s Name attribute or
reference, and does not affect the label used for other occurrences of the item
in the same or other user views.

To change the label for an item, triple-click the item or right-click the item and
select Rename.

Edit Label
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Table 56: Tree View Tab Functionality
DescriptionFunctionality
Selects multiple items in the Select Item dialog box, which is displayed when you click Add Reference
or Add Tree.

Ctrl/Shift Keys

Moves the selected reference or folder, and its nested items, to a new location within the user view.
When you are dragging an item to a collapsed folder, hover the mouse pointer over the collapsed
folder for a moment and it automatically expands. To change the order in which items appear within
a parent folder or under a graphic, see Move Up and Move Down in Table 55.

Note: You can drag and drop objects from the all items tree or any other user view into the user
view you are editing. When you drag/drop an object with children, only the parent object is
added to the user view.

Drag and Drop

Find and Replace
The Find and Replace button appears on the Tree View Tab. You can use the Find and Replace option after renaming
a site/device to update references to the new site/device name. This feature resolves any references that may have
become broken due to the name change (Table 57).

Table 57: Search Options
DescriptionButton
Updates the first occurrence of the specified text in all references with the replacement (Replace with)
text. Enter the reference text and the new text and click Find. A list of references is generated. Click
Replace All to update all references, or select a reference and click Replace to update a reference
individually.

Full Reference

Updates the site identifier in all references to the site name where the user navigation view resides.
This value comes from the user navigation view’s full reference and is not editable in this dialog box.
Click Find. A list of references is generated. Click Replace All to update all references, or select a
reference and click Replace to update a reference individually.

Site Name Only

Replaces the Engine or ADS/ADX device identifier in item references with a different device identifier.
All Device Names is entered by default, but you can specify a specific device name if desired. Enter
the new name and click Find. A list of references is generated. Click Replace All to update all
references, or select a reference and click Replace to update a reference individually. The device
identifier updates in the references for the selected item and its children.

Device Name Only

You also can use the Find and Replace option in online mode to quickly duplicate user view hierarchies for supervisory
devices with similar configurations.

Note: The Select Item dialog box contains the set of views that appear in your navigation frame. Because user
views do not appear in the navigation frame in the SCT, these steps work only in online mode.

For example, perhaps you have several Network Automation Engines (NAEs)s on your site that have the same set
of N2 controllers and field points under their N2 trunks. You can create a user view to group your field devices and
field points for NAE-1 into a logical system-based or geographical hierarchy. You can then duplicate the NAE-1 user
view to create the same references and hierarchy for NAE-2.

Follow these steps:

1. Create a user view referencing NAE-1 items (for example, field devices and/or field points), organizing the items
in folders as desired.

2. Refresh all tabs in the navigation frame to update the navigation views displayed in the UI.
3. Create and edit a new user view for NAE-2, or edit the user view you created for NAE-1.
4. Add items to the new NAE-2 user view.

Click Add Trees (see Table 55) to display the Select Item dialog box.a.
b. In the dialog box, select the tab for the user view you created for NAE-1.
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c. Select the items you wish to duplicate (choose the root node to duplicate the entire navigation view).
d. Click OK. The Select Item dialog box closes, and the selected items and their children appear in the NAE-2

user view.
5. Use the Find and Replace feature (Device Name Only in the Table 57) to replace the NAE-1 identifier with NAE-2

in the references for the duplicated items.
6. Save your changes when finished.

User Views with Tailored Summaries
The Tailored Summary feature relies on the User View feature to provide a mechanism for viewing Tailored
Summaries. After defining Summary Definition objects, add them to a folder in the User View through the All Items
tree. Then view the Tailored Summary through the User View (that is, view the User View folder to display the
Tailored Summary). See the User View Editor, Workflow, and Defining User Views with Summary Definitions topics
in the Tailored Summaries section.

User Views Steps
Creating a User View
See User View Authorization for details on the user view permissions.

Note: You cannot create, edit, or delete a user view in online mode with Basic Access.

To create a user view:

1. On the Insert menu, click User View.
2. Follow the wizard instructions. See Create New User View Wizard for information on the wizard. See Table 55

and Table 56 for details on using the Tree View tab.

Editing a User View
Note: You cannot create, edit, or delete a user view in online mode with Basic Access.

To edit a user view:

1. Browse to the user view (in either the User Views folder in the All Items navigation tree or by selecting the user
view tab).

2. Double-click the user view. The user view editor appears in the Display frame.
3. Click Edit and work with the user view as follows:

• Use the New Folder button to add a folder.
• Use the Add Reference(s) and Add Tree(s) buttons to add references to items.
• Use drag-and-drop functionality to add references to items from the navigation frame (User View [online] or

All Items tree) to a User View in Edit mode.
• Use drag-and-drop functionality to add references to items in a User View from the Global Search Results

table. View both the Global Search Viewer and the User View in the display frame (using a multiple panel
view). Click Edit in the User View. Then drag the desired items from the Search Results table to the User
View.

• Press the Ctrl key and drag and drop a tree (only from the navigation frame) to a User View in Edit mode to
add an entire tree to the User View. This functionality does not apply to the Global Search Results table.

• Select one or more items and use the Remove button to remove items.
• Sort the items in the user view using the Sort Ascending and Sort Descending buttons.
• Use the Move Up and Move Down buttons to reorganize the order of the items.
• Use the Edit Label button to rename items.
• Use the Find and Replace button to resolve broken references after changing the Site Director or to duplicate

user view hierarchies for supervisory devices with similar configurations. For details, see Find and Replace.

For information on the buttons and functionality in the Tree View tab, see the Tree View Tab section.
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For information on the attributes in the Focus tab, see the Summary Definition Object.
4. Click Save when finished.

Deleting a User View
Note: You cannot create, edit, or delete a user view in online mode with Basic Access.

To delete a user view:

1. Select the user view in the User Views folder of the All Items navigation tree.
2. On the Edit menu, select Delete Items.
3. Click Yes to confirm deletion. The user view disappears.

Consolidating User Views
You can consolidate multiple small user views into one larger user view.

Note: You must be in online mode to consolidate user views.

To consolidate user views:

1. Create a new user view, or edit an existing user view. This is the user view to which you add other views to
consolidate them.

2. With the user view in Edit mode, select the location (root or existing folder) where you would like to add the
contents of another user view.

3. Click Add Tree. The Select Item dialog box appears.
4. In the Select Item dialog box, select the tab for the user view you would like to add.
5. Select the root node of the user view you would like to add.
6. Click OK.

Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation frame) to a User View
in Edit mode to add an entire tree to the User View.

A new folder, which contains the contents of the user view you selected, appears in the user view you are
editing. If you would like to rename the folder or move the children to another location within the user view, see
Table 56.

7. Repeat Step 1 through Step 6 if you would like to consolidate other user views into the user view you are editing.
8. When you are finished consolidating user views, click Save.
9. Refresh the tabs in the navigation frame and delete any user views you no longer need.
10. Have a Metasys system Administrator adjust the navigation permissions for the consolidated user view (if

necessary).

Breaking Up User Views
You can break up a large user view into several smaller views.

Note: You must be in online mode to break up user views.

To break user views:

1. Create a new user view, or edit an existing user view.
2. Click Add Tree. The Select Item dialog box appears.
3. In the Select Item dialog box, select the tab for the user view you would like to break into several smaller views.
4. Select the items from the large user view you would like to add to the new smaller view.
5. Click OK.

Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation frame) to a User View
in Edit mode to add an entire tree to the User View.
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The items you selected and their children appear in the new user view. If you would like to rename the folder
or move the children to another location within the user view, see Table 56.

6. Repeat Step 2 through Step 5 if you want to move more content from the large user view to the new smaller
user view.

7. When you are finished with this new smaller user view, click Save.
8. Repeat Step 1 through Step 1 to create additional smaller user views with content from the large user view.
9. Refresh the tabs in the navigation frame and review the user views to make sure they contain the correct items.

Edit the new smaller user views as necessary.

Edit the large user view and remove the items that are now located in the new smaller views, if desired.
10. Refresh the tabs in the navigation frame.
11. Have a Metasys system Administrator adjust the navigation permissions for the consolidated user view (if

necessary).
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Tailored Summaries
Tailored Summaries allow you to view, command, and modify large quantities of similar data in a tabular format.
Tailored summaries are essentially summary views of Metasys system items where the rows and columns of the
summary are tailored to contain information of interest. Similar data, for example, may be all VAV boxes on a floor
of a building, showing current temperatures, setpoints, flows, and minimum/maximum settings. This feature allows
you to quickly analyze the operation of your facility.

The Summary Definition object is an integral part of the Tailored Summary feature. It allows you to view and edit
the columns and key data values used in a Tailored Summary based user view. The contents of the user view folders
are the rows in the Tailored Summary. Figure 17 illustrates the interaction between the user view, Summary Definition
object, and the Tailored Summary.

Figure 17: User View, Summary Definition, and Tailored Summary Interaction

In this example, a user view named HVAC contains a folder named VAV Boxes - VMA 1400s. In the VAV Boxes
folder are two Summary Definition objects named Monitoring - VMA1400 and Configuration - VMA1400 Flow. The
VAV Boxes folder also has item references to several VAVs in the system.

In the Tailored Summary, the Monitoring - VMA1400 Summary Definition object is selected, and its data appears in
the view. The referenced VAVs appear as rows in the table. The Label defined in the Summary Definition object
appears as the column heading named Controller for the referenced VAV items in the Tailored Summary. The
columns defined in the Summary Definition object (for example, Zone Temperature and Supply Temperature) appear
as columns in the Tailored Summary view. The Key Data in the Tailored Summary is defined in the Focus view of
the Summary Definition object.

See the Tailored Summary User Interfaces for details on the views described in this example.
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For more information and attribute details on the Summary Definition object, see the Summary Definition Object
section.

For information on user views, see the User Views and User Navigation Tree sections.

You can create and edit Summary Definition objects for the Tailored Summary feature in the SCT or the online Site
Management Portal UI for the Site Director, but you must be in the online Site Management Portal UI or the Ready
Access Portal UI to view the Tailored Summary.

The Tailored Summary feature requires minimal memory for the Summary Definition objects; however, the objects
do increase the object count.

Tailored Summary Concepts
Tailored Summary User Interfaces
Summary Definition Editor
On a Site Director, the Summary Definition Editor allows you to define and edit a Summary Definition object. The
Summary Definition Editor appears when you view a Summary Definition object. Summary Definition objects always
reside on a Site Director in the Summary Definitions folder of the All Items tree (that is, you cannot put a Summary
Definition object in another location).

Summary Definition Tab
The Summary Definition Editor’s Summary Definition tab allows you to define the table that appears in the Tailored
Summary view.

Figure 18: Summary Definition Editor - Summary Definition Tab
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Table 58: Summary Definition Editor - Summary Definition Tab
DescriptionButton/Field
Defines the label to display in the first column (that is, the row header column) in a Tailored
Summary. The label is limited to a maximum of 50 characters. This field also can be left
blank.

Label

Allows you to add a column at the end of the column configuration table.
Note: You can define up to a maximum of 7 columns. This button is disabled if 7 columns

already exist.

Add/Plus

Allows you to remove the currently selected column from the column configuration table.
Note: To select a column, click the column’s header. You must define a minimum of at

least one column.

Remove/Minus

Provides configuration of the columns that appear in the Tailored Summary:
• Column Heading - Defines the name of the column header. The name can have a

maximum of 50 characters.
• Child Item - Indicates the item for which the column data is retrieved based on its item

name attribute. You can use the Select Item dialog box to pick a name, or type in the
text box. The name must match a user-specified pattern (such as ZN-* or ZN-T, Zone-T).
You can define an unlimited amount of wildcards1. The first item found that matches
this item name pattern appears in the Tailored Summary view column. To display an
attribute of the row item, leave this field blank. Otherwise, specify the name of the child
item to display.

• Attribute - Defines the attribute information for the column. To display the default
attribute, no change is required (that is, leave the Attribute box set to Default). The
attributes are grouped into categories for easy selection. To specify an attribute, select
a category in the Attribute Filter section of the Select Column Attribute dialog, and then
select the desired attribute from the list.

Note: To change the order of the columns, select a column and drag it to the desired
placement.

Note: When you display a Tailored Summary (see Viewing a Tailored Summary), the
system searches for data within all levels of a field device (VMA, for example). For
all other objects (NAE, for example), the system searches for data only one level
down (not subsequent levels).

Column Configuration Table

Opens the Select Item dialog box for specification of the item name.
Note: This dialog box provides an easy way to fill in the item name of a child item. It does

not mean that the selected item displays in that column.

Browse (Child Item)

Opens the Select Column Attribute dialog box for selection of the attribute to display in the
column of the table. This process is necessary only when selecting an attribute other than
the default attribute.

This dialog box has two list boxes to aid in selection:
• Attribute Filter - Allows you to filter the items appearing in the Attribute list using

common attribute categories. If you filter on Alarms, for example, the supported alarm
attributes appear in the list for selection.

• Attribute - Lists the available attributes for selection.

Note: To display the default attribute of the row item, leave the Attribute box set to Default
(Attribute Filter: Common Attributes and Attribute: Default).

For an example of the attributes available for display in the Tailored Summary feature, see
the Tailored Summary Attributes section.

Browse (Attribute)

1 Use the asterisk (*) wildcard for partial name matching (for example, ZN-T* finds items named ZN-T and ZN-Temp).
Use a comma (,) to separate the wildcard search criteria (for example, ZN-T, Zone-T finds items named ZN-T or items named
Zone-T).

145Metasys System Online Help PDF



Use the Backslash(\) wildcard to indicate a character does not have a special meaning (for example, ZN\*T, ZN\, T, ZN\\T finds
items named ZN*T, ZN, T, and ZN\T).

Focus Tab
The Summary Definition Editor’s Focus tab allows you to define the Key Data that appears outside the main table
in the Tailored Summary view, as well as other common Metasys object attributes. To define Key Data, click the
Browse button of the Key Data attribute on the Focus tab. This action opens the Modify List dialog box.

The Object Name attribute on the Focus tab provides the name shown in the Summary Definition folder in the All
Items tree. For information on the other Summary Definition Focus tab attributes, see the Summary Definition Object
section.

Figure 19: Modify List Dialog Box

Table 59: Modify List Dialog Box
DescriptionButton/Field
Displays the added Key Data items. You can use the Select Item dialog box to pick the Key
Data item, or type in the text box. You also can use wildcards (asterisks * only), where the
system searches for the matching item in the user view folder. You can define up to 4 Key
Data items.
Note: The default attribute of the Key Data item appears in the Key Data table of the Tailored

Summary view.

Key Data List (Listof[x])

Opens the Select Item dialog box for selection of the Key Data item.Browse

Adds an undefined item to the Key Data list.Add

Removes the currently selected item from the Key Data list.Remove

Moves the currently selected item up one place in the Key Data list.Move Up

Moves the currently selected item down one place in the Key Data list.Move Down

Closes the dialog box without accepting the changes.Cancel

Accepts the changes and closes the dialog box.OK

Create New Summary Definition Wizard
Use the Create New Summary Definition Wizard to create a Summary Definition object from scratch. Access this
wizard using the Summary Definition option of the Insert menu.
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Table 60: Create New Summary Definition Wizard
DescriptionScreen
Allows you to enter a name for the Summary Definition object.Identifier

Allows you to define the data of the Summary Definition and Configuration tabs.
Note: The Configuration tab in this wizard contains the same data as the Focus tab of the

Summary Definition Editor.

See the Editing an Existing Summary Definition and Defining Key Data sections for details on
how to edit these items.

Configure

Displays the summary data of the Summary Definition object.Summary

User View Editor
The Tailored Summary feature relies on the User View feature to provide a mechanism for viewing Tailored
Summaries. See the Workflow section for details.

The following figure shows the User View Editor configured with folders holding specific Summary Definition objects
and references.

Figure 20: User View - Tree View Tab

For more information on User Views, see theUser Views and Defining User Views with Summary Definitions sections.

Tailored Summary View
The data that appears in the Tailored Summary view is the result of analysis based on the row and column definition
of the Summary Definition object. Access the Tailored Summary view by viewing the associated User View folder
containing the Summary Definition object(s) and references. The Tailored Summary view allows you to view,
command, or modify the data. The Tailored Summary view is only available in the online Site Management Portal
UI for the Site Director, or in the Ready Access Portal UI.
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The items in the Key Data and Tailored Summary tables use the graphic status colors defined by the preferences.
See Graphic Settings Tab in the Preferences section.

Guidelines and tips:

• A Tailored Summary cannot display more than 100 rows. The view automatically stops loading the data once
the 100 row limit is reached. A message appears at the bottom of the view to indicate that the first 100 items are
displayed.

• Items must be mapped (for example, appear in the All Items tree) to appear in the Tailored Summary.
• If the search does not find a match for an item, or the defined attribute does not apply to the item found, dashes

(---) appear in the Tailored Summary.
• Wireless TECs do not appear in a Tailored Summary (that is, this feature cannot use Wireless TECs as rows in

the Tailored Summary).
• The Tailored Summary feature displays data from engines at Release 2.2 or later.

• IP addresses for devices not upgraded to Release 5.0 appear differently within Tailored Summaries in the Site
Management Portal UI than in the Ready Access Portal UI; this is expected behavior. IP addresses for devices
not upgraded to Release 5.0 appear as the appropriate value when viewed in the Site Management Portal UI
Tailored Summaries. When you view a Tailored Summary in the Ready Access Portal UI, the value shown for
IP addresses of devices prior to Release 5.0 is (Complex). IP addresses for devices that are running Release
5.0 display correctly.

The following figure shows a Tailored Summary view with two Summary Definitions and two Key Data items. Notice
the items with alarm conditions appear with the graphic status colors defined in the System Preferences.

Figure 21: Tailored Summary Tab
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Table 61: Tailored Summary Tab
DescriptionField
Lists the available Tailored Summaries to view (that is, the list of Summary Definitions
that appear directly within the selected user view folder).

Available Tailored Summaries List
Box

Displays the default attribute value of the defined Key Data items.

See the Using a Tailored Summary section for the actions you can take on the Key Data
table (such as view, command, and modify).

Key Data Table

Displays the attribute value data according to the configuration of the selected Summary
Definition.

The list of user view items appears in the first column (row header column) with the
following exceptions:
• folders and user view folders do not appear
• Summary Definition objects do not appear

The data appears in the other columns.

See the Using a Tailored Summary section for the actions you can take on the Tailored
Summary table (such as view, command/global command, and modify/global modify).

Tailored Summary Table

Workflow
The following diagram shows a high-level workflow for creating and using Tailored Summaries. See the steps
following the diagram for more detailed workflow information.
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Figure 22: Tailored Summary Workflow

The workflow for creating and using Tailored Summaries is as follows:

1. Import the pre-built Summary Definitions. See Importing a Summary Definition for procedural details and the
location to access the pre-built Summary Definitions. Once imported, the Summary Definitions appear in the
Summary Definitions folder in the All Items tree.

OR

Create a new Summary Definition using the Summary Definition wizard (Creating a New Summary Definition).

Note: We recommend editing a pre-built Summary Definition similar to what you need. You may want to use
the same Summary Definition as the basis for slightly different groups of items (for example, a VAV with
two Air Handling Unit (AHU)s having different key data). Copy the existing Summary Definition to create
the new Summary Definitions. See the Reusing an Existing Summary Definition for Different Key Data
section.
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2. Edit the Summary Definitions and define key data, if desired (Editing an Existing Summary Definition):
a. View a Summary Definition by double-clicking it in the Summary Definitions folder of the All Items tree.
b. On Summary Definition tab, click Edit. Make the necessary changes and click Save.
c. On Focus tab, click Edit. Make the necessary changes (for example, define the Key Data following the

instructions in Defining Key Data), and click Save.
3. Create a user view or edit an existing one (Defining User Views with Summary Definitions):

a. Drag and drop the Summary Definitions from the Summary Definitions folder in the All Items tree to a folder
(for example, a Summary Definitions folder) in the user view (or use the user view editor’s add reference
option).

b. Drag and drop the Site Director object and items to reference (for example, supervisory devices or points)
from the All Items tree or from the global search results table to the folder in the user view (or use the user
view editor’s add reference option). The referenced items appear as rows in the Tailored Summary.

4. View the Tailored Summary (Viewing a Tailored Summary and Using a Tailored Summary):
a. Click the user view tab in the navigation pane. If the desired tab is already selected, refresh the tab.
b. Double-click the folder containing the Summary Definitions and devices (for example, the Summary Definitions

folder). The Tailored Summary appears in the display panel.
c. Click the Tailored Summary you want to view in the Available Tailored Summaries list box if more than one

Summary Definition appears in the list. By default, the first authorized Summary Definition in the list is
automatically selected.

d. View the key data and the table data. Use the right-click menu options to command, modify, or otherwise
work with the data.

Summary Definitions Library
A set of pre-built Summary Definitions are provided on the SCT installation media and the Johnson Controls Branch
Purchase Package (BPP). You can save these files to your computer or access them from the SCT installation
media or BPP DVD. To use the pre-built Summary Definitions, import the pre-built Summary Definition files into your
site. For details, see Importing a Summary Definition.

The pre-built Summary Definitions are designed to meet the needs of the users based on common tasks and
functions. The Summary Definitions fit into the following main categories: Configuration, Diagnostics, and Monitoring
(HVAC). The Device and Network Diagnostics definitions are intended for Site Administrators. Mechanical Equipment
definitions with links to graphics and Key Point definitions are useful for Service Professionals.

The following table lists and describes the pre-built definitions, including the definition name, default columns (appear
in English only), and overview description indicating typical rows, key data, and other useful information. Click an
attribute under Default Columns to view its description.
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Present Value
• Alarm Priority
• Differential
• Low Alarm Limit
• High Alarm Limit
• Alarm Ack Required
• Normal Ack Required

Displays analog alarm configuration data. The typical rows for
this Summary Definition include any key analog points (for
example, key zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend, and averaging
extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Trends
• Config - Analog Alarms Warning

Config - Analog Alarms
Main

• Present Value
• Unoccupied State
• Occupancy Reference
• Cooling Setpoint Reference
• Heating Setpoint Reference

Displays the Setpoint and Occupancy References in the alarm
extension. These points are used to configure the behavior of
a Room Control Module symbol.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

Config - Analog Alarms
Refs

• Present Value
• Warning Priority
• Low Warning Offset
• High Warning Offset
• Warning Reference
• Warning Ack Required
• Report Delay

Displays the warning alarm configuration data. The typical rows
for this Summary Definition include any key analog points (for
example, key zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend, and averaging
extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Trends
• Config - Analog Alarms Main

Config - Analog Alarms
Warning

• Present Value
• Device Type
• Min Value
• Max Value
• COV Increment
• Out of Service
• Relinquish Default

Displays the key attributes of an analog point that may require
modifying using the Global Modify feature or commanding using
a Global Command (seeModify Dialog andCommands Dialog).
The typical rows are any key analog points (for example, key
zone or discharge air temperatures, key static pressures, and
so on).

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends
• Config - BACnet Point Info

Config - Analog Points
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• BACnet Object Name
• Model Name
• Description
• Object Identifier
• Instance Number

Displays the key network configuration attributes of any FEC

controllers.2

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - FEC Controllers
• Diag - FEC Controllers

Config - BACnet
Controller Info

• BACnet Object Name
• Model ( Model Name)
• Network Address
• BACnet IP Port
• Object Identifier

Displays the key BACnet configuration attributes of any NxEs.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - Engine Summary
• Config - Engine Network Info
• Diag - Engines

Config - BACnet Engine
Info

• Present Value
• BACnet Object Name
• Object Identifier
• Intrinsic Alarming Defined

Displays the key BACnet configuration attributes of any points
on an FEC controller.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

Config - BACnet Point
Info

• Present Value
• Min On Time
• Min Off Time
• Heavy Equip Delay
• Out of Service
• Relinquish Default
• Device Type

Displays binary output configuration data. The typical rows are
any key output points (for example, fans or pump commands).

You can modify the attributes from the Tailored Summary view
using the Global Modify feature. See the Modify Dialog section.

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - BACnet Point Information

Config - Binary Output
Points

• Model ( Model Name)
• Status
• Version
• IP Address
• IP Mask
• Ethernet MAC Address
• DHCP Enabled

Displays the key network configuration attributes of any NxEs.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - Engine Summary
• Config- BACnet Engine Info
• Diag - Engines

Config - Engines Network
Info

MAC Address

• Description
• Model ( Model Name)
• Status
• ADS Repository
• Last Archive (Archive Date )
• Local Time
• Local Date

Displays the key configuration attributes of any NxEs.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - Engine Network Info
• Config - BACnet Engine Info
• Diag - Engines

Config - Engine Summary
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Model (Model Name)
• Status
• Description
• Version
• Address (MAC Address)
• Trunk Number
• Auto Alarm ( Disable

Automatic Alarming)

Displays the key network configuration attributes of any FEC
controllers.2

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - BACnet Controller Info
• Diag - FEC Controllers

Config - FEC Controllers

• Status
• Description
• Neuron ID
• Program ID
• DSN 1
• XIF Present
• Message Retry Count

Displays the key network configuration attributes of any
LONWORKS controllers.2

Config - LON Controllers

• Present Value
• Interface Value
• Field Units
• Manual Control
• Update Interval
• Target Reference
• Priority

Displays the key configuration attributes of any points in a
LONWORKS based controller.

Config - LON Points

• Present Value
• Normal State
• Alarm Priority
• Capture Changes
• Report Delay
• Report Delay Active
• Alarm Message Text

Displays multistate alarm configuration data. The typical rows
are any key multistate points (for example, modes of operation,
fan status, and so on) that have alarm, trend, and averaging
extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Config - Trends
• Config - BACnet Point Information

Config - Multistate Value
Alarms

• Status
• Description
• Controller Type
• Trunk Number
• Auto Alarm (Disable Automatic

Alarming)
• Item Reference
• Version

Displays the key network configuration attributes of any N2
controllers.2

Config - N2 Controllers
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Name ( NCM Name)
• Status
• Gate Number
• Network Name
• Node Number
• Object Count
• Poll Delay

Displays the key configuration attributes of any Network Control
Module (NCM)s. The NCMs are integrated with an NIE.

Config - NCM Info

• Description
• Present Value
• Enabled
• Item Reference
• Object Category

Displays the key configuration information and current status
about the listed schedule objects.

You can use the Global Command feature to enable or disable
all the schedules in the Tailored Summary view.

See the Commands Dialog section.

You also can use this Summary Definition for features other
than schedules.

Config - Schedules

• Model (Model Name)
• Status
• Version
• Auto Alarm ( Disable

Automatic Alarming Disable
Automatic Alarming)

Displays the key network configuration attributes of any TEC
controllers.2

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - BACnet Controller Info

Config - TEC Controllers

• Present Value
• Description
• Buffer State
• Log Enable
• Repository Enabled
• Sample Interval
• Transfer Setpoint

Displays the trend extension configuration data. The typical rows
are any key analog points (for example, Energy Essentials meter
points, key zone or discharge air temperatures, key static
pressures, and so on) that have trend and averaging extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning

Config - Trends

• CPU Usage
• Battery Condition
• % Flash Utilized ( Flash

Usage)
• Estimated Flash Available
• % Memory Utilized ( Memory

Usage
• Object Count
• Board Temperature

Displays the key diagnostic attributes of any NxEs.

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - Engine Summary
• Config - BACnet Engine Info
• Config - Engine Network Info

Diag - Engines
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Model (Model Name)
• Status
• Memory Usage Memory

Usage
• CPU Usage CPU Usage
• Object Count
• Object Memory Usage
• Flash Usage

Displays the key diagnostic attributes of any FEC controllers.2

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Config - FEC Controllers
• Config - BACnet Controller Info

Diag - FEC Controllers

• Lost Messages
• Missed Messages
• Transmit Errors
• Transmits Per Minute
• Transaction Timeouts

Displays the key diagnostic attributes of this communication
trunk’s Diagnostic tab.3

Diag - LON Trunks

• Bus Health Index
• Bus Performance Index
• Data CRC Errors
• Framing Errors
• Token Loop Time
• Lost Token
• Buffer Overflows

Displays the key diagnostic attributes of this communication
trunk’s Diagnostic tab.3

Diag - MSTP Trunks

• Command Count
• Message Timeout
• Acknowledgement Errors (NAK

Errors)
• Offline Occurrences
• Poll Scan Time
• Retries
• Transmits Per Minute

Displays the key diagnostic attributes of this communication
trunk’s Diagnostic tab.3

Diag - N2 Trunks
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Description
• Current State (ZNT-State)
• Zone Temp Prmy Clg Error
• Zone Temp Box Htg Error
• Box Htg Output Error
• Supp Htg Output Error
• Supply Flow Error

Displays the occupied zone temperature status (ZNT-State)
value along with the absolute error values from all of the possible
output controllers (for example, CLG-ABSERROR,
HTG-ABSERROR, or SAFLOW-ABSERROR). Allows you to
easily compare Exponentially-Weighted Moving Average
(EWMA) to identify devices with poor relative performance.

The rows for this Summary Definition are the VAV controllers
associated with an air handling system. The absolute error
columns indicate all the possible values available. We
recommend you remove columns not needed for your specific
application.

Note: Depending on the module instance used by your
application, the attributes used for each column may
differ. Refer to the Output Controller chapter of the CCT
Help (LIT-12011147) for details.

When using this Summary Definition, first observe the value in
the Current State column. Then refer to the other columns as
appropriate. For example, if the Current State column indicates
that cooling is taking place, refer to the cooling error columns
for more details on the cooling process.

This Summary Definition is typically packaged in a user view
with the following Summary Definitions:

• Monitoring - VMA1600 Overview
• Monitoring - VMA1600 Flow
• Diagnostic - VAV Box Effort Analysis
• Configuration - FEC Controllers

Diag - VAV Box Error
Analysis

• Description Description
• Current State (ZNT-State)
• Zone Temp Prmy Clg Effort
• Zone Temp Box Htg Effort
• Box Htg Output Effort
• Supp Htg Output Effort
• Supply Flow Effort

Displays the occupied zone temperature status (ZNT-State)
value along with the absolute effort values from all of the possible
output controllers (for example, CLG-ABSEFFORT,
HTG-ABSEFFORT, or SAFLOW-ABSEFFORT). Allows you to
easily compare EWMAs to identify devices with poor relative
performance.

The rows for this Summary Definition are the VAV controllers
associated with an air handling system. The absolute error
columns indicate all possible values available. We recommend
you remove columns not needed for your specific application.
Keep in mind that the only one absolute error column is active
at any point in time based on the present value of ZNT-State.

Note: Depending on the module instance used by your
application, the attributes used for each column may
differ. Refer to the Output Controller chapter of the CCT
Help (LIT-12011147) for details.

This Summary Definition is typically packaged in a user view
with the following Summary Definitions:

• Monitoring - VMA 1600 Overview
• Monitoring - VMA1600 Flow
• Diag - VAV Box Error Analysis
• Config - FEC Controllers

Diag - VAV Box Effort
Analysis
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Supply Fan Status
• Return Fan Status
• Mixed Air Temp
• Zone Temp
• Discharge Temp
• Cooling Command
• Heating Output

Displays the key point information based on standard naming
conventions for a Mixed Air Single Duct systems. The rows for
this Summary Definition are FEC or TEC series controllers.2

Key data from the associated central plant systems or weather
data is typically added to unique instances of this Summary
Definition.

Monitoring - AHUs

• Present Value
• Alarm Ack Pending
• Alarm Ack Required
• Late Alarm Date
• Back to Normal Date
• Last Alarm Time
• Back to Normal Time

Displays the current key status information of analog points
along with the date and time that the last alarm and return to
normal transitions occurred. The typical rows for this Summary
Definition include any key analog points (for example, key zone
or discharge air temperatures, key static pressures, and so on)
that have alarm, trend, and averaging extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Analog Points
• Config - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

Monitoring - Alarm
History

• Present Value
• Averaging Value (Average

Value)
• Min Value (Minimum Value)
• Max Value ( Maximum Value)
• Reliability
• Item Reference

Displays the minimum/maximum/average values from the
averaging extension and the key description attributes for the
item’s Focus tab. The typical rows for this Summary Definition
include any key analog points (for example, key zone or
discharge air temperatures, key static pressures, and so on)
that have alarm, trend, and averaging extensions.1

This Summary Definition is typically used in a user view with
the following Summary Definitions:
• Monitoring - Alarm History
• Config - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

Monitoring - Analog
Points
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Table 62: Pre-Built Tailored Summary Library
Default ColumnsDescriptionSummary Definition

Name
• Box Area
• Pickup Gain
• Flow
• Cooling Max Flow Setpoint
• Cooling Min Flow Setpoint
• Heating Flow Setpoint

Displays the key flow setup and monitoring information for a
typical single duct, pressure independent VAV Box application.
The rows for this Summary Definition are VMA14 controllers
that are associated with an air handling system.2

Key data from the associated air handling system is typically
added to unique instances of this Summary Definition.

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - VMA 1400 Overview

Monitoring - VMA1400
Flow

• Box Area
• Pickup Gain
• Flow
• Cooling Max Flow Setpoint
• Cooling Min Flow Setpoint
• Heating Flow Setpoint

Displays the key flow setup and monitoring information for a
typical single duct, pressure independent VAV Box application.
The rows for this Summary Definition are VMA16 controllers
that are associated with an air handling system.2

Key data from the associated air handling system is typically
added to unique instances of this Summary Definition.

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - VMA 1600 Overview

Monitoring - VMA1600
Flow

• Zone Temperature
• Supply Temperature
• Setpoint
• Flow
• Flow Setpoint

Displays the key point information for a typical single duct,
pressure independent VAV Box application. The rows for this
Summary Definition are VMA14 controllers that are associated
with an air handling system.2

Key data from the associated air handling system is typically
added to unique instances of this Summary Definition.

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - VMA 1400 Flow

Monitoring - VMA1400
Overview

• Zone Temperature
• Supply Temperature
• Setpoint
• Flow
• Flow Setpoint
• Damper Output
• Heating Output

Displays the key point information for a typical single duct,
pressure independent VAV Box application. The rows for this
Summary Definition are VMA16 controllers that are associated
with an air handling system.2

Key data from the associated air handling system is typically
added to unique instances of this Summary Definition.

This Summary Definition is typically used in a user view with
the following Summary Definition:
• Config - VMA 1600 Flow

Monitoring - VMA1600
Overview

1 The Name attribute of alarm, trend, or averaging extensions must be unique across all extensions on the item (that is, the alarm
and trend item extensions cannot both have a Name attribute of Present Value). You can modify the Name attributes from the
Tailored Summary view using the Global Modify feature. See the Modify Dialog section.

2 You can use the Global Modify feature to add an associated graphic to all the device objects. See the Modify Dialog section.
3 You can use the Global Command feature to send Clear Statistics and Latch Statistics from the Tailored Summary view to

capture the most current diagnostic information. See the Commands Dialog section.

Tailored Summary Attributes
The Select Column Attribute dialog box allows you to select the attributes to display in the Tailored Summary columns.
See the Editing an Existing Summary Definition section for details on accessing and using this dialog box.
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You can filter the available attributes by category using the Attribute Filter list box. The attributes of that category
appear in the Attribute list box. If you filter on Alarms, for example, the alarm attributes appear in the list for selection.

Figure 23: Select Column Attribute Dialog Box

The following table lists examples of the attributes available for display in the Tailored Summary feature according
to the attribute filter.

Note: Click an attribute in the table to view its description. For information on other attributes that do not appear in
this table, search for the attribute using the Help system's Search function, or search within the PDF of the
Help system.

Table 63: Example Tailored Summary Attributes
Example AttributesAttribute Filter
• Alarm Message Text
• Alarm Priority
• High Alarm Limit
• Low Alarm Limit

Alarms

• Average Value
• Minimum Value
• Maximum Value
• Totalize Limit

Averaging and Totalization

• BACnet IP Port
• Instance Number
• Intrinsic Alarming Defined
• Object Name

BACnet
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Table 63: Example Tailored Summary Attributes
Example AttributesAttribute Filter
• Alarm State
• Object Category
• Present Value
• Status

Common Attributes

• Disable Automatic Alarming
• Offline

Field Devices (General)

• DSN 1
• Neuron ID
• Program ID
• XIF Present

Field Devices (LON)

• Memory Usage
• Memory Usage
• Object Count
• Trunk Number

Field Devices (MSTP)

• Device Status
• NCM Name
• Object Count
• Poll Delay

Field Devices (N1)

• Controller Type
• Trunk Number

Field Devices (N2)

• Device Type
• Max Value
• Min Value
• Out of Service

Field Points (General)

• Command Status Mapping Table
• Interface Value
• Target Reference
• Update Interval

Field Points (LON)

• Feedback
• Setpoint
• Value: Present Value (Value)
•

Field Points (N1)

• APDU Retries
• Buffer Overflows
• Bus Health Index
• Bus Performance Index

Integrations (MSTP)

• Missed Messages
• Transmit Errors
• Transaction Timeouts
• Transmits Per Minute

Integrations (LON)
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Table 63: Example Tailored Summary Attributes
Example AttributesAttribute Filter
• Command Count
• Message Timeout
• NAK Errors
• Transmits Per Minute

Integrations (N2)

• ADS Repository
• IP Address
• Model Name
• Object Count

Supervisory Devices

• Buffer State
• Log Enable
• Sample Interval
• Transfer Setpoint

Trends

Tailored Summary Steps
Importing a Summary Definition
Note: You can perform this task in SCT or the online Site Management Portal UI for the Site Director.

1. In the All Items tree, right-click the Summary Definitions folder and select Import Definition. The Import dialog
box appears.

2. Browse to the location on the computer where the Summary Definitions are stored.

Note: The pre-built Summary Definitions are provided on the SCT installation media and the Johnson Controls
BPP. You can save these files to your computer or access them from the SCT installation media or BPP
DVD.

Note: You also can import Summary Definitions that were previously exported. See the Exporting a Summary
Definition section.

3. Select one or more Summary Definitions to import.
4. Click Import. The Notice dialog box appears, indicating the results of the import after all imports complete.

Figure 24: Notice Dialog Box

5. Click OK. The imported Summary Definitions appear in the Summary Definitions folder in the All Items tree.

Exporting a Summary Definition
Note: You can perform this task in SCT or the online Site Management Portal UI for the Site Director.
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1. In the Summary Definitions folder of the All Items tree, right-click the Summary Definition and select Export. The
Export dialog box appears.

2. Browse to the location on the computer to store the Summary Definition.
3. Click Export. The Notice dialog box appears, indicating the results of the export.

Figure 25: Notice Dialog Box

4. Click OK.

Note: You can now share the Summary Definition with others and import it to other sites as desired. If you import
the Summary Definition to another site, you may need to update the key data references.

Editing an Existing Summary Definition
Note: You can perform this task in SCT or the online Site Management Portal UI for the Site Director.

Note: See the Summary Definition Editor and Summary Definition Object sections for information on the editor and
attributes appearing on the Summary Definition.

1. In the Summary Definitions folder of the All Items tree, double-click the Summary Definition. The Summary
Definition appears in the display panel.

2. On the Summary Definition tab, click Edit.
3. In the Label text box, enter the text to display as the label for the row header column (that is, the first column

that contains the user view items). Leave the label blank for an empty heading.
4. Add, remove, and rearrange columns in the table:

• Click the Add/Plus button to add a column at the end of the column configuration table.

• Select a column by clicking the column header and click the Remove/Minus button to remove it from the
table.

• To change the order of the columns, select a column and drag it to the desired placement.

Note: You can define up to a maximum of seven columns. The Add button is disabled if seven columns already
exist. You must define a minimum of at least one column.

5. In the Column Heading text box, enter the text to display as the label for the column header (maximum of 50
characters).

6. In the Child Item text box, leave this field blank to display an attribute of the row item, or add a child item name
using any of the following methods:

• Enter the name of the child item to display.
• Select an item in the All Items tree, user view, or other view (for example, global search results table) and

drag it to the Child Item text box. This functionality is not available in the Create New Summary Definition
Wizard.

• Click the browse button. The Select Item dialog box appears. Select an item name and click OK.

Note: The child item is just an item name, not a Fully Qualified Reference (FQR).

Note: You can define an unlimited number of item names in a comma-delimited list.
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Note: You can define an unlimited amount of wildcards. The first item found that matches this item name
pattern is displayed in the Tailored Summary view column. See the table footnote in the Summary
Definition Tab section for more information on wildcards.

Note: In previous releases, the Name attribute of extensions was typically labeled Present Value. When you
create an extension at Release 5.0 and later, the Name attribute automatically includes the extension
type in the label (for example, Alarm - JCI System Status or Trend - Memory Usage).

If you select the Name attribute of an alarm or trend extension created at a previous release for the
attribute, we recommend renaming the Name attribute to indicate the type of extension so that it is
apparent in the Tailored Summary view (for example, Present Value versus Alarm - Present Value or
Trend - Present Value). Perform a global search and global modification to add Alarm or Trend to the
name; then define the Tailored Summary Child Item as *Alarm* or *Trend* (see Global Search and
Modify Dialog).

Another option is to add *Present Value* as a filter to the Child Items in the summary definition. This
option makes the existing trend extension names compatible if the default name of Present Value was
used. This option is a quick modification to the summary definition only so the existing trend extensions
do not require modification.

7. In the Attribute text box, select the attribute to display as follows (only when selecting an attribute other than
the default attribute):

a. Click the browse button. The Select Column Attribute dialog box appears.
b. In the Attribute Filter list box, select a filter category. The attributes of that type appear in the Attribute list

box. If you filter on Alarm, for example, the alarm attributes appear in the list for selection.
c. In the Attribute list box, select an attribute.
d. Click OK.

Note: To display the default attribute of the row item, leave the Attribute box set to Default (Attribute Filter:
Common Attributes and Attribute: Default).

Note: See the Tailored Summary Attributes section for more information on this dialog box and examples.
8. Click Save.
9. On the Focus tab, click Edit.
10. Make the necessary attribute changes (for example, define the Key Data following the instructions in Defining

Key Data).
11. Click Save.

Defining Key Data
Note: You can perform this task in SCT or the online Site Management Portal UI for the Site Director.

Note: See the Focus Tab and Summary Definition Object sections for information on the Key Data attribute of the
Summary Definition.

1. In the Summary Definitions folder of the All Items tree, right-click the Summary Definition and click View. The
Summary Definition appears in the display panel.

2. On the Focus tab, click Edit.
3. In the Key Data list box, click the browse button. The Modify List dialog box appears (Figure 19).
4. Add Key Data as follows:

Click Add. An undefined item appears in the list.a.
b. Click the Browse button of the item. The Select Item dialog box appears.
c. Select an item.
d. Click OK.

Note: You also can type in the text box and use wildcards (asterisks * only) to search for the item within the
user view folder.
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Note: You can define up to 4 Key Data items.
5. Select an item and click Remove to delete the item from the Key Data list.
6. Select an item and click Move Up or Move Down to rearrange the order the items appear in the list.
7. Click OK.
8. Click Save.

Creating a New Summary Definition
Note: You can perform this task in SCT or the online Site Management Portal UI for the Site Director.

1. From the Insert menu, select Summary Definition. The Create New Summary Definition Wizard appears.
2. On the Identifier screen, enter a name for the Summary Definition.
3. Click Next.
4. On the Configure screen, define the data of the Summary Definition and Configuration tabs. See the Editing an

Existing Summary Definition and Defining Key Data sections for details on how to edit these items.
5. Click Next.
6. On the Summary screen, click Finish. The new Summary Definition appears in the Summary Definitions folder

of the All Items tree.

Defining User Views with Summary Definitions
See the Creating a User View or Editing a User View topics in the User Views section for instructions on how to
perform the task in this procedure.

1. Create a user view or edit an existing one (for example, an HVAC user view).
2. Add a folder to the user view to hold the Summary Definitions. For example, add a Summary Definitions folder,

or a folder named according to function (such as VAV Boxes - VMA1400s, Key Point Information, Engines, or
MSTP Trunk Diagnostics).

3. Drag and drop the definitions from the Summary Definitions folder in the All Items tree to the folder you created
in the user view (or use the user view editor’s add reference option).

4. Drag and drop the items to reference (for example, supervisory devices or points) from the All Items tree or from
the global search results table to the folder in the user view (or use the user view editor’s add reference option).

5. Save the user view.

Viewing a Tailored Summary
Note: You can perform this task in the online Site Management Portal UI for the Site Director. For information on

viewing a Tailored Summary in the Ready Access Portal UI, refer to the Ready Access Portal Help.

1. Click the desired user view tab in the navigation pane.
2. Double-click the user view folder containing the Summary Definition(s) and referenced items (for example, the

Summary Definitions folder). The Tailored Summary appears in the display panel. See the Tailored Summary
View section for a description of this UI.

Note: If the user view does not contain a Summary Definition, only the standard Summary appears.
3. Click the Tailored Summary you want to view from the Available Tailored Summaries list box if more than one

Summary Definition appears in the list. By default, the first authorized Summary Definition in the list is automatically
selected.

4. View the key data and the table data.
5. Use the right-click menu options to command, modify, or otherwise work with the data. See Using a Tailored

Summary.

Using a Tailored Summary
Note: You can perform this task in the online Site Management Portal UI for the Site Director. For information on

using a Tailored Summary in the Ready Access Portal UI, refer to the Ready Access Portal Help.

1. View the Tailored Summary as described in the Viewing a Tailored Summary section.
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2. Work with the Tailored Summary table as follows:

• To issue commands, select one or more items (that is, select the table cells), then right-click and select
Command. To command all items in a column, right-click the column header and select Command. See the
Commands Dialog section for details. For example, use this process to send an operator override command
to multiple items.

• To make modifications, select one or more items, then right-click and select Modify. To modify all items in a
column, right-click the column header and select Modify. See the Modify Dialog section for details. For
example, use this process to change the Object Category for multiple items.

• To view an item, select an item and right-click and select View. The item appears in the display panel.
• To resize a column, place the cursor between the column headers so that the cursor has double-sided arrows

( ). Click and drag the column to the desired width.
• To sort the column data alphanumerically, click a column header. Click the column header again to sort in

the reverse order.
• To rearrange the order of the columns while viewing the Tailored Summary, select a column header and use

drag-and-drop functionality to move it to the desired location.
• To keep a snapshot of the Tailored Summary’s data for later comparison, select and copy the table data.

Then paste it into a program such as Microsoft Excel. Use the keyboard shortcuts Ctrl A, Ctrl C, and Ctrl V.
• To view a graphic associated with field controller, double-click the graphic icon that appears in the second

column of the table (by default). The graphic appears in the display panel.

Figure 26: Viewing a Graphic from a Tailored Summary

• To link a graphic to multiple field controllers, select the field controllers, then right-click and select Modify.
The Global Modify dialog box appears. Edit the Graphic and Graphic Alias attributes as desired and click
Send. This procedure applies only to field controllers. See Performing a Global Modify in the Modify Dialog
section for details.

3. Work with the Key Data table as follows:

• To issue a command, select one item and right-click and select Command. See the Commands Dialog
section.

• To make modifications to an item, select one item and right-click and select Modify. See the Modify Dialog
section for details.

• To view an item, select one item and right-click and select View. The item appears in the display panel.
• To resize a column, place the cursor between the column headers so that the cursor has double-sided arrows

( ). Click and drag the column to the desired width.
• To rearrange the order of the columns, select a column header and use drag-and-drop functionality to move

it to the desired location.
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• To view a graphic associated with a field controller, double-click the graphic icon that appears in the first
column of the table (by default). The graphic appears in the display panel.

• To link a graphic to a field controller, select the field controller, then right-click and select Modify. The Modify
dialog box appears. Edit the Graphic and Graphic Alias attributes as desired and click Send. This procedure
applies only to field controllers. See the Modify Dialog section for details.

Note: You cannot perform global commands/modifications or sort the data in the Key Data table.

Retaining Summary Definitions when Changing the Site Director
1. Export the Summary Definitions. See Exporting a Summary Definition.
2. Promote or demote the Site Director.
3. Import the Summary Definitions. See Importing a Summary Definition.
4. Add the Summary Definitions to the user view folder. See Defining User Views with Summary Definitions.
5. Fix the references in the Key Data, if needed. See Defining Key Data.

Reusing an Existing Summary Definition for Different Key Data
Use this procedure if the key data is the only thing that is different between two different views (for example,
establishing the key data for individual Air Handlers with their associated VAV boxes).

1. Export an existing Summary Definition. See the Exporting a Summary Definition section.
2. Rename the Summary Definition.
3. Import the renamed Summary Definition. See the Importing a Summary Definition section.
4. Make the necessary Object Name and Key Data changes. See the Defining Key Data section.
5. Add the Summary Definition to the desired user view. See the Defining User Views with Summary Definitions

section.

Tailored Summary Troubleshooting
Table 64: Tailored Summary Troubleshooting

SolutionProblem
If you change the Object Name attribute of an object after configuring the Summary
Definition object, the link to the Child Item breaks. Change the Child Item wildcards
in the Summary Definition object to match the new Object Name attribute.

In the Tailored Summary view, the child
item does not display data from an object
after editing its Object Name attribute.

Links to a Tailored Summary from a graphic are supported only in conjunction with
the Ready Access Portal software. Linking to a specific Tailored Summary only
using the Site Management Portal UI is not supported at this time.

To create a graphic link to a Tailored Summary:

1. Log on to the Ready Access Portal UI.
2. View a Tailored Summary in the Ready Access Portal UI.
3. Copy the URL for the Tailored Summary view.
4. Log on to the Site Management Portal UI.
5. Open the graphic where you want to create the link.
6. Add a button and link it to the URL of the Tailored Summary in the Ready

Access Portal UI.

When you click the button, the Ready Access Portal UI will open and display the
Tailored Summary.

You attempt to create a link to a Tailored
Summary from a graphic but are
unsuccessful.
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Table 64: Tailored Summary Troubleshooting
SolutionProblem
This issue was resolved in Release 5.1. If this delay is problematic, we recommend
you upgrade to Release 5.1 or later.

With a Release 5.0 NAE45 Site Director,
points in a Tailored Summary display
slowly and may time out.

On a summary view with more than 500 objects from a single NxE, you may
occasionally see red Xs if the device is busy. As the view continues to update data,
the red Xs disappear.

When running a Tailored Summary, User
Views with large point counts display red
Xs.
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Global Search
The Global Search feature allows you to search the Metasys system for multiple items that meet specific criteria
based on naming and object type. The global search provides you with the ability to manage lists of objects, which
can be used by other features for commanding, trending, reporting, modification, and object selection. For example,
you could create a list of all discharge air temperatures for the AHUs in a building. This feature is especially helpful
in the creation of User Views and Summary Definitions as you can use drag-and-drop functionality to add items from
the search results to these features. The Global Search feature is not available in the SCT.

See Using Global Commands with the Global Search in the Commands Dialog section and Using Global Modify
with Global Search in the Modify Dialog section for steps on using the these features together.

For information on backing up object lists before an upgrade, refer to the Preferences appendix in the NAE
Commissioning Guide (LIT-1201519) or the ADS/ADX Commissioning Guide (LIT-1201645).

Global Search Concepts
Global Search Overview
The Global Search feature allows you to search for objects from an entire site or from a portion of a site (for example,
one or more trunks or devices). The Global Search Viewer offers the ability to add and remove items from the search
scope and search by object name and type. During a search, the items found appear in the results table immediately,
and the status bar shows which location is currently being searched. The status bar also shows the number of items
found.

With the Global Search feature, you can view information about multiple items at once. You can create different
groups of objects and save them as object lists for later use. The Global Search Viewer lets you view summary data
for multiple objects, and allows multiple selection for Global Commanding and Global Modifying.

See the Global Search Viewer Screen and Object List sections.

Global Search Viewer Screen
The Global Search Viewer allows you to perform a global search for like objects in your Metasys system. You can
access the Global Search Viewer from the Query Menu by selecting Global Search. The Global Search Viewer
opens in the Display Frame of the Metasys system Site Management Portal.

You can have multiple Global Search Viewers open, but can only initiate one search at a time within the same UI.
If you try to start another search in the same UI, an error message appears stating you must either stop the search
in progress, or wait until it completes before initiating another search.

By default, the Global Search feature supports a maximum of 500 items displayed in a Global Search Viewer. You
can set the query results in the User Preferences on an ADS/ADX to a maximum of 2,000; however, after displaying
500 results, the values do not dynamically update. If an NxE is the Site Director, you can set the query results to a
maximum of 500. If the search results reach the maximum number of items, a message appears stating the current
search is too broad and you should change the search criteria to narrow the search and try again.

Note: On an NxE with more that 500 items, the Global Search may display red Xs and the message Value cannot
be read. As the view continues to update data, the red Xs disappear. However, once the search reaches
500, results data updates are disabled and the red Xs remain.

169Metasys System Online Help PDF



Figure 27: Global Search Viewer Screen

Table 65: Global Search Viewer Screen Components
DescriptionScreen Area/Item
Provides tips to help you perform a search.Instructions Area

Lists the parts of the Metasys system navigation view you selected to search.

When you initially invoke the Global Search feature, any items currently selected in the
navigation view appear in the Search Locations list box. If no items are selected in the navigation
view, the box appears blank. Make or change selections using the Add and Remove buttons.

Search Locations List Box

Opens the Select Item dialog box and allows you to select the parts of the system you want
to search. You can select items from available views (All Items tab or User View tabs) depending
on your user authorization.

You can search the entire site, one or more devices, one or more trunks on a device, one or
more User Views, and so on. Use the Ctrl or Shift keys when clicking to select multiple items.
After completing the dialog box, the items you selected appear in the Select Scope box.

Add Button

Removes selected items from the Search Locations list box.Remove Button

Allows you to type the full or partial name of the object you want to find. You can leave it blank
for a more expansive search. You also can use one or more wildcards (* or ?) to aid in your
search.

Wildcard Examples:
• LCP-2*
• ZN-T*
• OCC-S*
• N?E* (searches for all items named NAE*, NIE*, and so on)

The object name search is not case-sensitive.

The search looks at the Name attribute. For searches against user navigation views, the search
also considers the user-defined label assigned to the item within that particular navigation view,
and includes the item if its Name attribute or its label matches the search criteria for object
name.

Object Name Box
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Table 65: Global Search Viewer Screen Components
DescriptionScreen Area/Item
Allows you to select a specific type of object to search for or to search for all object types.
Options include:
• All (excluding extensions)
• Trend Extensions
• Totalization Extensions
• Alarm Extensions
• Schedules
• Calendars
• Field Devices
• Field Points

Object Type Drop-Down List

Includes all child objects of any items found when searching the Search Locations. That is, it
includes the nested child objects.

Include child objects Check
Box

Includes the location items in the search results (if they meet the search criteria), as well as
any items found when searching in those locations.

For example, if you initiate a search on an N2 Trunk namedN2 Trunk 1 to search for all objects
named *2*, and you check Include search location objects, the results include the N2 Trunk
in the results. If you do not check the option, the search results only include items under the
N2 Trunk (along with their child objects, if the Include child objects option was checked), and
will not include the N2 Trunk itself.

Include search location
objects Check Box

Begins the search.Search Button

Cancels a search in progress and no more new objects appear in the Search Results table.Stop Search Button

Displays the results of the search (object list).
• Dynamic data in this table automatically refreshes periodically. The refresh rate depends

on the platform to which you are logged in.
• If you select an item in the Search Results and place your cursor over it within each column,

tooltips appear providing more information, if available.
• Any data that does not fit within the columns is identified by an ellipsis (...). You can resize

the column or place your cursor over the table cell to see its tooltip text.
• If the search finds an object in more than one location (for example, in the All Items

navigation view and in a user navigation view), the object is listed twice in the Search
Results Table. If the same location is searched a second time, or if search locations overlap,
the object is not repeated in the table. Items are only repeated in the table if their location
differs.

See the Working with Search Results section for more information on manipulating and using
the table data.

Search Results Table

Displays the icon of the object’s current status as defined by its Status attribute.Status Icon Column

Displays the icon of the object as it appears in the navigation tree.Icon Column

Displays the object’s current status as defined by its Status attribute.Status Column

Displays the object’s name as defined by its Name attribute. The object’s full reference identifier
appears in a tooltip when the cursor is placed over the name.

Name/Label Column

Displays the object’s value as defined by its default attribute (generally, the Present Value
attribute).

Value Column

Displays the Units attribute data for analog objects, Number of States attribute data for multistate
objects, and appears blank for all other objects.

Units/States Column

Displays the data defined in the object’s Description attribute.Description Column

Displays the object’s context, specifically its location within a particular navigation view.Location Column

Displays the object’s type (for example, NAE55).Type Column
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Table 65: Global Search Viewer Screen Components
DescriptionScreen Area/Item
Displays the object’s category as defined by its Object Category attribute (for example, General).Category

Indicates whether a signature is associated with the object.Signature

Indicates whether an annotation is associated with the object.Annotation

Selects all rows in the Search Results table.Select All

Removes all of the objects from the Search Results table.Clear List

Removes selected objects from the Search Results table.Remove From List

Allows you to manually add one or more objects to existing search results (where the added
objects append to the bottom of the existing Search Results table).

Add New

Copies the selected search results in a tab-delimited format to the Clipboard for pasting into
other applications such as Microsoft Excel or Word.

Copy to Clipboard

Displays the current location being searched while the search is in progress, the status of the
search, and the number of objects found.

Status Bar

Object List
The objects listed in the Search Results table make up an object list. You can save an object list for future viewing
and commanding. You can open an existing object list in the Global Search Viewer if you want to access the same
search results without having to perform the search again. You also can open object lists for use by other features
such as the Trend Viewer, Scheduled Reports, Global Commands, and Global Modify. Object lists provide easy
object selection for these features.

When you save an object list, it is saved on the Site Director. Sorting order is not saved in the object list. For
information on working with and using object lists, see the Working with Search Results, Saving an Object List,
Opening an Object List, and Deleting an Object List sections. Also, see the Trend Viewer, Scheduled Reports,
Commands Dialog, and Modify Dialog sections.

The object lists are not saved during a backup of the database, and are deleted during a restore. The files must be
manually saved and restored in order to retain saved lists.

On the ADS/ADX, the files are stored at:

• Windows XP OS and Windows Server® 2003 OS: C:\Documents and Settings\All Users\Application Data\Johnson
Controls\MetasysIII\File Transfer\Object Lists

• Windows 7 OS, and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\File Transfer\Object
Lists).

On the engines, use Remote Desktop within the NxE Information and Configuration Tool (NCT) to access the files.
For information on backing up object lists, refer to the Preferences appendix in the NAE Commissioning Guide
(LIT-1201519) or the ADS/ADX Commissioning Guide (LIT-1201645).

Global Search Steps
Performing a Global Search
Note: When initiating a global search, especially after restarting the ADS/ADX, the operation may timeout. This is

most likely to occur when CPU usage is high.

To perform a global search:

1. From the Query Menu, select Global Search. The Global Search Viewer appears in a display panel. Any items
currently selected in the navigation view appear in the Search Locations list box.

2. In the Search Locations section, click Add. The Select Item dialog box appears.
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Figure 28: Select Item Dialog Box

3. Select the part of the system that you want to search from the available tabs (All Items tab or User View tabs)
depending on your user authorization. You can search the entire site, the All Items navigation tree, a User View,
one or more devices, one or more trunks on a device, and so on. Use the Ctrl or Shift keys when clicking to
select multiple items.

Note: Selecting a User View object from the All Items tab does not search that User View’s contents. You must
select the root of the User View from its tab.

4. Click OK.

Note: To remove items from the Search Locations box, select the item and click Remove.
5. Select the Include child objects check box if you want to include all child objects of any items found when searching

the Search Locations.
6. Select the Include search location objects check box if you want to include the Search Locations in the results.
7. In the Object Name box, type the full or partial name of the object you want to find or leave it blank. You can use

one or more wildcards (* or ?) to aid in your search (for example, N?E*). The object name search is not
case-sensitive.

8. From the Object Type menu, select the type of object to search or select All (excluding extensions).
9. Click Search. The search begins and the Search Results table fills with any matching object information. When

finished, the status section displays Search Completed and the number of objects found.

Note: If you rename an object, you must remove the old name from the Search Locations list before the object can
appear in the results list under its new name.

See the Working with Search Results section.

Stopping a Search
To stop a running search, click Stop Search.
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Working with Search Results
Selecting Objects in the Search Results
To select objects in the search results, click an individual object in the Search Results table or use the Ctrl or Shift
keys when clicking to select multiple items.

To select all of the search results, click Select All.

Note: You also can click and drag your cursor over objects in the Search Results table to select objects that appear
consecutively.

Note: You can use drag-and-drop functionality to add items from the Global Search Results table to a User View
or Summary Definition. View both the Global Search Viewer and the User View or Summary Definition in the
display frame (using a multiple panel view). Click Edit in the User View or Summary Definition. Then drag
the desired items from the Search Results table to the User View or Summary Definition.

Note: You also can drag an item from the Global Search Results table and drop it into an empty display panel to
view the item.

Removing Objects from the Search Results
1. Click an individual object in the Search Results table or use the Ctrl or Shift keys when clicking to select multiple

items.
2. Click Remove From List. The Confirm Delete dialog box appears asking if you want to delete the selected item

from the list.
3. Click Yes.

Note: You also can use the Delete key to remove selected objects from the Search Results table.

Clearing All Search Results
1. Click Clear List. The Confirm Delete dialog box appears asking if you want to delete all the items from the list.
2. Click Yes.

Manually Adding Objects to Existing Search Results
Note: The added objects append to the bottom of the existing Search Results table.

1. Click Add New. The Select Item dialog box appears.
2. Select the object to add to the search results. Use the Ctrl or Shift keys when clicking to select multiple items.
3. Click OK.

Adding New Search Results to Existing Search Results
To add new search results to existing search results (where the results of the new search append to the bottom of
the existing Search Results table):

1. In the Search Locations box, remove the existing location, if desired, by selecting it and clicking Remove. The
existing search results remain in the Search Results table.

2. Perform Step 2 through Step 9 in the Performing a Global Search section to add the new search criteria and
execute the search. The results appear at the bottom of the Search Results table.

Sorting Search Results
To sort search results, click the heading of the desired column. The results sort and a small red triangle appears
indicating the order of the sort (ascending or descending). Click the column heading again to change the sort order.

Expanding and Collapsing the Global Search Viewer Display Areas
To expand and collapse the Search Locations, Search Criteria, and Search Results table display areas of the Global
Search Viewer, click one of the splitter bar arrows located between the display areas to show and hide the
section. Continue to click until the desired display is achieved.

Reordering Columns in the Search Results Table
To reorder the columns in the Search Results table, drag the heading of the column to the desired location.
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Printing the Search Results Table
To print the Search Results table (object list), follow the Printing instructions in the Site Management Portal User
Interface section.

Note: You also can use the Scheduled Reports feature to run reports and print object lists. See the Scheduled
Reports section.

Commanding Objects in the Search Results Table
To command objects in the Search Results table (object list):

1. Select one or more objects following the instructions in the Selecting Objects in the Search Results section.
2. If you selected one object, right-click and select Commands. The Command dialog box appears. Follow the

Commanding Items instructions in the Site Management Portal User Interface section.

If you selected two or more objects, right-click and select Commands. The Global Commands dialog box appears.
See the Commands Dialog section.

Modifying Objects in the Search Results Table
1. Select one or more objects following the instructions in the Selecting Objects in the Search Results section.
2. If you selected one object, right-click and select Modify. The Modify dialog box appears. Follow the Editing Items

instructions in the Site Management Portal User Interface section.

If you selected two or more objects, right-click and select Modify. The Global Modify dialog box appears. See
the Modify Dialog section.

Copying Search Results to the Clipboard
1. Select the desired results according to the Selecting Objects in the Search Results section.
2. Click Copy to Clipboard.

Note: You also can use Ctrl-C to copy the data.
3. Open the program to paste the results (for example, Microsoft Excel or Word).
4. Paste the results according the program’s conventions (generally, Edit > Paste).

Saving an Object List
To save an object list (objects appearing in the Search Results table):

1. From the Query Menu, select Save Object List, or right-click the Global Search Viewer title bar and select Save
Object List. The Save Object List dialog box appears.

2. In the Name box, enter a unique name for the object list. This name must be unique, otherwise you risk overwriting
an existing object list.

3. In the Category list, select All or select the desired category (for example, General, Security, and Lighting) to
which you want to save the list. You only can save to authorized categories based on your user rights defined
in the Security Administrator system.

Note: If you select a specific category, the object list is available for use or modification only by users with the
proper authorization for that category. If you select All, all users can access the object list, including the
ability to open, modify, or delete the list.

4. Click Save. The object list is saved on the Site Director.

Note: Sorting order is not saved in the object list.

Opening an Object List
1. From the Query Menu, select Open Object List, or right-click the Global Search Viewer title bar and select Open

Object List. The Open Object List dialog box appears.
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Figure 29: Open Object List Dialog Box

2. Select the desired object list to open. You can only open object lists under All, and under categories for which
you have View access.

3. Click Open. The Global Search Viewer appears in the display panel with the search criteria and the object list
filling the Search Results table.

Note: Objects that are renamed in the UI after an object list is saved do not reflect the new name in the object list
until the object list is re-saved.

Modifying an Object List
See the procedures in the Working with Search Results section.

Deleting an Object List
1. From the Query Menu, select Delete Object List. The Delete Object List dialog box appears.
2. Select the desired object list to delete from the tree. Use the Ctrl or Shift keys when clicking to select multiple

object lists. You can only delete object lists under All, and under categories for which you have authorization
based on your user rights defined in the Security Administrator system.

3. Click Delete.
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Commands Dialog
The Commands dialog box allows you to send a command to a single item (single command feature) or to multiple
items at once (global commands feature). You can open the Global Search Viewer or a Tailored Summary, for
example, in a display panel and select one or more items from the table to command. For example, you could send
a command to open all the reheat valves on VAV boxes so the balancer can balance the hot water system in your
facility.

The single command feature uses the Commands dialog box. The global commands feature uses the Global
Commands dialog box for sending commands and uses the Change Results Viewer for viewing, saving, and printing
the sent global commands.

For information on the Change Results Viewer and how to use it, see the Change Results Viewer section. The
Change Results Viewer is used by both the Global Modify and the Global Commands features.

See Using Global Commands with the Global Search in this section for steps on using the Global Search and Global
Commands features together.

Commands Dialog Concepts
Commands Overview
You can send a command by selecting one or more Metasys system objects (items) in the navigation tree or in the
display panel. For example, you can open the Global Search Viewer in a display panel and select one or multiple
items from the Search Results table to command. See Commanding Objects in the Search Results Table in the
Global Search section.

For the global commands feature, the Change Results Viewer displays the results of all global commands sent
during the current user session. The viewer includes information such as change type, time, status, item name, and
parameter. You can save the results to a text file or print the results if you wish to review them at a later time. The
Change Results Viewer provides the option to copy one or more result entries to the clipboard for pasting into other
applications such as Microsoft Excel or Word. You also can sort the results table data in ascending or descending
order, and resize and reorganize the columns to suit your needs.

Once you log out of the Metasys system, the current user session closes and the items in the Change Results Viewer
are permanently cleared.

See the Commands Dialog Box, Global Commands Dialog Box, and Change Results Viewer sections.

Commands Dialog Box
The Commands dialog box allows you to configure and send a command to a single item in the Metasys system.
You can access the Commands dialog box from the Action Menu by selecting Commands. You also can access the
Commands dialog box from the right-click menu (in supported views).

Note: Commands issued through the Commands dialog box are not shown in the Change Results Viewer.

Table 66: Commands Dialog Box Components
DescriptionScreen Area/Item
Provides tips to help you send a command.Instructions Area

Allows you to filter the commands shown in the commands list by:
• All Commands: Shows all commands for the item.
• Primary Commands: Shows the commonly used commands for the item. Selecting this

setting shows only the Archive, Reset Device, and Route Samples commands.
• Secondary Commands: Shows the less commonly used commands for the item. Selecting

this setting shows only the Change Audit Enabled Class Level, and Update Flash Usage
commands.

Note: User Preferences determines the default setting.

Show Command Set
Drop-Down Menu
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Table 66: Commands Dialog Box Components
DescriptionScreen Area/Item
Displays the list of commands available for the selected item. Unauthorized commands are either
grayed out (disabled) or not shown (hidden), depending on user preference settings. The default
is grayed out. For commands that require parameter values, the fields appear after selecting the
command.

Commands List

Sends the selected command to the object/item. All commands are sent at the default priority
for the command.

Send

Closes the Commands dialog box without sending the command.Cancel

Global Commands Dialog Box
The Global Commands dialog box allows you to configure and send a command to multiple items in the Metasys
system. You can access the Global Commands dialog box from the Action Menu by selecting Commands. However,
you must have more than one object selected in the navigation tree or the display panel to open the Global Commands
dialog box. You also can access the Global Commands dialog box from the right-click menu (in supported views).

Figure 30: Global Commands Dialog Box - Commands Tab
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Figure 31: Global Commands Dialog Box - Items Tab

Table 67: Global Commands Dialog Box Components
DescriptionScreen Area/Item
Provides tips to help you send a global command.Instructions Area

Allows you to filter the commands shown in the commands list by:
• All Commands: Shows all commands for the item.
• Primary Commands: Shows the commonly used commands for the item. Selected this setting

shows only the Off, On, Operator Override, Release Operator Override, and Change Default Value
commands.

• Secondary Commands: Shows the less commonly used commands for the item. Selecting this
setting shows only the Release and Release All commands.

Note: User Preferences determines the default setting.

Commands Tab: Show
Command Set
Drop-Down Menu

Displays the list of commands available for the selected items. Unauthorized commands are either
grayed out (disabled) or not shown (hidden), depending on user preference settings. The default is
grayed out. For commands that require parameter values, the fields appear after selecting the command.

Commands Tab:
Commands List

Lists the selected items in table format and indicates:
• if you are authorized/unauthorized to send the command to the items
• the command to be sent
• the number of items to be commanded

Items Tab

Sends the selected command to the objects listed in the Items tab. All commands are sent at the
default priority for the command.

Send

Closes the Global Commands dialog box without sending the command.Cancel

When selected, displays the Change Results Viewer in the display panel after clicking Send.Show Command
Results

Global Command Support
The following table lists the objects that can be commanded using the global command feature, and the available
commands.
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Table 68: Global Command Support
CommandsObject1

• Present ValueAccumulator Objects

• Enable
• Disable
• Cancel Delay Time
• Cancel Report Delay

Alarm Extensions

• In Service
• Out of Service

Analog Input Object

• Release All
• Release
• Operator Override
• Release Operator Override
• Adjust
• Setpoint (N2 AO only)

Analog Output Object

• Release All
• Release
• Operator Override
• Release Operator Override
• Adjust
• Change Default Value (MS/TP FEC/FAC AV only)

Analog Value Object

• In Service
• Out of Service

Binary Input Object

• Release All
• Release
• Operator Override
• Release Operator Override
• State Commands2

Binary Output Object

• Release All
• Release
• Operator Override
• Release Operator Override
• State Commands2

• Change Default Value (MS/TP FEC/FAC BV only)

Binary Value Object

• Clear Statistics
• Latch Statistics

Integration Objects3

• Unlock
• Lock
• Shed
• Release Load
• Comfort Override
• Release Comfort Override
• Enable
• Disable

Load Extensions
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Table 68: Global Command Support
CommandsObject1

• Release All
• Release
• Operator Override
• Release Operator Override
• State Commands4

• Enable
• Disable

Multiple Command Object

• In Service
• Out of Service

Multistate Input Object

• Release All
• Release
• Operator Override
• Release Operator Override
• State Commands4

Multistate Output Object

• Release All
• Release
• Operator Override
• Release Operator Override
• State Commands4 MSV Mapper (MS/TP FEC MSV only):
• Set State Command
• Change Default Value

Multistate Value Object

• Enable
• Disable

Optimal Start Object

• Enable
• Disable

Schedule Object5

• Clear
• Execute
• Enable
• Disable
• Route

Trend Extensions

• Reset
• Enable
• Disable

Totalization Extensions

1 You must select and command similar object types. For example, you cannot send a command to both alarm extensions and
trend extensions at once. You need to command the alarm extensions and trend extensions separately.

2 For binary objects, state commands display as the generic State0 and State1 commands if the States Text attribute is different.
If the States Text attribute is the same, then the specific states text is used (for example, On or Off).

3 Integrations include Field Bus, XL5K, N2 Trunk, Vendor Devices (VND), Wireless Supervisor, BACnet, and N1 Migration.
4 For multistate objects, state commands display as the generic State0 and State1 commands if the States Text attribute is

different. If the States Text attribute is the same, then the specific states text is used (for example, On, Off, or Auto). In addition,
you can command multistate items together only when the number of states matches.

5 This works only for schedules in the NxE, not the FAC.
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Commands Dialog Steps
Commanding an Item
Note: You must be in online mode to issue commands to items.

To send a command to an item in a graphic, see the User Graphics Tool (UGT) section. To send a command to an
item in a Graphics+ graphic, see the Graphics+ section. To send a command to multiple items, see the Commanding
Multiple Items (Global Command) section.

To command an item:

1. Select the item to command in the navigation tree or in the display panel.

2. From the Action Menu, select Commands, or right-click and select Commands.
3. Filter the list of commands using the Show Command Set drop-down menu, if desired.
4. Select the command to issue.

Note: After selecting one of the available commands, you may be prompted to specify additional parameters
for the command.

5. Click Send.

Note: If an error occurs while sending the command, the dialog box remains open.

Commanding Multiple Items (Global Command)
This procedure sends a command to more than one item. For information on sending a command to a single item,
see Commands in the Site Management Portal User Interface section.

To command multiple items (send a Global Command):

1. Select the desired, compatible objects in the navigation tree or in the display panel. Hold the Ctrl or Shift keys
when clicking to select multiple items in the navigation tree, or use the selection conventions of the feature
displayed in the display panel. For example, see Commanding Objects in the Search Results Table in the Global
Search section.

Note: You must select and command similar object types. For example, you cannot send a command to both
alarm extensions and trend extensions at once. You need to command the alarm extensions and trend
extensions separately.

2. From the Action Menu, select Commands, or right-click and select Commands. If you selected objects from the
navigation tree, a Preparing Command Data box appears stating the authorization information for the selected
objects is being retrieved. The Global Commands dialog box appears.

Note: If you click Cancel on the Preparing Command Data box, both it and the Global Commands dialog box
close without issuing commands.

Note: If no commands are available for the selected objects or if you have selected incompatible object types,
a dialog box appears stating so. Click OK. The Commands dialog box does not open. Go back to Step
1.

3. On the Commands tab, filter the list of commands using the Show Command Set drop-down menu, if desired.
4. On the Commands tab, select the command to send to the objects.

Note: After selecting one of the available commands, you may be prompted to specify additional parameters
for the command.

5. On the Items tab, review the list of objects to command.

Note: To change the objects in this list, click Cancel and go back to Step 1.
6. Select the Show Command Results check box to display the Change Results Viewer after issuing the command.
7. Click Send. The command is sent to the selected objects and the Change Results Viewer appears if you selected

the Show Command Results check box.
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Note: If you are not authorized to send a global command to one or more objects, a dialog box appears stating
the command will not be sent to unauthorized objects. Click Yes to continue to send the command to the
authorized objects. Click No to return to the Command dialog box without sending the command to any
objects. Click Cancel to close the Command dialog box without sending the command to any objects.
Your system access and category-based privileges set in the Security Administrator System determine
your authorization.

After the command has been sent to all selected items, the Global Command Completed dialog box appears
indicating:

• the command sent
• the date/time the command started and completed
• the number of successful/failed commands
• if any commands were not sent because they were unauthorized
• the total commands attempted

Figure 32: Global Command Completed Dialog Box

8. Click OK.

See Working with the Change Results Viewer in the Change Results Viewer section.
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Using Global Commands with the Global Search
To use Global Commands with the Global Search:

1. Perform a global search according to the Performing a Global Search procedure in the Global Search section.
For example, search for alarms that you plan to command.

2. Save the object list if this is a common search (for example, you plan to command the alarms or review their
status often). See Working with Search Results and Saving an Object List in the Global Search section.

3. Select the items in search results table and send a global command (for example, enable or disable alarms)
according to the instructions in the Commanding Multiple Items (Global Command) section.

Note: In addition to these options, you can perform a global modification on items in the object list. Select and
right-click the items, and modify them as desired. See the Modify Dialog section.

184Metasys System Online Help PDF



Modify Dialog
Note: The term edit refers to changing items using the Edit button. See Editing Items in the Site Management Portal

User Interface section. The term modify refers to changing items using the Modify menu item and the Modify
dialog box as described in this section.

The Modify dialog box allows you to modify attributes of a single item (single modify feature) or multiple items at
once (global modify feature). You can open the Global Search Viewer or a Tailored Summary, for example, in a
display panel and select one or more items from the table to modify. For example, you could send a modification to
change the Object Category of all VAV boxes in your facility from General to HVAC. Only attributes common to all
items being modified appear in the Global Modify dialog box.

The single modify feature uses the Modify dialog box. The global modify feature uses the Global Modify dialog box
for sending modifications and uses the Change Results Viewer for viewing, saving, and printing the sent global
modifications.

For information on the Change Results Viewer and how to use it, see the Change Results Viewer section. The
Change Results Viewer is used by both the Global Modify and the Global Commands features.

See Using Global Modify with Global Search in this section for steps on using the Global Search and Global Modify
features together.

Single and Global Item Modify Concepts
Modify Dialog Box
The Modify dialog box allows you to modify attributes of a single item in the Metasys system. You can access the
Modify dialog box for the selected item by selecting the Modify menu option from the Action Menu or the right-click
menu. The attributes shown in the modify box are different for different object types.

Figure 33: Modify Dialog Box
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Table 69: Modify Dialog Box Components
DescriptionScreen Area/Item
Provides tips to help you send a modification.Instructions Area

Displays the list of attributes available to modify for the selected item. Unauthorized modifications
are disabled. Attribute value fields appear after the attribute name.

The check box next to an attribute is automatically selected when you make a modification in its
value field. Modifications are sent for only the selected (checked) attributes.

Attributes Table

Sends the selected modifications to the object/item.Send

Closes the Modify dialog box without sending the changes.Cancel

Global Modify Dialog Box
The Global Modify dialog box allows you to modify common attributes of multiple items in the Metasys system. You
can access the Global Modify dialog box for the selected items by selecting the Modify menu option from the Action
Menu or the right-click menu.

Figure 34: Global Modify Dialog Box - Attributes Tab
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Figure 35: Global Modify Dialog Box - Items Tab

Table 70: Global Modify Dialog Box Components
DescriptionScreen Area/Item
Provides tips to help you send global modifications.Instructions Area

Displays the list of common attributes available to modify for the selected items. Unauthorized
modifications are disabled. Attribute value fields appear after the attribute name.

The check box next to an attribute is automatically selected when you make a modification in its
value field. Modifications are sent for only the selected (checked) attributes.

Attributes Tab

Lists the selected items in table format and indicates:
• if you are authorized/unauthorized to modify the items
• the number of items to be modified

Items Tab

Sends the selected modification to the objects/items listed in the Items tab.Send

Closes the Global Modify dialog box without sending the changes.Cancel

Displays the Change Results Viewer in the display panel after clicking Send (when this box is
checked).

Show Modify Results

Modify Attributes
The following table lists the attribute groupings and examples of the attributes available for modification.
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Table 71: Modify Attributes
Example AttributesAttribute Grouping
• COV Increment
• Display Precision
• Object Category
• Units

General

• BACnet Deadband
• High Limit
• Low Limit

BACnet Intrinsic Alarming

• Differential
• High Alarm Limit
• Low Alarm Limit

Alarm Values

• Alarm Ack Required
• Alarm Message Text
• Alarm Priority
• Event Enable

Alarm Setup

• Graphic
• Graphic Alias

Graphic Setup

Modify Dialog Steps
Modifying a Single Item
For information on editing an item using the Edit button in the display panel, see Editing Items in the Site Management
Portal User Interface section.

This procedure is for modifying a single item. To modify multiple items, see Performing a Global Modify.

You can modify an item from the navigation tree, display panel view (for example, Tailored Summary view), or Global
Search Results table.

To modify a single item:

1. Select and right-click a single item in the navigation tree, display panel view, or global search results. Select the
Modify menu item. Or, select a single item and select the Modify command from the Action menu. The Modify
dialog box appears.

2. Make changes to one or more attributes as desired.
3. Click Send.

Note: You cannot use the modify feature to modify items that reside on a Release 2.2 or earlier device. If you
attempt to modify Release 2.2 or earlier items, one of the following errors appears: Object does not exist
or One or more attribute modifications failed error appears.

Performing a Global Modify
For information on editing an item using the Edit button in the display panel, see Editing Items in the Site Management
Portal User Interface section.

This procedure is for modifying more than one item in a single operation. To modify a single item, see Modifying a
Single Item.

You can globally modify items online and in the SCT.

You can perform a global modification on items from the navigation tree, display panel view (for example, Tailored
Summary view), or Global Search Results table.
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Note: Once sent, you cannot undo a global modification; however, you can send another global modification to
readjust values as needed.

To perform a Global Modify:

1. Select multiple items in the navigation tree, display panel view, or global search results. Right-click the items
and select the Modify menu item. The Global Modify dialog box appears.

Note: The Items tab lists the selected items and your permissions to modify them.

2. On the Attributes tab, make changes to one or more attributes as desired.
3. Select the Show Modify Results check box to display the results of the modifications, if desired.
4. Click Send. If you selected to view results, the Change Results Viewer appears in a display panel. The Change

Results Viewer has options to copy the results, save the results to a file, and clear the results.

Note: If you are not authorized to send a global modification to one or more objects, a dialog box appears stating
the modification can not be sent to unauthorized objects. Click Yes to continue to send the modification
to the authorized objects. Click No to return to the Modify dialog box without sending the modification to
any objects. Click Cancel to close the Modify dialog box without sending the modification to any objects.
Your system access and category-based privileges set in the Security Administrator System determine
your authorization.

Note: On an MVE site, you are prompted to authorize this action (only once) with the defined annotation and/or
electronic signature requirements.

After the modification has been sent to all selected items, the Global Modify Completed dialog box appears
indicating:

• the attributes that were modified (appears in a comma delimited list)
• the date/time the modification started and completed
• the number of successful/failed modifications
• if any modifications were not sent because they were unauthorized
• the total modifications attempted

Figure 36: Global Modify Completed Dialog Box

5. Click OK.

Note: You cannot use the modify feature to modify items that reside on a Release 2.2 or earlier device. If you
attempt to modify Release 2.2 or earlier items, one of the following errors appears: Object does not
exist or One or more attribute modifications failed.

See Working with the Change Results Viewer in the Change Results Viewer section.
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Using Global Modify with Global Search
To use Global Modify with Global Search:

1. Perform a global search according to the Performing a Global Search procedure in the Global Search section.
For example, search for alarms that you plan to modify.

2. Save the object list if this is a common search (for example, you plan to modify the alarms or review their status
often). See Working with Search Results and Saving an Object List in the Global Search section.

3. Select the items in the search results and send a global modify according to the instructions in the Performing
a Global Modify section.

Note: In addition to these options, you can perform a global command on items in the search results. Select and
right-click the items, and command them as desired. See the Commands Dialog section.
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Change Results Viewer
The Change Results Viewer allows you to view, save, and print the results of global commands and global
modifications sent using the Global Commands and Global Modify features. See the Commands Dialog and Modify
Dialog sections for information on these features.

Change Results Viewer Concepts
Change Results Viewer Overview
The Change Results Viewer displays the result entries for the global commands and global modifications sent during
the current user session. You can access the Change Results Viewer by selecting Change Results from the View
Menu.

Note: The Change Results Viewer screen is available for global commands and global modifications only. Single
object commands and modifications do not appear in the Change Results Viewer.

Figure 37: Change Results Viewer Screen
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Table 72: Change Results Viewer Screen Components
DescriptionColumn/Button
Displays the results of all global commands/modifications sent during the current user session.

If you select an item in the table and place your cursor over it within each column, tooltips appear
providing more information, if available.

Any data that does not fit within the columns is identified by an ellipse (...). You can resize the
column or place your cursor over the table cell to see its tooltip text.

If you send another global command/modification at a later time during the current user session,
the result entries are added to any existing result entries from prior commands/modifications sent
during the session.

The most recent entry appears at the top of this table by default. If desired, you can sort the
results.

See the Working with the Change Results Viewer section for more information on manipulating
and using the table data.

Change Results Table

Displays the date and time the command/modification was sent.When

Displays the name of the object to which the command/modification was sent. The object’s full
reference identifier appears in a tooltip when you place the cursor over the name.

Item

Displays the type of command/modification sent.Change Type

Displays the list of parameters for the command/modification that was sent. For example, for a
Release command, an attribute and priority such as Present Value, 15 (Scheduling) appear in
the Parameters column.

Parameters

Displays the status of the command/modification that was sent (for example, OK or an explanation
of failure).
Note: An OK status for a command indicates the supervisory device validated and accepted

the command, but does not necessarily indicate the command executed successfully.
There may be cases where the command is accepted, but fails execution. For example,
a Route command to a trend extension may be accepted by the supervisory device with
a status of OK, but if the actual routing of the trend data fails due to the ADS offline or
other error, the failure is noted in the Audit log at that point in time.

Note: An OK status for a modification indicates the modification executed successfully.

Status

Deletes all the entries from the Change Results Viewer and adds an entry to indicate when it
cleared those entries.

Clear Results Viewer

Copies the selected change results to the Clipboard for pasting into other applications such as
Microsoft Excel or Word.

Copy

Saves the current content of the change results table to a text file.Save to File

Change Results Viewer Steps
Working with the Change Results Viewer
Displaying the Change Results Viewer
To display the Change Results Viewer, select Change Results from the View Menu. The Change Results Viewer
appears in the display panel.

Note: If no global commands/modifications were issued during the current user session, the Change Results Viewer
appears with a message stating No global commands or modifications have been issued within the
current session.

Selecting Entries in the Change Results Viewer
To select entries in the Change Results Viewer, click an individual entry in the change results table or use the Ctrl
or Shift keys when clicking to select multiple entries.
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Note: You also can click and drag your cursor over entries in the change results table to select entries that appear
consecutively. With an entry in the change results table selected, you can press Ctrl+A to select all entries.

Sorting Change Results in the Change Results Viewer
To sort change results in the Change Results Viewer, click the heading of the desired column in the change results
table. The results sort and a small arrow appears indicating the order of the sort (ascending or descending). Click
the column heading again to change the sort order.

Reordering Columns in the Change Results Viewer
To reorder the columns in the Change Results Viewer, drag the heading of the column to the desired location.

Printing the Change Results
To print the contents of the Change Results Viewer, follow the Printing instructions in the Site Management Portal
User Interface section.

Saving Change Results to File
To save the contents of the Change Results Viewer to a file:

1. Click Save to File. The Save dialog box appears.
2. Specify the desired location to save the results.

Note: The default name for the text file is ChangeResultsLog.txt. You can change the name as you wish to
further identify these results, or to prevent overwriting previously saved results.

3. Click Save.

Copying Change Results to the Clipboard
To copy change results in the Change Results Viewer to the clipboard:

1. Select the desired results according to the Selecting Entries in the Change Results Viewer section.
2. Click Copy.

Note: You also can use Ctrl+C to copy the data.
3. Open the program to paste the results (for example, Microsoft Excel or Word).
4. Paste the results according the program’s conventions (generally, Edit > Paste or Ctrl+V).

Clearing the Change Results Viewer
If the size of the results log becomes too large, the Global Command or Global Modify feature prompts you to clear
the change results.

To clear all change results in the Change Results Viewer:

1. Click Clear Results Viewer. A dialog box appears asking if you want to permanently clear all command results.
2. Click Yes.
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Alarm and Event Management
The alarm and event feature provides event management for the Metasys system. This feature allows you to configure
the detection of alarm conditions and the routing of event messages to destinations such as an e-mail account or
pager for acknowledgement. The Alarms Window displays event messages in a prioritized order and allows you to
respond to the alarms. The Event Viewer provides the functionality to retrieve and examine event messages stored
in an event repository.

For information on alarm and event management for Metasys systems integrated with BACnet devices, see the
Alarm and Event Management for Metasys Systems Integrated with BACnet Devices topics.

Alarm and Event Management Concepts
Alarm and Event Management Overview
An event is a notification of a state change of an item in the system. When a value in an Advanced Application Field
Equipment Controller (FAC), Engine, or ADS/ADX deviates from its normal operating condition, such as exceeding
a high limit or failing to respond to a command within a specified time period, the system detects a change of state
and the FAC, Engine, or ADS/ADX generates an event message.

When an FAC generates an event message, it temporarily stores the event message in its Event Log. It also
immediately forwards the event message to the Engine to which it is connected. When an Engine generates an
event message, it temporarily stores the message in its local event repository. When an ADS/ADX generates an
event message, it permanently stores the message in its ADS/ADX event repository. You can send event messages
stored in the local event repository of an Engine to the event repository of an ADS/ADX for permanent storage by
defining an ADS/ADX event repository as the default destination. Also, you can route event messages to other
destinations such as a pager or an e-mail account. For more information, see the Event Repositories and Event
Message Routing, Filtering, and Destinations sections.

For sites with MVE installed, configure the following attributes in the Site Object:

• Annotation Include
• Annotation Exclude
• Annotation Alarm Priority Threshold
• Signature Include
• Signature Exclude
• Signature Alarm Priority Threshold

These settings apply to only MVE sites, and enable the MVE required annotations and electronic signature for event
messages. You can apply these settings at the site level or down to the object level as needed. You can define the
settings to require an electronic signature, an annotation, neither, or both. When both options are required, and a
user acknowledges or discards an event message, they are prompted to reauthenticate and enter a reason and
annotation for the action. The user’s logon name, date and time of signature, and the reason for signature are saved
as part of the annotation. You cannot delete annotations on an MVE site.

Non-MVE sites may optionally define and use annotations; however, electronic signatures are specific to MVE sites.

SeeConfiguring Annotation and Electronic Signature Requirements in the Site Object inMVE in the Site Management
Portal User Interface section. For additional information, refer to the Metasys for Validated Environments, Extended
Architecture Technical Bulletin (LIT-12011327).

The Alarms Window and Event Viewer allow you to examine and respond to event messages. The Alarms Window
displays event messages one at a time in a prioritized order and allows you to respond to the newest alarm first.
The Event Viewer displays all of the event messages stored in the event repository of the currently selected device.
In addition, Alarm Reports allow you to query for alarm conditions in the Metasys system online and provide a list
of items that are currently in an alarm condition.

Note: The current navigation view does not limit or affect the alarm notification; only the user’s permissions for
managing item events can. Therefore, it is possible for a user to receive an alarm for an item that does not
exist in the currently displayed navigation view.
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The following figure shows the flow of event messages through the Metasys system.

Figure 38: Event Message Flow

For information on how to configure and route event messages for Metasys systems integrated with BACnet devices,
see the Alarm and Event Management for Metasys Systems Integrated with BACnet Devices topics.

Alarm Extensions
Using object alarm extensions is a very easy method for configuring the detection of alarm conditions. To configure
the values that determine alarm condition detection, use the Alarm Extension Wizard that appears after creating an
object using the Insert Object Wizard. You also can add alarm extensions after you create an object by selecting it
in the navigation tree and selecting Show Extensions from the Action Menu. You cannot add, edit, or delete alarm
extensions in online mode with Basic Access.

Use alarm extensions to define the values for the high/low warning and high/low alarm conditions for Analog Input
Object, Analog Output Object, and Analog Value Object. For a complete list of Analog Alarm extension attributes,
see Analog Alarm Attributes.

Also, use alarm extensions to define the values for the alarm and trouble conditions for Binary Input Object, Binary
Output Object, Binary Value Object, Multistate Input Object, Multistate Output Object, and Multistate Value Object.
For a complete list of Multistate Alarm extension attributes, see Multistate Alarm Attributes.

In addition, you can use alarm extensions to define the following conditions:

• alarm state parameters such as Event Enable, Delay Time, and Report Delay
• alarm setup parameters such as Acknowledgment Required, Alarm Message Text, and associated Graphics

Devices with the Disable Automatic Alarming attribute set to True do not produce an alarm but indicate they are
offline in the navigation tree with a red X. See the appropriate object in the Object Help for details on this attribute.
This attribute does not affect alarm extensions.

The Enable Alarms and Disable Alarms commands affect any and all alarm extensions defined for an object.

For more details on configuring alarm extensions, see Creating Extensions, Alarm Extensions, and the Help section
for the selected object.

After using alarm extensions to configure the detection of alarm conditions, you must configure the routing, filtering,
and format of event messages from Engine or ADS/ADX to the desired destinations. For more information on filtering
or routing events messages, click one of the following section names:

• Event Message Routing, Filtering, and Destinations
• Configuring Destination Delivery Agents (DDAs)
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• Applying Filters for Routing Event Messages to Destinations
• Configuring Event Message Format

For information on AO/BO feedback, see AO/BO Feedback.

Event Repositories
The Metasys system has three event repositories for storing event messages:

Table 73: Event Repositories
DescriptionType
• Provides temporary storage for event messages on the Engine.
• Allows the event messages stored in the local Engine event repository to appear in the Event

Viewer and Alarms Window.
• Sends event messages from the local Engine event repository to the definedDefault Destination.

Local (Engine) Event
Repository

• Provides permanent storage for event messages on the ADS/ADX platform.
• Event messages generated on an ADS/ADX platform are placed directly into the ADS/ADX

event repository.
• Allows the event messages stored in the ADS/ADX event repository to appear in the Event

Viewer and Alarms Window.
• Receives event messages from multiple local Engine event repositories and provides permanent

storage for the event messages. The ADS/ADX event repository is usually defined as the
Default Destination for event messages from local Engine event repositories.

• Provides the option to send event messages from a single ADS/ADX event repository to one
or more ADS/ADX event repositories for permanent storage. See theConfiguring an ADS/ADX
Event Repository section for details.

ADS/ADX Event
Repository

• Event logs are only viewable in the CCT. Configure the Advanced tab to work with Advanced
Application Field Equipment Controllers (FACs) to record events via events logs. See Working
with the Advanced Tab in the CCT Help (LIT-12011147).

• The CCT can be set up to send event notifications from the FAC event logs to other devices.
See Setting up Device Notification in the CCT Help (LIT-12011147).

FAC's Event Log

For information on configuring the event repositories, click one of the following section names:

• Configuring an Engine Event Repository
• Configuring an ADS/ADX Event Repository

A Database Timeout Error can occur when viewing events if the repository contains too many events to be filtered
before the system times out (typically, one million events). To prevent this error, you should backup and purge event
records from the repository (JCIEvents) using the Metasys Database Manager on a regular basis.

Default Destination
You can define an ADS/ADX repository as a Default Destination for each Engine where event messages are sent
under certain conditions and permanently stored:

• If the Default Destination is an ADS/ADX that has a LAN connection (as defined by the Engine Device Object’s
ADS Connection Type attribute or the Site Object’s Default ADS Connection Type attribute), event messages
generated by the Engine are sent to the ADS/ADX as they occur.

• If the Default Destination is an ADS/ADX that has a Dial connection, event messages generated by the Engine
are sent to the ADS/ADX when the local event repository is 90% full (NAE object’s Alarm Repository Size
attribute), at the user-defined time (NAE object’s ADS Delivery Time attribute), or when the event priority exceeds
the user-defined level (NAE object’s ADS Priority Threshold attribute).

See the Site Object and Engine Device ObjectADS Connection Type sections for information on these attributes.

For information on how to define a Default Destination, see the Configuring an Engine Event Repository section.
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If you have not defined a Default Destination when the Engine local event repository is 100% full, the local event
repository either replaces the oldest messages (rollover) with new messages or stops recording events according
to the Event Action When Full attribute configuration.

Event message rollover begins or replacement stops only when the total number of nonforwarded event messages
reaches the size defined by the Event Repository Size attribute. In other words, once the local event repository
reaches the defined size, new event messages continue to enter the local event repository replacing forwarded
messages until all forwarded messages are gone. The following figure illustrates the Event Action When Full when
set to Rollover or when set to Stop.

Figure 39: Event Action When Full

If you have defined a Default Destination and the Event Action When Full attribute is set to Stop, the event messages
do not stop rolling over as long as forwarding is successful. This situation occurs because event messages are
forwarded to the Default Destination when new event messages are received, and the forwarded messages are
automatically replaced. The local event repository does not fill up with nonforwarded event messages and, therefore,
does not stop accepting new event messages.

If an event repository is full when a new event occurs, the following rules apply:

1. Events forwarded to an ADS Event Repository are always removed before events – not forwarded.
2. The lowest priority event with the oldest time stamp and Acknowledge Required set to false is replaced first.
3. If the event about to be created is of higher priority than at least one event in the repository, the event with the

oldest time stamp and lowest priority is replaced.
4. If all events are of the same priority, the event with the oldest time stamp is replaced.
5. If the event about to be created is of a lower priority than all other events in the Event Repository, no event is

replaced and the new event is discarded. In this situation, the new event does not cause the Alarm Window to
appear, or any other Destination Delivery Agent (DDA) action to take place.

Note: The local repository for alarms in the NAE is set to rollover at 1000 alarms automatically if the alarms meet
the above requirements.

Note: You can define only one ADS/ADX Repository as the Default Destination for an Engine; however, different
Engines can have different ADS/ADX Repositories defined as their Default Destination.

You can forward event messages from one ADS/ADX to other ADS/ADXs on the same site. For details, see
the Configuring an ADS/ADX Event Repository section.
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Event Viewer and Event Messages
The Event Viewer displays the event messages from the event repository of the currently selected device in your
system and allows you to acknowledge and discard the event messages. See Launching the Event Viewer.

Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and event messages do not
appear acknowledged or discarded in the ADS/ADX.

You can only view the event messages from one event repository of one device at a time. The window displays
1,000 messages per page.

If you are viewing the contents of a local Engine event repository, the event messages shown come from that Engine
only.

If you are viewing the contents of a local Engine event repository of an Engine device designated as the Site Director,
the event messages shown come from that Engine local event repository only.

If you are viewing the contents of an ADS/ADX event repository, the event messages shown come from that ADS/ADX
event repository only. An ADS/ADX event repository may contain event messages that have been routed from other
Engine or ADS/ADX devices but does not display the contents of multiple repositories.

Note: You can define an event repository as a Default Destination so it receives event messages from other event
repositories. You can forward event messages from one ADS/ADX event repository to other ADS/ADX event
repositories. See ADS/ADX Event Message Forwarding.

When viewing an ADS/ADX device, the system applies a standard filter to the Event Viewer when it is first opened.
This filter allows you to see all events that you have permission to view.

You can use custom filters when viewing the ADS/ADX device to narrow the list of events to only those that meet
specific criteria. Custom filters query the entire ADS/ADX database, not just the list of events that appears on the
screen. You can filter events by any combination of Date/Time, Priority Range, Alarm Type, Item Category, Requires
Acknowledgement, User, Acknowledged, and/or Discarded. New events appear in the list only if they meet all criteria
specified in the filter. You cannot save custom filters.

You can print the event messages displayed in the Event Viewer at any printer connected to the computer running
the Web-based Metasys user interface. For information on how to do this, see Printing the Event Messages Displayed
in the Event Viewer.

For information on the Alarms Window, see Alarms Window.

The following table describes the format of the event message (and corresponding buttons and fields) as displayed
in the Event Viewer.

Table 74: Event Message Format
DescriptionItem/Column
Indicates the device for which the Event Viewer is displayed. The device name appears on the left side of
the Event Viewer above the table only for Engine devices.

This field corresponds to the selection made in the Device Selection Dialog box. See Launching the Event
Viewer.

Selected Device
(Engines Only)

Indicates the number of event messages that currently appear in the Event Viewer. The Event Count appears
on the right side of the Event Viewer above the table only for Engine devices.

Event Count
(Engines Only)

Indicates that standard filtering is applied to the Event Viewer for the selected ADS/ADX. This filter information
appears on the right side of the Event Viewer above the table. The count of entries that apply to this filter
appears in parentheses next to the radio button.

Standard Filter
Radio Button
(ADS/ADX Only)

Indicates that custom filtering is applied to the Event Viewer for the selected ADS/ADX. This filter information
appears on the right side of the Event Viewer above the table. The count of entries that apply to this filter
appears in parenthesis next to the radio button.

Custom Filter
Radio Button
(ADS/ADX Only)
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Table 74: Event Message Format
DescriptionItem/Column
Allows you to apply custom filtering to the Event Viewer when the Custom Filter radio button is selected.
This table appears but is not active when the Standard Filter radio button is selected. You may need to
adjust the slider bar to show the Custom Filter table.

The buttons for this table are:
• Add - adds a filter using the Add Filter dialog box
• Remove - removes the selected filter
• Apply - queries the ADS/ADX database and displays the resultant event messages

See Creating a Custom Filter for the Event Viewer (ADS/ADX Only).

Custom Filter
Table (ADS/ADX
Only)

Displays an icon indicating the status of the event message:

- event message is new (that is, the message has occurred in the system within the new entry timeframe)
Note: See Display Settings Tab in the Preferences section for information on changing the amount of time

event messages are considered new using the New entry timeframe preference (default value = 15
minutes).

- event message does not require acknowledgement. A red X through this icon indicates that the message
has been discarded.

- event message requires acknowledgement. A red X through this icon indicates that the message has
been discarded.

- event message has one annotation

- event message has more than one annotation

- event message has an associated graphic

- event message has an electronic signature

Status Icons

Displays the status of the item associated with the event message:
• Normal
• Low Warning/High Warning/Warning
• Low Alarm/High Alarm/Alarm
• Trouble
• Status
• Offline
• Unreliable
• [Blank] - none of the above status types apply.

Type

Indicates the priority of the event. See Event Priority. A lower priority number indicates event messages of
higher importance.

Priority

Displays the date and time that the event message was generated. The date and time format is defined by
the Language selected in the User Profile (User Profile tab of the Security Administrator System).

When

Displays the Name of the item that generated the event message. An item name is the label displayed for
the selected item in the All Items navigation tree (for example, AV1, NAE2, or Schedule1). Be sure you
define relatively unique item names if you plan to use printed lists of the event messages of the Event Viewer.

Item

Displays the Present Value and engineering units, if applicable, of the associated item at the time the event
message was generated.

Value

Displays the text defined by the Description attribute for the item that generated the event message. Be sure
you define relatively unique descriptions if you plan to use printed lists of the event messages of the Event
Viewer.

Description
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Table 74: Event Message Format
DescriptionItem/Column
Displays the text defined by the Alarm Message Text attribute of the alarm extension for the state of the
item associated with the event message, if applicable.

Text

Specifies the column of data used to sort the event messages currently displayed in the Event Viewer
(ascending or descending order).

Allows you to navigate through the pages of event messages in the Event Viewer. Use the buttons to go to
the first page, previous page, next page, or last page. Type a page number in the text box and press the
enter key to jump directly to a specific page.

Paging Controls
(ADS/ADX Only)

Acknowledges the selected event messages. See Acknowledging Event Messages.Ack Button

Removes the selected event messages from the Event Viewer. See Discarding Event Messages.
Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and event messages

do not appear acknowledged or discarded in the ADS/ADX.

Discard Button

Copies the selected events to the Clipboard for pasting into other applications such as Microsoft Excel or
Word.

If nothing is selected in the Event Viewer when you click this button, all entries copy to the Clipboard. You
can also use Ctrl A to select all and Ctrl C to copy to Clipboard.

Copy Button

Event Message Annotations
An annotation is a textual string associated with an event message. All acknowledgements add an annotation to an
event message. In addition, you can add annotations to an event message (in the ADS/ADX event repository only).
You cannot edit an existing annotation. Instead, add a new annotation to the event message. You can also define
custom annotations. See Adding Annotations, Viewing Annotations, and Creating Annotations.

Note: On an Engine, you can view annotations but you cannot add them.

The following table describes the fields of an annotation dialog box.

Table 75: Annotation Dialog Box Fields
DescriptionField
When viewing annotations: The User field appears under the Annotation Information section
that displays the user ID of the person that added the annotation.

User

When adding annotations: Displays the date and time the event message was generated.

When viewing annotations: The first Date and Time field displays the date and time the event
message was generated. The Date and Time field appearing under the Annotation Information
section displays the date and time the annotation was added to the event message.

The date and time format is defined by the Language selected in the User Profile (User Profile
tab of the Security Administrator System).

Date and Time

Indicates the complete Item Reference defined for the item that generated the event message.Item Reference

Displays the text defined by the Description attribute of the item that generated the event message.Description
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Table 75: Annotation Dialog Box Fields
DescriptionField
Allows you to select from a list of predefined annotations or add a text string (annotation) of
1–255 characters that may be used to describe any operational tasks that should be performed
to respond to the cause or condition that prompted the generation of the event message.

Annotation

Allows you to navigate through the annotations, if the event message has multiple annotations
associated with it. Use the buttons to go to the first annotation, previous annotation, next
annotation, or last annotation.

The text box displays the number of the annotation being viewed. The Annotations feature
automatically assigns a number to each annotation created. For example, if the event message
has three annotations, the number appearing in this section can be 1, 2, or 3 depending on the
annotation being viewed. Type a number in the text box and press the enter key to jump directly
to a specific annotation.

Navigation Controls

ADS/ADX Event Message Forwarding
You can forward event messages from one ADS/ADX to other ADS/ADXs on the same site. You also can forward
event messages from an ADS/ADX on one site to an ADS/ADX defined as the Site Director on another site. After
forwarding event messages from one site to another, you can configure the Site Director of the receiving site to
forward the messages to the other ADS/ADXs on that site as desired.

SeeConfiguring anADS/ADXEvent Repository for information on how to forward event messages from one ADS/ADX
to other ADS/ADXs.

Note: When you forward event messages, the messages are sent (copied) to the ADS/ADX repository defined as
the Default Destination. The event messages are not removed from the ADS/ADX repository that sent the
messages.

Note: Use message forwarding for notification purposes, not as a backup or archiving method. Use standard SQL
practices for backup, archiving, or replication purposes.

Event Message Routing, Filtering, and Destinations
The Metasys system alarm and event feature allows you to route Engine generated event messages to different
devices that are defined as destinations. For each Engine and/or ADS/ADX, you can configure the routing and
filtering of event messages using Destination Delivery Agents (DDAs). Supported destinations include pagers,
printers, e-mail, and Network Management Systems that use SNMP traps. You can define DDAs by displaying the
Engine or ADS/ADX and clicking on the desired DDA tab (Pager, for example).

Note: You cannot create, edit, or delete DDAs in online mode with Basic Access.

For each Engine, you can configure the routing and filtering of event messages using the following DDAs:

• E-mail
• Pager
• SNMP Trap
• Serial Printer

Note: This DDA is enabled using Remote Desktop of a Site Director Engine and no attributes/tabs appear in
the UI. This DDA is not available on the NAE35, NAE45, NCE25, or NIE59. Refer to the NAE
Commissioning Guide (LIT-1201519) for details on this DDA.

For each ADS/ADX, you can configure the routing and filtering of event messages using the following DDAs:

• E-mail
• Pager

201Metasys System Online Help PDF



• Printer
• SNMP Trap

When configuring any of these DDAs, you can apply filters for routing specific event messages and define the format
in which the event messages are displayed at the destination. See Configuring Destination Delivery Agents (DDAs)
for information on how to route event messages to destinations. See Configuring Event Message Format to define
the message delivery format.

Use filters to determine which event messages get routed to the defined Destination, such as a pager or e-mail
account. For example, define a filter to route only the event messages that require acknowledgement by selecting
Acknowledge Required == true.

For more information on filters, click the following section names:

• Filtering Operators
• Filtering Options
• Filtering Examples
• Applying Filters for Routing Event Messages to Destinations

See the Event Message Routing Sample Scenario section for a sample event message routing scenario.

See the Related Documentation table.

Filtering Operators
The following table describes the Boolean operators used to configure the filters for routing event messages to
destinations.

Table 76: Operators
MeaningOperator
Equal To==

Not Equal To!=

Less Than<

Less Than or Equal To<=

Greater Than>

Greater Than or Equal To>=

Note: If you define multiple filters for a destination, the DDA combines all the criteria with an AND condition (all
filter criteria must be met).

For more information on filters, click one of the following section names:

• Filtering Options
• Filtering Examples
• Applying Filters for Routing Event Messages to Destinations

Back to Event Message Routing, Filtering, and Destinations.

Filtering Options
You can apply filters to define which event messages are sent to specific destinations. For information on how to
apply filters to event messages, see Applying Filters for Routing Event Messages to Destinations. Use the following
table as a guide to defining filters.

Note: If you define multiple filters for a destination, the DDA combines all the criteria with an AND condition (all
filter criteria must be met).
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Table 77: Filters
ValueOperatorItem
HVAC, Fire, Security, Services, Administrative, General, Lighting,
Refrigeration, Critical Environment, Air Quality, Power, Energy,
System, or Custom Value

==, !=Item Category

true, false==, !=Acknowledge Required

Normal, Fault, Off Normal, High Limit, Low Limit, Low Warning,
High Warning, Low Alarm, High Alarm, Alarm, Trouble, Status,
Offline, Shutdown, Unreliable, Online, Unknown Previous State

==, !=Current Status

Normal, Fault, Off Normal, High Limit, Low Limit, Low Warning,
High Warning, Low Alarm, High Alarm, Alarm, Trouble, Status,
Offline, Shutdown, Unreliable, Online, Unknown Previous State

==, !=Previous Status (status
prior to the event)

Range 0–255

See Event Priority.

==, !=, <, <=, >, >=Priority

Monday through Sunday==, !=, <, <=, >, >=Start Day of Week

The Time format is defined by the Language selected in the User
Profile (User Profile tab of the Security Administrator System).

Example: HH:MM:SS AM/PM format (12:15:00 PM) for English
Language selection

==, !=, <, <=, >, >=Start Time

Monday through Sunday==, !=, <, <=, >, >=End Day of Week

The Time format is defined by the Language selected in the User
Profile (User Profile tab of the Security Administrator System).

Example: HH:MM:SS AM/PM format (12:15:00 PM) for English
Language selection

==, !=, <, <=, >, >=End Time

For more information on filters, click the following section names:

• Filtering Operators
• Filtering Examples
• Applying Filters for Routing Event Messages to Destinations

Back to Event Message Routing, Filtering, and Destinations.

Filtering Examples
The following table provides examples of filters used by DDAs for routing event messages.

Table 78: Filtering Examples
MeaningExample
The DDA routes all event messages to the defined destination except those
from the HVAC category.

Item Category != HVAC

The DDA routes only the event messages that require acknowledgement
to the defined destination.

Acknowledge Required == true

The DDA routes all event messages that were generated by objects in
Alarm status to the defined destination.

Current Status == Alarm

The DDA routes all event messages to the defined destination except those
that were generated by objects in the unknown previous state.

Previous Status != Unknown Previous State
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Table 78: Filtering Examples
MeaningExample
The DDA routes all event messages with an Event Priority equal to or less
than 200 to the defined destination. See Event Priority.

Priority <= 200

The DDA routes all event messages generated from 5:00:00 PM on Friday
through 6:00:00 AM on Monday.

The Time format is defined by the Language selected in the User Profile
(User Profile tab of the Security Administrator System).

Start Day of Week >= Friday

and

Start Time >= 05:00:00 PM

and

End Day of Week <= Monday

and

End Time <= 06:00:00 AM

Applying Multiple Filters Example:

If you define multiple filters for a destination, the DDA combines all the criteria with an AND condition (all filter criteria
must be met).

If you want to define a set of filters for sending all High Alarm messages for your HVAC systems that have been
defined with event priorities belonging to the Property Safety Group (Priority 40–79) and require acknowledgment
at an e-mail destination, apply all the following filters under the E-mail tab of the Engine of ADS/ADX.

• Item Category == HVAC
• Current Status == High Alarm
• Priority >= 40
• Priority <= 79
• Acknowledge Required == true

For more information on filters, click the following section names:

• Filtering Operators
• Filtering Options
• Applying Filters for Routing Event Messages to Destinations

Back to Event Message Routing, Filtering, and Destinations.

E-mail
You can configure e-mail addresses as destinations for event messages. The Email DDA supports standard Simple
Mail Transfer Protocol (SMTP).

For information on how to configure an e-mail destination, see Configuring Destination Delivery Agents (DDAs).

Note: The procedure for configuring the Email DDA is the same for the NAE, NCE, NIE, ADS, and ADX.

For additional information, see one of the following sections:

• Email Tab in the Object and Feature Tabs
• Engine Device Object or ADS Device Object
• Configuring Event Message Format to configure how the event message appears at the e-mail destination

Back to Event Message Routing, Filtering, and Destinations.

E-mail Addresses in the Destination Configuration
The Email Addresses attribute on the Email tab in the Destination Configuration of the device specifies the e-mail
address of one or more recipients to receive alarm notification via e-mail. Click the button next to the Email
Address attribute to select e-mail addresses defined by the user accounts in the Security Administrator system.
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You must use valid e-mail addresses, which are set up on an e-mail server, for the device to successfully send the
alarms via e-mail.

Figure 40: Email Addresses Dialog Box

Table 79: Email Addresses Dialog Box Components
DescriptionField
Displays the users defined in the Security Administrator System and their e-mail
addresses. This information appears only for the device that you are currently accessing.

Metasys User Addresses

Allows you to enter e-mail addresses not appearing in the Metasys User Addresses list.
When entering more than one e-mail address, separate the addresses with a comma
(John.Smith@jci.com,Jane.Smith@jci.com).

Additional User Addresses

Displays the Metasys User Addresses and Additional User Addresses that you selected
or entered from the Metasys User Addresses and Additional User Addresses lists.

You can expand or collapse the Metasys User Addresses folder and Additional User
Addresses folder by clicking the + or - sign or by double-clicking the folders.

If you right-click the Metasys User Addresses folder or Additional User Addresses folder,
the following menu options appear:
• Sort-by Name: Displays the users in alphabetical order by name. This option is

available only for the Metasys User Addresses folder.
• Sort-by Email: Displays the e-mail addresses in alphabetical order.
• Remove All: Removes all users and e-mail addresses from the selected list.

Destination Email Addresses
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Table 79: Email Addresses Dialog Box Components
DescriptionField
For the button next to the Metasys User Addresses list, adds the selected users and
their e-mail addresses to the Destination Email Addresses list.

For the button next to the Additional User Addresses lists, adds the e-mail addresses
entered to the Destination Email Addresses list.

Add Button

Displays the number of characters in the e-mail address string. This number is calculated
after clicking the Add button next to either the Metasys User Addresses list or the
Additional User Addresses list.

The maximum number of characters allowed for the e-mail address string is 256.

Current Calculated Length

Removes the selected user and e-mail address from the Destination Email Addresses
list. You also can select a user or e-mail address, right-click, and select Remove.

Remove

Removes all users and e-mail addresses from the Destination Email Addresses list.Remove All

Pager
You can configure one or more pagers as destinations for event messages. The Pager DDA supports standard
Telelocator Alphanumeric Protocol (TAP).

For information on how to configure a pager destination, see Configuring Destination Delivery Agents (DDAs).

Note: The procedure for configuring the Pager DDA is the same for the NAE, NCE, NIE, ADS, and ADX.

For additional information, see the following:

• Pager Tab in the Object and Feature Tabs
• Engine Device Object or ADS Device Object
• Configuring Event Message Format to configure how the event message appears at the pager destination

Note: The event message format for pagers is very brief to conform to pager space limitations.

Back to Event Message Routing, Filtering, and Destinations.

Troubleshooting Tip:

Any modem initialization strings set in the Control Panel of an ADS/ADX are prefixed withAT&. Enter the initialization
strings for the modem accordingly. Several safe, benign codes can be entered at the beginning of your string to
prevent any improper initialization but must be re-entered if the ADS/ADX is restarted. The exact text of the string
varies per modem. For example, for one U.S. Robotics® modem qualified with the Metasys system, enter
M4S13=7S19=2.

Troubleshooting Tip:

Occasionally, a pager message may contain extraneous junk characters. These characters may come from the
paging service, appear as a result of interference, or appear when the pager battery is low.

To reduce the number of pager messages containing such characters, cycle power to the modem by unplugging
the USB cable from the modem and any power adapters, if applicable. Wait 10 seconds, and then reconnect the
USB cable and any power adapters.

Printer
On the ADS/ADX platform, you can define any printer supported by Windows software as a destination for event
messages, and a single DDA can print alarms on multiple printers. Printers connected to the ADS/ADX by parallel
port or USB are supported, as well as IP-based network printers (if printers are set up with an IP address). This
platform does not support Novell® NetWare printers. Printer support is the same for both the ADS and ADX.

To set up a printer on a split ADX, the printer must be accessible from the Web/Application server computer, as
opposed to the Database server computer.
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You can configure the ADS/ADX Printer DDA for single line printing for a tractor feed printer (also known as tractor
feed printing, line printing, and dot matrix printer support). To set up a printer for single line printing for a tractor feed
printer (no form feed/tractor printing mode), set the ADS Device Object Printer tab Line Out attribute to 0. By setting
this attribute to 0, when an alarm is sent to the tractor feed printer, it prints the alarm text, and then advances a single
line, thus waiting to print the next alarm.

Note: When using a tractor feed printer (without any form feeds), the Timeout, Printing Priority Threshold, Orientation,
Font Face, and Font Size attributes are not used and any values set for them are ignored. You can set the
Orientation, Font Face, Font Size, and line wrapping at the printer itself.

Note: Tractor feed printing is only intended for tractor feed printers. You may encounter abnormal behavior if you
set the Line Out attribute to 0 for other type of printers, such as deskjet and laserjet printers.

For information on how to configure a printer destination on an ADS/ADX, see Configuring Destination Delivery
Agents (DDAs).

For additional information on ADS/ADX Printer DDAs see the following:

• Printer Tab in the Object and Feature Tabs
• Engine Device Object or ADS Device Object
• Configuring Event Message Format to configure how the event message appears at the printer destination

On the NAE55/NIE55 and NAE85/NIE85 platform, you can use the Serial Printer DDA on the Site Director Engine
to print event messages. This DDA is enabled using Remote Desktop and no attributes/tabs appear in the UI. This
DDA is not available on the NAE35, NAE45, or NIE59. Refer to the NAE Commissioning Guide (LIT-1201519) for
details on this DDA.

Back to Event Message Routing, Filtering, and Destinations.

SNMP Trap
You can configure a Simple Network Management Protocol (SNMP) Trap as a destination for event messages. The
SNMP Trap DDA supports SNMP Versions 1, 2C, and 3.

For information on how to configure an SNMP Trap destination, see Configuring Destination Delivery Agents (DDAs).

Note: The procedure for configuring the SNMP Trap DDA is the same for the NAE, NIE, ADS, and ADX.

For additional information, see the following:

• SNMP Tab in the Object and Feature Tabs
• Engine Device Object or ADS Device Object
• Configuring Event Message Format to configure how the event message appears at the SNMP Trap destination

Back to Event Message Routing, Filtering, and Destinations.

Event Message Routing Sample Scenario
An Engine is configured to route all event messages to John Smith’s (Building Operations Engineer) e-mail address
and a set of selected event messages to his manager’s (Building Operations Manager) pager.

The following configuration is required to make this scenario work:

Make sure the Engine is configured properly. See the Related Documentation table and the Engine Device Object
section for information.

Make sure that object alarm extensions are configured for each object in the Engine that you want to detect alarm
conditions. See the Alarm Extensions section for information.

Define an e-mail destination for John Smith’s (Building Operations Engineer) e-mail address. See Event Message
Routing, Filtering, and Destinations, E-mail, and Configuring Destination Delivery Agents (DDAs).

Define a pager destination for John’s manager’s (Building Operations Manager) pager. SeeEvent Message Routing,
Filtering, and Destinations, Pager, and Configuring Destination Delivery Agents (DDAs). Make sure you have defined
the pager filters correctly.
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Once the Engine detects an alarm condition and generates an event message, the Email DDA routes all unfiltered
event messages to John Smith’s e-mail address. The Pager DDA only routes the event messages that pass the
defined pager filters to John’s manager’s pager.

Event Priority
Indicates the importance of the event message and determines when the event message is displayed. Displaying
the priority of the event messages in the Event Viewer allows the user to acknowledge event messages of higher
importance before event messages of lower importance. The priority number associated with the event message
falls within a range of 0–255. Event messages with a lower priority number are of a higher importance or are more
critical than event messages with a higher priority number. You can route event messages based on priority.

Note: Using a consistent priority scheme makes sorting event messages based on priority in the Event Viewer
easier.

Note: You can specify alarm notification sounds based on alarm priorities. See Alarm Settings Tab.

Life Safety Group (Priority 0–39)
Table 80: Life Safety

Recommended UsePriority
Automatic Fire Alarm5

Life Safety Process Alarm8

Manual Fire Alarm11

Other Higher Priority Life Safety14

Medical Alarm19

Hold Up and Duress Alarm22

Panic Alarm25

Life Safety Pre-Alarm Alert28

Other Lower Priority Life Safety31

Property Safety Group (Priority 40–79)
Table 81: Property Safety Group

Recommended UsePriority
Burglar Alarm and Forced Door Alarm45

Security Alarm48

Other Higher Priority Property Safety51

Watchman Tour Alarm60

Property Process Alarm63

Door Held Open Alarm66

Other Lower Priority Property Safety69

Supervisory and Trouble Group (Priority 80–139)
Table 82: Supervisory and Trouble Group

Recommended UsePriority
Fire Supervision (Tamper)85

Security Supervision (Tamper)88

Other Supervisory91

Fire Trouble (Equipment Failure)100

Security and Burglar Trouble (Equipment Failure)103
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Table 82: Supervisory and Trouble Group
Recommended UsePriority
Communication Equipment Failure Trouble106

Process Trouble109

Energy Alarm112

Other Failure115

Communication Equipment Warning Trouble124

Early Warning Alert127

Energy Warning130

Other Warning133

Other Group (Priority 140–255)
Table 83: Other Group

Recommended UsePriority
Equipment and Industrial Supervision145

Comfort Alarm148

Miscellaneous Higher Priority Alerts151

System Events160

Miscellaneous Higher Priority Events163

Life Safety Return to Normal172

Property Safety Return to Normal179

Supervisory and Trouble Return to Normal186

Miscellaneous Return to Normal189

System Status Active198

Comfort Warning201

Miscellaneous Lower Priority Events204

System Status Normal213

Comfort Normal216

Test and Diagnostic Events219

Miscellaneous222

Alarm and Event Steps
Configuring an Engine Event Repository
To configure the local Engine Event Repository and the Default Destination:

1. View the desired Engine device. See Viewing Item Data for information on how to display an item.

2. Select the Focus tab and click the Advanced radio button to display additional item information.
3. Select Edit.
4. Scroll down to the Alarms and Site sections.
5. Edit the attributes in these sections as desired. Use the following table as a guide. See Engine Device Object

for information about the attributes. The NAE Device attributes table contains Default Value and
Values/Options/Range information for the attributes. Click on the attribute names in the table for descriptions.
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Table 84: Repository Configuration
Edit This Engine Device Object Attribute:To Do This:
Alarm Repository SizeChange the size of the local Engine repository

Alarm Snooze TimeChange the snooze time for the Alarms Window

ADS RepositoryDesignate anADS/ADX repository as aDefault Destination

ADS Connection TypeIndicate the type of connection used by the ADS/ADX

ADS Delivery TimeDefine a time to deliver event messages to the ADS/ADX

ADS Priority ThresholdDefine the event message priority that triggers delivery
to the ADS/ADX

Note: You can define only one repository as the Default Destination for an Engine. See Event Repositories for
more information.

6. Click Save.

Note: If you want to define all local Engine repositories for the entire site at one time instead of individually,
select the Site in the navigation tree and edit the following Site Object attributes (the Site attributes table
contains Default Value and Values/Options/Range information for the attributes):

• Default ADS Repository
• Default ADS Connection Type
• Default ADS Delivery Time
• Default ADS Priority Threshold

Configuring an ADS/ADX Event Repository
To configure an ADS/ADX Event Repository for forwarding event messages from one ADS/ADX to other ADS/ADXs:

1. View the desired ADS/ADX. See Viewing Item Data for information on how to display an item.
2. Select the Focus tab and click the Advanced radio button to display additional item information.
3. Select Edit.
4. Scroll down to the Repository Storage section.
5. Edit the ADS Device Object’s ADS Repositories attribute. See the ADS/ADX attributes table for more information

on this attribute or other ADS/ADX attributes, including their Default Value and Values/Options/Range information.
6. Click Save.

Configuring Destination Delivery Agents (DDAs)
To provide consistency and easy configuration of DDAs, each DDA tab in the Metasys system user interface contains
the same layout. Follow the instructions below when configuring any DDA. See Event Message Routing, Filtering,
and Destinations for more information on DDAs.

On the NAE55/NIE55 and NAE85/NIE85 platform, you can use the Serial Printer DDA on the Site Director Engine
to print event messages. This DDA is enabled using Remote Desktop, and no attributes/tabs appear in the UI. This
DDA is not available on the NAE35, NAE45, or NIE59. Refer to the NAE Commissioning Guide (LIT-1201519) for
details on this DDA.

Note: You cannot create, edit, or delete DDAs in online mode with Basic Access.

To configure DDAs for routing event messages:

1. View the desired Engine or ADS/ADX device. See Viewing Item Data for information on how to display an item.
2. Select the tab for the desired destination type (such as, Pager).
3. Select Edit.
4. Edit the attributes in the Shared Configuration section.

Note: Skip to Step Step 1 if you are configuring a Printer DDA.
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Note: See the specific DDA tab in the Object and Feature Tabs for information on configuring attributes. Also,
see the Engine Device Object or the ADS Device Object section for information on configuring Engine
or ADS/ADX attributes, respectively.

5. In the Destinations section, select New to add a destination or click an existing destination.
6. Edit the parameters in the Destinations section.

For the Engine, see the following:

• E-mail
• Pager
• SNMP Trap

For the ADS/ADX, see the following:

• E-mail
• Pager
• Printer
• SNMP Trap

Note: See the specific DDA tab in the Object and Feature Tabs for information on configuring attributes. Also,
see the Engine Device Object or the ADS Device Object section for information on configuring Engine
or ADS/ADX attributes, respectively.

Note: If you are enabling an E-mail DDS on an ADS/ADX and the ADS/ADX computer is using Symantec
Endpoint Protection, verify that the POP3/SMTP Scanner feature is not installed. If this feature is installed,
e-mail alerts for the ADS/ADX are blocked. To uninstall the POP3/SMTP Scanner feature, open Control
Panel and select Add/Remove Programs or Programs and Features. Locate Symantec Endpoint Protection
in the list of installed programs and click Change. Navigate through the installation wizard until you reach
the Custom Setup screen. Place an X next to the POP3/SMTP Scanner feature, then navigate the
remaining wizard screens to remove this feature.

7. Repeat Step 5 and Step 6 if you want to configure this device to send event messages to more than one destination
of that type. Add the desired amount of destinations. For example, to send event messages to two different
pagers, create two separate destinations on the Pager tab.

Note: See Applying Filters for Routing Event Messages to Destinations for information on how to apply filters
to route particular event messages to destinations.

Note: See Configuring Event Message Format for information on how to configure event message format.
8. To remove a destination, select the destination and click Delete.
9. Click Save.

Applying Filters for Routing Event Messages to Destinations
1. View the desired Engine or ADS/ADX device. See Viewing Item Data for information on how to display an item.

2. Select the tab for the desired destination type (such as, Pager).
3. Select Edit.
4. Select the desired destination in the Destinations section.
5. Select New in the Filters section. The Filter dialog box appears.
6. Select the desired filter type from the Item drop-down menu. For more information and examples on filtering,

see Event Message Routing, Filtering, and Destinations.
7. Select the operator from the drop-down menu.
8. Select the desired value from the drop-down menu or type the value in the text box.
9. Click OK.
10. Repeat Step 4 through Step 9 to add more filters to that destination.
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Note: If you define multiple filters for a destination, the DDA combines all the criteria with an AND condition
(all filter criteria must be met).

11. Make changes to filters using the drop-down menus or text boxes.
12. To remove a filter, select the desired filter and click Delete.
13. Click Save.

Configuring Event Message Format
1. View the desired Engine or ADS/ADX device. See Viewing Item Data for information on how to display an item.

2. Select the tab for the desired destination type (such as, Pager).
3. Select Edit.
4. Select the desired destination in the Destinations section.
5. Select the check boxes in the Format section to define which attribute information is included in the event message

when delivered to that destination.

Note: For example, select Value and Units if you only want to display the Value and Units portion of the event
message at the destination.

6. Click Save.

Launching the Event Viewer
1. Select Event Viewer from the View menu. If you have more than one Engine or ADS/ADX on the site, a Device

Selection Dialog box appears.

2. Select the device containing the event repositories with the event messages that you want to display in the Event
Viewer.

3. Click OK. The Event Viewer appears in the display frame and displays the event messages from the event
repository of the selected device. See Event Viewer and Event Messages for details.

Note: Alternatively, you can right-click the desired device in the navigation frame and select Event Viewer from the
menu that appears.

Acknowledging Event Messages
1. Launch the Event Viewer.

2. Select one or more event messages.

Note: Use the Ctrl or Shift key to select multiple messages.
3. Click Ack.

Note: Alternatively, you can right-click and select Ack or you can acknowledge event messages in the Alarms
Window. See Acknowledging, Snoozing, and Discarding Events for details.

Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and event messages do not
appear acknowledged or discarded in the ADS/ADX.

Note: All acknowledgements add an annotation to the event message. See Event Message Annotations.

Note: An electronic signature and/or annotation may be required when acknowledging an event.

Discarding Event Messages
1. Launch the Event Viewer.
2. Select one or more event messages.

Note: Use the Ctrl or Shift key to select multiple messages.

3. Click Discard.
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Note: Alternatively, you can right-click and select Discard or you can discard event messages in the Alarms
Window. See Acknowledging, Snoozing, and Discarding Events for details.

Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and event messages do not
appear acknowledged or discarded in the ADS/ADX.

Note: An electronic signature and/or annotation may be required when discarding an event.

Sorting the Event Message List
Note: When you sort the event message list, only those messages currently displayed on the screen sort. This

feature does not sort all messages if you have multiple pages of event messages.

1. Launch the Event Viewer.

2. Click the header of the column you want to use for sorting. An up or down arrow appears in the header of that
column. Click the arrow to change the sorting order and the table reorganizes.

Creating a Custom Filter for the Event Viewer (ADS/ADX Only)
1. Launch the Event Viewer.

2. Click Custom Filter.
3. Click Add.
4. Select the criteria and the associated values for the filter and click OK. All criteria added to the custom filter table

will make up the rules of the filter.
5. Click Apply to get the results of the custom filter.
6. To view the data without the custom filter, click Standard Filter.

Printing the Event Messages Displayed in the Event Viewer
1. Launch the Event Viewer.

2. Click anywhere in the Event Viewer.
3. Select Print from the Item Menu. The event messages are printed in the order they appear in the Event Viewer.

Launching the Focus View of the Item That Generated the Event Message
1. Launch the Event Viewer.

2. Select an event message and choose Selected Item from the View menu, or right-click and select View Item.

Note: Some items, such as site level items, do not support this option because they do not have viewable
information.

Note: Alternatively, you can launch the Focus view of the item that generated the event message in the Alarms
Window by clicking on the View Item button. See Acknowledging, Snoozing, and Discarding Events for
details.

Launching a Graphic Associated with an Event Message
1. Launch the Event Viewer.

2. Double-click the graphic icon of an event message.

Note: Alternatively, you can launch a graphic associated with an event message in the Alarms Window by
clicking the View Graphic button. See Acknowledging, Snoozing, and Discarding Events for details.

Adding Annotations
The annotation feature is not available on the local Engine event repository. You can add annotations to the ADS/ADX
event repository only.

1. Launch the Event Viewer.

2. Click on the event message.

213Metasys System Online Help PDF



3. Select Add Annotation from the Actions menu or right-click and select Add Annotation. The Add Annotation dialog
box appears.

Note: The drop-down field on the Add Annotation dialog box contains predefined annotations from your system
preferences. If you have not defined annotations in your system preferences, the drop-down list is empty.

4. Type the desired text in the message box.
5. Click OK.

Creating Annotations
1. Select the Annotation Settings tab on the Metasys Preferences screen.

2. Enter annotation text. The text can be from 1 to 255 characters in length.
3. Click Add to save the new annotation.

Note: The annotations you create appear in the drop-down list on the Add Annotations dialog box. If you do not
create any annotations, this list is blank.

Viewing Annotations
You can view annotations from both the ADS/ADX and Engine event repository.

1. Launch the Event Viewer.

2. Click on the event message.
3. Select View Annotations from the Actions menu or right-click and select View Annotations. The View Annotations

dialog box appears.

Note: Alternatively, you can double-click the annotation icon in the first column of the Event Viewer for the
desired event message.

4. View the message. If multiple messages exist, use the navigation buttons to browse between event messages
or to the first and last event message.

5. Click OK.

Note: A signed book icon is displayed in the event’s associated Acknowledgement Annotation dialog.
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Alarm and Event Management for Metasys Systems Integrated with
BACnet Devices
The Metasys system provides the option to use the Alarm and Event feature when integrating with BACnet devices
(including the N30). You can send event messages generated by the Metasys system’s Engine, FAC or ADS/ADX
devices to BACnet devices. This alarming method uses the Notification Class Object and Event Enrollment or objects
with intrinsic alarming to detect alarm conditions and route event messages from the Metasys system to BACnet
devices.

For the alarm and event feature steps, see the Alarm and Event Management Alarm and Event Steps section.

For details on the attributes appearing on the BACnet Alarms tab, see BACnet Alarm Tab in the Object and Feature
Tabs section.

For information on the BACnet Integration object, see the BACnet Integration Object.

For information on alarm and event management for the Metasys system, see Alarm and Event.

Alarm and Event Management for Metasys Systems Integrated with BACnet
Devices Concepts
Metasys/BACnet Alarming Overview
The Metasys system provides the functionality to use the Alarm and Event feature when integrating with BACnet
devices (including the N30). You can configure the Metasys system’s FAC, Engine or ADS/ADX devices to comply
with the standard BACnet alarm and event services such as intrinsic alarming, Event Enrollment object alarming,
and alarm routing using the Notification Class Object. These optional alarming methods allow you to send alarm
and event messages from the Metasys system to BACnet devices.

To use the alarm and event feature for Metasys systems that integrate BACnet devices, configure the Notification
Class object, then reference that Notification Class object from the Event Enrollment Object or from an object with
intrinsic alarming. The Notification Class object routes event messages from Event Enrollment objects or objects
with intrinsic alarming to one or more BACnet device. Intrinsic alarming attributes, Event Enrollment objects, and
Notification Class objects are fully compliant with the BACnet standard specifications and should be used if you want
your Metasys system to send event messages to BACnet devices.

Event Messages routed through the Notification Class object to the Metasys system’s event repositories can use
the Alarm and Event features such as the Event Viewer, Alarms Window, Alarm Reports, and DDAs. To enable this
functionality, you must set the Route to Metasys attribute to true in the Notification Class objects used. SeeConfiguring
Metasys/BACnet Integration Alarming. See the Alarm and Event Management Alarm and Event Steps section for
more information on the alarm and event feature.

The following figure shows the flow of event messages routed by the Notification Class object.
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Figure 41: Event Message Flow

For details on configuring the detection of alarm conditions, the routing event messages to destinations, and the
filtering and message formatting options, click one of the following:

• Notification Class object and its attributes
• Event Enrollment object alarming
• intrinsic alarming
• event routing, filtering, and destinations
• event message format

The alarm extensions method of alarming is easier to configure and provides greater flexibility and functionality for
standard Metasys applications. Use alarm extensions for alarming if your system does not require integration with
BACnet devices.

BACnet Intrinsic Alarming
Intrinsic alarming is fully compliant with the BACnet standard specifications and should only be used when integrating
with BACnet devices. Intrinsic alarming allows you to configure the detection of alarm conditions and the generation
of event messages based on attributes (properties) within an object that is compliant with the standard BACnet
objects, such as the High/Low alarm limits for analog objects and the alarm state for binary objects. The Notification
Class Object routes the event message.

By default, objects do not have intrinsic alarming; however, you can add intrinsic alarming to an object by setting its
Intrinsic Alarming Defined attribute to True. You can add intrinsic alarming when you create an object, or you can
add intrinsic alarming to an existing object. You can also remove intrinsic alarming from an existing object by changing
its Intrinsic Alarming Defined attribute to False. The Intrinsic Alarming Defined attribute is located under the
BACnet heading in the Insert Object wizard and in the object’s Focus view, which is accessible when you select the
Advanced option for the display. When you set the Intrinsic Alarming Defined attribute to True, the BACnet Alarm
tab appears the next time you view the object. The default alarming settings (for example, high and low limits) are
used until you change the settings on the BACnet Alarm tab. When you set the Intrinsic Alarming Defined attribute
to False, all intrinsic alarm settings configured through the BACnet Alarm tab are discarded and the alarming settings
return to their default values. For more information on configuring intrinsic alarming in an object, see Configuring
Metasys/BACnet Integration Alarming.
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To view the BACnet intrinsic alarming attributes of existing Metasys objects after they have been configured, view
the object and click the BACnet Alarm tab. You can add alarm extensions to objects supporting intrinsic alarming.

The following Metasys objects are compliant with the standard BACnet objects and support BACnet intrinsic alarming:

• Accumulator Objects
• Analog Input Object
• Analog Output Object
• Analog Value Object
• Binary Input Object
• Binary Output Object
• Binary Value Object
• Multistate Input Object
• Multistate Output Object
• Multistate Value Object

Intrinsic alarming is only available on the above objects for your Metasys system if you set the BACnet Site attribute
to True in the Site object. See the Site Object for information on configuring the Site object.

After configuring one or more objects with intrinsic alarming, you must configure at least one Notification Class object
to define the routing of event messages to BACnet device destinations. Then you must reference the desired
Notification Class object from the objects with intrinsic alarming. If you want the Notification Class object to route
the event messages created by the objects with intrinsic alarming to the Metasys Alarm and Event feature, set the
Notification Class object’s Route to Metasys attribute to true.

In addition, you can add object alarm extensions to objects with intrinsic alarming if you want to route event messages
to both BACnet device destinations and Metasys DDAs. For more information on DDAs, see Event Message Routing,
Filtering, and Destinations.

The Enable Alarms and Disable Alarms commands for objects using intrinsic alarming edit the Event Enable flags
under Alarm State to prevent alarms.

You can configure intrinsic alarming online at the Site Management Portal UI or offline in the SCT. Intrinsic alarms
for objects in an FAC can be defined using CCT or Site Management Portal, but not SCT. If defined with SMP, you
must specify if the intrinsic alarm is to Use Remote Alarming as defined in the object's Focus tab. If true, then the
intrinsic alarm parameters will be stored in the FAC. If false, the parameters will be stored in the Engine.

For details on the attributes appearing on the BACnet Alarms tab, see BACnet Alarm Tab in the Object and Feature
Tabs section.

BACnet Event Enrollment Object Alarming
The Event Enrollment Object is fully compliant with the BACnet standard specifications and should only be used
when integrating with BACnet devices. The Event Enrollment object monitors the value of a single attribute and
generates event messages based on the defined alarm conditions.

You can create an Event Enrollment object using the Insert Object Wizard and configure its attributes, or you can
view an existing Event Enrollment object and edit its attributes. Event Enrollment objects are not supported by a
FAC. Based on the defined event type, the Event Enrollment object generates event messages for different conditions
monitored in the referenced object. See the Event Type attribute of the Event Enrollment Object and the Event
Enrollment Configuration Examples for more information.

Note: Event Enrollment alarming is only available for your Metasys system if you set the BACnet Site attribute to
true in the Site object. See the Site Object for information on configuring the Site object.
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After configuring one or more Event Enrollment objects, you must configure at least one Notification Class Object
to define the routing of event messages to BACnet device destinations. Then you must reference the desired
Notification Class object from the Event Enrollment objects. If you want the Notification Class object to route the
event messages created by the Event Enrollment objects to the Metasys Alarm and Event feature, set the Notification
Class object’s Route to Metasys attribute to true.

You can add object alarm extensions to Event Enrollment objects if you want to route event messages to Metasys
DDAs. For more information on DDAs, see Event Message Routing, Filtering, and Destinations.

The Enable Alarms and Disable Alarms commands for the Event Enrollment object alarming edit the Event Enable
flags under Alarm State to prevent alarms.

Click one of the following for more information:

• Event Enrollment Object and its attributes
• event types used by the Event Enrollment Object ( Event Type attribute)
• Event Enrollment Configuration Examples

Event Enrollment Configuration Examples
The alarm conditions monitored by the Event Enrollment Object are defined by the selected event type. Click the
event types in the following list for configuration examples:

• Event Enrollment Configuration Example - Change of Bitstring
• Event Enrollment Configuration Example - Change of State
• Event Enrollment Configuration Example - Change of Value Example 1 and Event Enrollment Configuration

Example - Change of Value Example 2
• Event Enrollment Configuration Example - Command Failure
• Event Enrollment Configuration Example - Floating Limit
• Event Enrollment Configuration Example - Out of Range

Event Enrollment Configuration Example - Change of Bitstring
The following table is an example of how to configure an Event Enrollment Object using the Change of Bitstring
event type. In this example, the Event Enrollment object references an Analog Value Object and generates an event
message as defined by its Event Enable attribute when any of the AV’s selected Status Flags attribute values
change for a time period longer than the defined Time Delay. For more information on this event type, see the Event
Enrollment object’s Event Type attribute.

This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard with
the Event Enrollment object selected.

Table 85: Change of Bitstring Attributes
ValueAttributes

Focus/Configuration Tab:

Event Enrollment1Name

Status ChangeDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To Off NormalEvent Enable

AlarmNotify Type

4194001Notification Class

Change in Setpoint StatusAlarm Message Text

NormalExecution Priority
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Table 85: Change of Bitstring Attributes
ValueAttributes

Event Tab:

AV1: Status FlagsInput Reference

10Delay Time (seconds)

Change of bitstringEvent Type

In Alarm - selected (true)

Fault - selected (true)

Overridden - not selected (false)

Out of Service - not selected (false)

Mask

In Alarm - selected (true)

Fault - selected (true)

Overridden - not selected (false)

Out of Service - not selected (false)

Values

Event Enrollment Configuration Example - Change of State
The following table is an example of how to configure an Event Enrollment Object using the Change of State event
type. In this example, the Event Enrollment object references a Multistate Value Object and generates an event
message as defined by its Event Enable attribute when the state of the MV’s Reliability attribute changes for a time
period longer than the defined Time Delay. For more information on this event type, see the Event Enrollment object’s
Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

Table 86: Change of State Attributes
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Feedback ReliabilityDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To Off NormalEvent Enable

AlarmNotify Type

4194001Notification Class

Feedback StateAlarm Message Text

NormalExecution Priority

Event Tab:

MV1: ReliabilityInput Reference

0Delay Time (seconds)

Change of stateEvent Type

UnreliableValue
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Event Enrollment Configuration Example - Change of Value Example 1
The following table is an example of how to configure an Event Enrollment Object using the Change of Value event
type. In this example, the Event Enrollment object references an Analog Input Object and generates an event
message as defined by its Event Enable attribute when the value of the AI’s Present Value attribute changes by
more than the specified COV Increment for a time period longer than the defined Time Delay. For more information
on this event type, see the Event Enrollment object’s Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

See Event Enrollment Configuration Example - Change of Value Example 2 for another example of how to configure
the Event Enrollment object for the Change of Value event type.

Table 87: Change of Value Attributes (Example 1)
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Room Temp COVDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To NormalEvent Enable

AlarmNotify Type

4194001Notification Class

NW Conf. Room TempAlarm Message Text

NormalExecution Priority

Event Tab:

AI1: Present ValueInput Reference

120Delay Time (seconds)

Change of valueEvent Type

3.0COV Increment

Event Enrollment Configuration Example - Change of Value Example 2
The following table is an example of how to configure an Event Enrollment Object using the Change of Value event
type. In this example, the Event Enrollment object references an Analog Value Object and generates an event
message as defined by its Event Enable attribute when the value of the AV’s Status Flags attribute changes for a
time period longer than the defined Time Delay. For more information on this event type, see the Event Enrollment
object’s Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

Table 88: Change of Value Attributes (Example 2)
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Status COVDescription

Event EnrollmentObject Type

HVACObject Category
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Table 88: Change of Value Attributes (Example 2)
ValueAttribute
trueEnabled

To NormalEvent Enable

AlarmNotify Type

4194001Notification Class

Status Change in FeedbackAlarm Message Text

NormalExecution Priority

Event Tab:

AV1: Status FlagsInput Reference

30Delay Time (seconds)

Change of valueEvent Type

In Alarm - selected (true)

Fault - selected (true)

Overridden - not selected (false)

Out of Service - selected (true)

Mask

Event Enrollment Configuration Example - Command Failure
The following table is an example of how to configure an Event Enrollment Object using the Command Failure event
type. In this example, the Event Enrollment object references a Binary Value Object and generates an event message
as defined by its Event Enable attribute when a command to BV1’s Present Value attribute is not accepted by the
command target (BV2) after the defined Time Delay has expired. For more information on this event type, see the
Event Enrollment object’s Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

Table 89: Command Failure Attributes
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Fan Command MonitorDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To Off NormalEvent Enable

ValueNotify Type

4194001Notification Class

BV1(Fan4) Command FailureAlarm Message Text

NormalExecution Priority

Event Tab:

BV1: Present ValueInput Reference

60Delay Time (seconds)
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Table 89: Command Failure Attributes
ValueAttribute
Command FailureEvent Type

BV2: Present ValueCommand Target

Event Enrollment Configuration Example - Floating Limit
The following table is an example of how to configure an Event Enrollment Object using the Floating Limit event
type. In this example, the Event Enrollment object references an Analog Input Object and generates an event
message as defined by its Event Enable attribute when the value of the AI’s Present Value attribute exceeds the
defined setpoint plus the high or low differential limit values for a time period longer than the defined Time Delay.
For more information on this event type, see the Event Enrollment object’s Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

Table 90: Floating Limit Attributes
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Room Temp MonitorDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To Off NormalEvent Enable

AlarmNotify Type

4194001Notification Class

Room Temp Limit ExceededAlarm Message Text

NormalExecution Priority

Event Tab:

AI1: Present ValueInput Reference

120Delay Time (seconds)

Floating LimitEvent Type

AV1: Present ValueSetpoint Reference

3.0Low Differential Limit

4.0High Differential Limit

1.5Deadband

Event Enrollment Configuration Example - Out of Range
The following table is an example of how to configure an Event Enrollment Object using the Out of Range event
type. In this example, the Event Enrollment object references an Analog Input Object and generates an event
message as defined by its Event Enable attribute when the value of the AI’s Present Value attribute goes out of the
user-defined low limit/high limit range for a time period longer than the defined Time Delay. For more information
on this event type, see the Event Enrollment object’s Event Type attribute.

Note: This table describes both the Configuration and Event tabs of the Configure screen of the Insert Object wizard
with the Event Enrollment object selected.

222Metasys System Online Help PDF



Table 91: Out of Range Attributes
ValueAttribute

Focus/Configuration Tab:

Event Enrollment1Name

Status ChangeDescription

Event EnrollmentObject Type

HVACObject Category

trueEnabled

To off NormalEvent Enable

AlarmNotify Type

4194001Notification Class

Room Temp Out of RangeAlarm Message Text

NormalExecution Priority

Event Tab:

AI1: Present ValueInput Reference

300Delay Time (seconds)

Out of RangeEvent Type

66.0Low Limit

74.0High Limit

2.0Deadband

Alarm and Event Management for Metasys Systems Integrated with BACnet
Devices Steps
Configuring Metasys/BACnet Integration Alarming
The BACnet Intrinsic Alarming and BACnet Event Enrollment Object Alarming routing services are fully compliant
with the BACnetstandard specifications and should only be used when integrating your Metasys system with BACnet
devices.

You can configure intrinsic alarming online at the Site Management Portal (SMP) UI or offline in the SCT. Intrinsic
alarming for FAC objects can be defined with the SMP or off-line with CCT.

To configure Metasys/BACnet integration alarming:

1. Set the BACnet Site attribute to true in each Site Object representing a site that you want to use Metasys/BACnet
Integration alarming.

2. For each NAE in the site using alarming integration, configure one or more Notification Class objects for routing
event messages from Event Enrollment objects and/or objects with intrinsic alarming to BACnet device destinations.
Be sure you reference the BACnet devices by adding them to the Recipient List of the Notification Class object.
Identify a BACnet device by using either its network address or BACnet device identifier (OID).

Note: If you want to display alarm and event data from BACnet device destinations on the Metasys system
Alarms Window and Event Viewer, set the Notification Class Object’s Route to Metasys attribute to true.
The BACnet device must specify the NAE as a recipient for their alarms. To make the NAE an alarm
recipient, configure a Notification Class object on the BACnet device. Alarms and acknowledgements
from the BACnet device are incorporated into the Metasys alarming system. To route BACnet alarms
from the N30 to the NAE, the N30 must be configured to use BACnet alarm routing. For information on
how to do this, see the documentation of the BACnet device you are integrating.
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Note: When the NAE receives an alarm from an NAE, it can be sent from the DDAs on the receiving NAE but
can not be routed again from that NAE. If the alarms need to be routed from the NAE device, they should
set the Use Remote Alarming to False for objects in the FAC.

3. Configure one or more Event Enrollment Object or objects that supports intrinsic alarming using the Insert Object
Wizard. See BACnet Intrinsic Alarming for a list of objects that support intrinsic alarming.

Note: For both types of these alarm generating objects, you must configure the Event Enrollment object’s Notification
Object Reference attribute to reference the Notification Class Object created in Step 2. This reference
represents the instance number of the Notification Class (value of its Object Identifier attribute). The Notification
Class object and the alarming object must exist on the same device.

See BACnet Intrinsic Alarming for more information on intrinsic alarming.

See BACnet Event Enrollment Object Alarming for information on Event Enrollment alarming.

For more information on BACnet Integration, see the BACnet Integration Object and the Related Documentation
table.
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Audit Trail
The Audit Trail feature generates audit messages and stores them in Audit Repositories. An audit message contains
information about a significant event on the Building Automation System (BAS). For audit purposes, a significant
event is an action or occurrence on the system that should be recorded for later analysis of building operations. A
new audit message is generated for each significant event on the BAS. The Audit Viewer displays the audit messages
stored in an audit repository. You can access the Audit Viewer from the View Menu of the Metasys user interface
in online mode.

The Audit Trail provides a historical record of the audited events, such as creating or deleting items, that have
occurred within the system. By viewing audit messages, you can examine and analyze the actions that occurred in
the system.

Audit Trail Concepts
Audit Trail Overview
The Audit Trail feature initiates an audit message when the system detects an audited event such as a user logging
on or logging off of the Metasys system, commanding an item, or changing the configuration of a device. An audit
message is stored in the Audit Repositories of the device that generated the audit message. When the local audit
repository is full, you can send its audit messages to an ADS (ADX) repository defined as the Default Destination
for permanent storage.

The Audit Viewer allows you to view audit messages stored in the audit repository of the selected device. You can
determine how to sort and filter the audit messages that appear in the Audit Viewer as well as forward them to the
defined default destination. You can add annotations to audit messages and view them when displayed on an
ADS/ADX. You can also define customized annotations and add these custom annotations to audit messages.

For sites with MVE installed, configure the following attributes in the Site Object:

• Annotation Include
• Annotation Exclude
• Signature Include
• Signature Exclude

These settings are used by MVE sites to enable the MVE desired annotations and electronic signature for audit
messages. You can apply these settings at the site level or down to the object level as needed. You can set the
MVE site to require only annotations, only electronic signatures, both annotations and signatures, or neither annotations
nor signatures. Non-MVE sites may optionally define and use annotations; however, electronic signatures are specific
to MVE sites.

When both annotations and signatures are required, and a user acknowledges or discards an audit message, they
are prompted to reauthenticate and enter a reason and annotation for the action. The user’s logon name, date and
time of signature, and the reason for signature are saved as part of the annotation. You cannot delete annotations
on an MVE site.

SeeConfiguring Annotation and Electronic Signature Requirements in the Site Object inMVE in the Site Management
Portal User Interface section. For additional information, refer to the Metasys for Validated Environments, Extended
Architecture Technical Bulletin (LIT-12011327).

Figure 42 shows the flow of audit messages through the Metasys system.
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Figure 42: Audit Message Process

Audited Events
Audited events are significant events occurring in the system that trigger the Audit Trail feature to generate an audit
message. The following table lists the features and corresponding actions that initiate the generation of audit
messages. The following table also lists Audit Classes (Set 568) in which the actions belong. Click the feature name
for more information about that feature.

Note: Do not confuse audited events with those associated with alarming. See Alarm and Event Management for
details on alarming.

Table 92: Audited Events
Action Causing Audit MessageFeature
each command issued, enabled, disabled, or deleted (Audit Class = User Action)ActionQ

By default, the ADS/ADX does not create an audit entry when you discard an event that originates
on the ADS/ADX via the Alarms Window, Event Viewer, or via a BACnet device (Audit Class =
User Action). To capture audit entries for these events would create an undue number of entries
in the database.

Note: Engines do not create an audit entry when you discard events that originate on the
engine. For details on changing this setting, refer to Creating Audit Entries for Discarded
Events in the NAE Commissioning Guide (LIT-1201519).

Note: Error messages returned by the Email DDA logged in the Audit Viewer appear in English
only.

Alarm and Event
Management

• each command issued to clear the Audit Repository. See Clearing the Audit Repository.
(Audit Class = User Action)

• each command issued to discard an audit message or a group of audit messages (Audit
Class = User Action)

• each command issued to change the Enabled Audit Level attribute in the Engine Device
Object or ADS Device Object based on a system event, a user changing the time of day, or
a user command

See Configuring the Engine Audit Repository. (Audit Class = User Action, Non-critical System
Event, Critical System Event, Application, or Diagnostic)

Audit Trail

each errorlog listing problems with your Metasys system such as detected software or
configuration errors (Audit Class = Diagnostic)

Diagnostics
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Table 92: Audited Events
Action Causing Audit MessageFeature
• each new trend extension created (Audit Class = User Action)
• each change to the trend routing configuration (Audit Class = User Action)
• each command issued to the trend extension (Audit Class = User Action)
• each change to trend views such as creating, deleting, or editing a trend view (Audit Class

= User Action)
• each change to the Engine and ADS/ADX configuration (Audit Class = User Action)

Trend Extensions

Trend Studies

• each item added to or removed from the schedule (Audit Class = User Action)
• each change to the key item or its scheduled attribute (Audit Class = User Action)
• each change to the effective period (Audit Class = User Action)
• each time the schedule is enabled or disabled (Audit Class = User Action or Application)

Scheduling

• each successful and failed log on and log off attempt (Audit Class = User Action)
• each administrative action (Audit Class = User Action)
• each authentication failure (Audit Class = Application)
• each authorization failure (Audit Class = Application)

System Security

each command (Audit Class = User Action)User Graphics Tool (UGT)

• each user command (Audit Class = User Action)
• each change in item configuration such as adding, deleting, and editing an item (Audit Class

= User Action)
• each controller upload, download, synchronization, and reset occurring in online mode. Audit

messages are not generated for those actions in the SCT offline mode. (Audit Class = User
Action, Application, Non-critical System Event, Critical System Event)

Navigation Tree and Other
Features

Audit Repositories
The following table describes the two types of audit repositories for storing audit messages in the Metasys system.

Table 93: Audit Repositories
DescriptionType
• Provides temporary storage for audit messages on the Engine.
• Allows the audit messages stored in the Engine local audit repository to be displayed in the

Audit Viewer.
• Forwards audit messages from the Engine local audit repository to the Default Destination.

See Default Destination and Message Forwarding.

Local (Engine) Audit
Repository

• Provides permanent storage for audit messages on the ADS/ADX platform.
• Places audit messages generated on an ADS/ADX platform directly into the ADS (ADX)

audit repository.
• Receives audit messages from multiple Engine local audit repositories and provides

permanent storage for the audit messages. The ADS (ADX) audit repository is usually defined
as the default destination for audit messages from Engine local audit repositories.

• Allows the audit messages stored in the ADS (ADX) audit repository to be displayed in the
Audit Viewer.

ADS (ADX) Audit Repository

For information on configuring the Engine local audit repository and the default destination, click one of the following:

• Configuring the Engine Audit Repository
• Forwarding Audit Messages to the Default Destination

A Database Timeout Error can occur when viewing audit messages if the repository contains too many unfiltered
audit messages before the system times out (typically, one million messages). To prevent this error, back-up and
purge audit message records from the repository (JCIAuditTrails) using the Metasys Database Manager on a regular
basis.
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Default Destination and Message Forwarding
The Default Destination defines where audit messages are sent when the Engine local audit repository is full, at a
user-defined time (ADS Delivery Time attribute of Engine device), or when a user clicks the Forward Messages
button in the Audit Viewer. Configure an ADS (ADX) Audit Repository as the Default Destination to permanently
store audit messages. For information on how to define a default destination, see Configuring the Engine Audit
Repository.

When the Audit Forwarding Threshold is reached, all non-forwarded audits in the Local Audit Repository are
forwarded to the defined ADS Repository.

To generate an alarm message when a Rollover or Stop condition occurs, set the Audit Generate Alarm When Full
attribute in the Engine device to True. See Configuring the Engine Audit Repository and Audit Repositories.

You can forward audit messages to the Default Destination from the Engine local audit repository by clicking the
Forward Messages button in the Audit Viewer. See Forwarding Audit Messages to the Default Destination.

Note: You cannot forward audit messages from an ADS (ADX) audit repository to another ADS (ADX) audit
repository.

Note: You can define only one ADS (ADX) audit repository as the Default Destination for messages from an Engine
local audit repository; however, different Engines can have different ADS (ADX) repositories defined as their
Default Destination.

If you have not defined a Default Destination when the Engine local audit repository is 100% full, the local audit
repository either replaces the oldest messages (rollover) with new messages or stops recording audits according
to the Audit Action When Full attribute configuration.

Audit message rollover begins or replacement stops only when the total number of non-forwarded audit messages
reaches the size defined by the Audit Repository Size attribute. In other words, once the local audit repository
reaches the defined size, new audit messages continue to enter the local audit repository replacing forwarded
messages until all forwarded messages are gone. The following figure illustrates the Audit Action When Full when
set to Rollover or when set to Stop.

Figure 43: Audit Action When Full
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If you have defined a Default Destination, the Audit Forwarding Threshold attribute is set to any percentage other
than 100%, and the Audit Action When Full attribute is set to Stop; also the audit messages do not stop rolling over
as long as forwarding is successful. This situation occurs because audit messages are forwarded to the Default
Destination when new audit messages are received, and the forwarded messages are automatically replaced. The
local audit repository does not fill up with non-forwarded audit messages and, therefore, no alarm is generated.

Audit Message and Audit Viewer
The Audit Trail feature generates a new audit message for each significant event occurring on the system that
contains data associated with the event. SeeAudited Events. The Audit Viewer displays the audit messages residing
in the Audit Repositories of the currently selected device and is accessible from the View Menu of the Metasys user
interface in online mode. The window displays 1,000 audit messages per page for an ADS/ADX, other engines are
limited to a maximum of 500 audit messages per page. See Launching the Audit Viewer.

You can only view the audit messages from one audit repository of one device at a time:

• If you are viewing the contents of an Engine local audit repository, the audit messages displayed come from that
Engine only.

• If you are viewing the contents of a Engine local audit repository of an Engine device designated as the Site
Director, the audit messages displayed come from that Engine local audit repository only.

• If you are viewing the contents of an ADS (ADX) audit repository, the audit messages displayed come from that
ADS (ADX) audit repository only. An ADS (ADX) audit repository may contain audit messages that have been
routed from other Engine or ADS/ADX devices, but the repository does not display the contents of multiple
repositories.

Note: You can define an audit repository as a Default Destination, so it receives audit messages from other audit
repositories. See Default Destination and Message Forwarding.

When viewing an ADS/ADX device, a standard filter is applied to the Audit Viewer when it is first opened. This filter
allows you to see all audit messages.

Custom filters can also be used when viewing the ADS/ADX device to narrow the list of audit messages to only
those that meet specific criteria. Custom filters query the entire ADS/ADX database, not just the list of audit messages
that appears on the screen. You can filter audit messages by any combination of Date/Time, User, Class Level,
Action Type, and/or Discarded. New audit messages appear in the list only if they meet all criteria specified in the
filter. Custom filters cannot be saved.

The following table describes the format of the audit message (and corresponding buttons and fields) as displayed
in the Audit Viewer.

Table 94: Audit Viewer
DescriptionItem/Column
Indicates the device for which the Audit Viewer is displayed. The device name appears on the left side
of the Audit Viewer above the table.

This field corresponds to the selection made in the Device Selection Dialog box. See Launching the
Audit Viewer.

Selected Device

Indicates the number of audit messages that currently appear in the Audit Viewer. The Audit Count
appears on the right side of the Audit Viewer above the table only for Engine devices.

Audit Count (Engines
Only)

Indicates that standard filtering is applied to the Audit Viewer for the selected ADS/ADX. This filter
information appears on the right side of the Audit Viewer above the table. The count of entries that
apply to this filter appears in parenthesis next to the radio button.

Standard Filter Radio
Button (ADS/ADXOnly)

Indicates that custom filtering is applied to the Audit Viewer for the selected ADS/ADX. This filter
information appears on the right side of the Audit Viewer above the table. The count of entries that
apply to this filter appears in parenthesis next to the radio button.

Custom Filter Radio
Button (ADS/ADXOnly)
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Table 94: Audit Viewer
DescriptionItem/Column
Allows you to apply custom filtering to the Audit Viewer when the Custom Filter radio button is selected.
This table appears but is not active when the Standard Filter radio button is selected. You may need
to adjust the slider bar to show the Custom Filter table.

The buttons for this table are:
• - adds a filter using the Add Filter dialog box

• - removes the selected filter

• Apply - queries the ADS/ADX database and displays the resultant audit messages

See Creating a Custom Filter within the Audit Viewer (ADS/ADX Only).

Custom Filter Table
(ADS/ADX Only)

Displays an icon indicating the status of the audit message:

- audit message is new (that is, the message has occurred in the system within the new entry
timeframe)

Note: See Display Settings Tab in the Preferences section for information on changing the amount
of time audit messages are considered new using the New entry time frame preference (default
value = 15 minutes).

- audit message has one annotation

- audit message has more than one annotation

- audit message has an electronic signature

Status Icons

Displays the date and time that the audit message was generated. The date and time format is defined
by the Language selected in the User Profile (User Profile tab section of the Security Administrator
System).

When

Displays the name of the item that generated the audit message. An item name is the label displayed
for the selected item in the All Items navigation tree (for example, AV1, NAE2, or Schedule1). Be sure
you define unique item names.

Item

Indicates the class in which the audit message belongs. For more information on Class Level, see the
Enabled Audit Level attribute in the Engine Device Object or ADS Device Object.

Class Level

Indicates the application that performed the action that generated the audit message. For example,
the origin application may be the Alarm and Event, Trend, or Security feature.

Origin Application

Indicates the user associated with the action that initiated the audit message (for example, the person
who changed a setpoint).

User

Indicates the type of action that initiated the audit message.Action Type

Provides the description of the action that generated the audit message. For example, Enabled appears
in this column if you send an Enable command to an item. The description appearing in this column
comes from the State, Mode, and Type Sets associated with the time that generated the audit message.

Note: If the Class Level is Non-Critical System Error or Diagnostics and the Action Type is Error,
then the associated error string appears. If the Action Type is Command and there is no further
definition of the type of command (for example, Operator Override, Adjust, etc.), then
Description will show the value of the new command (for example, On or Off).

Description

Indicates the value and engineering units, if applicable, of the item before performing the action that
generated the audit message.

Previous Value
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Table 94: Audit Viewer
DescriptionItem/Column
Indicates the value and engineering units, if applicable, of the item after performing the action that
generated the audit message.

Note: If the Action Type is Command and there is no further definition of the type of command (for
example, Operator Override, Adjust, etc.), then the actual post value will be shown in the
Description column. If the Description is a User Login Successful or Failed, then the Post
Value will show the IP address of the client PC from which the login attempt was made.

Post Value

Indicates the status of the item at the time the audit message was generated.Status

Specifies the column of data used to sort the audit messages in the current Audit Viewer (ascending
or descending order).

Allows you to navigate through the pages of audit messages in the Audit Viewer. Use the buttons to
go to the first page, previous page, next page, or last page. Type a page number in the text box and
press the enter key to jump directly to a specific page.

Paging Controls
(ADS/ADX Only)

Sends audit messages from the Engine local audit repository to the Default Destination. See Forwarding
Audit Messages to the Default Destination.

Forward Messages
Button

Removes the selected audit messages from the Audit Viewer. See Discarding Audit Messages.Discard Button

Copies the selected audit messages to the Clipboard for pasting into other applications such as
Microsoft Excel or Word.

When you click this button with nothing selected in the audit viewer, all entries are copied to the
clipboard.

Note: You can also use Ctrl A to select all entries and Ctrl C to copy to the clipboard.

Copy Button

Audit Message Annotations
An annotation is a textual string associated with an audit message. You can view or add annotations from the ADS
(ADX) audit repository only. You cannot edit an existing annotation. Instead, add a new annotation to the audit
message. You can also define custom annotations. See Adding Annotations, Viewing Annotations, and Creating
Annotations.

Note: The annotation feature is not available on the Engine local audit repository.

The following table describes the fields of an annotation.

Table 95: Audit Message Annotations
DescriptionField
When adding annotations, indicates the user ID of the person associated with the action that generated
the audit message.

When viewing annotations, the first User field displayed indicates the user ID of the person associated
with the action that generated the audit message. The User field displayed under the Annotation
Information section indicates the user ID of the person that added the annotation.

User

When adding annotations, indicates the date and time the audit message was generated.

When viewing annotations, the first Date and Time field displayed indicates the date and time the audit
message was generated. The Date and Time field displayed under the Annotation Information section
indicates the date and time the annotation was added to the audit message. The date and time format
is defined by the language selected in the User Profile (User Profile tab section of the Security
Administrator System).

Date and Time

Indicates the complete Item Reference of the item associated with the audit message.Item Reference
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Table 95: Audit Message Annotations
DescriptionField
Provides the description of the action that generated the audit message. For example, Enabled appears
in this field if you send an Enable command to an item. The descriptions come from the State, Mode,
and Type Sets associated with the item that generated the audit message.
Note: If the Class level is Non-Critical System Error or Diagnostics and the Action Type is Error,

then an associated error string appears.

Description

Allows you to select from a list of predefined annotations or add or view a text string (annotation) of
up to 254 characters describing the associated audit message.

Annotation

If the audit message has multiple annotations associated with it, allows you to navigate through the
annotations. Use the buttons to go to the first annotation, previous annotation, next annotation, or last
annotation.

The text box displays the number of the annotation being viewed. The Annotations feature automatically
assigns a number to each annotation created. For example, if the audit message has three annotations,
the number being displayed in this section can be 1, 2, or 3 depending on the annotation being viewed.
Type a number in the text box and press the enter key to jump directly to a specific annotation.

Navigation Controls

Audit Trail Steps
Configuring the Engine Audit Repository
To configure the Engine Audit Repository and the Default Destination:

1. View the desired Engine device. See Displaying Information About an Item for information on how to display an
item.

2. Select the Focus tab, and click the Advanced radio button to display additional item information.
3. Select Edit.
4. Scroll down to the Audit Trail and Site sections.
5. Edit the attributes in these sections as desired. Use the table below as a guide. See the Engine Device Object

chapter for information about the attributes. The Engine Device attributes table contains Default Value and
Values/Options/Range information for the attributes. Click the attribute names in the table for descriptions.

Table 96: Configuring the Engine Audit Repository
Edit This Engine Attribute:To Do This:
Audit Repository SizeChange the size of the Engine local audit repository.

ADS RepositoryDesignate an ADS/ADX repository as a Default Destination.

ADS Delivery TimeDefine a time to deliver audit messages to the ADS/ADX.

Audit Forwarding ThresholdDefine how full the audit repository must be before forwarding audit
messages to the ADS/ADX.

Audit Action When FullDefine if the Audit Trail feature overwrites existing audit messages
or stops generating audit messages when the audit repository is full.1

Audit Generate Alarm When FullDefine if the Audit Trail feature should generate an alarm when the
audit repository is full.

Enabled Audit LevelDefinewhich level of audit messages get added to the audit repository.

1 This action is only valid when the device is not set to forward data to an ADS/ADX. The stop/rollover option only applies
when there is no forwarding to an external repository.

Note: You can define only one repository as the Default Destination for audit messages from an Engine audit
repository. See Audit Repositories for more information.
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6. Click Save.

Note: If you want to define all Engine local repositories for the entire site instead of individually, select the Site
in the navigation tree and edit the following Site Object attributes. The Site object attributes table contains
Default Value and Values/Options/Range information for the following attributes:

• Default ADS Repository
• Default ADS Delivery Time

Launching the Audit Viewer
1. Select Audit Viewer from the View Menu. If you have more than one Engine or ADS/ADX on the site, a Device

Selection Dialog box appears.

2. Select the device containing the audit repository with the audit messages that you want to display in the Audit
Viewer.

3. Click OK. The Audit Viewer appears in the display frame and displays the audit messages from the audit repository
of the selected device. See for details.

Note: Alternatively, you can right-click the desired device in the navigation frame and select Audit Viewer from the
menu that appears.

Adding Annotations
Note: You can add annotations from the ADS/ADX device only. Annotations are not forwarded between ADS/ADXs.

1. Launch the Audit Viewer by selecting the desired ADS/ADX from the Device Selection Dialog box.

2. Right-click the audit message, and select Add Annotation from the menu. Alternatively, you can select Add
Annotation from the Actions menu. The Add Annotation dialog box appears.

Note: The drop-down list on the Add Annotation dialog box contains predefined annotations from your system
preferences. If you have not defined annotations in your system preferences, the drop-down list is empty.
See Annotation Settings Tab in Preferences.

3. Type the desired text in the message box.
4. Click OK.

Viewing Annotations
Note: You can view annotations from the ADS/ADX device only.

To view annotations:

1. Launch the Audit Viewer by selecting the desired ADS/ADX from the Device Selection dialog box.

2. Double-click the annotation icon in the first column of the Audit Viewer for the desired audit message. The View
Annotations dialog box appears.

Note: To indicate that an audit message was electronically signed, a signed book icon appears in the first
column of the Audit Viewer on a validated ADX on an MVE system.

Note: Alternatively, you can select View Annotations from the Actions menu or right-click the audit message
and select View Annotations from the menu.

3. View the message.
4. Click OK.

Creating Annotations
1. Select the Annotation Settings tab on the Metasys Preferences screen.

2. Enter annotation text. The text can be from 1 to 254 characters in length.
3. Click Add to save the annotation settings.
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Note: The annotations you create appear in the drop-down list on the Add Annotations dialog box. If you do not
create any annotations, this list is blank.

Sorting the Audit Message List
1. Launch the Audit Viewer.

2. Click the header of the column in which you want to use as the sorting criteria. An up or down arrow appears in
the header of the column. Click on the arrow to change the sorting order, and the table reorganizes.

Creating a Custom Filter within the Audit Viewer (ADS/ADX Only)
1. Launch the Audit Viewer.

2. Click the Custom Filter radio button.
3. Click the Add button.
4. Select the criteria and the associated values for the filter and click OK. All criteria added to the custom filter table

make up the rules of the filter.
5. Click Apply to get the results of the custom filter.
6. To view the data without the custom filter, click the Standard Filter radio button.

Clearing the Audit Repository
1. Launch the Audit Viewer by selecting the desired Engine or ADS/ADX from the Device Selection Dialog box.

2. Click anywhere in the Audit Viewer.
3. Click Clear. All audit messages stored in that Audit Repository are cleared.

Note: If you want to permanently store audit messages, click the Forward Messages button before clicking
Clear.

Note: For a validated ADX on an MVE system, an electronic signature with annotation is required before clearing
the audit repository.

Discarding Audit Messages
1. Launch the Audit Viewer.

2. Select one or more audit messages.

Note: For a validated ADX on an MVE system, an electronic signature with annotation is required before
discarding an audit message.

3. Click Discard.

Note: When you discard audit messages from the repository, they are not automatically discarded from the
originating device.

Forwarding Audit Messages to the Default Destination
1. Launch the Audit Viewer.

2. Click Forward Messages. The messages are forwarded from the local audit repository to the defined Default
Destination.

Launching the Focus View of the Item That Generated the Audit Message
1. Launch the Audit Viewer.

2. Select an audit message and choose Selected Item from the View menu.

Note: Some items, such as site level items, do not support this option because they do not have viewable information.
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Scheduling
The scheduling feature allows you to automate routine functions such as changing the operating mode of a room
from occupied to unoccupied for heating or cooling needs and helping perform Energy Optimization strategies. Each
schedule consists of a list of weekly scheduled events as well as a list of exception events. Each event consists of
a value to write to a list of Scheduled Items at a particular time. The event by default ends at midnight unless ended
earlier. The scheduling feature’s user interface provides a graphical view for configuring the schedule and displaying
when events are scheduled to occur.

Scheduling Concepts
Calendar
The Calendar Object resides in an Engine or FAC and is the internal basis for the calendar functionality of the
scheduling feature. Create a Calendar and use it to define a list of holidays or special events that can be used in
multiple schedule objects to define different events that need to occur. The schedule executes an exception schedule
based on the list of dates defined in the calendar. For example, use a calendar to define different building operations
on days such as holidays when the building is not occupied.

A schedule can reference calendars on any Engine or FAC on the site.

Use the calendar feature to:

• create new calendars

Note: You cannot create a new Calendar in a FAC from SMP or CCT.
• edit existing calendars
• copy and paste a calendar to another device or item (offline mode), only in the NAE

• toggle the calendar view between a graphical, one-month view or 12-month view
• enable or disable a calendar
• reference a global calendar

The following table describes the functions of the Calendar View’s buttons.

Table 97: Calendar Button Functions
FunctionButton
Opens Edit mode

Shows the Date, Date Range, and Week and Day details of the calendar entries
and allows you to create new entries or edit existing entries when in Edit mode.

Increases or decreases the currently displayed year by one year.

Increases or decreases the currently displayed month by one month.

Returns the display to the current month.

Toggles the calendar display between the 1-month view and 12-month view.
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Schedule
The Schedule Object resides in an Engine or FAC and is the internal basis for the Scheduling feature. Create a
Schedule and use the Scheduling feature to define the items and times when the Schedule writes values to the
referenced attributes of the Scheduled Items. Each schedule includes the following:

• a view of today’s schedule that shows what actions the schedule is currently configured to perform today, including
the Default Schedule Command. This view is not available in the SCT.

• a weekly schedule that uses events for each day (Monday through Sunday) to configure the times when the
Schedule writes values to its referenced attributes (Scheduled Items)

• an exception schedule that uses events to configure exceptions to the weekly schedule (optional)
• a list of items that the schedule controls (referenced by the schedule, called Scheduled Items) (optional)
• an effective period that optionally allows you to activate/inactivate the schedule for a selected period of time

Use the scheduling feature to:

• create new schedules

Note: You cannot create a new Schedule in a FAC from SMP or CCT.
• edit existing schedules
• add references to items for scheduling to a schedule using a navigation tree of the site
• delete references to items for scheduling from a schedule
• copy and paste a schedule to another device or item (offline mode), only in Engines
• enable or disable a schedule, not in FAC
• change the effective period of a Schedule
• provide day/time inputs within control logic

The following tables describe the functions of the Schedule View’s buttons and attributes and right-click menu.

Table 98: Schedule Button Functions
FunctionButton
Opens Edit mode

Click the button to open the Effective Period dialog box which allows you to
specify the Effective Period. Wildcards (any) are also available options for Month,
Day, Year or Day of Week fields.

Effective Period attribute

Binary, Analog, Multistate, Derived from Key Item - each of these choices will
bring up unique choices in the Default Schedule Command and State Text Fields.

Schedule Output Type

Binary: Release option or a choice of Off and On

Analog: Release option or a choice to input number

Multistate: Release option or a choice of State 0 to State 31

Derived from Key Item: Release option or a choice of Off and On

Note: If the Default Schedule Command is set to Release, the scheduling
feature’s control over the scheduled items ends. Release should only be
used for the Default Schedule Command if the scheduled items support
the Release command.

Default Schedule Command

Lists the available states and allows you to specify the state of the selected event
which are unique for each Schedule Output Type.

States Text

Allows you to toggle between views: Today's Schedule, Weekly Schedule,
Exception Schedule or Scheduled Items
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Table 99: Schedule Right-click Menu1

DescriptionMenu Option
Display Mode - Weekly Schedule

The States Text commands what the right-click menu will be. For example, toggle
between Off-On, Off-Reset, Absent-Present, Active-Inactive, Alarm-Normal.

Binary

Opens the Add Event dialog box and allows you to add an event to the schedule.Add Event(s)

Allows you to specify an event end time. The end time corresponds to the location of
your mouse cursor when you opened the menu. Drag the end of the event to adjust
the end time.

End Event

Right-click and choose between Add New Event or Modify Selected Event(s). Define
New Event(s) allows you to add (Day, Days, Hours, Minutes and Value). Modify Events
allows you to modify (Hours, Minutes and Value).

Analog

Opens the Add Event dialog box and allows you to add an event to the schedule.Add Event(s)

Allows you to specify an event end time. The end time corresponds to the location of
your mouse cursor when you opened the menu. Drag the end of the event to adjust
the end time.

End Event

The States Text commands what the right-click menu will be. For example, toggles
between Not Operating, Normal Start, Heating, Cooling, Fan Only or Minimum DAT
Control.

Multistate

Opens the Modify Event dialog box and allows you change the times and value of the
selected event. You can also double-click an event to access the Modify Event dialog
box.

Modify Selected Event(s)

Deletes the selected event.Delete Selected Event(s)

Display Mode - Scheduled Items

Choose between Key Data Type or Remove Item.All Scheduled Output Types

1 This menu is accessible only when Edit mode is used.

Today’s Schedule
The scheduling feature includes a view called Today’s Schedule. Today’s Schedule is a read-only view that shows
the schedule timeline for the current day. The timeline displays the projected schedule output that is written to the
scheduled objects for the current day, combining the default Schedule Command with events from both the Weekly
Schedule and Exception Schedule. Today’s Schedule also displays a table of times and values, which details the
changes in the schedule’s output for the current day.

Weekly Schedule
The scheduling feature has a weekly schedule that provides a schedule for each day of the week, Monday through
Sunday. Each daily schedule begins at 00:00 and ends at midnight (the display reads 23:59). Each day consists of
events that initiate the writing of values to the referenced attributes of the scheduled items based on the day of the
week. For example, you can schedule a fan to start at 7:00 and stop at 22:00 on Mondays.

To edit the weekly schedule, double click or right-click on the weekly schedule. Right-click brings up the context
menu (see Table 99).

Exception Schedule
The exception schedule provides a list of exceptions to the weekly schedule. Exceptions define a different set of
events that supersede the events for particular days in the weekly schedule. An exception can be defined for a date,
a date range, a week of the month and day of the week (week and day), or a reference to a Calendar. The following
table contains information on the four types of exceptions. Wild cards can also be used to define exceptions; refer
to Wildcards for more information.
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Table 100: Exception Types
DescriptionException Type
Occurs on a specific date.Date

Occurs during a range of dates.Date Range

Occurs on certain weekdays during certain weeks of certain months. For example, the second
Tuesday in any month or any Wednesday in June.

Week and Day

Occurs during all dates selected in the referenced calendar. Associating an exception with a
calendar allows you to reference a large number of dates.

Calendar Reference

Note: The N1 exception schedule only supports the Date exception (for example, to schedule the same exception
3 days in a row using an N1 Exception schedule requires the use of three separate date exception entries).
Date range, week and day, and calendar reference exceptions are not supported.

Each exception can have one or more events that run during the exception time period. Recall the example in the
Schedule topic where you scheduled a fan to start at 7:00 and stop at 22:00 on all Mondays. You can create a date
type exception to this weekly schedule if you want the fan to start and stop at different times on a certain day. For
example, you can create an exception for Monday, May 26, and define an Off event at the start of the day (00:00),
an On event at 9:00 in the morning (instead of 7:00), and another Off event at 17:00 in the evening (instead of 22:00).

You can assign a precedence level (1–16, where 1 receives the highest precedence) to each exception, regardless
of type, to determine the order of execution. If you define two or more exceptions for the same date, the exception
with the highest precedence executes. For example, an exception with a precedence of 2 executes over an exception
with a precedence of 8 if they are both defined for the same date.

If all exceptions for the same date have the same precedence, the exception that appears first in the exception list
executes first; therefore, if you have multiple exceptions defined for one day, the exceptions apply by precedence
level and then by the order of the items in the exception list.

Double clicking the exception schedule allows you to edit the exception schedule.

The JCI Exception Schedule attribute for the engine object (also an FAC mapped to an engine) allows you to set
how long exception schedules are kept after the exception date has expired . The default value is Auto Delete 31
days. Two options, Auto Delete 7 days and Manual Delete are available for this attribute. See the JCI Exception
Schedule attribute configuration in the Engine Device Object section for more information.

Note: Manual Delete is needed for locations like Japan where the local standards state that only the BACnet
workstation can delete exception schedules.

Events
An event describes the time when the scheduling feature writes user-defined values to the referenced item attributes
(Scheduled Items). Weekly schedules and exception schedules use an event to define when the scheduling feature
should change its output.

Each day of a weekly schedule and each exception day of an exception schedule has its own set of events. Days
can have multiple events (for example, a start event and a stop event). When the time defined by an event arrives,
the scheduling feature writes the value for the defined event to the referenced attribute of each item in the list of
scheduled items. Unless specified to end earlier, all events end at midnight. If an event is ended before midnight,
and no other events are scheduled, the scheduling feature writes the Default Schedule Command to the referenced
item attributes. If the Default Schedule Command is set to Release, the scheduling feature’s control over the scheduled
items ends. Values are sent to the referenced attributes at priority 15.

Note: Release should only be used for the Default Schedule Command if the scheduled items support the Release
command.
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Scheduled Items
Scheduled items are the objects/attributes that the event values are written to. A schedule can operate with an empty
Scheduled Items list. The scheduling feature writes the defined value to the scheduled items at the time defined by
an event. Schedules can reference any item that can be mapped into an Engine or ADS/ADX. Schedules defined
in an FAC can reference items within that FAC even if not mapped to an Engine. Adding items to a schedule involves
selecting the item and then selecting the attribute of the item that you want the schedule to change. At the times
defined by an event, the schedule writes the defined values to the attribute (scheduled attribute) associated with
each referenced item.

When there are no events active in the weekly schedule or exceptions, the schedule writes the Default Schedule
Command to the referenced attributes. If the Default Schedule Command is set to Release, the schedule’s control
over the scheduled items ends.

Note: Release should only be used for the Default Schedule Command if the scheduled items support the Release
command.

The table of scheduled items provides the Status Log entry for each scheduled item. The status log indicates any
errors that occurred when the scheduling feature attempted to write values to the scheduled items.

A single schedule can only apply values of one data type to all items in its list of scheduled items; therefore, the first
item in the Scheduled Items list becomes the key item. The key item determines the data type of the values that the
schedule writes to the attributes of all scheduled items. See the following Example Scenario for a description of how
scheduled items and the key item work.

Example Scenario:

You can close a relay or switch to start a fan. If the relay is represented as a Binary Output Object in the Metasys
system and you set the Present Value attribute of the Binary Output (BO) to On (1), the relay closes and starts the
fan. To do this, add the BO to the Scheduled Items and then select Present Value as the scheduled attribute. See
Adding Scheduled Items and the following figure.

Figure 44: Table of Scheduled Items

Suppose the BO in this scenario is the key item because it is the first item in the list of scheduled items and the
Present Value attribute is the scheduled attribute. Because the Present Value attribute of a binary output has a value
of 0 or 1, the schedule can only write 0 or 1 to the scheduled attributes of the items appearing below it in the list.

Suppose you add an Analog Value Object below the BO and select the Present Value attribute of the Analog Value
(AV) as the scheduled attribute. Even though the Present Value attribute of an AV has a wide range of numeric
values, only 0 (meaning Off) or 1 (meaning On) can be written to the AV attribute because the schedule writes values
to all items in the list of scheduled items using the data type of the BO, which is the key item.

To change the key item, see Editing Scheduled Events.
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Dates - Calendar Entry and Exception Schedule
You can use the following date formats for defining exceptions to the weekly schedules using calendar entries or
exception schedules:

• Date
• Date Range
• Week and Day

BACnet Clarification for Date Entries
ASHRAE has published a BACnet addendum 135-2008 AC to restrict and clarify what is allowed in the format of
calendar entries for single dates and range of date formats in the Calendar object and the exception schedule (the
dates you do not want the Schedule to operate, such as holidays).

For a Calendar object Date entry, the entry can be either a specific date or a date pattern:

• a specific date has all fields filled with specific values, and the Day of Week should also have a specific value
• a date pattern has some of the fields with any (wildcard) present

For a Calendar object Date Range entry, the new rules restrict each part (start date and end date) to be one of the
following:

• a fully specified date (all fields defined)
• a completely unspecified date (no fields defined - all fields wildcards [any])

Note: No partial wildcard fields for start date or end date are allowed in order to eliminate cases that could not
be clearly interpreted and implemented.

Note: The Metasys system currently allows partial wildcard fields for start or end dates leading to unpredictable
operation in some cases. You should follow the new BACnet rules and disallow these kinds of entries.

Date/Date Range
You can use a single date or a range of dates when defining exceptions to weekly schedule. The following table
describes the options available for defining a single date (January 1, 2010, for example) or range of dates (November
25, 2009 through November 26, 2009, for example) calendar or exception schedule entry.

Table 101: Date/Date Range Format
OptionsMenu
any, January through December, Odd (odd numbered months, 1 is January, 3 is March, and so on),
Even (even numbered months, 2 is February, 4 is April, and so on)

Month

any, 1 through 31, Last (the last day of the month)Day

any, 2006–2048Year

any, Monday through SundayDay of Week

Tip: If you specify a single date (that is, you define the day, month, and year), set the Day of Week to match the
day of the week for the specified date. For example, November 26, 2009, is a Thursday, so you need to specify
Thursday. If you specify Wednesday, the schedule is considered improperly configured. SeeData Consistency
Checking.

Note: For exception schedule entries, you also need to define the Precedence at which the schedule executes the
exception schedule.

Week and Day
You can use a week and day entry when defining exceptions to the weekly schedule. The following table describes
the options available for defining a week and day calendar or exception schedule entry (Saturday of the first week
in May, for example). Any mixture of any (wildcard) and specified entries is allowed. Week and day entries apply to
all years.
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Table 102: Week and Day Format
OptionsMenu
any, January through December, Odd (odd numbered months, 1 is January, 3 is March, and so on),
Even (even numbered months, 2 is February, 4 is April, and so on)

Month

any

1 = Days 1 through 7

2 = Days 8 through 14

3 = Days 15 through 21

4 = Days 22 through 28

5 = Days 29 through 31

6 (Schedule object)/Last (Calendar object) = Last seven days of the month

Week of Month

any, Monday through SundayDay of Week

Note: For exception schedule entries, you also need to define the Precedence at which the schedule executes the
exception schedule.

Wildcards
You can use wildcards to define specific calendar or exception schedule exceptions. Wildcards are the fields of an
exception schedule or calendar entry date specified by the any selection. For example, an exception date of December
25, any year, and any day of week means the events defined in the exception schedule occur on December 25 of
every year regardless of the events defined in the weekly schedule. To use wildcards, select any from the drop-down
menu of the Exception Detail or Calendar Entry dialog box.

For exceptions, the wildcard part (field) of the date appears as any in the list of exceptions. For example, December
25, any year Precedence 8 appears in the list of exceptions after saving the selections described in the following
table for a single Date entry.

Table 103: Schedule Wildcard Example - Single Date
ValueParameter
DecemberMonth

25Day

anyYear

anyDay of Week

8Precedence

For calendars, the wildcard part (field) of the date appears as any in the calendar entries list. For example, Month
= February, Day = 2, Year = any appears in the calendar entries list after saving the selections described in the
following table for a single Date entry.

Table 104: Calendar Wildcard Example - Single Date
ValueParameter
FebruaryMonth

2Day

anyYear

anyDay of Week

You can use wildcards for the following types of exceptions and calendar entries:

• Date
• Date Range
• Week and Day
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Wildcards - Date
For a single date, a wildcard opens a particular field to the full range of possible values for that field. The following
table describes the meaning for each type of unspecified wildcard date field.

Table 105: Unspecified Wildcard Date Field Meanings
MeaningUnspecified Field
Every monthMonth

Every day of the month, unless a particular day of the week is specified by the Day of Week fieldDay of Month

Every yearYear

Every day of the week, unless a particular day of the month is specified by the Day of Month fieldDay of Week

The following table shows some sample wildcard dates and their meanings.

Table 106: Sample Wildcard Date Meanings
MeaningDay of WeekYearDay of MonthMonth
The first day of every month, every yearanyany01any

March 5 of every yearanyany05Mar

March 5 of 2010any201005Mar

Every day in March 2010any2010anyMar

Every dayanyanyanyany

Every FridayFridayanyanyany

Every Friday in 2010Friday2010anyany

Every Friday in March of 2010Friday2010anyMar

Only on Friday, March 12, 2010Friday201012Mar

Every April 13 that occurs on a MondayMondayany13Apr

The second of every even numbered month in 2010:
February 2, April 2, June 2, August 2, and so on

any20102Even

The last day of every month in 2010any2010lastany

Wildcards - Date Range
For a range of dates, the start date and end date can be fully specified dates (all fields defined). If the start date is
a fully specified date, then the end date can be a completely unspecified date (all fields wildcards [any]). If the start
date is a completely unspecified date (all fields wildcards [any]), then the end date must be a fully specified date.
The Day of Week must be set to match the day of the week for all specified dates. The following table shows some
sample wildcard date ranges and their meanings.

Table 107: Sample Wildcard Date Range Meanings
MeaningEnd DateStart Date

Day of
Week

YearDay of
Month

MonthDay of
Week

YearDay of
Month

Month

From Thursday, August 30,
2012 to any date

anyanyanyanyThursday201230Aug

Any date to Wednesday, July
4, 2012

Wednesday201204Julanyanyanyany

Sunday, January 1, 2012 to
Monday, April 30, 2012

Monday201230AprilSunday20121Jan

Note: No partial wildcard (any) fields for start date or end date are allowed in order to eliminate cases that could
not be clearly interpreted and implemented. See BACnet Clarification for Date Entries section for more
information.
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Wildcards - Week and Day
You can use wildcards for Week and Day entries. The Week and Day selection identifies a month, a week of the
month, and a day of the week. The possible selections include any (every) as the week of the month, 1 (Days 1–7),
2 (Days 8–14), 3 (Days 15–21), 4 (Days 22–28), 5 (Days 29–31), and 6/Last (the Last seven days). The following
table shows some sample wildcard week and day exceptions.

Table 108: Sample Wildcard Week and Day Exceptions
MeaningDay of WeekWeek of MonthMonth
Every day of the yearanyanyany

Monday of the first week of every monthMonday1

Days 1–7

any

Every Tuesday in JanuaryTuesdayanyJan

Every day of the week in the second week of Februaryany2

Days 8–14

Feb

Wednesday of every week of every monthWednesdayanyany

Every day of every week in MarchanyanyMar

Every day of the third week of every monthany3

Days 15–21

any

Thursday in the fourth week of AprilThursday4

Days 22–28

Apr

29th, 30th, and 31st (as applicable) of every monthany5

Days 29–31

any

Saturday in the last seven days of JuneSaturday6/Last

Last seven days

Jun

Effective Period
The effective period defines the active or inactive date range for a schedule (weekly and exception schedule). In
Edit mode, the button opens the Effective Period dialog box. By default, a schedule is always active.

For example, you can create two schedules with the same items/objects and configure one for the heating season
and the other for the cooling season. Then you can define the effective period of the heating schedule from October
through March and the cooling schedule from April through September of each year.

Trend Scheduling
Use the Schedule feature to configure time and day periods for recording trend data for object trend extensions. In
the schedule, add the trend extension to the Scheduled Items list and select the desired trend extension attribute.
Make sure the trend extension is the Key Item in the Scheduled Items list. Then use the weekly schedule to define
the days and times you want to record trend data for the selected object trend extension.

For more information on trend extensions and trending, see the examples below and click one of the following:

• Extensions
• Trend Extensions
• Trend Studies

For instructions on how to schedule a trend extension, see Scheduling a Trend Extension.

Example 1:

To collect trend samples starting at 6:00 A.M. Monday through Friday and at 8:00 A.M. on Saturday and Sunday,
and stopping trend collection at 8:00 P.M. on all days, configure a schedule as follows:
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In the Scheduled Items list, add the desired object trend extension and select the trend extension’s Log Enabled
attribute as the Scheduled Attribute. Make sure the trend extension is the key item.

On the Weekly Schedule tab, set the Default Schedule Command to False and configure the event to begin and
end according to the following table:

Table 109: Example 1 - Event Configuration
ValueTime
TrueMonday - Friday/6:00 A.M. - 8:00 P.M. (06:00 - 20:00)

TrueSaturday - Sunday/8:00 A.M. - 8:00 P.M. (08:00 - 20:00)

Example 2:

You may want to define how many trend samples are collected during specific periods of time. You can use a shorter
trend sampling interval to collect more trend samples during the day when there is more activity in the building, and
use a longer trend sampling interval to collect fewer trend samples at night when there is less activity in the building.

To take samples every 60 seconds from 6:00 A.M. to 6:00 P.M. Monday through Friday, every 600 seconds from
6:01 P.M. to 5:59 A.M. Monday through Friday, and every 600 seconds from 12:00 Midnight to 11:59 P.M. on Saturday
and Sunday, configure a schedule as follows:

In the Scheduled Items list, add the desired object trend extension and select the trend extension’s Sample Interval
attribute as the Scheduled Attribute. Make sure the trend extension is the key item.

On the Weekly Schedule tab, set the Default Schedule Command to 600 seconds and configure the event to start
and end according to the following table:

Table 110: Example 2 - Event Configuration
ValueTime
60 (seconds)Monday - Friday/6:00 A.M. - 6:00 P.M. (06:00 - 18:00)

Fast Clock
A device (true for FAC devices as well) containing schedules activates the fast clock feature when the current date
and time are changed in the device, the device restarts following a power failure or reset, or the device is put into
simulation mode. The fast clock feature ensures the schedule and its associated scheduled items are in the correct
state based on day and time of the device.

The fast clock evaluates the events scheduled for the current day from midnight to the current time, to find the last
scheduled time and value for the current day. If the fast clock does not find any scheduled events, then the value
associated with the latest time for the current day is used. Then the fast clock writes this value to all scheduled
attributes of all items referenced by the schedule’s list of scheduled items.

Data Consistency Checking
The exception schedule or calendar verifies the existence of exception and calendar dates and that the start date
of a date range occurs earlier than the end date for schedules and calendars when:

Exception and calendar dates have all four fields defined and do not use wildcards (Month, Day of Month, Year, and
Day of Week). For example, if you entered Monday, January 10, 2010, in the Exception Detail or Calendar Entry
Detail dialog box, a warning message appears because January 10, 2010, is not a Monday.

Exception and calendar dates have Month, Day of Month, and Year defined and use a wildcard for the Day of Week
field. For example, if you entered February 29, 2010, and any in the Day of Week field of the Exception Detail or
Calendar Entry Detail dialog box, a warning message appears because there is no 29th day in February, 2010.

Exception and calendar date ranges have all fields of both the start and end dates defined. For example, if you
entered a start date of Tuesday, July 2, 2010, and an end date of Monday, July 6, 2010, in the Exception Detail or
Calendar Entry Detail dialog box, a warning message appears because July 2, 2010, is not a Tuesday.
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Exception and calendar date ranges have Month, Day of Month, and Year defined and use a wildcard for the Day
of Week field for both the start and end dates. For example, if you entered a start date of August 27, 2010, and any
in the Day of Week field, and an end date of August 6, 2010, and any in the Day of Week field in the Exception
Detail or Calendar Entry Detail dialog box, a warning message appears because the end date occurs before the
start date.

Because the Schedule can reference Calendars residing in another device, the scheduling feature performs the
following calendar reference verification:

If a schedule references a calendar in another device and that device goes offline, the schedule assumes that while
the device is offline, the calendar’s Present Value does not change. For example, a schedule residing on NAE1
refers to a calendar residing on NAE2 and the Calendar Object’s Present Value attribute is True; however, if NAE2
is offline at midnight, the schedule assumes the calendar’s Present Value changes to False at midnight. This means
that the exception schedule is not active.

If a schedule refers to a calendar and that calendar is deleted, the schedule assumes the Calendar object Present
Value is False and the exception schedule is not active.

When the date changes (at midnight), the daily schedule ends and the Schedule object executes the next day’s
regular schedule, exception schedule, or Default Schedule Command.

Global Calendar
The Global Calendar allows you to make facility-wide changes to calendars, such as defining holidays. These
changes are tedious if you need to edit many calendars. To solve this problem, you can reference a Global Calendar
object in each FAC or NxE. When you edit the values of the Global Calendar object, the dates automatically download
into all the local calendars.

To reference a Global Calendar object:

1. To create a calendar object - in the Configuration tab, click to choose the Global Calendar Object Reference.

Figure 45: Global Calendar Object Reference - Configuration Tab

2. To edit attributes of a calendar - in the Advanced Focus tab, click and click to choose the Global
Calendar Object Reference.

3. Click Save and the Configuration tab will add the date and time of the last Global Calendar Update.
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Figure 46: Global Calendar Update

Scheduling Steps
Creating a Schedule or Calendar
Note: The procedure for creating a schedule or a calendar in offline mode (using SCT) is the same as the online

procedure using the Insert Object Wizard. See Metasys Modes for more information about the modes of
operation.

Note: You cannot create schedules or calendars in an FAC from SCT or SMP.

1. From the Insert menu, select Object... The Insert Object Wizards appears.
2. Select Schedule or Calendar and follow the Insert Object Wizard instructions.

Note: Add extensions to the schedule or calendar at the wizard prompt, if desired. See Extensions.

Displaying an Existing Schedule or Calendar
To display an existing schedule or calendar, drag and drop the item from the navigation tree into a display frame or
double-click the item in the navigation tree.

Note: Alternatively, you can right-click the item and select View from the menu that appears.

Displaying Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop down menu, select the view you want to see (Today’s Schedule, Weekly Schedule,

Exception Schedule, or Scheduled Items).
3. Place the cursor over a leading or trailing edge of a time bar segment. The time-of-day appears in 24-hour format

in a small pop-up window.

Adding Weekly Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop down menu, select Weekly Schedule.
3. Click Edit.
4. Click the new (green plus) button or double-click a time bar segment and the Define New Event(s) dialog box

appears.
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Note: Alternatively, you can right-click a time bar segment and select Add Event(s). The Define New Event(s)
dialog box allows you to define the new event for multiple days.

5. Select one or more days, the starting time (hour and minute), and a value for the event using the check boxes
and drop-down menus and click OK.

6. Repeat Step 4 through Step 5 as necessary.
7. To specify an event end time, make sure no event is selected, right-click where you want the event to end and

select End Event from the pop-up menu. Drag the end of the event to adjust the end time.
8. Click Save.

Note: Once you click Save, the schedule object goes into effect and writes the new value to the scheduled
items if necessary.

Editing Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Weekly Schedule.
3. Click Edit.
4. Double-click the time bar segment. The Modify Event(s) dialog box appears.

Note: Alternatively, you can select and right-click the event on the time bar and select Modify Selected Event(s)
from the menu.

5. Adjust the starting time (hour and minute) and value as desired for the event using the check boxes and drop-down
menus and click OK.

Note: You can also change the value of an event by selecting and right-clicking the event and selecting a value
from the menu, if the value type is Boolean (True/False), binary, or multistate with less than eight states.

Note: To specify an event end time, make sure no event is selected, right-click where you want the event to
end, and select End Event from the pop-up menu. Once you specify an end time, you can drag the tail
edge right or left to adjust the end time.

Note: You can adjust start times and end times of events by dragging the edges of the time bar segment to the
right or left. When adjusting a time, a small pop-up window shows the digital time of day based on a
24-hour clock, and adjusts in 5-minute increments.

Note: You cannot drag the end of an event that ends at midnight. To do this, first right-click and select the End
Event. Once the event ends prior to midnight, you can then drag to adjust the end time.

Note: If you have a gap in the schedule between two events, you can drag the edge of one to meet the edge
of the other. Once you do, the events become locked together so that the second begins as soon as the
first ends, the begin/end points move together, and the gap is removed from the schedule.

6. Repeat Step 4 through Step 5 as necessary.
7. Click Save.

Note: Once you click Save, the schedule object goes into effect and writes the new value to the scheduled
object if necessary.

Deleting Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop down menu, select Weekly Schedule.
3. Click Edit.
4. Select the event on the time bar and click the delete (red minus) button (or press the Delete key).

Note: Alternatively, you can select and right-click the event on the time bar and select Delete Selected Event(s)
from the menu.

5. Repeat Step 4 as necessary.
6. Click Save.
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Adding Exception Schedules
To add exception schedules:

1. Display a Schedule.
2. From the Display Mode drop down menu, select Exception Schedule.
3. Click Edit.
4. Click the new (green plus) button to add exception schedules. The Exception Detail dialog box appears. You

can add exception schedules to the list using one of the following exception types:

• Date/Date Range
• Week and Day
• Calendar Reference

5. Select the radio button next to the type of exception. Depending on the type of exception date selected, a
different set of drop-down menu options appears. The Calendar Reference exception type has a button
that brings up a dialog box for selecting a calendar.

Note: When mapping a schedule into the Metasys system from a third-party BACnet device, you must also
map any calendar objects referenced by the schedule (that is, calendar exceptions) in order to properly
view and edit them in the schedule exception list.

6. Make your selections from the drop-down menus or for the Calendar Reference, click the button and
select a calendar from the Select Items dialog box and click OK.

7. Click OK on the Exception Detail dialog box.
8. Select the exception schedule in the exception list.
9. Click the new event (green plus) button above the time bar or right-click the time bar and select Add Event(s).

The Define New Event(s) dialog box appears.
10. Select the starting time (hour and minute), and a value for the event using the check boxes and drop-down

menus and click OK.
11. To specify an event end time, make sure no event is selected, right-click where you want the event to end and

select End Event from the pop-up menu. Drag the end of the event to adjust the end time.
12. Repeat Step 4 through Step 11 as necessary.
13. Click Save.

Note: Once you click Save, the schedule object goes into effect and writes the new value to the scheduled
items if necessary.

Editing Exception Schedules
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Exception Schedule.
3. Click Edit.
4. Double-click the exception schedule. The Exception Details dialog box appears.

5. Make your modifications using the drop-down menus or for the calendar reference, click the button and
select a calendar from the Select Items dialog box and click OK.

6. Click OK on the Exception Details dialog box.
7. Select the exception schedule in the exception list.
8. Select and right-click the event in the time bar and select Modify Selected Event(s) from the menu. The Modify

Event(s) dialog box appears.

Note: Alternatively, you can double-click an event to open the Modify Event(s) dialog box.
9. Select the starting time (hour and minute), and a value for the event using the check boxes and drop-down

menus and click OK.
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10. Repeat Step 4 through Step 9 as necessary.

Note: To change the value of an event, select and right-click an event and select a value from the menu.
11. Adjust the start and end times of events by dragging the edge of the event to the right or left.
12. Click Save.

Note: Once you click Save, the schedule object goes into effect and writes the new value to the scheduled
object if necessary.

Removing Exception Schedules
1. Display a Schedule.
2. From the Display Mode drop down menu, select Exception Schedule.
3. Click Edit.
4. Select the exception in the exception list.
5. Click the delete (red minus) button (or press the Delete key).
6. Click Save.

Adding Scheduled Items
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Click the add (green plus) button.
5. Select one or more items from the Select Item dialog box and click OK.

Note: To select multiple items, use the Control or Shift key.
6. The system automatically chooses the default attribute for each item you selected. To choose a different attribute,

click the button and select the attribute that you want to schedule.

7. Click Save.

Note: The first item in the list of scheduled items (Table of Scheduled Items) determines the data type used
when the schedule writes values to the attributes of the scheduled item.

Editing Scheduled Items
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Right-click the item name and select an option from the pop-up menu. For example, select make key item to

promote the selected item to the key item of the schedule. When you add a key item, or choose the Make Key
Item menu option for an item, the States Text (or Display Units) is updated to match the key item.

Important: When you add the first item to the Scheduled Items list, or if you promote an item to key item, the
values in the scheduled events change to a default value if they are incompatible with the new key
item. The default for numeric values is 0 or 0.0. The default for attributes that support multiple values
is the first value available in the set of possible values (for example, False or Off). After changing
the key item, we strongly recommend reviewing and adjusting the values for all events in the
schedule as necessary.

5. The system automatically chooses the default attribute for each item you selected. To choose a different attribute,
click the button and select the attribute that you want to schedule. For example, selecting Present Value
means that the schedule writes a value to the Present Value attribute of that item.

6. Click Save.

Removing Scheduled Items
1. Display a Schedule.
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2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Select the item name.
5. Click the remove (red minus) button or right-click and select remove object from the pop-up menu.

Editing the Effective Period of a Schedule
1. Display a Schedule.
2. On the Schedule tab, click Edit.

3. Click the button of the Effective Period attribute. The Effective Period dialog box appears.

4. Select the start and end dates using the drop-down menus.
5. Click Apply.
6. Click OK.
7. Click Save.

Creating a New Calendar Entry
1. Display a Calendar.
2. Click Edit.
3. Click Entry Detail. The Calendar Entry Detail dialog box appears.
4. Click New.
5. Select the Date, Date Range, or Week and Day radio button. Depending on the type of entry selected, a different

set of drop-down menu options appears.
6. Make your selections.
7. Click Apply.
8. Click OK.
9. Click Save.

Note: Alternatively, create date and date range calendar entries visually by selecting an individual calendar
date or by selecting and dragging the mouse over a range of dates.

Note: Wildcard date entries appear with a contrasting blue background on the calendar and have an asterisk
next to the date. Once you create a wildcard entry, visually selecting and deselecting it does not change
the entry. To edit the entry, click Entry Detail on the calendar display frame.

Editing a Calendar Entry
1. Display a Calendar.
2. Click Edit.
3. Click Entry Detail. The Calendar Entry Detail dialog box appears.
4. Select the entry from the calendar entries list.
5. Use the drop-down menus to edit the entry.
6. Click Apply.
7. Click OK.
8. Click Save.

Note: Alternatively, edit Date and Date Range calendar entries visually by selecting an individual calendar date
or by selecting and dragging the mouse over a range of dates.

Note: Wildcard date entries appear with a contrasting blue background on the calendar and have an asterisk
next to the date. Once you create a wildcard entry, visually selecting and deselecting it does not change
the entry. To edit the entry, click Entry Detail on the calendar display frame.
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Deleting a Calendar Entry
1. Display a Calendar.
2. Click Edit.
3. Click Entry Detail. The Calendar Entry Detail dialog box appears.
4. Select the entry from the Calendar Entries list.
5. Click Delete.
6. Click OK.
7. Click Save.

Note: Alternatively, you can delete calendar entries visually by selecting the individual calendar date a second
time or by selecting and dragging the mouse over the range of dates a second time. This method cancels
the selection, thus deleting the entry.

Toggling Between Calendar Views
Note: The cursor turns into a hand when you place it over the header area of a calendar.

1. Display a Calendar.
2. Place the cursor over the header of a calendar until it changes shape from an arrow to a hand and click. The

view switches between 1-month and 12-month view.

Editing the Attributes of a Schedule or Calendar
1. Display a Schedule or Calendar.
2. Select the Focus tab.
3. Click Edit.
4. Make your modifications using the drop-down menus and text boxes. See the Schedule Object or Calendar

Object for details about the attributes of these items. Select the Advanced radio button if needed.

Note: Selecting false in the Enabled drop-down menu of the Schedule disables (turns off) the schedule.
5. Click Save.

Copying and Pasting a Schedule or Calendar (Offline Mode Only)
Note: This procedure is available only in offline mode (SCT).

Note: This function is not available for schedules/calendars in an FAC.

1. In offline mode, select the schedule or calendar from the navigation tree.
2. Select Copy from the Edit menu.
3. Select the desired destination for the copied schedule or calendar in the navigation tree.
4. Select Paste from the Edit menu. The Paste Object Wizard appears.
5. Edit the name of the schedule or calendar as desired and click Paste.

Deleting a Schedule or Calendar
1. Select the schedule or calendar you want to delete in the navigation tree.
2. Select Delete Items from the Edit menu, or press the Delete key.

Scheduling a Trend Extension
Note: See the Trend Scheduling topic for information and examples on scheduling trend extensions.

1. Create a Schedule or display the desired Schedule.
2. In the Scheduled Items list, add the desired object trend extension and the desired scheduled attribute. Follow

the steps in the Adding Scheduled Items procedure. Make sure the trend extension is the key item. See Trend
Extensions for information on the trend extension attributes you want to schedule.

3. On the Weekly Schedule tab, configure the events as desired. Follow the steps in the Adding Weekly Scheduled
Events and Editing Scheduled Events procedures to schedule specific days and times to perform the defined
trending capability.
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4. Click Save.

Scheduling the Enabled Audit Level
To schedule the Enabled Audit Level based on time using the Scheduling feature:

1. Create a Schedule or display the desired Schedule.
2. In the Scheduled Items tab, add the desired Engine or ADS/ADX and select the Enabled Audit Level attribute.

Follow the steps in the Adding Scheduled Items procedure.
3. On the Weekly Schedule tab, configure the events as desired. Follow the steps in the Adding Weekly Scheduled

Events and Editing Scheduled Events procedures to schedule specific days and times to change the Enabled
Audit Level. See the Engine Device Object or ADS Device Object ’s Enabled Audit Level attribute description
for information on the levels you want to schedule.

4. Click Save.

Copying Events within the Weekly Schedule
To copy the events from one day in the Weekly Schedule to one or more days in the same Weekly Schedule:

1. With the Weekly Schedule in Edit mode, left-click and highlight the name of the day whose events you want to
copy.

2. Right-click the highlighted day and select Copy from the pop-up menu.
3. Left-click to highlight the name of the day (or days) where you want to copy the schedule.

Note: You can select multiple days by holding the Control or Shift key while selecting days.
4. Right-click the highlighted name of any target day and select Paste from the pop-up menu. The copied schedule

overwrites the schedule for the selected day(s).
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Scheduled Reports
The Scheduled Reports feature provides a reporting service on an ADS/ADX Site Director. The ADS/ADX generates
summary reports based on Object Lists and Report Schedules.

Scheduled Reports Concepts
Scheduled Report
A Scheduled Report consists of one Object List and one Report Schedule. You select the objects that appear on an
Object List. Create and Save Object Lists to the Site Director using the Global Search feature. A Report Schedule
specifies the day and time to run the report.

Object List
An Object List is a list of objects you select. Object Lists are created and saved to the Site Director using the Global
Search feature. See the Object List section in the Global Search section for more information.

Report Schedule
The Report Schedule specifies the days and times a report is generated.

Report Output
Scheduled reports generate files on the ADS/ADX that contain the actual report output. You can view the content
of a report output file through the online UI using any compatible Web browser, but you must log on to the ADS/ADX
Windows operating system and use Windows Explorer (or another software application) to browse to and
delete/manage the files. Scheduled reports configured to be sent directly to printer on the ADS/ADX are printed in
the system’s default language.

To view the content of the Report Output file in the UI, use the Report Output Viewer. See Report Output Viewer for
information on viewing the Scheduled Report output in the UI. To manage report output files, see Accessing Report
Output Files on the ADS/ADX.

Report Output Viewer
The Report Output Viewer allows you to view the content of a Scheduled Report output file in the UI in the Report
Output Viewer window. The Report Output Viewer displays output in any format (tab delimited, XML, and text) and
is available via the Scheduled Reports Viewer.

Each Report Output viewer window displays the content of a single report output file. You can have multiple Report
Output viewers open simultaneously. To display the Report Output viewer, see Viewing the Content of a Report
Output File in the UI.

Scheduled Reports Overview
Each scheduled report contains one or more properties (for example, Item Name and Status) of each item in an
Object List. A report engine on the server runs the Scheduled Report at the specified times and saves it to a file in
a standard location on the server. The report engine can also send the report output to a printer if specified.

There are two scheduled report screens: the Create New Scheduled Report Screen and the Scheduled Reports
Viewer screen.

Create New Scheduled Report Screen
The Create New Scheduled Report screen (Figure 47) allows you to configure new report information and associated
schedule information. You can access the Create New Scheduled Report screen from the Query Menu by selecting
New Scheduled Report.
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Figure 47: Create New Scheduled Report Screen

Table 111 describes the fields in the Create New Scheduled Report screen.

Table 111: Scheduled Reports
DescriptionField
Allows you to enter a name for the report. Use a descriptive name so you can recognize the details
by the name; for example, Weekly Building Two Status Report.

Report Name

Allows you to select which object list to run the report against. For information on Object Lists, see
Object List in the Global Search section.

Object List

Allows you to select the report file format: Tab Delimited, XML, and Text.
• Tab Delimited: saves the report with an .txt extension. You can use the report with a spreadsheet

application, such as Excel.
• XML: saves the report with an .xml extension. You can use the report with an Internet browser,

such as Internet Explorer.
• Text: saves the report with an .txt extension. You can use the report with any text-viewing

application, such as Wordpad.

Report Format

Allows you to automatically send the report to the default printer of the ADS/ADX each time the report
generates. The report first saves to a file on the server, then it is sent to the default printer. Scheduled
reports configured to be sent directly to printer on the ADS/ADX are printed in the system’s default
language. For more information on configuring the default printer on the ADS/ADX, refer to the ADS
documents listed in the Related Documentation table in the Welcome section.

Send To Printer

Allows you to run the report immediately.Run Report Now
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Table 111: Scheduled Reports
DescriptionField
Allows you to schedule the report to run at one or more future times.Schedule Report

Allows you to select how often to generate the report. Selections include: One Time Only (default),
Daily, Weekly, Monthly, and Yearly.

Run This Report

Allows you to select the report start date.Start Date

Allows you to select the report end date.End Date

Allows you to configure the report to run indefinitely.No End Date

Allows you to further configure the date information for when the scheduled report runs.Date Information

Allows you to further configure the time information for when the scheduled report runs.Time Information

Scheduled Reports Viewer
You can access the Scheduled Reports Viewer from the View Menu. The Scheduled Reports Viewer has three main
screens/tabs.

Table 112: Scheduled Reports Viewer Tabs
DescriptionTab
Allows you to monitor, enable/disable, reschedule, delete, and reschedule reports that are in progress
or pending.

Actions in Progress

Allows you to enable/disable, delete, edit, and run upcoming scheduled reports.Scheduled Actions

Allows you to view the status of completed reports, reschedule reports, delete the status entries from
the screen, and view the content Scheduled Report output file.

Completed Actions

Scheduled Reports Steps
Creating a New Scheduled Report
To create a new scheduled report:

1. From the Query Menu, select New Scheduled Report. The Metasys - New Scheduled Report screen appears.
2. Enter a Report Name.
3. Select an Object List.
4. Select a Report Format.
5. Select Send to Printer if you want to print the report.
6. Select either Run Report Now or Schedule Report.
7. From the Run This Report drop-down list, specify how often you want to run the report.
8. Enter a Start Date.
9. Enter an End Date.

Note: If you wish to run the report indefinitely, select No End Date.

10. Enter the Date Information if you schedule to run the report more than One Time Only.
11. Enter the time you want the report to run in the Time Information section.

Note: To repeat the schedule every X minutes, select the Repeat check box. Enter the interval (in minutes) to
repeat and configure the time when this repeating interval ends. The range is 15 to 1,440 minutes. For
an example, see the Scheduling Scenarios section.

12. Click Save.

Note: If you click Cancel, a Metasys - Report Changes Pending screen appears. Click Yes to save your changes.
Click No to close the screen without saving your changes.
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Launching the Scheduled Reports Viewer
To launch the Scheduled Report Viewer, select Scheduled Reports from the View Menu. The Scheduled Reports
Viewer Screen appears.

Editing an Existing Scheduled Report
To edit an existing scheduled report from the Scheduled Reports Viewer:

1. Launch the Scheduled Reports Viewer.
2. On the Scheduled Actions tab, select the report to edit.
3. Click Edit.
4. Make the necessary changes.
5. Click Save.

Copying an Existing Report to a New Report
To copy an existing report to a new report:

1. Launch the Scheduled Reports Viewer.
2. Select the Scheduled Actions tab.
3. Select a report to copy.
4. Click Edit.
5. Click Copy to New Report. The Copy to a New Report dialog box appears.

Note: The Copy To a New Report button allows you to save an exact copy of the current report with a different
name. Your new report appears in the Scheduled Actions tab in the Scheduled Reports Viewer.

6. Enter a new name and/or Object List.
7. Click OK. A message appears to indicate a successful copy. Your new report appears in the Scheduled Actions

tab in the Scheduled Reports Viewer.

Enabling/Disabling a Report
To enable or disable a report:

1. Launch the Scheduled Reports Viewer, and select either the Actions in Progress tab or the Scheduled Actions
tab.

2. Click the report.
3. Click Enable or Disable.

Rescheduling a Completed or In Progress Report
To reschedule a completed or in progress report:

1. Launch the Scheduled Reports Viewer and select the Completed Actions or Actions in Progress tab.
2. Click the report.
3. Click Reschedule. The Reschedule a Report screen appears.
4. Modify the date and time using the drop-down menus.
5. Click OK.

Viewing the Status of a Report
To view the status of a report:

1. Launch the Scheduled Reports Viewer and select the Completed Actions tab.
2. Click the report.
3. Click View Status. The Scheduled Reports Status dialog box appears.
4. Verify the scheduled report has completed successfully.
5. Click OK.

256Metasys System Online Help PDF



Deleting an Existing Scheduled Report
To delete an existing scheduled report:

1. Launch the Scheduled Report Viewer and select the Scheduled Actions tab.
2. Click one or more reports.
3. Click Delete. The Confirm Delete dialog box appears.
4. Click Yes to confirm the delete.

Deleting a Completed Report Status Entry or an In Progress Report
To delete a completed report status entry or an in progress report:

1. Launch the Scheduled Reports Viewer and select the Completed Actions or Actions in Progress tab.
2. Click one or more reports.
3. Click Delete.

Note: The current Report Schedule is not affected. Deleting a completed report status entry or an in progress
report only affects the instance of the report that is currently running or the completed status entry.

Automatically Deleting Completed Report Status Entries
To automatically delete completed report status entries after a given amount of days:

1. Launch the Scheduled Reports Viewer and select the Completed Actions tab.
2. Enter the desired amount of days in the Number of days after which entries will be automatically deleted

(1–30) text box.

Note: The Metasys User Interface supports a maximum of 500 entries displayed on each screen of the Scheduled
Reports Viewer. Either configure the number of days between automatic deletion to ensure the number
of entries remains less than 500 or periodically delete the entries manually.

Accessing Report Output Files on the ADS/ADX
You may need to access report output files to view, delete, or use data from the report in other applications. To view
the output in the UI, see Viewing the Content of a Report Output File in the UI.

To access report output files on the ADS/ADX:

1. Log on to your ADS/ADX local Windows operating system.
2. Navigate to the correct report directory. The default directory of the report output files on the ADS/ADX Site

Director is:

• Windows XP OS: C:\Documents and Settings\All Users\Application Data\Johnson Controls\MetasysIII\File
Transfer\Report Definitions

• Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\File
Transfer\Report Definitions.

To change the default directory of the report output files, see the Changing the Report Output Directory Location
section.

Note: The directory name and report name are the same.
3. Select the report to view.
4. Open the report in the correct viewer.

Note: The correct viewer depends on the report type. For example, text in Notepad, XML in Internet Explorer®,
and tab delimited in Excel.

Note: You may wish to periodically archive or delete report output files to avoid filling the ADS/ADX hard disk.
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Viewing the Content of a Report Output File in the UI
You can use the Report Output viewer to view the content of a report output file, copy the content to the clipboard,
or save the content to a file on your local computer. To view the and manage the output files on the ADS/ADX, see
Accessing Report Output Files on the ADS/ADX.

To view the content of a Report Output file in the UI:

1. Launch the Scheduled Reports Viewer.
2. On the Completed Actions tab, select the report for the output file you would like to view.

Note: You can also double-click the report to view it in the Report Output Viewer window.
3. Click View Report. The Report Output Viewer window appears.

Note: The View Report button is enabled only when a single report is selected. If no reports are selected, or
more than one report is selected, the button is disabled.

Note: To copy the content to the clipboard, click Copy to Clipboard. To save the content to a file on your computer,
click Save to File.

Note: If the report was not successful, an error message appears with this text:

Figure 48: Unsuccessful Report Error Message

4. Click Close when you are finished. All open Report Output Viewer windows close when you log out or exit the
UI.

Changing the Report Output Directory Location
The Scheduled Report output is saved to the following directory on the ADS/ADX Site Director computer by default:

• Windows XP OS: C:\Documents and Settings\All Users\Application Data\Johnson Controls\MetasysIII\File
Transfer\Report Definitions

• Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\File Transfer\Report
Definitions.

Use this procedure if you want to change the location of the report output directory.

To change the Report Output directory location:

1. From the Control Panel of the ADS/ADX Site Director computer, select Administrative Tools > Services. The
Services window appears.

2. Right-click the Metasys III Action Queue service and select Stop.
3. Right-click the Metasys III Device Manager service and select Stop.
4. Right-click theMetasys III Action Queue service and select Properties. The Metasys III Action Queue Properties

dialog box appears.
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Figure 49: Metasys III Action Queue Properties Dialog Box

5. Note the directory in the Path to executable text box (Figure 49), and use Windows Explorer to navigate to
that directory.

6. Open the ActionQueue.exe.config file using a standard text editor, such as Notepad.
7. Locate the following line of text (Figure 50):

Windows XP OS and Windows Server 2003 OS:

<add key=“FileTransfer.AliasFilePath” value=“C:\Documents and Settings\All
Users\Application Data\Johnson Controls\MetasysIII\FileTransfer\”/>

Windows 7 OS and Windows Server 2008 OS:

<add key=“FileTransfer.AliasFilePath” value=“C:\ProgramData\Johnson
Controls\MetasysIII\FileTransfer\”/>
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Figure 50: ActionQueue.exe.config File Text

8. Change the contents of the value section to the desired location of the report output. For example, to send
report output to the C:\Metasys System directory, the line of text appears as follows:

<add key=“FileTransfer.AliasFilePath” value=“C:\Metasys System\”/>

9. Save and close the ActionQueue.exe.config file.
10. Cut the Report Definitions subdirectory and its contents from one of the following locations:

• Windows XP OS: C:\Documents and Settings\All Users\Application Data\Johnson Controls\MetasysIII\File
Transfer\Report Definitions

• Windows 7 OS and Windows Server 2008 OS: C:\ProgramData\Johnson Controls\MetasysIII\File
Transfer\Report Definitions

11. Paste the files to the location defined in Step 8 (for example, C:\Metasys System\Report Definitions).
12. Return to the Services window (see Step 1 for the location).
13. Right-click the Metasys III Device Manager service and select Start.
14. Right-click the Metasys III Action Queue service and select Start.

Scheduling Scenarios
Repeat Steps Step 1–Step 1 in Creating a Daily Report section for all of the Scheduling Scenarios.

Creating a Daily Report
To create a new report that runs every day at 8:00 A.M. with no end dates:

1. From the Query menu, select New Scheduled Report. The Create New Scheduled Report Dialog Box appears.
2. Enter a New Report name.
3. Select an Object List to run the report against.
4. Select a Report Format.
5. Select Schedule Report.
6. Select Run This Report Daily.
7. Verify the Start Date is set to today.
8. Select the No End Date check box.
9. In the Time Information section, configure the Run At time to 8:00 A.M.

Note: Do not configure Repeating Information.
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10. Click Save.

Creating a Repeating Weekday Report
To create a new report that runs every hour on weekdays between the hours of 11:00 A.M. and 1:00 P.M. with an
end date of two months from today:

1. Repeat Steps Step 1–Step 1 in Creating a Daily Report.
2. Select Run This Report Weekly.
3. Verify the Start Date is set to today.
4. Configure the End Date to two months from today.
5. In the Date Information section, select the Mon - Fri check box.
6. In the Time Information section, configure the Run At time to 11:00 A.M.
7. Select the Repeat check box. The Until and Every fields enable.
8. Configure the Every field to 60 minutes.
9. Configure the Until field to 1:00 P.M.
10. Click Save.

Creating a Repeating Monthly Report
To create a repeating monthly report that runs on the 15th and last day of every month at 8:00 A.M. with no end
date:

1. Repeat Steps Step 1–Step 1 in Creating a Daily Report.
2. Select Run This Report Monthly.
3. Verify the Start Date is set to today.
4. Select the No End Date check box.
5. In the Date Information section, select 15 and Last (Ctrl + click).
6. In the Time Information section, configure the Run At time information to 8:00 A.M.
7. Click Save.

Creating a Repeating Yearly Report
To create a repeating yearly report that runs on the last day of February:

1. Repeat Steps Step 1–Step 1 in Creating a Daily Report.
2. Select Run This Report Yearly.
3. Enter the Start Date.
4. Enter the End Date.
5. In the Date Information section, select Feb and Last from the drop-down menus.
6. In the Time Information section, configure the Run At time information.
7. Click Save.

Note: If it is a leap year, this report runs on February 29th; otherwise, it runs on February 28th.
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Create a Report to Run Immediately
To create a new report to run immediately:

1. Repeat Steps Step 1–Step 1 in Creating a Daily Report.
2. Select Run Report Now.
3. Click Save.
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Trend Viewer
Use the Trend Viewer to display the trend data for an ad hoc selection of one or more items from a navigation tree
or Global Search viewer. You may select any item type when initially displaying a Trend Viewer. However, the viewer
only displays data for those items that are either of trend extension type (selectable from the Global Search viewer)
or that have a defined trend extension. For items with more than one defined trend extension, only the first trend is
displayed. Do not confuse the Trend Viewer with the Trend Study or a Trend Extension.

Once the Trend Viewer is displayed, you can use the Select Item dialog box to add additional trend items, including
trends in an ADS historical database.

Note: Although multiple trend extensions can be added to an object on an NxE, these extensions will be combined
as a single trend if sent to an Historical Data Repository. This may not yield the expected result. To use
multiple trends on a single object in an Historical Data Repository, create duplicate AV or BV objects that
map to the point in question, then create a new trend on the parallel AV or BV.

For information on trend extensions or trend studies, see the and sections.

For performance information on trends, refer to the Metasys System Extended Architecture Overview Technical
Bulletin (LIT-1201527).

Trend Viewer Concepts
Trend Viewer Overview
The Trend Viewer has three different views: Trend Viewer Chart View, Trend Viewer Table View and Trend Viewer
Definition View. The Chart View and Table View allow you to see trend data in a variety of different formats. The
Definition View allows you to configure how the data appears within the views.

The Trend Viewer can display the data for up to 10 trends. Although you can select up to 32 items to include in the
Trend Viewer, you are limited to showing the data for a maximum of 10 trends in the Chart or Table views. The Trend
Viewer lists the included items in the Chart Legend (Chart View), and in the Trend Items table (Definition View). Use
the Chart Legend check boxes to choose which items should be shown or hidden. You can also display multiple
Trend Viewers in the display panels of the user interface.

As you add items to the Trend Viewer, the trends for the new items are automatically shown up to the maximum
number of 10. Once 10 items are shown, you are unable to choose additional trends to show until you hide one or
more of the currently displayed trends. You can hide a trend by clearing the check box on the Chart Legend.

Note: Changes you make to the Trend Viewer, such as changes to how the chart appears, are only maintained
while you are logged on to the Metasys system user interface. Changes apply to all new instances of Trend
Viewer, within your user session. Changes do not affect existing Trend Viewers, Trend Study views, or Trend
Extension views.

Views
There are three views in the Trend Viewer: Chart View, Table View, and Definition View.

Table 113: Views
DescriptionViewButton
Allows you to view trend data in a chart format.Chart View

Allows you to view trend data in a table format.Table View

Allows you to view the trend viewer setup and display options.Definition View

Trend Viewer Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data. You can zoom,
unzoom, and pan within the chart. You can also specify the X-axis and Y-axis ranges. You can change the Y-axis
type to view the chart using stacked Y-axis or a single Y-axis.
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Table 114: Chart View
DescriptionNameButton
Retrieves the most recent data samples for the displayed trends.Update

Toggles the mouse behavior for the chart between zoom mode and normal mode.

While in zoom mode:

• drag the mouse over an area of the chart to zoom in on that area.
• click Zoom to exit zoom mode and restore the mouse to normal mode.
• left-click to zoom out one level.

When you exit zoom mode, the chart remains at the current zoom level. Use the
Restore button to fully zoom out on the chart.

Note: You cannot pan while the mouse is in zoom mode.

Note: You can also zoom and unzoom in normal mode by using the Shift key and
the mouse. To zoom, hold the Shift key down while dragging the mouse across
the chart. To zoom out one level, left-click the mouse while holding the shift
key down.

Zoom(Zoom)

(Normal)

Allows you to return to an unzoomed view and switches the mouse back to normal
mode if the chart's zoom mode is active.

Restore

Allows you to pan the view of the chart vertically or horizontally by dragging the mouse
across a zoomed chart. Panning is not available for unzoomed charts or when zoom
mode is active. To pan left or right, drag the mouse over the X-axis. To pan up or
down, drag the mouse over the Y-axis.

Pan

Displays the data using lines and point markers. This is the default.Points Line

Displays the data using an area chart.Area

Displays the data using a bar chart.

Note: Only use the bar chart when the number of data samples can reasonably be
expected to display as bars. If too many data samples exist when you click
this option, the display becomes unstable and fails to properly update the
screen. To recover, select any other display option.

Bar

Displays the data using markers with no lines.Points

Displays the data using lines with no markers.Line

Displays the data in a separate Y-axis for each trend.Stacked Y-axis

Displays the trend data using a single Y-axis.Single Y-axis

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click in the panel to
display the menu.

Table 115: Chart Right-Click Menu
DescriptionMenu Item
Opens the Select A Color dialog box and allows you to configure the background color of the
chart.

Background Color

Displays the Y-axis scale Range Configuration dialog box.Y-axis Scale

Displays the X-axis Range Configuration dialog box.X-axis Scale
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Table 115: Chart Right-Click Menu
DescriptionMenu Item
Allows you to select what type of gridlines appear on the chart. You can choose: None, X and
Y, X Only, and Y Only.

Gridlines

Allows you to select which type of chart to display. You can choose: Points Line, Area, Bar,
Points, and Line.

Chart Type

Displays the chart on a stacked Y-axis when check box is selected.Stacked Y-axis

Chart Legend
The Chart Legend appears below the graphical charting area. The Chart Legend displays the list of trend items for
the Trend Viewer in a table, and includes information about each item.

Table 116: Legend
DescriptionNameButton/Field
Selects the maximum number (10) of trend items for display in the chart.Select All

Deselects all trend items in the chart Legend.Remove All Selections

Opens the Select Item dialog box and allows you to add trend items to the Trend
Viewer.

Note: All items and navigation trees appear in the Select Item window; however,
you can only select trends. All other items appear dimmed.

Add

Allows you to remove trend items from the Trend Viewer.Remove

Indicates if the data for the trend item appears in the Chart. When checked, the
data appears on the chart and in the table. When unchecked, the data does not
appear in the chart or table.

Show

Indicates the trend was selected from the ADS Historical Database folder.Historical Trend Icon

Indicates the appearance of the marker style and color for the trend item on the
Chart.

Marker

Opens the Select a Color dialog box. Allows you to change the color used to chart
the trend data.

Color Palette

Displays the trend item name based on the Name attribute.Name

Displays the trend item’s full reference.Reference

Chart Legend Right-Click Menu
You can right-click an item in the Chart Legend to access item-specific menu options. The right-click menu content
is based on the type of item you click on. For example, if you right-click a trend item from a historical database, you
can only Refresh the Trend Viewer.

Trend Viewer Table View
The Table view of the Trend Viewer allows you to view data for the selected trends in a table format. You can copy
the trend data to the clipboard for pasting into other applications such as Microsoft Excel.
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Table 117: Table View1

DescriptionNameButton
Updates the data samples with new trend data immediately.Update

Allows you to add additional trend items to the Trend Viewer.Add

Allows you to copy selected trend data to the system clipboard for pasting
into other applications such as Microsoft Excel. You can also use Ctrl + C
to copy data to the clipboard.

Copy to Clipboard

1 The appears in the Table View column headings when applicable.

Trend Viewer Definition View
The Definition view of the Trend Viewer allows you to view and edit the Trend Viewer setup and charting options.

Table 118: Definition View
DescriptionSection
Allows you to edit the refresh rate and display precision.

• Refresh Rate: specifies the amount of time, in seconds, for automatic refresh of data. You must
configure this attribute with a value of 0 seconds, 60 seconds, or greater than 60 seconds. Values 1
to 59 are invalid and not allowed. 0 means manual refresh. If the refresh rate is 0, click the Update
button to display new data.

• Display Precision: specifies the decimal point rounding and the number of decimal places used to
format real values that do not report a display precision. If the value reports a display precision, this
Trend Viewer attribute is ignored in favor of the value’s native display precision.

General

Specifies the Start Time and End Time for the Trend Viewer.

• Date: Displays the dates for the Viewer Range.
• Time: Displays the times for the Viewer Range.

Range Start and
Range End

Allows you to add gridlines, stack the Y-axis, and choose the chart style for the Trend Viewer.Chart Display

Definition View Trend Items Table
The Trend Items table appears at the bottom of the Definition view. The table displays the list of the Trend Viewer’s
trend items.

Table 119: Definition View Trend Items Table
DescriptionNameButton
Indicates the trend was selected from the ADS Historical Database folder.Historical Trend Icon

Opens the Select Item dialog box and allows you to add trend items to the Trend
Viewer.

Add

Allows you to remove a trend item from the Trend Viewer.Remove

Displays the name of the trend item.Name

Displays the trend item’s reference information.Reference

Allows you to select the plotting method for the trend item.

• Continuous - straight line between data samples. Continuous plotting connects
samples with the shortest possible line, giving an appearance of a set of diagonal
ramps as samples change value.

• Discrete - line stays at the same value until the next data sample is taken (good
for binary data). Discrete plotting has 90-degree angles at the time when samples
change value. The chart appears to be a series of steps.

Plotting Style

266Metasys System Online Help PDF



Trend Viewer Steps
Selecting Trend Items
To select trend items for initial display in the Trend Viewer, click an individual item in the navigation tree (select items
that have trend extensions). Use the Ctrl or Shift keys to select multiple items.

You can also select items from the Viewer. In the Global Search Viewer, you can select trend extensions or items
with trend extensions. Once the Trend Viewer is displayed, you can add additional trend items by selecting trend
extensions or historical trend items in the Select Item dialog box.

Note: If you selected an item from the navigation tree that does not have a trend extension, the Name column in
the Legend and Trend Items Table states No Trend Defined.

Launching the Trend Viewer
1. Select one or more trend items. See Selecting Trend Items.
2. From the View menu, select Trend Viewer. The Trend Viewer appears with data for the selected items (if available).

Note: If the chart appears to flicker, you have too many trend samples in the Trend Viewer. Reduce the number
of displayed trends or change the trending date/time range to display fewer samples, and performance
will improve. See Removing Trends from the Trend Viewer.

Changing Views
To change views in the Trend Viewer, click the Chart, Table, or Definition view buttons.

Editing the Chart View
Changing the Chart Type
To change the chart type in the Chart view, click one of the chart buttons (such as points, line, or area).

Configuring the X-axis
To configure the X-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the X-axis Scale. The Range Configuration dialog box appears.
3. Specify whether to Use Automatic Range Calculation. The automatic range is determined automatically based

on the setup in the Definition View.

Note: When you select Use Automatic Range Calculation, you do not fill in the Range fields.
4. Specify the Start Time, Start Date, End Time, and End Date.
5. Click OK.

Note: You can also configure the X-axis range by changing the start and end dates and times in the Definition View.
See Editing the Definition View.

Configuring the Y-axis
To configure the Y-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the Y-axis Scale menu item. The Range Configuration dialog box appears.
3. If you are using stacked Y-axis, choose the trend item to which the Y-axis range should be applied.
4. Specify whether to Use Automatic Range Calculation. The Range is determined automatically based on the trend

items.

Note: When you select Use Automatic Range Calculation, you do not fill in the Range fields.
5. Specify the minimum and maximum values for the Y-axis.

Note: When you use stacked Y-axis, click Apply to apply the changes to a specific trend item. You can continue
setting the ranges for other trend items in the Range Configuration dialog box.

6. Click OK.
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Changing the Background Color
To change the background color in the Chart View:

1. Place your cursor in the chart view and right-click.
2. Select the Background Color menu item. The Select a Color dialog box appears.
3. Select a new background color.
4. Click OK.

Changing the Color for Charted Data
To change the color used to plot the data for a trend item:

1. Click the button in the Marker column in the Chart Legend for the desired trend item. The Select a Color
dialog box appears.

2. Select a color.
3. Click OK. The color appears on all chart styles (not just the charts using Markers).

Zooming
To zoom in the Chart view:

1. Click to switch the mouse to zoom mode for the chart.
2. Click and drag your cursor over the area to zoom.

Note: Left-click within the chart to zoom out one level. To exit zoom mode while retaining the current zoom
level, click Zoom. To exit zoom mode and restore the chart to an unzoomed state, click Restore.

Working with the Table View
Selecting Trend Data
To select trend data, click an individual row in the Table view or use the Ctrl and/or Shift keys to select multiple rows.

To select all of the trend data, click Select All.

Note: You also can click and drag your cursor over rows in the table to select items that appear consecutively.

Sorting Trend Data
To sort search the trend data in the Table view, click the heading of the desired column. The column sorts and a
small red triangle appears indicating the order of the sort (ascending or descending). Click the column heading again
to change the sort order.

Reordering Columns
To reorder the columns in the Table view, drag the heading of the column to the desired location.

Copying Trend Data to the Clipboard
To copy trend data in the Table View to the system clipboard:

1. Select the desired trend data according to section.
2. Click Copy to Clipboard.

Note: You can also use standard keyboard shortcuts to select and copy the data (Ctrl + A to Select All, Ctrl +
C to Copy).

3. Open the program to paste the results (for example, Microsoft Excel).
4. Paste the results according to the program’s conventions (generally Edit > Paste or Ctrl + V).

Editing the Definition View
Configuring Trend Attributes
To configure the Trend Viewer attributes, edit the values and selections using the text boxes, drop-down menus,
and calendars. See the section.
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Changing the Plotting Style
To change the plotting style in Definition view:

1. In the Trend Items table, click the drop-down list in the Plotting Style column.
2. Select either Continuous or Discrete.

Expanding and Collapsing the Legend and Trend Items Table
To expand and collapse the Legend and Trend Items table in the Chart and Definition view, click one of the arrows

located on the splitter bar to show and hide the table. Continue to click the arrows until the desired display is
achieved.

Note: You can also drag the splitter bar to resize the Legend and Trend Items table areas.

Adding Trends
To add trends to the Trend Viewer in the Chart, Table, and Definition views:

1. Click the button. The Select Item dialog box appears.

2. Select one or more items (Ctrl or Shift).

Note: All non-trend items appear dimmed. If everything appears dimmed in the Select Item dialog box, check
to see if you have at least one object with a Trend Extension and/or that Engine devices from other sites
are storing samples in the ADS/ADX (if applicable).

3. Click OK.

Note: You can use the Select Item dialog box to select historical trends from an ADS.

Removing Trends from the Trend Viewer
1. Select one trend item from either the Chart Legend or Definition View Trend Items Table.

2. Click the button. The Remove confirmation dialog box appears.

3. Click Yes.

Changing the Gridlines
To change the gridlines in the Chart view, right-click > Gridlines > and select type.

To change the gridlines in the Definition view, click the Gridlines drop-down list and select type.

Printing Trend Viewer Information
To print Trend Viewer information, follow the printing instructions in the Site Management Portal User Interface
section.
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Trend Studies
The Metasys Historical Data Management feature allows you to collect and store historical samples of Engine object
data. Metasys Trend Studies allow you to view the historical data. Using this information, you can manage energy
usage, bill tenants, prove compliance to standards, and diagnose problems in your Metasys system. You can also
trend attributes of system objects. With the addition of an ADS Device Object/ADX to your network, the Metasys
system provides long-term storage of historical data and you dramatically increase storage capabilities.

See the Site Object and Engine Device Object.

The Engine allows you to add Trend Extensions to objects. The Trend Extension contains all of the trend definition
information associated with the object. Each trend is associated with a single attribute of that object and collects
historical data samples of that attribute. With Trend Extensions, data is collected in the Engine only, but you can
configure the Engine to transfer the data to the ADS/ADX for long-term storage. For more information on extensions,
see Extensions.

Do not confuse the trend study with the Trend Viewer or Trend Extension. For information on Trend Extensions or
the Trend Viewer, see the Trend Extensions and Trend Viewer sections.

For performance information on trends, refer to the Metasys System Extended Architecture Overview Technical
Bulletin (LIT-1201527).

For more information on the wizard used to insert Trend Studies, see Insert Trend Study Wizard.

Trend Studies Concepts
Historical Data Overview
Basic Historical Data Management begins with the Engine trend extension. Each Engine attribute that can be trended
can store historical data samples about the attribute. Sample storage in the Engine is limited to the size of the
individual Trend Buffer. For storage of long-term or large numbers of samples, configure your system to store
historical data in the ADS/ADX. Use the Trend Extension to view and configure trends in the Engine and the Trend
Study to view trend data from the Engine and/or ADS/ADX.

Note: Although multiple trend extensions can be added to an object on an NxE, these extensions will be combined
as a single trend if sent to an Historical Data Repository. This may not yield the expected result. To use
multiple trends on a single object in an Historical Data Repository, create duplicate AV or BV objects and
that map to the point in question, then create a new trend on the parallel AV or BV.

Historical Data Management in an ADS/ADX
When you add an ADS/ADX to your Metasys system, trend data can be placed in a Historical Data Repository for
long-term storage. If your Engine is configured to route trends to the ADS/ADX, the ADS/ADX stores the trends in
the Historical Data database. The ADS/ADX utilizes a standard database management system that supports archival
storage.

Trend Studies
Accessible through the navigation tree, Trend Studies display trend sample data from trends in Engine trend buffers
and/or ADS/ADX repositories. An ADS/ADX on the site is not required to retrieve trend data from the Engine.

When you create a Trend Study, you use the Trend Study wizard to choose the sources for the trends and the display
properties.

An Audit Trail message is created whenever you create, delete, or edit a Trend Study. Trend Studies, graphics, and
folders are the only items you can create under an ADS/ADX on the navigation tree.

The main advantages to using Trend Studies are that you can:

• view multiple trends at once (from both Engine and ADS/ADX)
• view ADS/ADX historical trend data
• configure the Study Range with flexible parameters

Note: You do not need an ADS/ADX on the site to forward trend samples to an ADS/ADX. You can forward trend
samples to an ADS/ADX on a different Metasys site. See the ADS Device Object for ADS/ADX information.
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Views
There are three views in the Trend Study: Chart View, Table View, and Definition View.

Table 120: Views
DescriptionViewButton
Allows you to view trend data in a chart format.Chart View

Allows you to view trend data in a table format.Table View

Allows you to view the Trend Study setup and display options.Definition View

Trend Study Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data. You can zoom,
unzoom, and pan within the Chart. You can also specify the X-axis and Y-axis ranges. You can change the Y-axis
type to view the chart using stacked Y-axis or single Y-axis.

Table 121: Chart View
DescriptionNameButton
Retrieves the most recent data samples for the displayed trends.Update

Toggles the mouse behavior for the chart between zoom mode and normal
mode.

While in zoom mode:

• drag the mouse over an area of the chart to zoom in on that area.
• click Zoom to exit zoom mode and restore the mouse to normal mode.
• left-click to zoom out one level.

When you exit zoom mode, the chart remains at the current zoom level. Use
the Restore button to fully zoom out on the chart.

Note: You cannot pan while the mouse is in zoom mode.

Note: You can also zoom and unzoom in normal mode by using the Shift
key and the mouse. To zoom, hold the Shift key down while dragging
the mouse across the chart. To zoom out one level, left-click the
mouse while holding the shift key down.

Zoom(Zoom)

(Normal)

Allows you to return to an unzoomed view and Allows you to return to an
unzoomed view and switches the mouse back to normal mode if the chart's
zoom mode is active.

Restore

Allows you to pan the view of the chart vertically or horizontally by dragging
the mouse across a zoomed chart. Panning is not available for unzoomed
charts or when zoom mode is active. To pan left or right, drag the mouse
over the X-axis. To pan up or down, drag the mouse over the Y-axis.

Pan

Displays the data using lines and point markers. The Points Line chart is the
default chart type in chart view.

Points Line

Displays the data using an area chart.Area

Displays the data using a bar chart.

Note: Only use the bar chart when the number of data samples can
reasonably be expected to display as bars. If too many data samples
exist when you click this option, the display becomes unstable and
fails to properly update the screen. To recover, select any other
display option.

Bar

Displays the data using markers, with no lines.Points
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Table 121: Chart View
DescriptionNameButton
Displays the data using lines, with no markers.Line

Displays a separate Y-axis for each trend.Stacked Y-axis

Displays the trends using a single Y-axis.Single Y-axis

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click in the panel to
display the menu.

Table 122: Chart View Right-Click Menu
DescriptionMenu Item
Opens the Select a Color dialog box and allows you to configure the background color.Background Color

Displays the Y-axis Range Configuration dialog box.Y-axis Scale

Displays the X-axis Range Configuration dialog box.X-axis Scale

Allows you to select what type of gridlines to appear on the chart. You can choose: None, X
and Y, X Only, and Y Only.

Gridlines

Allows you to select what type of chart to display. You can choose: Points Line, Area, Bar,
Points, and Line.

Chart Type

Displays the chart on a stacked Y-axis.Stacked Y-axis

Chart Legend
The Chart Legend appears below the graphical charting area. The Chart Legend displays the list of trend items for
the Trend Study in a table, and includes information about each item.

Table 123: Legend
DescriptionNameButton/Field
Selects the maximum number of trend items for display in the chart.Select All

Deselects all trend items in the chart Legend.Remove All Selections

Indicates if the trend item appears in the Chart. When checked, the data
appears on the chart and in the table. When unchecked, the data does not
appear in the chart or table.

Show

Indicates the trend was selected from the ADS Historical Database folder.Historical Trend Icon

Indicates the appearance of the marker style and color for the trend item on
the Chart.

Marker

Displays the Select a Color dialog box. Allows you to change the color used
to chart the trend data.

Color Palette

Displays the trend item name based on the Name attribute.Name

Displays the trend item’s full reference.Reference

Chart Legend Right-Click Menu
You can right-click an item in the Chart Legend to access item-specific menu options. The right-click menu content
is based on the type of item you click on. For example, if you right-click a trend item from a historical database, you
can only Refresh the Trend Study display.
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Trend Study Table View
The Table view of the Trend Study allows you to view data for the selected trends in a table format. You can copy
the trend data to the clipboard for pasting into other applications such as Microsoft Excel.

Table 124: Table View1

DescriptionNameButton
Updates the data samples with new trend data immediately.Update

Allows you to copy selected trend data to the system clipboard for
pasting into other applications such as Microsoft Excel. You can also
use Ctrl + C to copy selected trend data.

Copy to Clipboard

1 The Historical Trend Icon appears in the Table View column headings when applicable.

Trend Study Definition View
Use the Definition View to edit the Trend Study configuration. You can choose which trends are viewed, choose the
Study Range, and edit the display properties. You can view more than one trend item at a time on the same graph.
The following table details the fields in the Definition View.

Table 125: Definition View
DescriptionField
Allows you to edit the refresh rate and display precision.

• Refresh rate: specifies the amount of time, in seconds, for automatic refresh of data. You must configure
this attribute with a value of 0 seconds, 60 seconds, or greater than 60 seconds. Values 1 to 59 are
invalid and not allowed. 0 means manual refresh. If the refresh rate is 0, click the Update button to
display new data.

• Display precision: specifies the decimal point rounding and the number of decimal places used to
format real values that do not report a display precision. If the value reports a display precision, this
Trend Viewer attribute is ignored in favor of the value’s native display precision.

General

Specifies the Start Time and End Time for the Trend Study.

• Radio Buttons: Allows you to choose relative time or absolute time for the Study Range (start and
end times). The fields enable depending on which one you select.

• Date: Displays the date for the Study Range.
• Absolute Time: Select either Today or Now. If you select Today, enter the Relative Time. If you choose

Now, specify an Offset.
• Relative Time: Allows you to choose the relative time for the Study Range.
• Offset: Represents a combination of a whole number of days, hours, minutes, and seconds before or

after (- or +) the current date and time.

Range Start and
Range End

Allows you to add gridlines, stack the Y-axis, and choose the chart style for the Trend Study.Chart Display

Definition View Trend Items Table
The Trend Items table appears at the bottom of the Definition view. The Trend Items table displays the list of the
Trend Study’s trend items.

Table 126: Trend Items Table
DescriptionNameButton
Indicates the trend was selected from the ADS Historical Database folder.Historical Trend Icon

Opens the Select Item dialog box and allows you to add trend items to the
Trend Study. This button only enables when the view is in edit mode.

Note: All items and navigation trees appear in the Select Item window;
however, you can only select trends. All other items appear dimmed.

Add
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Table 126: Trend Items Table
DescriptionNameButton
Allows you to remove a trend item from the Trend Study. This button only
enables when the view is in edit mode.

Remove

Displays the name of the trend item.Name

Displays the trend item’s reference information.Reference

Allows you to select the aggregate function to use on the trend sample data
(NONE, Average, Minimum, Maximum, Standard Deviation, Range, Sum, and
Variance). You can sample the same point for different aggregate functions
and display them on a single chart.

The aggregate functions of the trend study apply to information in the Historical
Data at the ADS/ADX Server and do not apply to data in the NAE buffer.

Aggregate Function

Specifies the time, in minutes, over which the aggregate function should be
applied (for example, 60 for an hourly calculation, or 1,440 for a daily
calculation).

Aggregate Interval

Allows you to select the plotting method for the trend item.

• Continuous - straight line between data samples. Continuous plotting
connects samples with the shortest possible line, giving an appearance of
a set of diagonal ramps as samples change value.

• Discrete - line stays at the same value until the next data sample is taken
(good for binary data). Discrete plotting has 90-degree angles at the time
when samples change value. The chart appears to be a series of steps.

Plotting Style

Study Range
The Study Range is the time period used to filter trend data. The Trend Study gathers and displays the trends that
are taken during this time period.

Default Destination
The ADS Repository defines where trend samples are sent when the local trend buffers reach their defined Transfer
Setpoint (see the Trend Extensions section), the Engine defined ADS Delivery Time (see the Engine Device Object)
is reached, or the user initiates a transfer. You can initiate a transfer by using the Trend Extension’s Route command.

Note: You do not need an ADS/ADX on the site to forward trends to an ADS/ADX. You can forward trend samples
to an ADS/ADX on a different Metasys site. The off-site ADS/ADX that receives forwarded trend samples
must be the site director of its site. See the ADS Device Object for more information on the ADS/ADX.

Note: You can define only one repository as the default destination for each Engine.

For more information on ADS/ADX default trend destinations, see Configuring the ADS/ADX as the Destination for
Trend Data.

Trend Studies Steps
Setting Up Trend Studies (Overview)
1. Create a Trend Extension.
2. Configure an ADS/ADX as the destination for trend data.
3. Configure the trend extension to pass trends to the ADS/ADX.
4. Configure the ADS/ADX to forward trends to another ADS/ADX trend repository (if desired).
5. Create a Trend Study.

Note: If you have a site with an ADS/ADX and engines, and you create a Trend Study on an engine (rather than
on the ADS/ADX), any trend items added to the trend study from the ADS/ADX’s Historical DB folder is listed
with the current site name in their references instead of their actual site names.
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Note: When referencing trend items that were forwarded from an off-site device, create the trend study object on
the ADS/ADX, rather than on the engine.

Configuring the ADS/ADX as the Destination for Trend Data
Note: You can define only one repository as the default destination.

Note: If you need to provide long-term storage for trend samples from an Engine, follow these steps to configure
the Trend Repository of an ADS/ADX as the Default Destination.

To configure the ADS/ADX Trend Repository as the Default Destination for trend samples from an Engine:

1. Select the Engine device in the navigation tree.
2. View the Engine. See Displaying Information About an Item for more information on how to display an item.
3. Select the Focus tab and click the Advanced radio button to display additional item information.
4. Select Edit.
5. Edit the attributes listed below. Click one of the following for information on these Engine Device Object attributes

(The Engine Device attributes table contains Default Value and Values/Options/Range information for the
attributes.):

• ADS Repository
• ADS Delivery Time

6. Click Save.

Note: If you want to define the ADS/ADX attributes for the entire site instead of at the individual Engine level,
select the Site in the navigation tree and edit the following Site Object attributes (The Site attributes table
contains Default Value and Values/Options/Range information for the attributes.):
• Default ADS Repository
• Default ADS Delivery Time

Configuring the Trend Extension to Pass Trend Data to the ADS/ADX
To configure the ADS/ADX as a default destination for trends, you must configure the Repository Enabled and
Transfer Setpoint attributes in the Trend Extension. See the Object Help section.

Configuring an ADS/ADX to Forward Trend Data to Another ADS/ADX Trend Repository
1. View the original ADS/ADX. See Viewing Item Data for information on how to display an item.
2. Select the Focus tab and click the Advanced radio button to display additional item information.
3. Select Edit.
4. Scroll down to the Repository Storage section.
5. Edit the ADS Repositories attribute. See the ADS Device Object/ADX object attributes table for more information

on this attribute or other ADS/ADX attributes, including their Default Value and Values/Options/Range information.
6. Click Save.

Creating Trend Studies (Overview)
Note: Before creating a Trend Study, create a Trend extension. See Setting Up Trend Studies (Overview) for details.

1. From the Insert Menu, select Trend Study.
2. Follow the Trend Study’s wizard steps. The new study appears in the Navigation Tree.
3. Drag and drop the study to the Display Frame.
4. On the Definition View, click Edit and configure the fields (see Trend Study Definition View) as you want them.
5. Add trend items to the Trend Item table using the add button. The Select Item window appears.
6. Select one or more trend items.

Note: Multiple selection adds multiple items.
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Note: All non-trend items appear dimmed. If everything appears dimmed in the Select Item tree, check to see
if you have at least one object with a Trend Extension and/or that Engine devices from other sites are
storing samples in the ADS/ADX (if applicable).

7. Click OK. See Adding New Trend Items to the Trend Study.
8. Click Save.
9. Click the Chart or Table buttons to see trended data in the specific format.

Note: If nothing appears in the chart or table, check to see if you have samples in your study range and adjust
if necessary.

Editing Trend Studies
1. View the Trend Study.
2. Click the Definition View button.
3. Click the Edit button.
4. Make your changes using the table in the Trend Study Definition View section, including adding new Trend Items.
5. Click the Save button to save the changes.

Viewing Trend Studies
Note: To create Trend Studies, see Creating Trend Studies (Overview).

1. From the navigation tree, drag and drop the Trend Study you want to view to the Display Frame.
2. Select the Definition View button to edit the Trend Study. Select the Chart View or Table View buttons to view

the trend data.

Note: The UI limits the number of data samples you can retrieve. Therefore, you may not see the full range specified.
The most recent data samples are always retrieved first.

Note: If the chart appears to flicker, you have too many trend samples in the Trend Study. Reduce the number of
displayed trends or change the trending date/time range to display fewer samples and improve performance.
See Deleting Trends from the Trend Study.

Deleting Trend Studies
1. Select a Trend Study in the navigation tree.
2. Select Edit > Delete Items and answer Yes to the Confirm Delete box.

Adding New Trend Items to the Trend Study
1. View the Trend Study.
2. If necessary, click the Definition View button.
3. Click the Edit button in the upper left of the Trend Study tab.

4. Click the button in the Trend Items table. The Select Item dialog box appears.

5. Select the trend(s) that you wish to add from the Select Item dialog box.

Note: Multiple selection adds multiple items.

Note: All non-trend items appear dimmed. If everything appears dimmed in the Select Item dialog box, check
to see if you have at least one object with a Trend Extension and/or that Engine devices from other sites
are storing samples in the ADS/ADX (if applicable).

6. Click the OK button in the Select Item dialog box.
7. Click the Save button in the Definition View to save the changes.

Deleting Trends from the Trend Study
1. View the Trend Study.
2. Click the Definition View button.
3. Click the Edit button.
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4. Select a trend in the Trend Item table.

5. Click the button. The Remove confirmation dialog box appears asking if you want to remove the trend item.
Click Yes.

6. Click Save.

Configuring the X-axis
To configure the X-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the X-axis Scale. The Range Configuration dialog box appears.
3. Specify whether to Use Automatic Range Calculation. The automatic range is determined automatically based

on the set-up in the Definition View.

Note: You are limited to dates and times between the start and end dates configured in the Trend Study definition.

Note: When you select Use Automatic Range Calculation, you do not fill in the Range fields.
4. Specify the Start Time, Start Date, End Time, and End Date.
5. Click OK.

Note: You can also configure the X-axis range by changing the start and end dates and times in the Definition View.
See the table in the Trend Study Definition View.

Configuring the Y-axis
To configure the Y-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the Y-axis Scale menu item. The Range Configuration dialog box appears.
3. If you are using stacked Y-axis, choose the trend item to which the Y-axis range should be applied from the item

drop-down list.
4. Specify whether to Use Automatic Range Calculation. The Range is determined automatically based on the trend

items.

Note: When you select Use Automatic Range Calculation, you do not fill in the Range fields.
5. Specify the minimum and maximum values for the Y-axis.

Note: When you use stacked Y-axis, click Apply to apply the changes to a specific trend item. You can continue
setting the ranges for other trend items in the Range Configuration dialog box.

6. Click OK.
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User Graphics Tool (UGT)
Graphics provide a visual representation of the monitored systems that enable you to quickly check the status of
system symbols and recognize unusual system conditions. Graphics can be designed to allow the user to move
through buildings, floors, and other areas, viewing building systems and control processes. You can view, create,
and edit graphics using the User Graphics Tool (UGT).

User graphics are usually made up of three parts:

• the Static Background image
• Symbols
• Hyperlinks that allow you to navigate to graphics and Web addresses

The UGT operates in two modes:

• The Edit Mode allows you to edit an existing graphic or create new graphics.
• The View Mode allows you to view existing graphic to monitor and command all systems integrated into the

Metasys network.

The UGT is available with the NAE, NIE, ADS, ADX, and SCT. You can access the UGT when you are logged in to
the Metasys user interface via any Web browser. The Group Object represents user graphics in the All Items
navigation tree and can be displayed in any active display panel.

Note: If your graphics reference multiple Engines or multiple ADS/ADXs, and one device needs to be downloaded,
upload all Engine/ADS/ADXs prior to making changes in SCT. This procedure ensures your graphics work
consistently.

For information on default preferences for graphics (such as status colors, fan colors, state colors, and alarm flashing
settings), see Graphic Settings Tab in the Preferences section.

For more information on configuring an NAE or NIE and for details on user access configuration, see the Related
Documentation table.

User Graphics Tool Concepts
Graphic Workspace
When viewing an existing graphic or creating new graphics, the UGT runs in the Graphics Workspace, which is
displayed in an active display panel. The background for the workspace defaults to a gray background. The graphic
workspace displays all graphical symbols and a user-selectable Static Background. The UGT Toolbar shows only
the appropriate tools for the UGT Modes you are working in View Mode or Edit Mode.

UGT Modes
The User Graphics tool runs in either Edit Mode or View Mode. When you are generating new graphics or editing
graphics, the User Graphics tool is in Edit mode. When you finish editing and click save and the UGT switches to
View mode.

Note: You can generate graphics in the Metasys system online mode or offline mode (Metasys Modes). See the
following scenarios:
Online: If your Web browser is connected to an Engine or ADS/ADX. In this case, a new graphic is generated
online in the device where the graphic resides during normal operation. When you are finished creating or
editing graphics, Upload the database to the archive database in the SCT.

Offline: If your Web browser is connected to the SCT. If this case, the new graphic is generated offline and
stored in the archive database. When you are finished creating or editing graphics, Download the database
to the device where the graphic will reside during normal operation.

Edit Mode
Edit mode is the mode used by the UGT to design and edit graphics. Access the Edit mode by clicking the Edit
button on the UGT Toolbar. In Edit mode, you have access to all toolbar items/symbols and you can bind symbols
to objects and link graphics to other graphics.
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Right clicking in Edit mode brings up basic choices for editing graphics such as copy, paste, delete, duplicate, hide,
and zoom, depending on the type of item you select. Double clicking in Edit mode brings up the binding information
for a symbol.

For a list of mouse shortcuts, see the Mouse Shortcuts: Edit Mode topic.

View Mode
Graphics display in the View mode when you are navigating using graphics and when you first open a graphic.
Graphics appear in an active display panel. You must enter the Edit Mode (by clicking the Edit button) to design or
edit a graphic. In View mode, you have access only to a limited number of items on the UGT Toolbar. The symbols
in the palette on the left do not appear in this mode.

The View mode allows you to command an object bound to a Value Display Box or Analog Fill Bar Graph and to
click on Hyperlinks to access linked graphics. Double clicking on a bound symbol in View mode displays the Focus
view of the bound object.

For binary point objects, the value and status update every 10 seconds. For analog point objects, the value and
status update every 10 seconds. Commands and value changes return a new state/value or error message within
10 seconds or less. The error message could be related to priority (if the system can’t perform the requested function
now) or failure to reach a commanded state or value. Error messages appear in dialog boxes.

For a list of mouse shortcuts, see the Mouse Shortcuts: View Mode topic.

Toolbar
The UGT toolbar shows only the appropriate tools for the current mode of the UGT. The table below shows the
toolbar options available in Edit Mode and View Mode.

For information on mouse shortcuts, see Mouse Shortcuts.

Table 127: UGT Toolbar Options in Edit Mode and View Mode
Action PerformedVisible In:DescriptionIcon

(Standard
Windows Icons
not Shown)

View ModeEdit Mode

Saves all changes to the graphic and exits Edit
mode.

XSave

Cancels any changes to the graphic (made since
the last save) and exits Edit mode.

XCancel

Changes the UGT to Edit mode.

Note: This is the only toolbar item that requires
Configure Access (Security Administrator
System).

XEdit

Brings up the Print dialog.XXPrint

Brings up the Print Preview dialog.XXPrint Preview

Cuts the selected symbol out of the graphic.XCut

Copies the selected symbol.XCopy

Pastes a cut or copied symbol into the system.XPaste

Undoes the previous action (except for a save) up
to 4 actions.

XUndo
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Table 127: UGT Toolbar Options in Edit Mode and View Mode
Action PerformedVisible In:DescriptionIcon

(Standard
Windows Icons
not Shown)

View ModeEdit Mode

Redoes the previous undone action up to 4 actions.XRedo

Allows you to import the background of the graphic.XSet Background Image

Allows you to import an advanced graphic.XSet Advanced Image

Saves the background image.XSave Background Image

Brings up the Bind Information dialog box for the
selected item (this is the same box as when you
double click on an item).

XBind

Turns the cursor into a selection cursor.XXSelect

Turns the cursor into a text cursor that allows you
to create a text box.

XText

Turns the cursor into a hand that allows you to pan
over the diagram by dragging.

XXPan

Allows you to select an area to zoom in on.XXMarquee Zoom

Zooms in and out on a graphic when you hold the
mouse down.

XXInteractive Zoom

Zooms the diagram to fit within the window.XXZoom - Fit Window

Shows an overview of the entire graphic in one
window.

XXOverview

Allows you to select the percentage zoom applied
to the diagram.

XXSelective Zoom

Static Background
Backgrounds are static images displayed in the background of a graphic. Backgrounds represent buildings, floor
plans, mechanical equipment, and any other picture that represents the location or function of the equipment in the
graphic. By default, a newly created graphic has a gray background. You can insert a background image using a
file based on SVG, SVGZ, or JPEG graphic format.

You can create SVG/SVGZ background images with graphic drawing packages or from established libraries of
images. We recommend using the Professional or Standard edition of Microsoft Visio 2003, 2007 or 2010 (32 bit)
software and the AGSL to create background images. Alternatively, you can use Microsoft Visio 2002 software with
the Graphics Stencil Library (GSL). SVGZ and SVG images must be created in positive space (quadrant 1, on the
positive X and positive Y axis).

Background images in JPG format are usually created with cameras or scanners. You cannot resize a UGT background
in JPG format, and if an area of the graphics workspace is not fully covered by the JPG image, the exposed area
defaults to gray.

Access available backgrounds with the background icon on the Toolbar.
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For information on how to edit an existing background image, see Editing a Background Image.

Managing Graphic Creation
In general, you should store your graphic files on the Site Director. The Site Director provides you with a uniform
point of entry and traffic control. The Site Director allows information sharing between users while minimizing network
traffic.

NAE35/NAE45 Graphic Size Limitation
When you create or edit graphics with an online UI to an NAE35 or NAE45, changes you make do not save if the
graphic is too large. The total size of the graphic background, dynamics, and static text must not exceed 700K bytes.
A typical size for an SVGZ graphic is 100–200K. You do not receive a warning that the graphic is too large to save.
Transactions larger than 1 MB are rejected by the NAE. The size limitation includes a 40% overhead from the HTML
wrapper around the save transaction.

Note: This size restriction does not apply to graphics that are created and saved through the online UI to an NAE55,
NAE85, or SCT.

When you work with NAE35/NAE45 graphics, use the following equation to help keep your graphics at a manageable
size:

(background image size x 140%) - 1 MB (1,048,576 bytes) = available space for graphic dynamic symbols and text
blocks

Note: Each graphic symbol is 3,000 bytes.

Example:

Background size: 700,000 bytes

Background + overhead: 700,000 x 140% = 980,000

Total Space for symbols and text = 1,048,576 - 980,000 = 68,576

Total symbol and text elements = 68,576 / 3,000 = 22

Symbols
Symbols are graphic elements or components that are inserted into graphics to represent the value or status of
equipment in your system. The UGT contains the set of symbols described in the table below. In Edit mode, the
symbols appear in a palette to the left side of the graphic workspace.

Symbols support drag and drop functionality. For more information, see Drag and Drop Shortcuts.

Table 128: Symbol Descriptions
DescriptionSymbol
Buttons allow you to hyperlink from one graphic to an item, URL, or application.Buttons

Value Display Boxes display the value and status of bound objects and allow you to
access the Focus view of the bound object. Value Display Boxes also show the units
used by the value.

Value Display Boxes

Gauges display the value and status of bound objects with graphs, dials, and standard
colors. UGT offers the following gauge categories:

Analog Fill Bar Graph

Dial Gauge

Gauges

Dynamic symbols indicate the value of bound objects. Some of these symbols move as
the object change. Members of this category are:

Fans

Basic Shapes (Block)

Switch (2 or 3 State)

Dynamics
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Button Symbols
Button symbols are useful when browsing to another graphic, object, or a Web site. Buttons support the drag and
drop functionality, allowing you to drag items from the navigation tree and drop them in the graphic workspace with
the following rules:

If you select multiple objects in the Navigation Tree and then drag a button to the Graphic Workspace, the UGT
creates buttons that Alias the selected objects.

If you select a graphic/object in the navigation tree and then drag a button to the graphic workspace, the UGT creates
a button bound to the selected graphic/object.

In Edit mode, after you drag and drop a button, click on it to add a label. If you double click on a Button in the Edit
mode, the Hyperlink Information box appears. Using this box, you can specify to link the graphic to a graphic, object,
or Web page, choose display properties, and choose to hide the button. See the Button Symbols topic for more
information.

Only buttons support Hyperlinks.

In the View mode, left click on the Button to navigate to the bound object, graphic, or Web page. When your cursor
passes over a button, the cursor changes into a finger pointer.

See the Buttons step section for information on binding Buttons.

Hyperlinks
Hyperlinks are links from one graphic to other items (graphics or other objects), URLs, or applications using buttons.
If you click on a button hyperlinked to an item, your view switches from the current graphic to the hyperlinked graphic
or object. If you click on a hyperlink to a URL, the Web site appears in a separate browser window. If you click on
a hyperlink to an application, the application opens.

Only buttons support hyperlinks. Set hyperlinks when you bind a button symbol.

Note: You cannot link to items in the system, such as Tailored Summaries, unless you are also using Ready Access
Portal software. To link to a Tailored Summary, use the Ready Access Portal UI URL as the link destination
in the graphic. If you are not logged on to the Ready Access Portal UI, you are asked for your username and
password after clicking the link.

Value Display Boxes
Value Display Boxes are useful for displaying the value and status of a large number of objects in a single graphic.
The Value Display Box supports drag and drop functionality. If you select a single item or multiple items in the
navigation tree and then drag and drop a Value Display Box, the box/es automatically binds to the selected item/s.

If a Value Display Box is configured to display the Status of the bound object, the text and box background appear
in the standard Status Colors.

In View mode, Value Display Boxes appear as if they are editable boxes, but they are not. Double click on the Value
Display Box to display the Focus view for the bound object and right click to show the command menu.

See the Value Display Boxes step section for information on binding Value Display Boxes.

Gauges Category
Gauges provide an indication of the present value and status for the bound objects. If you select a single item or
multiple items in the navigation tree and drag a gauge to the workspace, the UGT creates one gauge per item and
binds each symbol to an item.

The following table lists the gauges included in the UGT.
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Table 129: Gauges
AnimationSymbolGauge Type
Bar moves to indicate value of bound object.Analog Fill Bar Graph

Dial needle moves to indicate value of bound object.Dial Gauge

Analog Fill Bar Graph
Analog Fill bar graph symbols show the present value of an object by changing the size of the bar in the graph and
indicating the present value as a number in the display box. The color of the moving bar graph and the display box
background color indicate the status of the bound object. We recommend using Analog Fill Bar Graphs with analog
objects.

You can define the minimum and maximum value of the bar graph range. If you don’t define the minimum and
maximum for the bar range, the gauge defaults to 0 for the minimum and 100 for the maximum. Under the bar, a
value box displays the numeric value of the bound object. Analog Fill symbols can be configured to move vertically
or horizontally. To change the orientation of the Analog Fill box, see Gauges: Analog Fill.

In View mode, the display box appears as an edit box, but it is not editable. If you choose, the color of the display
box background shows the status of the bound object and the units used by the symbol. Double click on the symbol
to see the Focus view of the bound object and right-click to show the command dialog box.

Dial Gauge
Dial gauges indicate the present value of a bound object with the position of a needle on a gauge. A display box
shows the present value as a number with units, and shows the status of the bound object. We recommend using
Dial Gauge with analog objects.

You can choose the minimum and maximum value for the dial range. If you don’t define the minimum and maximum
for the dial range, the gauge defaults to 0 for the minimum and 100 for the maximum.

In the View mode, the Dial Gauge appears as a circular dial with a needle pointing to the position that represents
the value of the bound analog object. A value box below the dial shows the numeric value of the bound object.
Double click the dial gauge to display the Focus view for the bound object and right-click to show the command
dialog box.

See the Gauges: Dial Gauge Symbol step section for information on binding Dial Gauges.

Dynamics
Dynamic symbols display the status of bound objects. If you select a single item or multiple items in the navigation
tree and drag a dynamic symbol to the workspace, the UGT creates one symbol per item and binds each symbol
to an item.

The dynamics category includes the symbols listed in the table below.
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Table 130: Dynamics
AnimationSymbolDynamics Type
Fan/pump blades spin or remain
stationary.

Fans

Colors change.Basic Shapes (Square, Circle, and
Triangle)

Switch changes positions.Switch (2 or 3 State)

Fans
Fan symbols display rotational movement when bound to an object. Use this dynamic component to provide animation
capabilities for fans or pumps that appear in the background image. You can choose either a clockwise or a
counter-clockwise spin. We recommend using Fans with binary objects.

In View mode, if the bound object has a value of 0, the fan appears stationary. If the bound object has a value greater
than 0, the fan/pump blade spins. The fan/pump color shows the state of the bound object (red for Off, green for
On).

If the fan is spinning, the bound object has a normal status or is unreliable, and the device that the bound point
resides on is online, the color of the fan is set to the color defined in the system preferences for the On state. If the
fan is not spinning, the bound object has a normal status or is unreliable, and the device that the bound point resides
on is online, the color of the fan is set to the color defined in the system preferences for the Off state. If neither of
these scenarios apply, the color of the fan is defined by the status colors defined in the system preferences.

In the View mode, a double click on a fan symbol displays the Focus view of the bound object. A right-click shows
the command dialog box.

See the Dynamics: Fans step section for information on binding Fans.

Basic Shapes
Basic Shapes show the status of the bound object. Any basic shape can be bound to either an analog, binary, or
multistate object. You can resize these symbols, which include a square, triangle, and circle.

If a basic shape is bound to an analog object, in the View mode, the color of the shape indicates the status of the
bound object. White is normal, but other colors are listed. See Status Colors.

If a basic shape is bound to a binary object, in the View mode, the color of the shape indicates the state of the bound
object. By default, if the state is 0, the shape is white and if the state is greater than 0, the shape is green. These
can be configured by the user when you bind the symbol.

Double click on the shape to display the Focus view for the bound object. Right-click to display the commands.

Tip: Use the circles to depict temperature sensors on a floor plan graphic. Circles and rectangles can be used as
status lights.

See the Dynamics: Basic Shapes step section for information on binding basic shapes.
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Switch (2 or 3 State)
The Switch is a dynamic symbol that can be bound to an object, and can be configured to be either a 2 or 3 state
switch). User-defined text appears at the top of the Switch to show what state the point is in. You can resize Switches.
We recommend you bind a Switch to a binary or multistate object.

In View mode, Switch symbols show the state of the bound object. Double click on the shape to display the Focus
view for the bound object. Right-click to show the command dialog box.

See the Dynamics: Switches step section for information on binding switches.

Binding Symbols to Objects
In the UGT you can bind symbols to objects, which allows the symbol to display the condition of the bound object.
Refer to each symbol section for details about which object type can be bound to each symbol.

To speed up the binding process, select one item or several items (using the Shift or Control key) in the navigation
tree and then drag and drop a symbol into the graphic workspace. The symbol automatically binds to the item or
items selected in the tree.

To bind graphics in Edit Mode, see Binding Symbols to Objects in Edit Mode.

For information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

Status Colors
Status colors are used by symbols such as Value Display Boxes, Analog Fill Bar Graphs, and Basic Shapes to
indicate the status of a bound object. The following table lists the default status colors used by the UGT.

Table 131: Status Colors
Symbol Background ColorSymbol Text ColorStatus
WhiteBlackNormal

RedBlackAlarm

YellowBlackWarning

YellowBlackTrouble

BlackWhiteOffline

OrangeBlackOperator Override

Light BrownBlackOut of Service

Note: All status color defaults can be changed in the Graphic Settings Tab in the Preferences chapter.

See Binding Symbols to Objects in Edit Mode for information on binding graphics.

Alias
Aliases simplify the process of binding symbols to objects during graphic generation when a site has several graphics
that contain a common set of objects. The Alias feature allows you to use a wildcard character (*) to represent a
single string of characters that may be part of the complete object reference as part of the binding information for a
symbol. When a graphic is displayed in View Mode, the alias symbol (*) is replaced with the text from the alias box
of the symbol you used to access the graphic. If you navigate to a graphic using an aliased button, you cannot edit
the graphic. To edit the aliased graphic, access it via the navigation tree.

For example, aliasing allows you to use a single aliased graphic for multiple field controllers, such as VAV Modular
Assemblies (VMAs), with similar configurations. See Creating Aliases.

Figure 51 shows an example of a main graphic and an aliased graphic. In the figure, the top panel contains the main
graphic, which has several buttons bound to the aliased graphic. Each button has its alias string set to the reference
for a different field device. The bottom panel shows the aliased graphic, displayed directly from the navigation view
(that is, with no alias strings passed in).
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Figure 52 show the aliased graphic as it displays when the user clicks the corresponding buttons in the main graphic
(that is, with field device-specific values).

Figure 51: Alias Example - Main and Aliased Graphics
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Figure 52: Alias Example - Using the Aliases

For more information on binding graphics, see Binding Symbols to Objects in Edit Mode.

Navigation
You can navigate between graphics by using hyperlinked Button Symbols or by selecting graphics from the navigation
tree and displaying them in the Display Frame. You can restrict user access to specific graphics by setting security
levels in the Security Administrator System.

You can also create user views that contain only graphics (hierarchy of graphics references). See User Views for
more information.

Commands
You can command objects that are bound to symbols by right clicking on the symbol in View Mode. If you are not
authorized to command the object, the command will be disabled in the command dialog box.

Mouse Shortcuts
Use mouse shortcuts to speed up User Graphics Tool use. See Mouse Shortcuts: Edit Mode and Mouse Shortcuts:
View Mode.

Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the User Graphics Tool.

Table 132: Edit Mode Mouse Shortcuts
Right-ClickDouble Left ClickSingle Left ClickItem
Remove BackgroundNo action takes place.No action takes place.Static Background

Image

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Hyperlink Information dialog box
appears.

SelectButton

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectValue Display Box

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectGauge: Analog Fill

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectGauge: Dial
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Table 132: Edit Mode Mouse Shortcuts
Right-ClickDouble Left ClickSingle Left ClickItem
Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectDynamics: Fan

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectDynamic: Basic Shape

Cut, Copy, Paste, Duplicate, Delete,
Format, Align

Bind Information dialog box appears.SelectDynamics: Switches

Format
The Format menu choice contains the choices listed in the following table.

Table 133: Format Menu Options
DescriptionChoice
Copies the selected symbol’s binding information, which you can then paste to a new symbol.
With this feature, you can easily bind several symbols to one object.

Copy Binding

Pastes the previously copied binding information to the selected symbol(s).Paste Binding

Copies the selected symbol’s formatting (size and font information), which you can then paste
onto another symbol. This allows you to easily format multiple symbols in the same way.

Copy Format

Pastes the previously copied formatting information to the selected symbol(s).Paste Format

Align
The Align menu choice contains the choices listed in the following table.

Table 134: Align Menu Options
Description1Choice

Aligns all symbols to the top most edge of the first symbol you selected.Align Top

Aligns all symbols to the bottom most edge of the first symbol you selected.Align Bottom

Aligns all symbols to the left most edge of the first symbol you selected.Align Left

Aligns all symbols to the right most edge of the first symbol you selected.Align Right

Aligns all symbols to the horizontal center of the first symbol you selected.Align Horizontal Center

Aligns all symbols to the vertical center of the first symbol you selected.Align Vertical Center

1 When you select multiple objects by dragging the mouse across them, the first selected symbol is not based on the symbol's
location within the graphic, but on the order in which it was originally added to the graphic. We recommend that you first click
on the symbol with which you want to align other symbols. Once you have selected that symbol, hold down the Shift key while
you drag the mouse across additional symbols to select them (you can also use Shift + click to select additional symbols).

Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the User Graphics Tool.

Table 135: View Mode Mouse Shortcuts
Right-ClickDouble Left ClickSingle Left ClickSymbol
No action takes place.Navigate to hyperlink.Navigate to hyperlink.Button

Command box appears.Display focus view of bound object.SelectValue Display Box

Command box appears.Display focus view of bound object.SelectGauge: Analog Fill

Command box appears.Display focus view of bound object.SelectGauge: Dial

Command box appears.Display focus view of bound object.SelectDynamics: Fan
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Table 135: View Mode Mouse Shortcuts
Right-ClickDouble Left ClickSingle Left ClickSymbol
Command box appears.Display focus view of bound object.SelectDynamic: Basic Shape

Command box appears.Display focus view of bound object.SelectDynamics: Switches

Drag and Drop Shortcuts
Consider the following shortcuts when dragging and dropping items to the Graphic Workspace:

• If you select a Graphic Object in the navigation tree and then drag a button to the graphics workspace, the UGT
creates a button already bound to the selected Graphic object.

• If you select multiple field points in the Navigation Tree and drag a Value Display Box to the graphics workspace,
the UGT creates multiple Value Display Boxes each bound to a field point.

• If you select multiple field points in the navigation tree and drag a dynamic symbol or gauge to the graphics
workspace, the UGT creates multiple symbols each bound to a field point.

• If you select multiple field controllers along with a Graphic object in the navigation tree and drag a button to the
graphics workspace, the UGT creates buttons for all the controllers. All buttons have the appropriate Alias string
already entered.

• To change the binding information for a symbol or to add binding information (if you drag and drop a symbol
without selecting anything in the navigation tree), see Binding Symbols to Objects in Edit Mode.

User Graphics Tool Steps
Generating Graphics (Overview)
Note: This process is the same when the system is offline, except the binding is done to the archive database

instead of the online system. You cannot create, edit, or delete a graphic in online mode with Basic Access.

Note: For information on default preferences for graphics (such as status colors, fan colors, state colors, and alarm
flashing settings), see Graphic Settings Tab in the Preferences section.

To create a complete graphic:

1. On the Insert Menu, click Graphic. The Insert Graphic Wizard appears.
2. Follow the wizard instructions.
3. Drag the graphic from the Navigation Tree to the display panel.
4. Click on the Background Image icon on the UGT toolbar to import a Static Background image into the graphic.

Note: To scale imported SVGZ Floorplans from Visio, cut the rescaled image from Visio. Paste the image into
Paint. Cut the image from Paint and use paste special as a Device Independent Bitmap into Visio.

5. Add Symbols as needed on top of the static background.
6. Bind the symbols to objects.
7. Add Hyperlinks to the buttons and create aliases (if desired).
8. Save the graphic.
9. Download the graphic to the online device (if you have created the graphic with the Metasys software offline

using the SCT). Upload the graphic to the archive database of the SCT (if you have created the graphic with
Metasys software online).

Changing UGT Modes
To change from View mode to Edit mode, click the Edit button on the UGT Toolbar.

To change from Edit mode to View mode, click Save on the UGT toolbar.

Viewing User Graphics
To view user graphics, double click on or drag a graphic item from the Navigation Tree into the Display Frame.
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Note: To be sure the graphic item drops completely, release the drop with your cursor over the header section of
the desired display frame.

Copying an Existing Graphic
Note: This is available when using the SCT only.

1. Click on an existing graphic item in the Navigation Tree.
2. From the Edit menu, select Copy.
3. Click in the navigation tree where the new graphic is to appear.
4. From the Edit menu, select Paste and name the new graphic.

Binding Symbols to Objects in Edit Mode
Buttons
To bind buttons to items, URLs, or applications:

1. Double-click on a button. The Hyperlink Information dialog box appears.
2. Use the information below to edit the fields.

Table 136: Button Options
DescriptionField
Selects whether the button provides a link to an item, URL, or application.Hyperlink Type

If you link the button to a URL, type the address here. If you link to an item or application, click
and see below. Applications configured using the Metasys Preferences Applications Tab

appear on the drop-down menu.

Item/URL/Application

Opens a dialog box for browsing to an item or application.

If you are linking to an item, UGT displays a navigation tree listing graphics/objects you can
bind to the button.

If you are linking to an application that is not in the Application drop-down menu, UGT allows
you to navigate to and select an executable file for an application that resides on your local
file system or a network drive.

Note: The linked application does not close when you exit the UI.

Hides the button in the View mode, creating a virtual hyperlink on the background image.Hidden

Passes the defined Alias string to the linked graphic when you press the button.Alias

Displays a dialog box to change font size and text justification for the button label text.Properties

Accepts changes.OK

Cancels changes.Cancel

Value Display Boxes
To bind Value Display Boxes to objects:

1. Double click on a Value Display Box. The Binding Information dialog box appears.
2. Use the information below to edit the fields.
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Table 137: Value Display Box Options
DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Value Display
Box. Or, lets you click to launch a tree browser to select the object to bind to the Value
Display Box.

Object

Allows you to select the specific attribute to bind to the Value Display Box. The bound attribute
is initially set to the object's Default attribute, which varies per object type, but is typically
Present Value.

If an object does not have a Default attribute, the value box displays ???? on the graphic until
you change the binding to a different attribute.

You can bind to string values or to numeric values.

Attribute

Shows the Units for the bound object in the Value Display box.Units

Shows the Status for the bound object by color-coding the text and background for the Value
Display box.

Status

Allows you to configure the text properties for the Value Display Box text.Properties

Accepts changes.OK

Cancels changes.Cancel

Note: In the View mode, double clicking on the Value Display box displays the focus view for the bound object.
Right-click displays the commands.

Gauges: Analog Fill
To bind Analog Fill symbols to objects:

1. Double-click on an Analog Fill Bar Graph icon. The Binding Information dialog box appears.
2. Use the information below to edit the fields.

Table 138: Analog Fill Gauge Options
DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Analog Fill
Gauge. Or, lets you click to launch a tree browser to select the object to bind to the Analog
Fill Gauge.

Object

Allows you to select the object’s attribute to bind to the gauge.Attribute

Launches the fill color selector to select the color displayed by the bar graph.Fill Color

Chooses vertical or horizontal motion of the bar graph.Orientation

Sets the high number for the display range of the gauge.High Limit

Sets the low number for the display range of the gauge.Low Limit

Displays the units used by the bound object.Units

Displays the status of the object in the display box of the symbol.Status

Allows you to configure the text properties for the text in the display box of the gauge.Properties

Accepts changes.OK

Cancels changes.Cancel

Gauges: Dial Gauge Symbol
To bind Dial Gauge symbols to objects:

1. Double-click on the Dial Gauge symbol. The Binding Information dialog box appears.
2. Use the information below to edit the fields.
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Table 139: Dial Gauge Symbol Options
DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Dial Gauge. Or,
lets you click to launch a tree browser to select the object to bind to the Dial Gauge.

Object

Allows you to select the object’s attribute to bind to the gauge.Attribute

Launches the color selector for the gauge to select the color displayed in the center of the
gauge.

Gauge Color

Sets the high number for the display range of the gauge.High Limit

Sets the low number for the display range of the gauge.Low Limit

Displays the units used by the bound object.Units

Displays the status of the bound object in the display box of the gauge.Status

Allows you to configure the text properties for the text in the display box of the gauge.Properties

Accepts changes.OK

Cancels changes.Cancel

Dynamics: Fans
To bind Fan symbols to objects:

1. Double-click on the Fans symbol. The Binding Information dialog box appears.
2. Use the information below to edit the fields.

Table 140: Fan Dynamics Options
DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Fan. Or, lets
you click to launch a tree browser to select the object to bind to the Fan.

Object

Allows you to select the object’s attribute to bind to the fan.Attribute

Selects if the Fan symbol will spin in a clockwise or counter-clockwise direction.Clockwise/Counter-Clockwise

Accepts changes.OK

Cancels changes.Cancel

Dynamics: Basic Shapes
To bind Basic Shapes symbols to objects:

1. Double-click on the Basic Shapes symbol. The Binding Information dialog box appears.
2. Use the information below to edit the fields.

For information on default preferences for graphics (such as status colors, fan colors, state colors, and alarm
flashing settings), see Graphic Settings Tab in the Preferences section.

Table 141: Basic Shape Dynamics Options
DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Basic Shape.
Or, lets you click to launch a tree browser to select the object to bind to the Basic Shape.

Object

Allows you to select the object’s attribute to bind to the Basic Shape.Attribute

Allows you to set the color for State 0.State 01

Allows you to set the color for State 1.State 1

Allows you to set the color for State 3.State 2
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Table 141: Basic Shape Dynamics Options
DescriptionField
Allows you to set the color for State 4.State 3

Allows you to set the color for all other states.All Other States

For the triangle basic shape, chooses the position of the point (Up, Down, Left, or Right).Orientation

Accepts changes.OK

Cancels changes.Cancel

1 The default color is determined by the preferences. See Graphic Settings Tab in the Preferences section for details.

Dynamics: Switches
To bind Switch symbols to objects:

1. Double-click on the Switch symbol. The Binding Information dialog box appears.
2. Use the information below to edit the fields.

DescriptionField
Allows you to type in the Item Reference of the object you want to bind to the Switch. Or, lets
you click to launch a tree browser to select the object to bind to the Switch.

Object

Allows you to select the object’s attribute to bind to the switch.Attribute

Allows you to choose the number of states (2 or 3) the switch will have.Number of States

Allows you to choose the text associated with each state.State 0/1/2

Accepts changes.OK

Cancels changes.Cancel

Monitoring and Commanding Items Using Graphics in View Mode
Note: The Metasys system user interface provides the capability to monitor and command the Metasys system

using graphics. To navigate through the system, see Navigating Graphics in View Mode.

To monitor your Metasys system using graphics:

1. Display graphics to show the status/state of your system components.
2. Navigate through the system.
3. To command objects/items using graphics, right-click on the symbol in View mode and select the desired

command.

Note: Right clicking has no effect on Button Symbols.

Navigating Graphics in View Mode
To navigate graphics in View mode, double click on the symbol and navigate by one of the following two methods:

1. Navigate to the hyperlink of a button symbol by clicking on the button.
2. Navigate to the Focus view of an object by double clicking on a Dial Gauge or Fan symbol.

Adding Symbols to the Workspace
To add symbols to the workspace, drag the symbol from the palette and drop the symbol into the workspace.

Note: Depending on the symbol you are adding, be wary if items are selected in the navigation tree. Some symbols
will automatically bind to items selected in the tree. See the Symbols topics for more information on drag and
drop capabilities.

Note: For more information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

293Metasys System Online Help PDF



Deleting Symbols from the Graphics Workspace
To delete symbols from the workspace, select the symbol and press Delete on your keyboard or right-click on the
symbol and select Delete from the menu.

Adding Text Blocks
To add text blocks in Edit mode:

1. Click on the Text icon on the UGT Toolbar.
2. Click on the workspace to select a location for the text. The text block appears.
3. Click the Select icon from the toolbar and double-click on the text block. The edit text box appears.
4. Type in the text box and click OK.
5. Select the Select icon on the UGT Toolbar.
6. Select the text block and drag the sides to resize the block.

Editing Text Blocks
To edit text:

1. With the selection pointer tool, double-click on the block. The block opens for editing.
2. Change the text and click OK.
3. To change the text properties, right click on the text block and select Properties from the menu.

Note: You can change the font (type, size, bold, italic, bold italic), text color, background color, and border
visibility/color.

Editing a Background Image
Use this procedure if you want to edit a background of a graphic by exporting it from the UGT. Use this method when
a copy of the existing background image is not available.

1. Drag the desired graphic from the Navigation Tree to the display panel.
2. Click the Edit button on the UGT Toolbar to enter Edit Mode.
3. Click the Save Background Image icon on the UGT toolbar to save the static background image to a location on

your hard drive. The Save dialog box appears.
4. Enter a name for the background image, select the desired location on your hard drive, select JPG or SVG

format, and click Save.
5. Open the background image file in the desired graphic editing program. Edit the background image as desired

and save the file in SVG, SVGZ, or JPG format. See the Static background image section for information on
supported file formats.

Note: You can only save a background image under its original file type. For example, if the background image
was originally a JPG, you can save it only as a JPG now. You can save SVG and SVGZ files as SVG or
SVGZ.

6. Return to the graphic in the UGT.
7. Click the Set Background Image icon on the UGT toolbar to import the revised background image file into the

graphic.
8. Save the graphic.
9. Download the graphic to the online device (if you have created the graphic with the Metasys software offline

using the SCT). Upload the graphic to the archive database of the SCT (if you have created the graphic with
Metasys software online).

Note: Save a copy of the background image file in a folder on your hard drive as a backup method. If you decide
to edit that background image later, you can edit your hard drive copy and use the Set Background Image
icon to re-import the background into the graphic in the UGT. You also can use your hard drive copy in the
event that you lose your databases and need to recover the background image.
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Creating Aliases
See Alias for more information on aliases.

Note: Do not set the Graphic attribute for an alarm extension to an aliased graphic. Aliased graphics will not display
properly when displayed from the Alarms Window or Event Viewer.

1. Create a graphic with an appropriate background image, and add value boxes to represent common field points.
2. For each value box, edit the bound reference and use a wildcard character (*) to replace the portion of the

reference specific to a particular supervisory device, field trunk, and/or field controller.

For example, change the bound object reference for a Zone Temperature AI from ADS1:NAE1/N2 Trunk
1.VMA-1.ZN-T to *.ZN-T. This is your aliased graphic.
Note: One wildcard character is allowed per reference, and all wildcard characters used in bindings for a

particular aliased graphic must represent the same string.
3. Create a separate main graphic to use as the access point for your aliased graphic.
4. On the main graphic, add a button bound to the aliased graphic. Give the button a name indicating the field

device it represents (see Tip below).
5. Set the alias string for the button to the text that should replace the wildcard in the reference for the value boxes

on the aliased graphic.

For the example above, the alias string would be:

ADS1:NAE1/N2 Trunk 1.VMA-1
6. Repeat Step 4 and Step 5 to add buttons for additional field controllers, setting the alias string appropriately for

each.

For example, ADS1:NAE201/N2 Trunk 2.VMA-43.

Tip: You can use the following shortcut steps to quickly create the buttons for your aliased graphic on your
main graphic:

a. Display your main graphic in the Display panel, and click Edit.
b. Select the aliased graphic in the All Items navigation tree, then use Ctrl + click or Shift + click to select the

items to use with the aliased graphic.

For the example given earlier, select VMA-1 under N2 Trunk on NAE1, and VMA-43 under N2 Trunk 2 on
NAE 201.

c. With the aliased graphic and other items selected in the navigation tree, drag the Button from the UGT palette
into the graphic display area. A new button appears in the main graphic for each item. Each button is labeled
with the item name, bound to the aliased graphic, and has its alias string set to the full reference of the
selected item (for example, ADS1:NAE1/N2 Trunk 1.VMA-1).

d. Find the button on the main graphic that has its alias string set to the aliased graphic (labeled with the name
of the aliased graphic). This button is no longer needed, so you may delete it.

e. Save your changes.

Once you have finished configuring your main and aliased graphic, display the main graphic in the online UI. Use
the buttons on the main graphic to open the aliased graphic for each field device. See Figure 51 and Figure 52.

Saving a Graphic
To save a graphic, click the Save button on the Toolbar.
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Graphics+
Graphics+ files created with the Graphic Generation Tool (GGT) provide comprehensive and three-dimensional
views of building automation systems that allow you to monitor the status of a single building or an entire campus
of buildings. Unusual conditions are quickly identified on a dashboard screen that can navigate deeper into a building,
floor, or zone. With minimal navigation, you can diagnose a problem and take corrective action. You can view
historical data directly within the graphic, further enabling effective problem diagnosis. You can also issue commands
from the graphic.

Graphics+ files are created offline with the GGT, a stand-alone application that runs on a computer with a supported
Microsoft Windows operating system. These graphics are then saved as Metasys objects (typically on the Site
Director) and viewed within the Site Management Portal UI or Ready Access Portal UI in any active display panel.

Graphics are usually made up of three parts:

• one or more background images
• animated HVAC elements, ductwork or piping, and/or floor plan information
• buttons that allow you to navigate to other graphics, applications, and Web addresses

You can access a graphic when you are logged in to the Site Management Portal UI via any Web browser. The
XAML Graphic Object represents a Graphics+ object in the All Items navigation tree. You can open these graphics
in any active display panel.

For information about Graphics+ symbol and element functions, refer to the Graphics+ RuntimeHelp (LIT-12011708).

For information about creating and editing Graphics+ files, then saving the graphic to an online device (ADS, ADX,
or supervisory controller) or offline to an SCT archive database, refer to the Graphic Generation Tool Help
(LIT-12011697).

Graphics+ Concepts
Graphics+ View
Graphics appear in the navigation tree as stand-alone items. You can access graphics from a Tailored Summary,
the Alarm Pop-ups window, or the Associated Graphic tab of a Field Controller device. The symbol identifies a
Graphics+ graphic. When you open the graphic, a Display Control tool appears in the upper left corner of the active
display panel. Use the Display Control to zoom and pan a graphic. You can also open the Trend Module from this
control. See Figure 53 and Table 142 for details on the Display Control tool.
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Figure 53: Graphics+ Control Tool

Table 142: Components of Display Control Tool
DescriptionNameCallout
Hides the Display Control tool. After you hide the tool, a faint arrow
appears that allows you to restore the tool.

Collapse1

Zooms the graphic to fit in the frame.Fit to Window

(center block)

2

Allows you to zoom by moving the ball clockwise (zoom in) and
counterclockwise (zoom out) along the zoom ring.

Zoom Ball with Zoom Ring3

Enables and disables the panning tool that allows you to move the
graphic in the workspace.

Turn On/Off Panning4

Allows you to pan up, down, left, and right over the graphic in set
increments.

Move (four arrows)5

Displays the current zoom level.Current Zoom Level6

Enables and disables the manual zoom (magnifying glass) that allows
you to re-center the graphic and zoom in an out.

Turn On/Off Zoom Mode7

Drops down a list of Tools. At this time, only the Trend Module is
available.

Tools Menu8

Opens and closes the Trend Module. This option appears when you
click the Tools down arrow. See .

Trend9

Allows you to move the Display Control tool to a different area of the
graphic.

Move Display Control10
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Navigation
You can navigate between graphics using the linked images and navigation buttons or opening the desired graphic
from the navigation tree. You can restrict user access to specific graphics by setting security levels in the Security
Administrator System.

You can also create user views that contain only graphics (hierarchy of graphics references). See User Views for
more information.

Commands
You can command objects that are bound to graphic symbols using two methods. The first method is to left-click
the object’s Inline Command Box or Advanced Value Box, then edit the value of the object. If commanding is disabled
for that symbol, the value is not be editable. The second method is to right-click the object’s Inline Command Box
or Advanced Value Box to open the User Actions Panel, then select More Commands to bring up the Metasys
commands dialog box. With either method, if you are not authorized to command the object, the command selection
is disabled.

User Actions Panel
You can open the User Actions Panel for a graphic element by right-clicking the graphic element. The User Actions
Panel is a submenu of options that appears adjacent to the graphic element (Figure 54). The panel in the Site
Management Portal UI supports three actions: View, Command, and Trend (SCT only supports View; Trend only
appears for trended objects). To view the Focus window for the object, select its name (for example, ZN-SP). To
command the object, select More Commands. To view trend data for the object in the Trend Module, select View
Trend. If more than one attribute is trended, select View Trend, then click the attribute name. User access to all three
actions is set with security levels in the Security Administrator System.

Figure 54: Opening a User Actions Panel

Trend Module
From a Graphics+ object, you can view trended data for any object in the Site Management Portal UI with the Trend
Module. The object must be displayed in the graphic and have at least one trend extension defined. Examples of
graphic elements that support the Trend Module include any value box (for example, Basic Value Box, Inline Command
Box, and Key Data Item), any basic shape, the LCD display in the Room Control Module, gauges, and the Room
Status element. The Trend Module shows trend data from the device’s online buffer, not from archived samples
stored in a historical database.

Opening the Trend Module
To open the Trend Module for an object on a Graphics+ graphic, click View Trend from the element’s User Actions
Panel (Figure 55). The Trend Module appears with the charted trend data. If more than one trended attribute is
available, click View Trend to display a submenu that lists all available trended attributes. Click a trended attribute
to open the Trend Module.
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Figure 55: Selecting a Trend to Add to the Trend Module

If you want to open the Trend Module without adding or changing its content, click the Tools drop-down arrow on
the Graphics+ Display Control tool (Figure 56) and select Trend. The Trend Module reappears in its last state and
condition.

Figure 56: Reopening the Trend Module

For more details, see Trend Module Chart Functions and Trend Module Legend Functions.

Closing the Trend Module
You close the Trend Module by clicking the X in the upper right corner of the Trend Module screen.

Trend Module Chart Functions
See Figure 57 and Table 143 for explanations of the Trend Module chart components.
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Figure 57: Graphics+ Trend Module - Chart Functions

300Metasys System Online Help PDF



Table 143: Descriptions of Trend Module Chart Components
DescriptionNameNumber
Plots the trend data for all objects added to the Trend Module.Plot Area1

Zooms in for the area that is highlighted. To enable box zoom, place the cursor
inside the plot area, hold down the mouse and drag left or right. A white shadow
appears to outline the zoom area.

Box Zoom2

Indicates the name of the trended object with its value at the selected moment in
time (white vertical line).

Callouts3

Changes the size of the Trend Module to its maximum size within the constraints
of the Metasys display panel.

Maximize4

Removes the Trend Module from the screen.Close5

Returns the chart to its original size. This option is only available if the chart is
currently zoomed in.

Zoom Out6

Indicates the axis that is plotting the discrete states for objects currently displayed
in the Trend Module. Metasys objects that are displayed on this axis typically consist
of Boolean or multi-state values.

Right Y Axis

(state data)

7

Shifts the chart to display more recent trend data.Right Pan Arrow8

Displays date and time of the last value that appears on the chart.Newest Date/Time9

Indicates the date and time of the value at a particular location on the chart. The
date/time information as well as a vertical moment in time line is displayed as
you move the mouse over the chart. The units along the x-axis always represent
time.

Moment in Time

(X Axis)

10

Indicates the date and time of first sample that appears on the chart.Oldest Date/Time11

Shifts the chart to display older trend data.Left Pan Arrow12

Indicates the axis that is plotting the numeric values for objects currently displayed
in the Trend Module. Metasys objects that are displayed using this axis typically
consist of analog values.

Left Y Axis

(numeric)

13

Adjusts the range of data that appears on the chart. Also zooms in and out when
you resize the scroll bar. To zoom, click and drag the left/right arrows of the scroll
bar. To pan, drag the scroll bar left or right.

Scroll Bar14

Updates the trend data for all objects shown in the Trend Module.Refresh15

Trend Module Legend Functions
See Figure 58 and Table 144 for explanations of the Trend Module legend components.
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Figure 58: Graphics+ Trend Module - Legend Functions
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Table 144: Descriptions of Trend Module Legend Components
DescriptionNameNumber
Resizes the space taken by the legend. Move the splitter to the bottom
or double-click the splitter bar to hide the legend and increase the size
of the trend chart.

Legend Splitter Bar1

Display both the color and the y-axis that is used to display the trend
data for the trended object in this row of the legend. The legend color
assigned to an object matches its trended values in the chart, so that
you can correlate information between the legend and the chart.

Four preset trend line colors are used: blue, orange, violet, and white.
The colors cannot be customized. These icons are used:

The forward facing L indicates that the left y-axis is used for this
trend series, which displays numeric values.

The backward facing L indicates that the right y-axis is used for this
trend series, which displays state values.

Legend Icons2

Selects which objects currently appear in the chart. Click this box to hide
and unhide trend data.

Show/Hide Trend3

Displays the name for the trended Metasys object. When you click the
object name (or its row), the corresponding line in the chart is highlighted.

Object Name4

Displays the name of the trend that appears in the chart. If more than
one trend is available for this trended object, a drop-down box appears
from which to select.

Trend Name5

Navigates away from the Trend Module and the graphic and opens the
trend data for the attribute. If you are not authorized to view the object,
the navigate button is disabled.

Navigate6

Removes the trended object and its associated data from the Trend
Module.

Remove7

The Trend Module has the following characteristics:

Loading Indicator
A loading indicator ( ) appears in the chart area while the system is retrieving trend data.

Trend Module Repositioning
You can reposition the trend module anywhere within the graphic’s display panel, but not across panels in a
multiple-panel layout. To move the Trend Module, drag the title bar.

You can dock the Trend Module by dragging the module outside the panel boundary on the top, bottom, right or left
side of the Metasys display panel. The Trend Module does not support multiple monitors.

Zoom Operations
You can zoom in the chart by holding down the mouse and sliding across the chart (either to the left or to the right).
This action activates drag zoom. Zoom works for values on the x-axis, not values on the y-axis. To zoom out, click
the Zoom Out link that appears in the upper right corner on a zoomed chart ().

You can also zoom from the horizontal scroll bar by clicking and dragging on the ends of the scroll bar.

Legend Operations
Once the trend data is plotted, use the check boxes in the legend to hide or unhide trend values from appearing in
the chart. If you want to remove the trended object from the legend and the chart, click the remove ( ) button.

To highlight a specific trend object and its data, click on its name in the legend. This action sends the selected series
and its associated y-axis information to the foreground of the chart.

303Metasys System Online Help PDF



If you try to plot a trended attribute that was deleted or whose object is offline, its legend icon is blank and a user
message box appears (Figure 59).

Figure 59: User Message: No Trend Data Available

Trend Module Limitations
The limitations of the Trend Module are as follows:

• A maximum of 500 data points can be displayed for a single trended object. No data older than 2 years can be
displayed.

• The trend data originates from the device’s online buffer; samples stored in a historical database such as the
JCIHistorianDB archive database are not included.

• You can open only one Trend Module per graphic.
• The Trend Module can chart a maximum of four trended Metasys objects. If you try to plot a fifth object, a user

message box appears (Figure 60).
Figure 60: User Message Example: Full Trend Module
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• The Trend Module does not support nested trend extensions. For example, the Trend Module cannot chart
totalization extensions that contain a trend extension.

• You cannot save the Trend settings for later use. Once you close the graphic, you need to select the objects for
the trend module again.

Refresh Function
The Trend Module does not automatically refresh with new data samples. Use the refresh button to display the latest
trend data within the Trend Module.

Error Handling
If an error occurs while stored trend samples are retrieved (for example, the bound trend object does not exist or its
supervisory device is offline), the chart line for this trend series does not appear. The error message Could not
retrieve trend information appears as a tooltip for the existing legend item.

Graphics+ Steps
Viewing Graphics
To view a graphic, double-click or drag the Graphics+ object from the Navigation Tree into the Display Frame.

Monitoring and Commanding Items Using Graphics
Note: The Site Management Portal UI provides the capability to monitor and command the Metasys system from

a graphic.

To monitor your Metasys system using graphics:

1. Open a graphic to display the current status/state of system components.
2. Navigate through the system.
3. To command Metasys objects or items using graphics, right-click the graphic element to open the User Actions

Panel and click More Commands. Select from the available commands. To change the value of a Metasys object
or item from an inline command box, click inside the box, type a new value, and press Enter. For information on
the runtime behavior of a particular graphic element, refer to the Graphics+ Runtime Help (LIT-12011708).

Navigating Graphics
To navigate graphics, click the image or navigation button in the graphic to navigate to the linked graphic.

Opening the User Actions Panel from a Graphic
To open the user actions panel from a graphic:

1. Open a Graphics+ object to display the current status and state of system components.
2. Right-click the graphic element. The User Actions Panel that applies to the object appears. If no panel appears,

this element does not support the User Actions Panel. Supported elements include value boxes, room status
elements, the LCD display within a Room Control Module, basic shapes, and gauges.

3. Select an action.

Opening the Trend Module from a Graphic
Note: You can open the Trend Module from a User Actions Panel or from the Graphics+ Display Control tool.

1. Open a Graphics+ object.
2. To open the Trend Module from a User Actions Panel, right-click a graphic element to open its User Actions

Panel. Supported elements include value boxes, room status elements, the LCD display within a Room Control
Module, basic shapes, and gauges.

3. Click View Trend. If more than one trend is available, click View Trend, then select from the list of trended
attributes that appear in the submenu. The Trend Module loads and plots the trend data.

Note: If View Trend does not appear in the User Actions Panel, this object has no trend extension.
4. For more details, see Trend Module.
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5. To open the Trend Module from the Graphics+ Display Control tool, click the Tools drop-down arrow. The Trend
option appears.

6. Click Trend. The Trend Module appears either blank (no trend data selected) or replots the trend data for the
objects you selected earlier.
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Logic Connector Tool (LCT)
Use the Logic Connector Tool to create the logic within a control system using a graphical presentation. The control
logic may include System Blocks and Logic Blocks. The Edit Mode allows you to edit logic, and the View Mode
allows viewing and limited commanding capabilities. When running the LCT on the SCT (Metasys system in offline
mode), commanding is disabled.

The Logic Connector Tool allows control system viewing and editing via any browser logged onto any online or
configuration server with access to a Program (Control System) Object and Metasys system.

Logic runs approximately every 5 seconds. It is important that control applications that require particular timing use
internal logic to determine time between execution.

Note: You cannot insert logic on an ADS/ADX.

For information on installing an Engine, see the Related Documentation table.

Logic Connector Tool Concepts
Logic Connector Tool Workspace
The Logic Connector Tool runs inside an active display panel. The workspace for the Program (Control System)
Object defaults to a white background. You have the option to add a lined or dotted grid to the workspace using the
appropriate buttons on the Toolbar. The workspace displays all building blocks and the connections between them,
and serves as the destination for dragged and dropped blocks.

LCT Modes
The Logic Connector Tool runs in either Edit Mode or View Mode.

You can generate logic and make logic changes when you are using Metasys in offline mode (using the SCT) or
online mode. (See Metasys Modes.) After generating logic or making any changes to existing logic in offline mode,
download the database to the online device to ensure the latest information is used.

Edit Mode
Access Edit mode by clicking the Edit mode button (see Toolbar). You must be in Edit mode to edit logic or create
logic. The LCT opens in View mode.

In Edit mode, you have access to all toolbar items, System blocks, and Logic blocks.

Right-clicking in Edit mode brings up basic choices such as cut, copy, paste, delete, duplicate, hide, label, zoom,
and connect, depending on the type of item you select.

Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

For mouse shortcuts in Edit mode, see Mouse Shortcuts: Edit Mode.

View Mode
The Logic Connector Tool displays in the View mode when you are browsing a site running Metasys software in
offline mode (using the SCT) or online mode. (See Metasys Modes.) See Errors in View Mode.

In View mode, you have access only to a limited number of items on the toolbar. The System and Logic blocks do
not appear in this mode. The LCT opens in View mode. You must enter the Edit Mode to edit any of the control
system logic.

The View mode allows you to edit Program (Control System) Object attributes (from the Configuration tab) and send
commands to any of the input reference blocks in the diagram.

Dynamic values display on the connection line between two logic blocks. Values refresh every 15 seconds unless
you click the Refresh button on the Toolbar. Click the Trace mode icon on the toolbar and the tool displays online
values, but hides logical connections between blocks. If you click a block, the tool traces all connections to and from
that block (from the first input to the last output).

Right-clicking in View mode has no effect.

For mouse shortcuts in View mode, see Mouse Shortcuts: View Mode.
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Toolbar
The Logic Connector Tool uses the toolbar described here:

Table 145: LCT Toolbar
ActionVisible InCommandIcon

(Standard
Windows Icons not
Shown)

View ModeEdit Mode

Changes the control system to Edit mode.XEdit Mode

Refreshes the values for control system
components.

XRefresh

Saves the logic system and changes it to View
mode. If there are unconnected points, the logic
system warns to fix them prior to a save.

XSave

Cancels current changes and returns to View
mode.

XCancel

Print dialog appearsXXPrint

Print Preview dialog appearsXXPrint Preview

Cuts an item of the control system.XCut

Copies an item in the control system.XCopy

Pastes a cut or copied item into the logic
system.

XPaste

Undoes the previous action (except for a save)
for up to 4 actions.

XUndo

Redoes the previous undone action (for up to
4 actions).

XRedo

Removes the grid from the diagram.XNo Grid

Displays a line grid behind the diagram.XLines Grid

Displays a point grid behind the diagram.XPoints Grid

Turns the cursor into a selection cursor.XXSelect

Turns the cursor into a text cursor that allows
you to create a text box.

XText

Turns the cursor into a hand that allows you to
pan over the diagram by dragging.

XXPan

Zooms a selected area.X1XZoom

Zooms in and out on a diagram when you hold
the mouse down.

X1XInteractive Zoom

Zooms the diagram to fit within the window.X1XZoom - Fit Window

Removes all the connection lines in the
diagram. Live values remain.

X1Trace Mode
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Table 145: LCT Toolbar
ActionVisible InCommandIcon

(Standard
Windows Icons not
Shown)

View ModeEdit Mode

Allows you to select the percentage zoom
applied to the diagram.

X1XSelective Zoom

Checks the control system logic and places a
balloon with an icon over unconnected points.
See the Logic Checker section.

XLogic Checker

Shows the logical sequence order of the
connected blocks. A value of -1 indicates that
logic does not execute on the block.

XSequence (Show
Sequence Order)(123)

Shows an overview of the entire control system.XXOverview

1 When using a zoom tool in View mode, if you click outside of the display panel containing the logic system, the zoom level
automatically changes back to the default.

Logic
Logic contains the following components:

• System Blocks that reference another control system
• Logic Blocks that represent functions performed on objects
• Math Category between the Logic blocks

Once a logic process completes, it runs again in approximately 5 seconds. For example, if a logic process starts at
10:00:00 and completes at 10:00:04, it runs again at 10:00:09. It is important that control applications that require
particular timing use internal logic to determine time between execution.

If your logic references multiple Engines or multiple ADS/ADXs, and one device needs to be downloaded, upload
all Engine/ADS/ADXs prior to making changes in SCT. This procedure ensures your logic works consistently.

System Blocks
System blocks support drag and drop functionality. When you deposit a System block onto the workspace, a
configuration wizard guides you through the configuration of the control system. System blocks are useful when you
have complex logic because they allow you to nest one control system in another control system. When you create
a System block, the Metasys software creates a Program (Control System) Object under the first Program object in
the navigation tree.

See Adding Items to Logic.

Logic Blocks
Logic blocks support drag and drop functionality. If the list of Logic blocks is too long to fit into the Logic block list
area, use the scroll bar to expose additional blocks.

Logic blocks are not visible on the navigation tree. If the LCT window is not large enough to show all the logic blocks,
you cannot scroll down to see the hidden blocks. To make sure you see them all, enlarge the panel displaying the
logic by dragging the borders or reducing the number of panels.

See the following table for a list of Logic blocks.
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Table 146: Logic Blocks
DescriptionLogic Block Name
Performs mathematical functions on one or more inputs, producing a single output.

1–8 inputs

Math

Performs Boolean functions on 2–8 inputs, producing a single output. This category also includes the
Latch function.

Bool

Performs statistical functions on 2–8 inputs producing a single output.Statistical

Performs multiplexing for 2–8 inputs, producing a single output. Based on the current mode assigned
to each input, the selector chooses which input to pass through to the output.

Selector

Performs control functions on three inputs, producing a single output.Control

Performs psychrometric functions on the defined inputs, producing a single output.Psychro

(Psychrometric)

Gives the user the ability to expose values from within their control logic, either as an input or output.
These blocks are considered attributes of the Program (Control System) Object in which they are
included, and may be viewed or configured from the standard Focus view. A control system is limited
to a combination of 24 inputs and 24 outputs. See the Program (Control System) Object for more
information.

Attributes

Passes a constant value to building block inputs.Constant

Controls the amount an output can change per control system execution or extrapolates an output using
two inputs for reference.

Calculation

Passes its input to its output at the next execution of the control system (every 5 seconds). Timing
blocks are used to break up feedback loops. The Timing category also includes the Time and Timer
blocks.

Timing

Math Category
Math blocks perform calculations on input. See the following table for details.

Table 147: Math Blocks
InputsMath TypeBlock
2–8Multiply*

2–8Add+

2DivideX/Y

2SubtractX-Y

1NegativeNeg

1AbsoluteAbs

1Square RootSqr

1CosineCos

1SineSin

1TangentTan

1Arc TangentATan

1Arc CosineACos

1Arc SineASin

1ExponentExp

1Natural LogLN
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Table 147: Math Blocks
InputsMath TypeBlock
1LogLOG

2X^YX^Y

The number of inputs to a Math logic block depends on the number of inputs supported by the type of math function.
The Logic Connector Tool allows you to add multiple connections to the output of the block.

See Editing Blocks in Edit Mode for information on editing Math blocks.

Bool Category
Bool blocks apply Boolean functions to input. The number of inputs to a Bool logic block depends on the number of
inputs supported by the type of Boolean function. The Logic Connector Tool allows you to add multiple connections
to the output of the block.

Table 148: Bool Blocks
InputsBool Type
2–8AND

2–8OR

2XOR

1NOT

See LTCH (Latch) for details.LTCH

See Editing Blocks in Edit Mode for information on editing Bool blocks.

LTCH (Latch)
The Latch block holds a binary value until you command it to reset. Latch blocks help capture rapidly changing binary
states that might otherwise be missed. The Input of the Latch block is a binary attribute, sampled every time the
logic system runs (every 5 seconds). Use an Attribute Reference block to create the Input for Latch.

Reset determines if the Output of the block changes with a change in the value of the Input. When Reset is True,
the Output of the Latch block stays its original value, even if the Input changes value. Reset is also a binary attribute.
To change the value of Reset, double-click the binary attribute block in View Mode and issue an Inactive or Active
command.

This table translates the value of the Input or Reset binary attribute into True and False values for the Latch block:

Table 149: Latch Blocks
True or FalseCommand/StateBinary Attribute Value
TrueActive1.0

FalseInactive0.0

The following table and figure summarize the operation of the Latch block:

Table 150: Latch Block Operation
OutputResetInput
True

Even if the Input goes to False, the Output stays True as long
as Reset is False.

FalseGoes from False to True

FalseTrueGoes from False to True
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Table 150: Latch Block Operation
OutputResetInput
True

Even if the Input goes to True, the Output stays False as long
as Reset is False.

FalseGoes from True to False

FalseTrueGoes from True to False

Figure 61: Latch Block Example

Statistical Category
Statistical blocks perform statistics on input. The number of inputs to a Statistical logic block depends on the number
of inputs supported by the type of statistic. The Logic Connector Tool allows you to add multiple connections to the
output of the block.

Table 151: Statistical Block Connections
InputsStatistical Type
2–8AVG

2–8MAX

2–8MIN

See Editing Blocks in Edit Mode for information on editing Statistical blocks.

Selector Category
Selector logic blocks (Mux) have 2–8 inputs, one mode input, and one output. Depending on the current value of
the mode input, the Selector chooses which input passes through to the output. The Logic Connector Tool allows
you to add multiple connections to the output of the block.

See Editing Blocks in Edit Mode for information on editing Selector blocks.

Control Category
Most control logic blocks have three inputs, and you can add multiple connections to the output of the block. The
blocks compare input number 1 with input number 2 using the differential (input number 3). The type of control
depends on the statistical type. The Sequencer functions differently. See SEQ (Sequencer) for details.
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Table 152: Control Blocks
InputsStatistical TypeBlock
3greater thanX>Y

3less thanX<Y

3less than or equalX<=Y

3greater than or equalX>=Y

3not equal<>

3equal=

See SEQ (Sequencer) for details.SequencerSEQ

See Editing Blocks in Edit Mode for information on editing Compare blocks.

SEQ (Sequencer)
Sequencer blocks activate devices in a sequential order based on the rank of the device and whether the device is
enabled. Lower ranked devices are activated before higher ranked devices, and higher ranked devices are deactivated
before lower ranked devices.

The Input value at which the sequencer activates or deactivates each device is based on the make and break limits
configured for the Sequencer. See Editing SEQ (Sequencer) Blocks for information on configuring the make and
break limits. The defaults for a 3-stage Sequencer with a range of 0–100 are the following:

Table 153: SEQ (Sequencer Blocks)
Break Limits (Deactivation Points)Make Limits (Activation Points)
133Stage 1

3467Stage 2

6899Stage 3

Sequencer blocks can output a value for minimum of 2 and maximum of 8 devices. The following table describes
the components of a Sequencer block:

Table 154: Sequencer Block Components
DescriptionComponent
Determines the number of activated stages.Input

Determines if the Sequencer is enabled or disabled. Use a binary object attribute

(1.0=Enabled, 0.0=Disabled).

Instant Shutdown

Activates reordering of output sequence. The manner in which the outputs Device 1 Output through
Device 8 Output are reordered for activation is based on a combination of two factors: the ranking
defined for each device, and whether the device is enabled. All enabled outputs are scheduled for
output selection prior to disabled outputs. And, within each of these categories (enabled and disabled
outputs), the selections are ordered beginning with the lowest ranked and proceeding on through to
the highest ranked output. Unlike all other reordering scenarios, the issue of whether or not a device
is currently active is not taken into account in this situation.

Use a binary object attribute (1.0=Rotate now, 0.0=Do not rotate now).

Rotate Now

Establishes whether or not the output is enabled. Use a binary object attribute

(1.0=Enabled, 0.0=Disabled).

Device 1–8 Enable

Establishes the order in which device outputs are activated. Use an analog object attribute (reference
block) or a Constant block.

Device 1–8 Rank
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Table 155: Sequencer Block Example
True or FalseCommand/StateBinary Attribute Value
TrueActive1.0

FalseInactive0.0

See Editing SEQ (Sequencer) Blocks for information on editing Sequencer blocks.

Psychrometric Category
Psychrometric logic blocks have 2 inputs, and you can add multiple connections to the output of the block.

Table 156: Psychrometric Blocks
Lower InputUpper InputDescriptionSymbols
DPDBEnthalpy - Dew PointEN-DP (EnDp)

RHDBEnthalpy - Relative HumidityEN-RH (EnRh)

DPDBRelative Humidity - Dew PointRH-DP (RhDp)

WBDBRelative Humidity - Wet BulbRH-WB (RhWb)

DPDBWet Bulb - Dew PointWB-DP (WbDp)

RHDBWet Bulb - Relative HumidityWB-RH (WbRh)

RHDBAbsolute HumidityABH

RHDBDew PointDP

See Editing Blocks in Edit Mode for information on editing Psychrometric blocks.

Attributes Category
Attribute blocks let you expose values in your logic and configure inputs and outputs. Control systems can contain
a maximum of 24 inputs and 24 outputs.

Input and Output Attributes
In View Mode, a double-click on an Attribute Input or Output block has no effect. In the Edit Mode, when you drag
and drop an attribute block from the palette, configuration wizards launch to help you configure the attribute.

Attributes support a maximum of 24 input or 24 output blocks of Numeric, Enum, or Bool. Attributes expose values
at different stages of the Metasys system for a user to see at a glance or connect to/from.

See Editing Blocks in Edit Mode for information on editing Attribute blocks.

Note: Once an attribute is configured as Numeric, Enum, or Boolean, it cannot be changed.

Attribute Reference
After inserting an attribute reference (Input Ref or Output Ref), you can edit which object/attribute is being referenced.
See Editing Blocks in Edit Mode. If you double-click in View mode, a Command dialog box appears for Input refs
only.

Constant Category
Constant logic blocks can have multiple connections to the output of the block. Constant logic blocks can be any
one of the following:

Table 157: Constant Blocks
Statistical TypeBlock
EnumerationEnum

FloatFloat

Release

Note: Sends the Release command at a specific priority based on the connection.

Rel.
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See Editing Blocks in Edit Mode for information on editing Constant blocks.

Calculation Category

RL (Rate Limiter)
The Rate Limiter block controls the rate at which its Output changes with variations in its Input value. If rate limiting
is disabled, this block passes the value of the Input to the Output. If rate limiting is enabled, this block limits changes
to its Output to an increment determined by the Step Equation, executed according to the rate limit. This table
describes the components of the Rate Limiter block:

Table 158: RL (Rate Limiter Blocks)
DescriptionSymbol
InputIN

Enabled

Enables rate limiting. Use a binary object attribute reference for EN:

0 = Disabled (Inactive command)

1 = Enabled (Active command)

EN

Rate Limiter blocks use the Step Equation to determine the maximum increment (step) the Output can change to
match the Input if the two differ. The Step Equation recalculates the step every time system logic executes (every
5 seconds).

The Step Equation looks like this:

Step = Rate Limit/60,000 * Actual Period

Where:

Rate per minute to increase or decrease the Output until it matches the InputRate Limit:
Time in milliseconds since the last execution of the block. The system logic and Step Equation execute
every 5 seconds (5,000 milliseconds).

Actual Period:

For example, if the Rate Limiter block is set up like this:

Rate Limit = 10

Actual Period = 5,000 (milliseconds)

The Step Equation looks like this:

Step = 10/60,000 * 5,000

Step = .8

So, the maximum increment the Output can change on its way to match the Input is .8.

See Editing Blocks in Edit Mode for information on editing Rate Limiter blocks.

Span
The Span block applies a range and extrapolated values to an input to produce an output. This table describes the
Span block components:

Table 159: Span Blocks
DescriptionSymbol
InputIN

Input LowIL

Output LowOL
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Table 159: Span Blocks
DescriptionSymbol
Input HighIH

Output HighOH

The Span block creates a linear relationship between the low input/output and high input/output pair. If the Input for
the Span block falls between the low and high input, the Output of the Span block is found on the line between the
low and high pairs.

The following example shows a graphical picture of how the Span block works:

Figure 62: Span Block Example 1

The line connecting the low and high pairs (blue line) represents the linear relationship between them. When you
enter an Input for the Span block, the logic finds where the line crosses that input and provides the corresponding
output. (The output must lie on the thick blue line.) Using the figure above, if you enter 5 for the Span block Input,
the block would find 5 on the Input axis and provide an output of 5.5 because that is where the line crosses an Input
value of 5. (The green line shows this relationship.)

If the Span block is set up to Clamp (see Editing Span Blocks) the value of the Output, the Output of the block is
restricted to the range between (and including) the low and high Output you enter for the block. Range clamping is
the default setting. For example, assume you are using the values in the figure below and have clamping set to True.
If you enter an Input of 5, you still generate an Output of 5.5, because the original line crosses an Input of 5 at 5.5,
which is between 4 and 8 (low and high output). If you enter an Input of 12, you generate an Output of 8, because
where the original line crosses an Input of 12 is higher than the high output (see where thin blue and thin green lines
intersect). If clamping is True for both high and low, the output must lie on the newly drawn thick blue line.

Figure 63: Span Block Example 2
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The Span block works for the reverse span as well (if the Output High is lower than the Output Low). See Editing
Blocks in Edit Mode for information on editing Span blocks.

Timing Category
Delay blocks have one input and one output and are commonly used to break up feedback loops.

The Timing category also includes the TMR (Timer) and Time blocks.

See Editing Blocks in Edit Mode for information on editing Timing blocks.

TMR (Timer)
This table describes the components of the TMR blocks:

Table 160: TMR (Timer) Blocks
DescriptionOutput
InputIN

Reset. Cancels the timer. Reset does not apply to Minimum On or Minimum Off timers. Use a binary
object attribute for Reset (1.0=Reset Active, 0.0=Reset Inactive).

RS

The LCT contains five different types of timers. Each type uses a Duration (how long the timer is active) and unique
functions to generate an Output. The different types of timers are listed below. Click the name of the timer for a
description and figure of timer operation.

• Pulse Timer Function
• On Delay Timer Function
• Off Delay Timer Function
• Minimum On Timer Function
• Minimum Off Timer Function

For information on setting Duration and the type of Timer, see Editing Timing Blocks.

Pulse Timer Function
The following table and figures illustrate the function of the Pulse timer.

Table 161: Pulse Timer Function
DescriptionFeature
Goes active if the Input goes from low to high in two consecutive executions (logic executes every 5
seconds. The Pulse timer remains active for the amount of time specified in Duration, then goes to
inactive. High to low transitions do not activate this timer.

Activation

Stays high as long as the timer is active. After the Duration expires, the Output goes low at the next
logic execution.

Output

Cancels timer activity and makes the output low. If the Reset goes from high to low, the timer
re-evaluates the Input at the next low to high transition.

Reset

Captures a short pulse on a binary input and keeps the Output True long enough so that the logic can
react to it.

Example
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Figure 64: Pulse Timer Example 1
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Figure 65: Pulse Timer Example 2

Back to TMR topic.

On Delay Timer Function
The following table and figures illustrate the function of the On Delay timer.

Table 162: On Delay Timer Function
DescriptionFeature
Goes inactive in a low to high Input transition, depending on the state of the input during the duration
period. If the Input returns to a low state (inactive), the timing cycle is canceled and the Output remains
inactive. If the Input remains in a high state, the Output goes to the high state at the next execution of
logic.

In a high to low Input transition, the Output becomes inactive the next time the logic executes (logic
executes every 5 seconds).

Activation

See row above.Output

Cancels timer activity and makes the output inactive. If the Reset goes from active to inactive, the
timer re-evaluates the Input at the next low to high transition.

Reset

Delays the supply fan start 20 seconds after the return fan starts.Example
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Figure 66: On Delay Timer Example 1

Figure 67: On Delay Timer Example 2

Back to TMR topic.

Off Delay Timer Function
The following table and figures illustrate the function of the Off Delay timer.
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Table 163: Off Delay Timer Function
DescriptionFeature
In a low to high Input transition, the Output becomes active the next time the logic executes (logic
executes every 5 seconds).

Goes inactive in a high to low Input transition, depending on the state of the input during the duration
period. If the Input returns to a high state (active), the timing cycle is canceled and the Output remains
active. If the Input remains in a low state, the Output goes to the low state at the next execution of
logic.

Activation

See row above.Output

Cancels timer activity and makes the output inactive. If the Reset goes from active to inactive, the timer
re-evaluates the Input at the next low to high transition.

Reset

Keeps the fan running to purge the coils after a heating or cooling system is turned off. Off Delay is
useful when your building contains electrical heat and/or DX cooling.

Example

Figure 68: Off Delay Mode Example 1
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Figure 69: Off Delay Mode Example 2

Back to TMR topic.

Minimum On Timer Function
The following table and figures illustrate the function of the Minimum On timer.

Table 164: Minimum On Timer Function
DescriptionFeature
See row below.Activation

Goes active when there is a low to high Input transition when the timer executes (logic executes every
5 seconds). The Output remains active until the time specified in Duration passes AND the Input
returns to inactive.

Output

Has no effect on Minimum On timer.Reset

Keeps a chiller running for a minimum time after startup to stabilize equipment.Example
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Figure 70: Minimum On Timer Example 1

Figure 71: Minimum On Timer Example 2

Back to TMR topic.

Minimum Off Timer Function
The following table and figures illustrate the function of the Minimum Off timer.

Table 165: Minimum Off Timer Function
DescriptionFeature
See row below.Activation

Goes inactive when there is a high to low Input transition when the timer executes (logic executes
every 5 seconds). The Output remains inactive until the time specified in Duration passes AND the
Input returns to active.

Output
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Table 165: Minimum Off Timer Function
DescriptionFeature
Has no effect on Minimum Off timer.Reset

Keeps a chiller off from a minimum time after shutdown to equalize refrigerant.Example

Figure 72: Minimum Off Timer Example 1

Figure 73: Minimum Off Timer Example 2

Back to TMR topic.
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Time
A Time block has no configurable input because it extracts time and date information from the network. Network
time/date is set at the site director (see the NAE and ADS commissioning documents listed in the Related
Documentation table in the Welcome section for details on time management). The outputs of a Time block are six
time/date values:

Table 166: Time Blocks
FormatDescriptionOutput
0–23 (24-hour time)HourHH

0–59MinuteMM

four-digit yearYearYR

1–12MonthMO

1–31DayDA

1=Monday

2=Tuesday

3=Wednesday

4=Thursday

5=Friday

6=Saturday

7=Sunday

Day of the WeekDOW

Connections
Connection lines connect blocks in the logic. The LCT does not do a datatype check; that is, you can connect Boolean
and Constant values, and any other combination. But, the tool does not allow inputs to connect to inputs, or outputs
to outputs. The tool determines the connection line routing, and the only way to change the routing is to move the
blocks or use the hide feature.

Control Systems
Control systems are collections of subsystems and/or Logic Blocks that may be connected together.

General Logic Connector Tool Rules
Table 167: General LCT Rules

These Rules Apply:What Components Are You
Using?

What Are You Doing?

• Left-click to drag and drop blocks
• Block size is fixed
• Font size and type are fixed

All blocksMoving, Sizing, Typing

Connection Type Allowed:

• Output
• Input or Output
• Input, Output, or Both

Attribute Properties:

• Read Only
• Writable
• Prioritized Write

System blocksConnecting

All inputs should be connected for these Logic blocks. If you
attempt to save logic that is missing inputs, an error message
displays. You may save anyway or supply inputs where
necessary. We do not recommend saving with missing inputs.
In the Edit view, blocks with missing inputs have red input points.
When the inputs are connected, the connection point turns blue.

Math, Bool, Statistical, Selector,
Control, Psychrometric,
Calculation

Connecting
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Logic Checker
The Logic Checker is not the same logic check run with a LCT save. It must be selected from the Toolbar. The Logic
Checker scans the control system logic and reports any configuration issues it finds.

Table 168: Logic Checker
Message Text PositionMessage TextCondition
Top-center of the blockMissing Output ConnectionAn output is not connected.

Top-center of the blockMissing Input ConnectionAn input is not connected.

Top-center of a connection in the loopFeedback Loop Is PresentA feedback loop exists in the logic.

Top-center of the attributeAttribute Is Not ConnectedAn attribute is not connected.

Top-center of the attributeDuplicate Attribute NameDuplicate attribute name is defined.

Errors in View Mode
While in View Mode, the tool displays the status of System Blocks, references (Attribute Reference), and Math
Category. If any connection is unreliable, the tool inserts a red circle at the center of the connection. If you place
your cursor over the circle, the error condition appears as transparent text over the block. For example, the error
could be a write or offline error.

Printing
The Logic Connector Tool supports printing of the following paper sizes in either landscape or portrait orientation:

• Letter (8.5 x 11 in)
• Folio (8.5 x 13 in)
• Legal (8.5 x 14 in)
• Tabloid (11 x 17 in)
• A1
• A2
• A3
• A4
• A5

The Logic Connector Tool supports printing of just the existing control system.

Mouse Shortcuts
Use mouse shortcuts to speed up LCT use.

Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the LCT.

Table 169: Edit Mode Mouse Shortcuts
Right-ClickDouble Left-ClickSingle

Left-Click
Component

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing System
Blocks).

SelectSystem Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Math Blocks).SelectMath Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Bool Blocks)
(except for LTCH blocks).

SelectBool Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Statistical
Blocks).

SelectStatistical Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Selector
Blocks).

SelectSelector Block
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Table 169: Edit Mode Mouse Shortcuts
Right-ClickDouble Left-ClickSingle

Left-Click
Component

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Control
Blocks).

SelectControl Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Psychrometric
Blocks).

SelectPsychrometric
Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Attribute
Blocks: Input and Output).

SelectAttribute Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Attribute
Reference Blocks).

SelectAttribute
Reference Block

Cut, Copy, Paste, Duplicate, Delete,
Label

Lets you edit the block (Editing Constant
Blocks).

SelectConstant Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Calculation
Blocks).

SelectCalculation Block

Cut, Copy, Paste, Duplicate, DeleteLets you edit the block (Editing Timing Blocks)
(except for Time blocks).

SelectTiming Block

Hide, DeleteCalls up a box to set connection priority.SelectConnection:
Prioritized

Hide, DeleteHas no action.SelectConnection:
Non-Prioritized

Cut, Copy, Paste, Duplicate, Delete,
Properties

Opens the box for editing.SelectText Block

Cut, Copy, Paste, Duplicate, Delete,
Connect, Zoom (with subcategories)

Releases a connection if one is in progress.Select (drag to
lasso items)

Workspace

Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the LCT.

Table 170: View Mode Mouse Shortcuts
Right-ClickDouble Left-ClickSingle Left-ClickComponent
--SelectSystem Block

--SelectMath Block

--SelectBool Block

--SelectStatistical Block

--SelectSelector Block

--SelectControl Block

--SelectPsychrometric Block

--SelectAttribute Block

--SelectAttribute Reference Block

--SelectConstant Block

--SelectTiming Block

--SelectCalculation Block

--SelectConnection

---Text Block
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Logic Connector Tool Steps
Generating a Logic System (Overview)
To generate a complete logic system:

1. On the Insert Menu, select Control System. The Insert System wizard appears.
2. Follow the instructions. The Program (Control System) Object appears in the Navigation Tree.
3. Drag and drop the program/control system to the workspace. The LCT opens in View Mode.
4. Change to Edit mode (Changing LCT Modes) to add or edit items in the workspace.
5. Add symbol blocks (Adding Items to Logic) and add text blocks (Adding Text Blocks) to the workspace.
6. Connect the blocks (Connecting Blocks).
7. Edit blocks (Editing Blocks in Edit Mode).
8. Save the program/control system (Saving a Control System).
9. Download the program/control system to the online controller, if you created or edited the logic in offline mode

(using the SCT).

Note: You must create a unique name for each program/control system created under the same folder. You can
create programs/control systems with the same names as long as they are stored in different folders.

Note: When defining logic with scientific notation where the number of digits to the left of the decimal point is large,
the system extends the range of values displayed without scientific notation to include all values with an
absolute value less than 10 million and greater than or equal to one millionth (0.000001 <= |value| <
10,000,000.0).

Changing LCT Modes
To change from View Mode to Edit Mode, click the Edit mode button on the Toolbar.

To change from Edit Mode to View Mode, click the Cancel or Save button on the Toolbar.

Viewing Existing Logic
1. Browse to either an archive database or an online controller.
2. Drag and drop the desired Program (Control System) Object from the tree structure to the workspace. The Logic

Connector Tool opens in View Mode.

Adding Items to Logic
Drag and Drop
To add items to a control system using the drag and drop method:

1. In the Edit Mode of the LCT, left-click and drag an item from the left side of the tool view and drop it in the
workspace.

Note: If the item is a System block, a configuration wizard appears. Answer the questions to set up the new
object/system or create a reference to an object or control system.

Note: There is not interaction between the user navigation tree and logic.
2. Edit the block to match your needs. See Editing Blocks in Edit Mode.

Copy and Paste
Note: You can copy and paste existing objects into the workspace from the workspace only.

To add items to a control system using the copy and paste method:

1. Right-click an existing object and select Copy.
2. Right-click in the workspace and Paste the object.

Note: The copy and paste method supports copying and pasting of multiple blocks. To copy and paste more
than one block, hold down the Shift key while selecting blocks with the cursor or use the select tool to
lasso the blocks.
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Connecting Blocks
1. Make sure the Logic Connector Tool is running in Edit Mode.
2. Place the cursor over the starting connection point until it changes shape from an arrow to a magic wand and

click on the point.
3. Click on the ending connection point.

Note: If the connection is valid, the cursor is a magic wand. If the connection is not valid, a circle with an X
through it appears, and the tool does not connect the points.

Note: After you successfully connect two points, the line between them turns blue until you click somewhere
else in the workspace.

Note: You do not need to click the exact connection point. If you click in the block, the tool automatically creates
a connection to/from the nearest block’s connection point. To cancel the connection after clicking the first
block, click anywhere in the workspace.

4. The Priority Connection dialog box appears. Choose a priority from 1–16 (1 is the highest priority).

Note: To change the priority at a later time, you must delete the connection and reinsert it.

Re-Routing a Connection
1. Make sure the LCT is running in Edit Mode.
2. Place the cursor over an existing end connection point until the cursor changes into a cursor with lines protruding

from the tip.

Note: You may only move the destination point. To completely change the connection, seeDeleting Connections.
3. Click the connection point. The tool removes the connection.
4. Click a new connection point. The tool creates the newly routed connection.

Hiding Output Connections
1. Make sure the LCT is running in Edit Mode.
2. Place the cursor over the output connection point and right-click and a menu appears.
3. Select Hide from the menu. The tool removes all connections from the output and replaces the lines with numbered

symbolic representations of the connections.
4. To see the connections again, right-click the starting connection point and select Unhide.

Note: Double-click the hidden connection to label it. If multiple connections are from the same hidden input, it
is shown as Label: number where number is the number of connections.

Do not start labels with a number and then follow it with any of these characters: $ . - ,

Deleting Connections
1. Make sure the LCT is running in Edit Mode.
2. Select the connection and right-click.
3. Select Delete from the menu.

OR

1. Select the connection.
2. Press the Delete key on the keyboard.

Editing Blocks in Edit Mode
To edit blocks in Edit mode:

1. Enter Edit Mode (Changing LCT Modes).
2. See one of the following sections for information on the block you are editing.

Editing System Blocks
To edit System Blocks in Edit mode:
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1. Double-click a System block. The Expose Attributes dialog box appears.
2. Configure the inputs, outputs, and attributes of the subsystem.

Note: Select the Add button to add an attribute to configure. To remove attributes from the System, select the
check box next to one or more attributes and click the Remove button.

Note: To view the control system for the System block, drag and drop the control system from the Navigation
Tree to the Display Frame.

Editing Math Blocks
To edit Math blocks in Edit mode:

1. Double-click a Math block. The configuration dialog box appears.
2. Edit the fields and configure the number of inputs based on the selected type of logic.

Table 171: Math Block Configuration
DescriptionField
The number of inputs depends on the type of Math block you use. You cannot reduce the input count
lower than the number of current connections.

Input

Accepts changes.OK

Cancels changes.Cancel

Editing Bool Blocks
Note: LTCH (Latch) blocks are not editable.

To edit Bool blocks in Edit mode:

1. Double-click a Bool block. The configuration dialog box appears.
2. Edit the fields and configure the number of inputs based on the selected type of Boolean logic.

Table 172: Bool Block Configuration
DescriptionField
The number of inputs depends on the type of Bool block you use. You cannot reduce the input count
lower than the number of current connections.

Input

Accepts changes.OK

Cancels changes.Cancel

Editing Statistical Blocks
To edit Statistical blocks in Edit mode:

1. Double-click a Statistical block. The configuration dialog box appears.
2. Edit the fields and configure the type of statistical block and number of inputs.

Table 173: Statistical Block Configuration
DescriptionField
Allows you to switch between the statistical types.Type

You cannot reduce the input count lower than the number of current connections.Input

Accepts changes.OK

Cancels changes.Cancel

Editing Selector Blocks
To edit Selector blocks in Edit mode:

1. Double-click a Selector (Mux) block. The Selector Edit dialog box appears.
2. Edit the fields and configure the number of inputs, the enumeration set, and the mode for each input.
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Table 174: Selector Block Configuration
DescriptionField
The number of inputs determines the list of inputs.Input

Filters the enumeration set list based on the chosen category.Enum Category

When Enum Set changes, all modes are reset.Enum Set

Click the button and a dialog box appears that allows you to select which modes associate with each
input. In the dialog box, select the check box next to the desired mode(s). If a mode is already assigned
to another input, the mode appears dimmed. Select Default to select all modes for an input that are
not currently selected by any other input.

Input 1 Mode(s)

Click the button and a dialog box appears that allows you to select which modes associate with each
input. In the dialog box, select the check box next to the desired mode(s). If a mode is already assigned
to another input, the mode appears dimmed. Select Default to select all modes for an input that are
not currently selected by any other input. There is one of these per input (2–8).

Input 2 Mode(s)

Accepts changes.OK

Cancels changes.Cancel

Editing Control Blocks
To edit Control blocks in Edit mode:

1. Double-click a Control block. The configuration dialog box appears.

Note: See Editing SEQ (Sequencer) Blocks for Sequencer configuration information.
2. Edit the fields to configure the type of comparison.

Table 175: Control Block Configuration
DescriptionField
The Type of comparison performed by the block. This field defaults to what was dragged over, but may
be changed.

Type

Accepts changes.OK

Cancels changes.Cancel

Editing SEQ (Sequencer) Blocks
To edit SEQ (Sequencer) blocks in Edit mode:

1. Double-click a Sequencer block. The Sequencer dialog box appears.
2. Edit the fields to configure the sequencer.

Table 176: SEQ (Sequencer) Block Configuration
DescriptionField
Determines the number of binary outputs for the block.Outputs

Specifies the minimum time an output must be on before being deactivated to an off condition. When
an output is activated, a timer starts. Until the timer reaches the minimum time, the output cannot be
deactivated.

Min On Time

Specifies the minimum time an output must be off before being reactivated to an on condition. When
an output is deactivated, a timer starts. Until the timer reaches the minimum time, the output cannot
be activated.

Min Off Time

Defines the minimum time that must elapse between the sequential activation of Sequencer stages.Interstage On Delay

Defines the minimum time that must elapse between sequential deactivation of Sequencer stages.Interstage Off Delay
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Table 176: SEQ (Sequencer) Block Configuration
DescriptionField
The box next to Make/Break indicates if Proactive is selected and, when you click, launches the
Make/Break Dialog box.

In the Make/Break Dialog box:

• Default check box: Disables all make/break limit text boxes and uses the default values. The
default values are set so that each device is on for a proportional amount of time.

• Proactive check box: Disables the Stage 1 make/break limit boxes (because that stage is always
on) and shifts all the make/break limits down one stage.

• Make Limit: Turns on the stage when the input value to the block reaches this limit.
• Break Limit: Turns off the stage when the input value to the block decreases to this value.

Make/Break Limit Rules:

• The current stage make limit must be less than the next stage make limit.
• The current stage break limit must be less than the current stage make limit,

OR

the current stage make limit must be greater than the current stage break limit.
• The current stage break limit must be less than the next stage break limit.

Make/Break Limits

Accepts changes.OK

Cancels changes.Cancel

Editing Psychrometric Blocks
To edit Psychrometric blocks in Edit mode:

1. Double-click a Psychrometric block. The configuration dialog box appears.
2. Edit the fields and configure the elevation based on the selected logic type.

Note: If you double-click an ABH or DP block, the Unit Type field does not appear.

Table 177: Psychrometric Block Configuration
DescriptionField
Allows you to configure the current elevation of the site (in feet or meters).Elevation

Allows you to choose International System of Units (SI) or Imperial (IP) units.Unit Type

Accepts changes.OK

Cancels changes.Cancel

Editing Attribute Blocks: Input and Output
To edit Attribute blocks in Edit mode:

1. Double-click an attribute block.
2. Edit the fields and configure the input/output (see Editing Attribute Inputs and Editing Attribute Outputs).

Editing Attribute Inputs
Table 178: Attribute Input

DescriptionField
Name of the inputName

The units for the output.

This field only appears for floating inputs.

Units
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Table 178: Attribute Input
DescriptionField
Tells the Metasys software what precision to use when formatting data.

This field only appears for floating inputs.
Note: Display Precision is used in the Focus view of data, not the graphical view.

Display Precision

Set category determined by the user interface (either Two State or Multi State).

This field only appears for Enum inputs.

Enum Category

Set determined by the category selected in Enum Category.

This field only appears for Enum inputs.

Enum Set

This is checked if you want the attribute to trigger the control system to execute if its value changes by
more than the defined increment.

Trigger

Accepts changes.OK

Cancels changes.Cancel

Editing Attribute Outputs
Table 179: Attribute Output

DescriptionField
Name of the outputName

The units for the outputUnits

Tells the Metasys software what precision to use when formatting data.

This field only appears for floating outputs.
Note: Display Precision is used in the Focus view of data, not the graphical view.

Display Precision

Set category determined by the user interface (either Two State or Multi State).

This field only appears for Enum outputs.

Enum Category

Set determined by the category selected in Enum Category.

This field only appears for Enum outputs.

Enum Set

Accepts changes.OK

Cancels changes.Cancel

Editing Attribute Reference Blocks
To edit Attribute Reference blocks in Edit mode:

1. Double-click an Attribute Reference block. The Attribute Reference Edit dialog box appears.
2. Edit the fields and configure the object or attribute to which the block refers (Editing Attribute Reference Inputs

or Editing Attribute Reference Outputs).

Editing Attribute Reference Inputs
Table 180: Attribute Reference Input

DescriptionField
Enter a label here for the block.
Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

Label

Browses to the object to which the reference is linked. Leaving this field blank leaves a placeholder for a
future reference. The dragged object's name appears in this field and the object's attributes appear in the
drop-down list in the attribute field.

Object

The attribute to which the reference is linked. When you are configuring for an Input reference, the drop-down
list contains numeric attributes only.

Attribute
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Table 180: Attribute Reference Input
DescriptionField
Units for the attributeUnits

This is checked if you want the attribute to trigger the control system to execute immediately instead of
waiting for the next control system scan if the value changes by more than the defined increment. Otherwise,
the control system executes normally.

Trigger

Sets the increment.Increment

Accepts changes.OK

Cancels changes.Cancel

Editing Attribute Reference Outputs
Table 181: Attribute Reference Output

DescriptionField
Enter a label here for the block.
Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

Label

Browses to the object to which the reference is linked. Leaving this field blank leaves a placeholder for a
future reference. The dragged object’s name appears in this field and the object’s attributes appear in the
drop-down list in the attribute field.

Object

The attribute to which the reference is linked. When you are configuring an Output reference, the drop-down
list contains numeric, writable attributes only.

Attribute

Accepts changes.OK

Cancels changes.Cancel

Editing Constant Blocks
To edit Constant Category blocks in Edit mode:

1. Double-click a Constant block. One of two dialog boxes appears depending on the type of constant you select.

Note: There are no configurable parameters for the Rel. (Release) constant. When you double-click, nothing
happens.

2. Edit fields and configure the constant value (Editing Constant Enum, Editing Constant Float).

Editing Constant Enum
Table 182: Constant Enum

DescriptionCallout
Set category determined by the user interface (either Two State or Multi State).Enum Category

Set determined by the category selected in Enum Category.Enum Set

Set state determined by the set and set category.Enum

Accepts changes.OK

Cancels changes.Cancel

Editing Constant Float
Table 183: Constant Float

DescriptionCallout
The value of the float.Value

The units used by the float.Units

Accepts changes.OK

Cancels changes.Cancel
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Editing Calculation Blocks

Editing RL (Rate Limiter) Blocks
To edit RL (Rate Limiter) blocks in Edit mode:

1. Double-click a Rate Limiter block. The RL dialog box appears.
2. Edit the Rate Limit and Startup Value for the RL block.

Table 184: RL (Rate Limiter) Block Configuration
DescriptionField
Specifies the rate per minute to increase/decrease the Output until it matches the Input.Rate Limit

Specifies the initial value used when the block is enabled.Startup Value

Accepts changes.OK

Cancels changes.Cancel

Editing Span Blocks
To edit Span blocks in Edit mode:

1. Double-click a Span block. The Span dialog box appears.
2. Edit the fields to enable or disable clamping.

Table 185: Span Block Configuration
DescriptionField
Selects whether (True) or not (False) to clamp the Output at the Output High (OH). For more
information on clamping, see Span.

Clamp High

Selects whether (True) or not (False) to clamp the Output at the Output Low (OL). For more information
on clamping, see Span.

Clamp Low

Accepts changes.OK

Cancels changes.Cancel

Editing Timing Blocks
Note: Time (logic) blocks are not editable.

Editing Delay Blocks
To edit Timing Category blocks in Edit mode:

1. Double-click a Delay block. The Delay dialog box appears.
2. Edit the field to configure the delay.

Table 186: Delay Block Configuration
DescriptionField
Displays the initial value of the Delay block.Startup Value

Accepts changes.OK

Cancels changes.Cancel

Editing TMR (Timer) Blocks
To edit TMR (Timer) blocks in Edit mode:

1. Double-click a Timer block. The TMR dialog box appears.
2. Edit the timing functions of the block.
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Table 187: TMR (Timer) Block Configuration
DescriptionField
Specifies the length of the timer function in seconds. The range is 5–86,400 seconds.Duration

Determines the type of timer you use:

• Pulse
• On Delay
• Off Delay
• Minimum On
• Minimum Off

Setup

Accepts changes.OK

Cancels changes.Cancel

Adding Text Blocks
1. Click the Text icon on the Toolbar.
2. Click the workspace to select a location for the text. The text block appears.
3. Select the Select icon on the toolbar.
4. Double-click the text block to display the text editor. Edit the text and click OK.
5. Select the text block and drag the sides to resize the block.

Note: To edit the text, double-click the block. The block opens for editing.

Note: To change the text properties, right-click the text block and select Properties from the menu. You can
change the font (type, size, bold, italic, bold italic), text color, background color, and border visibility/color.

Note: Colon (:) and quote (“) characters cannot be entered by the user in this field.

Running the Logic Checker
To run the Logic Checker:

1. Select the Logic Checker icon from the Toolbar.
2. If the Logic Checker does not detect errors, a No Warnings Found dialog box appears. Click OK to return to the

logic.
3. If the Logic Checker detects errors, a Configuration Warnings Were Found dialog box appears. After you click

OK, the tool returns you to the logic with Information symbols over the warning elements.

Note: The Information symbols remain unless you ignore them and save the logic or fix the errors and run the
Logic Checker successfully.

Saving a Control System
To save a control system, click Save on the Toolbar. The LCT scans for logic errors.

Note: The logic check done with the Save command is not the same as the Logic Checker run from the toolbar.

Note: If inputs are missing, an error message appears asking if you want to continue with the save. Click No to
return to the logic. Click Yes to save anyway. We do not recommend saving with errors.

Printing a Control System
To print a control system, click the print icon on the Toolbar.
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Security Copy
Two types of database load wizards exist:

• the Manage Archive Wizard for uploading, downloading, and synchronizing archive (configuration) databases
• the Security Copy Wizard for restoring the Security System databases of Site Directors and other supervisory

devices

Both wizards use the ActionQueue (ActionQ) to initiate and monitor the load or restore process. The Security Copy
Wizard is described in this section. For information on the Load Wizard, see Database Uploading, Downloading,
Upgrading Device and Synchronization.

Use the Security Copy Wizards to restore security system databases of Site Directors and other supervisory devices.
The SCT archive database stores the security system database information.

Access this wizard by selecting Security Copy from the Tools Menu in the SCT (offline mode). The Security Copy
Wizard collects information necessary to perform the security database restore such as action type, device names,
and scheduled time. Once you complete the wizard, the restore commands are added to the ActionQ in the SCT.
The ActionQ initiates and monitors the process.

For more information on the ActionQ, see ActionQ.

For information on uploading, downloading, and synchronizing archive databases, see Database Uploading,
Downloading, Upgrading Device and Synchronization.

Security Copy Concepts
Security Copy Restore
The Security Copy Wizard restores the backup of the security system settings including all user and role definitions
stored in the SCT archive database to the selected device’s security database.

Security Copy Considerations
When using the Security Copy Wizard, keep the following considerations in mind:

• If you want to restore an Engine or ADS/ADX security database in an SCT, you must use the Security Copy
Wizard.

• If an SCT and ADS reside on the same computer, the security database is shared between them both and can
be restored using the Security Copy Wizard.

• If an SCT is not installed on an ADS, you cannot use the Security Copy Wizard to restore the SCT security
database.

Security Copy Steps
Restoring Security Databases
Note: You must be in offline mode to load databases.

Note: After restoring a security database on an Engine only, the password for the MetasysSysAgent or
BasicSysAgent user resets to the default password, and must be manually restored. See Step 3. (The
MetasysSysAgent user password does not reset to the default password for an ADS/ADX.) See the Related
Documentation table in the Welcome section to find information on user accounts, passwords, and security.

Important: Before restoring a security database, verify that the Item Reference of the device in the SCT matches
(case-sensitive) the Item Reference of the same device in the online mode.

Important: To successfully restore an ADS security database, create and assign users and roles that have the
System Administrator permission on the ADS and the SCT. Then on the SCT, restore the ADS security
database. If the ADS user does not have this permission, that user cannot successfully perform the
restore.

1. Select Security Copy from the Tools Menu in the SCT. The Security Copy Wizard appears. See Wizards for help
on using wizards.
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2. Follow the wizard instructions. See the following table for tips. The ActionQ appears after clicking Finish on the
Summary screen of the wizard. See the ActionQ Help for information on monitoring the progress of the restore.

3. After restoring a security database on an Engine only, log on to the Site Director Engine as theMetasysSysAgent
or BasicSysAgent user and change the password as desired using the Change Password option from the Tools
menu. The password you select must meet the requirements for complex passwords. For details, refer to the
Network and IT Guidance for the BAS Professional Technical Bulletin (LIT-12011279).

Table 188: Security Copy Wizard Tips
TipsWizard Screen
• A list of devices that have backed up their security databases appears.
• Select one source device that has the security database you want to restore to one or more

devices.

Select Source

• Select one or more devices for which you want to restore the security database.
• Use the Ctrl or Shift keys to select multiple items.

Select Devices

• Select either the Perform Operation Now or Schedule Operation radio button.
• If you select Schedule Operation, use the date, hour, and minute menus to select the date and

time for the restore.

Note: If you schedule multiple restores to begin at the same time, some restores may not begin
at the specified time because they are waiting for others to complete. You cannot define
a restore order for devices scheduled together. If you must restore a certain device first,
schedule that device separately with an earlier restore time.

Schedule Operation

• Select the Communicate via Site Director check box if the device is not on the LAN. Only use
this option if necessary because it slows down the restore process.

• Enter the Username and Password for logging on to the Site Director to perform the restore.
• Click the Test Login button to test if the Username and Password entered allow you to

communicate with the device. The device must be online to perform this test successfully.

Note: If the SCT Username and Password do not match the Site Director or the destination
device Username and Password, the restore fails and returns an Authorization Failure
error. You must enter the correct Username and Password on this screen.

Note: Active Directory users may not be used to log on to the site.

Site Login

• Enter the number of times you want to retry the restore if communication failure occurs.Specify Retries

• View the final information for the restore and click Finish.Summary
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Database Uploading, Downloading, Upgrading Device and
Synchronization
Two types of database load wizards exist:

• the Manage Archive Wizard for uploading, downloading, and synchronizing archive (configuration) databases
• the Security Copy Wizard for restoring the Security System databases of Site Directors and other supervisory

devices

Both wizards use the ActionQ (ActionQueue) to initiate and monitor the load or backup/restore process. The Manage
Archive Wizard is described in this section. For information on the Security Copy Wizard, see Security Copy.

Use the Manage Archive Wizard to download, upload, and synchronize archive databases. Access the Manage
Archive Wizard by selecting Manage Archive Archive from the Tools Menu in offline mode. The Manage Archive
Wizard collects information necessary to perform the load such as load type, controller names, and load time. Once
you complete the wizard, the load commands are added to the ActionQueue in the SCT. The ActionQ initiates and
monitors the load.

Note: When a computer running the SCT is restarted, the SCT application shuts down until a user logs on to the
application again. If a load is scheduled and the computer running the SCT is restarted, the load does not
start until a user logs on to the SCT application again. Logging on to the SCT restarts the application and
automatically starts any scheduled loads.

There are four types of actions:

• Upload
• Download
• Synchronize
• Upgrading Device

For more information on the ActionQ, see ActionQ.

For information on restoring security databases, see Security Copy.

Database Uploading, Downloading, Upgrading Device and Synchronization
Concepts
Upload
The Manage Archive Wizard Upload option transfers a copy of the engine or ADS/ADX archive database into the
archive database of the SCT. Perform an upload to update the SCT archive database with changes made in the
online mode. The engine or ADS/ADX database overwrites the SCT archive database for the device being loaded.
The direction of an upload is from the engine or ADS/ADX to the SCT. Figure 74 and Table 189 describe the upload
process.

Note: When uploading an NCE, the archive database and the local application (Controller Application File, .caf file)
automatically upload. To perform successful NCE uploads, you must first add the Controller Application File
(.caf file) as a Resource File extension of the NCE using the Resource File wizard. For details, see Resource
File Extensions.

Note: To ensure recent online changes are captured during an upload, manually archive the device (Actions >
Commands > Archive) and then upload. The archive function moves data from the engine RAM to its nonvolatile
memory, from which it then can be uploaded. Do not confuse the archive function within the engine with the
archive database that is in SCT.
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Figure 74: Upload Process

Table 189: Upload Process
Process DescriptionNumber
After configuring an upload in the Manage Archive Wizard, the Manage Archive Wizard sends the upload
command to the ActionQ feature in the SCT.

1

The ActionQ locks the engine or ADS/ADX in the archive database. See Database Locking.2

1. The ActionQ begins the upload process at the time defined for uploading the engine or ADS/ADX database.
2. The engine or ADS/ADX creates an archive file of its database.

3

1. The ActionQ transfers the engine or ADS/ADX archive file to the SCT archive database.
2. The ActionQ replaces the existing archive database with the engine or ADS/ADX archive file.

4

1. The ActionQ unlocks the engine or ADS/ADX in the archive database.
2. The ActionQ displays the final status of the upload.

5

Download
The Manage Archive Wizard Download option transfers a copy of the SCT archive database into the engine or
ADS/ADX database. Perform a download to send the changes made in the SCT database to the engine or ADS/ADX
database. The SCT archive database overwrites the engine or ADS/ADX database. At the end of the download, the
engine or ADS/ADX restarts and does not control or monitor the system until the restart is complete. The following
figure and table describe the download process.

Note: When downloading an NCE, you can download the archive database and/or the local application (Controller
Application File, .caf file). To perform a successful download of the local application, you must first add the
Controller Application File (.caf file) as a Resource File extension of the NCE using the Resource File wizard.
Then, when you are ready to download the application, select the Local Application option on the Load Type
screen of the Manage Archive Wizard. For details, see Resource File Extensions.
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Figure 75: Download Process

Table 190: Download Process
Process DescriptionNumber
After configuring a download in the Manage Archive Wizard, the Manage Archive Wizard sends the download
command to the ActionQ in the SCT.

1

1. The ActionQ locks the engine or ADS/ADX in the archive database. See Database Locking.
2. The ActionQ polls for progress during the download process.
3. The ActionQ begins the download process at the time defined for the download.

2

The ActionQ transfers the SCT archive database file to the engine or ADS/ADX database.3

1. The ActionQ unlocks the engine or ADS/ADX in the archive database.
2. The ActionQ displays the final status of the download.

4

Synchronize
Note: Read this section thoroughly before using the Synchronize feature to fully understand the implications of

synchronizing databases. We recommend that you create a backup of the SCT database before proceeding
with a synchronization.

The Manage Archive Wizard Synchronize option synchronizes an engine or ADS/ADX database with the SCT archive
database. In synchronization, changes made since the last load process in the online database merge with changes
made in the SCT database since the last load process, resulting in two databases that contain the same information.
One of the benefits of the Synchronization feature is that the engine and ADS/ADX do not have to restart after the
synchronization is complete.

If changes made since the last load process conflict, the SCT data supersedes the engine or ADS/ADX data. For
example, if a Relinquish Default attribute of a setpoint is changed to 77° in the SCT and the same attribute is changed
to 78° in the engine or ADS/ADX device, the attribute after synchronization is set to 77° in both databases.

Note: The UI does not indicate where discrepancies exist between the SCT data and the engine or ADS/ADX data.
Use care when using the synchronize option.

341Metasys System Online Help PDF



Note: When synchronizing an NCE, the load only synchronizes the database. The local application (Controller
Application File, .caf file) is not part of the synchronization process.

See Table 191 for examples of synchronization scenarios.

Table 191: Synchronization Scenarios
Final Result after SynchronizationChange in Device1Change in SCT

Object is deleted from both databases.No ChangeDelete an Object

Object is deleted from both databases.Delete an ObjectNo Change

Object is added to both databases.No ChangeAdd an Object

Object is added to both databases.Add an ObjectNo Change

Attribute value is changed in both databases.Edit an AttributeNo Change

Attribute value is changed in both databases.No ChangeEdit an Attribute

SCT attribute value is used in both databases.Edit Same Attribute to a Different
Value

Edit an Attribute

The FEC with an address of 11 is added to both
databases.

Add an IOM to the Same FC Bus with
an Address of 11

Add an FEC to the FC Bus with
an Address of 11

The databases stay the same as they were prior to the
synchronization attempt.
Note: Structural errors like this cause the

synchronization process to fail with an error.

Delete the XYZ FolderAdd Object to the XYZ Folder

1 This is most commonly done from the online device UI.

Figure 76 and Table 192 describe the synchronization process.

Figure 76: Synchronize Process

342Metasys System Online Help PDF



Table 192: Database Synchronization Process
Process DescriptionNumber
After configuring a synchronization load in the Load Wizard, the Manage Archive Wizard sends the
synchronization command to the ActionQ in the SCT.

1

1. The ActionQ locks the engine or ADS/ADX in the archive database. See Database Locking.
2. The ActionQ polls for progress during the synchronization process.

2

1. The ActionQ begins the synchronization process at the time defined for the load by uploading the engine
or ADS/ADX database into the SCT archive database. See the Upload section.

2. The SCT archive database saves a copy of the engine or ADS/ADX database, then rebuilds the engine
or ADS/ADX database using the new file.

3. The SCT archive database applies all changes from the engine or ADS/ADX database to its own archive
database.

4. If structural errors are detected, the saved copy of the original engine or ADS/ADX database is restored
to the engine or ADS/ADX, an error message appears, and the engine or ADS/ADX and SCT databases
remain unchanged.
Note: A structural error is a change made to one database that invalidates the other database. For

example, a structural error occurs if you add an object to a folder in the SCT, but delete the
corresponding folder online from the engine or ADS/ADX database.

5. If structural errors are not detected, the ActionQ continues by downloading the new file from the SCT
to the engine or ADS/ADX database. See the Download section. However, the engine or ADS/ADX
applies the changes from the new file to the database and goes through the startup process without
resetting.

6. The ActionQ unlocks the engine or ADS/ADX in the archive database.
7. The ActionQ displays the final status of the synchronization.

3, 4

Database Locking
After scheduling a load, the archive database for that device is locked in the SCT until all loads for that device have
completed or are deleted. Only the device being loaded is locked. You can still access devices that have no scheduled
loads.

If you need to edit the archive database in the SCT for a device with a scheduled load (locked device), you can still
delete the load to clear the lock. After making your changes, you can schedule the load again.

Upgrading Device
The Manage Archive Wizard upgrade device option upgrades the version of a supervisory device within the Archive
database. If the site director is not already upgraded, include it to allow upgrades to the current SCT Version. You
may schedule the load for later by selecting the Schedule upgrade radio button and entering a date and time.

Table 193: Upgrade Device Process
Process DescriptionNumber
After configuring an upgrade device in the Manage Archive Wizard, the Manage Archive Wizard sends the
upload command to the ActionQ feature in the SCT.

1

The ActionQ locks the engine or ADS/ADX in the archive database. See Database Locking.2

1. The ActionQ begins the upload process at the time scheduled in the upgrading device wizard.
2. The supervisory device within the Archive database is upgraded. If the site director is upgraded, it will

also allow upgrades to the current SCT Version.

3

The ActionQ displays the final status of the upgrade device.4
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Database Uploading, Downloading, Upgrading Device and Synchronization
Steps
Uploading, Downloading, Upgrading Device or Synchronizing a Database
You must be in offline mode to load databases.

Important: Before uploading, downloading, upgrading device or synchronizing a database, verify that the Item
Reference of the device in the SCT matches (case-sensitive) the Item Reference of the same device
in the online mode.

Important: During a load, the database files are sent to:
• Windows XP OS: C:\Documents and Settings\All Users\Application Data\Johnson

Controls\MetasysIII\download
• Windows 7 OS, and Windows Server 2008 OS: C:\ProgramData\Johnson

Controls\MetasysIII\download)

This location string and the item reference string make up the file name string. If the entire file name
string exceeds the 256 character limit, the load fails.

For example, if you are downloading NAE-1, the location of the download files is:

• Windows XP OS and Windows Server 2003 OS: C:\Documents and Settings\All Users\Application
Data\Johnson Controls\MetasysIII\download\NAE-1NAE-1\*.*

• Windows 7 OS: C:\ProgramData\Johnson Controls\MetasysIII\download\NAE-1NAE-1\*.*

This location string is already 102 characters long. If the location string and the item reference string
(*.*) exceed the 256 character limit for the entire file name string, the download fails.

Note: If you change names in your system, we recommend using the upload or download process. If you add or
delete points, use the upload, download, or synchronize process.

To upload, download, upgrade device or synchronize a database:

1. Select Manage Archive from the Tools Menu. The Manage Archive Wizard appears. See Wizards for help on
using wizards.

2. Follow the wizard instructions. See Table 194.

The ActionQ appears after clicking Finish on the Summary screen of the manage archive wizard. See ActionQ
for information on monitoring the load.

Note: If the download freezes with the load status of Establishing Communications, and no error message
appears, wait a reasonable amount of time to allow the download to complete. Then, refresh the SCT
display to update the screen. The updated status message appears when the download completes. The
amount of time it takes to download depends on the size of the database, but is usually a few minutes.
In addition, you can determine that the database downloaded properly by waiting for the device to come
online after the download completes.

Note: When synchronizing databases, make sure the SCT computer remains running and online until the
synchronization process completes. This action helps to prevent failures such as duplicate device
databases. See the Troubleshooting section for more information on this problem.
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Table 194: Manage Archive Wizard Tips
TipsWizard Screen
• Select the radio button for the type of load: Synchronize, Upload From Device, Download To

Device or Upgrade Device.
• Select the desired Options check boxes to download the Supervisory Device (archive database)

and/or the Local Application (Controller Application File, .caf file). For an NCE, the load
automatically pulls the archive database and application during an upload.

To perform successful NCE uploads and downloads, you must first add the Controller Application
File (.caf file) as a resource file of the NCE using the Resource File wizard. For details, see Resource
File Extensions.

Note: When synchronizing the NCE, the load only synchronizes the database. The application file
is not part of the synchronization process.

Load Type

• Select one or more devices to upload, download, upgrade device or synchronize.
• Use the Ctrl or Shift keys to select multiple items.

Note: If upgrading device, if the site director is not already upgraded, include it to allow upgrades
to the current SCT Version.

Select Devices

• Select either the Upload/Download/Synchronize/Upgrade now or Schedule
upload/download/synchronize/upgrade radio button.

• If you select Schedule upload/download/synchronize/upgrade, a date and time selector appears.

Note: If you schedule multiple loads to begin at the same time, some loads may not begin at the
specified time because they are waiting for other loads to complete. You cannot define a
load order for devices scheduled together. If you must load a certain device first, schedule
that device separately with an earlier load time.

Load Schedule

• Enter the Username and Password for the load.
• Click the Test Login button to test if the Username and Password entered allow you to

communicate with the device. The device must be online to perform this test successfully.
• Click the Communicate via Site Director check box if the device is not on the LAN.

Note: If the SCT Username and Password do not match the Site Director or the destination device
Username and Password, the load fails and returns an Authorization Failure error. You must
enter the correct Username and Password on this screen.

Note: Active Directory users may not be used to log on to the site.

Site Login

Enter the number of times you want to retry the load if communication failure occurs.Specify Retries

• Appears only in the Upload Wizard.
• To repeat the upload automatically, enter the number of days between uploads. Enter 0 if you

do not want to repeat the load.

Note: Use this option only if all changes are being made online to the engine or ADS/ADX database.
The engine or ADS/ADX is always locked in the SCT archive database because once a
scheduled load completes, another load is automatically scheduled. You can delete all
scheduled loads for the engine or ADS/ADX to clear the database lock. See Database
Locking.

Repeat Upload

• Appears only in the Download Wizard when only one device is selected for download.
• To change the Name and Computer Name of a device during the download, click Use this

option to rename a device via download and enter the new name in the text box.
• To change the address of a device during the download, click Use this option to change a

device address via download and enter the new address in the text box.

Note: You cannot use this Device Change option to change the name of an ADS/ADX. The name
of the ADS/ADX object is the same as the computer host name. To change the name of the
ADS/ADX object you must change the name of your host computer, then reboot your
computer.

Device Change

View the final information for the load or upgrade and click Finish.Summary
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Simulation
Simulation allows you to test the system logic created for an Engine when the Metasys system is offline. With
Simulation mode, you can enter commands and see how an online system would react if commanded to do the
same action. The Simulation mode uses the same Site Management Portal User Interface and command features
of the online system.

Simulation Concepts
Simulation
You must be running the System Configuration Tool (offline) to use Simulation. You cannot run Simulation on the
same PC as an ADS/ADX because the ADS/ADX is part of the online system. Simulation supports the simulation
of one Engine on one site, and if you attempt to start a second simulation, the first simulation must be stopped.

In Simulation mode, you can perform tasks including:

• viewing a control system created using the Logic Connector Tool (LCT)
• simulating Inputs/Outputs (I/O)

Simulation offers menu choices different from those available in other modes (the Edit, Insert, and Tools menus are
not available). Simulation does not support moving logic or items from within the simulated system to the archive
database or online system.

Simulation runs in a new browser window labelled Metasys Simulation in the title bar of the browser. Only the
information for the simulated device appears in the simulation session (not the entire site).

Inputs/Outputs
In Simulation, you can manually override and command the simulated I/O objects. Typically, the I/O objects are
integrated into a Logic system, Program (Control System) Object, or a Graphic.

Refresh
When you make changes to a simulated device, the changes become part of the simulated device immediately,
without the need for a refresh.

Simulation Steps
Starting a Simulated Session
1. In the All Items Navigation Tree, select the Engine you want to simulate.
2. On the Action Menu, click Start Simulation.

or

Right-click the Engine you want to simulate in the All Items navigation tree and select Start Simulation from the
menu.

Note: When you start a simulation session, a new Web browser window opens that can be closed immediately
while the user interface for Simulation loads.

Stopping a Simulated Session
To stop a simulated session, click the Exit button in the upper right corner of the Simulation screen.

Note: Be sure to also exit the Web browser window that was used to start Simulation.
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ActionQ
The ActionQ (pronounced Action Queue) receives time consuming commands such as an upload or download from
wizards, allows you to edit and monitor the commands, and sends the command information to the SCT for scheduled
execution. You can only access the ActionQ from the View menu in the offline mode (SCT).

For more information on the load process, see Database Uploading, Downloading, Upgrading Device and
Synchronization.

ActionQ Concepts
ActionQ Operation
The ActionQ shows the status of commands and allows you to monitor, enable or disable, delete, and reschedule
commands. See the ActionQ Interface section. The ActionQ receives a command from a wizard and executes the
command based on the date, time, and other specified parameters.

The order of operation is as follows:

1. The ActionQ receives a command from the Manage Archive Wizard wizard.
2. The ActionQ initiates the command (for example, starts the upload process).
3. The ActionQ interface displays the progress and final status of the command.

Note: The final status remains on the ActionQ screen until you delete it or it is automatically deleted after a
user-defined number of days (1–30).

Note: At this time, the ActionQ only supports upload, download, upgrade device and synchronization commands
from the Manage Archive Wizard.

ActionQ Interface
The ActionQ contains three main screens.

Table 195: ActionQ Screens
DescriptionScreen
Allows you to view active, scheduled, and completed commands. This screen is the main screen
of the ActionQ interface and has three tabs:

• Actions in Progress - Allows you to monitor, enable/disable, delete, and reschedule commands
that are in progress or pending.

• Scheduled Actions - Allows you to view, enable/disable, delete, and reschedule upcoming
scheduled commands.

• Completed Actions - Allows you to view the status of completed commands, reschedule
commands, and clear them from the screen.

Note: A command is pending when it has not been issued because the recipient device is busy
as a result of too many incoming commands.

Note: Once a command is issued, it may be complete before a command to disable, delete, or
reschedule reaches it.

ActionQ

• Allows clicking the Reschedule button from the Action in Progress, Scheduled actions, or
Completed Actions tabs of the ActionQ main screen.

• Allows you to edit the scheduled start date and time of a command.

Note: If you schedule multiple commands to occur at the same time, not all commands may begin
at the specified time because they are waiting for other commands to complete.

ActionQ Reschedule a
Command Dialog Box

• Appears after clicking the View Status button from the Completed Actions tab of the ActionQ
main screen.

• Allows you to view the completion information of a command, such as destination, start time,
end time, final status, error status, and any additional information.

ActionQ View Status
Dialog Box
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ActionQ Steps
Launching the ActionQ
Note: You must be in offline mode (SCT) to access the ActionQ. The ActionQ automatically launches after the Load

Wizard completes.

To launch the ActionQ Interface, select ActionQ from the View menu.

Enabling/Disabling a Command
1. Launch the ActionQ and select either the Actions in Progress tab or the Scheduled Actions tab.
2. Click the command.
3. Click Enable or Disable.

Rescheduling a Command
1. Launch the ActionQ and select a tab.
2. Click the command.
3. Click Reschedule. The ActionQ Reschedule a Command dialog box appears.
4. Edit the date and time using the drop-down menus.
5. Click OK.

Viewing the Status of a Command
1. Launch the ActionQ and select the Completed Actions tab.
2. Click the command.
3. Click View Status. The ActionQ View Status dialog box appears.
4. Click OK to return to the ActionQ screen.

Deleting a Command
1. Launch the ActionQ and select a tab.
2. Click the command.
3. Click Delete.

Automatically Deleting Completed Commands
1. Launch the ActionQ and select the Completed Actions tab.
2. Enter the desired amount of days in the Number of days after which entries will be automatically deleted

(1–30) text box.
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Diagnostics
Diagnostics help you discover problems with your Metasys system. The following areas have diagnostic information
available:

• Hardware (found under Diagnostics tab of an object)

- N2, N1, and BACnet trunk statistics or other integration type statistics
- NAE and NxE (all engine types) statistics
- ADS/ADX communication statistics
- Field device statistics
- BACnet Protocol Engine statistics per NxE
- Ethernet IP Datalink statistics per NxE

• software

- error logs viewed through Audit Trails
- unbound/duplicate references (Engine Device Object)
- events viewed through Alarm and Event information
- trends viewed through Trend Studies and Trend Extensions

For Ethernet statistics and task-utilization data, use off-the-shelf diagnostic tools. Refer to the manuals shipped with
these tools for more information.

For more information on diagnostics, see Displaying Diagnostic Data.

Diagnostics Steps
Displaying Diagnostic Data
1. Drag and drop the object you want diagnostic data on over to the display frame.

2. Click the diagnostic tab. Diagnostic data appears.

For example, see the Diagnostic tab table in the Attributes section of the following objects for more information:

• NAE Object (Engine Device Object)
• N2 Trunk (N2 Master Datalink Object (N2 Trunk))
• NCM Object
• BACnet Integration Object ( Execution Time attribute)
• BACnet Protocol Engine Object
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Energy Optimization
Energy Optimization features, when properly applied and configured for your facility, enable you to reduce energy
usage.

For more information on the Optimal Start object and Energy Optimization, see Optimal Start Object.
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Object Help
The Object Help describes each object in the system, the attributes of the objects, and the characteristics and
functions of each attribute. The Object Help provides detailed information to aid in creating objects, entering values
for configuring attributes, understanding how to read attributes, and defining the interaction between objects via the
attributes.

Object Help Concepts
Objects
Objects are self-contained functional items in the Metasys system that contain processes to manage building
automation system components. Objects appear as items in the Navigation Tree that shows the hierarchical physical
or logical relationship between the objects as created by the user. These objects are generally referred to as items
in the Metasys user interface.

Each object that exists in a system is based on a specific object type. There is an object type to manage the functions
of the site, object types to manage the operation of the various device types installed on the site, object types to
manage the physical input/output points of each field device, and others.

Examples: Site Object, Engine Device Object, Analog Input Object, Program (Control System) Object

Objects communicate with the rest of the system and with the user through their attributes. The object type defines
the basic function of the object, but the actual behavior of each object also depends on the values assigned to its
configuration attributes and received by its input attributes from other objects. The object writes its status conditions
and the results of internal processes to its output attributes.

When an object type has an equivalent BACnet Object Type, the attribute list includes the BACnet Properties required
by the BACnet protocol specification and some of the optional properties. These objects may be accessed from a
BACnet network. For detailed information on BACnet objects and properties, refer to ANSI/ASHRAE Standard
135-2008 - A Data Communication Protocol for Building Automation and Control Networks.

Object Extensions
Object extensions provide additional features to objects and include Alarm, Trend Log, Totalization (Analog, Runtime,
and Event), Load, Averaging, and Resource File. Object extensions do not appear in the navigation tree. The
attributes of Object Extensions are displayed under specific tabs when viewing object details. You may define object
extensions when the object is first created using the configuration wizard or add them later.

For more information on extensions, see the Extensions section.

Attributes
Attributes contain data that an object exposes to the system. The data in some attributes is set by the user or by
other objects and features in the system and is used by the object to perform its function. Other attributes contain
data produced by the object itself. The Attributes table for each object lists the characteristics of each attribute to
help you configure the object.

There is a set of attributes common to many Metasys system objects. These attributes are described in the Common
Object Attributes section. Each object attribute section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to that object. See the Object and Feature Tabs section
for information on the attributes that appear on the other tabs of the object (for example, the Hardware and Options
tab appear on point objects and the Email tab appears on Engine and Server objects). The attributes listed in the
tables appear in alphabetical order.

The column headings in the Attribute table are defined as follows:

Attribute Name
Gives the name of the attribute as it appears on the user interface.

Example: High Limit

See the Status and Display Attribute Location topic.
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Data Type
Lists the data type of the attribute value. The following table defines the various data types used in the Metasys
system.

Table 196: Data Types
DefinitionFormal NameData Type
Reference of an attribute from which data is read or to which data is sent.
The format is <Object Reference.Attribute Name>

Attribute ReferenceAttribute Reference

Day of week, day, month, year

Example: Wednesday, February 19, 2003

DateDate

List of attributes or properties of other objects that is created or used by a
particular function of this object.

ListList

Number from 0–255 with no decimal point. Allowable range appears in
column headed Values/Options/Range

ByteNumber

Number from 0 to 65,535 with no decimal point. Allowable range appear in
column headed Values/Options/Range.

Unsigned Integer
Short

Number

Number from 0 to 4,294,967,295 with no decimal point. Allowable range
appears in column headed Values/Options/Range.

Unsigned LongNumber

Signed number that is also an integer with no decimal point. The value may
be positive or negative. Allowable range appears in column headed
Values/Options/Range.

Examples:
• DLLR: Shed Pending, Shed Lost
• Accumulator: Scale As Integer

Signed IntegerNumber

Item Reference of an object to which a command is sentObject ReferenceObject Reference

Discrete state/type/mode taken from a set of numbered possible values and
normally represented on the user interface by text.

EnumerationOne State/Type/Node
from a Set

Number with a decimal point to show required precision

Example: 24.5

FloatReal Value

A set of values of mixed data types representing one physical entityStructureSet of Related Values

Series of true/false states that each have an independent meaning but
together define the overall state of an attribute or object

Bit StringSeries of True or False
States

A set of a specified number of values of the same data typeArraySet of Values

A line of characters (letters and numbers)StringText

Hours, minutes, seconds

Example: 12:30:56 AM

Each Time data type has a time chooser for graphical time selection, where
writable.

TimeTime

Data that can only be true or falseBooleanTrue or False

Notes
The Notes column lists specific characteristics of the attribute and its value. The characteristics (or flags) in Notes
specify how the attribute is used in the object and how it can be set within the Metasys system.

352Metasys System Online Help PDF



Table 197: Notes
DefinitionNote
Indicates if the value of the attribute is defined by the user when first creating the object and cannot be
changed by the object itself. Configurable (C) attributes that are writable (W) can be changed by the
user online or by a process or feature in the running system after the object has been created.

C - Configurable

Indicates that this is the primary value of this object, and is used when the user interface needs to display
a single value from the object. For example, this attribute is displayed in the header bar of the display
panel for an object.

D - Default Attribute
for Display

Indicates that this configurable attribute may contain a blank value. (Other configurable [C] attributes
without N must contain a valid value for the object to function.) For example, a value for a high or low
limit attribute is not required and a blank value indicates that the alarm processing is not required.

N - Value Not
Required

Indicates that the reliability of the value of this attribute is dependent on the object being in a reliable
state.

R - Affected by
Object Reliability

Indicates that the user can edit the value of the attribute online or by a process or feature in the running
system or network. A write to a configurable (C) attribute replaces the existing value. A write to other
attributes is handled as an override to the value calculated by the object or as a command for some
action by the object.

W - Writable

BACnet Notes
The BACnet Notes column specifies if the attribute is exposed as a standard BACnet property and if it can be modified
from a BACnet network.

Table 198: BACnet [System] Notes1

DefinitionNote
Indicates that the attribute can be accessed as a standard BACnet Property of the equivalent BACnet
Object Type from a BACnet network.

B - Exposed as
Standard BACnet
Property

Indicates that the value of the attribute can be modified by a message from a device on the BACnet
network.

W - Writable

1 The types listed in Table 197 may also appear in the Note column, as applicable.

Initial Value
A configurable attribute takes the initial value when the object is being created if the user does not enter another
value. Other attributes take the initial value on startup and until the object calculates a new value.

Values/Options/Range
Based on the attribute’s data type, this column may show the range of valid values or a reference to the set of
possible values for this attribute. If the complete set of values for the attribute is small, all possible values are shown
in this column.

Status and Display Attribute Location
The Status and default display attribute (typically the Present Value) of objects appear just below the header of the
Display Panel displaying the object.

Object Naming Attributes
Every object can be identified by one of three naming attributes.

Name - a freely definable user name for the object

Item Reference - a fixed name used internally by the system

BACnet Object Name - the name exposed to a BACnet network based on the Item Reference; or the name based
on the User Name Is BACnet Obj Name common attribute setting

See the Object and Feature Tabs section for more information on these attributes.
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Commands
The Commands table for each object lists the commands that the object supports. Commands allow you to perform
an action on an object, such as Start or Stop. The user executes these commands through the user interface. If an
object does not support any commands, the Commands table does not appear in the Help. For a description of each
command, click the command name in the Commands table.

The column headings in the Commands table are defined as follows:

Command Name - Gives the name of the command as it appears in the user interface.

Parameters - Gives the parameters required in the command along with some descriptive information.

State, Mode, and Type Sets
State, Mode, and Type Sets provide the source of readable text for the user interface when the displayed value can
be one of many states, modes, or types. For example, the Status attribute of every object is displayed as one of the
texts listed in the Object Status (Set 505).

References to specific sets appear throughout the Object Help, usually in the Values/Options/Range column of the
object’s attribute table.

Common Object Attributes
The Object and Feature Tabs are used by most of the object types in the Metasys system. Each particular object in
the object list contains a reference to the use of common object attributes.

Object List
The entire list of objects that are available in the Metasys system appears in the table of contents in the Help system
and PDF. Also see the Extensions section for object extensions.

Object Creation
Objects can be created offline in the system database on the SCT and later downloaded to the host device as part
of the edited database. You can also create objects online with a browser if you have the Access Privileges to
configure objects using the Security Administrator System. The user interface screens and procedures are similar
in either case. Creating an object involves placing it at the desired position in the Navigation Tree and defining all
the attributes that are required for it to operate. The procedure begins with the Insert Menu, and a wizard guides
you through all the necessary configuration steps.

See the Creating Items with Wizards section for the steps to create objects/items.

Object Deletion
Objects can be deleted offline in the system database on the SCT and later downloaded to the host device as part
of the edited database. You can also delete objects online with a browser if you have the Access Privileges to
configure objects using the Security Administrator System. The user interface screens and procedures are similar
in either case. Deleting an object involves selecting it in the Navigation Tree and using the Delete Items command.

See the Deleting Objects/Items section for more information.

Note: Before deleting an object, you should delete all references to the object within other objects and reconfigure
any objects that are referenced in the object to be deleted. If the references are not edited or deleted, the
referenced objects may not operate correctly. See the Unbound References attribute in the Engine Device
Object for an example of how to locate incomplete references.
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Common Object Attributes
The Common Object Attributes are used by most of the object types in the Metasys system. Each object type also
has specific attributes that apply only to that object type. A reference to the use of Common Object Attributes and
a description of specific object attributes are given under each particular object in the Object List.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the Common Object Attributes, see Common Attributes.

Common Attributes
This section lists the attributes that are common to Metasys system objects. Click the attribute name in the table for
a description of the attribute.

For detailed information on BACnet properties, refer to ANSI/ASHRAE Standard 135-2008 - A Data Communication
Protocol for Building Automation and Control Networks.

Table 199: Common Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

DateArchive Date

Subset of the Object Status (Set 505)NormalOne state from a
set

Alarm State

Maximum 40 charactersNo textBNWCNWTextDescription

TrueTrue or FalseEnabled

All Items navigation tree path to object.
SiteID:DeviceID/x.y.z

CTextItem Reference

Maximum 400 characters (40 or less
is best for display layout)

During online creation, this field is
limited to 32 characters; however, you
can edit and lengthen the name later.

Item IDCWTextName

HVAC, Fire, Security, Services,
Administrative, General, Lighting,
Refrigeration, Critical Environment, Air
Quality, Power, Energy, System,
Custom 1–12

GeneralWCWOne type from a
set

Object Category

NumberObject Count

Instance Number of Object Type within
the host device

BCNumberObject Identifier

Item Reference less SiteIDBTextObject Name

Actual Object TypeBOne type from a
set

Object Type

(Displayed in panel header.)NormalOne state from a
set

Status

FalseCWCWTrue or FalseUser Name Is
BACnet Obj Name

Actual version of Object in deviceVersion

1 B - Exposed as Standard BACnet Property, C - Configurable, N - Value Not Required, W - Writable
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Common Object Attribute Details
Archive Date
Indicates the date of the last successful archive of object instances. The value of this attribute is valid if a valid
archive exists and during the archive download process. The value of this attribute is 0xFF at all other times.

Back to Common Object Attributes.

Alarm State
Indicates the current Warning or Alarm state of an object. This attribute is set by an Alarm Extension associated
with the object.

Back to Common Object Attributes.

Description
Contains a user-defined description of the object or, for some integrations, the device description. After the description
is defined by the user, the description is not read from the device again.

Back to Common Object Attributes.

Enabled
Indicates whether the object is set to execute/enabled (True) or not execute/disabled (False).

Back to Common Object Attributes.

Item Reference
Contains a unique reference name for the object that is the full path name of the object through the All Items navigation
tree using the unique identifier you specified when you manually created the object. The Item Reference begins with
the site and device identifiers (separated by a colon), followed by the identifiers of any parent objects, such as an
integration object, field device, or any nested folders, and ends with the identifier of the object itself.

You define the identifier of each object as it is created and the system builds the Item Reference automatically. Once
the object is defined, the Item Reference cannot be changed directly. But, the Computer Name attribute of a Site
Director or device is the object identifier. If you change the Site Director or device Computer Name attribute, the
Item Reference then updates to show the new Computer Name.

If a device has a domain specified in the Domain Name attribute, the name for the domain appears in the Item
Reference after the Computer Name:

Computer Name.Domain Name

The following characters are not allowed in references:

@ . , ? * # : ‘ “ ” \ / [ ] < > |

Figure 77 shows an example for a field point object in an N2 integration.

Figure 77: Example of Item Reference

Back to Common Object Attributes.
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Name
Contains a freely definable user-friendly Name for the object that is independent of the Item Reference or the location
of the object in the physical network. The Name is used as the label in the All Items navigation tree. The Name is
shown in alarm reports, the event and audit viewers, and in summaries. The Name does not need to be unique to
the site unless the name is used as the BACnet Object Name. When the name is used as the BACnet Object Name,
it must be unique among the BACnet Object Names in the device (if it is not a Device object) or unique among the
other device objects (if it is a Device object).

The Name defaults to the object identifier you used during manual object creation, but can be edited later. For
integrated BACnet objects, the name defaults to the BACnet Object Name in the remote BACnet device. For integrated
N1 network objects, the name defaults to the System.Object Name in the Network Communication Module (NCM).

Example: ConferenceCenter-Room2-SpaceSetPoint

For devices, both the Computer Name and Name attributes default to the object identifier you used during manual
object creation. But, do not confuse the Computer Name attribute with the Name attribute. Changing the NAE Name
attribute does not impact the object references or network communication with other devices on the site.

Changing the Computer Name online breaks any existing references between the NAE object and other objects on
the site, and may break the existing network connection to other devices on the network. We do not recommend
changing the Computer Name online. If you change the Computer Name attribute in the SCT (right-click the NAE
in the navigation tree and select Rename), both the Computer Name and Name attributes are changed to the new
name you select. The Item Reference then updates to show the new Computer Name.

Back to Common Object Attributes.

Object Category
Classifies the object by the category of system or equipment that it monitors to aid in the determination of user
access privileges and alarm routing.

Examples: HVAC, Fire, Security

Back to Common Object Attributes.

Object Count
Indicates the number of object instances within the device. This count includes objects of any type.

Back to Common Object Attributes.

Object Identifier
Indicates the instance number of the Object Type used in the BACnet Object ID as exposed to a BACnet network.
The object ID must be unique within the host device. The object ID of the Device object must be unique within the
BACnet network.

Back to Common Object Attributes.

Object Name
Indicates the Object Name as exposed to a BACnet network. This attribute is equivalent to the Item Reference
without the site identifier. You cannot edit this attribute, but it changes when the Item Reference attribute updates.
In addition, you can change the Object Name attribute by editing the User Name attribute and setting the User Name
Is BACnet Obj Name attribute to True.

Example: NAE3/N2 Trunk1.AHU4.Supply Temp

Back to Common Object Attributes.

Object Type
Indicates the Object Type as displayed in the Metasys software and as exposed to a BACnet network.

Example: AI (Analog Input)

Back to Common Object Attributes.
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Status
Note: The value of the Status attribute displays next to the Default Attribute for Display (typically Present Value) in

the header bar of the Display panel.

Displays the highest priority Status for the object.

Examples: (in order of priority - supported states depend on Object Type)

• Out Of Service: The Out Of Service attribute value is True.
• Offline: Communication with the physical hardware has failed.
• Unreliable: Reliability attribute is not reliable.
• Alarm: Object or alarm extension has an alarm state.
• Normal: No abnormal condition for this object detected.

Back to Common Object Attributes.

User Name Is BACnet Obj Name
Controls whether the object’s User Name attribute is also the Object Name attribute. The Object Name attribute is
not writable, so the only way to change the Object Name attribute is to edit the User Name attribute and set the User
Name Is BACnet Obj Name attribute to True.

Back to Common Object Attributes.

Version
Displays the version number of the object software code. As the functionality of objects is enhanced, the version
numbers are incremented.

Example: 3.1 where 3 is the major revision and 1 is a minor revision

Back to Common Object Attributes.
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Accumulator Objects
The accumulator object allows you to count pulses, which are often provided by energy meters. The accumulator
objects can feed their Present Values to the Pulse Meter Object.

Note: The Accumulator’s Interface Value updates when the hardware is read by the Pulse Meter Object or when
the hardware’s current value changes.

Table 200 describes the types of accumulator objects and how to add them to the Metasys system. The Integration
(Device) Type column indicates the type of integration and device in which the accumulator object resides.

Table 200: Accumulator Types
Steps and TipsDescriptionIntegration

(Device) Type
To add an accumulator from a third-party general BACnet
device on an IP BACnet integration:

1. From the Metasys UI, add a BACnet integration.
2. Add a BACnet device type compatible with the field

device that contains an accumulator.
3. Map the accumulator at the engine (that is, add the

Accumulator point to the mapped BACnet device
using the Insert Point Wizard).

Provides integration of BACnet controllers with
supervisory controllers via a BACnet
accumulator mapper. This object provides
information on the UI (including Present Value
and Scale) from a BACnet integration with an
accumulator that exists in a third-party BACnet
device.

Note: A BACnet accumulator is mapped at
the engine via the Insert Point Wizard.

IP BACnet
Integration

(Third-Party
General BACnet
Device)

To add an accumulator from a third-party general BACnet
device on an MS/TP field bus:

1. From the Metasys UI, add an MS/TP field bus.
2. Add a BACnet device type compatible with the field

device that contains an accumulator.
3. Map the accumulator at the engine (that is, add the

Accumulator point to the mapped BACnet device
using the Insert Point Wizard).

Provides integration of BACnet controllers with
supervisory controllers via a BACnet
accumulator mapper. This object provides
information on the UI (including Present Value
and Scale) from a BACnet Integration with an
accumulator that exists in a third-party BACnet
device.

Note: A BACnet accumulator is mapped at
the engine via the Insert Point Wizard.

MS/TP Field Bus

(Third-Party
General BACnet
Device)

To add an accumulator from an FEC family BACnet device
on an MS/TP field bus:

1. From the Metasys UI, add an MS/TP field bus.
2. Add an FEC family BACnet device compatible with

the field device that contains a visible accumulator
(defined by CCT).

3. Map the accumulator at the engine (that is, add the
Accumulator point to the mapped field device using
the Insert Point Wizard).

Provides integration of pulse meters integrated
to the Dry Contact Pulse (MISC-MTR) binary
input of an FEC family BACnet device. CCT
creates an Accumulator object for the pulse
meter input of the FEC family BACnet device.
This FEC accumulator is shadowed by the
engine.

Note: An FEC accumulator object is mapped
at the engine via the Insert Point
Wizard.

MS/TP Field Bus

(FEC Family
BACnet Device)
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Table 200: Accumulator Types
Steps and TipsDescriptionIntegration

(Device) Type
To add an accumulator from an N2 device on an N2 trunk:

1. From the Metasys UI, add an N2 trunk.
2. Add an N2 device type compatible with the field

device.
3. Map the accumulator (Accumulator or Pulse Counter

type) at the engine (that is, add the Accumulator point
to the N2 device using the Insert Point Wizard).

4. Define the Rollover Limit:
You must set the rollover limit in the N2 accumulator
to match the rollover limit of the N2 field device
selected. For example, AHU or Unitary (UNT) devices
have a rollover limit of 4,294,967,295. A DX-9100
CNT point has a rollover limit set by the GX-9100
configuration tool. An XT-9100 or XTM CNT point has
a rollover limit set by either the GX-9100 configuration
tool or XTM configuration tool.

Map BI7 or BI8 for an AHU, BI4 for a UNT or VAV, or
Analog Data Integer (ADI) network point types for a
DX-9100 or XTM.

Provides integration of the wide variety of N2
controller binary input/pulse counters, resulting
in a consistent interface for point mapping any
N2 controller types.

Note: An N2 accumulator or pulse counter is
mapped at the engine via the Insert
Point Wizard.

N2 Trunk

(N2 Device)

To add an accumulator from a device on other
integrations:

1. From the Metasys UI, add the desired integration.
2. Add a device type compatible with the field device.
3. Map the accumulator at the engine (that is, add the

Accumulator object using the Insert Object Wizard).
4. Reference a value that continually counts up until the

value wraps back to zero when it passes the Rollover
Limit value defined in the accumulator object.

Allows you to monitor the increasing pulse count
from any attribute that has an incrementing
value. This provides greater flexibility for
creating accumulator objects.

Note: An object with an attribute that has an
incrementing value is mapped at the
engine via the Insert Object Wizard.

Other Integrations

(For Example,
LONWORKS, N1,VND,
and XL5K Devices)

Figure 78 illustrates the interaction between the different types of accumulators and the accumulator in the engine,
showing the key attributes and functionality.
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Figure 78: Accumulator Interaction

An FEC family BACnet device that resides on the MS/TP field bus has a binary input with a Dry Contact Pulse signal
(MISC-MTR) created in CCT. This provides an FEC accumulator. A third-party general BACnet device that resides
on either the BACnet integration or the MS/TP field bus has an accumulator. Both the FEC accumulator and BACnet
accumulators have BACnet Prescale, Units, and Limit Monitoring Interval attributes that interact with the accumulator
in the engine via the prescaled Present Value.

An N2 controller resides on the N2 trunk, and has an attribute that counts. Similarly, other devices that reside on
other integrations (for example, a LONWORKS device on a LONWORKS integration) that have attributes that count may
take advantage of the accumulator functionality. The accumulator in the engine uses the count value.

The accumulator in the engine uses the prescaled Present Value or counts from the devices with the key engine
accumulator attributes listed in the figure. For details on the calculations used by and functionality of these attributes,
see the Accumulator Attributes section.

The accumulator’s prescaled Present Value is used by the Pulse Meter, DLLR, or IEIEJ objects. You can trend the
prescaled Present Value, which may then be used by Energy Essentials. You also can trend the accumulator’s Pulse
Rate, Scaled Present Value, or Value Before Change attributes.
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Note: The prescaled Present Value, as well as its associated commands and attributes (Preset Value, Value Before
Change, Max Value, Value Set), do not necessarily have the same units as Scaled Present Value or the
Units attribute.

The header of the focus window shows the Scaled Present Value after the scale factor has been applied to the
Present Value, as well as the units that apply to the Scaled Present Value.

For general information on Metasys system objects, see the Object Help section.

Accumulator Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 201: Accumulator Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes2Data TypeIntegration

Type1
Attribute Name

TrueCWTrue or FalseN2

Other

Anti Spike

20 Character LimitNullCNWTextAllDevice Type

HundredthsCWOne type from a
set

AllDisplay Precision

Limited to Numeric type properties.CAttribute referenceOtherInput Ref

NumberN2Interface Value

Applies to Present Value, Value Set,
Max Value, and Value Before Change

No Internal UnitsCWOne type from a
set

AllInternal Units

FalseCWTrue or FalseAllIntrinsic Alarming
Defined

CWObject referenceAllJCI Logging
Object Reference

Range 60–604,800

Unit = Seconds

300CWNumberAllLimit Monitoring
Interval

BACnet Object IDCWObject referenceAllLogging Object
Reference

StructureAllLogging Record

2,000,000,000CWNumberAllMax Value

FalseWTrue or FalseAllOut of Service

Units = Seconds

Minimum = 10

Maximum = 10,000

60CWNumberFEC

N2

Other

Periodic Update3

1–65,5351, 1CWStructureAllPrescale

0NWNumberAllPresent Value

See the Reliability (Set 503).Unreliable (FEC)

0 (Other, N2)

WOne state from a
set

AllReliability
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Table 201: Accumulator Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes2Data TypeIntegration

Type1
Attribute Name

32,767CWNumberN2

Other

Rollover Limit

0NumberAllScale4

0.0CNWNumberAllScale As Float

0CNWNumberAllScale As Integer

UnitsNumberAllScaled Present
Value

See the BAC Status Flags (Set 9).Series of True or
False States

AllStatus Flags

Applies to Scaled Present Value.No unitsCWOne type from a
set

AllUnits

FalseCWTrue or FalseBACnetUse Remote
Alarming

NumberAllValue Before
Change

*.*.*Set of related
values

AllValue Change
Time

0WNumberAllValue Set

1 BACnet (Third-Party General BACnet Device), FEC (FEC Family BACnet Device), N2, Other (LONWORKS, N1, VND, and XL5K,
for example), or All

2 C - Configurable, D - Default Attribute for Display, N - Value not Required, W - Writable
3 This attribute only appears in the snapshot view of the mapper object and on the Engineering tab of the integration.
4 This attribute does not appear in a view; it is a BACnet property.

Accumulator Attribute Details
Anti Spike
When True, causes the object to use the first good input count value received after previously being unreliable as
strictly an initial value. Any archived or last known value for input count is ignored. If the input device resets or loses
power, uncontrolled changes to the input count value are filtered out and do not result in a spike in accumulator
values. Use this setting in cases where the input device is not known to preserve its count value over a power loss
(for example, in a LONWORKS integration an LN-PRG20 GPI, and in an N2 integration a UNT).

When False, causes the object to use the first good input device count value received after previously being unreliable
as a valid change from the archived or last known value for input count. This means the first good input device value
is used to catch up on any counts that were missed while the input device was unable to communicate due to either
an NAE restart or communication loss. Do not set this value to False unless the input device is known to
preserve its count value during a power loss (for example, in an N2 integration, an XTM-105 with a XPB-821 or
in a LONWORKS integration LN-PRG300-2, LNPRG400-2, LN-PTRG500-2, LN-PRG600, or in a vendor integration
BTR Netcom GmbH device LC14 [Model # 11045013-US], an IDEC SX5L-SBCN081, or an WATANBE Electric
Industry WRBC-DI16F-A002).

Note: Any mapper object used to deliver a raw count value to the Accumulator must provide an unreliable value
during startup if the value was not updated from the field controller at the time it is read by the accumulator.
For example, a LON counter mapped as an Analog Input (AI) point object reports as unreliable until it reads
a value from the field controller. If the LON counter is mapped as an Analog Output (AO) point object, it
reports as reliable even if the value is not initialized, causing improper values to be recorded at the accumulator.
This may occur regardless of the value of Anti Spike.
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Note: Any mapper object used to deliver a raw count value to the accumulator must be allowed to count up without
disruption from manual commands, schedules, interlocks, or any other function that may change its value
outside the normal counting process. Any such changes may cause the Accumulator to record improper
values regardless of the value of Anti Spike.

Note: When replacing the input device, set Anti Spike to True before the replacement is brought online for the first
time. This setting prevents the accumulator value from spiking upward due to an uncontrolled count value
change at the input device. Failure to set Anti Spike to True can upset the accumulator value. You can use
a manual preset to restore the correct value after the new device is online.

Back to Accumulator Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to Accumulator Attributes.

Display Precision
Determines how many decimal places to display in the Scaled Present Value.

Input Ref
Identifies the attribute reference to the object property that is the pulse count input for the Accumulator object (for
the Other integrations type: LONWORKS, N1, VND, and XL5K, for example). This must be a continuously increasing
positive numeric attribute of another object, such as the present value of a totalization extension to an analog meter.

Back to Accumulator Attributes.

Interface Value
Indicates current value from the hardware interface. This attribute is the same as input count, but is specific to the
N2 accumulator.

Internal Units
Contains the engineering units for the Present Value, Value Set, Max Value, and Value Before Change attribute.

Back to Accumulator Attributes.

Intrinsic Alarming Defined
Indicates whether intrinsic alarming is enabled when the site is defined as a BACnet site. When intrinsic alarming
is defined for accumulators on the MS/TP field bus, the pulse rate of the accumulated point can be monitored.

Back to Accumulator Attributes.

JCI Logging Object Reference
Indicates the object (Johnson Controls proprietary reference) that resides in the same device as the Accumulator
object which, when it acquires Logging Record data from the Accumulator object, causes the Accumulator object
to acquire, present, and store the Logging Record data (that is, snapshot) from the underlying system. When the
object specified by the Logging Object Reference issues the Get Monitor Data command, the Logging Record is
acquired and updated.

Back to Accumulator Attributes.

Limit Monitoring Interval
Specifies the monitoring period in seconds for determining the Pulse Rate. The Pulse Rate is the number of pulses
received during the previous Limit Monitoring Interval period.

Back to Accumulator Attributes.
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Logging Object Reference
Indicates the object (via BACnet Object Identifier) that resides in the same device as the Accumulator object which,
when it acquires Logging Record data from the Accumulator object, causes the Accumulator object to acquire,
present, and store the Logging Record data (that is, snapshot) from the underlying system. When the object specified
by the Logging Object Reference issues the Get Monitor Data command, the Logging Record is acquired and
updated.

Back to Accumulator Attributes.

Logging Record
Specifies a list of values to acquire, save, and return when read by other objects or devices.

• Timestamp - Indicates the local date and time when the data was acquired.
• Present Value - Indicates the value of the Present Value attribute.
• Accumulated Value - Indicates the short-term accumulated value of the counter. The algorithm used to calculate

the accumulated value is a function of the value of accumulator status. If this is the initial read, the value returned
is zero.

• Accumulator Status - Indicates the reliability of the data in this list of values. The accumulator status values
include:

- Normal - Indicates that no event affecting the reliability of the data has occurred during the period from the
preceding to the current qualified reads of the Logging Record attribute (Accumulated Value = current Present
Value - previous Present Value).

- Starting - Indicates that the data of the Logging Record attribute is either the first data acquired since startup
by the object identified by Logging Object (that is, timestamp has no wildcard values) or that no data has
been acquired since startup by the object identified by Logging Object (that is, timestamp has all wildcard
values).

- Recovered - Indicates that one or more writes to Value Set or changes to Value Before Change occurred
since the Logging Record was acquired by the object identified by Logging Object (Accumulated Value =
[current Present Value - Value Set] + [Value Before Change - previous Present Value]).

- Abnormal - Indicates that the accumulation has been carried out, but some unrecoverable event such as
the clock’s time changing a significant amount since the Logging Record was acquired by the object identified
by Logging Object.

- Failed - Indicates that the accumulation value is not reliable due to some problem.

Back to Accumulator Attributes.

Max Value
Indicates the maximum value allowed for the Present Value. The Present Value is not allowed to exceed this value,
and wraps back to zero when this value is passed. Accumulation does not stop.

Back to Accumulator Attributes.

Out of Service
When set to True, indicates that the object is not tracking pulse count or rate.

Used to de-couple the object from the physical input. When Out of Service is True, the object de-couples the Present
Value and Reliability from the hardware. The Reliability is writable when Out Of Service is True. When de-coupled,
the Present Value can be changed to simulate specific conditions or for test purposes.

When the Accumulator object is placed Out of Service, the current value of the Present Value is saved. While Out
of Service, an N2, FEC, or Other Accumulator continues to track the count of this saved value in the background,
thereby ensuring that no counts are lost. When placed back in service, this new count is copied to the Present Value
attribute.

A third-party BACnet accumulator behaves according to the design of the third-party vendor.

Back to Accumulator Attributes.
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Periodic Update
This attribute only appears in the snapshot view of the mapper object and on the Engineering tab of the integration.
This attribute applies to all integrations, except for BACnet integrations. Represents the time, in seconds, between
successive COV messages issued by the local Accumulator object at a field device, or updates made to the
Accumulator object on the UI.

The field device Accumulator object pushes its Present Value count up to the Supervisory controller through the
COV mechanism. By requiring a minimum time between successive COVs, the Update Interval ensures that the
integration does not get flooded with COVs from the Accumulator.

Back to Accumulator Attributes.

Prescale
Indicates the coefficients used to convert the accumulated pulses into the Present Value. This attribute uses
moduloDivide integer division (where 5/2 is 2). The algorithm used is:

Present Value = (prescale.multiplier x accumulated-pulses)/

prescale.moduloDivide.

Back to Accumulator Attributes.

Present Value
Represents the value of the Accumulator object, prescaled via the Prescale attribute. The Present Value falls in the
range between 0 and the Max Value. When the Present Value reaches the Max Value, it rolls over to zero. You can
write to Present Value when it is out of service and you can reset the Present Value by updating the Value Set, or
you can use the Preset Value command to do so. The Scaled Present Value is the value of the object displayed in
the UI, not the Present Value. If Scale As Float and Scale As Integer are both zero (the default value), the Present
Value and Scaled Present Value are equal.

Back to Accumulator Attributes.

Reliability
Indicates whether the Present Value is reliable and why. You can write to Reliability when it is out of service.

Back to Accumulator Attributes.

Rollover Limit
Represents the actual rollover value of the input pulse counter. This attribute applies to N2 and Other Accumulators.
This value is used to compute a change rate, which is added to the Accumulator property to calculate the Pulse
Rate and Present Value.

You must set the rollover limit in the N2 accumulator to match the rollover limit of the N2 field device selected. For
example, AHU or UNT devices have a rollover limit of 4,294,967,295. A DX-9100 CNT point has a rollover limit set
by the GX-9100 configuration tool. An XT-9100 or XTM CNT point has a rollover limit set by the either the GX-9100
configuration tool or XTM configuration tool.

Back to Accumulator Attributes.

Scale
This BACnet property does not appear in a view in the Metasys system. Indicates the conversion factor to be multiplied
with the value of the Present Value attribute to provide a Scaled Present Value in the units indicated by the Units
attribute. By default, the Present Value and Scaled Present Value are equal. These values remain equal if you do
not use the accumulator’s Scale attribute.

Back to Accumulator Attributes.

Scale As Float
Indicates the floating conversion factor to be multiplied with the value of the Present Value attribute to calculate the
Scaled Present Value for the chosen units. If set to zero (the default value), the Scale As Integer value is used and
Scale As Float is ignored.

Back to Accumulator Attributes.
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Scale As Integer
Indicates the power of ten to be multiplied with the value of the Present Value attribute to get Scaled Present Value.
This attribute only applies if Scale As Float is zero. For example, when Scale As Integer is set to two, the Present
Value is multiplied by 100; while setting Scale As Integer to -1 multiplies the Present Value by 0.1. When zero (the
default value), the Present Value and Scaled Present Value are equal (see Scaled Present Value).

Back to Accumulator Attributes.

Scaled Present Value
Indicates the value of the Present Value attribute conversion. The Present Value is multiplied by the Scale as Float
value when that attribute contains a value (not zero). Otherwise, the Present Value is multiplied by 10 to the power
of the Scale As Integer value (for example, if Scale As Integer is 3, it is multiplied by 1,000 and if Scale As Integer
is -2, it is multiplied by 0.01). This is the actual value of the object.

Back to Accumulator Attributes.

Status Flags
Indicates the general status of the Accumulator object in BACnet terms and contains four independent states.

The states are:

In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True.

Fault - True if the Reliability attribute is not reliable; otherwise, the Fault flag is False.

Overridden - Overridden flag is always False.

Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of Service
flag is False.

Back to Accumulator Attributes.

Units
Contains the engineering units for the Scaled Present Value attribute.

Back to Accumulator Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation.

Back to Accumulator Attributes.

Value Before Change
Indicates the Present Value prior to the last write to the Value Set property or Preset Value command.

Back to Accumulator Attributes.

Value Change Time
Indicates the time of the last change to the Value Before Change attribute or Preset Value command.

Back to Accumulator Attributes.

Value Set
Allows you to reset the Present Value. The Present Value attribute gains its value from the value written to the Value
Set attribute. The Value Before Change takes on the previous value of the Present Value attribute (that is, the original
value before the write processed), and the Value Change Time is set to the current date and time. You also can use
the Preset Value command to change Present Value if the Accumulator object is in or out of service.
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Back to Accumulator Attributes.

Accumulator Commands
The table below lists the commands supported by the Accumulator Objects.

Table 202: Accumulator Object Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

Get Monitor Data

In Service

The value to be written to the Present Value Attribute.Out of Service

The value to be written to the N2 device accumulator or pulse counter hardware point.Preset Counter

The value to be written to the Value Set attribute.Preset Value

Accumulator Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Accumulator Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Accumulator Commands.

Get Monitor Data
Acquires and updates the Logging Record when the object specified by the Logging Object Reference issues the
Get Monitor Data command.

Back to Accumulator Commands.

In Service
Cancels the effect of an Out of Service write or command. The Present Value and Reliability revert to the values
obtained from the physical input. The Present Value attribute continues to receive inputs from the hardware input
while in the Out of Service state and continues to increment its count internally. When the Out of Service is cancelled,
the Present Value attribute of the N2, FEC, or Other Accumulator updates with this new internal count.

A third-party BACnet accumulator behaves according to the design of the third-party vendor.

Back to Accumulator Commands.

Out of Service
Allows a user to override the object’s hardware input for simulation or other purposes. The Out Of Service command
writes the Present Value to the value of the command parameter and writes the Reliability attribute to Reliable. The
Present Value and Reliability no longer track the physical input, but the N2, FEC, or Other Accumulator continues
to track pulses while out of service. When placed back in service, the Present Value resumes counting pulses.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

A third-party BACnet accumulator behaves according to the design of the third-party vendor.

Back to Accumulator Commands.

Preset Counter
Allows you to set the value to write to the N2 device accumulator or pulse counter hardware point. You cannot adjust
this attribute for a UNT or AHU. This attribute may be used with DX-9100, XTM, or XT hardware.
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Back to Accumulator Commands.

Preset Value
Allows you to reset the Present Value. This command writes a supplied value to the Value Set attribute. The Present
Value attribute then gains its value from the value written to the Value Set attribute. The Value Before Change takes
on the previous value of the Present Value attribute (that is, the original value before the write processed), and the
Value Change Time is set to the current date and time. This preserves the Present Value before the command took
place. Use this command to change Present Value if the Accumulator object is in or out of service.

Back to Accumulator Commands.
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ADS Device Object
The ADS Device object defines the attributes that represent the externally visible characteristics of an ADS/ADX
device. One ADS Device object exists per ADS/ADX device. This object allows you to see data about the ADS/ADX,
such as the name of the current Post Office Protocol (POP) server host name or information on printer destinations.
For general information on Metasys system objects, see the Object Help section.

ADS Concepts
ADS/ADX Features
The ADS/ADX runs on a computer platform and is installed within the Metasys network. With an ADS/ADX, you can
provide a location to install the SCT and a location to send trend logs (Trend Studies), event logs (Alarm and Event
Management), and audit trails (Audit Trail). The ADS/ADX can also be configured to take the role of the Site Director
to coordinate system access and present data to the user in a Web browser running on the same computer or
connected over the LAN, WAN, Internet, or telephone line via a dial-up connection.

Note: Online/offline modes as explained here do not apply to the ADS/ADX. However, the ADS/ADX can be online
and offline in the same sense as any other device on the network can be connected or disconnected from
the network.

Note: You may need to change the Windows Defender tool settings on the Windows 7 OS or Windows Server 2008
OS when using an ADS/ADX. Windows Defender is a spyware identification and removal tool that is part of
the OS. For the Windows 7 OS, this tool is on by default. For the Windows Server 2008 OS, this tool is off
by default. Windows Defender scans the OS for spyware every night at 2 A.M. If you expect heavy use of
the ADS/ADX at this time (for example, due to trend collection), reschedule the scan to a time when the
ADS/ADX is not as active.

Note: You may need to change the Disk Defragmentation settings on the Windows 7 OS or Windows Server 2008
OS when using an ADS/ADX. Disk Defragmentation on the OS is scheduled to run by default every Wednesday
at 1 A.M. If you expect heavy use of the ADS/ADX at this time (for example, due to trend collection), reschedule
the scan to a time when the ADS/ADX is not as active.

Trend Repository Database
The trend repository database resides within the server that stores the trend data. For more information, click one
of the following:

• Trend Studies
• Trend Extensions

Event Repository Database
The event repository database resides within the server that stores the event data. For more information, see the
Alarm and Event Management section.

Audit Repository Database
The audit repository database resides within the server that stores the audit data. For more information, see the
Audit Trail section.

ADS/ADX Computer Name
For information on ADS/ADX computer name guidelines and changing the computer name, refer to the Changing
the ADS/ADX Name and the Computer Name Appendix in the ADS/ADX Commissioning Guide (LIT-1201645).

ADS Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Beginning with Release 2.2, the attributes shown on the ADS/ADX Focus tab (when viewed from the Site Director)
do not refresh automatically. To refresh the Focus tab, either close and reopen the tab or issue the Refresh command.

Table 203: ADS Device Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

See the attribute description for details on
ADS Repositories.

CWList of value setsADS Repositories

Offline, OKCWList of value setsADS Repositories Status

0–75

Units = Minutes

5CWNumberAlarm Snooze Time

0 = DHCP disabled,

1 = DHCP enabled

True (1)CWTrue or FalseDHCP Enabled

See the attribute description for details on
the Enabled Audit Level.

Range = 1–4 with 5 Audit Levels

Level 1 (N/A) User Action

Level 2 (1) Critical System Events

Level 3 (2) Application

Level 4 (3) Non-critical System Events

Level 5 (4) Diagnostic

Audit

Level 2 (1)

CWOne from a list of
values

Enabled Audit Level

TextHost Name

CWList of numbersIP Address

True or FalseFalseCTrue or FalseIs Validated

DateLocal Date

TimeLocal Time

ADSTextModel Name

NumberNumber of NxEs Reporting

Units = Per Hour

See attribute description for calculation
details.

NumberSample Rate

Units = SecondsNumberService Time

Units = %NumberTransfer Buffer Full Worst
NxE

1 C - Configurable, N - Value Not Required, W - Writable

Table 204: ADS Device Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

IP address and Value

Units = seconds

ListAverage Intermittent Failure
Period

Units = Per HourNumberIncoming Event Rate

IP address and Value

Units = seconds

ListMaximum Intermittent
Failure Period
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Table 204: ADS Device Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

Units = Per HourNumberOutgoing Event Rate

IP address and Value

Units = Failures Per Day

ListTransport Failure Rate

1 C - Configurable, N - Value Not Required, W - Writable

ADS Device Attribute Details
ADS Repositories
Lists the ADS/ADX device host names or IP addresses to which incoming trend and Alarm/Event data forwards. An
ADS/ADX cannot have its own host name or IP address in this field. Refer to the ADS/ADX Commissioning Guide
(LIT-1201645) for details on configuring repositories.

Back to ADS Attributes.

ADS Repositories Status
Indicates the status of the devices listed in the ADS Repositories attribute.

Note: When forwarding data to a secondary ADS/ADX (that is, data forwarded to an ADS/ADX is forwarded to
another ADS/ADX), the status does not calculate. This attribute shows only the status for the initial forward.

Back to ADS Attributes.

Alarm Snooze Time
Specifies the amount of time to delay before re-announcing an alarm.

Back to ADS Attributes.

Average Intermittent Failure Period
Specifies the average number of seconds devices in the transport layer are offline (for diagnostic purposes). Only
times less than 1 minute are used in this average, to eliminate device resets. Ideally, this number should be zero,
indicating there are no failures.

Back to ADS Attributes.

DHCP Enabled
Indicates whether the Dynamic Host Configuration Protocol (DHCP) protocol should be used. The device may run
in three modes:

1. DHCP is enabled and a DHCP server exists on the network. The DHCP server assigns network configuration
information. The DHCP server assigns the IP Address attribute.

2. DHCP is enabled and no DHCP server exists on the network. Using the Automatic Client Configuration feature,
the device automatically defines the network configuration. The DHCP server assigns the IP Address attribute.

3. DHCP is disabled. You must manually assign the network configuration. The values from the DHCP are assumed
to be more current than the tool interface. When DHCP Enabled is True, the UI ignores the IP Address attribute
and should not attempt to write to it.

Note: This attribute only appears in the ADS object in the SCT and is used by the SCT during a download or upload
of the ADS database.

Back to ADS Attributes.

372Metasys System Online Help PDF



Enabled Audit Level
Specifies which level of audit entries are added to the audit repository. Only audit entries of type Level 1 through
and including the specified level are included. All other levels are not stored in the audit trail. Level 1 and Level 2
audit entries are always stored in the audit trail.

• Level 1 and 2 (1): Stores all user action and system error audit messages.
• Level 3 (2): Stores application audit messages in addition to Level 1 and 2 auditing.
• Level 4 (3): Stores system audit messages in addition to Level 3 auditing.
• Level 5 (4): Stores diagnostic audit messages in addition to Level 4 auditing.

Back to ADS Attributes.

Host Name
Indicates the host name of the NxE whose value appears in the Transfer Buffer Full Worst NxE attribute.

Back to ADS Attributes.

Incoming Event Rate
Specifies the average rate of events, per hour, received from other devices (NxEs or ADS/ADXs) during the previous
hour. The value of this attribute updates every 5 minutes. This rate only includes events generated by devices at
Release 5.2 or later.

IP Address
Represents the IP address of this ADS/ADX. The IP address identifies the ADS/ADX on the network and assists in
the routing of messages. Each ADS must have a unique IP address for the network to operate properly. A write to
this attribute is ignored when the DHCP Enabled attribute is True. A read of this attribute returns either the
user-specified value or the value determined from DHCP.

Certain IP addresses are invalid and cannot be written successfully. The network address portion of the IP address
is computed by including all bits in which the corresponding bit from the IP mask is 1. The device address portion
of the IP address is computed by including all bits in which the corresponding bit from the IP mask is 0. Neither the
network address nor device address can be all zero bits or all one bits. For example, if the IP mask is 255.255.0.0,
the following IP addresses are invalid: 0.0.100.100 and 100.100.0.0.

The IP Address attribute can be set explicitly, or it may be automatically set using the DHCP server. Using the DHCP
server, you can change this attribute even if you set it up explicitly. See the DHCP Enabled attribute.

Note: This attribute only appears in the ADS object in the SCT and is used by the SCT during a download or upload
of the ADS/ADX database.

Back to ADS Attributes.

Is Validated
Enables the MVE feature at the device, which includes reauthentication with electronic signature and required
annotation when the user makes a change to the system, such as commanding an object, acknowledging an alarm,
or changing the value of an attribute. This attribute can be set to True for MVE sites only. This attribute is writable
only with the SCT, and is read-only online.

Back to ADS Attributes.

Local Date
Displays the date on the ADS/ADX.

Back to ADS Attributes.

Local Time
Displays the time on the ADS/ADX.

Back to ADS Attributes.
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Maximum Intermittent Failure Period
Specifies the maximum number of seconds a device was offline at the transport layer (for diagnostic purposes).
Only times under 1 minute are recorded, to eliminate device resets. The value of this attribute does not match the
offline times determined from generated alarms. Ideally, this number should be zero, indicating there are no failures.

Back to ADS Attributes.

Model Name
Contains the name of the device model. In this case, it is ADS.

Back to ADS Attributes.

Number of NxEs Reporting
Specifies the number of NxE devices that registered this ADS/ADX as their trend repository.

Back to ADS Attributes.

Outgoing Event Rate
Specifies the average rate of events per hour, sent to other repositories (ADS/ADXs or Ready Access Portal). This
value of this attribute updates every 5 minutes. This rate only includes events generated by devices at Release 5.2
or later.

Read Only Community
Contains the community string used by the Network Management System to retrieve data from objects maintained
by managed devices. This attribute is ignored if SNMP Enabled is False.

Back to ADS Attributes.

Read/Write Community
Contains the community string used by the Network Management System to edit data in objects maintained by
managed devices. This attribute is ignored if SNMP DDA is False.

Back to ADS Attributes.

Sample Rate
Specifies the number of trend samples, per minute, received by the Metasys server from all NxEs (for diagnostic
purposes). The value of this attribute updates every 5 minutes.

Note: The sample rate at the NxE is calculated based on the actual raw samples taken by every trend object. The
sample rate at the ADS/ADX is calculated once every poll cycle and is based on the number of samples
received from all the NxEs and the time it took to poll them. Most NxEs do not forward all the samples taken
between polls because the ADS/ADX transfer setpoint is usually not set to 1 (that is, forward on every sample).
The result is that the sample rate at the ADS/ADX is less than the sum of the samples taken at all the NxEs.

Back to ADS Attributes.

Service Time
Displays the amount of time in seconds that it takes for the ADS/ADX device to poll all NxEs on the site for trend
samples.

Back to ADS Attributes.

Transfer Buffer Full Worst NxE
Indicates the buffer fullness, in percent, of the NxE with the fullest trend buffer of the trend poll cycle.

Back to ADS Attributes.

Transport Failure Rate
Specifies the number of transport failures per day (for diagnostic purposes). This number represents how often
HTTP posts from this server failed when they were sent to another device that is considered online. Failures include
the inability to open the connection, to send the message, or to receive the reply. This value represents failures over
the last 24 hours and is updated hourly, but does not correlate directly to the number of offline alarms generated by
your system. Ideally, this number should be zero, indicating there are no failures.
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Back to ADS Attributes.

ADS Commands
The table below lists the commands supported by the ADS Device Object.

Table 205: ADS Object Commands
ParametersCommand Name

Rediscover Text Strings

ADS Command Details
Rediscover Text Strings
Resets the States Text across a supervisory device by rediscovering text strings from all mapped BACnet objects.

Note: When the Rediscover Text Strings command is sent from the Site Director device UI to another supervisory
device and the UI is running on the supervisory device, you must close and restart the UI on the supervisory
device in order for the text to appear correctly.
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Analog Input Object
The AI object processes data from a physical analog input point that resides on a field device and presents the data
to the Metasys user interface in a consistent format that is independent of the source. Analog Input Objects appear
under the field device object in the All Items navigation tree.

When the source of the data is an analog input in an N2 controller on the N2 Trunk, an NCM on an integrated N1
network, or an integrated BACnet device, the Analog Input Object exchanges data with the native analog object in
the source to synchronize attribute data that are common to both. The source is identified under the hardware tab
of the Analog Input Object.

For general information on Metasys system objects, see Common Object Attributes.

Analog Input Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 206: Analog Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Any value > 00.1BWCW2Real valueCOV Increment

20 Character LimitNullCNWCNWTextDevice Type

10thsCWCWOne from a setDisplay Precision

FalseCTrue or FalseIntrinsic Alarming
Defined

1.7E38BWCWReal valueMax Value

-1.7E38BWCWReal valueMin Value

FalseBWCWTrue or FalseOut of Service

DNRWDNRWReal valuePresent Value

No Fault Detected (Reliable), No
Sensor, Over Range, Under
Range, Open Loop, Shorted Loop,
Unreliable Other

ReliableBWWOne state from a
set

Reliability

BReal valueResolution

In Alarm, Fault, Overridden, Out
of Service

False,

False,

False,

False

BSeries of True or
False states

Status Flags

Deg FWCWOne value from
a list

Units

0–65,535

Units = hundredths of a second

0BNumberUpdate Interval
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Table 206: Analog Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Applies to MS/TP Analog Inputs.FalseWTrue or FalseUse COV Min Send
Time

FalseBCWTrue or FalseUse Remote
Alarming

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, R -
Affected by Object Reliability, W - Writable

2 For MS/TP Analog Inputs, COV Increment may not be writable, based on its configuration.

Analog Input Attribute Details
COV Increment
Defines the minimum change in the Present Value required for the object to report a change.

Back to Analog Input Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to Analog Input Attributes.

Display Precision
Defines the decimal rounding and the decimal places to display for the Present Value and associated attributes.

Back to Analog Input Attributes.

Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Analog Input Attributes.

Max Value
Defines the highest reliable value (in engineering units) for the Present Value.

Back to Analog Input Attributes.

Min Value
Defines the lowest reliable value (in engineering units) for the Present Value.

Back to Analog Input Attributes.

Out of Service
Used to de-couple the object from the physical input. When Out of Service is True, the object de-couples the Present
Value and Reliability from the hardware. The Reliability is writable when Out Of Service is True. When de-coupled,
the Present Value can be changed to simulate specific conditions or for test purposes.

Additionally, the Out of Service state of the Status Flags attribute is set to True and the Fault state is decoupled from
the physical input when Out of Service is True.

Back to Analog Input Attributes.

Present Value
Indicates the current value of the analog input object in the defined Units. When Out of Service is True, this attribute
is writable.

Back to Analog Input Attributes.

Reliability
Indicates whether the Present Value is unreliable.
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Examples:

• Reliable - No detectable faults
• Unreliable High - Present Value is greater than the Max Value.
• Unreliable Low - Present Value is less than the Min Value.

When Out of Service is True, the Reliability attribute may be written directly.

Back to Analog Input Attributes.

Resolution
Indicates the smallest possible change in Present Value (in engineering units) and is equal to the Display Precision.
This attribute has the data type required by the standard BACnet property.

Back to Analog Input Attributes.

Status Flags
Indicates the general status of the Analog Input object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden at the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Analog Input Attributes.

Units
Indicates the engineering measurement units used by the object.

Back to Analog Input Attributes.

Update Interval
Indicates the time period (in hundredths of a second) between updates to Present Value when the input is not
overridden or out of service.

Back to Analog Input Attributes.

Use COV Min Send Time
Configures the MS/TP Analog Input object to send COV messages on a periodic basis instead of on every change
of value that exceeds the COV Increment . This attribute is typically set to True for objects with values that fluctuate
greatly, such as air pressure, to decrease the number of COV messages. The change of value still must exceed the
COV Increment to be reported. This attribute is available only on Metasys system field devices, such as the MS/TP
field devices.

Back to Analog Input Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Analog Input Attributes.
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Analog Input Commands
The table below lists the commands supported by the Analog Input Object.

Table 207: Analog Input Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present Value attribute.Out of Service

Analog Input Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Input Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Input Commands.

In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. The Present
Value and Reliability will revert back to the values obtained from the physical input.

Note: For BACnet objects, this command is dependent on the ability to write the Out Of Service attribute of the
BACnet Analog Input object in the remote BACnet device. Objects in the N30, for example, do not support
this command.

Back to Analog Input Commands.

Out of Service
Allows a user to override the object’s hardware input for simulation or other purposes. The Out Of Service command
will change the Out of Service attribute to True, write the Present Value to the value of the command parameter and
write the Reliability attribute to Reliable. The Present Value and Reliability will no longer track the physical input.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

Note: For BACnet objects, this command is dependent on the ability to write the Out Of Service attribute of the
BACnet Analog Input object in the remote BACnet device. Objects in the N30, for example, do not support
this command.

Note: For integrated N2 objects, this command is dependent on the ability to set the AI point in the N2 controller
to an override state. System 91 controllers, for example, do not support this command.

Back to Analog Input Commands.
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Analog Output Object
The AO object’s attributes represent the external, visible characteristics of an analog output. This object integrates
N1, N2, and BACnet controllers into supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous set to the user
interface

• flexibility in point mapping
• permanent update of setpoints in controllers. The user has the ability to write to the permanent memory of some

controllers.
• support for all Metasys controllers
• For example, this object allows you to command a damper to a given position from a supervisory controller.

For general information on Metasys system objects, see Common Object Attributes.

Analog Output Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 208: Analog Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Any value > 00.1BWCW2Real valueCOV Increment

Limit: 20 charactersNullWCWTextDevice Type

10thsCWCWOne value from a
list

Display Precision

FalseCTrue or FalseIntrinsic Alarming
Defined

This attribute is not Writable for a
Position Adjust Output (PAO).

100.0BWCWReal valueMax Value

This attribute is not Writable for a
PAO.

0.0BWCWReal valueMin Value

BWCWTrue or FalseOut of Service

0.0BWDNRWReal valuePresent Value

Set of valuesPriority Array

No Fault Detected (Reliable), Open
Loop, Shorted Loop, No Output,
Unreliable Other

0BWWOne value from a
set

Reliability

0.1BReal valueResolution

In Alarm, Fault, Overridden, Out of
Service

False,

False,

False,

False

BSeries of True or
False states

Status Flags

This attribute is not Writable for a
PAO.

%WCWOne value from a
list

Units
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Table 208: Analog Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

FalseWTrue or FalseUse COV Min Send
Time

FalseBCWTrue or FalseUse Remote
Alarming

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, R -
Affected by Object Reliability, W - Writable

2 For MS/TP Analog Outputs, COV Increment may not be writable, based on its configuration.

Analog Output Attribute Details
COV Increment
Specifies the minimum change in Present Value required for the object to report a change.

Back to Analog Output Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to Analog Output Attributes.

Display Precision
Defines the decimal rounding and the decimal places to display of the Present Value and associated attributes.

Back to Analog Output Attributes.

Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Analog Output Attributes.

Max Value
Defines the highest reliable value (in engineering units) for the Present Value.

Back to Analog Output Attributes.

Min Value
Defines the lowest reliable value (in engineering units) for the Present Value.

Back to Analog Output Attributes.

Out of Service
Used to de-couple the object from the physical output. When Out of Service is True, the object de-couples the
Present Value and Reliability from the hardware. The Reliability is writable when Out Of Service is True. When
de-coupled, the Present Value can be changed to simulate specific conditions or for test purposes.

Additionally, the Out of Service state of the Status Flags attribute is set to True and the Fault state is decoupled
from the physical input when Out of Service is True.

Back to Analog Output Attributes.

Present Value
Indicates the current value of the Analog Output object in the defined Units. When Out of Service is True, this attribute
is writable.

Back to Analog Output Attributes.

Priority Array
Lists values of the object in level of importance.

Back to Analog Output Attributes.
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Reliability
Indicates whether the Present Value is unreliable.

Examples:

• Reliable - No detectable faults
• Unreliable High - Present Value is greater than the Max Value.
• Unreliable Low - Present Value is less than the Min Value.

When Out of Service is True, the Reliability attribute may be written directly.

Back to Analog Output Attributes.

Resolution
Indicates the smallest possible change in Present Value (in engineering units) and is equal to the Display Precision.
This attribute has the data type required by the standard BACnet property.

Back to Analog Output Attributes.

Status Flags
Indicates the general status of the Analog Output object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden at the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Analog Output Attributes.

Units
Indicates the engineering measurements units used by the object.

Back to Analog Output Attributes.

Use COV Min Send Time
Configures the object to send COV messages on a periodic basis instead of on every change of value that exceeds
the COV Increment. This attribute is typically set to True for objects with values that fluctuate greatly, such as air
pressure, to decrease the number of COV messages. The change of value still must exceed the COV Increment to
be reported. This attribute is available only on Metasys system field devices, such as the MS/TP field devices.

Back to Analog Output Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Analog Output Attributes.

Analog Output Commands
The table below lists the commands supported by the Analog Output Object.
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Table 209: Analog Output Commands
ParametersCommand Name
The value to be written to the Present Value. The value must be less than Max
Present value and greater than Min Present Value.

Adjust

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present Value.Operator Override

Out of Service

Release Operator Override1

Attribute name

Command priority
Release1

Attribute nameRelease All1

Setpoint2

1 For the Release Operator Override, Release, and Release All commands, if all Command Priorities have been released and
a Relinquish Default is not defined, the supervisory controller gives control to the actual hardware.

2 Setpoint command is supported by N2 protocol only.

Analog Output Command Details
Adjust
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. The value must be less than Max Present value and greater than Min Present Value.

Important: Be aware that an operator Adjust command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

If Local Control is True, this command is rejected.

The command is only sent when one of the following conditions is met:
1. NOT Local Control and NOT Out Of Service, or
2. NOT Local Control and after issuing the In Service command.

Back to Analog Output Commands.

Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Output Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Output Commands.

In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. The Present
Value and Reliability will revert back to the values obtained from the physical hardware output.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Analog Output Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override (8).
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The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when not Out Of Service.

Back to Analog Output Commands.

Out of Service
Allows a user to override the object’s hardware output for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True. The Present Value and Reliability no longer track the physical output.
No commands are sent to the actual hardware. When the Out of Service attribute is set to False, the current Present
Value is sent to the actual hardware.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Analog Output Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Analog Output Commands.

Release
Releases the identified Command Priority from the specified attribute and allows the next highest priority to control
it.

Back to Analog Output Commands.

Release All
Releases Command Priorities 3 through 16 (Default), from the specified, writable attribute. Command Priorities 1
and 2 remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to Analog Output Commands.

Setpoint
Writes the value to the permanent memory of the field device and may change the Present Value if there is no
override.

Back to Analog Output Commands.
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Analog Value Object
Analog Value (AV) objects have similar software characteristics and capabilities to Analog Input Objects; however,
Analog Value objects are not associated with any physical hardware and are the result of a control process or
operator entry. This object allows you to hold an analog value for other objects to reference. For example, an Interlock
Object can reference and base its operation on an analog value such as Outdoor Air Temperature Low Limit.

For general information on Metasys objects, see Common Object Attributes.

Analog Value Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 210: Analog Value Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Flags1
Flags1Data TypeAttribute Name

Any value > 00.01BWCWReal ValueCOV Increment 2

10thsCWCWOne value from
a set

DisplayPrecision

FalseCTrue or FalseIntrinsic
AlarmingDefined

This value is not writable for FEC objects.

This value is writable if the AV is the ZN-SP on
a Net Sensor. This method is the only way to
set the range for the Net Sensor.

1.7E38BWCWReal valueMax Value

This value is not writable for FEC objects.

This value is writable if the AV is the ZN-SP on
a Net Sensor. This method is the only way to
set the range for the Net Sensor.

-1.7E38BWCWReal valueMin Value

Always FalseFalseWTrue or FalseOut of Service

DRWDRWReal valuePresent Value

Set of valuesPriority Array

See the attribute description for details on
Reliability.

No Fault Detected (Reliable), Over Range,
Under Range, Unreliable Other

ReliableBWWOne value from
a set

Reliability

See the attribute description for details on
Status Flags.

In Alarm, Fault, Overridden, Out of Service

False,

False,

False,

False

BSeries of True or
False values

Status Flags
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Table 210: Analog Value Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Flags1
Flags1Data TypeAttribute Name

BlankWWOne type from a
set

Units

FalseBCWTrue or FalseUse Remote
Alarming

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, R - Affected by Object Reliability,
W - Writable

2 This attribute is required if the object supports COV reporting.

Analog Value Attribute Details
COV Increment
Defines the minimum change in the Present Value required for the object to report a change.

Back to Analog Value Attributes.

Display Precision
Defines the decimal rounding and the decimal places to display of the Present Value and associated attributes.

Back to Analog Value Attributes.

Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Analog Value Attributes.

Max Value
Defines the highest reliable value (in engineering units) for the Present Value.

This value is not writable for Analog Value objects in the FEC.

This value is writable if the AV is the ZN-SP on a Net Sensor. This method is the only way to set the range for the
Net Sensor.

Back to Analog Value Attributes.

Min Value
Defines the lowest reliable value (in engineering units) for the Present Value.

This value is not writable for Analog Value objects in the FEC.

This value is writable if the AV is the ZN-SP on a Net Sensor. This method is the only way to set the range for the
Net Sensor.

Back to Analog Value Attributes.

Out of Service
This attribute is always False for this object due to the absence of hardware.

Back to Analog Value Attributes.

Present Value
Indicates the current value of the analog value. Present Value is optionally commandable. The optional Priority
Array must be present for Present Value to be commandable. Values written to Present Value are compared with
the Min Value and Max Value attributes and set the Reliability.

Back to Analog Value Attributes.

386Metasys System Online Help PDF



Priority Array
Contains prioritized commands in effect for the object. The highest priority command is sent to the Present Value
attribute.

Back to Analog Value Attributes.

Reliability
Indicates whether the Present Value is unreliable.

Examples:

• Reliable - No detectable faults
• Unreliable High - Present Value is greater than the Max Value.
• Unreliable Low - Present Value is less than the Min Value.

When Out of Service is True, the Reliability attribute may be written directly.

Back to Analog Value Attributes.

Status Flags
Indicates the general status of the Analog Input object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden at the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Analog Value Attributes.

Units
Indicates the engineering measurement units used by the object.

Back to Analog Value Attributes.

Use COV Min Send Time
Configures the object to send COV messages on a periodic basis instead of on every change of value that exceeds
the COV Increment. This attribute is typically set to True for objects with values that fluctuate greatly, such as air
pressure, to decrease the number of COV messages. The change of value still must exceed the COV Increment to
be reported. This attribute is available only on Metasys system field devices, such as the MS/TP field devices.

Back to Analog Value Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Analog Value Attributes.

Analog Value Commands
The table below lists the commands supported by the Analog Value Object.
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Table 211: Analog Value Object Commands
DescriptionCommand
The value to be written to the Present Value attribute. The value must be less
than Max Present value and greater than Min Present Value.

Adjust

Disable Alarms

Enable Alarms

The value to be written to the Present Value attribute.Operator Override

Release Operator Override

1. Attribute name
2. Command priority

Release

Attribute nameRelease All

Analog Value Command Details
Adjust
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. The value must be less than Max Present value and greater than Min Present Value.

Important: Be aware that an operator Adjust command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

If Local Control is True, this command is rejected.

The command is only sent when one of the following conditions is met:

1. NOT Local Control and NOT Out Of Service, or
2. NOT Local Control and after issuing the In Service command.

Back to Analog Value Commands.

Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Value Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Analog Value Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override (8).

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when not Out Of Service.

Back to Analog Value Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Analog Value Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Analog Value Commands.
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Release All
Releases Command Priorities 3 through 16 from the specified, writable attribute. Command Priorities 1 (Manual
Emergency) and 2 (Fire Application) remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.

If an operator has overridden an input, use the Release Operator Override command.

Back to Analog Value Commands.
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Auto Shutdown Object
When a selected multistate control point is in a specified shutdown state, the Auto Shutdown object suppresses
alarm reporting from a list of dependent objects to prevent nuisance alarms. The Auto Shutdown object accomplishes
this by sending an enable/disable command to each of the dependent object's Alarm objects, based on the control
point’s current state (the value of the Control attribute) and the defined shutdown state. For BACnet intrinsic alarming
and Event Enrollment objects, these commands set and reset the BACnet Alarm Event Enable property flags (To
Off Normal, To Fault, and To Normal) that cause or prevent alarms. A startup delay is provided so that points are
not released immediately from shutdown.

An example of a use for the Auto Shutdown object is to prevent alarms set to monitor the discharge air temperature
of a fan when that fan is turned off. When the fan is turned off, the fan state value is sent to the Auto Shutdown
object. The Auto Shutdown object then evaluates the current state of the point against the Shutdown State defined
in the Auto Shutdown object. If the current point state matches the Shutdown State, the Auto Shutdown object sends
a Disable command to the Alarm object of every referenced dependent object in the Dependents list.

Consequently, when the fan is turned back on, the Auto Shutdown object again evaluates the current state and, if
the current state does not match the Shutdown State, starts the Startup Delay timer. Once the timer expires, the
Auto Shutdown object sends an Enable command to the Alarm object of every referenced dependent object in the
Dependents list.

Note: Changing the Dependents or Shutdown State attribute causes an immediate reevaluation of the current
state. However, changes to the Startup Delay time do not take effect until the next change in the control point
state.

For general information on Metasys system objects, see the Object Help section.

For more information on the wizard used to create an Auto Shutdown object, see Insert Object - Auto Shutdown.

Auto Shutdown Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section.

Click the attribute name in the table for a description of the attribute.

Table 212: Auto Shutdown Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

CAttribute
Reference

Control

Number of Entries = 1–32CWList of Object
Reference

Dependents

TrueTrue or FalseEnabled

NormalCWOne state from a
set

Execution Priority

On = 1

Off = 0

OffROne value from a
set

Present Value

VariousInput UnreliableOne state from a
set

Reliability

Uses the value set of the control point
once the Auto Shutdown object reads
the control point value.

CWOne state from a
set

Shutdown State

Units = Minutes5CWNumberStartup Delay

List of statesStates Text

1 C - Configurable, R - Affected by Object Reliability, W - Writable
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Auto Shutdown Attribute Details
Control
Determines, in conjunction with the Shutdown State, if an alarm shutdown should occur. This is the current state
of the references control point.

Back to Auto Shutdown Attributes.

Dependents
Uses each dependent object identified in this list of object references to locate the Alarm object that is to have its
alarm reporting controlled by the control point.

Back to Auto Shutdown Attributes.

Enabled
Indicates whether the Auto Shutdown object is enabled (True) or disabled (False).

Back to Auto Shutdown Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Auto Shutdown Attributes.

Present Value
Represents the current value of the Auto Shutdown object. When the state is On, the object has disabled the Alarm
objects. When the state is Off, the object has enabled the Alarm objects.

Back to Auto Shutdown Attributes.

Reliability
Reflects the reliability of the control point. When the control point is not reliable, the Reliability attribute becomes
Input Unreliable.

Back to Auto Shutdown Attributes.

Shutdown State
Determines the definition of the shutdown state. When the control point goes to the state defined as the shutdown
state, Auto Shutdown disables alarms from the point.

Back to Auto Shutdown Attributes.

Startup Delay
Represents the time in minutes that must elapse before alarm reporting is re-enabled, once the control point changes
from the Shutdown State to any other state.

Back to Auto Shutdown Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Auto Shutdown Attributes.

Auto Shutdown Commands
The table below lists the commands supported by the Auto Shutdown Object.

Table 213: Auto Shutdown Commands
ParametersCommand Name

Disable

Enable
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Auto Shutdown Command Details
Disable
Prevents the Auto Shutdown object from responding to any change occurring at the Control attribute reference,
including the Reliability associated with the master. Immediately following receipt of this command, an Enable
command is sent to the Alarm object of every referenced dependent object in the Dependents list.

Back to Auto Shutdown Commands.

Enable
Allows the Auto Shutdown object to respond once again to any changes occurring at the control point. Immediately
following receipt of this command, the control point current state is re-evaluated, and the appropriate action is taken
on the items in the Dependents list.

Back to Auto Shutdown Commands.
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BACnet Device Object
Note: The Johnson Controls NAE Device object includes attributes and methods not required by the BACnet Device

object. For information on the NAE Device object, see the Engine Device Object section.

Note: The Object Type for this object is labeled Non-FEC BACnet Device in the software.

The BACnet Device object defines a standardized BACnet object with attributes that represent the external, visible
characteristics of a device. Only one Device object exists in each BACnet Device.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the BACnet Device object, see BACnet Device Attributes.

BACnet Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 214: BACnet Device Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

FalseWTrue or FalseAlign Intervals

3WNumberAPDU Retries

4,000WNumberAPDU Segment Timeout2

The default is 6,000 milliseconds for devices
that permit modification of this attribute. The
default value is 60,000 milliseconds for all
other devices.

See next columnNumberAPDU Timeout

ListActive COV Subscriptions3

ListActive VT Sessions4

TextAppl SW Version

Units = Seconds120WNumberBackup Fail Timeout5

Set of valuesConfiguration Files6

True, FalseWTrue or FalseDST Status

NumberDatabase Revision

Unrestricted rangeWTextDescription

WListDevice Addr Binding

TextFirmware Version

CWObject referenceGraphic

Maximum 256 charactersCWTextGraphic Alias

Units = Minutes0CWNumberInterval Offset

One value from a
set

Last Restore Time6

ListList of Session Keys

WDateLocal Date

WTimeLocal Time

WTextLocation
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Table 214: BACnet Device Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueFlags1Data TypeAttribute Name

Greater or equal to 50NumberMax APDU Length

10 (FEC)

20 (NxE)

NumberMax Info Frames7

127NumberMax Master7

NumberMax Segments Accepted

TextModel Name

FalseTrue or FalseOffline

TextProfile Name

Series of True or
False values

Protocol Obj Support

NumberProtocol Revision

Series of True or
False values

Protocol Ser Support

NumberProtocol Version

CWStructureRestart Notification
Recipients

Segmented Both,

Segmented Transmit,

Segmented Receive,

No Segmentation

One type from a
set

Segmentation

Operational, Operational Read Only,
Download Required, Download in Progress,
Nonoperational, Backup in Progress

DOne type from a
set

System Status

Units = Minutes0CWNumberTime Synchronization
Interval

Zero or moreWListTime Sync Recipients8

-720 though +720WNumberUTC Offset

ListVT Classes Supported 4

NumberVendor ID

TextVendor Name

1 C - Configurable, D - Default Attribute for Display, W - Writable
2 If segmentation of any kind is supported, this is required.
3 If the device supports execution of either the Subscribe COV or Subscribe COV Property service, this attribute is required.
4 If either Video Terminal (VT) Classes Supported or Active VT Sessions is present, both are present. If the Protocol Implementation

Conformance Statement (PICS) indicates support for VT Services, both of these attributes are present.
5 If the device supports the backup and restore procedures, this attribute must be present and writable.
6 If the device supports the backup and restore procedures, these attributes are required.
7 If the device is an MS/TP master node, these attributes are required.
8 If PICS indicates the device is a Time Master, this is required. If present, this attribute is writable.
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BACnet Device Attribute Details
Align Intervals
Specifies whether clock-aligned periodic time synchronization is enabled. If periodic time synchronization is enabled
and the time synchronization interval is a factor of an hour or a day (that is, the value divides without remainder),
then the beginning of the period specified for time synchronization aligns to the hour or day, respectively.

Back to BACnet Device Attributes.

APDU Retries
Indicates the maximum number of times that an Application Protocol Data Unit (APDU) is retransmitted. The default
value is 3. If this device does not perform retries, then this attribute is zero. If the value of this attribute is greater
than zero, a nonzero value is placed in the Device object APDU Timeout attribute.

Back to BACnet Device Attributes.

APDU Segment Timeout
Indicates the amount of time in milliseconds between retransmissions of an APDU segment. This value is nonzero
if APDURetries is nonzero. The APDU Segment Timeout attribute is present if segmentation of any kind is supported.

In order to achieve reliable communication, the values of the APDU Segment Timeout attributes of the Device objects
of all intercommunicating devices should contain the same value.

Back to BACnet Device Attributes.

APDU Timeout
Indicates the amount of time in milliseconds between retransmissions of an APDU requiring acknowledgement for
which no acknowledgement has been received. This value is nonzero if APDU Retries is nonzero.

In order to achieve reliable communication, the values of the APDU Timeout attributes of the Device objects of all
intercommunicating devices should contain the same value.

Back to BACnet Device Attributes.

Active COV Subscriptions
Contains a list of BACnet COV Subscriptions, each of which consists of a Recipient, a Monitored Property Reference,
an Issue Confirmed Notifications flag, a Time Remaining value, and an optional COV Increment. This attribute
provides a network-visible indication of those COV subscriptions active at any given time. Whenever a COV
Subscription is created with the Subscribe COV or Subscribe COV Property service, a new entry is added to the
Active COV Subscriptions list. Similarly, whenever a COV Subscription is terminated, the corresponding entry is
removed from the Active COV Subscriptions list.

If the device supports execution of either Subscribe COV or Subscribe COV Property service, this attribute is required.

Back to BACnet Device Attributes.

Active VT Sessions
Specifies a list containing a Local Video Terminal (VT) Session Identifier, a Remote VT Session Identifier, and
Remote VT Address. This attribute provides a network-visible indication of those VT sessions that are active. When
a VT session is created with the VT-Open service, a new entry is added to the Active VT Sessions list. When a VT
session terminates, the corresponding entry is removed from the Active VT Sessions list. If either VT Classes
Supported or Active VT Sessions is present, then both are present. Both are required if support of VT Services is
indicated in the PICS.

Back to BACnet Device Attributes.

Appl SW Version
Identifies the version of the application software installed in the device. The content of this string is locally defined
(date-and-time stamp, a programmer’s name, a host file version number, and so on).

Back to BACnet Device Attributes.
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Backup Fail Timeout
Indicates the number of seconds that the device being backed up or restored waits before unilaterally ending the
backup or restore procedure. This attribute is writable (the device performing the backup, or the operator, configures
this with an appropriate timeout).

Back to BACnet Device Attributes.

Configuration Files
Identifies the files within the device that determine what device image can be backed up. The contents of this attribute
are only required to be valid during the backup procedure. If the device supports the BACnet backup and restore
procedure, this attribute is supported.

Back to BACnet Device Attributes.

DST Status
Indicates whether Daylight Saving Time (DST) time is in effect (True) or not (False).

Back to BACnet Device Attributes.

Database Revision
Specifies a logical revision number for the device’s database. Database Revision is incremented when an object is
created or deleted, an object name changes, or a restore is performed.

Back to BACnet Device Attributes.

Description
Contains a string of printable characters used to describe the application being run by the device or other descriptive
information.

Back to BACnet Device Attributes.

Device Addr Binding
Contains a list of BACnet Object Identifiers of a BACnet Device object and a BACnet device address in the form of
a BACnet Address. Entries in the list identify the actual device addresses that are used when accessing the remote
device via a BACnet service request. The list may be empty if no device identifier-device address bindings are
currently known to the device.

Back to BACnet Device Attributes.

Firmware Version
Contains a number assigned by the vendor to represent the level of firmware installed in the device.

Back to BACnet Device Attributes.

Graphic
Indicates the graphic associated with the object.

Back to BACnet Device Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to BACnet Device Attributes.

Interval Offset
Specifies the offset, in minutes, from the beginning of the period defined for time synchronization until the actual
time synchronization requests are set. Interval Offset has no effect when Align Intervals is False.

Back to BACnet Device Attributes.

Last Restore Time
Specifies when the device’s image was last restored. If the device supports the BACnet backup and restore
procedures, this attribute is supported.
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Back to BACnet Device Attributes.

List of Session Keys
Contains a list of the cryptographic keys used to communicate with other security-conscious BACnet Devices. This
attribute is not readable or writable by any device except a device designated the Key Server. A session key consists
of a 56-bit encryption key and a BACnet Address of the peer with which secure communications is requested.

Back to BACnet Device Attributes.

Local Date
Indicates the date. If the device has no knowledge of time or date, Local Date is omitted.

Back to BACnet Device Attributes.

Local Time
Indicates the time of day. If the device has no knowledge of time or date, Local Time is omitted.

Back to BACnet Device Attributes.

Location
Indicates the physical location of the device.

Back to BACnet Device Attributes.

Max APDU Length
Specifies the maximum number of octets contained in a single, indivisible application layer protocol unit. Underlying
data link technology constrains the value of this attribute.

Back to BACnet Device Attributes.

Max Info Frames
Specifies the maximum number of information frames the node may send before it passes the token. This attribute
is present if the device is a node on an MS/TP network. If Max Info Frames is not writable or otherwise user
configurable, its value is one.

Back to BACnet Device Attributes.

Max Master
Specifies the highest possible address for master nodes and is less than or equal to 127. This is present if the device
is a master node on an MS/TP network. If Max Master is not writable via BACnet services, its value is 127.

Back to BACnet Device Attributes.

Max Segments Accepted
Indicates the maximum number of segments of an Application Protocol Data Unit (APDU) accepted by the device.

Back to BACnet Device Attributes.

Model Name
Contains a name assigned by the vendor to represent the model of the device.

Back to BACnet Device Attributes.

Offline
Displays the offline or online status of connected hardware.

Back to BACnet Device Attributes.

Profile Name
Contains a string of characters that represents the name of the object profile to which the object conforms. A profile
name must begin with a vendor identifier code in base-10 integer format, followed by a dash. The vendor identifier
code indicates the organization that administers the remaining characters of the profile name, and publishes and
maintains the profile document identified by the profile name. The vendor identifier does not need to match the
vendor identifier of the device in which the object resides.
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Back to BACnet Device Attributes.

Protocol Obj Support
Indicates which standardized object types the device’s protocol implementation supports. This attribute reflects the
minimum set of object types, but implementation often supports additional standard and non-standard object types
with their own set of attributes. (The list of attributes supported for a particular object may be acquired by use of the
Read Property Multiple service with an attribute reference of All.)

Back to BACnet Device Attributes.

Protocol Revision
Indicates the minor revision level of the BACnet standard. This starts at 1 and increases for each subsequent release.
If the Protocol Version attribute changes, this number reverts to zero. This attribute is required for all devices with
BACnet Protocol Version 1, Protocol Revision 1 and above. If this attribute is not present, the device is Protocol
Version 1, Protocol Revision 0.

Back to BACnet Device Attributes.

Protocol Ser Support
Indicates which standardized protocol services the device’s protocol implementation supports. This attribute reflects
the minimum set of services, but implementation often supports additional standardized services.

Back to BACnet Device Attributes.

Protocol Version
Represents the BACnet protocol the device supports. Initial releases are Version 1; subsequent releases increase
the number by one.

Back to BACnet Device Attributes.

Restart Notification Recipients
Controls the restrictions on which devices, if any, are notified when a restart occurs. The value of this attribute is a
list of BACnet Recipients. When the length of this list is empty, the device cannot send a device restart notification.
The default value of this property is a single entry representing a broadcast on the local network. If the list has one
or more entry, the device sends a restart notification, but only to the devices or addresses listed.

Back to BACnet Device Attributes.

Segmentation
Indicates if the BACnet device supports segmentation of messages. If so, it supports segmented transmission,
reception, or both.

Back to BACnet Device Attributes.

System Status
Reflects the current physical and logical state of the device.

Back to BACnet Device Attributes.

Time Synchronization Interval
Specifies the periodic interval, in minutes, at which TimeSynchronization and UTCTimeSynchronization requests
are sent. When set to zero, then periodic time synchronization is disabled.

Back to BACnet Device Attributes.

Time Sync Recipients
Controls the restrictions placed on a device’s use of the Time Synchronization service. If the list is of length zero, a
device is prohibited from automatically sending a Time Synchronization request. If the list is of length one or more,
a device automatically sends a Time Synchronization request but only to the devices or addresses listed. If it is
present, this attribute is writable. If the PICS indicates that this device is a Time Master, then Time Synchronization
Recipients is present.

Back to BACnet Device Attributes.
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UTC Offset
Indicates the number of minutes offset between local standard time and UTC. The Time Zones to the west of the
zero degree meridian are positive and those to the east are negative. Subtract the value of the UTC Offset from the
UTC received in the UTC Time Synchronization service requests to calculate the correct local standard time.

Back to BACnet Device Attributes.

VT Classes Supported
Contains a list of BACnet Video Terminal (VT) Classes that indicate a particular set of terminal characteristics. A
device often supports multiple types of behaviors for differing types of terminals or differing types of operator interface
programs. If either VT Classes Supported or Active VT Sessions is present, then both are present. Both are required
if support of VT Services is indicated in the PICS.

Back to BACnet Device Attributes.

Vendor ID
Distinguishes proprietary extensions to the protocol with a unique ASHRAE vendor ID code.

Back to BACnet Device Attributes.

Vendor Name
Identifies the manufacturer of the device.

Back to BACnet Device Attributes.
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BACnet Integration Object
The BACnet Integration object manages the communication with a BACnet network. All integrated BACnet devices
and objects appear under the BACnet Integration object in the Navigation Tree.

The BACnet Integration object serves as the root for all integrated BACnet objects on an Ethernet trunk. The BACnet
Integration object is a direct child of a supervisory controller and integrates BACnet devices using the Ethernet trunk.

For general information on Metasys system objects, see the Object Help section.

For detailed information on the BACnet Integration object, see BACnet Integration Attributes.

BACnet Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 215: BACnet Integration Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
Notes1Data TypeAttribute Name

NumberCount

Structure elements:

• network number (see attribute description)
• high limit device instance (Range: 1–4,194,302)
• low limit device instance (Range: 1–4,194,302)

CWStructureDevice Discovery Range

0–65,535

Units = seconds

60CWNumberPeriodic Update

Milliseconds

10–50

CWNumberPoll Delay

TrueCWTrue or FalsePreserve Discovered
Devices

0–65,535

The current list of Vendor IDs can be viewed at
http://www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm.

CNWNumberRequested Vendor ID

1 C - Configurable, N - Value Not Required, W - Writable

Table 216: BACnet Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

ListDuplicate Device
Identifiers

0–4,294,967,295

Units = seconds

NumberExecution Time

NumberPolled Object Count

1 C - Configurable, N - Value Not Required, W - Writable
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BACnet Integration Attribute Details
Count
Indicates the number of BACnet objects defined for this integration.

Back to BACnet Integration Attributes.

Device Discovery Range
Contains the destinations for the Who-Is message sent during the device autodiscovery process. When the list is
empty, the object sends a global broadcast in the form of the Who-Is. Adding entries to the list limits the scope of
the Who-Is broadcast to only the networks and device instance ranges specified. Multiple entries to this list cause
the object to send multiple Who-Is messages sequentially.

Table 217: Device Discovery Range Network Number
Network NumbersBroadcast Type
0 (locked for editing)Local

65,535 (locked for editing)Global

1–65,534 (editable)Remote

Back to BACnet Integration Attributes.

Duplicate Device Identifiers
Lists any duplicate BACnet Device Object Identifiers found after an auto-discovery of BACnet devices is performed.
The list contains the instance number of the BACnet Device Object Identifier and the network address (represented
in hex notation) of each device with the same identifier instance number as another device on the network. The
devices in this list are not included in the list of auto-discovered devices in the integration tree under the Engineering
tab of the BACnet Integration object. The physical locations of BACnet devices with duplicate device identifiers must
be determined, and their object identifiers changed to make them unique network-wide.

Back to BACnet Integration Attributes.

Execution Time
Records the amount of time taken for the last periodic update of all integrated BACnet objects. The value for this
attribute can be used to tune the Periodic Update attribute. If the Execution Time is greater than the Periodic Update,
attribute values of integrated BACnet objects are constantly being updated over the network.

Back to BACnet Integration Attributes.

Periodic Update
Specifies how frequently integrated BACnet objects update their attribute values. Every period, the BACnet Integration
object prompts each integrated BACnet object that needs to update its attribute values. Also see the Execution
Time attribute.

Back to BACnet Integration Attributes.

Poll Delay
Specifies the time in milliseconds between BACnet object polls for attribute values. The polls start at the time specified
in the Periodic Update attribute. As the Poll Delay increases, the overall time in the Execution Time attribute
increases. It is useful to specify a Poll Delay on sites where the rate of reading the remote objects causes too high
a burden on the Metasys network or third-party device. The initial value of the Poll Delay attribute is blank (zero).

Back to BACnet Integration Attributes.

Polled Object Count
Indicates the number of mapped BACnet objects currently being polled on a periodic basis. The polling is limited to
those mapped BACnet objects which are currently being accessed either by a feature or the UI (the Instance Number
is typically smaller than the total Count).

Back to BACnet Integration Attributes.
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Preserve Discovered Devices
Controls the behavior when field device discovery is started. When this value is True, any devices which were
previously discovered or already mapped remain in the list of discovered devices, without any attempt to reestablish
communication with them. If this value is False, an attempt is made to reestablish communication with all devices,
and devices which do not respond are not shown in the list of discovered devices. Set this value to False to rediscover
devices which have been re-addressed on the network.

Back to BACnet Integration Attributes.

Requested Vendor ID
Specifies a Vendor ID when discovering new devices to limit the device list displayed to that specified Vendor ID.
The default value of this attribute is Null (stored as zero) which allows all vendors to be discovered and displayed.

The current list of Vendor IDs can be viewed at http://www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm.

Note: If you do not want to display devices already discovered or mapped, then set Preserve Discovered Devices
to False.

Back to BACnet Integration Attributes.
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BACnet Protocol Engine Object
The BACnet Protocol Engine object maintains diagnostic statistics on communications with the BACnet devices on
the network.

For general information on Metasys system objects, see the Object Help section.

BACnet Protocol Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 218: BACnet Protocol Engine Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberAbort Rcv

0NumberAbort Tx

0NumberAck Rcv

0NumberAck Tx

0NumberAllocated Record Count

FalseTrue or FalseClear Statistic

0NumberConf Req Rcv

0NumberConf Req Tx

0NumberError Rcv

0NumberError Tx

FalseTrue or FalseLatch Statistics

0NumberLocal Abort Tx

0NumberNet Messages Rcv

0NumberNet Messages Tx

0NumberNet Rejects Rcv

0NumberNet Routed Messages

0NumberNet Routes Busy

0NumberNet Unknown Msg Rcv

0NumberNet Unknown Routes

0NumberPeak Pending Queue
Count

0NumberPeak Unknown Queue
Count

0NumberPending Queue Count

0NumberRcvMessagesDiscarded

0NumberRcv Msg Rate

0NumberRcv Record Count

0NumberRecord Count

0NumberReject Rcv

0NumberReject Tx
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Table 218: BACnet Protocol Engine Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberReq Retries Tx

DateReset Date

TimeReset Time

0NumberSeg Ack Rcv

0NumberSeg Ack Tx

0NumberSeg Conf Req Rcv

0NumberSeg Conf Req Tx

0NumberSeg Retries Tx

0NumberSegment Ack Rcv

0NumberSegment Ack Tx

0NumberSegment Rcv

0NumberSegment Tx

0NumberSimple Ack Rcv

0NumberSimple Ack Tx

0NumberTransaction Timeouts

0NumberTransmits Per Minute

0NumberTx Messages Discarded

0NumberTx Record Count

0NumberUnconfirmed Rcv

0NumberUnconfirmed Tx

0NumberUnknown Queue Count

1 C - Configurable, N - Value Not Required, W - Writable

BACnet Protocol Engine Attribute Details
Abort Rcv
Contains the number of abort messages received. Aborts occur in response to a number of situations, such as
communication or memory problems.

Back to BACnet Protocol Engine Attributes.

Abort Tx
Contains the number of abort messages sent.

Back to BACnet Protocol Engine Attributes.

Ack Rcv
Contains the number of complex acknowledgement messages received.

Back to BACnet Protocol Engine Attributes.

Ack Tx
Contains the number of complex acknowledgement messages sent.

Back to BACnet Protocol Engine Attributes.

Allocated Record Count
Indicates the number of state machines that have been allocated.

Back to BACnet Protocol Engine Attributes.
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Clear Statistic
Resets all of the attributes containing diagnostic statistics.

Back to BACnet Protocol Engine Attributes.

Conf Req Rcv
Contains the number of confirmed request messages received.

Back to BACnet Protocol Engine Attributes.

Conf Req Tx
Contains the number of confirmed request messages sent.

Back to BACnet Protocol Engine Attributes.

Error Rcv
Contains the number of error messages received. An example of an error is an attempt to write to a read-only
attribute.

Back to BACnet Protocol Engine Attributes.

Error Tx
Contains the number of error messages sent.

Back to BACnet Protocol Engine Attributes.

Latch Statistics
Updates the displayed statistics with the current values.

Back to BACnet Protocol Engine Attributes.

Local Abort Tx
Contains the number of application layer abort messages generated locally (for example, messages that used up
all allowed retries and did not get an acknowledge from the remote device).

Back to BACnet Protocol Engine Attributes.

Net Messages Rcv
Contains the number of messages received at the network layer.

Back to BACnet Protocol Engine Attributes.

Net Messages Tx
Contains the number of messages transmitted at the network layer.

Back to BACnet Protocol Engine Attributes.

Net Rejects Rcv
Contains the number of reject messages received at the network layer.

Back to BACnet Protocol Engine Attributes.

Net Routed Messages
Contains the number of messages routed through the network layer from one network (for example, IP) to another
(for example, MS/TP).

Back to BACnet Protocol Engine Attributes.

Net Routes Busy
Contains the number of messages not sent because the network route is busy or not initialized.

Back to BACnet Protocol Engine Attributes.

Net Unknown Msg Rcv
Contains the number of unknown messages received at the network layer.

Back to BACnet Protocol Engine Attributes.
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Net Unknown Routes
Contains the number of messages not sent due to unknown route information.

Back to BACnet Protocol Engine Attributes.

Peak Pending Queue Count
Indicates the largest number of client requests that were queued for transmission.

Back to BACnet Protocol Engine Attributes.

Peak Unknown Queue Count
Indicates the largest number of client requests the unknown queue contained at one time.

Back to BACnet Protocol Engine Attributes.

Pending Queue Count
Indicates the number of client requests currently queued for transmission.

Back to BACnet Protocol Engine Attributes.

Rcv Messages Discarded
Indicates the number of messages received from the network that were not processed due to lack of resources or
because there were to many requests for the Metasys Engine to process.

Back to BACnet Protocol Engine Attributes.

Rcv Msg Rate
Indicate the number of messages received in the last minute.

Back to BACnet Protocol Engine Attributes.

Rcv Record Count
Indicate the number of active state machines currently in use for receipt of requests from other BACnet devices (that
is, the number of requests being processed at this moment).

Back to BACnet Protocol Engine Attributes.

Record Count
Indicates the number of active state machines holding information on pending messages.

Back to BACnet Protocol Engine Attributes.

Reject Rcv
Contains the number of reject messages received. Rejects occur in response to a variety of communication problems
much like aborts and errors.

Back to BACnet Protocol Engine Attributes.

Reject Tx
Contains the number of reject messages sent.

Back to BACnet Protocol Engine Attributes.

Req Retries Tx
Contains the number of confirmed request messages re-sent due to timeout.

Back to BACnet Protocol Engine Attributes.

Reset Date
Indicates the date of the last Clear Statistic command.

Back to BACnet Protocol Engine Attributes.

Reset Time
Indicates the time of the last Clear Statistic command.

Back to BACnet Protocol Engine Attributes.
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Seg Ack Rcv
Contains the number of segmented complex acknowledgement messages received.

Back to BACnet Protocol Engine Attributes.

Seg Ack Tx
Contains the number of segmented complex acknowledgement messages sent.

Back to BACnet Protocol Engine Attributes.

Seg Conf Req Rcv
Contains the number of segmented confirmed request messages received.

Back to BACnet Protocol Engine Attributes.

Seg Conf Req Tx
Contains the number of segmented confirmed request messages sent.

Back to BACnet Protocol Engine Attributes.

Seg Retries Tx
Contains the number of segmented confirmed request messages re-sent due to timeout.

Back to BACnet Protocol Engine Attributes.

Segment Ack Rcv
Contains the number of segment acknowledgement messages received.

Back to BACnet Protocol Engine Attributes.

Segment Ack Tx
Contains the number of segment acknowledgement messages sent.

Back to BACnet Protocol Engine Attributes.

Segment Rcv
Contains the number of segment messages received.

Back to BACnet Protocol Engine Attributes.

Segment Tx
Contains the number of segment messages sent.

Back to BACnet Protocol Engine Attributes.

Simple Ack Rcv
Contains the number of simple acknowledgement messages received.

Back to BACnet Protocol Engine Attributes.

Simple Ack Tx
Contains the number of simple acknowledgement messages sent.

Back to BACnet Protocol Engine Attributes.

Transaction Timeouts
Indicates the number of MS/TP Postpone messages sent due to a late reply to a received Confirmed Request
message (that is, this device’s applications could not process the request before a low-level MS/TP answer was
required).

Back to BACnet Protocol Engine Attributes.

Transmits Per Minute
Displays the calculated number of transmissions per minute.

Back to BACnet Protocol Engine Attributes.
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Tx Messages Discarded
Indicates the number of client requests aborted due to lack of resources. Usually, this situation occurs due to memory
issues in the controller.

Back to BACnet Protocol Engine Attributes.

Tx Record Count
Indicates the number of active state machines currently in use for transmission of client requests.

Back to BACnet Protocol Engine Attributes.

Unconfirmed Rcv
Contains the number of unconfirmed messages received.

Back to BACnet Protocol Engine Attributes.

Unconfirmed Tx
Contains the number of unconfirmed messages sent.

Back to BACnet Protocol Engine Attributes.

Unknown Queue Count
Indicates the number of current client requests that need network address resolution.

Back to BACnet Protocol Engine Attributes.

BACnet Protocol Engine Commands
The table below lists the commands supported by the BACnet Protocol Engine Object.

Table 219: BACnet Protocol Engine Commands
ParametersCommand Name
NoneClear Statistics

NoneLatch Statistics

BACnet Protocol Engine Command Details
Clear Statistics
Resets all of the attributes containing diagnostic statistics.

Back to BACnet Protocol Engine Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to BACnet Protocol Engine Commands.
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Binary Input Object
The Binary Input (BI) object’s attributes represent the external, visible characteristics of a binary input. As a binary
input, this object can be in either an Active or Inactive state. The Polarity attribute allows for normally open relays
that are Active when energized and normally closed relays that are Inactive when energized.

The Binary Input object integrates N1, N2, and BACnet controllers into supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous set to the user
interface

• flexibility in point mapping
• support for all Metasys controllers. See the N2 Controller Object section.

For example, this object allows you to map a fan status into a supervisory controller.

For general information on Metasys system objects, see Common Object Attributes.

Binary Input Concepts
BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is determined by the
Polarity attribute.

The table below describes this relationship as defined by BACnet standards. Johnson Controls Polarity is always
Normal. Johnson Controls N2 protocol does not support changes to the Polarity attribute.

Table 220: BACnet Polarity Relationships
Physical State of the Monitored
Device

Physical State of the Hardware
Input

PolarityPresent Value

not runningOff or InactiveNormalInactive

runningOn or ActiveNormalActive

not runningOn or ActiveReverseInactive

runningOff or InactiveReverseActive

Binary Input Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 221: Binary Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Limit: 20 charactersBTextActive Text2

BDate/TimeActive Time Reset3

0–4,294,967,295BWNumberCOS Count4

BDate/TimeCOS Time4

Limit: 20 charactersNullBWCWTextDevice Type

0–4,294,967,295

Units = seconds

NullBNumberElapsedActive Time
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Table 221: Binary Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Limit: 20 charactersBTextInactive Text2

FalseCTrue or FalseIntrinsic Alarming
Defined

FalseBWCWTrue or FalseOut of Service

Normal, ReverseBWOne value from a
set

Polarity

0BWDNRWReal valuePresent Value

No Fault Detected (Reliable), No Sensor,
Open Loop, Shorted Loop, Unreliable
Other, Communication Failure

ReliableBWWOne state from a
set

Reliability

BDate/TimeState Count Reset4

Off

On

CWOne value from a
list

States Text

In Alarm, Fault, Overridden, Out of ServiceFalse,

False,

False,

False

BSeries of True or
False values

Status Flags

FalseBCWTrue or FalseUse Remote
Alarming

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, R -
Affected by Object Reliability, W - Writable

2 If either Inactive Text or Active Text is present, both are present.
3 If either Elapsed Active Time or Time of Active Time Reset is present, both are present.
4 If Change of State Time, Change of State Count, or Time of State Count Reset is present, all are present.

Binary Input Attribute Details
Active Text
Characterizes the intended effect of the Active state of Present Value from the viewpoint of the operator. The content
of this string is a local matter but is intended to represent a readable description of the Active state.

For example, if the physical input is a switch contact, then the Active Text attribute is assigned a value such as Fan
1 On. If either the Active Text or the Inactive Text attribute is present, both of them are present.

Back to Binary Input Attributes.

Active Time Reset
Represents the last date and time Elapsed Active Time was set to a zero value. If either Elapsed Active Time or
Time of Active Time Reset is present, all are present.

Back to Binary Input Attributes.

COS Count
Represents the number of times the Present Value attribute changes state since the COS Count attribute was most
recently set to zero. A change of state is any event that alters Present Value. This attribute persists in the archive.

Back to Binary Input Attributes.
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COS Time
Represents the date and time at which the most recent change of state occurred. A change of state is any event
that alters the Present Value attribute. When Out of Service is False, a change to the Polarity attribute alters Present
Value and is considered a change of state. When Out of Service is True, changes to Polarity do not cause changes
of state.

Back to Binary Input Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to Binary Input Attributes.

Elapsed Active Time
Represents the accumulated number of seconds Present Value is Active since the Elapsed Active Time attribute
was most recently set to zero. This attribute value updates automatically a minimum of once a day.

Back to Binary Input Attributes.

Inactive Text
Characterizes the intended effect of the Inactive state of Present Value attribute from the viewpoint of the operator.
The content of this string is a local matter, but it is intended to represent a readable description of the Inactive state.

For example, if the physical input is connected to a switch contact, then the Inactive Text attribute is assigned a
value such as Fan 1 Off. If either the Inactive Text or Active Text attribute is present, both are present.

Back to Binary Input Attributes.

Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Binary Input Attributes.

Out of Service
Indicates (when True) that the Present Value and Reliability attributes are decoupled from the physical input to the
object and their values may be changed for simulation or testing purposes. Functions that depend on the values of
the Present Value or Reliability attributes continue to respond to changes while Out of Service is True, as if those
changes had come from the physical input.

Additionally, the Out of Service state of the Status Flags attribute is set to True and the Fault state is decoupled
from the physical input when Out of Service is True.

Back to Binary Input Attributes.

Polarity
Indicates the relationship between the physical state of the input and the logical state represented by Present Value.
The Johnson Controls N2 Polarity attribute is always Normal.

Back to Binary Input Attributes.

Present Value
Indicates the current value of the binary input. Polarity determines the relationship between Present Value and the
state of the input. When Out of Service is True, Present Value is writable.

Back to Binary Input Attributes.

Reliability
Indicates if the Present Value is unreliable.

Examples:

• Reliable - No detectable faults
• Communication Failure - Communication to the sensor or device reading the sensor has failed.
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When Out of Service is True, the Reliability attribute may be written directly.

Back to Binary Input Attributes.

State Count Reset
Represents the date and time the COSCount attribute was most recently set to a zero value. IfCOS Time or Change
of State Count is present, both are present.

Back to Binary Input Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Binary Input Attributes.

Status Flags
Indicates the general status of the input object in BACnet terms and contains four independent states.

The four flags are:

• In Alarm - False if the Event State attribute value is Normal; otherwise, the In Alarm flag is True. (Set only by
BACnet Intrinsic Alarming.)

• Fault - True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False.
• Overridden - Overridden flag is True if the Present Value is overridden from the hardware source level.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Binary Input Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Binary Input Attributes.

Binary Input Commands
The table below lists the commands supported by the Binary Input Object.

Table 222: Binary Input Commands
Number of ParametersCommand Name

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present Value.Out of Service

Binary Input Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Binary Input Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.
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Back to Binary Input Commands.

In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. The Present
Value and Reliability will revert back to the values obtained from the physical input.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Binary Input Commands.

Out of Service
Allows a user to override the object’s hardware input for simulation or other purposes. The Out of Service command
will change the Out of Service attribute to True, write the Present Value to the value of the command parameter and
write the Reliability attribute to Reliable. The Present Value and Reliability will no longer track the physical input.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Binary Input Commands.
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Binary Output Object
The BO object’s attributes represent the external, visible characteristics of a binary output. As a binary output, this
object can be in either an Active or Inactive state. The Polarity attribute allows for normally open relays that are
Active when energized and normally closed relays that are Inactive when energized. This object integrates N1, N2,
and BACnet controllers into supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous set to the user
interface

• flexibility in point mapping
• support for all Metasys controllers. See N2 Controller Object.

For example, this object allows you to start or stop a fan from a supervisory controller.

For general information on Metasys system objects, see Common Object Attributes.

Binary Output Concepts
BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is determined by the
Polarity attribute.

Note: The table below describes this relationship as defined by BACnet standards. Johnson Controls Polarity is
always Normal. Johnson Controls does not support changes to the Polarity attribute.

Table 223: BACnet Polarity Relationships
Physical State of the Monitored
Device

Physical State of the
Hardware Input

PolarityPresent Value

not runningOff or InactiveNormalInactive

runningOn or ActiveNormalActive

not runningOn or ActiveReverseInactive

runningOff or InactiveReverseActive

Binary Output Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 224: Binary Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

Limit: 20 charactersTextActive Text

Date/TimeActive Time Reset

0–4,294,967,2950WNumberCOS Count

Date/TimeCOS Time

Limit: 20 charactersNullWCWTextDevice Type

0–4,294,967,295

Units = seconds

0NumberElapsed Active Time

Range: 0–255 Seconds0Not
supported

CWNumberHeavy Equip Delay
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Table 224: Binary Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

1–5Not
supported

CWNumberHED Controller

Limit: 20 charactersTextInactive Text

False

True

FalseNot
supported

CTrue or FalseIntrinsic Alarming
Defined

0–604,800

Units = seconds

0WCWNumberMin Off Time

0–604,800

Units = seconds

0WCWNumberMin On Time

False

True

WTrue or FalseOut of Service

Normal, ReverseOne value from a
set

Polarity

Inactive, Active States Text attribute identifies
the value set for this attribute.

DRWDRWOne value from a
set

Present Value

Set of valuesPriority Array

No Fault Detected (Reliable), No Output, Open
Loop, Shorted Loop, Unreliable Other,
Communication Failure

ReliableOne value from a
set

Reliability

Date/TimeState Count Reset

Off

On

CWOne value from a
set

States Text

In Alarm, Fault, Overridden, Out of ServiceFalse,

False,

False,

False

Series of True or
False states

Status Flags

FalseBCWTrue or FalseUse Remote
Alarming

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object’s Reliability, W - Writable

Binary Output Attribute Details
Active Text
Characterizes the intended effect of the Active state of Present Value from the viewpoint of the operator. The content
of this string is a local matter but is intended to represent a readable description of the Active state.

For example, if the physical output is a switch contact, then the Active Text attribute is assigned a value such as
Fan 1 On. If either the Active Text or the Inactive Text attribute is present, both of them are present.

Back to Binary Output Attributes.

Active Time Reset
Represents the last date and time Elapsed Active Time set to a zero value. If either Elapsed Active Time or Active
Time Reset is present, both are present.

Back to Binary Output Attributes.
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COS Count
Represents the number of times the Present Value attribute changed state since the COS Count attribute was last
set to zero. A change of state is any event that alters Present Value. This attribute persists in the archive.

Back to Binary Output Attributes.

COS Time
Represents the date and time at which the most recent change of state occurred. A change of state is any event
that alters the Present Value attribute. When Out of Service is False, a change to the Polarity attribute alters Present
Value and is considered a change of state. Changes to Polarity do not cause changes of state.

Back to Binary Output Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to Binary Output Attributes.

Elapsed Active Time
Represents the accumulated number of seconds Present Value is Active since the Elapsed Active Time attribute
was last set to zero. This attribute value updates automatically a minimum of once a day.

Back to Binary Output Attributes.

Heavy Equip Delay
Indicates the amount of time that this output point adds to the Accumulated Delay attribute of the Heavy Equipment
Controller (HEC) object when this point is started. The next output point is delayed by that amount of time of the
HEC Accumulated Delay is not already decremented to zero.

The NAE device’s five internal Heavy Equipment Controller objects (see HED Controller) time their delays
independently of one another. For example, HED 1 and HED 4 can count down their delays at the same time.

Back to Binary Output Attributes.

HED Controller
Identifies the Heavy Equipment Controller (HEC) object managing the delays.

The NAE device has five internal Heavy Equipment Controller objects for use by BO and Multistate Output (MO)
objects. The BO and MO objects reference the Heavy Equipment Delay (HED) controller objects by number (1-5).

All BO and MO objects on an NAE share the five internal HED controller objects. For example, if BO1 and MO3 on
NAE-1 reference HED controller 1, they are using the same HED controller.

Also see Heavy Equip Delay.

Back to Binary Output Attributes.

Inactive Text
Characterizes the intended effect of the Inactive state of Present Value attribute from the viewpoint of the operator.
The content of this string is a local matter, but it is intended to represent a readable description of the Inactive state.

For example, if the physical output is connected to a switch contact, then the Inactive Text attribute is assigned a
value such as Fan 1 Off. If either the Inactive Text or Active Text attribute is present, then both are present.

Back to Binary Output Attributes.

Intrinsic Alarming Defined
Enables the definition of the intrinsic alarm related attributes.

Back to Binary Output Attributes.

Min Off Time
Represents the fewest number of seconds Present Value remains in the Inactive state after entering the Inactive
state.
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Back to Binary Output Attributes.

Min On Time
Represents the fewest number of seconds Present Value remains in the Active state after entering the Active state.

Back to Binary Output Attributes.

Out of Service
Used to decouple the object from the physical output. When out of service is True, the object will decouple Present
Value and Reliability from the hardware. The Reliability will be writable when Out Of Service is True. Not all devices
support setting this attribute to True.

Back to Binary Output Attributes.

Polarity
Indicates the relationship between the physical state of the output and the logical state represented by Present
Value. If the Polarity attribute is Normal, then the Active state of the Present Value attribute is also the Active or On
state of the physical output as long as Out of Service is False. If the Polarity attribute is Reverse, then the Active
state of the Present Value attribute is in the Inactive or Off state of the physical output as long as Out of Service is
False. If Out of Service is False for a constant physical output state, a change in the Polarity attribute produces a
change in Present Value. If Out of Service is True, the Polarity attribute has no effect on Present Value. The N2
Polarity attribute is always Normal.

Back to Binary Output Attributes.

Present Value
Indicates the current value of the binary output. Polarity determines the relationship between Present Value and the
state of the output.

Back to Binary Output Attributes.

Priority Array
Lists values of the object in level of importance.

Back to Binary Output Attributes.

Reliability
Indicates whether the Present Value is unreliable and why. When Out of Service is True, the Reliability may be
written directly.

Back to Binary Output Attributes.

State Count Reset
Represents the date and time the COS Count attribute was last set to a zero value. If the COS Time, Change of
State Count, or State Count Reset attribute is present, all of these attributes are present.

Back to Binary Output Attributes.

States Text
Indicates the displayed strings for the Present Value.

Status Flags
Represents four true or false flags that indicate the general health of an analog output. Three flags are associated
with the values of other attributes of the object.

The four flags are:

• In Alarm - In Alarm flag is False (0) if the Event State attribute value is Normal; otherwise, the In Alarm flag is
True (1).

• Fault - Fault flag is True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False (0).
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• Overridden - Overridden flag is Logical 1 if the Present Value is decoupled from the hardware output because
operator intervention provided a different value or local override is active.

• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of
Service flag is False.

Back to Binary Output Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Binary Output Attributes.

Binary Output Commands
The table below lists the commands supported by the Binary Output Object.

Table 225: Binary Output Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present ValueOperator Override

Out of Service

Release Operator Override1

1. Attribute name
2. Command priority

Release1

Attribute nameRelease All1

State0. . . State1

1 For the Release Operator Override, Release, and Release All commands, if all Command Priorities have been released and
a Relinquish Default is not defined, the supervisory controller gives control over to the actual hardware.

Binary Output Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Binary Output Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Binary Output Commands.

In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. The Present
Value and Reliability will revert back to the values obtained from the physical hardware output.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Binary Output Commands.
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Operator Override
Updates the Present Value at Command Priority equal to Operator Override (8).

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when one of the following conditions is met:

1. NOT Local Control and NOT Out Of Service, or
2. NOT Local Control and after issuing the In Service command.

Back to Binary Output Commands.

Out of Service
Allows a user to override the object’s hardware output for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True. The Present Value and Reliability no longer track the physical output.
No commands are sent to the actual hardware. When the Out of Service attribute is set to False, the current Present
Value is sent to the actual hardware.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Binary Output Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Binary Output Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Binary Output Commands.

Release All
Releases Command Priorities 3 through 16 (Default) from the specified, writable attribute. Command Priorities 1
and 2 remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space might overcool or overheat, a fan might
run longer than expected, and so on.

If an operator has overridden an input, use the Release Operator Override command.

Back to Binary Output Commands.

State0. . . State1
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. If this is the highest, it is sent to the controller. The state command names and number of commands
are dependent on the States Text attribute.

Important: Be aware that an operator state command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

If Local Control is True, this command is rejected.

Back to Binary Output Commands.
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Binary Value Object
Binary Value (BV) objects have similar software characteristics and capabilities to a Binary Input Object; however,
Binary Value objects are not associated with any physical hardware and are the result of a control process or operator
entry. This object allows you to hold a binary value for other objects to reference. For example, an Interlock Object
can reference and base its operation on a binary value such as duty/standby.

For general information on Metasys system objects, see Common Object Attributes.

Binary Value Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 226: Binary Value Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

Limit: 20 charactersTextActive Text2

Date/TimeActive Time Reset

0–4,294,967,2950WNumberCOS Count3

NullDate/TimeCOS Time3

0–4,294,967,295

Units = seconds

NullNumberElapsed Active Time4

Limit: 20 charactersTextInactive Text2

False

True

FalseNot
supported

CTrue or FalseIntrinsic Alarming

0–4,294,967,295

Units = seconds

0WCWNumberMin Off Time

0–4,294,967,295

Units = seconds

0WCWNumberMin On Time

Always FalseFalseWTrue or FalseOut of Service

Inactive, Active States Text attribute identifies
the value set for this attribute.

DRWDRWMultistatePresent Value5

Set of valuesPriority Array

No Fault Detected (Reliable), Unreliable Other,
Communication Failure

ReliableWWMultistateReliability

Date/TimeState Count Reset3

Inactive,
Active

CWOne state from
a set

States Text
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Table 226: Binary Value Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

In Alarm, Fault, Overridden, Out of ServiceSeries of True
or False states

Status Flags

FalseBCWTrue or FalseUse Remote Alarming

1 C - Configurable, D - Default Attribute for Display, R - Affected by Object’s Reliability, W - Writable
2 If either Inactive Text or Active Text is present, both are present.
3 If Change of State Time, Change of State Count, or State Count Reset is present, all are present.
4 If either Elapsed Active Time or Active Time Reset is present, both are present.
5 Present Value is commandable; it is also writable. This attribute is writable when Out of Service is True.

Binary Value Attribute Details
Active Text
Characterizes the intended effect of the Active state of Present Value from the viewpoint of the operator. The content
of this string is a local matter but is intended to represent a readable description of the Active state. If either the
Active Text or the Inactive Text attribute is present, both of them are present.

Back to Binary Value Attributes.

Active Time Reset
Represents the last date and time Elapsed Active Time set to a zero value. If either Elapsed Active Time or Time
of Active Time Reset is present, both are present.

Back to Binary Value Attributes.

COS Count
Represents the number of times the Present Value attribute changed state since the COS Count attribute was last
set to zero. A change of state is any event that alters Present Value. This attribute persists in the archive.

This attribute is persisted in the archive.

Back to Binary Value Attributes.

COS Time
Represents the date and time at which the most recent change of state occurred. A change of state is any event
that alters the logical state of Binary Value.

Back to Binary Value Attributes.

Elapsed Active Time
Represents the accumulated number of seconds Present Value is Active since the Elapsed Active Time attribute
was last set to zero. This attribute value updates automatically a minimum of once a day.

Back to Binary Value Attributes.

Inactive Text
Characterizes the intended effect of the Inactive state of Present Value attribute from the viewpoint of the operator.
The content of this string is a local matter, but it is intended to represent a readable description of the Inactive state.
If either the Inactive Text or Active Text attribute is present, both are present.

Back to Binary Value Attributes.

Intrinsic Alarming
Enables the definition of the intrinsic alarm related attributes.

Back to Binary Value Attributes.

Min Off Time
Represents the least number of seconds Present Value remains in the Inactive state after entering the Inactive
state.
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Back to Binary Value Attributes.

Min On Time
Represents the least number of seconds Present Value remains in the Active state after entering the Active state.

Back to Binary Value Attributes.

Out of Service
Indicates the offline/online state of the connected hardware. This attribute exists for compatibility with BACnet protocol
and indicates whether the physical input that the object represents is in service. When out of service, the physical
input is not coupled to changes in the Present Value. The object does not send commands to the hardware. This
attribute is always False due to the absence of hardware.

Back to Binary Value Attributes.

Present Value
Indicates the current value of the binary value. When Out of Service is True, Present Value is writable. Present
Value is optionally commandable. If Present Value is commandable, Priority Array and Relinquish Default are both
present.

Back to Binary Value Attributes.

Priority Array
Lists values of the object in level of importance. If Priority Array or Relinquish Default is present, both are present.
If Present Value is commandable, Priority Array and Relinquish Default are both present and Present Value is
writable.

Back to Binary Value Attributes.

Reliability
Indicates whether the Present Value is unreliable and why.

Back to Binary Value Attributes.

State Count Reset
Represents the date and time the COS Count attribute was last set to a zero value. If COS Time, Change of State
Count, or Time of State Count Reset is present, all are present.

Back to Binary Value Attributes.

States Text
Indicates the displayed strings for the Present Value. For BACnet compliant objects, if no States Text is specified
when the object is created, the Inactive Text and Active Text are used to derive the equivalent States Text if possible.

Back to Binary Value Attributes.

Status Flags
Contains four true or false flags that indicate the general health of the object. Three of the four flags are associated
with the values of other attributes within the same object. By reading these attributes, you can achieve a clearer
picture of the object status.

The four flags are:

• In Alarm - In Alarm flag is False (0) if the Event State attribute value is Normal; otherwise, the In Alarm flag is
True (1).

• Fault - Fault flag is True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False (0).
• Overridden - Overridden flag is Logical 1 if the Present Value has been overridden by some mechanism local

to the BACnet device or because operator intervention provided a different value.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Binary Value Attributes.
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Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Binary Value Attributes.

Binary Value Commands
The table below lists the commands supported by the Binary Value Object.

Table 227: Binary Value Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

The value to be written to the Present Value attribute.Operator Override

Release Operator Override

1. Attribute name
2. Command priority

Release

Attribute nameRelease All

State0

State1

Binary Value Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Binary Value Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Binary Value Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override (8).

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when one of the following conditions is met:

1. NOT Local Control and NOT Out Of Service, or
2. NOT Local Control and after issuing the In Service command.

Back to Binary Value Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Binary Value Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.
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Back to Binary Value Commands.

Release All
Releases Command Priorities 3 through 16 from the specified, writable attribute. Command Priorities 1 (Manual
Emergency) and 2 (Fire Application) remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.

If an operator has overridden an input, use the Release Operator Override command.

Back to Binary Value Commands.

State0
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority.

Important: Be aware that an operator state command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

Back to Binary Value Commands.

State1
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority.

Important: Be aware that an operator state command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

Back to Binary Value Commands.
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Calendar Object
The Calendar object is used behind the scenes by the Scheduling feature by maintaining a list of dates designated
as exceptions to the normal schedule. Exception Schedule days are days when you do not want the Schedule to
operate, such as holidays. They can be defined as specific dates or ranges of dates. Typically, a Schedule object
references a Calendar object, which lists the days the weekly schedule should not operate. A Schedule object
working from a chosen Calendar reads the Present Value of the Calendar object, which indicates if the current day
is within the Date List (Entry Detail) of the Calendar.

A different set of activities from those in the weekly schedule can be defined in the Schedule object to occur on these
exception days. Multiple Schedule objects can reference a single Calendar object so that only the Calendar object
needs to be changed to affect all schedules.

This object allows you to accommodate for a special day or days, like a holiday, in which the building controls should
run differently from usual, in accordance with the change in the number of people and the amount of activity in the
building.

For general information on Metasys system objects, see Common Object Attributes.

For more information on the Scheduling feature and how to create a calendar, see Scheduling. For detailed information
on the Calendar object, see Calendar Attributes. For more information on global calendar function, see Global
Calendar.

Calendar Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 228: Calendar Attributes - Calendar Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

WCWDate/TimeDate List (Entry Detail)

WCWAttribute
reference

Global Calendar Object
Reference

Date/TimeGlobal CalendarUpdate

FalseDDTrue or FalsePresent Value

1 C - Configurable, D - Default Attribute for Display, W - Writable

Calendar Attribute Details
Date List (Entry Detail)
Lists dates defined as entries to the Calendar object. Each entry is either an individual date, range of dates, or
month/week-of-month/day-of-week specification. If the current date matches any calendar entry, the Present Value
is set to True. Also, individual fields of an entry can be left unspecified, thus acting as Wildcards, or include all
options. If a device allows writing to Date List, all date choices are permitted.

Back to Calendar Attributes.

Global Calendar Object Reference
Specifies a globally referenced calendar (if any) used as the master calendar for the site. Specifying a global calendar
allows a site to synchronize many calendars so that only a single calendar (master calendar) needs to be changed.
If you are using calendar references, you usually set up field controllers that reference a calendar on the engine,
and engines that reference a calendar on a single supervisory engine, which is designated as the master calendar.

Back to Calendar Attributes.
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Global Calendar Update
Specifies a time and date when the local calendar date list was last updated from the master calendar. If no calendar
is referenced by the device, then the global calendar update remains unspecified.
Note: If a calendar references a master calendar, the date list is not writable and the Edit button within the UI is

unavailable.

Back to Calendar Attributes.

Present Value
Indicates the current value of the Calendar. Present Value is True if the current date is in the Date List (Entry Detail)
and False if the current date is not in the Date List.

Back to Calendar Attributes.
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Data Broadcast Object
The Data Broadcast object provides a means of sharing globally useful data with third-party BACnet devices. The
data value from an object/attribute to be shared is referenced by this object. Typically, this data may be the outdoor
air temperature, or a value indicating whether a building is occupied. The Data Broadcast then broadcasts an
Unconfirmed COV Notification message containing the referenced data value when it changes.

On a site containing only Metasys devices, the Data Broadcast object is not useful, and should not be created.

As the number of these objects on a site increases, the network performance may suffer due to excessive broadcasts.
Therefore, use Data Broadcast objects only when necessary.

For general information on Metasys system objects, see the Object Help section.

For more information on the wizard used to create the Data Broadcast object, see Insert Object - Data Broadcast
in the Wizards section.

Data Broadcast Concepts
Unconfirmed COV Notification
Unconfirmed COV Notification is a BACnet service that can be used to distribute object attributes of wide interest
to many devices simultaneously without a subscription.

Data Broadcast Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 229: Data Broadcast Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Units = seconds

Range = 30–86,400

NullCNWNumberCOV Period

NullCAttribute referenceInput Reference

0NumberMessage Transmits

Input UnreliableOne state from a
set

Reliability

1 C - Configurable, N - Value Not Required, W - Writable

Data Broadcast Attribute Details
COV Period
Broadcasts an Unconfirmed COV on a periodic basis. When set to a value from 30 to 86,400, this object issues an
Unconfirmed COV containing the attribute value and status flags at least once every period. This broadcast occurs
even when the value remains unchanged. If an actual change of value occurs during the period and a COV is sent,
the timer for the periodic COV resets. To disable the periodic broadcast feature, clear the value from the COV Period
and save the change. The null entry represents not sending periodic COVs. The maximum range for this value is
86,400 seconds (24 hours). By default, this feature is disabled.

Back to Data Broadcast Attributes.

Input Reference
Specifies the object and attribute value that is monitored for COVs. This object’s attribute value, if reliable, is then
broadcast in an Unconfirmed COV Notification message.

Back to Data Broadcast Attributes.
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Message Transmits
Provides a count of the number of Unconfirmed COV Notification messages that have been sent by the Data
Broadcast object. After reaching 4,294,967,295, the value rolls over to 0 and the count continues.

Back to Data Broadcast Attributes.

Reliability
Specifies the reliability of the Data Broadcast object. The reliability changes to Input Unreliable when errors with the
Input Reference occur.

Back to Data Broadcast Attributes.

Data Broadcast Commands
The following table lists the commands supported by the Data Broadcast Object.

Table 230: Data Broadcast Commands
ParametersCommand Name

Disable

Enable

Data Broadcast Command Details
Disable
Locks all outputs and prevents the object from broadcasting any messages.

Back to Data Broadcast Commands.

Enable
Specifies that the Data Broadcast object broadcasts Unconfirmed COV Notification messages when the Input
Reference changes.

Back to Unconfirmed COV Notification.
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Demand Limiting/Load Rolling (DLLR) Object
The Demand Limiting feature helps you save money by limiting peak energy usage. The Load Rolling feature helps
save money by reducing overall energy consumption. The Demand Limiting (DL) portion of DLLR selectively turns
off (sheds) equipment, such as fans and lights, or adjusts setpoints to limit energy use during peak times. The Load
Rolling (LR) portion acts continuously to maintain a specified energy reduction by shedding unnecessary loads. A
facility can implement either one or both of these strategies.

The DLLR object represents the attributes, commands, and reports that define the DLLR functionality. For information
on the features and operation of DLLR, refer to the DLLR Technical Bulletin (LIT-12011288).

DLLR Object Attributes
The DLLR object is divided into three tabs, the Focus/Configuration Tab, the Profile Tab, and the Load Summary
Tab. If you add extensions to this object, see Extensions for descriptions of the extension tabs.

DLLR Object Features
DLLR Object Icon

Table 231: DLLR Object Icon
Key WordsIcon
Gears, Spinning gears

Focus/Configuration Tab
Object Attributes

Name
The Name attribute contains a freely definable user-friendly name for the object that is independent of the Item
Reference or the location of the object in the physical network. The Name is used as the label in the All Items
navigation tree. The Name is shown in alarm reports, the event and audit viewers, and in summaries. The Name
does not need to be unique to the site.

The Name defaults to the object identifier you used during manual object creation but can be edited later.

Description
The Description attribute contains a user-defined description of the object.

Object Type
The Object Type attribute indicates the Object Type as displayed in the Metasys software and as exposed to a
BACnet network.

Example: DLLR (Demand Limiting Load Rolling).

Object Category
The Object Category classifies the object by the category of system or equipment that it monitors to aid in the
determination of user access privileges and alarm routing.

Examples: Energy, HVAC, Fire, Security

Status Attributes

Enabled
The Enabled attribute provides a mechanism to stop DLLR operation. When disabled, DLLR releases all shed loads
except those that are locked shed. Also, DLLR does not perform any calculations, report alarms, or issue any
commands to any loads when disabled. DLLR attributes can be changed, but no actions are taken until DLLR is
enabled.

When enabled, DLLR operation starts again. If Shed mode is active, the configured DLLR strategies begin shedding
loads as needed. If Monitor Only mode is configured, simulated load shedding begins.
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Alarm State
Indicates the current Warning or Alarm state of an object. This attribute is set by an Alarm Extension associated
with the object.

DLLR Status
The DLLR Status attribute indicates the current DLLR status. The statuses include:

• Normal - no errors or problems in the DLLR object
• LR cannot meet target - the Load Rolling algorithm was unable to shed enough loads to meet its target.
• DL cannot meet target - the Demand Limiting algorithm was unable to shed enough loads to meet its target.
• Meter Off Normal - a meter is defined, but it is offline or its value is not reliable.
• EOI Off Normal - an End of Interval (EOI) attribute is defined, but it is offline or its value is not reliable. This also

indicates that the EOI Attribute is replaced with the fixed window algorithm.
• Disabled - the DLLR object is not being used to shed (or simulate the shedding of) loads.
• No meter defined for DL - a meter is not currently defined for DL; a requirement if the Shed Strategy includes

Demand Limiting.

Meter Status
The Meter Status attribute indicates the status of the meter, if the meter is defined. The meter status includes:

• Undefined
• Normal
• Off Normal

EOI Status
The EOI Status attribute indicates the status of the EOI object, if the EOI object is defined. The EOI Status attribute
uses the same status set as Meter Status.

Operational Data Attributes

Energy Rate
The Energy Rate attribute displays the current rate from the meter, if a meter is defined.

Interval Demand
The Interval Demand attribute displays the average energy demand over the current interval.

Amount Shed
The Amount Shed attribute indicates how much energy is currently shed. It is the default attribute of the DLLR object
and is displayed near the top of the DLLR object window.

Calculated Demand
When DLLR is in Monitor Only mode, the Calculated Demand attribute indicates the energy rate when DLLR is in
Shed mode (energy rate - amount shed). This attribute is blank when DLLR is in Shed mode.

Setup Attributes

Mode
The Mode attribute controls whether DLLR is actively shedding Loads (Shed mode) or is simulating Load shedding
(Monitor Only mode). The mode pertains to both the Demand Limiting and Load Rolling strategies simultaneously.
The Modes include:

• Monitor Only - simulated shedding occurs, where loads appear shed but output points are not actually commanded
or turned off.

• Shed - true shedding occurs where output points are commanded.
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Shed Strategy
The Shed Strategy attribute allows you to specify which shedding strategy the DLLR uses. The Shed Strategies
include:

• Demand Limiting and Load Rolling
• Demand Limiting Only
• Load Rolling Only (default)

Meter Object
The Meter Object identifies the Metasys object (for example, Pulse Meter, AI, AV) that is used for the energy rate if
the Demand Limiting strategy is configured. If only the Load Rolling strategy is used, a meter is not required.

The Meter Object should be defined on the same supervisory controller as the DLLR Object. Do not use an N1
Integration object for the meter unless you can guarantee that the NCM Service Time is always less than 60 seconds
because the DLLR algorithm requires an updated meter value every minute.

DLLR Startup Behavior
The DLLR Startup Behavior attribute selects which mode the feature is set to whenever the supervisory controller
is restarted or its database is downloaded. Two selections are offered:

• Startup in Monitor Onlymode - DLLR starts in Monitor Only mode, even if it had been commanded or configured
to Shed mode before the restart or download. Also, if the DLLR object was disabled while in Shed mode, it reverts
to Monitor Only mode when enabled.

• Startup in last commanded mode - DLLR starts in the mode that was active at the time the controller was
restarted or its database downloaded.

Regardless of the selection, the following also apply:

• Any Comfort Override commands that were in place before the startup are persisted.
• Any previous Shed commands are not automatically persisted to loads on startup. DLLR evaluates the current

situation and completes all calculations before issuing any new Shed commands to loads.
• When DLLR starts issuing Shed commands to loads, it resumes where it left off with the first eligible, lowest-priority

load.

Monitor Mode Release
The Monitor Mode Release attribute allows you to specify the load output release behavior when DLLR is commanded
to Monitor Only mode from Shed mode. If set to Release immediately, the outputs of loads that are not locked are
immediately released regardless of whether their Minimum Shed Time has expired. If set to Release After Min Shed
Time, the outputs of loads that are not locked are released only after their Minimum Shed Time expires. Possible
behaviors include:

• Release Immediately
• Release After Min Shed Time

Profile Tracking Period
The Profile Tracking Period attribute determines the time period for the Current Profile and Previous Profile attributes
in the Profile tab. This is customarily set to the utility’s billing period. If you change the Profile Tracking Period, the
Current Profile is copied to the Previous Profile, and a new Current Profile is started. When Manual is selected, the
Current Profile and Previous Profile are only changed when the user commands the DLLR object to Reset Profile.
Possible settings include:

• Manual
• Hourly
• Daily
• Weekly
• Monthly
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Table 232 describes when the start and end times are set based on the tracking period.

Table 232: Profile Tracking Periods
End TimeStart TimeProfile Tracking

Period
60 minutes from the current hour

Example: 09:00:00 A.M.

At the top of the current hour

Example: 08:00:00 A.M.

Hourly

12:00:00 A.M. next day12:00:00 A.M. current dayDaily

12:00:00 A.M. Monday of next week12:00:00 A.M. Monday of current weekWeekly

12:00:00 A.M. first day next month12:00:00 A.M. first day of current monthMonthly

Always Not SpecifiedThe moment when the Reset Profile command
is issued.

Manual

There are three exceptions to when the Start Times and End Times can vary from what is shown in Table 232. The
Start Times and End Times differ when:

• a Reset Profile command is issued to the DLLR object while in Shed or Monitor Only mode
• a Reset Initialization Parameters command is issued to the DLLR object while in Monitor Only mode
• the controller is downloaded or reset

Note: The Start Times and End Times are not reset when DLLR changes from Monitor Only mode to Shed mode.
Also, when the DLLR object is disabled, the current profile is copied to the previous profile, the current profile
values are all set to 0, and the times are all set to undefined.

Stop DLLR Audits in Monitor Only Mode
The Stop DLLR Audits in Monitor Only Mode attribute specifies whether an audit entry is created each time a load
is shed or released when DLLR is in Monitor Only mode and the NAE’s Enabled Audit Level is set to 3 or 4. (When
DLLR is in Active mode, an audit entry is always created to record that event.) The default is False, but if you set it
to True, no audit entries are created in Monitor Only mode.

Demand Limiting Attributes

Active Demand Limit
The Active Demand Limit attribute always displays the actual demand target being used by the demand limiting
strategy. If a ramp down is in progress, it displays the ramp down value; otherwise, it displays the Current Demand
limit.

DL Tariff Targets
The DL Tariff Targets attribute is the list of energy targets for the Demand Limiting strategy. Each target consists of
a target value and an entry from the Target Description set identifying the type of target, such as On-Peak. If the
Demand Limiting strategy is used, there must be at least one target defined. Only one target is active at any time.
The Active DL Target attribute specifies which target is currently active. The Target Description set includes:

• Continuous
• Off-Peak
• On-Peak
• Semi-Peak
• Shoulder
• Summer Off-Peak
• Summer On-Peak
• Winter Off-Peak
• Winter On-Peak
• Summer Semi-Peak
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• Winter Semi-Peak
• Summer Shoulder
• Winter Shoulder

Active DL Target
The Active DL Target specifies which of the defined Demand Limiting targets is currently active. When this attribute
changes, the Active DL Target Changed attribute indicates True until the start of the next interval. This attribute
uses the Target Description enumeration set.

Current Demand Limit
The Current Demand Limit attribute represents the demand limiting target that is set by the user (DL Tariff Targets
indexed by Active DL Target). This attribute defines the maximum allowed average demand during the current
elapsing interval, and allows you to change the value of the demand limiting target. To change the value of the
demand limiting target, write a new value to this attribute.

Algorithm
The Algorithm attribute specifies which algorithm is used for the Demand Limiting strategy (Fixed Window or Sliding
Window). In most cases, the Sliding Window Algorithm is required by North American utilities, while the Fixed Window
Algorithm is used by European utilities.

Demand Interval Length
The Demand Interval Length attribute specifies the length in minutes of an interval for the Demand Limiting strategy.
This value is normally obtained from the energy utility. The DLLR Interval Lengths set specifies the possible interval
lengths (15, 30, or 60).

Current Amount Shed by DL
The Current Amount Shed by DL attribute displays how much energy is currently shed for the Demand Limiting
strategy. When Shed Strategy is set to Demand Limiting and Load Rolling, this attribute indicates how much of the
Amount Shed is due to Demand Limiting alone.

Sliding Window Alg (Algorithm) Attributes

Unc (Uncontrolled) Interval Demand
The Uncontrolled Interval Demand attribute displays the average uncontrolled energy demand (interval demand
plus amount shed) over the current interval. It indicates what the demand would be if the DLLR object had not shed
any loads.

Ramp Down In Progress
The Ramp Down In Progress attribute indicates whether a target ramp down is in progress.

Fixed Window Alg (Algorithm) Attributes

Profile Limit
The Profile Limit attribute displays the current value of the Demand Limit profile, which is the current demand limit
adjusted by the safety factor for this minute.

EOI Attribute
The EOI attribute is a reference to the Metasys object (for example, BI, BV) supplying the EOI pulse, which is used
for the Fixed Window algorithm only. The EOI pulse is used to synchronize DLLR’s demand interval to the utility’s
demand interval. If this is not specified, DLLR performs its own interval timing, which is not as accurate.

This EOI attribute can be any binary type object, as long as the following requirements are met:

• A permanent communication path must exist between this attribute and the DLLR object; therefore, the EOI point
and DLLR object should reside on the same supervisory controller.

• The attribute must be a numerical attribute, in which a change from 0 to 1 indicates the end of interval and the
beginning of the next interval. The EOI Status attribute is set to Off Normal when the object supplying the EOI
pulse becomes offline or unreliable to the DLLR object.
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Load Rolling Attributes

LR Tariff Targets
The LR Tariff Targets attribute lists the energy targets for the Load Rolling strategy. Each target consists of a target
value and an entry from the Target Description set identifying the type of target, such as On-Peak. If the Load Rolling
strategy is used, there must be at least one target defined. Only one target is active at a time. The Active LR Target
attribute specifies which LR Target is currently active. The Target Description set includes:

• Continuous
• Off-Peak
• On-Peak
• Semi-Peak
• Shoulder
• Summer Off-Peak
• Summer On-Peak
• Winter Off-Peak
• Winter On-Peak
• Summer Semi-Peak
• Winter Semi-Peak
• Summer Shoulder
• Winter Shoulder

Active LR Target
The Active LR Target attribute specifies which of the defined Load Rolling targets is currently active. When this
attribute changes, the Active LR Target Changed attribute indicates True until the start of the next interval if demand
limiting is configured, or the next minute if load rolling only is configured. This attribute uses the Target Description
enumeration set.

Current LR Target
The Current LR Target attribute represents the load rolling target that is set by the user (LR Tariff Targets indexed
by Active LR Target). This target defines the amount of energy that should be shed each minute for the load rolling
strategy. You can change the value of the load rolling target by writing to this attribute.

Current Amount Shed by LR
The Current Amount Shed by LR attribute indicates how much energy is currently shed for the Load Rolling strategy.
When Shed Strategy is set to Demand Limiting and Load Rolling, this attribute indicates how much of the Amount
Shed is due to Load Rolling alone.

Display Attributes

Rate Units
The Rate Units attribute specifies the energy units used for instantaneous energy demand attributes and referenced
in the DLLR Profile and Load Summary (for example, kW). If a meter is defined, the Rate Units attribute indicates
the units of the meter.

Consumption Units
The Consumption Units attribute specifies the consumption energy units (for example, kWh).

Display Precision
The Display Precision attribute defines the decimal display precision for all real values (floating values) in the DLLR
object.

Advanced Operational Data Attributes

Minutes Since Meter Failure
If the Meter is offline or unreliable, the Minutes Since Meter Failure attribute indicates the number of minutes (up to
the interval length) since the meter was last reliable.
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Advanced Demand Limiting Attributes

Unreliable Meter Options
The Unreliable Meter Options attribute allows you to specify what should happen to Demand Limiting if the meter
becomes unreliable or goes offline. These options are as follows:

• Stop Shedding - no more shedding occurs until the meter is again reliable. Currently, shed loads continue to
be shed until their Max Shed Time expires.

• Maintain the Current Shed Rate - as loads are released, DLLR sheds other Loads to maintain the current
amount of shed load.

• Use Unreliable Meter Shed Rate - sheds or releases loads as needed to maintain the amount of load specified
in the Unreliable Meter Shed Rate.

The second and third options cause Demand Limiting to act similarly to the Load Rolling strategy. If the Demand
Limiting strategy is not defined, an offline or unreliable meter prompts no actions.

Also, when the meter goes offline or unreliable, DLLR sets its Meter Status attribute to Off Normal and continuously
updates its Minutes Since Meter Failure attribute (up to the interval length) until the meter is again reliable. The
Minutes Since Meter Failure value is listed under the Operational Data section of the DLLR object - Advanced view.

Unreliable Meter Shed Rate
The Unreliable Meter Shed Rate attribute specifies how much load the DLLR object should keep shed if the meter
goes unreliable, provided the Use Unreliable Meter Shed Rate option is selected for the Unreliable Meter Options
attribute.

DL to Shed
The DL to Shed attribute indicates how much energy needs to be shed to meet the current Demand Limit target for
this minute. A negative value indicates how much energy can be released this minute.

DL Not Shed
The DL not Shed attribute indicates how much energy was unable to be shed (this minute) to meet the current
Demand Limit target for this minute. A positive value indicates a potential problem that Demand Limiting might not
be able to meet its target during this interval.

Current Amount Eligible to be Shed by DL
The Current Amount Eligible to be Shed by DL attribute represents the amount of energy available for Demand
Limiting to shed at this moment. It does not include the energy of loads already shed.

Active DL Target Changed
The Active DL Target Changed attribute displays True when the Active DL Target value is changed. It remains True
until the start of the next interval, when it is reset to False. This attribute allows an alarm to be raised when the DL
target changes.

Sliding Window Alg (Algorithm) Advanced Attributes

Target Ramp Down Enabled
The Target Ramp Down Enabled attribute specifies whether a target reduction causes an incremental ramp down
over the course of one interval, as opposed to an immediate target drop that could result in major immediate Load
shedding.
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Sensitivity
The Sensitivity attribute specifies the level of aggression for shedding Loads when using the Sliding Window algorithm.
A High sensitivity sheds more loads sooner than a Low sensitivity.

• Low setting - allows you to start shedding loads later and shedding loads over a shorter period of time. This
setting reduces the amount of equipment that is turned off; however, it increases the possibility of exceeding the
target.

• Medium setting - (default) allows you to start shedding slightly earlier than a low setting and later than a high
setting. This setting turns off equipment earlier than with a low setting, but does not have to turn off as much
equipment at once as with the high setting.

• High setting - allows you to begin shedding sooner into the demand peak. This setting decreases the possibility
of exceeding the target; however, it increases the amount of equipment that is turned off.

Smoothed ABS Error
The smoothed absolute error is based on the forecast error and is used to provide a safety margin to prevent the
interval demand from exceeding the target. It equals the average percentage of variation in the uncontrolled energy
rate.

Error Limit
The Error Limit attribute limits the Smoothed ABS Error to a percentage of the Active Demand Limit. It can be used
to reduce the size of the safety margin to avoid unnecessary overshedding. This value should be changed with care,
since it increases the possibility of exceeding the demand limit target. The default value is 10%.

Fixed Window Alg (Algorithm) Advanced Attributes

Limit Elevation
The Limit Elevation attribute indicates the amount (in percent) by which the demand limit is increased at the beginning
of the next interval to obtain the starting value of the demand limit profile. A high value may result in increased
shedding toward the end of an interval. Changing this interval affects the next interval, not the current interval.

As shown in Figure 79, the demand limit profile specifies for each minute the maximum allowed average power
during the whole interval. If too much energy is consumed during the first half of the interval, because the limit
elevation allowed this consumption, then more loads are shed during the second half of the interval, even though
the actual metered power is then below the demand limit profile. In other words, the net effect of limit elevation is to
defer aggressive load shedding to the second half of the fixed demand interval.

Figure 79: Use of Limit Elevation on a Demand Limit Profile
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Active Elevation
The Active Elevation attribute indicates the amount (in percent) by which the demand limit was increased during the
elapsing interval to obtain the starting value of the demand limit profile. The Active Elevation represents the Limit
Elevation that is used for the current interval.

Time Until EOI
The Time Until EOI attribute indicates the number of minutes until the expected end of the interval.

Time Since EOI
The Time Since EOI attribute indicates the number of minutes since the latest EOI.

Energy Since EOI
The Energy Since EOI indicates the consumed energy since the latest EOI.

Demand Since EOI
The Demand Since EOI indicates the average power since the latest EOI.

Max Allowed Peak Until EOI
The Max Allowed Peak Until EOI attribute indicates the maximum allowed average power until the next EOI.

Advanced Load Rolling Attributes

LR to Shed
The LR to Shed attribute indicates how much energy needs to be shed to meet the current Load Rolling target for
this minute.

LR Not Shed
The LR not Shed attribute indicates how much energy was unable to be shed (this minute) to meet the current Load
Rolling target for this minute. A non-zero value indicates an error situation in which Load Rolling was unable to meet
its target this minute.

Active LR Target Changed
The Active LR Target Changed attribute displays True when the Active LR Target value is changed. It is set to False
at the start of the next interval if demand limiting is configured, or at the start of the next minute if load rolling only
is configured. This attribute allows the DLLR object to raise an alarm when the LR target changes.

Control Attributes

Allow Reset in Shed Mode
The Allow Reset in Shed Mode attribute controls whether the Reset Initialization Parameters command can be issued
while DLLR is in Shed mode. When True, the Reset Initialization Parameters command can be issued once if DLLR
is in Shed mode. As soon as the command is issued, this attribute is automatically reset to False and must be
manually set to True before the command can be issued again in Shed mode.

Profile Tab
The DLLR Object Profile indicates energy usage for the current and previous tracking periods. The current Energy
Rate and Active Demand Limit values are also shown. The profile includes the following parameters:

How Daylight Saving Time Affects Start Times and End Times
If daylight saving time is used at your facility, the Profile reacts accordingly. For example, when daylight saving time
begins, the system clock on the supervisory controller advances from 1:59 A.M. to 3:00 A.M. If an hourly tracking
period is used, the Profile starts a new tracking period at that moment, setting the Current Start Time to 3:00 A.M.
and the Current End Time to 4:00 A.M. The Profile also changes the Previous Start Time to 1:00 A.M. and the
Previous End Time to 3:00 A.M. The previous profile indicates that 2 hours have elapsed, but contains only 1 hour
of energy data.

When daylight saving time ends, the system clock on the supervisory controller changes from 1:59 A.M. to 1:00
A.M. In this scenario, the system does not reach 2:00 A.M. until 2 hours after 1:00 A.M. The current profile contains
2 hours of profile data, even though the Current Start Time is 1:00 A.M. and the Current End Time is 2:00 A.M.
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Whereas start/end date and times are not affected when the other tracking periods are used (daily, weekly, monthly,
or manual), the period in which daylight saving time begins always contains 1 hour of data fewer than in a standard
period. The period in which daylight saving time ends always contains 1 hour of data more than a standard period.

Start Time
Start Time indicates when the DLLR Object starts to record demand profile data.

The Start Time depends on the situation. For example, at startup, the Start Time is set to when the controller was
restarted. If the Profile Tracking Period has expired, Start Time is set to when the next tracking period begins.

The Start Time is also reset if the Profile Tracking Period is changed, a Reset Profile command is issued to the
DLLR object while in Shed or Monitor Only mode, a Reset Initialization Parameters command is issued to the DLLR
object while in Monitor Only mode, or the controller is downloaded. Note that the Start Time is not reset when DLLR
changes from Monitor Only mode to Shed mode.

See the How Daylight Saving Time Affects Start Times and End Times section.

End Time
The End Time for current profile indicates the predicted end time. The End Time for the previous profile indicates
the actual end time. If the Profile Tracking Period is set to Manual, the End Time indicates Unspecified for the Current
Profile.

See the How Daylight Saving Time Affects Start Times and End Times section.

Energy Consumption
Energy indicates the calculated total energy consumption.

Peak Interval Demand
Peak Interval Demand indicates the total Peak Interval Demand with date and time.

Peak
Peak indicates the highest measured energy demand.

Projected Peak
Projected Peak indicates the highest energy demand that would have occurred if DLLR had not been enabled and
had not shed any loads.

Targets
The Targets list the Energy Consumption, Peak Interval Demand, Peak, and Projected Peak for each target that is
active during the current profile tracking period. Only configured targets are listed.

Load Summary Tab
In the Runtime view, the Load Summary provides real-time information about each load associated with the DLLR
object, as well as the Energy Rate and Current LR Target values. By default, all of the loads associated with this
DLLR object are displayed in the order in which they were added to the object. They are sorted by priority, starting
with the lowest Shed priority (10) at the top of the list. This matches the order in which DLLR seeks eligible loads to
shed. Clicking on column headers allows you to sort the information. Reordering is available for all columns except
Status and Load Rating.

Note: The entry Unspecified in the Last Shed Time column means that the load has never been shed or has not
been shed since the last controller download.

The Load Summary is automatically refreshed at the standard UI refresh rate. You can command one or more loads
directly from the Load Summary by selecting them and right-clicking the mouse to display the appropriate command
window. Right-clicking a single load also allows you to command the output or navigate to the output’s focus view.

The Setup option on the Load Summary changes the view to allow editing of some of the fields.

When the Setup view for the Load Summary is displayed, the Associate Load(s) button is used to add new loads to
the table. The Remove Load(s) button removes loads from the table. The MultiEdit button edits more than one load
at a time when several loads are highlighted.
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Energy Rate and Current LR Target
The top portion of the Load Summary indicates current values for the Energy Rate and Current LR Target.

Status
Status displays an icon to indicate the current status of the load. Table 233 provides icon descriptions.

Table 233: Load Summary Icons and Their Status
Load StatusStatus Icon1

Load appears to be offline; system is awaiting confirmation.

Load is offline.

Load is disabled.

Load is shed.

Load is locked.

Load is in comfort override.

Load is released.<no icon>

1 Positioning the mouse on an icon in the Status column displays a tooltip.

Point Name and Point Reference
The Point Name and Point Reference fields display in colors that indicate the load output’s current condition. Table
234 describes the default colors.

Table 234: Default Coloration of Point Name and Point Reference Fields
Point Name and Point Reference Field Color1Condition of Output

WhiteNormal

OrangeOverridden

BlackOffline

YellowTrouble/Warning

RedAlarm

1 The actual colors used are set in the Status Colors section of Metasys Preferences > Graphic Settings. For details, refer to the
ADS/ADX Commissioning Guide (LIT-1201645) or NAE Commissioning Guide (LIT-1201519).

Load Priority
The priority of the load affects the order in which it is shed. Priority 10 loads are the lowest priority and are shed first.
Priority 1 loads are not shed unless no higher priority loads are available for shedding.

Shed Strategy
Shed Strategy indicates whether the load can be shed for Demand Limiting, Load Rolling, or both.

Minimum Shed Time
Minimum Shed Time specifies the minimum number of minutes that a load must be shed before it can be automatically
released. A load can be manually released before this value expires. The range is 0 to 65,535 minutes.

Maximum Shed Time
Maximum Shed Time (optional) specifies the maximum number of minutes that a load can be shed before it is
automatically released. If the Maximum Shed Time value is not defined, the default value of 65,535 is used. The
range is 0 to 65,535 minutes.
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Minimum Release Time
Minimum Release Time specifies the minimum number of minutes that a load must be released from shed before
it can be shed again. Although DLLR does not shed a load before this time expires, a load can be manually shed
before this value expires. The range is 0 to 65,535 minutes.

Load Rating
Load Rating indicates how much energy is saved when the load is shed. This is specified in the same units as the
Rate Units.

Output Present Value
The Output Present Value indicates the current value of the load’s output.

Ineligibility
Ineligibility indicates the reason that the load cannot be shed at this time. This field is blank if the load is eligible to
be shed.

Active Timer
The Active Timer displays the shed or release timer if one is in effect.

Time Remaining
The Time Remaining displays the minutes remaining if a shed or release timer is in effect.

Last Shed Time
The Last Shed Time displays the last time that the load was shed.

DLLR Object Commands
After a DLLR Object is defined, an authorized user can issue one of several commands (see DLLR Object
Commanding). Metasys objects with a Load extension are intended for use with the DLLR feature permit operator
or scheduled commands.

DLLR Object Commanding
After a DLLR object is defined, an authorized user can issue one of several commands to the object.

Table 235: Commands Available to DLLR Objects
DescriptionParametersCommand
Selects between Monitor Only mode and Shed mode for the Demand Limiting
and Load Rolling strategies. The selected mode applies to both strategies; in
other words, you cannot put DL in Monitor Only mode and keep LR in Shed
mode.

Monitor Only

Shed

Set Mode

Sets the active Target Level used for either the Demand Limiting or Load Rolling
strategy. Optionally, you can specify a new value for the target and select a
Target Description. The Target Description is an element of the DL Targets and
LR Targets attributes, which describes the purpose of the target. Examples
include Continuous, Off-Peak, On-Peak, and Semi-Peak.

You also can:
• Change the value of the current target by writing to the Current Demand

Limit and Current LR Target attributes.
• Set which target is active using the Active DL Target and Active LR Target

attributes.

Type

Demand Limiting

Load Rolling

Target Level1

Value

New value

Set Target

Copies the current DLLR profile to the previous DLLR profile and starts a new,
current profile. Use this command if DLLR’s Profile Tracking Period is set to
Manual. It is not necessary to use this command if a definitive tracking period
is selected, such as Monthly, because DLLR resets the profile automatically.

NoneReset Profile
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Table 235: Commands Available to DLLR Objects
DescriptionParametersCommand
Restarts the Demand Limiting calculations associated with the current interval
- Fixed Window Algorithm only.

You can specify a new start of a demand interval for the Demand Limiting
strategy. If you are using the Fixed Window Algorithm, and there is no EOI input
defined, issue this command at the start of the utility company’s interval, the first
time that DLLR runs. It synchronizes DLLR to the start minute of the utility
company’s billing interval (15, 30, or 60 minutes). Thereafter, DLLR uses a
pseudo EOI pulse, so that the start of each subsequent interval is synchronized.
If an EOI input is defined, DLLR automatically starts each interval at the correct
time.

When the Reset Interval command is received, the DLLR object resets interval
parameters and starts a new Demand Interval.
Note: If the Sliding Window Algorithm is used, do not use this command, as

the interval is reset each minute.

NoneReset Interval

Stops DLLR operation. When disabled, DLLR releases all shed loads except
those that are locked shed. Also, DLLR does not perform any calculations, report
alarms, or issue any commands to any objects when disabled. DLLR attributes
can be changed, but no actions are taken until DLLR is enabled.

NoneDisable

Starts DLLR operation. If Shed mode is active, the configured DLLR strategies
begin shedding loads as needed. If Monitor Only mode is configured, simulated
load shedding begins.

NoneEnable

Initializes DLLR as if it were running the demand limiting algorithm for the first
time. Use it in Monitor Only mode for testing new potential demand tariff targets
without using any data from a previous test. It releases all shed loads, clears all
load timers, reinitializes DLLR, and clears the Energy Profile.
Note: Since these actions would adversely affect a smoothly running DLLR

feature, you cannot issue this command while in Shed mode unless you
manually set the Allow Reset in Shed Mode attribute to True. If you issue
the Reset Initialization Parameters command while in Shed mode, the
Allow Reset in Shed Mode attribute reverts to False immediately after
the command is issued.

NoneReset Initialization
Parameters

1 Possible target descriptions: Continuous, Off-Peak, On-Peak, Semi-Peak, Shoulder, Summer Off-Peak, Summer On-Peak,
Winter Off-Peak, Winter On-Peak, Summer Semi-Peak, Winter Semi-Peak, Summer Shoulder, Winter Shoulder.
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Engine Device Object
The Engine object defines the attributes that represent the externally visible characteristics of an NAE/NIE/NCE
controller. One Engine Device object exists per controller. The Johnson Controls Engine object functions differently
from the BACnet Device object.

Note: This chapter applies to the NCE25, NAE35, NAE45, NAE55/NIE55, NAE85/NIE85, and NCE25. In this
chapter, Engine refers to all NCE25, NAE35, NAE45, NAE55/NIE55, NAE85/NIE85, and NCE25 models.

Note: In this chapter, references to the NAE45 encompass hardware versions NAE45-1 and higher. References
to the NAE55 also describe the NAE45-0.

Note: The Object Type for this object is labeled Device in the software.

This object allows you to see data about the controller, such as the IP address and the current date and time.

For general information on Metasys system objects, see the Object Help section.

Engine Concepts
Flash Memory
A type of nonvolatile memory within the Engine device. The Engine stores the operating system, software, and
archive within this memory. This memory is not used during normal operation of the Engine device, except when a
new graphic is added and the new image is uploaded and stored. The Flash Memory is mostly used during shutdown
and system restart.

Operating System
Engines use a Microsoft Windows operating system (specific OS depends on the model), which is shipped preinstalled
on the Engine. In general, the operating system cannot be modified by adding or deleting programs or drivers,
although provisions are made to install factory-authorized patches and upgrades. See Related Documentation for
details.

Software
The software is the Johnson Controls programs used in the Engine, also preinstalled at the factory. This includes
graphics, trending, logic, alarm, and other programs. Provisions are made for both the software and the operating
system to be upgraded at the job site when new revisions of Metasys Engine software are available. See Related
Documentation for details.

Database
The database is the collection of objects and their parameters as defined by the user. Each database is unique to
the job. A database can be created or edited (with appropriate user authority) either online using the Site Management
Portal UI, or offline using the SCT. SCT can also be used to download a database or upload and create a backup
copy of the database.

Archive
A copy of the database, called the archive, is kept in each Engine’s flash memory. This happens automatically once
a day or on operator command. Following restoration of power loss to an Engine, the archive is copied into main
memory to restore normal operation.

Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 236: Engine Device Object Attributes - Focus/Configuration Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

LAN (0)

Dial (1)

LANCNWOne from a list of
types

ADS Connection Type

12:15 AMCNWTimeADS Delivery Time

0–255255CWNumberADS Priority Threshold

IP address or hostnameCNWSet of mixed
values

ADS Repository

Units = Entries

100–1,000 = NAE55/NIE55/NAE85/NIE85

100–500 = NAE35/NAE45/NCE25

1,000 (NAE55/
NIE55/NAE85/
NIE85)

500 (NAE35/
NAE45/NCE25)

CWNumberAlarm Repository Size

0–75

Units = Minutes

5CWNumberAlarm Snooze Time

FalseTrue or FalseAlign Intervals

2–104CWNumberAPDU Retries2

1,000–65,535

Units = milliseconds

4,000CWNumberAPDU Segment
Timeout2

1,000–65,535

Units = milliseconds

6,000CWNumberAPDU Timeout2

TextAppl SW Version

DateArchive Date

Rollover = 0

Stop = 1

Rollover (0)CWOne from a list of
values

Audit Action When Full

1–100

Units = %

80CWNumberAudit Forwarding
Threshold

TrueCWTrue or FalseAudit Generate Alarm
When Full

Units = Entries

10–500 = NAE55/NIE55/NAE85/NIE85

10–250 = NAE35/NAE45/NCE25

500 (NAE55/
NIE55/NAE85/NIE85)

250 (NAE35/
NAE45/NCE25)

CWNumberAudit Repository Size

jci_bacnet_commCWTextBACnet
Communications
Password

0–65,53547,808CWNumberBACnet IP Port2

TextBIOS Version

NumberDatabase Revision

WListDevice Addr Binding

True or FalseDST Status

ListDuplicate References
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Table 236: Engine Device Object Attributes - Focus/Configuration Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

See the attribute description for details on the
Enabled Audit Level.

Range = 1–4 with 5 Audit Levels

Level 1 (N/A) User Action

Level 2 (1) Critical System Events

Level 3 (2) Application

Level 4 (3) Non-critical System Events

Level 5 (4) Diagnostic

Audit Level 2 (1)CWOne from a list of
values

Enabled Audit Level

Rollover = 0

Stop = 1

Rollover (0)CWOne from a list of
values

Event ActionWhen Full

TextFirmware Version

Structure of Destination NetworksCWStructureIEIEJ Function A List

Units = Seconds

Min value = 30

60CWNumberIEIEJ FunctionA Period

Range = 5–25520CWNumberInternode Comm Timer

Units = Minutes0CWNumberInterval Offset

True or FalseFalseCTrue or FalseIs Validated

Auto Delete 31 days

Manual Delete

Auto Delete 7 days

Auto Delete 31 daysCWOne from a list of
values

JCI ExceptionSchedule

Uses the BACnetRestartReason set.One type from a
set

Last Restart Reason

DateLocal Date

CWSet of mixed
values

Local Site Director

TimeLocal Time

(empty string)CWTextLocation

128–65,535

Units = bytes

1,024CWNumberMax APDU Length2

98–65,535

Units = bytes

994CWNumberMax Message Buffer

NumberMax Segments
Accepted

TextModel Name

0–65,5351,001CWNumberNetwork Address2

0–325CWNumberPower Consecutive
Samples

0–32

Units = Seconds

1CWNumberPower Sampling
Interval

Maximum 64 elements, values limited by
range of unsigned 32

empty listCWList of value setsProcess ID List
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Table 236: Engine Device Object Attributes - Focus/Configuration Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

Series of bitsSeries of True or
False values

Protocol Obj Support

NumberProtocol Revision

Series of bitsSeries of True or
False values

Protocol Ser Support

NumberProtocol Version

CWStructureRestart Notification
Recipients

Segmented Both, Segmented Transmit,
Segmented Receive, No Segmentation

One type from a
set

Segmentation

TrueTrue or FalseSite Director Online

Operational, Operational Read Only,
Download Required, Download in Progress,
Nonoperational, Backup in Progress

DOne type from a
set

System Status

BACnetTimeStampStructureTime of Device Restart

Zero or moreWListTime Sync Recipients

Units = Minutes0CWNumberTime Synchronization
Interval

ListUnbound References

-900 to +900CNumberUTC Offset

0–65,5355NumberVendor ID

JCITextVendor Name

1 C - Configurable, N - Value Not Required, Q - BACnet Required, W - Writable
2 If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Table 237: Engine Device Object Attributes - Diagnostic Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

Units = Per HourNumberAudit Rate

IP address and Value

Units = seconds

ListAverage Intermittent
Failure Period

Units = Per MinuteNumberBACnet Broadcast
Receive Rate

Units = Per MinuteNumberBACnet Routed
Messages Rate

Uses Ok Fault (Set 161) or Battery Condition
(Set 175).

One from a list of
conditions

Battery Condition

This attribute appears in only the
NAE35/NAE45/NCE25.

True or FalseBattery Charging

Units = Deg C

Display Precision = 1

COV Increment = 1.0

Real valueBoard Temperature

Units = Per MinuteNumberCOV Rcv Rate

Units = Per MinuteNumberCOV Tx Rate
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Table 237: Engine Device Object Attributes - Diagnostic Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

This attribute appears in only the NAE45/
NAE55/NIE55.

Units = Deg C

Display Precision = 1

COV Increment = 1.0

Real valueCPU Temperature

Units = %

Display Precision = 1

COV Increment = 1

Real valueCPU Usage

Units = secondsNumberDetection Interval

Units = megabytes

Display Precision = 0.1

COV Increment = 0.1

Real valueEstimated Flash
Available

Units = Per HourNumberEvent Rate

NumberEvents Lost

Units = %

Display Precision = 1

COV Increment = 1.0

Real valueFlash Usage

IP address and Value

Units = seconds

ListMaximum Intermittent
Failure Period

Units = %

Display Precision = 0.01

COV Increment = 0.1

NumberMemory Usage

Uses Error Tolerance set.

Low, Medium, High

LowCWOne from a list of
values

Network Tolerance

NumberObject Count

Units = %

Display Precision = 1.0

COV Increment = 1.0

Real valueObject Memory Usage

Uses Network Status (Set 570).One from a list of
values

Pager Dial-up Status

Uses Repository Status set:

0 = Offline

1 = OK

2 = Undefined

3 = Dialup

4 = RAP

5 = Incompatible Release

One from a list of
values

Repository Status

NumberSamples Lost
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Table 237: Engine Device Object Attributes - Diagnostic Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

Units = Per Hour

See attribute description for calculation details.

NumberSample Rate

0 - 65,534

Units = Minutes

NumberTime Between Buffer
Reads

Units = %Real valueTransfer Buffer Full

IP address and Value

Units = Failures Per Day

ListTransport Failure Rate

1 C - Configurable, N - Value Not Required, Q - BACnet Required, W - Writable
2 If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Table 238: Engine Device Object Attributes - Communications Tab
Values/Options/Range2Initial ValueFlags1Data TypeAttribute Name

See attribute description.CWSet of mixed
values

External ModemConfig

See attribute description.CWSet of mixed
values

Internal Modem Config

See attribute description.CWSet of mixed
values

Serial Port Cable Config

1 C - Configurable, N - Value Not Required, Q - BACnet Required, W - Writable
2 If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Table 239: Engine Device Object Attributes - Network Tab
Values/Options/Range3Initial ValueFlags1Data TypeAttribute Name

CWSet of mixed
values

ADS Dial-up Config3

COne from a list of
objects

BACnet Integrated
Objects

For the NAE55/NIE55/NAE85/NIE85 only.CWList of textCompletion Domains

See attribute description.WTextComputer Name3

0 = DHCP disabled

1 = DHCP enabled

True (1)CWTrue or FalseDHCP Enabled

List of IP addresses.CWList of numbersDNS Server IP
Addresses

WTextDomain Name3

List of numbersEthernet MAC Address

Any valid IP addressCWList of numbersIP Address

CWList of numbersIP Mask

CWList of numbersIP Router Address
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Table 239: Engine Device Object Attributes - Network Tab
Values/Options/Range3Initial ValueFlags1Data TypeAttribute Name

True (1)CWTrue or FalseObtain DNS Address
Automatically

CWOne from a list of
values

Routing Mode

1 C - Configurable, N - Value Not Required, Q - BACnet Required, W - Writable
2 If you write the value of this attribute, you must reset the Engine for the new settings to take effect.
3 If you change the value of this attribute, the Engine automatically resets.

Engine Device Attribute Details
ADS Connection Type
Specifies whether the ADS/ADX (defined in the ADS Repository attribute) is connected via a LAN or dial-up
connection. If a value is specified, it overrides the value of the Default ADS Connection Type attribute. If no value
is specified, the value of the Default ADS Connection Type attribute is used (Default ADS Connection Type is a site
level setting sent to the site’s devices). ADS Connection Type is ignored if no ADS/ADX is defined for this site.

Back to Engine Attributes.

ADS Delivery Time
Specifies the time of day when a connection should be established to the ADS/ADX (determined by the ADS
Repository attribute). A connection is attempted at a minimum of once a day at the specified time to deliver audit,
alarm, and trend data to the ADS/ADX. If a value is specified, it overrides the value of the Default ADS Delivery Time
attribute. If no value is specified, the value of the Default ADS Delivery Time attribute is used (Default ADS Delivery
Time is a site level setting sent out to the site’s devices). ADS Delivery Time is ignored if no ADS/ADX is defined
for this site.

Back to Engine Attributes.

ADS Dial-up Config
If ADS Connection Type is Dial-up, this attribute specifies the dial-up configuration used for a remote ADS/ADX.
The following describes the structure parameters for this attribute:

Table 240: Engine Object: ADS Dial-up Config Parameters
Minimum/Maximum ValueInitial ValueData TypeParameter Name
Internal Modem (0)

External Modem (1)

Internal Modem (0)One from a list of valuesConnect Using

TextAccess Number

0–327673NumberRedial Attempts

Uses Redial Delay (Set 565).1 Second (0)One from a list of valuesTime between Redial Attempts

Uses Idle Time (Set 566).1 Minute (1)One from a list of valuesIdle Time before Hanging Up

TrueTrue or FalseRedial if Line Is Dropped

FalseTrue or FalseEnable Internet Connection
Sharing

False = DHCP disabled

True = DHCP enabled

TrueTrue or FalseEnable DHCP

List of numbersIP Address

TextISP Password

AdministratorTextISP Username
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Table 240: Engine Object: ADS Dial-up Config Parameters
Minimum/Maximum ValueInitial ValueData TypeParameter Name

TrueTrue or FalseObtain DNS Address
Automatically

List of numbersDNS Server IP Address

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

ADS Priority Threshold
This attribute is used for Alarm and Event Management only. The ADS Priority Threshold attribute allows you to
specify the priority of an event that triggers the Engine to connect (dial or LAN connection) to the defined ADS/ADX
and delivers the event messages from the Engine local event repository to the ADS/ADX event repository without
waiting for the ADS Delivery Time.

For example, a value of 20 for this attribute means that any event having a priority of 20 or higher (events of higher
alarm priority have lower alarm priority numbers) forces a connection to the ADS/ADX and forwards event messages
from the Engine local event repository to the ADS/ADX’s repository.

Back to Engine Attributes.

ADS Repository
Specifies the ADS Repository device. The ADS/ADX is the device to which local audit, alarm, and trend data is
delivered. Repository refers to the three files in the ADS/ADX that store this data. If a value is specified, it overrides
the value of the Default ADS Repository attribute of the site. If no value is specified, the value of the Default ADS
Repository attribute is used (Default ADS Repository is a site level setting sent to the site’s devices).

Note: If the Engine uses a dial-up connection to transmit data to the ADS/ADX, then the ADS Repository must be
the first IP address listed in the range specified when configuring the ADS/ADX to Allow Incoming Connections
(see External Modem Config).

The Default ADS Repository of the Site is intentionally left blank and must be updated by the user (online or offline).
If the user does not populate the Default ADS value and leaves the Default ADS Repository value for all devices at
0.0.0.0, the ADS/ADX does not receive any audit, alarm, or trend data. The SCT does not automatically populate
the Default ADS Repository value because of the many different possibilities that could exist during archive creation,
including multiple ADSs/ADXs on a site or no ADS/ADX for a site. In these cases, it is not immediately clear which
ADS should be the Default ADS under the Site object.

Back to Engine Attributes.

Alarm Repository Size
Specifies the maximum number of alarms that can be maintained on the local device.

Back to Engine Attributes.

Alarm Snooze Time
Specifies the amount of time to delay after an operator temporarily ignores, or snoozes an alarm before re-announcing
the alarm.

Back to Engine Attributes.

Align Intervals
Specifies whether clock-aligned periodic time synchronization is enabled. If periodic time synchronization is enabled
and the time synchronization interval is a factor of an hour or a day (that is, the value divides without remainder),
then the beginning of the period specified for time synchronization aligns to the hour or day, respectively.

Back to Engine Attributes.
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APDU Retries
Indicates the maximum number of times that an Application Layer Protocol Data Unit (APDU) (as specified by the
BACnet device) is retransmitted. If the device does not perform retries, it is set to zero. If the value is greater than
zero, a nonzero value appears in the APDU Timeout attribute.

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

APDU Segment Timeout
Indicates the amount of time in milliseconds between retransmission of an APDU segment.

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

APDU Timeout
Indicates the amount of time in milliseconds between retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received.

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

Appl SW Version
Identifies the version of the application software installed in the device. The content of this string is locally defined
(date-and-time stamp, a programmer’s name, a host file version number, and so on).

Back to Engine Attributes.

Archive Date
Indicates the date of the last successful archive of object instances. The value of this attribute is valid when a valid
archive exists and during the archive download process. The value of this attribute is *.*.*.* at all other times.

Back to Engine Attributes.

Audit Action When Full
Specifies the operation of the audit trail feature when the audit repository is full. If the value is Stop, additional audit
entries are discarded. If the value is Rollover, additional audit entries replace the oldest audit entries.

See Default Destination and Message Forwarding in the Audit Trail section.

Back to Engine Attributes.

Audit Forwarding Threshold
Specifies the size limit of the audit repository (as a percent of the audit repository size) at which the system attempts
to deliver audit entries to the ADS. This attribute applies only if an ADS device has been defined for the site. When
the Audit Forwarding Threshold is reached, all audits in the Local Audit Repository that have not been forwarded
are forwarded to the defined ADS Repository.

See Default Destination and Message Forwarding in the Audit Trail section.

Back to Engine Attributes.

Audit Generate Alarm When Full
Specifies whether an alarm is generated when the audit repository is full.

See Default Destination and Message Forwarding in the Audit Trail section.

Back to Engine Attributes.

Audit Rate
Specifies the number of audit messages destined for the Metasys server in the last hour (for diagnostic purposes).
The value of this attribute updates every 5 minutes.

Back to Engine Attributes.
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Audit Repository Size
Specifies the maximum number of audit trail entries that can be maintained on the local device.

See Default Destination and Message Forwarding in the Audit Trail section.

Back to Engine Attributes.

Average Intermittent Failure Period
Specifies the average number of seconds devices in the transport layer are offline (for diagnostic purposes). Only
times less than one minute are used in this average, to eliminate device resets. Ideally, this number should be zero,
indicating there are no failures.

Back to Engine Attributes.

BACnet Broadcast Receive Rate
Indicates the number of BACnet broadcast messages received by the device in the previous minute. BACnet
broadcast messages are generated as part of the normal BACnet operation, but are also generated when a BACnet
device searches for another device that does not exist, such as when a device has objects with references to other
nonexistent objects (called unbound references). This number increases when the number of unbound references
increases on network connected devices. If this number gets too high, it indicates possible performance problems.

Back to Engine Attributes.

BACnet Communications Password
Provides password protection of BACnet services, such as DeviceCommunicationControl and ReinitializeDevice.
Third-party workstations may send these services and must provide the password for the Engine to execute the
services. The default password is jci_bacnet_comm. Third-party workstations cannot read or write this password.

Back to Engine Attributes.

BACnet Integrated Objects
Specifies whether integrated objects are displayed in the object list. The values are:

• Include in Object List - Makes internal integration objects visible to BACnet devices. This is the default value.
• Exclude from Object List - Makes internal integration objects unavailable to BACnet devices.

When this attribute is set to Include in Object List and Routing Mode is set to Enabled, the same third-party object
appears in the list twice (as a native object on the actual device and as an integrated object within the Engine);
therefore, this setup is not recommended. When Routing Mode is set to Enabled Without Broadcasts, it prevents
third-party devices outside the network from discovering devices on a routed network using broadcast data.

Back to Engine Attributes.

BACnet IP Port
Specifies the User Datagram Protocol (UDP) port number used to communicate with other BACnet devices over
the IP network. This value allows multiple BACnet networks on a single IP network and prevents communication
between the multiple BACnet networks.

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

BACnet Routed Messages Rate
Indicates the number of BACnet messages received by the device on the IP network in the previous minute. If this
number is high, it indicates that the performance of the MS/TP field bus network is affected by broadcast transmit
traffic.

Back to Engine Attributes.

BIOS Version
Specifies the BIOS version in the Engine. The format of the Basic Input/Output System (BIOS) version is a V (in
some models), major release, ., minor release. For example: V2.02.
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For NAE55/NIE55, if the BIOS version is earlier than V2.02, update the BIOS using the BIOS Update Utility. This
update significantly improves overall product performance. For information on the BIOS Update Utility, refer to the
BIOS Update Utility Technical Bulletin (Part No. 24-10110-42).

Back to Engine Attributes.

Battery Charging
Specifies the current battery charging state in an NCE25/NAE35/NAE45. A value of False indicates the battery
contains at least 80% of full charge capacity and is not currently recharging. A value of True indicates the battery
contains less than 80% of full charge capacity and is currently charging.

If the Battery Charging value is True and the battery is charging, the battery stops charging when it is 100% charged.
Trend this attribute value to determine the current battery charge cycle time. In Simulation, this attribute is False.

Back to Engine Attributes.

Battery Condition
Specifies the current battery condition. It is updated every 60 seconds.

For the NAE55/NIE55, a value of Fault implies the battery is missing or defective and a value of OK implies there is
no known problem with the battery.

For the NCE25/NAE35/NAE45, the values are:

• Good - Battery is operating at normal specifications. Provided the battery is fully charged, it should supply backup
power to the engine three times a day for 6 minutes each time.

• Service - Battery useful life is predicted to end soon. We recommend you replace the battery. Backup power
lasts less than 72 hours.

• Replace - Battery useful life is over. Replace the battery. Backup power may fail if the battery is not charged
fully.

• Defective - Battery is either missing, disconnected, incorrectly installed, or the battery is internally shorted or
otherwise defective. Take corrective action. Backup power is not provided for any duration.

After a line power failure, the battery is used to supply power to the device so the device can perform an orderly
shutdown without losing data. After the device shutdown process finishes, the device discontinues its use of battery
power. Valid data is provided only on the Engine hardware. Under device simulation, the value is Fault.

Back to Engine Attributes.

Board Temperature
Specifies the current Printed Wire Board (PWB) temperature in degrees Celsius. It is updated every 60 seconds. It
is obtained from a temperature sensor built onto the PWB. The device is designed to run reliably with a PWB
temperature at or below 67 degrees Celsius. If this temperature is exceeded, appropriate measures should be taken
to cool the device. Under device simulation, the value is 0.

Back to Engine Attributes.

COV Rcv Rate
Specifies the number of COV messages the Engine receives from other supervisory devices or field controllers per
minute. This attribute value updates every minute. Each COV message represents one object reporting a value
change.

Back to Engine Attributes.

COV Tx Rate
Specifies the number of COV messages the Engine sends to other supervisory devices per minute. This attribute
updates every minute. Each COV message represents one object reporting a value.

Back to Engine Attributes.
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CPU Temperature
Specifies the current CPU temperature in degrees Celsius for an NAE55/NIE55. It is updated every 60 seconds. It
is obtained from a temperature sensor built into the CPU. The CPU is designed to run reliably at or below 77 degrees
Celsius. If this temperature is exceeded, appropriate measures should be taken to cool the device. Under device
simulation, the value is 0.

Back to Engine Attributes.

CPU Usage
Specifies a running average of CPU usage over the last 50 minutes. The value is updated every 30 seconds. The
running average is calculated by adding or subtracting 1% of the difference between the current and average CPU
usage. The value may not be meaningful until 50 minutes after a system restart. A value of 0% means the CPU is
100% idle. A value of 100% means the CPU is 0% idle. A value of 50% or less is considered OK, although other
performance indicators should also be assessed. Under device simulation, the value is 0.

Back to Engine Attributes.

Completion Domains
Controls how unqualified host names are resolved into IP addresses from the local device. The following attributes
may specify a qualified or unqualified host name or IP address: Local Site Director Hostname, ADS Repository Host,
Default ADS Repository Host, Site Time Server Hostnames, Device Timer Server Hostnames. This attribute is
applicable only for unqualified host names.

If this attribute is not an empty list, the Engine attempts name resolution for the host name appended with each
domain name, one at a time, in the order specified by this attribute until resolved. This attribute affects both Domain
Name System (DNS) and host file name resolution. For example, if the host name is x, and completion domains are
jci.com and na.jci.com, the device tries to resolve the following fully qualified host names in the order here:

x.jci.com

x.na.jci.com

Back to Engine Attributes.

Computer Name
Resides on the Network tab as an editable attribute. Devices on the LAN and the Metasys system network use the
Computer Name to identify and communicate with the Engine across the network. Computer Name is synonymous
with host name on a network.

Important: Starting at Release 2.1.10, the Engine Update Tool places restrictions on the Host Name (Computer
Name) values you can use for NCE25/NAE35/NAE45 models. Name values must start with a letter,
end with either a letter or a number, and may contain dashes only in the interior of the name. Failure
to follow the name restrictions results in the Computer Name value changing when an
NCE25/NAE35/NAE45 is updated. Refer to theNAE/NIE Update Tool Technical Bulletin (LIT-12011524)
for more information on Host Name restrictions.

Each Engine ships with a unique initial Computer Name value, which is NAExxxxxxxxxxxx, where xxxxxxxxxxxx is
the Ethernet Media Access Control (MAC) address of the device without the hyphens. For example, if the Engine
has a MAC address of 00-80-66-05-0F-FC, the initial computer name is NAE008066050FFC.

If you change the value of this attribute, a Metasys Confirmation dialog box appears stating that the changes you
have made will cause the device to reset, and will cause any unsaved data in other user interface display panels to
be lost. Click OK to continue, or click Cancel to return to Edit mode. If you clicked OK, the Engine resets and the
new settings take effect. The name entered in the Computer Name attribute is automatically entered in the Local
Site Director attribute of the Engine, if it is defined as the Site Director.

Both the Computer Name and Name attributes default to the object identifier you used during manual object creation;
however, do not confuse the Computer Name attribute with the Name attribute. Changing the Engine Name attribute
does not impact the object references or network communication with other devices on the site.
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Changing the Computer Name online breaks any existing references between the Engine object and other objects
on the site, and may break the existing network connection to other devices on the network. We do not recommend
changing the Computer Name online. If you change the Computer Name attribute in the SCT (right-click the Engine
in the navigation tree and select Rename), both the Computer Name and Name attributes are changed to the new
name you select. The Item Reference then updates to show the new Computer Name. Download the updated
database to the renamed device and any other devices that refer to the renamed device.

Back to Engine Attributes.

Database Revision
Specifies a logical revision number for the device’s database. Database Revision is incremented when an object is
created or deleted, an object name changes, or a restore is performed.

Back to Engine Attributes.

Device Addr Binding
Contains a list of BACnet Object Identifiers of an Engine Device object and a BACnet device address in the form of
a BACnet Address. Entries in the list identify the actual device addresses that are used when accessing the remote
device via a BACnet service request. The list may be empty if no device identifier-device address bindings are
currently known to the device.

Back to Engine Attributes.

DHCP Enabled
Indicates whether the DHCP protocol should be used. The device may run in three modes:

1. DHCP enabled and a DHCP server exists on the network. The DHCP server assigns network configuration
information. The DHCP server can assign the following attributes:

• IP Address
• IP Mask
• IP Router Address
• DNS Server IP Addresses (when Obtain DNS Address Automatically attribute is True)

2. DHCP enabled and no DHCP server exists on the network. Using the Automatic Client Configuration feature,
the device automatically configures the network configuration. The following attributes can be assigned:

• IP Address
• IP Mask

3. DHCP disabled. You must manually assign the network configuration.

When DHCP Enable is True, the UI ignores the following attributes and should not attempt to write to them. The
values from the DHCP are assumed to be more current than the tool interface:

• IP Address
• IP Mask
• IP Router Address
• DNS Server IP Addresses (when Obtain DNS Address Automatically attribute is True)

Back to Engine Attributes.

DNS Server IP Addresses
Lists the IP address of the DNS on the network. The system uses a DNS to resolve host names to IP addresses
and similar tasks. A write to this attribute is ignored when the Obtain DNS Address Automatically attribute is True.
A read of this attribute returns either the user-specified value or the value determined from DHCP.

The DNS Server IP Addresses attribute can be set explicitly, or it may be automatically set using the DHCP server.
Using the DHCP server, you can change this attribute even if you set it up explicitly. See theDHCP Enabled attribute.

Back to Engine Attributes.
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DST Status
Indicates whether daylight saving time is in effect (True) or not (False) at the device’s location.

Back to Engine Attributes.

Detection Interval
Indicates the time, in seconds, determined by the HTTP transport mechanism based on the Poll Rate and Network
Tolerance settings. This value determines how fast a site detects a device going offline.

Back to Engine Attributes.

Domain Name
Indicates the Domain Name in which the Engine is defined. The Item Reference attribute of this object is constructed
using the Domain Name. When creating or renaming an Engine in the SCT, the Domain Name of an Engine is
specified by including it in the Engine’s Item Reference in this format: Computer Name.Domain Name.

In the online UI, the Domain Name of an Engine is specified directly on the Network tab. Change the Domain Name
only if you are working with a newly installed Engine. If you change the Domain Name at any other time, you may
invalidate object references on other devices to the Engine.

If a DHCP server is present and configured, the Domain Name changes automatically. If the name resolution method
for a site is a host file or DNS completion domains are used, you can leave the Domain Name field blank. If the site
uses DNS name resolution, the combination of the computer name dot domain name (Computer Name.Domain
Name) should resolve to the Engine’s IP address.

If you write the value of this attribute in the UI, a Metasys Confirmation dialog box appears, stating that the changes
you have made will cause the device to reset, and will cause any unsaved data in other user interface display panels
to be lost. Click OK to continue, or click Cancel to return to Edit mode.

If you rename the device in the SCT (right-click the Engine in the navigation tree and select Rename), both the
Computer Name and Name attributes are changed to the new name you select. You may invalidate object references
on other devices to the Engine because the Domain Name is included in the Item Reference of the device. Be sure
to download the updated database to the renamed device and any other devices that refer to the renamed device.

Note: Periods (.) are allowed in Domain Names.

Back to Engine Attributes.

Duplicate References
Lists references that are duplicated in the system. Entries in this list are object references that exist on more than
one device within the system.

Back to Engine Attributes.

Enabled Audit Level
Specifies which level of audit entries are added to the Audit Repository. Only audit entries of type Level 1 through
(and including) the specified level are included. All other levels are not stored in the audit trail. Level 1 and Level 2
audit entries are always stored in the audit trail.

• Level 1 and 2 (1): Stores all user action and system error audit messages.
• Level 3 (2): Stores application audit messages in addition to Level 1 and 2 auditing.
• Level 4 (3): Stores system audit messages in addition to Level 3 auditing.
• Level 5 (4): Stores diagnostic audit messages in addition to Level 4 auditing.

Back to Engine Attributes.

455Metasys System Online Help PDF



Estimated Flash Available
Specifies the estimated flash memory available within the device for use by the user’s database and applications.
This value can be used to determine whether additional use of flash can be accommodated; however, other
performance indicators should also be assessed. This property’s value is calculated at the same time as the Flash
Usage attribute. A negative value suggests that the flash usage should be reduced. Also, a negative value can affect
system reliability now or in future releases of software.

Back to Engine Attributes.

Ethernet MAC Address
Displays the Ethernet Media Access Control (MAC) address of this device.

Back to Engine Attributes.

Event Action When Full
Specifies the operation of the Alarm and Event Management feature when the event repository is full. If the value
is Stop, additional event entries are discarded. If the value is Rollover, additional event entries replace the oldest
event entries.

See Default Destination in the Alarm and Event Management section.

Back to Engine Attributes.

Event Rate
Specifies the number of event messages destined for the Metasys server in the last hour (for diagnostic purposes).
The value of this attribute updates every 5 minutes.

Back to Engine Attributes.

Events Lost
Specifies the total number of events which failed to be forwarded to the configured repository and which were deleted
from the NxE's local repository. This count does not persist through an NxE reset, and reflects the number of lost
events since the last reset.

External Modem Config
Specifies the modem configurations. If there is no external modem connected to the NAE55/NIE55, you cannot edit
the External Modem Config attribute. To edit this attribute, plug in an external modem, wait approximately 30 seconds,
and refresh the Communications tab. See the following table for the structure parameters of this attribute:

Table 241: Engine Object: External Modem Config Parameters
Minimum/Maximum ValueInitial ValueData TypeParameter

Name
The connection is defined only if it is enabled (read-only).True (1)True or FalseEnabled

When false, the connection can be used only for outgoing calls.False (0)True or FalseAllow Incoming
Connections

Uses Pager Baud Rates (Set 306).115,200One from a list
of rates

Baud Rate

Uses Pager Baud Rates (Set 306).115,200One from a list
of rates

Maximum Baud
Rate

False (0)True or FalseWait for Dial tone
Before Dialing

This is the initialization string sent to the modem whenever a modem is
being used.

M0TextExtra Initialization
Commands

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

456Metasys System Online Help PDF



Firmware Version
Represents the release of firmware installed in the main code section of the device. The first digit in the revision
number is advanced on major releases. The second digit is advanced on minor releases.

Back to Engine Attributes.

Flash Usage
Specifies the estimated percent of flash memory currently in use. The percentage is based on the portion of flash
that is designated for use by the user’s database. The value is updated on device startup, after a database archive,
sync or download from the SCT (offline mode), and by manual command (Update Flash Usage). A value greater
than 100% can affect system reliability now or in future software releases. No restrictions are in place to prohibit
use of flash over 100%.

If you are simulating an NAE/NIE, your computer’s hard disk must be formatted for NTFS. If your computer’s hard
disk is formatted to use FAT32 (32-bit File Allocation Table), the simulated value for the Flash Usage attribute is not
accurate.

Back to Engine Attributes.

IEIEJ Function A List
Provides a list of structures with the following elements: Network Number, Device ID High Limit, and Device ID Low
Limit. The first set of Who-Is messages is broadcast once the device reaches the Enable Field Commands phase
of startup. At this time, a timer starts running that calls a method to send the Who-Is messages at the period specified
by IEIEJ Function A Period.

Back to Engine Attributes.

IEIEJ Function A Period
Sets the period at which the IEIEJ Function A List sends the Who-Is message broadcasts. Clearing the value of this
property disables the function A feature. Each destination is guaranteed to get a Who-Is message within the period
specified by this property; however, if there are multiple destinations in the list, the object attempts to spread out the
Who-Is messages so that they are not all sent out at the same instant.

Back to Engine Attributes.

Internode Comm Timer
Controls the frequency of communication with remote Ethernet devices. This value is used by the Ethernet IP Datalink
object. Among other communications, this attribute defines the frequency of the heartbeat to monitored devices
(monitored at a rate of two times the Internode Comm Timer). A change to this attribute does not take effect until
the next Engine restart (cold or warm).

Back to Engine Attributes.

Interval Offset
Specifies the offset, in minutes, from the beginning of the period defined for time synchronization until the actual
time synchronization requests are set. Interval Offset has no effect when Align Intervals is False.

Back to Engine Attributes.

IP Address
Represents the IP address of this Engine. The IP address identifies the Engine on the network and assists in the
routing of messages. Each Engine must have a unique IP address for the network to operate properly. A write to
this attribute is ignored when the DHCP Enable attribute is True. A read of this attribute returns either the user
specified value or the value determined from DHCP.

Certain IP addresses are invalid and cannot be written successfully. The network address portion of the IP address
is computed by including all bits in which the corresponding bit from the IP mask is 1. The device address portion
of the IP address is computed by including all bits in which the corresponding bit from the IP mask is 0. Neither the
network address nor device address can be all zero bits or all one bits. For example, if the IP mask is 255.255.0.0,
the following IP addresses are invalid: 0.0.100.100 and 100.100.0.0.
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The IP Address attribute can be set explicitly, or it may be automatically set using the DHCP server. Using a DHCP
server may change this attribute even if you have set it up explicitly. See the DHCP Enabled attribute.

Back to Engine Attributes.

IP Mask
Represents the IP mask used on the Ethernet network. The IP Mask is used for subnet addressing. A write to this
attribute is ignored when the DHCP Enabled attribute is True. A read of this attribute returns either the user specified
value or the value determined from DHCP. The following IP masks are invalid and cannot be written successfully:
0.0.0.0 and 255.255.255.255. Generally, an IP mask consists of between 1 and 31 consecutive 1 bits, followed by
31 to 1 consecutive 0 bits when written out in binary notation. We recommend the IP mask follow this pattern.

The IP Mask attribute may be set explicitly, or it may be automatically set using the DHCP server. Using a DHCP
server may change this attribute even if you have set it up explicitly. See the DHCP Enabled attribute.

Back to Engine Attributes.

IP Router Address
Represents the IP address of one or more default gateways. A write to this attribute is ignored when the DHCP
Enabled attribute is True. A read of this attribute returns either the user specified value or the value determined from
DHCP. Certain IP router addresses are invalid and cannot be written successfully. See the description of the IP
Address.

The IP Router Address attribute may be set explicitly, or it may be automatically set using the DHCP server. Using
a DHCP server may change this attribute even if you have set it up explicitly. See the DHCP Enabled attribute.

Back to Engine Attributes.

Internal Modem Config
Specifies the modem configurations. See the following table for the structure parameters of this attribute:

Table 242: Engine Object: Internal Modem Config Parameters
Minimum/Maximum ValueInitial ValueData TypeParameter Name
The connection is defined only if it is enabled (read-only).True (1)True or FalseEnabled

When false, the connection can be used only for outgoing calls.False (0)True or FalseAllow Incoming
Connections

Uses Pager Baud Rates (Set 306).115,200One from a list of
rates

Baud Rate

Uses Pager Baud Rates (Set 306).115,200One from a list of
rates

Maximum Baud Rate

False (0)True or FalseWait for Dial Tone
Before Dialing

This is the initialization string sent to the modem whenever a
modem is detected.

M0TextExtra Initialization
Commands

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

Is Validated
Enables the MVE feature at the device, which includes reauthentication with electronic signature and required
annotation when the user makes a change to the system, such as commanding an object, acknowledging an alarm,
or changing the value of an attribute. This attribute can be set to True for MVE sites only. This attribute is writable
only with the SCT, and is read-only online.

Back to Engine Attributes.
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JCI Exception Schedule
Indicates how long exception schedules are kept after the exception date has expired. The default value is Auto
Delete 31 days, which is the same behavior prior to this release. New options are Auto Delete 7 days and Manual
Delete. See the Scheduling section for more information on Exception Schedules.

Note: The NAE (using SCT and online UI) and FAC (at CCT) allows selections for Manual Delete, Auto Delete 31
days, and Auto Delete 7 days.

Note: Manual Delete is needed for locations like Japan where the local standards state that only the BACnet
workstation can delete exception schedules.

Back to Engine Attributes.

Last Restart Reason
Indicates the reasons for the last device restart.

The possible reasons are:

• UNKNOWN: The device cannot determine the cause of the last reset. This may occur due to a startup error,
shutdown error, crash, or pushing the hardware reset button. The state is UNKNOWN if the device is powered
without the battery or if the Device Manager service is stopped.

• COLDSTART: A ReinitializeDevice request was received with a Reinitialized State of Device of COLDSTART
or the device was made to COLDSTART via the user interface.

• WARMSTART: A ReinitializeDevice request was received with a Reinitialized State of Device of WARMSTART
or the device was made to WARMSTART by some other means. WARMSTART also occurs after a download
from SCT.

• DETECTED_POWER_LOST: The device detected that incoming power was lost. This state occurs as the result
of a normal power down (with battery).

• DETECTED_POWERED_OFF: The device detected that its power switch was turned off.
• HARDWARE_WATCHDOG: The hardware watchdog timer reset the device.
• SOFTWARE_WATCHDOG: The software watchdog timer reset the device. This state is reported when Device

Manager cannot communicate with the control engine for any reason.
• SUSPENDED: The device was suspended. How the device was suspended or what it means to be suspended

is a local matter.

Back to Engine Attributes.

Local Date
Indicates the date to the best of the device’s knowledge. The Date type is a series of 4 one-number elements. The
first number is the year (for example, 2005); the second number is the month (1..12, 1=January); the third is the day
of month (1..31). To maintain compatibility with BACnet protocol, a fourth number contains the day of week
(1=Monday). A value of FF * (asterisk) in any of the elements indicates the value is not specified.

Back to Engine Attributes.

Local Site Director
Specifies a resolvable host name or IP address of the Site Director. A host name may be specified only if a DNS
server or other means of name resolution is available to the device. A Site Director may have more than one host
name. The host name specified here must be resolvable to an IP address on the LAN or WAN on which the site’s
devices exist.

The Local Site Director attribute is based on the Computer Name attribute, not the Name attribute. When you change
the Site Director device’s Computer Name attribute, its Local Site Director attribute automatically changes to match
its Computer Name. When you change a non-Site Director device’s Computer Name, its Local Site Director attribute
remains unchanged.

For information designating an Engine as the Site Director, refer to the NAE Commissioning Guide (LIT-1201519).

Back to Engine Attributes.
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Local Time
Indicates the time of day to the best of the device’s knowledge. The Time type is a series of four one-number
elements. The first number is the hour (0..23); the second number is the minute (0..59); and the third number is the
seconds (0..59). A fourth number has been added to maintain compatibility with BACnet protocol and contains the
hundredths of second (0..99). A value of * (asterisk) for any number indicates the value is unspecified. This value
would be used, for example, when the hundredths value is not important.

Back to Engine Attributes.

Location
Indicates the physical location of the device.

Back to Engine Attributes.

Max APDU Length
Indicates the maximum number of bytes that may be contained in a single, indivisible application layer protocol data
unit.

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

Max Message Buffer
Specifies the largest piece of data that can be sent to a device at one time, excluding all communications headers.
Some applications need to perform segmentation of data outside the communications system. This value is used
to size the data in those situations.

Back to Engine Attributes.

Max Segments Accepted
Indicates the maximum number of segments of an APDU accepted by the device.

Back to Engine Attributes.

Maximum Intermittent Failure Period
Specifies the maximum number of seconds a device was offline at the transport layer (for diagnostic purposes).
Only times under one minute are recorded, to eliminate device resets. The value of this attribute does not match
the offline times determined from generated alarms. Ideally, this number should be zero, indicating there are no
failures.

Back to Engine Attributes.

Memory Usage
Specifies the percent of system RAM that is currently in use.

It is calculated as follows:

Total commit charge x 100

Commit charge limit

These values are obtained from the Windows OS. Memory usage can be used to diagnose operational problems
with the device. For example, if the value climbs steadily over time (about 24 hours), it would indicate a memory
leak. A memory leak eventually consumes all system RAM and causes a device reset. Valid data is provided only
on the Engine hardware. Under device simulation, the value is 0.

If your computer’s hard disk is formatted to use FAT32 (32-bit File Allocation Table), the simulated value for the
Memory Usage attribute is not accurate.

Back to Engine Attributes.

Model Name
Indicates the device model, the hardware revision associated with the firmware, and the code file name used to
download the device.
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Back to Engine Attributes.

Network Address
Specifies the BACnet network address. A change to this attribute takes effect after the next Engine restart (cold or
warm).

If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

Network Tolerance
Sets the timeout tolerance of the flexible polling feature (that is, changes the lower level communication timeouts).
When edited by a user, this attribute is sent to the HTTP transport layer and determines how long the device waits
to connect, send, and wait to receive HTTP Post responses. The setting options are LOW, MEDIUM, and HIGH.
LOW is the default and matches the current behavior. The MEDIUM or HIGH setting increases the tolerance by
adding longer timeouts and more retries and should be used for poor network connections. Note that it takes longer
to detect an offline device as the tolerance gets higher.

Back to Engine Attributes.

Object Count
Indicates the number (count) of all of the object instances within the device. Objects of all classes are included.

Back to Engine Attributes.

Object Memory Usage
Specifies the percent of the object database that is currently in use. Each object created consumes memory within
the object database. This attribute can be used to help determine the device’s capacity for additional objects; however,
other performance indicators should also be assessed. Generally, the number of objects you define determines the
object memory usage. This attribute is valid on the Engine hardware and under device simulation.

Note: If you have a large number of objects, the object memory usage increases and the archive.moi file size
increases also. The archive.moi file is stored in flash memory.

Also, an attempt to create an object known to require X bytes of object database may fail even if more than X bytes
are available in the object database. This is because the object database is composed of multiple blocks. If the free
space of each block is fewer than X bytes, the request for X bytes fails even though the sum total of free space from
all blocks is greater than X bytes.

Back to Engine Attributes.

Obtain DNS Address Automatically
Controls whether the DNS Server IP Addresses attribute should be automatically determined using DHCP. If the
DHCP Enabled attribute is False, this attribute is ignored and a value of False is assumed. When True, a write to
the DNS Server IP Addresses attribute is ignored.

Back to Engine Attributes.

Pager Dial-up Status
Specifies the current status of the pager dial-up connection.

Back to Engine Attributes.

Power Consecutive Samples
Specifies the number of consecutive AC line status samples (indicate a power loss) must be received before the
device concludes that a power failure has occurred. When the device concludes that power has failed, the device
begins an orderly shutdown process. The process used for determining whether a power failure has occurred protects
the device from shutting down during short power failures or certain brownout conditions. Using default values, a
power failure of less than 5 seconds does not prompt a device shutdown.

Back to Engine Attributes.
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Power Sampling Interval
Specifies the period at which the AC line status is sampled to determine whether a power failure has occurred. This
attribute is used in conjunction with the Power Consecutive Samples attribute.

Back to Engine Attributes.

Process ID List
Contains a list of unsigned 32-bit numbers used to compare the Process ID sent with the BACnet events. If the event
Process ID is not found on this list, then the event is ignored. An empty list or a list containing only one entry with
the value of zero allows all events to be processed.

Back to Engine Attributes.

Protocol Obj Support
Indicates which standard BACnet object types the device’s protocol implementation supports.

This attribute is a bit string that uses the Object Type (Set 508). Each bit represents a BACnet object type in that
set. For example, bit 0 represents the BACnet AI object type, whereas bit 17 represents the BACnet schedule object
type. If the bit is true (1), the object type is supported. If the bit is false (0), the object type is not supported. The
BACnet object types supported can vary between device models.

Back to Engine Attributes.

Protocol Revision
Indicates the minor revision level of the BACnet standard the device supports.

Back to Engine Attributes.

Protocol Ser Support
Indicates which standard BACnet protocol services the device’s protocol implementation supports. For more
information on the PICS and BIBBs of the Engine, see the Related Documentation table in the Welcome section.
This object now supports both the BACnet UTCTimeSynchronization message and the BACnet TimeSynchronization
message (non-UTC version). Third-party devices now have the ability to send the TimeSynchronization message
to an Engine.

This attribute is a bit string that uses the Protocol Ser Support (Set 136). Each bit represents a BACnet service in
that set. For example, bit 0 represents the Acknowledge Alarm service, whereas bit 12 represents the Read Property
service. If the bit is true (1), the service is supported. If the bit is false (0), the service is not supported.

Back to Engine Attributes.

Protocol Version
Represents the BACnet protocol the device supports. Initial releases are Version 1; subsequent releases increase
the number by one.

Back to Engine Attributes.

Repository Status
Indicates the status of the communication between the device and the trend log sample repository (for diagnostic
purposes). This attribute uses the Repository Status set.

Back to Engine Attributes.

Restart Notification Recipients
Controls the restrictions on which devices, if any, are notified when a restart occurs. The value of this attribute is a
list of BACnetRecipients. When the length of this list is empty, the device cannot send a device restart notification.
The default value of this property is a single entry representing a broadcast on the local network. If the list has one
or more entry, the device sends a restart notification, but only to the devices or addresses listed.

Back to Engine Attributes.
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Routing Mode
Specifies whether third-party configuration tools operating on an IP network can access third-party MS/TP devices
connected to an Engine MS/TP trunk. Routing is disabled by default to keep present configurations intact. Enabling
routing is only recommended if existing third-party tool configurations cannot support any other connection method
to the third-party MS/TP device. Once routing is enabled on an Engine, all Device Identifiers and Network Address
numbers within each device on the network must be unique across all routed networks. The values are:

• Disabled - Disables routing of BACnet messages from one supervisory controller network to another.
• Enabled - Enables routing of BACnet messages from one supervisory controller network to another.
• Enabled Without Broadcasts - Enables routing of BACnet messages from one supervisory controller network

to another while blocking broadcasts.

Back to Engine Attributes.

Samples Lost
Specifies the number of trend samples lost because the Metasys server did not retrieve them fast enough (for
diagnostic purposes). This value resets only when the device restarts.

Back to Engine Attributes.

Sample Rate
Specifies the number of trend samples destined for the Metasys server in the last hour (for diagnostic purposes).
The value of this attribute updates every 5 minutes.

Note: The sample rate at the NxE is calculated based on the actual raw samples taken by every trend object. The
sample rate at the ADS is calculated once every poll cycle and is based on the number of samples received
from all the NxEs and the time it took to poll them. Most NxEs do not forward all the samples taken between
polls because the ADX transfer setpoint is usually not set to 1 (that is, forward on every sample). The result
is that the sample rate at the ADS is less than the sum of the samples taken at all the NxEs. The total ADS
sample rate is 60,000 and the total NxE sample rate is larger than 100,000.

Back to Engine Attributes.

Segmentation
Indicates if the device supports segmentation of messages and (if so) if it supports segmented transmission, reception,
or both.

Back to Engine Attributes.

Serial Port Cable Config
Specifies the configuration of a communications cable connected between Engine serial port A or port B and another
computer. See the following table for the structure parameters of this attribute:

Table 243: Engine Object: Serial Port Cable Config Parameters
Minimum/Maximum ValueInitial ValueData TypeParameter Name
The connection is defined only if it is enabled (read-only).True (1)True or FalseEnabled

When false, the connection can be used only for outgoing
calls.

True (1)True or FalseAllow Incoming
Connections

Uses Baud Rate (Set 121).115,200One from a list of
rates

Baud Rate

Uses Baud Rate (Set 121).115,200One from a list of
rates

Maximum Baud Rate

Not applicableFalse (0)True or FalseWait for Dial Tone
Before Dialing

Not applicable

Maximum length - 80

TextExtra Initialization
Commands
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If you write the value of this attribute, you must reset the Engine for the new settings to take effect.

Back to Engine Attributes.

Site Director Online
Indicates the communication status of this device with the Site Director. This value is kept current by a command
sent by the Data Refresh COV Monitor task whenever the status changes. The COV Monitor task performs this
check every 80 seconds. This attribute is triggered so it can be used for an alarm.

Back to Engine Attributes.

System Status
Reflects the current physical and logical state of the device.

Back to Engine Attributes.

Time Between Buffer Reads
Indicates the time, in minutes, between Engine trend consolidation buffer readings from the Metasys server (for
diagnostic purposes).

Back to Engine Attributes.

Time of Device Restart
Indicates the time at which the device was restarted.

Back to Engine Attributes.

Time Sync Recipients
Controls the restrictions placed on a device’s use of the Time Synchronization service. If the list is of length zero, a
device is prohibited from automatically sending a Time Synchronization request. If the list is of length one or more,
a device automatically sends a Time Synchronization request but only to the devices or addresses listed. If it is
present, this attribute is writable.

Back to Engine Attributes.

Time Synchronization Interval
Specifies the periodic interval, in minutes, at which TimeSynchronization and UTCTimeSynchronization requests
are sent. When set to zero, then periodic time synchronization is disabled.

Back to Engine Attributes.

Transfer Buffer Full
Indicates the percentage full of the Engine trend consolidation buffer (for diagnostic purposes).

Back to Engine Attributes.

Transport Failure Rate
Specifies the number of transport failures per day (for diagnostic purposes). This number represents how often
HTTP posts from this engine failed when they were sent to another device that is considered online. Failures include
the inability to open the connection, to send the message, or to receive the reply. This value represents failures over
the last 24 hours and is updated hourly, but will not correlate directly to the number of offline alarms generated by
your system. Ideally, this number should be zero, indicating there are no failures.

Back to Engine Attributes.

UTC Offset
Contains the Universal Coordinated Time (UTC). The UTC Offset attribute indicates the number of minutes (-900
to +900) offset between local standard time and Universal Coordinated Time. The time zones to the west of the zero
degree meridian are indicated by positive values, and those to the east are indicated by negative values. The value
of the UTC Offset attribute is derived from the Time Zone attribute of the site.

Back to Engine Attributes.
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Unbound References
Lists references that are not bound in the system. This attribute indicates that a process cannot find an object either
because the device on which the object is located is offline, the object has been deleted, or the object reference is
incorrect.

Back to Engine Attributes.

Vendor ID
Distinguishes proprietary extensions to the protocol using a unique vendor identification code assigned by ASHRAE.
The Johnson Controls Vendor ID is 5.

Back to Engine Attributes.

Vendor Name
Identifies the manufacturer of the device.

Back to Engine Attributes.

Engine Commands
The table below lists the commands supported by the Engine Device Object.

Table 244: Engine Device Object Commands
ParametersCommand Name

Archive

Integer (1–4)Change Audit Enabled Class Level

Reset Device

Route Samples

Rediscover Text Strings

Update Flash Usage

Engine Device Command Details
Archive
Archives the object instances to the nonvolatile memory.

Back to Engine Commands.

Change Audit Enabled Class Level
Changes the Audit Enabled Class Level attribute.

Back to Engine Commands.

Reset Device
Resets the device. This is an orderly reset that saves the archive and restarts the operating system. A reset is often
required after making changes to Operating System parameters and the following attributes:

• APDU Retries
• APDU Segment Timeout
• APDU Timeout
• BACnet IP Port
• Computer Name
• Contact Person
• Domain Name
• External Modem Config
• Internal Modem Config
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• Max APDU Length
• Network Address
• Port Number
• Read Only Community
• SNMP DDA Attributes
• Serial Port Cable Config
• Time Sync Period
• Read/Write Community
• ADS Dial-up Config

Note: When you update the time servers, you do not need to reset the Engine; however, if you change any direct
connect, internal modem, or external modem attributes, reset the Engine.

When the Engine requires a reset, Reset Needed appears in the title bar of the object in the display panel. The
Reset Needed status is triggered by Reset Needed (19) and Cold Reset Needed (20) in the JCI System Status (Set
25).

Important: Do not push the RE-BOOT SYSTEM switch on the Engine to initiate a reset to address a Reset Needed
status. Pushing the RE-BOOT SYSTEM switch initiates CPU reset and reboot, which causes all unsaved
data to be lost (including recent attribute value changes).

Back to Engine Commands.

Route Samples
Routes all Trend samples to the Metasys Server. Use this command before performing an engine upgrade to minimize
the risk of losing any trend samples.

Back to Engine Commands.

Rediscover Text Strings
Resets the States Text across a supervisory device by rediscovering text strings from all mapped BACnet objects.

Note: When the Rediscover Text Strings command is sent from the Site Director device UI to another supervisory
device and the UI is running on the supervisory device, you must close and restart the UI on the supervisory
device in order for the text to appear correctly.

Back to Engine Commands.

Update Flash Usage
Ensures the values of the Flash Usage and Estimated Flash Available attributes are current. The Engine executes
this command internally on device startup, after an Archive command, which also executes automatically at 12:02
A.M. daily, and after a database download or synchronize from the SCT (offline mode).

Back to Engine Commands.
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Ethernet IP Datalink Object
The Ethernet IP Datalink object manages the Ethernet communications bus and the messages transmitted on it.
Working with this object allows you to access Ethernet card statistics.

For general information on Metasys system objects, see the Object Help section.

Ethernet IP Datalink Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 245: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberAddress Length

2-104CWNumberAPDU Retries

1,000–65,535

Units = milliseconds

4,000CWNumberAPDU Segment Timeout

1,000–65,535

Units = milliseconds

6,000CWNumberAPDU Timeout

47,808NumberBACnet IP Port

Maximum length = 6 octetsTextBroadcast Address

Maximum length = 6 octetsTextDevice Address

128–65,535

Units = bytes

1,024CWNumberMax APDU Length

NumberNetwork Address

1 C - Configurable, W - Writable

Table 246: Ethernet IP Datalink Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberBroadcast Receives

NumberBroadcast Transmits

NumberDiscarded Frames

NumberMessage Receives

NumberMessage Transmits

DateReset Date

TimeReset Time

NumberRetry Attempts

NumberTransmit Failures

1 C - Configurable, W - Writable

Ethernet IP Datalink Attribute Details
Address Length
Indicates the number of octets for the device address (Data Link Address).
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Back to Ethernet IP Datalink Attributes.

APDU Retries
Indicates the maximum number of times that an APDU is retransmitted. If the device does not perform retries, it is
set to zero. If this value is greater than zero, a non-zero value appears in the APDU Timeout attribute.

Back to Ethernet IP Datalink Attributes.

APDU Segment Timeout
Indicates the amount of time in milliseconds between retransmission of an APDU segment. This value is non-zero
if the device supports segmentation of transmitted APDUs.

Back to Ethernet IP Datalink Attributes.

APDU Timeout
Indicates the amount of time in milliseconds between retransmissions of an APDU requiring acknowledgement for
which no acknowledgement has been received.

Back to Ethernet IP Datalink Attributes.

BACnet IP Port
Indicates the IP Port number that the device uses to transmit and receive messages.

Back to Ethernet IP Datalink Attributes.

Broadcast Address
Indicates the address used when sending broadcast messages.

Back to Ethernet IP Datalink Attributes.

Broadcast Receives
Indicates the number of broadcast messages received.

Back to Ethernet IP Datalink Attributes.

Broadcast Transmits
Indicates the number of broadcast message transmissions.

Back to Ethernet IP Datalink Attributes.

Device Address
Indicates the address of the device (Data Link Address).

Back to Ethernet IP Datalink Attributes.

Discarded Frames
Indicates the count of received messages discarded due to critical low resources (that is, the System Memory
Resource, Object Engine Queue Resource, or Protocol Engine Input Queue Resource).

Back to Ethernet IP Datalink Attributes.

Max APDU Length
Indicates the maximum number of bytes that may be contained in a single, indivisible application layer protocol data
unit.

Back to Ethernet IP Datalink Attributes.

Message Receives
Indicates the number of messages received.

Back to Ethernet IP Datalink Attributes.

Message Transmits
Indicates the number of message transmissions.

Back to Ethernet IP Datalink Attributes.
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Network Address
Indicates the BACnet network address of this data link.

Back to Ethernet IP Datalink Attributes.

Reset Date
Indicates the date of the last Clear Statistics command.

Back to Ethernet IP Datalink Attributes.

Reset Time
Indicates the time of the last Clear Statistics command.

Back to Ethernet IP Datalink Attributes.

Retry Attempts
Indicates the number of retry attempts.

Back to Ethernet IP Datalink Attributes.

Transmit Failures
Indicates the number of message transmit failures.

Back to Ethernet IP Datalink Attributes.

Ethernet IP Datalink Commands
The table below lists the commands supported by the Ethernet IP Datalink Object.

Table 247: Ethernet IP Datalink Object Commands
ParametersCommand Name
NoneClear Statistics

NoneLatch Statistics

Ethernet IP Datalink Command Details
Clear Statistics
Resets all statistics to zero and updates the Reset Data and Reset Time values.

Back to Ethernet IP Datalink Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to Ethernet IP Datalink Commands.
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Event Enrollment Object
The Event Enrollment object’s attributes represent and contain information for managing events. Events are changes
in the value of an object that meet specific criteria. The Event Enrollment object defines the event criteria and provides
a connection between an event and a notification message sent to recipients. A recipient device is enrolled for
notification if:

• it is one of the recipients in a Notification Class Object referenced by the Event Enrollment object
• a Notification Class object is not referenced and it is the recipient of the Event Enrollment object

For general information on Metasys system objects, see the Object Help section.

Event Enrollment Concepts
Event Relationships
Event Types, Event States, and Event Parameters are interrelated attributes:

Table 248: Event Relationships
Event ParametersEvent StateEvent Type1

Time Delay

Bitmask

List of Bitstring Values

Normal

Offnormal

Change of Bitstring

Time Delay

List of Values

Normal

Offnormal

Change of State

Time Delay

Bitmask2

COV Increment2

NormalChange of Value (COV)

Time Delay

Feedback Property Reference

Normal

Offnormal

Command Failure

Time Delay

Setpoint Reference

Low Diff Limit

Hi Diff Limit

Deadband

Normal

High Limit

Low Limit

Floating Limit

Time Delay

Low Limit

High Limit

Deadband

Normal

High Limit

Low Limit

Out of Range

1 Any Event Type generates a Fault Event State if the object referenced in the Object Property Reference becomes unreliable
and the Object Property Ref attribute is linked to Reliability.

2 Only one of these parameters is used.

Event Parameters
The table below lists the parameters in the Event Parameters attribute. For a description of the algorithms to which
these parameters apply, refer to ANSI/ASHRAE BACnet Standard 135 - 1995.

470Metasys System Online Help PDF



Table 249: Event Parameters
DescriptionParameter
This parameter applies to the Change of Bitstring event algorithm and the Change of Value event
algorithm in the special case where the referenced attribute is a Bit String data type. It represents a
bitmask that is used to indicate which bits in the referenced attribute are monitored by the algorithm.
A value of one in a bit position indicates that the bit in this position in the referenced attribute is
monitored by the algorithm. A value of zero in a bit position indicates that the bit in this position in
the referenced attribute is not significant for the purpose of detecting this Change of Bitstring or
Change of Value. A Bitmask must contain 4 bits.

Bitmask

These parameters apply to the Floating Limit and Out of Range event algorithms.Deadband

High Diff Limit

Low Diff Limit

High Limit

Low Limit

This parameter (BACnet Object Property Reference) applies to the Command Failure algorithm.
Feedback Property Reference identifies the object and attribute that provides the feedback to ensure
that the commanded attribute changes value. This attribute may reference only object properties
that have lists of true and false values.

Feedback Property
Reference

This is a list that applies to the Change of Bitstring event algorithm. This list defines the set of states
for which the referenced attribute is Offnormal. Only the bits indicated by the Bitmask are significant.
If the value of the referenced attribute changes to one of the values in the List of Bitstring Values,
then the Event State attribute of the Event Enrollment object makes a transition To Offnormal and
sends the appropriate notifications. This list must contain 4 bits.

List of Bitstring Values

This is a list of BACnet Property States that applies to the Change of State event algorithm. This
event algorithm applies to referenced properties that have discrete or lists of values. The List of
Values is a subset of the possible values that the attribute may have. If the value of the referenced
attribute changes to one of the values in the List of Values, then the Event State attribute of the
Event Enrollment object makes a transition to To Offnormal and sends the appropriate notifications.

List of Values

This parameter applies to the Change of Value event algorithm. It represents the increment by which
the referenced attribute must change in order for the event to occur.

COV Increment

This parameter (BACnet Object Property Reference), applies to the Floating Limit event algorithm.
Setpoint Reference indicates the setpoint reference for the reference attribute interval.

Setpoint Reference

This parameter applies to all event types and represents the seconds that the conditions monitored
by the event algorithm persist before an event notification is issued.

Time Delay

This parameter represents the increment by which the referenced property must change for an event
to occur.

Referenced Property
Increment

Event Enrollment Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 250: Event Enrollment Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Flags1Data TypeAttribute Name

To Offnormal, To Fault, To NormalTrue, True,
True

Series of True
or False states

Acked
Transitions

Not supportedCWTextAlarm Message
Text

To Offnormal, To Fault, To NormalTrue, True,
True

WCWSeries of True
or False states

Event Enable

Normal, Fault, Offnormal, High Limit, Low LimitNormalOne state from
a set

Event State

BACnetArray[3] of BACnet Time StampNONE_FFFFSet of valuesEvent Time
Stamps

NormalCWCWOne state from
a set

Execution
Priority

CWCWObject
reference

Graphic

Maximum 256 charactersCWCWTextGraphic Alias

0–4,294,967,295

The BACnet Object Identifier of the Notification
Class used for routing

1WCWNumberNotification
Object
Reference2

Alarm, EventAlarmWCWOne type from
a set

Notify Type

3–153–15CWCNWNumberProcess Identifier

CWCNWObject
reference

Recipient

1 C - Configurable, W - Writable
2 The Notification Class attribute is used if the Recipient attribute is not used. We recommend using the Notification Class attribute.

Table 251: Event Enrollment Object Attributes - Event Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Flags1Data TypeAttribute Name

See the Event Parameters term.WCWSet of related
values

Event
Parameters

Change of Bitstring, Change of State, Change
of Value, Command Failure, Floating Limit, Out
of Range

COne type from
a set

Event Type

Also referred to as Input Reference.CSet of related
values

Object Property
Ref (Input
Reference)

1 C - Configurable, W - Writable

Event Enrollment Attribute Details
Acked Transitions
Conveys three separate flags that each indicate if the most recent To Offnormal, To Fault, and To Normal event
transitions have been acknowledged (if the transition requires acknowledgement).

Back to Event Enrollment Attributes.
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Alarm Message Text
Contains the user-defined text included with the event notification.

Back to Event Enrollment Attributes.

Event Enable
Conveys three flags that determine if notifications are enabled for To Offnormal, To Fault, and To Normal transitions.
When a flag is set, this means that the corresponding transition causes notification to be sent to all enrolled devices.
When a flag is cleared, this means that the corresponding transition is not reported. The object’s Event State
continuously updates, regardless of the value of the Event Enable attribute.

Back to Event Enrollment Attributes.

Event Parameters
Determines the method used to monitor the referenced object. This attribute provides the parameter values used
for the algorithm. See the Event Parameters section for descriptions of the parameters.

Back to Event Enrollment Attributes.

Event State
Indicates the current state of the event. The permitted values for Event State are specific to the Event Type. The
value of Event State is independent of the Event Enable flags.

Back to Event Enrollment Attributes.

Event Time Stamps
Conveys the times of the last event notifications for To Offnormal, To Fault, and To Normal events. Time stamps of
type Time or Date have * in each octet. Sequence number time stamps have 0 if no event notification of that type
has generated since the object was created.

Back to Event Enrollment Attributes.

Event Type
Indicates the type of event algorithm used to detect events and report to enrolled devices. See the BACnet standard
for more information on algorithms. See Event Relationships for more information on the event types.

The table below describes the event types:

Table 252: Event Types
DescriptionEvent Type
Generates an offnormal transition when the value of the referenced property ( Object Property Ref
(Input Reference)) is equal to one of the user-defined Bitstring Values (List Elements after applying the
Bitmask) and the values are equal for the amount of seconds defined by the Time Delay attribute you’re
using. The Bitmask defines the bits important for monitoring.

Change of Bitstring

Generates an offnormal transition when the value of the referenced property ( Object Property Ref
(Input Reference)) is equal to one of the values in the List of Values (List Elements) and the values are
equal for the number of seconds defined by the Time Delay attribute of the object you’re using.

Change of State

Generates a normal transition when the value of the referenced property ( Object Property Ref (Input
Reference)) changes by an amount equal to or greater than the referenced property increment (Change
of Value [COV] Increment) for the number of seconds defined by the Time Delay attribute of the object
you’re using.

Change of Value

Generates an offnormal transition if the values of the referenced property ( Object Property Ref (Input
Reference)) and the Feedback Reference are not equal for a time greater than the number of seconds
defined by the Time Delay attribute of the object you’re using.

Command Failure
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Table 252: Event Types
DescriptionEvent Type
Generates a transition to high or low limit alarm if the value of the referenced property ( Object Property
Ref (Input Reference)) is higher or lower than the range of values determined by the current value of
the Setpoint Reference, High Limit, Low Limit, and Deadband for a time greater than the number of
seconds defined by the Time Delay attribute of the object you’re using.

Floating Limit

Generates a transition to high or low limit alarm if the value of the referenced property ( Object Property
Ref (Input Reference)) is higher or lower than the range of values determined by the High Limit and
Low Limit for a time greater than the number of seconds defined by the Time Delay attribute of the
object you’re using.

Out of Range

Back to Event Enrollment Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Event Enrollment Attributes.

Graphic
Indicates the graphic associated with the object.

Back to Event Enrollment Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to Event Enrollment Attributes.

Notification Object Reference
Specifies the notification class used when handling and generating event notifications for the object. This attribute
implicitly refers to the Notification Class Object that has a Notification Class attribute of the same value.

Back to Event Enrollment Attributes.

Notify Type
Conveys if the notifications generated by the object are Events or Alarms. This attribute is required if the object
supports intrinsic reporting.

Back to Event Enrollment Attributes.

Object Property Ref (Input Reference)
Designates the particular object and attribute referenced by the Event Enrollment object. This attribute applies the
algorithm specified by Event Type to the referenced attribute to determine the Event State.

Back to Event Enrollment Attributes.

Process Identifier
Determines the numeric handle of a process within the recipient device that is enrolled for event notification when
a Notification Class object is not used.

Back to Event Enrollment Attributes.

Recipient
Designates the recipient device that is enrolled for event notification when a Notification Class object is not used.

Back to Event Enrollment Attributes.

Event Enrollment Commands
The table below lists the commands supported by the Event Enrollment Object.
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Table 253: Event Enrollment Commands
BACnet SupportParametersCommand Name
NoDisable

NoEnable

Event Enrollment Command Details
Disable
Prevents distribution of event notifications.

Back to Event Enrollment Commands.

Enable
Allows distribution of event notifications.

Back to Event Enrollment Commands.
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Folder
A Folder object helps support the hierarchical organization of objects.

A total of 1000 objects can be added per folder, and up to 10 consecutive levels of Folder objects can be added
within any other folder or object.

Note: You must name a new folder differently from the folders in the default set on the user interface.

This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section.
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Generic Integration Object
The Generic Integration Object (GIO) is a single software representation of the hardware/internal data points from
a device that has been integrated into your Metasys network. One GIO can represent one or more control strategies
(for example, temperature control or static pressure control). Up to 256 data points can become attributes of the
GIO and each attribute of the GIO works with Metasys features such as historical data management, alarm and
event handling, and basic monitoring and commanding capabilities.

You can map data points to the GIO in either online or offline mode. When you map the data points, you define their
label, units, display precision, category, and whether or not the data point should be commandable. You can command
points from the GIO using Generic Integration Attributes commands.

The GIO is useful when you have multiple hardware/internal data points from an integrated device and it logically
makes sense to view them as a single entity rather than individual Metasys objects (that is, AI, BI, AO, BO, an so
on). While you may be able to browse to each device, there may only be a few data points you need to see on a
regular basis. The GIO lets you group the data points you need to see in one place and organize them in the following
categories:

• inputs
• outputs
• parameters

When the GIO appears in Metasys software, the attributes are organized by tabs bearing the names of the three
categories (Input Category, Output Category, and Parameter Category tabs). Each tab includes the status, description,
and value of the items in that category.

Note: Currently, the GIO supports N1 Migration Object and LON Integration Object. You can no longer manually
add a GIO to a LON trunk; however, the GIO is still supported in existing databases, even after upgrading
to the next software release.

For general information on Metasys system objects, see Common Object Attributes.

Generic Integration Concepts
N1 Integration and the GIO
For N1 integration, use the Control System object from your existing Metasys network. Hardware and internal points
are already defined in the Control System object so there is one to one mapping between a Control System object
and the GIO. N1 point mapping is one to one and the Metasys system restricts which characteristics of the GIO (for
example, label, display precision) can be edited once they are added to the system.

For more information on N1 integration, see the Related Documentation table in the Welcome section.

LONWORKS Network Integration
Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still supported in existing

databases, even after upgrading to the next software release.

In LONWORKS network integration, the GIO presents multiple LONWORKS network variables (with their individual data
elements) and/or NexSys controller points of an integrated LONWORKS network controller as a single Metasys object.
During the configuration of a GIO for an integrated LONWORKS network controller, the user is presented with the
internal network variables and NexSys controller points in a tree structure which then allows the user to add these
data points as attributes of the GIO object. The characteristics of the GIO attributes (label, units, display precision,
field units, category) and the commandability of the GIO attributes can be edited.

For more information on LONWORKS network integration, see theRelated Documentation table in theWelcome section.

Generic Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).
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Click the attribute name in the table for a description of the attribute.

Table 254: Generic Integration Object (GIO) Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NTextDisplay Reference

True or FalseOffline

True or FalseOverridden

Redirected to the Display attributeD(Depends on
the display
attribute)

Present Value

Reliable, Unreliable

Uses Reliability (Set 503).

One value
from a set

Reliability

TextTarget Reference

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

Table 255: Generic Integration Object (GIO) Attributes - Insert Point Wizard Hardware Tab1

Values/Options/RangeInitial ValueNotes2Data TypeAttribute Name

See the attribute description.CWListAttribute Info

Must be one of the defined 256 possible attributesCTextDisplay Attribute

<system>.<object>

8 characters each maximum

NoneCWTextRemote Object Name

1 These attributes only appear on the Hardware tab of the Configure screen of the Insert Point Wizard - GIO.
2 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

Table 256: Generic Integration Object (GIO) Attributes - Input Category, Output Category, and Parameter
Category Tabs

Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

WSet of ValuesGIO 1 Attr . . . GIO 256
Attr2

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable
2 This attribute represents the items that appear on the Input Category, Output Category, and Parameter Category tabs of the

GIO.

GIO Attribute Details
Attribute Info
Contains a list of structures that store data about each attribute defined within a GIO. The elements listed in this
table appear as columns on the Hardware tab of the Configure screen of the Insert Point Wizard - GIO.

Table 257: Attribute Info
Minimum/Maximum ValueInitial ValueData TypeElement Name

True or False
value

Adjust Allowed

0 - Input, 1 - Output, 2 - ParameterNumberCategory

List of valuesDisplay Precision

TextElementRef

Uses Unit Set (Set 869)One value from
a set

Field Units
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Table 257: Attribute Info
Minimum/Maximum ValueInitial ValueData TypeElement Name

TextLabel

True or False
value

Override Allowed

Uses Object Status (Set 505).List of valuesStatus

Use Unit Set (Set 869) to set the units of a real value.List of valuesUnits or EnumSet

Back to Generic Integration Attributes.

Adjust Allowed
Indicates whether or not this attribute supports the Adjust command.

Back to Generic Integration Attributes.

Category
Specifies the attribute category (input, output, or parameter).

Back to Generic Integration Attributes.

Display Precision
Specifies the display precision for an attribute with a real value (floating point).

Back to Generic Integration Attributes.

ElementRef
Specifies the element within the target reference associated with this attribute to provide it data for
value/status/reliability.

Back to Generic Integration Attributes.

Field Units
Represents the units that can be used for the attribute.

Back to Generic Integration Attributes.

Label
Contains the user label for the attribute name. This is the name used whenever you view the attribute in Metasys
software.

Back to Generic Integration Attributes.

Override Allowed
Indicates whether or not this attribute supports the Override command.

Back to Generic Integration Attributes.

Status
Represents the status value of the attribute.

Back to Generic Integration Attributes.

Units or EnumSet
Specifies the units for an attribute that is a real value (floating point).

If an attribute is one value from a set, this attribute sets the states text from the sets listed in the Alphabetical Set
List.

Back to Generic Integration Attributes.
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Display Attribute
Specifies the attribute that represents the value of the GIO. The value of this attribute is used as the Present Value
of the GIO. For example, for a GIO representing a temperature control strategy, you might choose the attribute
representing room temperature to be the Display attribute. Then, the room temperature appears as the GIO Present
Value.

Back to Generic Integration Attributes.

Display Reference
Represents the label of the Display Attribute. The Display Reference is not stored in the object, but read when
requested.

Back to Generic Integration Attributes.

GIO 1 Attr . . . GIO 256 Attr
Represents user-definable attributes that can be part of a GIO. Each attribute represents a potential entry in the
Attribute Info attribute which in turn represents a physical or logical piece of data within an integrated device.

Back to Generic Integration Attributes.

Offline
Has a value of True if the native data source is offline in the native system.

Back to Generic Integration Attributes.

Overridden
Indicates if the data source is overridden.

Back to Generic Integration Attributes.

Present Value
Specifies the current value associated with the Display Attribute of the GIO.

Back to Generic Integration Attributes.

Remote Object Name
Contains the name of the object in the format of system.object.

Back to Generic Integration Attributes.

Reliability
Holds the current reliability state for the GIO. If the source of any individual attribute of the GIO is unreliable, then
the GIO itself becomes unreliable.

Back to Generic Integration Attributes.

Target Reference
Identifies the source that provides the data elements linked to the individual attributes of the GIO.

Back to Generic Integration Attributes.

Generic Integration Commands
The table below shows the command supported by the Generic Integration Object.

Table 258: GIO Commands
Number of ParametersCommand Name

Attribute Command
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GIO Command Details
Attribute Command
Allows you to select one of the user-definable attributes of the GIO. When you select an attribute and click the ellipses
button, the Attribute Commands available for that attribute appear. This allows you to command individual attributes
represented by the GIO.

Back to Generic Integration Commands.

Attribute Commands
Attribute commands are commands you can issue from the GIO to individual attributes of the GIO. To access the
attribute commands, do one of the following:

• In the navigation tree, right click on the GIO object and select Commands then select an attribute for the GIO
Attribute Command, and click the ellipsis button.

• In a category view for the GIO (in the display frame), right-click on the attribute you want to command, and select
Commands.

The attribute commands that appear are based on the data type of the attribute and whether Override Allowed and
Adjust Allowed are True or False:

Table 259: Attribute Commands
NotesCommand
Real values only (floating points)Adjust1

Operator Override2

Release Operator Overrride2

All values but True/FalseChange Units

Change Name

Real values only (floating points)Change Display Precision

Two state or multistate valuesState0...StateN1

True/False onlyTrue1

True/False onlyFalse1

1 Adjust Allowedmust be True.
2 Override Allowed must be True.

Back to Generic Integration Commands.
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Global Data Sharing Object
The Global Data Sharing object provides a means for distributing information about changes in a single attribute
value to other attribute reference points. This minimizes hardware costs and system complexity. For example, an
NAE might have multiple Air Handling Units (AHUs) on its network, but only one has an outdoor air sensor. The
Global Data Sharing object can share the value from the single sensor with the other AHUs.

The data types defined for the Global Data Sharing object’s input and corresponding outputs should match. Otherwise,
each output attempts to convert the value being received to the data type defined for it. The software does not check
for data type consistency. Global data sharing is restricted to within one site.

For general information on Metasys system objects, see Common Object Attributes.

Global Data Sharing Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 260: Global Data Sharing Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NoneCNWAttribute referenceAlternate Master

NormalCWOne state from a
set

Execution Priority

CWReal valueFail Soft

NoneCWAttribute referenceMaster

n = 4

0 = Master, 1 = Alt Master, 2 = Last Reliable,
3 = Fail Soft

MasterCOne state from a
set

Present Value

16 (lowest priority) to 7 (highest priority)15CWNumberPriority for Writing

Default value is 0. No range check done.2 minCWNumberRefresh Timer

Reliable, Input UnreliableOne state from a
set

Reliability

n = 2

0 = Master, 1 = Alt Master

Last ReliableCOne value from a
set

Setup

Minimum number of entries = 0NoneCNWList of attribute
references

Slaves List

1 C - Configurable, N - Value Not Required, W - Writable

Global Data Sharing Attribute Details
Alternate Master
Defines an alternate to the Master. When the Master becomes unreliable, this attribute becomes the master attribute.

Back to Global Data Sharing Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Global Data Sharing Attributes.
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Fail Soft
Routes to all the outputs if Setup is configured as Fail Soft. Fail Soft routes when the object becomes unreliable
and when the output transitions from Reliable to Unreliable. This attribute is initialized to a specific value.

Back to Global Data Sharing Attributes.

Master
Contains an attribute reference. The value associated with this attribute is written to each of the designated slave
destinations.

Back to Global Data Sharing Attributes.

Present Value
Stores data about the value shared with the slaves.

Back to Global Data Sharing Attributes.

Priority for Writing
Defines the priority at which the referenced attributes are commanded. Seven is the highest priority and 16 is the
lowest supported by the Global Data Sharing object, with the default of 15.
Note: We do not recommend using priorities 7 or 8 as they may interfere with the operator override function.

Refresh Timer
Indicates the amount of time, in minutes, between updates to the slaves from the Master or Alternate Master.
Updates initiated by the refresh timer occur in addition to updates initiated by a COV from the Master/Alt Master.

For example, if the Refresh Timer attribute’s value is 2, the Global Data Sharing object updates the slaves with
information from the Master/Alt Master every 2 minutes and with each COV.

If this attribute is set to zero instead, updates are only sent upon receipt of additional COV reports.

Back to Global Data Sharing Attributes.

Reliability
Indicates whether a value is questionable. This attribute value equals Input Unreliable only if both the configured
Master and Alternate Master inputs are unreliable.

Back to Global Data Sharing Attributes.

Setup
Defines whether the Fail Soft or Last Reliable value needs to be the output if the object becomes unreliable.

Back to Global Data Sharing Attributes.

Slaves List
Contains a list of attribute references. Each slave identified in this list of attribute references receives its value from
the Master.

Back to Global Data Sharing Attributes.

Global Data Sharing Commands
The table below lists the commands supported by the Global Data Sharing Object.

Table 261: Global Data Sharing Object Commands
ParametersCommand Name

Disable

Enable

Global Data Sharing Command Details
Disable
Prevents the object from responding to any change in the Master, including reliability changes.
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Back to Global Data Sharing Commands.

Enable
Updates the Slaves List with COVs. Immediately after receiving this command, the Master referenced value is
routed to each of the output references.

Back to Global Data Sharing Commands.
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Group Object
The Group object’s attributes represent a collection of other objects and one or more of their attributes. This object
provides the user with the ability to customize the organization of objects within the site. The Group object simplifies
the exchange of information between objects by calling all members of the group at once. A group consists of any
combination of object types. For example, you can use the Group object to monitor the temperature in different
rooms throughout a floor of a building.

For general information on Metasys system objects, see Common Object Attributes.

For detailed information on the Group object, see Group Attributes.

For more information on the wizard used to create the Group object, see Insert Object - Group.

Group Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 262: Group Object Attributes - Group Tab
Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

WCWSet of typesList of Group
Members

Set of valuesPresent Value

1 C - Configurable, W - Writable

Group Attribute Details
List of Group Members
Contains the references (Input References) that define the members of the group. These group members are
referenced during a transaction. The List of Group Members consists of two parts:

• Object Identifier (Object ID)
• List of Property References

All members of the group are objects that reside in the same device that maintains the Group object. Nesting is not
allowed.

Back to Group Attributes.

Present Value
Lists the values of all the attributes specified in the List of Group Members. This is a read-only attribute; it cannot
be used to write a set of values to the members of the group. The Present Value list reconstructs each time the
attribute is read by fetching the member attributes.

Back to Group Attributes.
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Graphic Object
The Graphics object defines the attributes that represent a defined user graphic for a given set of objects. Graphic
objects must exist under a container object or under another Graphic object (this allows you to link graphics together).

For detailed information on the User Graphics Tool, see User Graphics Tool (UGT).

Graphic Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 263: Graphic Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

WSet of related valuesFile Name

1 W - Writable

Graphics Attribute Details
File Name
Specifies an XML file containing a UI tree.

Table 264: File Name Elements
Initial ValueData TypeElement Name
False (0)True or False valueExportable

List of referencesObject Reference

False (0)True or False valueReferences

TextRelative Path

Back to Graphic Attributes.

Relative Path
The name of the file relative to the directory containing the .moi file for the device.

Back to File Name.

Back to Graphic Attributes.
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IEIEJ BACnet System Objects
IEIEJ BACnet System Objects comply to the Institute of Electrical Installation Engineers of Japan (IEIEJ) Standard
Protocol based on BACnet specifications. Use these objects to comply with these guidelines.

For more information on IEIEJ BACnet System Objects, click one of the following:

• Electric Demand Monitoring Object
• Electric Demand Control Object
• Generator Load Control Object

IEIEJ BACnet System Object Descriptions
Electric Demand Monitoring Object
The Electric Demand Monitoring Object is a specialized object that monitors the power consumption in a fixed
30-minute window. This object uses an accumulator or analog input and calculates the demand every minute. The
object calculates a projected demand for the end of the 30-minute window, and compares that demand value to the
target demand. If the projected demand value exceeds the target demand value, the object triggers an alarm
notification. A graph of the demand values is the default view of the object.

Back to IEIEJ BACnet System Object Descriptions.

Electric Demand Control Object
The Electric Demand Control Object interacts with the Electric Demand Monitoring Object to control electrical loads
so the actual demand stays below the target demand. The present value is a value (1–16) that indicates the level
of shed activity needed to stay within the target demand. External logic must be used to interpret this value and
switch on/off loads.

Back to IEIEJ BACnet System Object Descriptions.

Generator Load Control Object
This object is similar to the Electric Demand Control Object but specifically controls the loads on a backup generator.
A given generator can supply a fixed maximum amount of power. A reference to the current load on the generator
and the value of the maximum generator output are configured in the object. This present value is a value (1–16)
that indicates the level of shed activity needed so the demand does not exceed the maximum power output of the
generator. External logic must be used to interpret this value and switch on/off loads.

Back to IEIEJ BACnet System Object Descriptions.
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Interlock Object
The Interlock object provides a means to establish conditional control over one or more other objects. It consists of
an IF conditional statement, True command statements, and False command statements. Through these statements,
the user specifies a set of conditional checks (using one or more points) for which a series of commands is used to
control a collection of one or more other objects.

Three essential parameters of the IF conditional statement, shown in the following list, determine the Interlock object’s
mode of operation:

• list of attribute references
• constants
• operators

This object allows a user to place a VAV controller in the occupied mode whenever the main fan is on and in the
occupied mode.

For general information on Metasys system objects, see Common Object Attributes.

For information on the logic used in the interlock object, see the Logic attribute description.

For more information on the wizard used to insert Interlock objects, see Insert Object - Interlock.

Interlock Configuration
Configure the attributes of the Focus/Configuration, Interlock Definition, and Action Tables tabs of the Interlock
object. See the Interlock Attributes section for descriptions of the attributes on these tabs.

On the Focus/Configuration tab, click the Advanced radio button to view and edit all the attributes available on
this tab.

On the Interlock Definition tab, define the items/objects to control and the desired conditional logic. Tips for this
tab include:

• Click the Add button to add items to the list from the Select Item dialog box.
• Click the check box next to an item in the list and click Delete to remove the item from the list.
• Select the type of logic to use for the items in the list from the Logic menu. See the Logic attribute description

for the types of logic.

On the Action Tables tab, define the commands and the priority for the items/objects under control. Tips for this
tab include:

• Check the All Commands Priority check box if you wish to use the same priority for all commands in the action
tables. Clear the All Commands Priority check box to enable individual priority selection for the commands in
the action tables.

• For theActions for Condition: True andActions for Condition: False tables, click the Add button to add items
to the table from the Select Item dialog box.

• For the Actions for Condition: True and Actions for Condition: False sections, click the check box next to
an item in the table and click Delete if you want to remove the item from the table.

Interlock Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 265: Interlock Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

FalseTrue or FalseExecuting

CWOne state from a
set

Execution Priority

NDateLast Executed Date

NTimeLast Executed Time

DRWOne state from a
set

Present Value

Set of valuesPriority Array

Uses Reliability (Set 503).One state from a
set

Reliability

Operator OverrideCWSeries of True or
False states

Restore Command
Priority

True or FalseSend OK

States Text defaults to False/True, but you can
use any two state set.

CWOne state from a
set

States Text

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable

Table 266: Interlock Object Attributes - Interlock Definition Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Match All (AND)

Match Any (OR)

Complex

0CWOne state from a
set

Logic

Maximum 56 charactersCWTextLogic Equation

Item/Object Name

Attribute

Relation (Equal, Not Equal, Greater Than, Less
Than, Greater Or Equal, Less Or Equal)

Value

Differential (required and only used when the value
is analog)

CWList of value setsSource

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable

489Metasys System Online Help PDF



Table 267: Interlock Object Attributes - Action Tables Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Item/Object Name

Command

Priority

Delay (0–65,535 seconds)

Parameters (vary according to command)

CWList of Command
References

Action Tbl 1 (True)

Item/Object Name

Command

Priority

Delay (0–65,535 seconds)

Parameters (vary according to command)

CWList of Command
References

Action Tbl 2 (False)

Uses Write Priority (Set 1).16CWOne state from a
set

Commands Priority

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable

Interlock Attribute Details
Action Tbl 1 (True)
Lists commands issued by this object when the condition is true:

• Item - The name of the object to be commanded.
• Command - The type of command to send to the object.
• Priority - The priority at which to send the command.
• Delay - The amount of time, in seconds, each command waits to be sent, after a change in condition.
• Parameters - These vary according to command.

Any object capable of accepting commands can be defined in either action table. The available commands depend
on the type of object and the user’s access capability. An object may be sent more than one command by identifying
the object more than once and specifying a different command. The user does not have to specify objects for both
the True and False Action Tables. If no command is specified for an object, no command is sent.

Back to Interlock Attributes.

Action Tbl 2 (False)
Lists commands issued by this object when the condition is false:

• Item - The name of the object to be commanded
• Command - The type of command to send to the object
• Priority - The priority at which to send the command
• Delay - The amount of time, in seconds, each command waits to be sent, after a change in condition
• Parameters - These vary according to command.

Any object capable of accepting commands can be defined in either action table. The available commands depend
on the type of object and the user’s access capability. An object may be sent more than one command by identifying
the object more than once and specifying a different command. The user does not have to specify objects for both
the True and False Action Tables. If no command is specified for an object, no command is sent.

Back to Interlock Attributes.
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Commands Priority
Determines the order by importance for all commands sent. If the All Commands Priority option is not selected, the
commands are sent at each individual priority specified in the Action Tbl attribute. If the All Commands Priority option
is selected, then every item in the Action Table is sent a command at the priority specified. For example, if the
command chosen is Operator Override, the command priority automatically sets to Operator Override (8) for every
item listed in the Action Table. When the All Commands Priority option is selected, you cannot change the command
priority within the Action Table.

An object defined in the Action Tables must use commands greater than Priority 16 (default) if no Relinquish Default
attribute is defined for that object. Otherwise, commands sent at Priority 16 to objects without a Relinquish Default
will not be accepted by that object. Commands with a lower priority number are of higher priority (importance) or are
more critical than commands with a higher priority number. For example, Manual Life Safety (1) is of higher priority
than Scheduling (15).

If the Commands Priority is defined as 16 (Default), then any existing commands from Scheduling (15) through
Priority 9 (9) will be released when the command is sent.

The Commands Priority uses the priorities in the Write Priority (Set 1).

Back to Interlock Attributes.

Executing
Specifies the current execution status of the object. It is True when the object receives a state command and starts
sending commands. When all actions are completed for a given state, this flag is set to False.

Back to Interlock Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Interlock Attributes.

Last Executed Date
Indicates the date stamp for the beginning of executing the current state.

Back to Interlock Attributes.

Last Executed Time
Indicates the time stamp for the beginning of executing the current state.

Back to Interlock Attributes.

Logic
Specifies the Boolean logic (And/Or) to be employed in combination with source inputs in deriving a True or False
outcome.

When the source input operator is unreliable, the interlock operates according to the following rules:

• Complex - Uses the equation defined by the Logic Equation attribute. If any input is unreliable, the expression
cannot be evaluated; therefore, the interlock is unreliable and does not execute.

• Match All (AND) - Every one of the source conditions must be True. If an input is reliable, it is evaluated. If the
result is False, the interlock evaluates to False and executes. All inputs are checked for trouble (Reliability !=
Reliable). If any input is not reliable, the expression cannot be evaluated; therefore, the interlock is unreliable
and does not execute.

• Match Any (OR) - One or more of the source conditions must be True. If an input is reliable, it is evaluated. If
the result is True, the interlock evaluates to True and executes. All inputs are checked for trouble (Reliability !=
Reliable). If no inputs are reliable, the expression cannot be evaluated; therefore, the interlock is unreliable and
does not execute.

Back to Interlock Attributes.

491Metasys System Online Help PDF



Logic Equation
Contains a logic equation when the Logic attribute is set to Complex.

Use the logic equation to define the relationship between the master conditions using logic operators and parentheses
for determining precedence.

Valid characters in the Logic Equation string are:

* AND operator

+ OR operator

( Open parenthesis (for grouping)

) Closed parenthesis (for grouping)

numbers Master condition numbers

spaces Spaces are allowed for readability

Equation Syntax:

• Open and close parenthesis must match.
• Empty parenthesis are not allowed ().
• The equation must be at least 3 characters in length, not including spaces.
• The numbers must not exceed the master condition numbers.
• There is no implied precedence for the operators (*,+).
• Any combination of different operators must be grouped with parenthesis to determine precedence.
• Operators of the same type do not require the use of parenthesis.
• A grouping may contain only one operator type.
• Numbers or groupings must be separated by an operator (*,+).
• Groups can be nested.

Table 268: Examples
CorrectIncorrect
1+2+(3*4) or (1+2+3)*41+2+3*4

(1*2)+(3*4) or 1*(2+3)*41*2+3*4

1*((2*3)+4) or (1*2)*(3+4) or (1*2*3)+41*2*3+4

((1+2)*(3+4))+(6*7) or (1+2)*((3+4)+(6*7))(1+2)*(3+4)+(6*7)

(3*4)*(1*2)(3*4)(1*2)

(3*1)(3*+1)

(3*1)(3*

Sample Logic Equation:

((1+2)*(3+4))+(6*7)

Where the equation says that master condition ((1 OR 2) AND (3 OR 4)) OR (6 AND 7) results in a TRUE (Action
Tbl 1) execution.

Objects are given numbers in the left column that correspond to the order you add them to the Interlock Definition
list (the first added is 1, the second added is 2, and so on). Use these numbers to represent the corresponding
objects in the Logic Equation.

Back to Interlock Attributes.
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Present Value
Represents the current value of the object. Present Value is set based on the relationships set up in the Interlock
definition.

Back to Interlock Attributes.

Priority Array
Lists values of the object in level of importance.

Back to Interlock Attributes.

Reliability
Indicates if the Present Value is questionable.

Back to Interlock Attributes.

Restore Command Priority
Selects which commands (at a selected priority) persist through a device restart. When the bit is set, the command
(at a selected priority) is saved at shutdown and restored at startup.

Back to Interlock Attributes.

Send OK
Indicates the success or failure of the slave commands. If any slave commands failed, this attribute is set to False.
When a send error is detected, a five minute timer is set. When the timer expires, the interlock is reevaluated and
all commands are sent again. Commands may fail if the slave object is off-box and offline or if the slave object is
set for local control.

Back to Interlock Attributes.

Source
Lists objects whose attributes are used for input into the logic expression to decide if the condition is True or False.
Information needed:

• Item - Name of the source object
• Attribute - Varies according to object. Default = Present Value
• Relation - Equal, Not Equal, Greater Than, Less Than, Greater Than or Equal, Less Than or Equal
• Value - The value used in the Relation. Varies according to the object.
• Differential - Accounts for variations in the value. Required (and only used) if the value is analog.

Back to Interlock Attributes.

States Text
Indicates the displayed strings for the Present Value.

Interlock Commands
The table below lists the commands supported by the Interlock Object.

Table 269: Interlock Commands
ParametersCommand Name

Disable

Enable

The value to be written to the Present Value attribute. This parameter has a
True or False data type.

Operator Override

Release Operator Override

Re-Command
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Table 269: Interlock Commands
ParametersCommand Name
Attribute name

Command priority

Release

Attribute nameRelease All

Interlock Command Details
Disable
Locks out all outputs and prevents the Interlock functionality.

Back to Interlock Commands.

Enable
Ensures object reacts to any changes it may have missed while it was disabled, and returns it to normal operation.

Back to Interlock Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override.

Important: The Operator Override command sends the specified command to the internal NxE object, which is
then only sent to the field device when one of the following conditions is met: a) NOT Local Control
and NOT Out Of Service, or b) NOT Local Control and after issuing the In Service command.

Back to Interlock Commands.

Release Operator Override
Releases Command Priority Operator Override from Present Value.

Back to Interlock Commands.

Re-Command
Reissues the commands for the current state.

Back to Interlock Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Interlock Commands.
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Release All
Releases Command Priorities 3 through 16 from the specified, writable attribute. Command Priorities1 and 2 remain.

Note: The Release All command may not cause an immediate return to automatic operation. The Release All
command clears all command priorities, including those that come from applications and features. When this
happens, the output point goes to its Relinquish Default condition. In some cases, the application or feature
may have sent a command that does not match Relinquish Default. In this instance, the output point does
not end in the state that the applications or features intended. This situation can cause unexpected operation
to occur; for example, a space could overcool or overheat, a fan might run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to Interlock Commands.
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Life Safety Point Object
The Life Safety Point object’s attributes represent the state of smoke detectors, fire detectors, security alarms, and
similar devices. As a Life Safety Point, the state of this object can be one of 24 states.

The Life Safety Point object is a standardized object that represents a BACnet Safety Point Object as defined in the
2008 BACnet specification.

Life Safety Point Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 270: Life Safety Point Object Attributes - Focus/Configuration Tab
Values/Options/RangeBACnet

Notes1
Data TypeAttribute Name

Uses BAC LifSfty Mode (BACnet Lifesafety Mode) (Set 189).QList ofAccepted Modes

Units = Redirected to Units attributeOFloatDirect Reading

Uses BAC Event State (Set 5).One state from a setEvent State

Uses BAC LifSfty Mode (BACnet Lifesafety Mode) (Set 189).WQOne value from a setLife Safety Mode

Uses BAC LifSfty Maint (BACnet Lifesafety Maintained) (Set
187).

OOne value from a setMaintenance
Required

Uses BAC LifSfty Oper (Set 190).QOne value from a setOperation Expected

BCWTrue or FalseOut of Service

Uses BAC LifSfty State (BACnet Lifesafety State) (Set 186).WDRQOne value from a setPresent Value

Uses Reliability (Set 503)BWOne state from a setReliability

Units = No UnitOByteSetting

Uses BAC LifSfty SilState (BACnet Life Safety Silent State) (Set
188).

QOne value from a setSilenced

Uses BAC LifSfty State (BACnet Lifesafety State) (Set 186).OOne value from a setTracking Value

Uses Unit Set (Set 869)OOne value from a setUnits

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O -
BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable

Table 271: Life Safety Point Object Attributes - Member Tab
Values/Options/RangeBACnet

Notes1
Data TypeAttribute Name

OList ofUnits

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O -
BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable

Life Safety Point Attribute Details
Accepted Modes
Specifies all the values the Life Safety Mode attribute accepts when written.

Back to Life Safety Point Attributes.
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Direct Reading
Indicates an analog quantity that reflects the measured or calculated reading from an initiating device.

Back to Life Safety Point Attributes.

Event State
Indicates if an active event state is associated with the object. If the object supports intrinsic reporting, this attribute
indicates the event state of the object. If not, the attribute is Normal.

Back to Life Safety Point Attributes.

Life Safety Mode
Specifies the operating mode of the Life Safety Point object. The Life Safety Point object generates
Change-of-Life-Safety event notifications for any mode transition if the flags in the Event Enable attribute are set.

Back to Life Safety Point Attributes.

Maintenance Required
Indicates that maintenance is required for the life safety point. This may indicate periodic maintenance or
parameter-determined maintenance, such as a dirtiness value for an associated detector.

Back to Life Safety Point Attributes.

Member Of
Indicates the Life Safety Zone objects of which this Life Safety Point is considered to be a zone member. Each object
in the Member Of list is a Life Safety Zone object.

Back to Life Safety Point Attributes.

Operation Expected
Specifies the next operation expected by this object to handle a specific life safety situation.

Back to Life Safety Point Attributes.

Out of Service
Indicates (when True) that the Present Value and Reliability attributes are decoupled from the physical input to the
object and their values may be changed for simulation or testing purposes. Functions that depend on the values of
the Present Value or Reliability attributes continue to respond to changes while Out of Service is True, as if those
changes had come form the physical input.

Additionally, the Out of Service state of the Status Flags attribute is set to True and the Fault state is decoupled from
the physical input when Out of Service is True.

Back to Life Safety Point Attributes.

Present Value
Indicates the current value of the Life Safety Point object in the defined Units. When Out of Service is True, this
attribute is writable.

Back to Life Safety Point Attributes.

Reliability
Indicates whether the Present Value is unreliable. When Out of Service is True, the Reliability attribute may be
written directly.

Back to Life Safety Point Attributes.

Setting
Specifies the next operation expected by this object to handle a specific life safety situation.

Back to Life Safety Point Attributes.
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Silenced
Indicates whether the most recently occurring transition for this object produced an audible or visual indication that
has been silenced by the recipient of a Life Safety Operation service request or a local process.

Back to Life Safety Point Attributes.

Tracking Value
Reflects the non-latched state of the Life Safety Point object. This attribute continuously tracks changes in the latched
state of the object.

Back to Life Safety Point Attributes.

Units
Indicates the units of the quantity represented by Direct Reading.

Back to Life Safety Point Attributes.

Life Safety Point Commands
The table below lists the commands supported by the Life Safety Point Object.

Table 272: Life Safety Point Commands
Number of ParametersCommand Name

In Service

The value to be written to the Present Value.Out of Service

Life Safety Point Command Details
In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. Present Value
and Reliability revert back to the values obtained from the physical input.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Life Safety Point Commands.

Out of Service
Allows a user to override the object’s hardware input for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True, writes the Present Value to the value of the command parameter, and
writes the Reliability attribute to Reliable. Present Value and Reliability no longer track the physical input.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Life Safety Point Commands.
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Life Safety Zone Object
The Life Safety Zone object represents a grouping of Life Safety Points. The Life Safety Zone can also represent a
grouping of Life Safety Zones.

The Life Safety Zone object is a standardized object that represents a BACnet Safety Zone Object as defined in the
2008 BACnet specification.

Life Safety Zone Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 273: Life Safety Zone Object Attributes - Focus/Configuration Tab
Values/Options/RangeBACnet

Notes1
Data TypeAttribute Name

Uses BAC LifSfty Mode (BACnet Lifesafety Mode) (Set 189).QOne value from a listAccepted Modes

Uses BAC Event State (Set 5).BOne state from a setEvent State

Uses BAC LifSfty Mode (BACnet Lifesafety Mode) (Set 189).WQOne value from a setLife Safety Mode

Uses BAC LifSfty Maint (BACnet Lifesafety Maintained) (Set
187).

OBooleanMaintenance Required

Uses BAC LifSfty Oper (Set 190).QOne value from a setOperation Expected

BCWTrue or FalseOut of Service

Uses BAC LifSfty State (BACnet Lifesafety State) (Set 186).WDRQOne value from a setPresent Value

Uses Reliability (Set 503)BWOne state from a setReliability

Uses BAC LifSfty SilState (BACnet Life Safety Silent State)
(Set 188).

One value from a setSilenced

Uses BAC LifSfty State (BACnet Lifesafety State) (Set 186).OOne value from a setTracking Value

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O -
BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable

Table 274: Life Safety Zone Object Attributes - Members Tab
Values/Options/RangeBACnet

Notes1
Data TypeAttribute Name

OList ofMember Of

QList ofZone Members

1 B - Exposed as Standard BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O -
BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable

Life Safety Zone Attribute Details
Accepted Modes
Specifies all the values the Life Safety Mode property accepts when written.

Back to Life Safety Zone Attributes.

Event State
Indicates if an active event state associated with the object. If the object supports intrinsic reporting, this attribute
indicates the event state of the object. If not, the attribute is Normal.
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Back to Life Safety Zone Attributes.

Life Safety Mode
Specifies the operating mode of the Life Safety Zone object. The Life Safety Zone object generates
Change-of-Life-Safety event notifications for any mode transition if the flags in the Event Enable attribute are set.

Back to Life Safety Zone Attributes.

Maintenance Required
Indicates that maintenance is required for one or more of the life safety points that are members of this zone.

Back to Life Safety Zone Attributes.

Member Of
Indicates the Life Safety Zone objects of which this Life Safety Point is considered to be a zone member. Each object
in the Member Of list is a Life Safety Zone object.

Back to Life Safety Zone Attributes.

Operation Expected
Specifies the next operation expected by this object to handle a specific life safety situation.

Back to Life Safety Zone Attributes.

Out of Service
Indicates (when True) that the Present Value and Reliability attributes are decoupled from the physical input to the
object and their values may be changed for simulation or testing purposes. Functions that depend on the values of
the Present Value or Reliability attributes continue to respond to changes while Out of Service is True, as if those
changes had come form the physical input.

Additionally, the Out of Service state of the Status Flags attribute is set to True and the Fault state is decoupled from
the physical input when Out of Service is True.

Back to Life Safety Zone Attributes.

Present Value
Indicates the current value of the Life Safety Zone object. When Out of Service is True, this attribute is writable.

Back to Life Safety Zone Attributes.

Reliability
Indicates whether the Present Value is unreliable.

When Out of Service is True, the Reliability attribute may be written directly.

Back to Life Safety Zone Attributes.

Silenced
Indicates whether the most recently occurring transition for this object produced an audible or visual indication that
has been silenced by the recipient of a Life Safety Operation service request or a local process.

Back to Life Safety Zone Attributes.

Tracking Value
Reflects the non-latched state of the Life Safety Zone object. This attribute continuously tracks changes in the latched
state of the object.

Back to Life Safety Zone Attributes.

Zone Members
Indicates which Life Safety Point and Life Safety Zone objects are members of the zone represented by this object.

Back to Life Safety Zone Attributes.
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Life Safety Zone Commands
The table below lists the commands supported by the Life Safety Zone Object.

Table 275: Binary Input Commands
Number of ParametersCommand Name

In Service

The value to be written to the Operation ExpectedOut of Service

Life Safety Zone Command Details
In Service
Cancels the affect of an Out of Service command and returns the Out of Service attribute to False. Operation
Expected and Reliability revert to the values obtained from the physical input.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Life Safety Zone Commands.

Out of Service
Allows a user to override the object’s hardware input for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True, writes the Present Value to the value of the command parameter and
writes the Reliability attribute to Reliable. Present Value and Reliability no longer track the physical input.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Life Safety Zone Commands.
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LON Controller Object
The LON Controller object defines attributes that represent the external, visible characteristics of a device residing
on a LONWORKS network.

For general information on Metasys system objects, see the Object Help section.

LON Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 276: LON Controller Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseEnabled

CWObject referenceGraphic

Maximum 256 charactersCWTextGraphic Alias

FalseTrue or FalseOffline

Number of Elements = 4

Uses Controller Status (Set 43).

OfflineOne value from a
set

Present Value

True or FalseXIF Present

1 C - Configurable, W - Writable

Table 277: LON Controller Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberCommand Count

LON_DEV_ERROR_LOGNOERROROne value from a
set

Error Log

0NumberLost Messages

NumberMissed Messages

LON Model NumberNeuron_3150One value from a
set

Neuron Model

Number of Elements = 7

Type = Value Given

Uses Node State (Set 583).

One value from a
set

Node State

0NumberOffline Poll Count

0NumberReceive Transaction
Full

Size = 5

Type = Value Given

Uses Neuron Reset Cause (Set 182).

ClearOne value from a
set

Reset Cause

DateReset Date

TimeReset Time

0NumberTotal Messages To
Device
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Table 277: LON Controller Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberTotal Single Message
Failures

0NumberTransaction Timeouts

0NumberTransmit Errors

0NumberVersion Number

1 C - Configurable, W - Writable

LON Controller Attribute Details
Command Count
Displays the total number of commands sent to this controller.

Back to LON Controller Attributes.

Enabled
If True, allows integration between the Metasys system extended architecture and the LON controller.

Back to LON Controller Attributes.

Error Log
Shows the error log according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Graphic
Indicates the graphic associated with the object.

Back to LON Controller Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to LON Controller Attributes.

Lost Messages
Shows the number messages lost according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Missed Messages
Shows the number messages missed according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Neuron Model
Shows the Neuron model according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Node State
Shows the state of the node according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Offline
Displays the offline or online status of connected hardware. The LONWORKS network server updates this attribute
value.

Back to LON Controller Attributes.
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Offline Poll Count
Displays the total number of times this controller was sent a poll while offline.

Back to LON Controller Attributes.

Present Value
Displays the communication status of the object.

Back to LON Controller Attributes.

Receive Transaction Full
Shows the number of times the transaction full message appeared in the last standard LONWORKS network Query
Status message.

Back to LON Controller Attributes.

Reset Cause
Shows the cause of the last reset according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Reset Date
Contains the date stamp of the last local Neuron statistics reset command.

Back to LON Controller Attributes.

Reset Time
Contains the time stamp of the last local Neuron statistics reset command.

Back to LON Controller Attributes.

Total Messages To Device
Displays the total number of messages sent to this controller.

Back to LON Controller Attributes.

Total Single Message Failures
Displays the total number of failures for single messages sent to this controller.

Back to LON Controller Attributes.

Transaction Timeouts
Shows the timeouts that appeared in the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Transmit Errors
Shows the number of transmit errors that appeared in the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

Version Number
Shows the version number according to the last standard LONWORKS network Query Status message.

Back to LON Controller Attributes.

XIF Present
Indicates whether a External Interface (XIF) file matching this controller’s Program ID was found.

Back to LON Controller Attributes.

LON Controller Commands
The table below lists the commands supported by the LON Controller Object.
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Table 278: LON Controller Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics

LON Controller Command Details
Clear Statistics
Resets the statistics for the integrated LONWORKS network. The contents of the Query Status message reflect these
statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Messages
• Missed Messages
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model

For information on gathering this statistical information, see the Latch Statistics command.

Back to LON Controller Commands.

Disable
Disables the entire LONWORKS network integration. No requests are made to the field trunk and no data broadcasts
to the network are processed.

Back to LON Controller Commands.

Enable
Allows the integration to function normally.

Back to LON Controller Commands.

Latch Statistics
Updates the displayed statistics with the current values. The following attributes reflect the statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Messages
• Missed Messages
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model

For information on clearing this statistical information, see the Clear Statistics command.
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Back to LON Controller Commands.
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LON Integration Object
The LON Integration object defines LONWORKS network integration for the NAE. The object contains pertinent attributes
and holds a list of LONWORKS network-related configuration resource files.

For general information on Microsoft system objects, see the Object Help section.

LON Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 279: LON Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberBind Retry Count

NumberCount

0NumberDevice Offline Polling
Cycle Time

0NumberDevice Online Polling
Cycle Time

NOERROROne value from a setError Log

DateLON Integration DLL
Date

0NumberLON Integration DLL
Size

TimeLON Integration DLL
Time

0NumberLost Messages

0NumberMissed Messages

LON Model NumberNeuron_3150One state from a setNeuron Model

Size = 7

Type = Value Given

Uses Node State (Set 583).

One state from a setNode State

0True or FalseOffline

0NumberPermanent Status Item
Count

SecondsNumberPoint Scan Time

0NumberPriority 1 Poll Items

0NumberPriority 2 Poll Items

0NumberPriority 3 Poll Items

0NumberPriority 1 Poll Time

0NumberPriority 2 Poll Time

0NumberPriority 3 Poll Time
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Table 279: LON Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberReceive Transaction
Full

Size = 5

Type = Value Given

Uses Neuron Reset Cause (Set 182).

ClearOne cause from a
set

Reset Cause

DateReset Date

TimeReset Time

0NumberStatus Cache Hits

0NumberStatus Cache Misses

0NumberTemporary Status Item
Count

0NumberTransaction Timeouts

0NumberTransmit Errors

0NumberTransmits Per Minute

0NumberVersion Number

True or FalseXIF Present

1 C - Configurable, W - Writable

LON Integration Attribute Details
Bind Retry Count
Indicates the number of objects for which the LON Integration code is still verifying with the field controller that it has
the correct type information.

Back to LON Integration Attributes.

Count
Displays the number of LONWORKS network point object defined for the trunk.

Back to LON Integration Attributes.

Device Offline Polling Cycle Time
Indicates how often all offline devices are polled.

Back to LON Integration Attributes.

Device Online Polling Cycle Time
Indicates how often all online devices are polled.

Back to LON Integration Attributes.

Error Log
Shows the error log according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

LON Integration DLL Date
Displays the current date stamp on the LonIntegration.DLL.

Back to LON Integration Attributes.

LON Integration DLL Size
Displays the current size of the LonIntegration.DLL.

Back to LON Integration Attributes.
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LON Integration DLL Time
Displays the current time stamp on the LonIntegration.DLL.

Back to LON Integration Attributes.

Lost Messages
Shows the number messages lost according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Missed Messages
Shows the number messages missed according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Neuron Model
Shows the Neuron model according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Node State
Shows the state of the node according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Offline
Displays the offline or online status of connected hardware. The LONWORKS network server updates this attribute
value.

Back to LON Integration Attributes.

Permanent Status Item Count
Displays the number of items polled as a result of COV signups.

Back to LON Integration Attributes.

Point Scan Time
Displays the calculated number of seconds the server takes to read all defined points.

Back to LON Integration Attributes.

Priority 1 Poll Items
Displays the number of items in the Priority 1 list.

Back to LON Integration Attributes.

Priority 2 Poll Items
Displays the number of items in the Priority 2 list.

Back to LON Integration Attributes.

Priority 3 Poll Items
Displays the number of items in the Priority 3 list.

Back to LON Integration Attributes.

Priority 1 Poll Time
Indicates how often the items in the Priority 1 list are polled.

Back to LON Integration Attributes.

Priority 2 Poll Time
Indicates how often the items in the Priority 2 list are polled.

Back to LON Integration Attributes.
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Priority 3 Poll Time
Indicates how often the items in the Priority 3 list are polled.

Back to LON Integration Attributes.

Receive Transaction Full
Shows the number of times the transaction full message appeared in the last standard LONWORKS network Query
Status message.

Back to LON Integration Attributes.

Reset Cause
Shows the cause of the lasts reset according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Reset Date
Contains the date stamp of the last local Neuron statistics reset command.

Back to LON Integration Attributes.

Reset Time
Contains the time stamp of the last local Neuron statistics reset command.

Back to LON Integration Attributes.

Status
Indicates the status of the object, where Normal means the LON integration is working normally.

Back to LON Integration Attributes.

Status Cache Hits
Displays the number of READATTRIBUTE calls that occurred while the object was already being polled.

Back to LON Integration Attributes.

Status Cache Misses
Displays the number of READATTRIBUTE calls that occurred while the object was not being polled.

Back to LON Integration Attributes.

Temporary Status Item Count
Displays the number of items polled as a result of READATTRIBUTE calls.

Back to LON Integration Attributes.

Transaction Timeouts
Shows the timeouts that appeared in the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Transmit Errors
Shows the number of transmit errors that appeared in the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.

Transmits Per Minute
Displays the calculated number of transmissions per minute.

Back to LON Integration Attributes.

Version Number
Shows the version number according to the last standard LONWORKS network Query Status message.

Back to LON Integration Attributes.
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XIF Present
Indicates whether the XIF is present. The XIF is a resource file required for the NAE to understand a particular device
type. This attribute is not used in the SCT.

Back to LON Integration Attributes.

LON Integration Commands
The table below lists the commands supported by the LON Integration Object.

Table 280: LON Integration Object Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics

LON Integration Command Details
Clear Statistics
Resets the statistics for the integrated LONWORKS network. The contents of the Query Status message reflect these
statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Messages
• Missed Messages
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model

For information on gathering this statistical information, see the Latch Statistics command.

Back to LON Integration Commands.

Disable
Disables the entire LONWORKS network integration. No requests are made to the field trunk and no data broadcasts
to the network are processed.

Back to LON Integration Commands.

Enable
Allows the integration to function normally.

Back to LON Integration Commands.

Latch Statistics
Updates the displayed statistics with the current values. The following attributes reflect the statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Messages
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• Missed Messages
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model

For information on clearing this statistical information, see the Clear Statistics command.

Back to LON Integration Commands.
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Loop Object
The Loop object allows a third-party BACnet workstation to represent a control loop in a standard way. If you use
the Site Management or Ready Access Portals as the primary mechanisms to view system information, you do not
need to use the Loop object.

The Loop object represents the key information from a Proportional plus Integral plus Derivative (PID) logic module.
The object does not execute the PID algorithm but simply allows you to represent the key parameters of a PID logic
module in a Focus tab view.

The Loop object uses the data provided by mapped field points to execute the BACnet intrinsic alarming algorithm.
First, create a folder and map the field points representing the loop information. Then use the Insert Object Wizard
to add the Loop object to the same folder and configure references to the mapped points representing the loop
information. The Loop object reads the information indicated by the references, and presents the values received
in the Focus tab of the Loop object.

The behavior of the Loop object’s intrinsic alarming algorithm is as follows:

• The loop object generates a TO OFFNORMAL event when the difference between the Setpoint Value and the
Controlled Variable Value remain outside the band defined by the Error Limit and the Time Delay has been
exceeded.

• The loop object generates a TO NORMAL event when the difference between the Setpoint Value and the
Controlled Variable Value is within the band defined by the Error Limit.

Note: You must configure references to the BACnet required properties to successfully create the Loop object.
These references appear red in the wizard until configured. You may optionally configure references for the
BACnet optional properties. If you do not define the optional references for some reason, the Loop object
responds to a read for the corresponding value with an Unknown Property error. These BACnet required and
optional properties are noted with footnotes in the attribute table. See Loop Attributes.

For general information on Metasys system objects, see the Object Help section.

Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 281: Loop Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Direct

Reverse

DirectCWOne state from a setAction

Uses BACEventState set.One state from a setAlarm State

NumberBias

CNWObject referenceBias Reference2

Restricted to field mapper points.NumberControlled Var Value

CWObject referenceControlled Variable
Reference3

0.1Real ValueCOV Increment

NumberDerivative Constant

CNWObject referenceDerivative Constant
Reference2
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Table 281: Loop Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Uses Display Precision set.10thsCWOne value from setDisplay Precision

NumberIntegral Constant

CNWObject referenceIntegral Constant
Reference2

Restricted to field points.CWObject referenceManipulated Variable
Reference3

NumberMax Output

CNWObject referenceMaximum Output
Reference2

NumberMin Output

CNWObject referenceMinimum Output
Reference2

NumberPresent Value

Restricted to field points.CWObject referencePresent Value Reference

NumberProportional Const

CNWObject referenceProportional Constant
Reference2

Uses Reliability set.One state from a setReliability

NumberSetpoint

CWObject referenceSetpoint Variable
Reference3

Uses Units set.One type from a setUnits

Units = millisecondsNumberUpdate Interval

1 C - Configurable, N - Value Not Required, W - Writable
2 You may optionally configure a reference for this BACnet optional property. If you do not define the optional reference for some

reason, the Loop object responds to a read for the corresponding value with an Unknown Property error.
3 You must configure references to this BACnet required property to successfully create the Loop object. This reference appears

red in the wizard until configured.

Loop Attribute Details
Action
Indicates whether the loop is direct or reverse acting.

Back to Loop Attributes.

Alarm State
Indicates whether the object has an active alarm state associated with it. The intrinsic alarming algorithm determines
the Alarm State value.

Back to Loop Attributes.

Bias
Indicates the bias value used by the loop algorithm. If the Bias Reference does not contain a value, a read of the
Bias attribute returns an Unknown Property error.

Back to Loop Attributes.
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Bias Reference
Provides the object reference for the Bias attribute. The Loop object reads and signs up for changes in the Present
Value attribute of the object referenced by the Bias Reference. The value received is stored as the Bias.

Back to Loop Attributes.

Controlled Var Value
Reflects the Present Value of the field point mapper defined by the Controlled Variable Reference.

Back to Loop Attributes.

Controlled Variable Reference
Defines the field point mapper that represents the source of the input to the control loop.

Back to Loop Attributes.

COV Increment
Defines the minimum change in the Present Value required for the object to report a change.

Back to Loop Attributes.

Derivative Constant
Indicates the value of the derivative gain parameter used by the loop algorithm. If the Derivative Constant Reference
does not contain a value, a read of the Derivative Constant attribute returns an Unknown Property error.

Back to Loop Attributes.

Derivative Constant Reference
Provides the object reference for the Derivative Constant attribute. The Loop object reads and signs up for changes
in the Present Value attribute of the object referenced by the Derivative Constant Reference. The value received is
stored as the Derivative Constant.

Back to Loop Attributes.

Display Precision
Indicates the rounded position and the number of decimal places to display for this object.

Back to Loop Attributes.

Integral Constant
Indicates the value of the integral gain parameter used by the loop algorithm. If the Integral Constant Reference
does not contain a value, a read of the Integral Constant attribute returns an Unknown Property error.

Back to Loop Attributes.

Integral Constant Reference
Provides the object reference for the Integral Constant attribute. The Loop object reads and signs up for changes
in the Present Value attribute of the object referenced by the Integral Constant Reference. The value received is
stored as the Integral Constant.

Back to Loop Attributes.

Manipulated Variable Reference
Defines the field point mapper that represents the destination of the output of the control loop.

Back to Loop Attributes.

Max Output
Indicates the maximum value of the output (Present Value) as limited by the PID loop algorithm. This value is normally
used to prevent the algorithm from controlling beyond the range of the controlled device, and to prevent integral
term wind up. If the Maximum Output Reference does not contain a value, a read of the Max Output attribute returns
an Unknown Property error.

Back to Loop Attributes.
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Maximum Output Reference
Provides the object reference for the Max Output attribute. The Loop object reads and signs up for changes in the
Present Value attribute of the object referenced by the Maximum Output Reference. The value received is stored
as the Max Output.

Back to Loop Attributes.

Min Output
Indicates the minimum value of the output (Present Value) as limited by the PID loop algorithm. This value is normally
used to prevent the algorithm from controlling beyond the range of the controlled device, and to prevent integral
term wind up. If the Minimum Output Reference does not contain a value, a read of the Min Output attribute returns
an Unknown Property error.

Back to Loop Attributes.

Minimum Output Reference
Provides the object reference for the Min Output attribute. The Loop object reads and signs up for changes in the
Present Value attribute of the object referenced by the Minimum Output Reference. The value received is stored as
the Min Output.

Back to Loop Attributes.

Present Value
Indicates the current output value of the loop algorithm.

Back to Loop Attributes.

Present Value Reference
Provides the object reference for the Present Value attribute. The Loop object reads and signs up for changes in
the Present Value attribute of the object referenced by the Present Value Reference. The value received is stored
as the Present Value.

Back to Loop Attributes.

Proportional Const
Indicates the value of the proportional gain parameter used by the loop algorithm. If the Proportional Constant
Reference does not contain a value, a read of the Proportional Const attribute returns an Unknown Property error.

Back to Loop Attributes.

Proportional Constant Reference
Provides the object reference for the Proportional Const attribute. The Loop object reads and signs up for changes
in the Present Value attribute of the object referenced by the Proportional Constant Reference. The value received
is stored as the Proportional Const.

Back to Loop Attributes.

Reliability
Reflects the Reliability attribute of the object referenced by the Present Value Reference attribute, providing an
indication of whether the Present Value of the loop in question is reliable. This attribute may have a value of Reliable
or Open when the field point mapper’s Reliability is Reliable or Open. This attribute may have a value of Unreliable
when the field point mapper’s Reliability is a value other than Reliable or Open.

Back to Loop Attributes.

Setpoint
Reflects the Present Value of the field point mapper defined by the Setpoint Variable Reference.

Back to Loop Attributes.

Setpoint Variable Reference
Defines the field point mapper that represents the setpoint for the control loop.

Back to Loop Attributes.
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Units
Reflects the Units attribute of the object referenced by the Present Value Reference attribute.

Back to Loop Attributes.

Update Interval
Indicates the time period, in milliseconds, between updates to the Present Value attribute.

Back to Loop Attributes.

Loop Commands
The table below lists the commands supported by the Loop Object.

Table 282: Loop Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

Loop Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.
This command restores the previous Event Enable values.

Back to Loop Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.
This command sets the Event Enable values to False, False, False.

Back to Loop Commands.
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MS/TP Field Device Object
The MS/TP Field Device object is used to represent FEC family MS/TP devices on the MS/TP Field bus. The MS/TP
Field Device object appears as a child of an MS/TP Field Bus Integration object.

Note: The Object Type for this object is labeled FEC Family BACnet Device in the software.

MS/TP Field Device Concepts
Supported Controllers
The Field Device object supports these MS/TP controllers:

• VMA16s
• Input/Output Modules (IOMs)

• Field Equipment Controllers (FECs)

• FACs

MS/TP Field Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 283: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Units = Seconds15WNumberCOV Min Send Time

TrueCWTrue or FalseEnabled

False

True

FalseTrue or FalseEnd of Line

TextFirmware Version

TextFixed Boot Version

CWObject referenceGraphic

Maximum 256 charactersCWTextGraphic Alias

True or FalseIn Test

Uses JCI System Status (Set 25).One state/type/
mode from a set

JCI System Status

TextLocation

TextModel Name

True or FalseOffline

TextPcode

Uses Controller Status (Set 43).OnlineDOne state/type/
mode from a set

Present Value

Uses Object Type (Set 508).Series of True or
False values

Protocol Obj Supported

Uses Protocol Ser Support (Set 136).Series of True or
False states

Protocol Ser Supported

TextStartup Code Version
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Table 283: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberVendor ID

TextVendor Name

1 C - Configurable, D - Default Attribute for Display, W - Writable

Table 284: MS/TP Field Device Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Units = %Real valueCPU Usage

Units = %Real valueFlash Usage

True or FalseHas Unbound
References

Units = %Real valueMemory Usage

NumberObject Count

Units = %Real valueObject Memory Usage

1 C - Configurable, D - Default Attribute for Display, W - Writable

MS/TP Field Device Controller Attribute Details
COV Min Send Time
Defines a specific rate at which the field device sends COV messages to the NAE for analog objects that have the
Use COV Min Sent Time attribute set to True. When analog objects have the Use COV Min Sent Time attribute set
to False, the COV Min Send Time attribute is ignored and COV messages are sent on every change of value.

Back to MS/TP Field Device Attributes.

COV TX Rate
The number of COV messages the field device sends to the NAE per minute. This value updates once every minute
and each COV message represents one object reporting a value change.

Back to MS/TP Field Device Attributes.

CPU Usage
Specifies a running average of CPU use. The value is updated every minute.

Back to MS/TP Field Device Attributes.

Enabled
If True, allows communication between the Metasys system and the MS/TP controller.

Back to MS/TP Field Device Attributes.

End of Line
Indicates whether the device is at the end of the bus.

Back to MS/TP Field Device Attributes.

Firmware Version
Indicates the version of the Main code in the field device.

Back to MS/TP Field Device Attributes.

Fixed Boot Version
Indicates the version of the Boot code in the field device. The Boot code is responsible for loading the Main code.

Back to MS/TP Field Device Attributes.
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Flash Usage
Specifies the estimated percent of flash memory currently in use. The percentage is based on the portion of flash
that is designated for use by the user’s database. A value greater than 100% can affect system reliability now or in
future software releases. There are no restrictions in place to prohibit use of flash over 100%.

Back to MS/TP Field Device Attributes.

Graphic
Indicates the graphic associated with the object.

Back to MS/TP Field Device Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to MS/TP Field Device Attributes.

Has Unbound References
Indicates that a process cannot find an object either because the device on which the object is located is offline, the
object has been deleted, or the object reference is incorrect.

Back to MS/TP Field Device Attributes.

In Test
Displays True when a Control Sequence in the device is currently in a test mode. When True, the device is marked
offline, although communication with the device is acceptable.

Back to MS/TP Field Device Attributes.

JCI System Status
Reflects the current status of the system.

Back to MS/TP Field Device Attributes.

Location
Indicates the physical location of the device.

Back to MS/TP Field Device Attributes.

Memory Usage
Specifies the percent of field device RAM currently in use.

Back to MS/TP Field Device Attributes.

Model Name
Indicates the product code for the device.

Back to MS/TP Field Device Attributes.

Object Count
Indicates the number (count) of all of the object instances within the device. Objects of all types are included.

Back to MS/TP Field Device Attributes.

Object Memory Usage
Specifies the percent of the object database that is currently in use. Each object created consumes memory within
the object database. This attribute can be used to help determine the device’s capacity for additional objects; however,
other performance indicators should also be assessed.

Also, an attempt to create an object known to require X bytes of object database may fail even if more than X bytes
are available in the object database. This is because the object database is composed of multiple blocks. A free
space block of at least X contiguous bytes available for allocation may not exist, even if the total free space is more
than X bytes.
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Back to MS/TP Field Device Attributes.

Offline
Indicates whether the MS/TP controller is offline.

Back to MS/TP Field Device Attributes.

Present Value
Indicates the current status of communication with the field device (Online, Offline, or Comm Disabled). A status of
Comm Disabled indicates that the field device has been disabled. A status of Offline indicates that either
communication problems exist, or the field device is currently in test mode. See In Test.

Back to MS/TP Field Device Attributes.

Pcode
Displays the device orderable product code.

Back to MS/TP Field Device Attributes.

Protocol Obj Supported
Indicates which standardized object types the device’s protocol implementation supports. Protocol Conformance
Class reflects the minimum set of object types, but implementation often supports additional standard and non-standard
object types with their own set of attributes. (The list of attributes supported for a particular object may be acquired
by use of the ReadPropertyMultiple Web method with an attribute reference of All.)

Back to MS/TP Field Device Attributes.

Protocol Ser Supported
Indicates which standardized protocol services the device's protocol implementation supports. Protocol Conformance
Class reflects the minimum set of services, but implementation often supports additional standardized services.

Back to MS/TP Field Device Attributes.

Startup Code Version
Specifies the version of the Startup code running in the controller. The Startup code is responsible for initial power
up operations.

Back to MS/TP Field Device Attributes.

Vendor ID
Identifies the unique manufacturer’s identifier, as defined by ASHRAE. For Johnson Controls, this value is 5.

Back to MS/TP Field Device Attributes.

Vendor Name
Identifies the manufacturer of the device (should be Johnson Controls).

Back to MS/TP Field Device Attributes.

MS/TP Field Device Commands
The table below lists the commands supported by the MS/TP Field Device object.

Table 285: MS/TP Field Device Object Commands
ParametersCommand Name

Disable

Enable

Reset Field Device
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MS/TP Field Device Command Details
Disable
Causes the MS/TP Field Device object to generate an offline alarm if previously online and to stop communicating
with the field device (stops receiving change of value and prevents any writes/commands from being sent). The
Present Value of a disabled field device is Comm Disabled.

Back to MS/TP Field Device Commands.

Enable
Causes the MS/TP Field Device object to re-establish communication with the field device (for example, sign-up for
COVs), eventually generating an online alarm if communication is OK.

Back to MS/TP Field Device Commands.

Reset Field Device
Causes the MS/TP field device to reset.

Back to MS/TP Field Device Commands.
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MS/TP Field Bus Integration Object
The MS/TP Field Bus Integration is the root for all Field Devices and BACnet objects on the MS/TP Field Bus in the
Metasys system. When you add a Field Bus integration to an NAE, you create an MS/TP communication link on a
specified hardware port. The MS/TP Field Bus Integration object offers diagnostic data related to the MS/TP network.
Once a Field Bus integration has been created, BACnet devices and associated BACnet objects can be added to
the trunk using the Insert Field Device and Insert Field Point wizards within SMP. The integration wizards support
both Automatic Device and Point discovery or manual object creation. The Field Bus integration supports 3rd party
BACnet MS/TP devices and all FEC family BACnet MS/TP devices.

For general information on Metasys system objects, see the Object Help section.

MS/TP Field Bus Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 286: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0–65,5354CWNumberAPDU Retries

0–65,535

Milliseconds

6,000CWNumberAPDU Timeout

0–65,535

Milliseconds

4,000CWNumberAPDU Segment
Timeout

Uses MSTPDL Baud Rate (Set 300).

See the attribute description.

0CWOne state/type/
mode from a set

Baud Rate Selection

NumberCount

Network number, high limit device instance,
low limit device instance

CWListDevice Discovery
Range

FalseCWTrue or FalseDiscover All AsGeneral
BACnet Device

NormalCWOne set from a stateExecution Priority

Range = 5–25520CWNumberInternode Comm Timer

Legal values are:

50

128

206

480

480CWNumberMax APDU Length

4–127127CWNumberMax Master

10–65,5351,000CWNumberPage Size

0–65,535

Units = seconds

20CWNumberPeriodic Update

10–50

Units = milliseconds

0CWNumberPoll Delay
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Table 286: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalsePreserve Discovered
Devices

The current list of Vendor IDs can be viewed
at
http://www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm

CNNumberRequested Vendor ID

FalseCWTrue or FalseSynchronize Time

FalseCWTrue or FalseSynchronize Time Zone

1 C - Configurable, W - Writable, N - Value Not Required

Table 287: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Uses MSTPDL Baud Rate (Set 300).

See the attribute description.

One state/type/
mode from a set

Active Baud Rate

Units = Per MinuteNumberBroadcast Receive
Rate

0–4,294,967,295NumberBroadcast Receives

Units = Per MinuteNumberBroadcast Transmit
Rate

0–4,294,967,295NumberBroadcast Transmits

0–4,294,967,295NumberBuffer Overflows

DateBus Analysis Date

TimeBus Analysis Time

See the MS/TP Analysis Set.One state/type/
mode from a set

BusAnalysis Progress

ListBus Device
Configuration List

NumberBus Health Index

NumberBusPerformance Index

0–4,294,967,295NumberBytes In

0–4,294,967,295NumberBytes Out

0–4,294,967,295NumberData CRC Errors

0–4,294,967,295NumberData Expecting Reply
Frames Rxed

0 - 4,294,967,295NumberData Expecting Reply
Frames Txed

0–4,294,967,295NumberData Not Expecting
Reply Frames Rxed

0–4,294,967,295NumberData Not Expecting
Reply Frames Txed

ListDuplicate Device
Identifiers

0–4,294,967,295

Units = seconds

0NumberExecution Time

0–4,294,967,295NumberFraming Errors
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Table 287: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0–4,294,967,295NumberHeader CRC Errors

0–4,294,967,295NumberInternal Errors

0–4,294,967,295NumberLost Token

1–65,534NumberMax Output Queue
Used

0–4,294,967,295

Milliseconds

NumberMaximum Token Loop
Time

0–4,294,967,295NumberOverrun Errors

0–4,294,967,295NumberPFM Frames Rxed

0–4,294,967,295NumberPFM Frames Txed

0–4,294,967,295NumberPackets Timed Out

0–4,294,967,295NumberPackets Too Long

NumberPolled Object Count

Uses MSTPDL Port Status (Set 302).One state/type/

mode from a set

Port Status

MillisecondsNumberPredicted Token Loop
Time

0–4,294,967,295NumberReply Postponed
Frames Rxed

0–4,294,967,295NumberReply Postponed
Frames Txed

0–4,294,967,295NumberReply to PFM Frames
Rxed

0–4,294,967,295NumberReply to PFM Frames
Txed

0–4,294,967,295NumberReply Too Slow
Application Errors

0–4,294,967,295NumberReply Too Slow
Datalink Errors

DateReset Date

TimeReset Time

0–4,294,967,295NumberRetries

0–4,294,967,295NumberTest Request Frames
Rxed

0–4,294,967,295NumberTest Request Frames
Txed

0–4,294,967,295NumberTest Response Frames
Rxed

0–4,294,967,295NumberTest Response Frames
Txed

0–4,294,967,295NumberToken Frames Rxed

0–4,294,967,295NumberToken Frames Txed
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Table 287: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0–4,294,967,295

Milliseconds

NumberToken Loop Time

0–4,294,967,295NumberUnexpected Frames
Rxed

Minimum = 0.10

Maximum: 0.99

0.5WNumberWeighted Bus Health
Constant

Minimum = 0.10

Maximum: 0.99

0.5WNumberWeighted Bus
Performance Constant

1 C - Configurable, W - Writable, N - Value Not Required

MS/TP Field Bus Integration Attribute Details
APDU Retries
Indicates the maximum number of times the device can retransmit a data frame. If the device does not perform
retries, it has a value of 0. If this value is greater than 0, a non-zero value appears in the APDU Segment Timeout
attribute. We do not recommend changing this attribute value from the default value without a strong reason.

Back to MS/TP Field Bus Integration Attributes.

APDU Segment Timeout
Indicates the amount of time in milliseconds between retransmissions of a data frame segment requiring
acknowledgement for which no acknowledgement has been received. This value is not 0 if the device supports
segmentation of transmitted data frames. We do not recommend changing this attribute value from the default value
without a strong reason.

Back to MS/TP Field Bus Integration Attributes.

APDU Timeout
Indicates the amount of time in milliseconds between retransmissions of a complete data frame requiring
acknowledgement for which no acknowledgement has been received. This attribute applies to smaller data messages
where the entire message fits within a single frame on the MS/TP bus. We do not recommend changing this attribute
value from the default value without a strong reason.

Back to MS/TP Field Bus Integration Attributes.

Active Baud Rate
Displays the actual data rate on the wire for transmitting and receiving. When set to Auto, the port is waiting to
synchronize with the network.

Back to MS/TP Field Bus Integration Attributes.

Baud Rate Selection
Indicates the baud rate of the NAE FC bus (Table 288).

Table 288: Baud Rate Options
DescriptionBaud

Rate
Use baud rate of running network. This value is the recommended setting for everything on the FC bus except the
bus supervisor port. See Active Baud Rate.

Auto

Use 1200 baud only. This value is not recommended and may not be allowed on some devices.1200

Use 9600 baud only. This value is the lowest standard MS/TP baud rate.9600

Use 19200 baud only. This value is not recommended.19200
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Table 288: Baud Rate Options
DescriptionBaud

Rate
Use 38400 baud only. This value is the recommended baud rate for bus supervisor ports.38400

Use 76800 baud only.76800

Important: At least one online device on the FC bus must have a Baud Rate Selection that is not Auto to establish
the baud rate for the other bus devices. Normally, this device is the supervisory device of the FC bus.

Back to MS/TP Field Bus Integration Attributes.

Broadcast Receive Rate
Indicates the number of BACnet broadcast messages received on the MS/TP field bus network of the device in the
last minute. If this number is high, it indicates that the performance of the specific MS/TP field bus network is affected
by broadcast receive traffic.

Back to MS/TP Field Bus Integration Attributes.

Broadcast Receives
Indicates the number of broadcast messages received.

Back to MS/TP Field Bus Integration Attributes.

Broadcast Transmit Rate
Indicates the number of BACnet broadcast messages transmitted on the MS/TP field bus network for the device in
the last minute. If this number is high, it indicates that the performance for the specific MS/TP field bus network is
affected by broadcast transmit traffic.

Back to MS/TP Field Bus Integration Attributes.

Broadcast Transmits
Indicates the number of broadcast message transmissions.

Back to MS/TP Field Bus Integration Attributes.

Buffer Overflows
Indicates the number of data frames lost at this MS/TP device because there was no buffer available to which to
save it. This number includes outgoing and incoming messages.

Back to MS/TP Field Bus Integration Attributes.

Bus Analysis Date
Displays the date when the last full MS/TP field bus scan finished. The Analyze Field Bus command initiates the
network scan.

Back to MS/TP Field Bus Integration Attributes.

Bus Analysis Time
Displays the time when the last full MS/TP field bus scan finished. The Analyze Field Bus command initiates the
network scan.

Back to MS/TP Field Bus Integration Attributes.

Bus Analysis Progress
Indicates the progress of the full MS/TP field bus scan initiated by the Analyze Field Bus command.

Back to MS/TP Field Bus Integration Attributes.

Bus Device Configuration List
Lists MS/TP devices that either have been detected on the FC bus or have been configured on field devices existing
under the MS/TP Field Bus Integration Object.
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The Bus Device Configuration List provides configuration information for each device, including which devices are
responding, which devices may have been configured incorrectly, and the addresses of all devices. Only bus
supervisor devices provide all this information. This object creates the list when you issue an Analyze Field Bus
command.

Back to MS/TP Field Bus Integration Attributes.

Bus Health Index
Indicates the overall health of the MS/TP field bus based on the number of errors occurring at the NAE. The most
desirable value is 0. The higher the number, the worse the bus health/higher the number of errors. The Bus Health
Index is re-evaluated every 30 seconds and gradually returns to zero if no new errors occur.

This object derives the value for the Bus Health Index from periodically reading the Header CRC Errors, Data CRC
Errors, Framing Errors, and Lost Token attribute values to create a moving average of total errors. The Weighted
Bus Health Constant attribute determines the responsiveness of the Bus Health Index.

Back to MS/TP Field Bus Integration Attributes.

Bus Performance Index
Indicates the responsiveness of the bus supervisor device on the MS/TP field bus. The most desirable value is 1.
Values from 2.5 to 6 are marginal and updates to devices on the bus may be slow. If the value is greater than 6, the
performance is poor and may indicate offline conditions.

The device derives the value for the Bus Performance Index by comparing the measured token loop time at the NAE
and the predicted token loop time calculated when the MS/TP Field Bus Integration object is first created or when
the NAE device count changes. This object uses the difference as input for determining the weighted moving average
of the token loop time. The Weighted Bus Performance Constant attribute determines the responsiveness of the
Bus Performance Index.

Back to MS/TP Field Bus Integration Attributes.

Bytes In
Indicates the number of data bytes received by this device. This number includes all messages from all devices.

Back to MS/TP Field Bus Integration Attributes.

Bytes Out
Indicates the number of data bytes sent by this device. This number includes all messages to all devices.

Back to MS/TP Field Bus Integration Attributes.

Count
Contains the number of FEC series and non-FEC series BACnet objects mapped on the field bus.

Back to MS/TP Field Bus Integration Attributes.

Data CRC Errors
Counts errors detected in the data portion of data frames sent to the device. Many data frames are used only for
protocol control and do not contain a data portion, and thus cannot have Data CRC Errors. The Header CRC Errors
check must be successful before the device attempts a Data CRC check. This attribute supplies an error count for
the Bus Health Index attribute.

Back to MS/TP Field Bus Integration Attributes.

Data Expecting Reply Frames Rxed
Displays the number of data frames received by the device that require an immediate reply. This value includes
proprietary frames that have been received and are expecting a reply.

Back to MS/TP Field Bus Integration Attributes.

Data Expecting Reply Frames Txed
Displays the number of data frames sent by the device that requires an immediate reply from the destination device.
This value includes proprietary frames that have been sent and are expecting a reply.
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Back to MS/TP Field Bus Integration Attributes.

Data Not Expecting Reply Frames Rxed
Displays the number of data frames received by this item that do not require an immediate reply. This value includes
proprietary frames that have been received and are not expecting a reply.

Back to MS/TP Field Bus Integration Attributes.

Data Not Expecting Reply Frames Txed
Displays the number of data frames sent by the device that do not require an immediate reply. This value includes
proprietary frames that have been sent and received a reply.

Back to MS/TP Field Bus Integration Attributes.

Device Discovery Range
Specifies the destinations for the messages sent during the device auto discovery process. This list is empty by
default. When the list is empty, a global broadcast message is sent. Adding entries to the list limits the scope of the
broadcast message to only the specified networks and device instance ranges. If multiple entries appear in the list,
the messages are sent sequentially. This attribute appears only in the snapshot view.

Back to MS/TP Field Bus Integration Attributes.

Discover All As General BACnet Device
Toggles the integration between pure BACnet mode and BACnet with proprietary messaging. When set to True,
proprietary messaging is disabled. This may be useful for special cases where customers do not want Private
Transfer messages on the BACnet trunk. Note that when this attribute is True, proprietary Objects, Attributes, and
Services on Johnson Controls devices (such as FECs, FACs, VMAs) will not be available. This attribute must be
set before devices are added to the Integration. The default value is False.

Back to MS/TP Field Bus Integration Attributes.

Duplicate Device Identifiers
Lists any duplicate object identifiers found after an auto-discovery of MS/TP BACnet devices finishes. If any devices
are listed, then the list of automatically discovered devices may be incomplete. The list contains the instance number
of the Object Identifier and the network address (represented in hex notation) of each device with the same identifier
instance number as another device on the same bus. MS/TP devices with duplicate device identifiers may be
integrated without problem, but should be physically located and their object identifiers changed to make them unique
network-wide.

Back to MS/TP Field Bus Integration Attributes.

Execution Priority
Indicates the order in which any given object within a group of objects is allowed to run or change data within a
system. This attribute should not be changed for this object.

Back to MS/TP Field Bus Integration Attributes.

Execution Time
Records the amount of time taken for the last periodic update of all referenced mapped BACnet objects. The value
for this attribute can be used to tune the Periodic Update attribute. If the Execution Time is greater than the Periodic
Update, attribute values of referenced BACnet objects are constantly being updated over the network. This attribute
applies only to non-FEC series devices. See the Poll Delay attribute description for information on how these
attributes interact.

Back to MS/TP Field Bus Integration Attributes.
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Framing Errors
Counts the number of errors detected in the individual data bytes received by the device. A framing error occurs
when the device receives a stop bit in the wrong state. This attribute supplies an error count for the Bus Health
Index attribute. Framing errors are usually caused by electrical noise on the bus, message collisions, incorrect baud
rate settings, bus wiring or termination errors, or devices that are not operating within the BACnet specified timing.
Framing errors generally cause CRC errors since the frame has been corrupted.

Back to MS/TP Field Bus Integration Attributes.

Header CRC Errors
Counts the number of errors detected in the header portion of frames received by the device. Many frames are only
used for protocol control and only contain a header portion. This attribute supplies an error count for the Bus Health
Index attribute.

Back to MS/TP Field Bus Integration Attributes.

Internal Errors
Indicates the number of internal MS/TP driver operation errors resulting from an incorrect state, insufficient memory,
errors from the serial port driver, incorrect internal state transitions, and other error states.

Back to MS/TP Field Bus Integration Attributes.

Internode Comm Timer
Controls the frequency of communication with MS/TP devices. Among other communications, this attribute defines
the frequency of the heartbeat to monitored devices (monitored at a rate of two times the Internode Comm Timer).

Back to MS/TP Field Bus Integration Attributes.

Lost Token
Indicates the number of times the device detects a lost token. A lost token indicates that the bus encountered a
serious network disruption. Serious disruption may occur when the bus first starts up or when wiring changes are
made. This attribute supplies an error count for the Bus Health Index attribute.

Back to MS/TP Field Bus Integration Attributes.

Max APDU Length
Indicates the maximum number of bytes that may be contained in a single, indivisible application layer protocol data
unit. This value should not be changed during normal installation or operation.

If you write the value of this attribute, you must issue a Reset Device command to the NAE for the new settings to
take effect.

Back to MS/TP Field Bus Integration Attributes.

Max Master
Specifies the highest possible address for devices on this network and is less than or equal to 127. This attribute is
present if the device is a bus supervisor device on an MS/TP network. Do not change this value from the default
unless you have a strong reason because incorrect values may cause devices to lose communications.

Back to MS/TP Field Bus Integration Attributes.

Max Output Queue Used
Displays the largest number of outgoing frames the device has held in a queue for transmission. The largest possible
value for this attribute depends on the capabilities of the engine. Generally, the maximum value is reached during
device startup, but is not reached during normal operation.

Back to MS/TP Field Bus Integration Attributes.
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Maximum Token Loop Time
Indicates the maximum time in milliseconds last seen at the device for the token to complete one circuit of the MS/TP
field bus (go from the originating bus supervisor device through several other devices and return to the original bus
supervisor device). The value is reset when the statistics are cleared. Maximum loop time is closely associated with
the worst-case performance encountered since the last time the value was reset.

Back to MS/TP Field Bus Integration Attributes.

Overrun Errors
Displays the number of times the MS/TP port hardware loses received data because the device is too slow in reading
the data. An overrun error occurs when the hardware receives a byte before it moves the prior byte to a buffer.

Back to MS/TP Field Bus Integration Attributes.

PFM Frames Rxed
Displays the number of Poll For Master frames received by the device. On a clean network, this should only count
the first Poll For Master (PFM) frame received when the device (or another with a MAC address below that of the
device) comes online. These frames are used to discover other devices on the network and should be seldom
received.

Back to MS/TP Field Bus Integration Attributes.

PFM Frames Txed
Displays the number of Poll For Master frames sent by the device. In normal operation on a clean network, only the
bus supervisor (MAC address 0) and the highest numbered master device on the network should be sending Poll
For Master (PFM) frames. These frames are used to discover other devices on the network.

Back to MS/TP Field Bus Integration Attributes.

Packets Timed Out
Counts the number of data frames expected by the device that did not arrive within the time allowed.

Back to MS/TP Field Bus Integration Attributes.

Packets Too Long
Counts any attempts to transmit or receive a data frame that is longer than allowed by the device or by MS/TP.

Back to MS/TP Field Bus Integration Attributes.

Page Size
Determines how many points are discovered per page. Default is 1,000.

Back to MS/TP Field Bus Integration Attributes.

Periodic Update
Specifies how frequently integrated BACnet objects that do not support COV subscription update their attribute
values. Every period, the MS/TP Field Bus Integration object prompts each integrated BACnet object that needs to
update its attribute values. This attribute applies only to non-FEC series devices. See the Poll Delay attribute
description for information on how these attributes interact.

Back to MS/TP Field Bus Integration Attributes.

Poll Delay
Specifies the time in milliseconds between BACnet object polls for attribute values. The polls start at the time specified
in the Periodic Update attribute. As the poll delay increases, the overall time in the Execution Time attribute increases.
It is useful to specify a Poll Delay on sites where the rate of reading the remote objects causes too high of a burden
on the Metasys network or third-party device. The initial value of the Poll Delay attribute is blank (zero).

Back to MS/TP Field Bus Integration Attributes.

Polled Object Count
Indicates the number of mapped BACnet objects that are currently polled on a periodic basis. This attribute applies
only to non-FEC series devices.
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Back to MS/TP Field Bus Integration Attributes.

Port Status
Indicates the state of the port.

Back to MS/TP Field Bus Integration Attributes.

Predicted Token Loop Time
Indicates the theoretical time in milliseconds needed for the token to complete one circuit of the MS/TP field bus.

The object derives this value from the defined bus baud rate, number of devices on the bus, and an estimate of the
type and amount of messages transmitted on the bus during this time. This object compares the value of this attribute
with that of the Token Loop Time attribute to help calculate the value of the Bus Performance Index attribute.

Back to MS/TP Field Bus Integration Attributes.

Preserve Discovered Devices
Controls the behavior when field device discovery is started. This attribute exists for historical reasons and is ignored
by the MS/TP Field Bus Integration object for FEC series or non-FEC series devices. The value of the attribute is
shown in the snapshot view. If an auto discovery has been completed since the last device restart, a complete new
auto discovery is performed for all FEC Series or non-FEC Series devices for each subsequent auto discovery in
which Restart is selected.

Back to MS/TP Field Bus Integration Attributes.

Reply Postponed Frames Rxed
Counts the number of data frames sent at the device that requires an immediate reply where the destination device
requests additional time to prepare the reply. This may happen normally if the reply involves a large amount of data.
It may also indicate that a device on the network is overloaded.

Back to MS/TP Field Bus Integration Attributes.

Reply Postponed Frames Txed
Counts the number of data frames received at the device that requires an immediate reply where this device requests
additional time to prepare the reply. This may happen normally if the reply involves a large amount of data. It may
also indicate that this device is overloaded.

Back to MS/TP Field Bus Integration Attributes.

Reply to PFM Frames Rxed
Counts the number of Reply to Poll For Master frames the device receives. On a clean network in normal operation,
the device receives only one Reply to PFM frame when either the device comes online or the next higher numbered
device comes online during normal operation. These frames announce the presence of this device on the network.

Back to MS/TP Field Bus Integration Attributes.

Reply to PFM Frames Txed
Counts the number of Reply to Poll For Master frames the device transmits. On a clean network during normal
operation, only one Reply to Project Folder Manager (PFM) frame needs to be sent when the device first comes
online. These frames are used to announce the presence of other devices on the network.

Back to MS/TP Field Bus Integration Attributes.

Reply Too Slow Application Errors
Counts the number of data frames received at this device that requires an immediate reply where the device cannot
assemble reply data within the time allowed and cannot internally detect the need for additional time. These errors
generally indicate an overloaded device if they occur frequently.

Back to MS/TP Field Bus Integration Attributes.
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Reply Too Slow Datalink Errors
Counts the number of data packets sent by the device that requires an immediate reply from the destination device,
but do not receive any reply within the time allowed. This number does not include Reply Postponed responses.
The affected frames likely require a retry and bus performance is reduced when this happens.

Back to MS/TP Field Bus Integration Attributes.

Requested Vendor ID
Used as a filter when discovering new devices to limit the device list to whatever is specified as the Vendor ID value.
The default value of this attribute is Null (stored as zero) which allows all vendors to be discovered and displayed.
Note that this filter applies only to non-Johnson Controls devices. Johnson Controls devices will always be included
in the discovered device list.

The current list of Vendor IDs can be viewed at http://www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm.

Note: If you do not want to display devices already discovered or mapped, then set Preserve Discovered Devices
to False.

Back to MS/TP Field Bus Integration Attributes.

Reset Date
Contains the date of the last Clear Statistics command (when the statistics for the device were last reset).

Back to MS/TP Field Bus Integration Attributes.

Reset Time
Contains the time of the last Clear Statistics command (when the statistics for the device were last reset).

Back to MS/TP Field Bus Integration Attributes.

Retries
Displays the number of times the device tried to pass a token as the next node did not start using it within the time
allowed by BACnet protocol.

Back to MS/TP Field Bus Integration Attributes.

Synchronize Time
Broadcasts time synchronization to all devices on the field bus when the field device comes online or when the time
changes by a significant amount. When changed from false to true, a time synchronization is sent immediately to
all devices on the field bus.

Back to MS/TP Field Bus Integration Attributes.

Synchronize Time Zone
Used to enable/disable time zone synchronization messages to devices on a trunk that support real time clock
capabilities, such as FACs. When this attribute is set to True, time zone synchronization messages are broadcasted
to devices on the field bus. The broadcast occurs either when individual devices come online or to all devices when
any of the time zone related attributes change (Time Zone, UTC Offset, Standard Time Offset, Daylight Savings
Time Offset, Standard Time Start, and Daylight Savings Time Start). When changed from false to true, time zone
synchronization is automatically sent to all devices on the field bus.

Back to MS/TP Field Bus Integration Attributes.

Test Request Frames Rxed
Displays the number of Test Request Frames the device receives. Test Request Frames are a normal part of bus
analysis, but should not be received during normal operation. A Test Response Frame should be sent in reply to
each Test Request Frame received.

Back to MS/TP Field Bus Integration Attributes.
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Test Request Frames Txed
Displays the number of Test Request Frames the device transmits. Test Request Frames are a normal part of bus
analysis, but should not be sent during normal operation. A Test Response Frame should be received in response
to each test Request Frame sent to an online device. Test Request Frames may also be sent to offline devices
where no response is received.

Back to MS/TP Field Bus Integration Attributes.

Test Response Frames Rxed
Displays the number of Test Response Frames the device receives. Test Response Frames are a normal part of
bus analysis, but should not be received during normal operation. A Test Response Frame should be received in
response to each test Request Frame sent to an online device.

Back to MS/TP Field Bus Integration Attributes.

Test Response Frames Txed
Displays the number of Test Response Frames transmitted by this MS/TP port. Test Response Frames are a normal
part of bus analysis, but should not be sent during normal operation. A Test Response Frame should be sent in
response to each test Request Frame received.

Back to MS/TP Field Bus Integration Attributes.

Token Frames Rxed
Displays the number of Token Frames the device receives. In MS/TP, each master device passes a logical token
to the next device during normal operation. Only the master device currently holding the token is allowed to initiate
a message; thus, the number of Token Frames sent or received should be large. Normally the number of Token
Frames received should be almost the same as the number of Token Frames transmitted.

Back to MS/TP Field Bus Integration Attributes.

Token Frames Txed
Displays the number of Token Frames the device transmits. In MS/TP, each master device passes a logical token
to the next device during normal operation. Only the master device currently holding the token is allowed to initiate
a message, thus the number of Token Frames sent or received should be large. Normally the number of Token
Frames received should be almost the same as the number of Token Frames transmitted.

Back to MS/TP Field Bus Integration Attributes.

Token Loop Time
Indicates how much time passes between the periods when the device allows initiation of messages on the network.
This time is a strong indicator of network performance and is associated strongly with the amount of traffic or errors
on the network. Shorter times indicate a more responsive network. Longer times indicate an increasingly busy and
slow network.

The object compares the value of this attribute with that of the Predicted Token Loop Time attribute to help calculate
the value of the Bus Performance Index attribute.

Back to MS/TP Field Bus Integration Attributes.

Unexpected Frames Rxed
Displays the number of data frames of an illegal type the device receives. During normal operation, only certain
kinds of MS/TP data frames are allowed to be sent during each phase of operation. If the device receives some
other kind of data frame (other than the allowed types for the current phase of operation), the device counts the data
frame as an Unexpected Frame. The device may often detect Unexpected Frames when connecting running devices
to a live MS/TP bus.

Back to MS/TP Field Bus Integration Attributes.
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Weighted Bus Health Constant
Indicates a smoothing constant used to calculate the Bus Health Index attribute value. The Weighted Bus Health
Constant attribute weighs the importance of the change from one reading to the next reading for the error attributes
associated with the Bus Health Index attribute. The higher the value for this attribute, the faster the Bus Health Index
value changes (the more responsive the Bus Health Index attribute is to changes in error values). The value is
always less than 1.0. The initial value is 0.5.

Back to MS/TP Field Bus Integration Attributes.

Weighted Bus Performance Constant
Indicates a smoothing constant used to calculate the Bus Performance Index attribute value. The Weighted Bus
Performance Constant attribute weighs the importance of the change from one reading to the next reading for the
Token Loop Time attribute. The higher this value, the faster the Bus Performance Index value changes (the more
responsive the Bus Performance Index attribute is to changes in Token Loop Time). The value is always less than
1.0. The initial value is 0.5.

Back to MS/TP Field Bus Integration Attributes.

MS/TP Field Bus Integration Commands
The following table lists the commands supported by the MS/TP Field Bus Integration Object.

Table 289: MS/TP Field Bus Integration Commands
ParametersCommand Name

Analyze Field Bus

Clear Statistics

Latch Statistics

MS/TP Field Bus Integration Command Details
Analyze Field Bus
Scans the entire MS/TP field bus (addresses 0–254) and compiles a list of all devices on the bus. The Analyze Field
Bus command also provides configuration information for each device that responds. The data collected helps to
determine devices that may be configured incorrectly and thus affect the bus performance. Because of the high bus
traffic load created by the scan, this command should not be used on a regular basis. This command is primarily
intended for use during commissioning.

Track the progress of this analysis in the Bus Analysis Progress attribute. The results of this command appear in
the Bus Device Configuration List attribute. The date and time of the last completed scan appear in the Bus Analysis
Date attribute and Bus Analysis Time attribute, respectively.

Back to MS/TP Field Bus Integration Commands.

Clear Statistics
Clears the statistics for the integrated MS/TP network.

Back to MS/TP Field Bus Integration Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to MS/TP Field Bus Integration Commands.
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Multiple Command Object
The Multiple Command object issues a series of commands to multiple objects by means of a single command
action. Commanding this object results in the execution of the commands for the given state. This object supports
States 1–32.

This object allows a user to start building controls for the day with one command or to prevent selected points from
generating Change-of-State (COS) and alarm messages when a control point is in a specified state (Auto Shutdown).

For example, based on a single input, such as Room Occupied, a defined set of actions can occur: setpoint goes
to 72˚, a fan comes on, lights come on, and the door unlocks.

For general information on Metasys system objects, see the Common Object Attributes section.

For more information on the wizard used to create Multiple Command objects, see the Insert Object - Multiple
Command section.

Multiple Command Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 290: Multiple Command Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

True or FalseEnabled

False, TrueFalseTrue or FalseExecuting

CWOne state from a setExecution Priority

NDateLast Executed Date

NTimeLast Executed Time

1–324CNumberNumber of States

States Text attribute identifies the states set
for this attribute.

DWOne state from a setPresent Value

True or FalseSend OK

StatesCOne state from a setStates Text

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

Table 291: Multiple Command Object Attributes - Action Tables Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Object Reference, Delay, Command ID,
Parameters, Priority
Note: The total number of commands

identified in the Action Table 1
command set should not exceed 40.

CWList of Command
References

Action Table (State0. .
. StateN)

Uses Write Priority (Set 1).16CWOne state from a setCommand Priority

1–324CNumberNumber of States

CNWOne state from a setRelinquish Default

StatesCOne state from a setStates Text

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable
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Multiple Command Attribute Details
Action Table (State0. . . StateN)
Lists actions to take for each supported state. Each action of the table contains a slave object reference, a delay, a
command and its associated parameters, and a priority. The priority in this table is used only when Commands
Priority is set to No Priority. The delay is the number of seconds before the given command is issued. Command
delays can be lengthened or shortened to result in commands being sent out after, before, or at the same time as
any other command.

The total number of commands identified in the Action Table command set should not exceed 40.

Back to Multiple Command Attributes.

Command Priority
Determines the order by importance for all commands sent. If it is set to Priority None, commands will be sent at
each individual priority specified in the Action Table attribute.

Back to Multiple Command Attributes.

Enabled
Indicates whether the Multiple Command object is enabled or disabled.

Back to Multiple Command Attributes.

Executing
Specifies the current execution status of the object. It is True when the object receives a state command and starts
sending commands. When all actions are completed for a given state, this flag is set to False.

Back to Multiple Command Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Multiple Command Attributes.

Last Executed Date
Indicates the date stamp for the beginning of executing the current state.

Back to Multiple Command Attributes.

Last Executed Time
Indicates the time stamp for the beginning of executing the current state.

Back to Multiple Command Attributes.

Number of States
Specifies the number of possible states this object can have.

Back to Multiple Command Attributes.

Present Value
Indicates the current value of this object.

Back to Multiple Command Attributes.

Relinquish Default
Specifies the default value to be used for the Present Value attribute when no commands are currently controlling
this object. If this attribute is configured to any value other than None, the object sends commands for the value
immediately.

Back to Multiple Command Attributes.
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Send OK
Indicates the success or failure of the slave commands. If any slave commands failed, this attribute is set to False.
When a send error is detected, a 5-minute timer is set. When the timer expires, the object is reevaluated and all
commands are sent again. Commands may fail if the slave object is off-box and offline or if the slave object is set
for local control.

Back to Multiple Command Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Multiple Command Attributes.

Multiple Command Commands
The table below lists the commands supported by the Multiple Command Object.

Table 292: Multiple Command Object Commands
ParametersCommand Name

Disable

Enable

Multistate0.. Multistate31

State 0–31Operator Override

1. Attribute name
2. Command priority

Release

Attribute nameRelease All

Release Operator Override

Multiple Command Object Command Details
Disable
Specifies that (when the Multiple Command object is disabled) outputs are locked and commands are prevented
from being sent.

Back to Multiple Command Commands.

Enable
Specifies that (when the Multiple Command object is enabled) the object it is capable of issuing commands.

Back to Multiple Command Commands.

Multistate0.. Multistate31
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. The state command names and number of commands are dependent on the States Text and
Number of States attributes.

Back to Multiple Command Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override.

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when one of the following conditions is met: a) NOT Local Control and NOT Out Of Service, or b)
NOT Local Control and after issuing the In Service command.

Back to Multiple Command Commands.
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Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Multiple Command Commands .

Release All
Releases Command Priorities 3 through 16 from the specified, writable attribute. Command Priorities 1 (Manual
Emergency) and 2 (Fire Application) remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to Multiple Command Commands.

Release Operator Override
Releases Command Priority Operator Override from Present Value.

Back to Multiple Command Commands.
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Multistate Input Object
The Multistate Input object’s Present Value attribute represents results of an algorithmic process within the device
in which the object resides. For example, the Present Value of the Multistate Input object could be either the result
of a combination of multiple binary inputs, the threshold of one or more analog inputs, or the result of a mathematical
computation. Present Value is an integer representing the state of the object. The State Text attribute associates
a description with this state.

Note: Do not confuse the Present Value state with the Event State attribute, which reflects the Offnormal state of
the Multistate Input.

The Multistate Input object integrates N1, N2, and BACnet controllers with supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types
• flexibility in point mapping
• support for Metasys N2 controllers. See the N2 Controller Object.

For example, this object allows you to display the speeds of a multispeed fan at a supervisory controller.

For general information on Metasys system objects, see Common Object Attributes.

Multistate Input Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 293: Multistate Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

Limit: 20 charactersNullWCWTextDevice Type

False

True

FalseNot SupportedCTrue or FalseIntrinsic Alarming
Defined

Minimum Value = 2

Maximum Value = 16

4WCWNumberNumber of States

False

True

FalseWCWTrue or FalseOut of Service

States Text attribute identifies the value
set for this attribute.

DNRWDNRWOne value from
a set

Present Value2

No Fault Detected (Reliable), No Sensor,
Over Range, Under Range, Open Loop,
Shorted Loop, Multi State Fault,
Unreliable Other Uses Reliability (Set
503).

WWOne value from
a set

Reliability

Set of ValuesState Text

Off Low

Med Hi

CCWOne value from
a set

States Text
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Table 293: Multistate Input Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

In Alarm, Fault, Overridden, Out of
Service Uses BAC Status Flags (Set 9).

Series of True or
False states

Status Flags

FalseBCWTrue or FalseUseRemoteAlarming

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object’s Reliability, W - Writable
2 This attribute is required to be writable if Out of Service is True.

Multistate Input Attribute Details
Device Type
Contains a description of the physical device connected to the object.

Back to Multistate Input Attributes.

Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Multistate Input Attributes.

Number of States
Defines the number of states Present Value can have.

Back to Multistate Input Attributes.

Out of Service
Used to decouple the object from the physical input that feeds its Present Value and Reliability. When out of service
is True, the object does not read the Present Value and Reliability from the hardware.

In addition, the Reliability attribute and the corresponding state of the Fault flag of the Status Flags attribute is
decoupled from the input when Out of Service is True. While the Out of Service attribute is True, Present Value and
Reliability may be changed to any value either as a means of simulating specific fixed conditions or for testing
purposes. Other functions that depend on the state of the Present Value or Reliability attributes respond to changes
made to these attributes while Out of Service is True, as if those changes had occurred in the input.

Back to Multistate Input Attributes.

Present Value
Reflects the current value of the input as one of n states, where n is the number of states defined in the Number of
States attribute. When Out of Service is True, Present Value is writable.

Back to Multistate Input Attributes.

Reliability
Indicates if the Present Value is unreliable and why. When Out of Service is True, the Reliability may be written
directly.

Back to Multistate Input Attributes.

State Text
Represents descriptions of all possible states of Present Value. The number of descriptions matches the number
of states defined in Number of States. Present Value (an integer) serves as an index into this attribute.

Back to Multistate Input Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Multistate Input Attributes.
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Status Flags
Contains four true or false flags that indicate the general health of the object. Three of the four flags are associated
with the values of other attributes within the same object. By reading these attributes, you get a clearer picture of
the object status. The four flags are:

In Alarm - In Alarm flag is False (0) if the Event State attribute value is Normal; otherwise the In Alarm flag is True
(1).

Fault - Fault flag is True (1) if the Reliability attribute is not reliable; otherwise the Fault flag is False (0).

Overridden - Overridden flag is Logical 1 if the Present Value is decoupled from the hardware output because
operator intervention provided a different value.

Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise the Out of Service
flag is False.

Back to Multistate Input Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Multistate Input Attributes.

Multistate Input Commands
The table below lists the commands supported by the Multistate Input Object.

Table 294: Multistate Input Object Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present Value attribute.Out of Service (Command)

Multistate Input Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Input Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Input Commands.

In Service
This command cancels the affect of an Out of Service (Command) command and returns the Out of Service attribute
to False. The Present Value and Reliability will revert back to the values obtained from the physical input.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Multistate Input Commands.
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Out of Service
This command allows a user to override the object's hardware input for simulation or other purposes. The Out Of
Service command changes the Out of Service attribute to True, write the Present Value to the value of the command
parameter and write the Reliability attribute to Reliable. The Present Value and Reliability will no longer track the
physical input.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Multistate Input Commands.
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Multistate Output Object
The Multistate Output object’s attributes represent the desired state of one or more physical outputs or processes
of the device in which the object resides. The actual functions associated with a particular state are determined
locally (not part of protocol). Present Value represents the state with a number, and State Text associates a
description with each state.

The Multistate Output object integrates N1, N2, and BACnet controllers with supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types
• flexibility in point mapping
• support for Metasys controllers

For example, this object allows you to command the modes of an access control device from a supervisory controller.

Note: The N1 migration Multiple Command object maps to this Multistate Output object.

For general information on Metasys system objects, see Common Object Attributes.

Multistate Output Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 295: Multistate Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

Limit: 20 charactersWCWTextDevice Type

Range: 0–255 Seconds0Not supportedCWNumberHeavy Equip Delay

1–5Not supportedCWNumberHED Controller

False

True

FalseNot supportedCTrue or FalseIntrinsic Alarming
Defined

2–164WCWNumberNumber of States

False

True

WCWTrue or FalseOut of Service

States Text attribute identifies the
value set for this attribute.

DRWDRWOne value from a setPresent Value

Set of valuesPriority Array

No Fault Detected (Reliable), Open
Loop, Shorted Loop, No Output,
Unreliable Other

Uses Reliability (Set 503).

ReliableOne value from a setReliability

Off Low

Med Hi

One state from a setState Text

Off Low

Med Hi

CWCWOne state from a setStates Text
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Table 295: Multistate Output Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

In Alarm, Fault, Overridden, Out of
Service

Uses BAC Status Flags (Set 9).

One value from a setStatus Flags

FalseBCWTrue or FalseUse Remote
Alarming

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object’s Reliability, W - Writable

Multistate Output Attribute Details
Device Type
Contains a description of the physical device connected to the object.

Back to Multistate Output Attributes.

Heavy Equip Delay
Indicates the amount of time that this output point adds to the Accumulated Delay attribute of the Heavy Equipment
Controller object when this point is started. The next output point is delayed by that amount of time of the HEC
Accumulated Delay is not already decremented to zero.

The NAE device’s five internal Heavy Equipment Controller objects (see HED Controller) time their delays
independently of one another. For example, HED 1 and HED 4 can count down their delays at the same time.

Back to Multistate Output Attributes.

HED Controller
Identifies the Heavy Equipment Controller object managing the delays.

The NAE device has five internal Heavy Equipment Controller objects for use by Binary Output and Multistate Output
objects. The BO and Multistate Output (MO) objects reference the HED controller objects by number (1–5).

All BO and MO objects on an NAE share the five internal HED controller objects. For example, if BO1 and MO3 on
NAE-1 reference HED controller 1, they are using the same HED controller.

Also see Heavy Equip Delay.

Back to Multistate Output Attributes.

Intrinsic Alarming Defined
Enables the definition of the intrinsic alarm related attributes.

Back to Multistate Output Attributes.

Number of States
Defines the number of states possible for Present Value.

Back to Multistate Output Attributes.

Out of Service
Used to decouple the object from the physical output. When Out of Service is True, the object decouples Present
Value and Reliability from the hardware. The Reliability will be writable when Out Of Service is True. Not all devices
support setting this attribute to True.

Back to Multistate Output Attributes.

Present Value
Indicates the current value of the output as one of n states, where n is the number of states defined in Number of
States.

Back to Multistate Output Attributes.
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Priority Array
Lists object commands in level of importance.

Back to Multistate Output Attributes.

Reliability
Indicates if the Present Value is unreliable and why. When Out of Service is True, the Reliability may be written
directly.

Back to Multistate Output Attributes.

State Text
Represents descriptions of all possible states of Present Value. The number of descriptions matches the number
of states defined in Number of States. Present Value (an integer) serves as an index into this attribute.

Back to Multistate Output Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Multistate Output Attributes.

Status Flags
Contains four true or false flags that indicate the general health of the object. Three of the four flags are associated
with the values of other attributes within the same object. By reading these attributes, you get a clearer picture of
the object status. The four flags are:

In Alarm - In Alarm flag is False (0) if the Event State attribute value is Normal; otherwise, the In Alarm flag is True
(1).

Fault - Fault flag is True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False (0).

Overridden - Overridden flag is Logical 1 if the Present Value is decoupled from the hardware output because
operator intervention provided a different value or local override is active.

Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of Service
flag is False.

Back to Multistate Output Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Multistate Output Attributes.

Multistate Output Commands
The table below lists the commands supported by the Multistate Output Object.

Table 296: Multistate Output Object Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

In Service

The value to be written to the Present Value attribute.Operator Override
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Table 296: Multistate Output Object Commands
ParametersCommand Name

Out of Service

Release Operator Override

1. Attribute name
2. Command priority

Release

Attribute nameRelease All

State0. . . StateN

Note: For the Override Release, Release, and Release All commands, if all Command Priorities have been released
and a Relinquish Default is not defined, the supervisory controller gives control over to the actual hardware.

Multistate Output Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Output Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Output Commands.

In Service
Cancels the effect of an Out of Service command and returns the Out of Service attribute to False. The Present
Value and Reliability will revert back to the values obtained from the physical hardware output.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to Multistate Output Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override (8).

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when one of the following conditions is met: a) NOT Local Control and NOT Out Of Service, or b)
NOT Local Control and after issuing the In Service command.

Back to Multistate Output Commands.

Out of Service
Allows a user to override the object's hardware output for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True. The Present Value and Reliability no longer track the physical output.
No commands are sent to the actual hardware. When the Out of Service attribute is set to False, the current Present
Value is sent to the actual hardware.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

For BACnet objects, support of this command depends on the ability to write the Out Of Service attribute.

Back to Multistate Output Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Multistate Output Commands.
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Release All
Releases Command Priorities 3 through 16 (Default) from the specified, writable attribute. Command Priorities 1
and 2 remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this release happens, the output point goes to its Relinquish Default condition. In some cases,
the application or feature may have sent a command that does not match Relinquish Default. In this
instance, the output point does not end in the state that the applications or features intended. This
situation can cause unexpected operation to occur; for example, a space might overcool or overheat,
a fan might run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to Multistate Output Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Multistate Output Commands.

State0. . . StateN
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. If this is the highest priority, it is sent to the controller. Both the state command names and the
number of commands are dependent on the States Text and Number of States attributes.

Important: Be aware that an operator state command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

If Local Control is True, this command is rejected.

Back to Multistate Output Commands.
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Multistate Value Object
The Multistate Value object’s attributes represent the desired state of one or more physical outputs or processes of
the device in which the object resides. The actual functions associated with a particular state are determined locally
(not part of protocol). Present Value represents the state with a number and State Text associates a description
with each state.

Multistate Value objects have similar software characteristics and capabilities to a Multistate Input Object; however,
Multistate Value objects are not associated with any physical hardware and are the result of a control process or
operator entry.

The Multistate Value object provides a means to map up to 32 different states to an object.

This object allows you to hold a multistate value for other objects to reference. For example, a specific multistate
value can be available for the Interlock object to reference and to base its operation on this value.

For general information on Metasys system objects, see Common Object Attributes.

Multistate Value Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 297: Multistate Value Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial

Value
BACnet
Notes1

Notes1Data TypeAttribute Name

False

True

FalseNot
supported

CTrue or FalseIntrinsic Alarming
Defined

2–324WCW2NumberNumber of States

Always FalseFalseTrue or FalseOut of Service

States Text attribute identifies the value
set for this attribute.

DRWDRWOne value from a
set

Present Value3

Set of valuesPriority Array4

No Fault Detected (Reliable), Multistate
Fault, Unreliable Other

Uses Reliability (Set 503).

ReliableWWOne value from a
set

Reliability5

Set of valuesState Text

CWCWOne value from a
set

States Text

In Alarm, Fault, Overridden, Out of
Service

Uses BAC Status Flags (Set 9).

Series of True or
False states

Status Flags

FalseBCWTrue or FalseUse Remote Alarming

1 C - Configurable, D - Default Attribute for Display, R - Affected by Object’s Reliability, W - Writable
2 Not writable through the MS/TP integration. Must be configured through CCT.
3 If Present Value is commandable, then it must be writable. If Out of Service is True, this attribute is True.
4 If Present Value is commandable, both these attributes are present.
5 The Reliability attribute is always present in NAE implementations.
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Multistate Value Attribute Details
Intrinsic Alarming Defined
Enables the BACnet Intrinsic Alarming feature in the object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Back to Multistate Value Attributes.

Number of States
Defines the number of states possible for Present Value.

Back to Multistate Value Attributes.

Out of Service
Indicates the offline/online state of the connected hardware. This attribute exists for compatibility with BACnet protocol
and indicates whether the physical input that the object represents is in service. When out of service, the object
does not read the hardware. This attribute is always False.

Back to Multistate Value Attributes.

Present Value
Reflects the current value of the multistate value object as one of n states, where n is the number of states defined
in the Number of States attribute. The Present Value is equal to the last value corresponding to the States Text
attribute. Present Value is optionally commandable. If Present Value is commandable for a given object instance,
then Priority Array and Relinquish Default are also present for that instance. If Out of Service is true, Present Value
is writable.

Back to Multistate Value Attributes.

Priority Array
Contains prioritized commands that are in effect for this object. See the BACnet standard for a description of the
prioritization mechanism. If either Priority Array or Relinquish Default is present, both are present. If Present Value
is commandable, Priority Array and Relinquish Default are both present.

Back to Multistate Value Attributes.

Reliability
Indicates whether the Present Value is reliable and why. If Fault Values is present, Reliability is also present. A To
Fault event generates under these conditions: Reliability is not equal to No Fault Detected, and the To Fault flag is
enabled in Event Enable.

Back to Multistate Value Attributes.

State Text
Represents descriptions of all possible states of Present Value. The number of descriptions matches the number
of states defined in Number of States. Present Value (an integer) serves as an index into this attribute.

Back to Multistate Value Attributes.

States Text
Indicates the displayed strings for the Present Value.

Back to Multistate Value Attributes.

Status Flags
Contains four true or false flags that indicate the general health of the object. Three of the four flags are associated
with the values of other attributes within the same object. By reading these attributes, you get a clearer picture of
the object status.
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The four flags are:

• In Alarm - In Alarm flag is False (0) if the Event State attribute value is Normal; otherwise, the In Alarm flag is
True (1).

• Fault - Fault flag is True (1) if the Reliability attribute is not reliable; otherwise, the Fault flag is False (0).
• Overridden - Overridden flag is Logical 1 if the Present Value has been overridden by some mechanism local

to the BACnet device or because the operator provided a different value.
• Out of Service - Out of Service flag is True if the Out of Service attribute value is True; otherwise, the Out of

Service flag is False.

Back to Multistate Value Attributes.

Use Remote Alarming
When the attribute Intrinsic Alarming Defined is set to True, determines where alarms for the object originate. If the
remote integrated object contains attributes for originating alarms, then Use Remote Alarming defaults to True,
causing the local mapper object to accept alarms from the remote integrated object that are routed to the NxE. If
the remote integrated object does not contain attributes for originating alarms, then Use Remote Alarming defaults
to False causing the local mapper object to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use Remote Alarming is changed, a restart of
the NxE may be required to assure correct operation. This attribute applies only to BACnet integrations.

Back to Multistate Value Attributes.

Multistate Value Commands
The table below lists the commands supported by the Multistate Value Object.

Table 298: Multistate Value Object Commands
ParametersCommand Name

Disable Alarms

Enable Alarms

State0–StateNOperator Override

Release Operator Override

1. Attribute name
2. Command priority

Release

Attribute nameRelease All

State0 . . . StateN1

1 The MS/TP Multistate Value supports an equivalent Set State command which takes State0-StateN as parameters.

Multistate Value Command Details
Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Value Commands.

Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to Multistate Value Commands.

Operator Override
Updates the Present Value at Command Priority Operator Override (8).

551Metasys System Online Help PDF



The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when one of the following conditions is met: a) NOT Local Control and NOT Out Of Service, or b)
NOT Local Control and after issuing the In Service command.

Back to Multistate Value Commands.

Release
Releases the identified command priority from the specified, writable attribute, and allows it to be controlled by the
next highest priority.

Back to Multistate Value Commands.

Release All
Releases Command Priorities 3 through 15 from the specified, writable attribute. Command Priorities 1 (Manual
Emergency) and 2 (Fire Application) remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to Multistate Value Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Present Value.

Back to Multistate Value Commands.

State0 . . . StateN
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Present Value at the Default (16)
command priority. The state command names and number of commands are dependent on the States Text and
Number of States attributes.

Important: Be aware that an operator state command releases the actions of any processes running to the object
in the NxE or FEC controllers that use Priorities 9 through 16. Consider this behavior when creating
control strategies.

Back to Multistate Value Commands.
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N1 Migration Object
Note: This object is for use with the NIE only. For more information on N1 migration, see the Related

Documentation table in the Welcome section.

The N1 Migration object contains all the necessary information to communicate with points on an existing Metasys
network. Add the new Metasys system hosting the migration server to the existing Metasys network as an Operator
Workstation (OWS) at a fixed IP Address. All existing Metasys networks are defined as N1 Migration objects in the
host NIE. Many of the existing point objects are defined as mapped devices to the NIE.

For general information on Metasys system objects, see the Object Help section.

N1 Migration Concepts
Migration Overview
When you add a new Metasys system N1 Migration object, the N1 migration component establishes communication
with the N1 network. The N1 Migration object is only an object on the new Metasys system controller to which it was
added.

After the N1 Migration object establishes communication with the existing Metasys system, the N1 Migration object
creates 2 new calendars that are a portal to the existing NCM calendar. (See Today’s Schedule in the Scheduling
section.) One calendar is a list of alternates, and one calendar is a list of holidays.

Note: An Ethernet connection is the only method for the NIE to connect to the N1 network. ARCnet jobs must use
an Ethernet router.

See the N1 Migration Attributes section for more information on N1 migration attributes.

Mapped Points
Existing features of the Metasys system are supported by moving their functionality to the host NIE. These features
are: trend, totalization, point history, and scheduling. When possible, existing objects maintain their configuration
parameters in the new Metasys system. For example, alarm limits, alarm state, and units. The table below lists points
specific to the Metasys system.

Table 299: Mapped Points
New Metasys System Mapped ObjectExisting Metasys System Object
N1 Pulse Counter ObjectAccumulator Object

Analog Input ObjectAnalog Input

Analog Output ObjectAnalog Output

Analog Output ObjectAnalog Data

Binary Input ObjectBinary Input

Binary Output ObjectBinary Output

Binary Output ObjectBinary Data

Generic Integration Object (GIO)Control System

Multistate Input ObjectMultistate Input

Multistate Output ObjectMultistate Output

Multistate Output ObjectMultistate Data

Multiple NIEs
Migration can be split across multiple NIEs with the following constraints:

• Only one N1 Migration object can exist per NIE per N1 network.
• Multiple NIEs can reference the same N1 network.
• Only one NCM object can exist per NCM per N1 Migration object.
• Multiple NCM objects can reference the same NCM as long as they exist on different NIEs.
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• Only one point object can exist per NIE per N1 object.
• Multiple point objects can reference the same N1 object as long as they exist on different NIEs.

N1 Migration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 300: N1 Migration Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

255.255.255.255CWList of 4 valuesBroadcast Address

0 = not connected (offline)

1 = connected (normal)

0NumberConnected Status

8 characters maxNULLCWTextDevice Name

0.0.0.0CWSet of valuesDiscovery IP Address

1CWNumberDiscovery Gate
Number

1CWNumberDiscovery Node
Number

FalseCWNumberDuty-Standby

FalseCWTrue or FalseEnable Polling

1–255100CWNumberGate Number

Seconds60CWNumberMessage Timeout

TrueCWTrue or FalseMigrate Object
Configuration

TrueCWTrue or FalseMigrate Schedules

TrueCWTrue or FalseMigrate Totalization
Configuration

TrueCWTrue or FalseMigrate Trend
Configuration

8 characters maximumNULLCTextNetwork Name

1–255100CWNumberNode Number

Milliseconds1000CWNumberPoll Delay

4CWNumberRetryCounterLimit

Seconds4CWNumberRetryWaitTime

FalseCWTrue or FalseSynchronize Time

11001CWNumberUDP Port

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

N1 Migration Attribute Details
Broadcast Address
Edits the address to use directed broadcasts. The user typically does not edit this attribute.

Back to N1 Migration Attributes.
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Connected Status
Displays if the NIE communicated with the Metasys N1 network for the object mapping service and UI service. This
attribute drives the status of the object.

Back to N1 Migration Attributes.

Device Name
Displays the defined case-insensitive device name. The device name is required for the existing Metasys system
to detect the On-Line status and Off-Line status of the NIE. This attribute must match the name of the NIE in the
existing N1 network.

Back to N1 Migration Attributes.

Discovery IP Address
Displays the defined NCM IP address of the existing Metasys system. Use for self discovery of the existing Metasys
system. You need at least 1 NCM in the existing N1 network that the NIE can talk to, to find the other N1 devices
and get N1 points.

Back to N1 Migration Attributes.

Discovery Gate Number
Displays the defined NCM Gate address on the existing Metasys system. Use for self discovery of the existing
Metasys system. You need at least 1 NCM in the existing N1 network that the NIE can talk to, to find the other N1
devices and get N1 points.

Back to N1 Migration Attributes.

Discovery Node Number
Displays the defined NCM Node address on the existing Metasys system. Use for self discovery of the existing
Metasys system. You need at least 1 NCM in the existing N1 network that the NIE can talk to, to find the other N1
devices and get N1 points.

Back to N1 Migration Attributes.

Duty-Standby
Displays whether the existing Metasys system is a Duty/Standby network. The NIE has to know if the existing N1
network is a Duty/Standby.

Back to N1 Migration Attributes.

Enable Polling
When True, this attribute causes the integration in the NIE to place any system into a 20 second fast polling table
being viewed. This attribute also places a system into this table on an object’s Focus view. This provides faster
updates to objects being viewed in any Metasys system UI. When viewing points from several systems, the Service
Time for the NCM increases. Take care when enabling this fast polling feature as it may affect the service times.

Note: To prevent delays in event reporting due to the fast scan operation, follow the existing report routing guidelines.

Note: Do not set this attribute to True when for NIEs used with validated environments (that is, when Trend data
must be collected within 2 minutes).

Back to N1 Migration Attributes.

Gate Number
Displays how the NIE is defined in the existing N1 network. This attribute is read from the NCM.

Back to N1 Migration Attributes.

Message Timeout
Displays the reply timeout in seconds. The reply timeout is how long the NIE waits for a reply from an NCM. The
user typically does not edit this attribute.

Back to N1 Migration Attributes.
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Migrate Object Configuration
When True, this attribute displays the basic object configuration from the existing Metasys system object used to
write basic configurations for newer Metasys objects. For example, units or descriptor. This attribute (when True)
tells the new Metasys system to bring alarm setup information from the existing N1 network and creates Alarm
Extensions (Analog Alarm and Multistate Alarm) for new objects that are added.

Back to N1 Migration Attributes.

Migrate Schedules
Displays the attached existing Metasys system schedules used to create the newer Metasys system Schedule. The
schedules that appear in the new Metasys systems are portals to the schedules in the existing N1 network. Schedules
appear in the new format and offer the same functionality. Changes made to the schedules in the new Metasys
system are also made to the N1 schedules in the NCM.

Back to N1 Migration Attributes.

Migrate Totalization Configuration
Displays the totalization configuration from the existing Metasys system object used to create the newer Metasys
system Totalization Extensions when an existing object is mapped to a newer object.

Back to N1 Migration Attributes.

Migrate Trend Configuration
Displays the trend configuration from the existing Metasys system object used to create the newer Metasys system
Trend Extension when an existing object is mapped to a newer object. This attribute creates one or more trend
extensions for existing N1 network trends.

Back to N1 Migration Attributes.

Network Name
Displays the defined network name.

Note: Be sure to configure the Network Name attribute of the N1 Migration. Once you insert the N1 Migration, you
cannot edit the Network Name attribute. The workaround is to delete the existing N1 Migration and insert a
new N1 Migration ensuring you enter the desired Network Name before completing the Insert Integration
Wizard.

Back to N1 Migration Attributes.

Node Number
Displays how the NIE is defined in the existing N1 network.

Back to N1 Migration Attributes.

Poll Delay
Displays the polling time for non-triggerable attributes in milliseconds. The poll delay is the time between NIE polls
to the N1 network points.

Back to N1 Migration Attributes.

RetryCounterLimit
Contains the number of retry attempts made. The NIE waits for the Message Timeout, then retries sending messages
the number of times defined in this attribute.

Back to N1 Migration Attributes.

RetryWaitTime
Contains the time between communication retries (in seconds). This attribute is the time the NIE waits for a low-level
Ack from the NCM. The user typically does not edit this attribute.

Back to N1 Migration Attributes.
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Synchronize Time
Displays whether the NIE is the master time keeper for the existing N1 network system. Time updates are sent to
the existing system once daily and when the time changes.

Back to N1 Migration Attributes.

UDP Port
Displays the UDP Port as defined in the existing Metasys system.

Back to N1 Migration Attributes.
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N1 PID Loop Object
The N1 PID Loop (PIDL) object generates outputs to maintain a measured value at a desired level. The PIDL performs
Proportional, Integral, and Derivative control. The PID Loop object manipulates outputs for closed loop control at a
given Digital Control Module (DCM101 or DCM140).

Note: For the PIDL object, the only difference between DCM101 and DCM140 operation is that the DCM101 has
up to 16 PID Loops, and the DCM140 has up to 20 PID Loops.

The PID Loop object generates outputs for closed loop control by using a collection of inputs and other variables to
perform calculations and issue commands. Each PID Loop object can accept up to six analog inputs, and issue
commands to a maximum of eight analog outputs. Inputs come from Active Interconnect (AI) objects. Outputs are
sent to Analog Output Digital object (AOD) objects or other PID Loops.

A primary function of the PID Loop object is to perform Proportional plus Integral plus Derivative calculations in order
to maintain steady and accurate control of a closed loop. PID calculations take into account the past, present, and
future (forecasted) performance of loop inputs for the purpose of adjusting outputs to correct levels. You can configure
the PID Loop object to compute any or all of the following:

• Proportional Only: Present performance is analyzed by computing the difference between the PID Loop setpoint
and its feedback. This difference is called an error. With proportional control, the output signal is directly
proportional to the difference between the input and the setpoint (that is, the error).

• Proportional plus Integral: Present and past performance are analyzed in this calculation to affect the output.
The error computed in the proportional calculation is now integrated (that is, accumulated over time). If the loop
failed to reach setpoint in the past, the integration causes the output to increase or decrease to maintain setpoint.

• Proportional plus Integral plus Derivative: This calculation uses past, present, and future (forecasted)
performance. The derivative part of the computation analyzes the rate of change of the feedback to predict the
future value of the feedback. As the feedback changes faster, the PID Loop issues outputs that slow down the
rate of change.

You can use the PID Loop object with a variety of control schemes, including sequencing a number of physical
devices to maintain control of a closed loop. Additional functions of the PID Loop object include Self-tuning PID
Control, bumpless transfer, and an auxiliary switch. Self-tuning PID Control automatically and continually self-tunes
the PID Loop to ensure correct feedback levels. The auxiliary switch allows another PID Loop object or a control
process to take control of the closed loop. When control of a closed loop is turned over to the PID Loop object, the
bumpless transfer function provides for a smooth and predictable transition.

For general information on Metasys system objects, see the Object Help section.

N1 PID Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 301: N1 PID Loop Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Any value > 00.1CWReal valueCOV Increment

20 Character LimitCNWTextDevice Type

10thsCWOne from a setDisplay Precision

Real valueFeedback

1.7E38CWReal valueMax Value

-1.7E38CWReal valueMin Value
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Table 301: N1 PID Loop Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

CWTrue or FalseOut of Service

DNRWReal valuePresent Value (Value)

No Fault Detected (Reliable), Open Loop, Shorted
Loop, No Output, Unreliable Other

0WOne value from a
set

Reliability

Real valueSetpoint

No unitsCWOne type from a
set

Units

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable

N1 PID Loop Attribute Details
COV Increment
Defines the minimum change in the Present Value required for the object to report a change.

Back to N1 PID Loop Attributes.

Device Type
Contains a description of the physical device connected to the object.

Back to N1 PID Loop Attributes.

Display Precision
Defines the decimal rounding and the decimal places to display for the Present Value and associated attributes.

Back to N1 PID Loop Attributes.

Feedback
Indicates the Feedback value, which results from the PIDL Input Conditioning process. This process scales each of
the six PIDL inputs and determines a sum, a maximum, or a minimum.

Back to N1 PID Loop Attributes.

Max Value
Defines the highest reliable value (in engineering units) for the Present Value.

Back to N1 PID Loop Attributes.

Min Value
Defines the lowest reliable value (in engineering units) for the Present Value.

Back to N1 PID Loop Attributes.

Out of Service
De-couples the object from the physical input. When Out of Service is True, the object de-couples the Setpoint and
Reliability from the hardware. The Reliability is writable when Out Of Service is True. When de-coupled, the Setpoint
can be changed to simulate specific conditions or for test purposes.

Back to N1 PID Loop Attributes.

Present Value (Value)
Represents the current value of the object.

Back to N1 PID Loop Attributes.

Reliability
Indicates whether the Setpoint is unreliable.

559Metasys System Online Help PDF



Examples:

• Reliable - No detectable faults
• Unreliable High - Setpoint is greater than the Max Value.
• Unreliable Low - Setpoint is less than the Min Value.

When Out of Service is True, the Reliability attribute may be written directly.

Back to N1 PID Loop Attributes.

Setpoint
Indicates the desired value for the control loop feedback signal.

Back to N1 PID Loop Attributes.

Units
Contains the engineering units for the Present Value attribute.

Back to N1 PID Loop Attributes.

N1 PID Loop Commands
The following table lists the commands supported by the N1 PID Loop Object.

Table 302: N1 PID Loop Object Commands
ParametersCommand Name
The value to be written to the Setpoint. The value must be less than Max
Value and greater than Min Value.

Adjust

Disable Alarms

Enable Alarms

In Service

The value to be written to the Setpoint.Operator Override

Out of Service

Release Operator Override1

Attribute name

Command priority
Release1

Attribute nameRelease All1

1 For the Release Operator Override, Release, and Release All commands, if all Command Priorities have been released and
a Relinquish Default is not defined, the supervisory controller gives control to the actual hardware.

N1 PID Loop Command Details
Adjust
Releases Command Priorities 9 through 15 (Scheduling) and then writes to the Setpoint at the Default (16) command
priority. The value must be less than Max Value and greater than Min Value.

If Local Control is True, this command is rejected.

The command is only sent when one of the following conditions is met: a) NOT Local Control and NOT Out Of
Service, or b) NOT Local Control and after issuing the In Service command.

Back to N1 PID Loop Commands.

Disable Alarms
Disables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to N1 PID Loop Commands.
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Enable Alarms
Enables all types of alarming: alarm extensions, BACnet intrinsic alarming, and BACnet Event Enrollment objects.

Back to N1 PID Loop Commands.

In Service
Cancels the effect of an Out of Service command and returns the Out of Service attribute to False. The Setpoint
and Reliability revert back to the values obtained from the physical hardware output.

Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to N1 PID Loop Commands.

Operator Override
Updates the Setpoint at Command Priority Operator Override (8).

The Operator Override command sends the specified command to the internal NxE object, which is then only sent
to the field device when not Out Of Service.

Back to N1 PID Loop Commands.

Out of Service
Allows a user to override the object's hardware output for simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True. The Setpoint and Reliability no longer track the physical output. No
commands are sent to the actual hardware. When the Out of Service attribute is set to False, the current Setpoint
is sent to the actual hardware.

When an Out Of Service command is issued, the NxE does not communicate subsequent changes (operator or
system) to the field device.

For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Back to N1 PID Loop Commands.

Release Operator Override
Releases Command Priority Operator Override (8) from Setpoint.

Back to N1 PID Loop Commands.

Release
Releases the identified Command Priority from the specified attribute and allows the next highest priority to control
it.

Back to N1 PID Loop Commands.

Release All
Releases Command Priorities 3 through 16 (Default), from the specified, writable attribute. Command Priorities 1
and 2 remain.

Important: The Release All command may not cause an immediate return to automatic operation. The Release
All command clears all command priorities, including those that come from applications and features.
When this happens, the output point goes to its Relinquish Default condition. In some cases, the
application or feature may have sent a command that does not match Relinquish Default. In this instance,
the output point does not end in the state that the applications or features intended. This situation can
cause unexpected operation to occur; for example, a space could overcool or overheat, a fan might
run longer than expected, and so on.
If an operator has overridden an input, use the Release Operator Override command.

Back to N1 PID Loop Commands.
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N1 Pulse Counter Object
The N1 Pulse Counter object aids in the integration of N1 controllers with supervisory controllers, resulting in:

• consistent interface to N1 point objects for all controller types, so they appear as a homogenous set to the user
interface

• flexibility in point mapping

This object allows you to read pulses from an electric or gas meter at a supervisory controller.

Note: The Pulse Counter object may feed its Present Value to the Pulse Meter Object.

For general information on Metasys system objects, see the Object Help section.

N1 Pulse Counter Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 303: N1 Pulse Counter Object Attributes - Focus/Configuration
Values/Options/RangeInitial ValueNotes1Data TypeTab

Attribute Name
0–4,294,967,295DRWNumberPresent Value

Uses Reliability (Set 503).One value from a
set

Reliability

1 C - Configurable, D - Default Attribute for Display, R - Affected by Object’s Reliability, W - Writable

N1 Pulse Counter Attribute Details
Present Value
Actual value of the Pulse Count the last time it was read.

Back to N1 Pulse Counter Attributes.

Reliability
Indicates whether the Present Value is reliable and why.

Back to N1 Pulse Counter Attributes.

N1 Pulse Counter Commands
The following table lists the commands supported by the N1 Pulse Counter Object.

Table 304: N1 Pulse Counter Object Commands
ParametersCommand Name

Preset Counter

Enable Alarms

Disable Alarms

N1 Pulse Counter Command Details
Preset Counter
Defines a preset value in the counter. This command is available only if you have the Supervise Access level
command priority.

Back to N1 Pulse Counter Commands.
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Enable Alarms
Enables alarms for the N1 pulse counter.

Back to N1 Pulse Counter Commands.

Disable Alarms
Disables alarms for the N1 pulse counter.

Back to N1 Pulse Counter Commands.
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N2 Controller Object
The N2 Controller object defines a physical device such as a DX-9100, VAV Modular Assembly (VMA), or UNT
controller on the N2 Bus of the NAE and is required for mapping data from the controller into the system. The N2
Controller object monitors the device and reports online/offline transitions. This object also allows you to access
information about the N2 controllers.

For general information on Metasys system objects, see the Object Help section.

N2 Controller Concepts
Supported Controllers
This table lists all N2 controllers supported by the system.

Metasys Integrator units, VAV, UNT, and AHU controllers are supported at all revision levels.

Table 305: Supported Controllers
CommentsProtocol TypeRevisionDevice/ Controller

Type
Room ControllerSys91Rev 1.x - 2.xDR-9100

Room ControllerSys91Rev 2.xDR-9101

Plant ControllerSys91Rev 1.x - 2.xDC-9100

Digital OptimizerSys91Rev 1.xDO-9100

Digital ControllerSys91Rev 1.xDX-9100 (V.1)

Digital ControllerSys91Rev 2.xDX-9100 (V.2)

Temperature ControllerSys91Rev 1.x - 3.xTC-9100

TC-9102

TC-9109

Extension ModuleSys91Rev 1.xXT-9100

Extension ModuleSys91Rev 1.xXTM-101

Extension ModuleSys91Rev 1.xXTM-105

Extension ModuleSys91Rev 1.xXTM-905

Lab and Central Plant ControllerSys91Revs allLCP-100

Metasys Integrator UnitN2 OpenRevs allMetasys Integrator Unit

Unitary ControllerN2 OpenRevs allUNT

Variable Air Volume ControllerN2 OpenRevs allVAV

Air Handling Unit ControllerN2 OpenRevs allAHU

Phoenix Interface ModuleN2 OpenRevs allPHX

VAV Modular AssemblyN2BRevs allVMA (VMA14)

Metasys Compatible Vendor Devices (by others)N2 OpenVND

Intelligent Lighting ControllerN2 OtherILC

N2 Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 306: N2 Controller Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Object Type = GraphicNullCNWObject ReferenceGraphic

Maximum 256 charactersCWTextGraphic Alias

Offline (True), Online (False)True or FalseOffline

Offline, Online, Pass Through, Comm Disabled,
Comm Enabled

DOne value from a setPresent Value

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

N2 Controller Attribute Details
Graphic
Indicates the graphic associated with the N2 controller.

Back to N2 Controller Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this N2
controller.

Back to N2 Controller Attributes.

Offline
Indicates if the NAE is or is not currently communicating with this N2 controller.

Back to N2 Controller Attributes.

Present Value
Represents the current communication state of the object.

Back to N2 Controller Attributes.

N2 Controller Commands
The table below lists the commands supported by the N2 Controller Object.

Table 307: N2 Controller Commands
Number of ParametersCommand Name
0Disable

0Enable

N2 Controller Command Details
Disable
Puts the controller offline and leaves it offline (Comm. Disabled).

Back to N2 Controller Commands.

Enable
Brings the controller from the offline state to the online state (Comm. Enabled).

Back to N2 Controller Commands.
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N2 Master Datalink Object (N2 Trunk)
The N2 Master Datalink object creates the communication link between the N2 controllers and the supervisory
controller. The N2 Master Datalink object is the root for all N2 objects in the Metasys system. When you add an N2
Trunk to an engine, you establish communication with the specific N2 controller network. The N2 Master Datalink
object offers diagnostic data related to the N2 controller network. This object allows you to see N2 Bus communication
statistics.

Note: The Object Type for this object is labelled N2 Trunk in the software.

For general information on Metasys system objects, see the Object Help section.

N2 Master Datalink (N2 Trunk) Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 308: N2 Master Datalink Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1,2Data TypeAttribute Name

0NumberBuffer Overflows

0–4,294,967,295NumberChecksum Errors

NumberCommand Count

0–65,535NumberCount

0–4,294,967,295NumberCOV-COS Count

0NumberData CRC Errors

0NumberFraming Errors

0NumberHardware Overflows

0–65,535

Seconds

NumberHP Point Scan Time

0–65,535

Seconds

NumberLP Point Scan Time

0–4,294,967,295NumberMessage Receives

0–4,294,967,295NumberMessage Transmits

0–4,294,967,295NumberNAK Errors

0–4,294,967,295NumberOffline Occurrences

0–4,294,967,295NumberOffline Polls

0–4,294,967,295NumberOnline Polls

0NumberParity Errors

0–65,535

Seconds

NumberPoll Scan Time

DateReset Date

TimeReset Time

0–4,294,967,295NumberRetry Attempts

65,535NumberTransmits Per Minute

0–4,294,967,295NumberVMA BAC Errors
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Table 308: N2 Master Datalink Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1,2Data TypeAttribute Name

0–4,294,967,295NumberVMA COV Errors

0–4,294,967,295NumberVMA FMT Errors

1 W - Writable
2 The writable attributes in the N2 Master Datalink object are writable only if the UDP Port attribute is not zero. If the UDP Port

attribute is zero and you attempt to write these attributes, an error message appears.

N2 Master Datalink Attribute Details
Buffer Overflows
Indicates the number of input buffer overflows.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Checksum Errors
Indicates the number of checksum errors.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Command Count
Indicates the number of N2 user or process commands.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Count
Specifies the number of N2 point objects defined for this trunk.

Back to N2 Master Datalink (N2 Trunk) Attributes.

COV-COS Count
Indicates the number of Changes of Value/Changes-of-State since the last reset.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Data CRC Errors
Indicates the number of System 9100 checksum errors.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Framing Errors
Indicates the number of UART framing errors.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Hardware Overflows
Indicates the number of UART hardware overruns.

Back to N2 Master Datalink (N2 Trunk) Attributes.

HP Point Scan Time
Indicates the calculated number of seconds the N2 master takes to scan high priority N2 point objects, such as
those used in alarming and interlocks.

Back to N2 Master Datalink (N2 Trunk) Attributes.

LP Point Scan Time
Indicates the calculated number of seconds the N2 master takes to scan low priority N2 point objects (all N2 point
objects that do not fall in the high priority category).

Back to N2 Master Datalink (N2 Trunk) Attributes.

Message Receives
Indicates the number of messages received from the N2 controllers.
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Back to N2 Master Datalink (N2 Trunk) Attributes.

Message Transmits
Indicates the number of message transmissions to the N2 controllers.

Back to N2 Master Datalink (N2 Trunk) Attributes.

NAK Errors
Indicates the number of negative acknowledge errors. A NAK is returned by an N2 device to indicate that it received
and decoded a command correctly, but the command did not make sense or could not be carried out. An example
of a NAK is an attempt to read an Analog Input beyond the range of the device.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Offline Occurrences
Indicates the number of offline occurrences by the N2 controllers.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Offline Polls
Indicates the number of offline polls to the N2 devices.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Online Polls
Indicates the number of online polls to the N2 devices.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Parity Errors
Indicates the number of messages that contain invalid hexadecimal characters (hexadecimal characters are 1-9 and
A-F).

Back to N2 Master Datalink (N2 Trunk) Attributes.

Poll Scan Time
Indicates the calculated number of seconds the N2 master takes to poll all defined N2 devices.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Reset Date
Indicates the date of the Clear Statistics command.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Reset Time
Indicates the time of the Clear Statistics command.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Retry Attempts
Indicates the number of message retry attempts.

Back to N2 Master Datalink (N2 Trunk) Attributes.

Transmits Per Minute
Indicates the calculated number of message transmissions per minute.

Back to N2 Master Datalink (N2 Trunk) Attributes.

VMA BAC Errors
Indicates the number of VMA BACnet errors

Back to N2 Master Datalink (N2 Trunk) Attributes.
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VMA COV Errors
Indicates the number of VMA Change-of-Value errors.

Back to N2 Master Datalink (N2 Trunk) Attributes.

VMA FMT Errors
Indicates the number of VMA Format errors.

Back to N2 Master Datalink (N2 Trunk) Attributes.

N2 Master Datalink (N2 Trunk) Commands
The table below lists the commands supported by the N2 Master Datalink Object (N2 Trunk).

Table 309: N2 Master Datalink Object Commands
ParametersCommand Name

Clear Statistics

Latch Statistics

N2 Master Datalink Command Details
Clear Statistics
Allows the user to clear the N2 statistics.

Back to N2 Master Datalink (N2 Trunk) Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to N2 Master Datalink (N2 Trunk) Commands.
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NCM Object
Create NCM objects by adding NCMs to the system Navigation Tree. The attributes of the NCM object are read
from the NCM device. The NCM object attributes update periodically based on the poll delay attribute of the parent
N1 Migration Object. The NCM object can only be a child object to the N1 Migration object. Add more NCM objects
with the Insert Field Device Wizard.

For general information on Metasys system objects, see Common Object Attributes.

NCM Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 310: NCM Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

NumberGate Number

Object Type = GraphicNullCNWObject ReferenceGraphic

Maximum 256 charactersCWTextGraphic Alias

TextIP Address

8 characters maximumCTextNCM Name

NumberNode Number

True or FalseOffline

Milliseconds0CWNumberPoll Delay

1 C - Configurable, W - Writable

Table 311: NCM Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Device Status

NumberMessage Errors

NumberMessage Receives

NumberMessage Transmits

Object Count

True or FalseOffline

Service Time

1 C - Configurable, W - Writable

NCM Attribute Details
Device Status
Displays Discovery in Progress when the N1 migration is currently reading trend, totalization, schedule, or object
configuration data for at least one mapped object within the NCM. If this attribute value is Discovery Complete,
these operations are complete.

Back to NCM Attributes.
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Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to NCM Attributes.

Gate Number
Displays how the NIE is defined in the existing N1 network. This attribute is read from the NCM.

Back to NCM Attributes.

Graphic
Indicates the graphic associated with the NCM.

Back to NCM Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this NCM.

Back to NCM Attributes.

IP Address
Displays the IP address of the NCM as read from the NCM itself.

Back to NCM Attributes.

Message Errors
Displays the number of error messages in the NCM as read from the NCM itself. The number of error messages
matches the N1 statistics in the NCM. The error message count is cleared by the Clear Statistics command.

Back to NCM Attributes.

Message Receives
Displays number of messages received as read from the NCM itself. The number of error messages matches the
N1 statistics in the NCM. The error message count is cleared by the Clear Statistics command.

Back to NCM Attributes.

Message Transmits
Displays the number of messages transmitted. The number of error messages matches the N1 statistics in the NCM.
The error message count is cleared by the Clear Statistics command.

Back to NCM Attributes.

NCM Name
Represents the defined name of the NCM as it appears in the existing N1 network.

Back to NCM Attributes.

Network Name
Displays the defined network name.

Back to NCM Attributes.

Node Number
Displays how the NIE is defined in the existing N1 network.

Back to NCM Attributes.

Object Count
Counts the mapped objects within the NIE for this NCM. This count includes (NCM) AI, AO, Analog Data (AD), BI,
BO, Binary Data (BD), Metasys System Integrator (MSI), Multistate Object Output (MSO), Message Storage Device
(MSD), Control System (CS), Annunciator Control Module (ACM) objects.
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Back to NCM Attributes.

Offline
Displays True if the NCM is offline. If this attribute is true, the NIE cannot talk with the NCM.

Back to NCM Attributes.

Poll Delay
Displays the polling time for non-triggerable attributes in milliseconds. The poll delay is the time between NIE polls
to the N1 network points.

Back to NCM Attributes.

Service Time
Displays the amount of time in seconds that it takes for the NIE to poll the NCM for all mapped objects within the
NCM.

Back to NCM Attributes.

NCM Commands
The table below lists the command specific to the NCM Object.

Table 312: NCM Object Commands
Number of ParametersCommand Name
0Clear Statistics

NCM Commands Details
Clear Statistics
Resets the statistics at the NCM. The Message Errors, Message Receives, and Message Transmits attributes
reflect these statistics.

Back to NCM Commands.
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Notification Class Object
The Notification Class object provides a means to send alarm messages (Event Notification Messages) that are
generated by other objects to any BACnet device. Typically, it is used to route alarm messages to third-party BACnet
devices. Notification Classes are useful for event-initiating objects that have identical needs in terms of how their
notifications should be handled, what the destinations for their notifications should be, and how they should be
acknowledged.

For general information on Metasys system objects, see Common Object Attributes.

For more information about the wizard used to insert a Notification Class object, see Insert Object - Notification.

Notification Class Concepts
Notification Class
A notification class defines how event notifications are prioritized according To Offnormal, To Fault, and To Normal
events; whether these categories of events require acknowledgement (nearly always, by a human operator); and
what destination devices or processes receive notifications.

Prioritization
Prioritization provides a means to ensure that alarms or event notifications with critical time considerations are not
unnecessarily delayed. Priorities may be assigned To Offnormal, To Fault, and To Normal events individually within
a notification class.

Acknowledgement
Acknowledgement provides assurance that a notification has been acted upon by some other agent, rather than
received correctly by another device. In most cases, acknowledgements come from human operators. To Offnormal,
To Fault, and To Normal events may, or may not, require individual acknowledgement within a notification class.

Destinations
You can send event notifications to multiple destinations or to different destinations based on the time of day or day
of week. Notification Classes specify a list of destinations, each of which is qualified by time, day of week, and type
of handling. The Recipient List attribute describes how the destination parameters relate to the Notification Class
object. If an event that uses a Notification Class object occurs, the day is one of the days of the week that is valid
for a given destination, and the time is within the window specified in the destination, then a notification is sent to
the destination defined in the Recipient List. You can qualify destinations by any combination of the three event
transitions: To Offnormal, To Fault, and To Normal.

The destination also defines the recipient device that receives the notification. The recipient device is specified by
either its unique Device Object Identifier or by its Network Address and MAC Address. In the latter case, a unicast
address or a broadcast, local/remote, or global address is used. The destination information specifies whether the
notification is sent using a confirmed or unconfirmed event notification.

The Ack Required attribute of the Notification Class object and the type of event transition determine whether the
event notification message requires acknowledgement.

Notification Class Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 313: Notification Class Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

To Offnormal

To Fault

To Normal

Uses BAC Event Bits (Set 525).

False,

False,

False

WCWSeries of True
and False
states

Ack Required

0–4,294,967,295NumberNotification Class

To Offnormal

To Normal

To Fault

Range = 0–255

120

200

70

WCWList of numbersPriority

True, FalseTrueNot supportedCWTrue or FalseRoute to Metasys

True, FalseTrueNot supportedCWTrue or FalseSendNotifications
to Supervisor

1 C - Configurable, W - Writable

Table 314: Notification Class Object Attributes - Recipient List Tab
Values/Options/RangeInitial ValueBACnet

Notes1
Notes1Data TypeAttribute Name

See Recipient List.

Uses BAC Day Bitset (Set 176), Recipient
Choice (Set 526), and BAC Event Bits (Set
525).

WCWList of value
sets

Recipient List

1 C - Configurable, W - Writable

Notification Class Attribute Details
Ack Required
Conveys three separate flags that represent whether acknowledgement is required in notifications generated for To
Offnormal, To Fault, and To Normal event transitions, respectively.

Back to Notification Class Attributes.

Notification Class
Indicates the numeric value of this notification class and equals the instance number of the Notification Class object.
Event initiating objects use this number to reference a specific Notification Class object.

Back to Notification Class Attributes.

Priority
Conveys the priority to be used for event notifications for To Offnormal, To Fault, and To Normal events, respectively.
A lower number indicates a higher priority.

Back to Notification Class Attributes.
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Recipient List
Conveys a list of one or more recipient destinations to which notifications are sent when event-initiating objects using
this class detect the occurrence of an event. Each destination structure contains the following:

• From Time, To Time (Start and Stop Times) - The window of time (inclusive) during which the destination
may be used. To specify all times, use 00:00:00 for Start Time and 23:59:59 for Stop Time.

• IP Address - The 4 byte IP Address of the destination if routing by IP address. This value is ignored when
Network Number is set to 65,535. When set to 255.255.255.255 IP Address or the broadcast IP Address,
notifications are broadcast based on the Network Number. A value of 0 sends a local broadcast. A value of
1–65,534 sends a remote broadcast.

• IssueConfirmedNotifications (Confirmed, Unconfirmed) - Indicates whether to send Confirmed or Unconfirmed
event notifications via radio button selection. This selection is ignored when using global broadcast notifications.

• MSTP Address - The MS/TP address of the destination if routing by MS/TP address.
• Network Number - The network number for the destination if routing by IP or MS/TP address:

- 0 designates the address of the local network
- 1–65,534 identifies a destination address on the specified network
- 65,535 specifies the use of global broadcast notification (note that the IP Address is not used and the

notifications are unconfirmed)
• Process Identifier - The process ID within the recipient device that receives the event notification messages.
• Recipient (Device Object ID) - The destination devices to receive event notification messages.
• Recipient Choice (Object ID or Address) - The choice of whether to use an Object Identifier or the Address

of the destination to route the notifications. If set to Address, the notification is sent either to the specified address
or broadcast. See IP Address and Network Number descriptions for details.

• Transitions (Off Normal, Fault, Normal) - Three flags which indicate the types of transitions (To Offnormal, To
Fault, or To Normal) sent to the destination.

• UDP Port Number - The UDP Port number used to send the notification message to the destination if routing
by address. When the port is set to 0, this value when written is replaced with the port used by the supervisory
device on the IP network.

• Valid Days - The days of the week on which notifications may be sent to this destination during the value of
From Time, To Time (Start and Stop Times).

Back to Notification Class Attributes.

Route to Metasys
Determines whether or not the Notification Class object routes alarms to the Metasys alarming system.

Back to Notification Class Attributes.

Send Notifications to Supervisor
Determines whether or not the Notification Class object routes alarms to the supervisory device.

Back to Notification Class Attributes.

Notification Class Commands
The table below lists the commands supported by the Notification Class Object.

Table 315: Notification Class Object Commands
BACnet SupportedParametersCommand Name
YesSee Recipient List.Add Recipient

No0Disable
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Table 315: Notification Class Object Commands
BACnet SupportedParametersCommand Name
No0Enable

YesSee Recipient List.Remove Recipient1

1 Only supported by the BACnet Notification Class

Notification Class Command Details
Add Recipient
Adds the Metasys device hosting the BACnet integration (for example, the NAE) to the Recipient List attribute.

Back to Notification Class Commands.

Disable
Prevents distribution of event notifications.

Back to Notification Class Commands.

Enable
Allows distribution of event notifications.

Back to Notification Class Commands.

Remove Recipient
Deletes the device hosting the BACnet integration from the Recipient List attribute.

Back to Notification Class Commands.
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Optimal Start Object
The Optimal Start object aids in the reduction of energy costs during a building’s transition from unoccupied to
occupied. This scenario is accomplished by turning on the preheating/precooling as late as possible to reach comfort
levels prior to occupancy and turning off the heating/cooling as early as possible while maintaining occupied zone
comfort until zone vacancy.

This object allows you to save energy by coordinating the startup and shutdown times of equipment according to
when people occupy certain rooms or areas of the building.

For general information on Metasys system objects, see the Object Help section.

For more information on the wizard used to insert Optimal Start objects, see Insert Object - Optimal Start.

Optimal Start Concepts
Optimal Start Overview
After you create an Optimal Start Object using the known characteristics of your building, the Optimal Start (OST)
calculates the best times for startup and shutdown. For Optimal Start mode (Optimal Start Equation), the OST
commands the ZoneWCMode Obj attribute to occupied and starts the heating or cooling sequence at the appropriate
time. For Optimal Stop mode, the OST commands the Zone Occ Mode Obj attribute to unoccupied at the appropriate
time.

If you set the Adaptation Enabled attribute to True (1), the OST automatically adjusts the Cooling Constant and
Heating Constant as needed.

Note: Warmup and cooldown (WC) is also referred to as the prestart period in the OST object.

Optimal Start
The goal of Optimal Start Object is to reach either the Heating Setpoint or Cooling Setpoint at occupancy. The
Optimal Start object selects the appropriate setpoint depending on the temperature before starting the equipment.
To meet this goal, the Optimal Start object calculates:

• Heating Constant and Cooling Constant represent the rate at which the temperature inside the building changes
when the heating or cooling equipment is running

• the temperature difference between the Zone Temperature and the Heating Setpoint or Cooling Setpoint before
occupancy

• how many minutes of precooling (cooldown) or preheating (warmup) are required based on the above difference
• optimal start time when the Zone WC Mode Obj (BO or BV only) is controlled by the optimal start process

The Optimal Start object interacts with a Schedule Object, binary objects, and analog objects in an Optimal Start
application. See the Object Help section for information on these objects. See the Optimal Start Object section for
attribute information on the Optimal Start object.

Figure 80 illustrates optimal start.
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Figure 80: Optimal Start - Heating

Optimal Start Equation
The following equation calculates the optimal start time:

[(Heating or Cooling Constant/100) x Temperature Difference2] + Heating or Cooling Deadtime = Optimal Start Time

Table 316: Optimal Start Equation
DescriptionVariable
This variable is the value of the Heating or Cooling Constant attribute of the OST object and
represents the rate of warmup or cooldown in the zone after equipment startup. If Adaptation
Enabled is Yes, the Optimal Start object learns each day and sets a new value. This variable can
be edited by the user.

Heating or Cooling
Constant

This variable is the difference between the Zone Temperature and the value of the Heating Setpoint
or Cooling Setpoint attribute before the warmup or cooldown period.

Units = delta deg F or delta deg K

Temperature Difference

This variable is the value of the Heating or Cooling Deadtime attribute of the OST object and is
the amount of time required to raise or lower the Zone Temperature 1.0 degree.

Units = minutes. If Adaptation Enabled is Yes, the Optimal Start object learns each day and sets
a new value. This variable can be edited by the user.

Heating or Cooling
Deadtime

Optimal Start Example
For an example of the optimal start process, assume:

• The Zone Occ Mode Obj is scheduled to be occupied at 7:00 A.M. and unoccupied at 5:00 P.M.
• Zone Temperature = 55˚F before the warmup period
• Heating Setpoint (since in Heating mode) = 70˚F
• Heating Deadtime (since in Heating mode) = 5 minutes
• Heating Constant (since in Heating mode) = 10 (The optimal start process has run for several days, and the

Heating Constant has been adjusted to 10 based on past performance.)
• Temperature Difference = 70˚F - 55˚F = 15˚F

Therefore:

Optimal Start Time = [(10/100) x 152] + 5
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= (0.1 x 152) + 5

= (0.1 x 225) + 5

= 22.5 + 5

= 27.5

= 28 minutes

The optimal start process turns on the Zone WC Mode Obj at 6:32 A.M. (28 minutes prior to the scheduled 7:00
A.M. start time.)

Adaptation
Each day, at occupancy, the optimal start process adapts the Heating or Cooling Constant. It checks the Zone
Temperature at occupancy time. If the Zone Temperature did not reach a value within the range defined by the
Temp Differential and the Heating Setpoint or Cooling Setpoint before the occupancy time, the Heating Constant
or Cooling Constant is increased. This increase moves the optimal start time closer to the earliest start time defined
in the OST object. If the Zone Temperature reached a value within the range defined by Temperature Differential
and the Heating Setpoint or Cooling Setpoint prior to occupancy, the Heating Constant or Cooling Constant is
decreased. This decrease moves the optimal start time closer to the occupancy start time defined in the Schedule
Object.

Optimal Stop
The goal of optimal stop is to set the zone to the unoccupied mode prior to actual zone vacancy. The OST must do
this while the zone is still occupied, without causing comfort level alarms. The Optimal Start object calculates the
number of minutes before the zone is scheduled to change from occupied to unoccupied. The OST then uses the
same equation (Optimal Start Equation) for deriving the optimal start time to determine the earliest stop time, except
for two differences:

• To ensure occupancy comfort, the OST sets the Temperature Difference factor to the Temp Differential attribute.
• The Deadtime is set to 0.

(Heating or Cooling Constant/100) x (Temperature Difference)2 + Heating or Cooling Deadtime (always = 0) = Optimal
Stop Time

Object Interaction
Different objects interact in an Optimal Start application. The following figure illustrates a sample Optimal Start
application. The table describes the objects and their role in an Optimal Start application.
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Figure 81: Optimal Start Object Interaction

Table 317: Optimal Start Application Object Interaction
RoleObject or Attribute#
Receives temperature, setpoint, and scheduling data to determine optimal start and optimal
stop times for the building zone.

Optimal Start (OST)
Object

1

Provides occupied and unoccupied times for the building zone.Schedule Object2

Refers to the binary object (Binary Output, Binary Value, for example) that commands a zone
to occupied or unoccupied. It is commanded by the Schedule object to occupied and by the
Optimal Start to unoccupied, possibly earlier than scheduled if the Maximum Prestop Time
attribute is non-zero.

Zone Occupancy
Mode

3

Refers to the binary object (Binary Output, Binary Value, for example) that commands the
zone to warm up or cool down. It is commanded by the Optimal Start object at the optimal
start time and released at the occupied time. It will not be released if the Zone Warmup or
Cooldown (WC) Mode and the Zone Occupancy Mode objects are the same.

Zone Warmup or
Cooldown Mode

4

Refers to the analog attributes (within Analog Input objects, Analog Value objects, for example)
that are referenced by the Optimal Start object and provide the temperatures and setpoints
for use in calculations.

Zone Temperature,

Cooling Setpoint,

Heating Setpoint,

Outdoor Air
Temperature

5-8

Object/Attribute Involvement
Building an Optimal Start application means that the OST object and its associated Schedule object must have their
attributes configured to reference the appropriate objects in order to achieve the desired operation. The table lists
the objects and attributes involved and guidelines for data entry.
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Table 318: Optimal Start Object/Attribute Involvement
Data Entry GuidelinesAttributes InvolvedObject Type/ Function
Enter the Object Name of the Schedule object that schedules occupied
and unoccupied times for the binary object controlling the zone occupancy
mode of the heating and cooling equipment for the zone.

This object must be defined in the schedule and have valid start and stop
times for the current day for the Optimal Start object to run. Only one
start time and stop time can be defined per day, and the start time must
precede the stop time.

Zone Schedule ObjOptimal Start Object

Enter the Object Name of the binary object controlling the occupancy
mode of the heating and cooling equipment for the zone.

Zone Occ Mode Obj

Enter the Object Name of the binary object (BO or BV only) controlling
the warmup and cooldown mode of the heating and cooling equipment
for the zone. This may be the same object as the Zone Occ Mode Object.

Zone WC Mode Obj

Enter the Object/Attribute Name of the analog value that represents the
cooling setpoint.

Cooling Setpoint

Enter the Object/Attribute Name of the analog value that represents the
heating setpoint.

Heating Setpoint

Enter the Object/Attribute Name of the analog value that represents the
temperature in the zone being controlled.

Zone Temperature

Enter the Object/Attribute Name of the analog value that represents the
outdoor air temperature.

If this attribute is not defined, or the referenced analog attribute is offline,
the outdoor air temperature is assumed to be within the design
temperatures limits for the OST calculations.

If an analog attribute reference is defined for the outdoor air temperature,
its value determines if the Optimal Start object should adapt heating and
cooling constants and deadtimes.

If its value is outside the design temperature limits, deadtime and constant
calculations are skipped.

If its value is outside the design temperatures before the warmup or
cooldown period, the optimal start time is set to the maximum prestart
time.

If its value is outside the design temperatures before the unoccupied
period, Prestop does not occur.

Outdoor Air Temp

Enter the Object Name of the binary object controlling the occupancy
mode of the heating and cooling equipment for the zone as one of the
Property References.

List of Object Property
References

Schedule Object

Optimal Start Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.
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Table 319: Optimal Start Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseAdaptation Enabled

DateCalc Prestart Date

TimeCalc Prestart Time

DateCalc Prestop Date

TimeCalc Prestop Time

Set redirected to ZWC States Text; Number of
States redirected to ZWC Nbr States

Only available in the online UI

1WOne state from a
set

CoolDown Command

1–99975.0CWReal valueCooling Constant

1–480

Units = Minutes

10 minutesCWNumberCooling Deadtime

-20 to 120

Units = Temperature Units

35.0 deg C or 95.0
deg F

CWReal valueCooling Design Temp

CWAttribute ReferenceCooling Setpoint

Offline = 0

Online = 1

Uses Offline Online (Set 91).

One value from a
set

Cooling Stpt Status

Uses Display Precision (Set 0).0.1CWOne value from a
set

Display Precision

1–99975.0CWReal valueHeating Constant

1–480

Units = Minutes

10 minutesCWNumberHeating Deadtime

-35 to 90

Units = Temperature Units

-20.6 deg C or -5.0
deg F

CWReal valueHeating Design Temp

CWAttribute ReferenceHeating Setpoint

Offline = 0

Online = 1

One value from a
set

Heating Stpt Status

5–480

Units = Minutes

120 minutesCWNumberMax Prestart Time

0–60

Units = Minutes

0 minutesCWNumberMax Prestop Time

0–240

Units = Minutes

20 minutesCWNumberMin Prestart Time

Heating and Cooling = 0

Heating Only = 1

Cooling Only = 2

Uses OST Type (Set 126).

Heating/CoolingCWOne type from a setOST Type

CNWAttribute ReferenceOutdoor Air Temp
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Table 319: Optimal Start Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Idle = 0

Prestart Heating = 1

Prestart Cooling = 2

Calculating Deadtime = 3

Calculating Constant = 4

Occupied = 5

Prestop = 6

Not Operational = 7

Uses OST State (Set 125).

IdleDOne value from a
set

Present Value

Set redirected to ZOM States Text; Number of
States redirected to ZOM Nbr States

Only available in the online UI

1WOne state from a
set

Prestart Cooling
Command

Set redirected to ZOM States Text; Number of
States redirected to ZOM Nbr States

Only available in the online UI

1WOne state from a
set

Prestart Heating
Command

Set redirected to ZOM States Text; Number of
States redirected to ZOM Nbr States

Only available in the online UI

0WOne state from a
set

Prestop Command

Uses Unit Set (Set 869).Relative deg FCOne type of units
from a set

Relative Temp Units

Uses Reliability (Set 503).ReliableOne value from a
set

Reliability

Set redirected to ZOM States Text; Number of
States redirected to ZOM Nbr States

Only available in the online UI

1WOne state from a
set

Schedule Occupied
Command

Set redirected to ZOM States Text; Number of
States redirected to ZOM Nbr States

Only available in the online UI

0WOne state from a
set

Schedule Unoccupied
Command

True or FalseSend OK

TimeStpt Reached Time

0–10

Units = Relative Temp Units

3.0 delta deg F or
1.67 delta K

CWReal ValueTemp Differential

Uses Unit Set (Set 869).Deg FCOne value from a
set

Temperature Units

Set redirected to ZWC States Text; Number of
States redirected to ZWC Nbr States

Only available in the online UI

1WOne state from a
set

WarmUp Command

CWObject ReferenceZone Occ Mode Obj

TimeZone Occ Time

CWObject ReferenceZone Schedule Obj

Offline = 0

Online = 1

One value from a
set

Zone Schedule Status
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Table 319: Optimal Start Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

CWAttribute ReferenceZone Temperature

NReal valueZone Temp At Start

Offline = 0

Online = 1

One value from a
set

Zone Temp Status

TimeZone Unocc Time

Must be defined as an N2 BO or N2 BV object.CWObject ReferenceZone WC Mode Obj

1 C - Configurable, D - Default Attribute for Display, N - Value Not Required, W - Writable

Optimal Start Attribute Details
Adaptation Enabled
Indicates whether OST uses adaptive learning to change the building heating and cooling constants and heating
and cooling deadtimes.

Back to Optimal Start Attributes.

Calc Prestart Date
Indicates the last calculated prestart date. This value is updated each time the optimal start time is calculated
(between early start time and optimal start time).

Back to Optimal Start Attributes.

Calc Prestart Time
Indicates the last calculated prestart time. This value is updated each time the optimal start time is calculated (between
early start time and optimal start time).

Back to Optimal Start Attributes.

Calc Prestop Date
Indicates the last calculated prestop date. This value is updated each time the optimal stop time is calculated (between
early stop time and optimal stop time).

Back to Optimal Start Attributes.

Calc Prestop Time
Indicates the last calculated prestop time. This value is updated each time the optimal stop time is calculated (between
early stop time and optimal stop time). If Max Prestop Time is zero, the value of this attribute is equal to the
unoccupied time.

Back to Optimal Start Attributes.

CoolDown Command
Specifies the command sent to the ZoneWCMode Obj point at prestart time when in cooling mode. The enumeration
set and number of states for this attribute are redirected and filled in at runtime from the Zone WC Mode Obj point.
The default value is set to a value of 1 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Cooling Constant
Defines the rate at which the zone cools down after equipment startup. If adaptation is enabled, this constant is
adapted without user intervention. If adapting, cooling, and heating setpoints are the same attribute, the cooling
constant is adapted even if the mode is not cooling, meaning both constants change.

Back to Optimal Start Attributes.
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Cooling Deadtime
Indicates the time required after startup to lower the temperature by one degree. This value is adapted by the OST
algorithm, if adaptation is enabled. If adapting, cooling, and heating setpoints are the same attribute, the Cooling
Deadtime is adapted even if the mode is not cooling, meaning both deadtimes change.

Back to Optimal Start Attributes.

Cooling Design Temp
Indicates the highest outside temperature at which the cooling system maintains zone comfort in the cooling mode.

Back to Optimal Start Attributes.

Cooling Setpoint
Identifies the attribute of an object used to define the zone occupied target cooling temperature. This attribute may
be the same as the Heating Setpoint attribute.

Back to Optimal Start Attributes.

Cooling Stpt Status
Identifies the OST object’s connection status to the Cooling Setpoint attribute. If this status is Offline, the Present
Value is set to Not Operational.

• Offline - Cooling Setpoint attribute is offline.
• Online - Cooling Setpoint attribute is online.

Back to Optimal Start Attributes.

Display Precision
Indicates the rounded position and decimal places to display for this object.

Back to Optimal Start Attributes.

Heating Constant
Defines the rate at which the zone heats up after equipment startup. If adaptation is enabled, this constant is adapted
without user intervention. If adapting, cooling, and heating setpoints are the same attribute, the heating constant is
adapted even if the mode is not heating, meaning both constants change.

Back to Optimal Start Attributes.

Heating Deadtime
Indicates the time required after startup to raise the temperature by one degree. This value is adapted by the OST
algorithm, if adaptation is enabled. If adapting, cooling, and heating setpoints are the same attribute, the Heating
Deadtime is adapted even if the mode is not heating, meaning both deadtimes change.

Back to Optimal Start Attributes.

Heating Design Temp
Indicates the lowest outside temperature at which the heating system maintains zone comfort in the heating mode.

Back to Optimal Start Attributes.

Heating Setpoint
Identifies the attribute of an object used to define the zone occupied target heating temperature. This attribute may
be the same as the Cooling Setpoint attribute.

Back to Optimal Start Attributes.

Heating Stpt Status
Identifies the OST object’s connection status to the Heating Setpoint attribute. If this status is Offline, the Present
Value is set to Not Operational.

• Offline - Heating Setpoint attribute is offline.
• Online - Heating Setpoint attribute is online.
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Back to Optimal Start Attributes.

Max Prestart Time
Indicates the maximum period of time required to bring the zone up to occupancy setpoint temperature under the
worst conditions (earliest optimal start time).

Back to Optimal Start Attributes.

Max Prestop Time
Indicates the maximum period of time that the heating/cooling system can be shut down and still maintain the
occupied zone temperature until entering the unoccupied mode (earliest optimal stop time). By setting this time to
zero (the default value), optimal stop is disabled.

Back to Optimal Start Attributes.

Min Prestart Time
Indicates the minimum period of time before occupancy to start the heating/cooling system. This time allows for the
required amount of air changes in the zone prior to occupancy (latest optimal start time).

Back to Optimal Start Attributes.

OST Type
Defines the OST supported configuration. When the zone is in a mode not supported by the OST object, the Present
Value is idle. OST-supported modes include:

• Heating and Cooling
• Heating Only
• Cooling Only

Back to Optimal Start Attributes.

Outdoor Air Temp
Identifies the attribute of an object used to determine the outdoor temperature:

• If this attribute is not defined, or is offline, the outdoor air temperature is not used in the OST calculations and is
assumed to be within the design temperatures.

• If an Analog attribute reference is defined for the outdoor air temperature, it aids in determining if the Optimal
Start object should adapt constants and deadtimes.

• If the attribute is defined and outside the design temperatures, deadtime and constant calculations are skipped.
• If the attribute is defined and is outside the design temperatures during Prestart, the optimal start time is set to

early start time.
• If the attribute is defined and outside the design temperatures during Prestop, do not Prestop.

Back to Optimal Start Attributes.

Present Value
Represents the current value of the object:

• Idle - Waiting for next occupied time for a supported mode (heating or cooling).
• Prestart Heating - Heating optimal start time is pending.
• Prestart Cooling - Cooling optimal start time is pending.
• Calculating Deadtime - Valid only if Adaptation Enabled.
• Calculating Constant - Valid only if Adaptation Enabled.
• Occupied
• Prestop - Waiting to reach optimal stop time. If Max Prestop Time = 0, then mode is Occupied, not Prestop.
• Not Operational - Optimal Start object is not operational due to errors in its connection status to other required

objects. The specific problem can be determined by viewing the other status attributes. The Optimal Start object
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could also be Not Operational (or Unreliable) if the Zone Occ Mode Obj is in the schedule but there are no valid
start and stop times for that day (due to holiday or schedule offline, for example).

Back to Optimal Start Attributes.

Prestart Cooling Command
Specifies the command sent to the Zone Occ Mode Obj point at prestart time when in cooling mode. The enumeration
set and number of states for this attribute are redirected and filled in at runtime from the Zone Occ Mode Obj point.
The default value is set to a value of 1 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Prestart Heating Command
Specifies the command sent to the Zone OccMode Obj point at prestart time when in heating mode. The enumeration
set and number of states for this attribute are redirected and filled in at runtime from the Zone Occ Mode Obj point.
The default value is set to a value of 1 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Prestop Command
Specifies the command sent to the Zone Occ Mode Obj point at prestop time. The enumeration set and number of
states for this attribute are redirected and filled in at runtime from the Zone Occ Mode Obj point. The default value
is set to a value of 0 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Relative Temp Units
Specifies the units associated with the Temp Differential attribute.

Back to Optimal Start Attributes.

Reliability
Indicates if a value is questionable due to operational errors in the Optimal Start object’s connection status to other
required objects. Without a valid start and stop time for the current day (due to holiday or schedule offline, for
example), the value is also Unreliable.

Back to Optimal Start Attributes.

Schedule Occupied Command
Specifies the command sent to the Zone Schedule Obj point at prestart time when in occupied mode. The enumeration
set and number of states for this attribute are redirected and filled in at runtime from the Zone Schedule Obj point.
The default value is set to a value of 1 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Schedule Unoccupied Command
Specifies the command sent to the Zone Schedule Obj point at prestart time when in unoccupied mode. The
enumeration set and number of states for this attribute are redirected and filled in at runtime from the Zone Schedule
Obj point. The default value is set to a value of 0 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Send OK
Indicates if the status of the last command was sent to the Zone WC Mode Obj, Zone Occ Mode Obj, or Zone
Schedule Obj.

Back to Optimal Start Attributes.

Stpt Reached Time
Indicates the time at which the zone temperature was equal to (within differential) the zone setpoint. This point is
set between the optimal start time and occupied. If this point is not reached during that time, then it continues to be
monitored during the occupied time until the zone temperature reaches the setpoint.

Back to Optimal Start Attributes.
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Temp Differential
Indicates the value added and subtracted to the zone setpoint to define a temperature range.

Back to Optimal Start Attributes.

Temperature Units
Indicates the units associated with the attributes for temperatures.

Back to Optimal Start Attributes.

WarmUp Command
Specifies the command sent to the ZoneWCMode Obj point at prestart time when in heating mode. The enumeration
set and number of states for this attribute are redirected and filled in at runtime from the Zone WC Mode Obj point.
The default value is set to a value of 1 upon creation so the attribute requires no configuration.

Back to Optimal Start Attributes.

Zone Occ Mode Obj
Identifies the object used to command a zone to occupied or unoccupied. This object must be specified in the Zone
Schedule Obj. This is commanded by scheduling to occupied and by OST if prestop is enabled.

Note: If the Zone Occ Mode Obj and the Warmup/Cooldown Mode Obj are the same point, then the point is
commanded by the Prestart Cooling/Heating Command at the prestart time and by the Scheduling at the
scheduled time.

Back to Optimal Start Attributes.

Zone Occ Time
Indicates the scheduled zone occupied time, obtained from the Zone Schedule Obj.

Back to Optimal Start Attributes.

Zone Schedule Obj
Identifies the Schedule object, which schedules the Zone Occ Mode Obj. This object must be defined in the schedule
and have valid start and stop times for the current day in order for OST to run. Otherwise, the OST object’s Present
Value is Not Operational. Only one Start and Stop time can be defined per day, and the Start time must precede
the Stop time. The Start time must be defined as binary State ON (1) and Stop time must be defined as binary State
OFF (0).

Back to Optimal Start Attributes.

Zone Schedule Status
Identifies the OST object’s connection status to the Zone Schedule Obj. If this status is Offline, the Present Value
is set to Not Operational.

• Offline - Zone Schedule Obj is offline.
• Online - Zone Schedule Obj is online.

Back to Optimal Start Attributes.

Zone Temperature
Identifies the attribute of an object used to determine the zone temperature.

Back to Optimal Start Attributes.

Zone Temp At Start
Specifies the zone temperature at the last optimal start time.

Back to Optimal Start Attributes.
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Zone Temp Status
Identifies the OST object’s connection status to the Zone Temperature attribute. If this status is Offline, the Present
Value is set to Not Operational.

• Offline - Zone Temp attribute is offline.
• Online - Zone Temp attribute is online.

Back to Optimal Start Attributes.

Zone Unocc Time
Indicates the scheduled zone unoccupied (vacancy) time, obtained from the Zone Schedule Obj.

Back to Optimal Start Attributes.

Zone WC Mode Obj
Identifies the object used to command a zone to Warmup or Cooldown mode. This object may be the same as the
Zone Occ Mode Obj. This object is commanded by the OST at the optimal start time. This object is released at the
occupied time unless this object is also the value for the Zone Occ Mode Obj.

Back to Optimal Start Attributes.

Optimal Start Commands
The table below lists the commands supported by the Optimal Start Object.

Table 320: Optimal Start Object Commands
ParametersCommand Name

Cancel Prestart

Cancel Prestop

Disable

Enable

Optimal Start Command Details
Cancel Prestart
Delays pending start until latest prestart time. Only valid during Prestart and before the optimal start time.

Back to Optimal Start Commands.

Cancel Prestop
Cancels the pending stop. Only valid during Prestop and before the optimal stop time.

Back to Optimal Start Commands.

Disable
Prevents the object’s functionality; no calculations take place.

Back to Optimal Start Commands.

Enable
Allows the object to perform its calculations once a minute.

Back to Optimal Start Commands.

Optimal Start Steps
Building an Optimal Start Application
To build an Optimal Start application:

1. Add the N2 Controller object and the analog and binary objects required for the OST application to the database.
See the Object Help section for information on objects and the Related Documentation table in the Welcome
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section for information on the SCT. See Creating Items with Wizards for information on creating objects and
other items.

2. Add the Schedule Object (see Scheduling), referencing the binary object controlling Zone Occupancy Mode.
3. Make sure valid occupied and unoccupied times are entered into the Schedule object.
4. Add the Optimal Start Object referencing the above Schedule object, the Binary objects designated as Zone

Occupancy Mode and Zone Warmup or Cooldown Mode, and the analog attributes of objects designated as
temperatures and setpoints.

Note: See the Site Management Portal User Interface section for information on creating, editing, commanding,
and deleting objects. See the Scheduling section for information on scheduling.

Optimal Start Troubleshooting
Table 321: Optimal Start Application Troubleshooting

SolutionProblem
The Optimal Start object’s Present Value attribute may indicate Not Operational because
of errors in its connection status to other required objects.

To verify the Optimal Start object’s connection status to other required objects:
• Verify that the required Schedule object, binary objects, and analog objects are all

defined and online.
• Verify that the binary object controlling Zone Occupancy Mode is in the List of Prop

Refs for the Schedule Object.
• Verify that valid occupied and unoccupied times for the current day are defined in

the Schedule object.

Present Value of the Optimal Start
Object indicates Not Operational

To ensure the Optimal Start object is adapting constants and deadtimes:
• Verify that the Adaptation Enabled attribute indicates True.
• Verify that the value of the Zone Temperature attribute is not within the value of the

Temp Differential attribute relative to the Heating or Cooling Setpoint (plus or minus
one degree) before the warmup or cooldown period.

• Verify that the value of the Outdoor Air Temp attribute is within the values of the
Cooling Design Temp and Heating Design Temp attributes.

Optimal Start Object is not adapting
Constants and Deadtimes

590Metasys System Online Help PDF



P2000 Integration
The P2000 system integration enables you to view access control objects in the P2000 security system from a single
user interface, the Metasys Site Management Portal UI. You also can view the objects from other building systems
controlled by the Metasys system. The integration leverages Web Services technology to integrate the P2000 system.

The P2000 integration provides many features, allowing you to:

• see P2000 objects in the navigation tree.
• perform door and output point control tasks.
• see P2000 events in the Metasys Event Viewer.
• use P2000 events to initiate actions on the Metasys system.

For information, refer to theP2000Metasys System Extended Architecture IntegrationManual (Part No. 24-10618-82).
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Program (Control System) Object
The Program object (previously the Control System object) stores information needed for the user-defined control
strategies created (graphically) with the Logic Connector Tool (LCT). The Control System object application now
includes BACnet command object functionality and appears as the Program object in the Metasys software. The
Program object attributes allow manipulation of the LCT application.

For general information on Metasys system objects, see Common Object Attributes.

Program Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 322: Program Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TextDescription Of Halt

CWTrue or FalseEnabled

TextInstance Of

0 = Ready

1 = Load

2 = Run

3 = Halt

4 = Restart

5 = Unload

ReadyWOne state from a
set

Program Change

TextProgram Location

0 = Idle

1 = Loading

2 = Running

3 = Waiting

4 = Halted

5 = Unloading

One state from a
set

Program State

0 = Normal

1 = Load Failed

2 = Internal

3 = Program

4 = Other

One state from a
set

Reason For Halt

Uses Reliability set.One state from a
set

Reliability

1 C - Configurable, W - Writable

Program Attribute Details
Description Of Halt
Displays the text matching the Reason for Halt attribute’s set value.
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Back to Program Attributes.

Enabled
Indicates whether the program/control system logic is enabled or disabled.

Back to Program Attributes.

Instance Of
Reflects the LCT control system’s user name.

Back to Program Attributes.

Program Change
Requests changes to the current state of the LCT application. When written, the following actions are carried out.
After the action is carried out, the Program Change value returns to Ready.

• Ready - Specifies that the LCT control system is ready for a change request (normal state).
• Load - Enables the LCT control system.
• Run - Enables the LCT control system.
• Halt - Disables the LCT control system.
• Restart - Disables, then Enables, the LCT control system.
• Unload - Disables the LCT control system.

Back to Program Attributes.

Program Location
Indicates the location of the program/control system.

Back to Program Attributes.

Program State
Reflects the current state of the LCT application.

• Halted - The Program object is Disabled.
• Running - The Program object is Enabled.

Back to Program Attributes.

Reason For Halt
Indicates that the LCT Control System has been disabled by a means other than the writing of the Program Change
attribute.

• Normal - The LCT control system is Enabled.
• Internal - The LCT control system has been disabled by a means other than writing of the Program Change

attribute.
• Program - The LCT control system has been disabled by writing the Program Change attribute.

Back to Program Attributes.

Reliability
Indicates whether the connections between logic blocks are reliable.

Back to Program Attributes.
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Pulse Meter Object
The Pulse Meter object accumulates the differences between consecutive reads of the integer value provided by
an Accumulator Object or Counter Input Object (defined by CCT), and calculates the rate of change between each
reading of the value. This object also totals the counted pulses and converts them into units of consumption.

The Pulse Meter object must reference a counter/accumulator object to access the counter value that resides in the
counter/accumulator hardware device (which is hardwired to the pulse input). The counter/accumulator object is
hardware specific, while the Pulse Meter object is hardware independent.

Multiple Pulse Meter objects may share the same counter/accumulator object, and must reside on the same device
as the counter/accumulator hardware device.

Note: The Pulse Meter object only handles counters that count forward.

Each Pulse Meter object may have different purposes, such as one calculates the rate over a 60-second period,
while others calculate the rate over a 5-minute period. For example, some Pulse Meters are supposed to run only
during certain times of the day.

For general information on Metasys system objects, see the Object Help section.

Pulse Meter Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 323: Pulse Meter Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0–4,294,967,2950NumberCalculation

FalseWTrue or FalseConsump Unreliable

Units = Consumption Units0WReal value
(double)

Consumption

Uses Unit Set (Set 869).kWhCWOne value form a
set

Consumption Units

CWObject ReferenceCounter Object

See Display Precision.10thsCWOne value from a
set

Display Precision

FalseWTrue or FalseExecution Trigger

True, FalseTrueCWTrue or FalseMeter Active

Units = Rate UnitsDRReal valuePresent Value

Units = Consumption Units0WReal value
(double)

Previous Consumption

Units = Consumption Units1.000000CWReal value
(double)

Pulse Consumption

0–4,294,967,295NumberPulse Count

3600.000000CWReal value
(double)

Rate Constant

> = 0, Units = Rate Units0.0CWReal valueRate Default

> = 0, Units = Rate Units3.402823466

E38

CWReal valueRate Limit
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Table 323: Pulse Meter Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Uses Unit Set (Set 869).kWCWOne value from a
set

Rate Units

FalseTrue or FalseRate Unreliable

Uses Reliability (Set 503).ReliableOne value from a
set

Reliability

True while reset in progressFalseWTrue or FalseReset

WDateReset Date

WTimeReset Time

0–4,294,967,29532767CWNumberRollover Limit

Units = seconds, Value > 960CWNumberSample Time

1 C - Configurable, D - Default Attribute for Display, R - Affected by Object Reliability, W - Writable

Pulse Meter Attribute Details
Calculation
Increases by one each time the Pulse Meter object executes its main routine until it rolls over and starts again with
zero.

Back to Pulse Meter Attributes.

Consump Unreliable
Indicates that the Consumption attribute may contain unreliable data.

Back to Pulse Meter Attributes.

Consumption
Indicates the consumption since the last reset of the Pulse Meter object.

Back to Pulse Meter Attributes.

Consumption Units
Indicates the measurement units for all consumption attributes.

Back to Pulse Meter Attributes.

Counter Object
Specifies the associated Accumulator Object or Counter Input Object (defined by CCT).

Back to Pulse Meter Attributes.

Display Precision
Specifies the rounded position and decimal places to display for this object’s analog values.

Back to Pulse Meter Attributes.

Execution Trigger
When written to True, the execution function runs.

Back to Pulse Meter Attributes.

Meter Active
Specifies whether the pulse meter object currently should be metering.

Back to Pulse Meter Attributes.

Present Value
Represents the currently calculated rate of consumption.

Back to Pulse Meter Attributes.
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Previous Consumption
Indicates the last value of Consumption before the last reset.

Back to Pulse Meter Attributes.

Pulse Consumption
Specifies the physical quantity that each single pulse represents.

Back to Pulse Meter Attributes.

Pulse Count
Indicates the pulse counter value as last reported from the Counter Input Object (define by CCT), or the last Present
Value of the Accumulator Object.

Back to Pulse Meter Attributes.

Rate Constant
Specifies the value multiplied by the Consumption Units to get the Present Value units to match Rate Units.

Back to Pulse Meter Attributes.

Rate Default
Specifies the value of Present Value when the calculated rate exceeds the Rate Limit.

Back to Pulse Meter Attributes.

Rate Limit
Specifies the highest allowed Present Value before using Rate Default.

Back to Pulse Meter Attributes.

Rate Units
Indicates the measurement units for all rate attributes.

Back to Pulse Meter Attributes.

Rate Unreliable
Indicates that the Present Value is unreliable because of a misreading of a counter.

Back to Pulse Meter Attributes.

Reliability
Indicates if a value is questionable.

Back to Pulse Meter Attributes.

Reset
When written to True, it transfers the current value of the Consumption attribute into the Previous Consumption
attribute before resetting Consumption to zero.

Back to Pulse Meter Attributes.

Reset Date
Indicates the date of the last resetting of Consumption attribute.

Back to Pulse Meter Attributes.

Reset Time
Indicates the time of the last resetting of Consumption attribute.

Back to Pulse Meter Attributes.

Rollover Limit
Specifies the highest counter value before the pulse counter rolls over to zero. This value must match that of the
counter, or the Max Value of the Accumulator.

Back to Pulse Meter Attributes.
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Sample Time
Specifies the period of automatic executions of the algorithm in seconds.

Back to Pulse Meter Attributes.

Pulse Meter Commands
The table below lists the commands supported by the Pulse Meter Object.

Table 324: Pulse Meter Object Commands
ParametersCommand Name

Enable

Disable

Reset

Start Meter

Stop Meter

Pulse Meter Command Details
Enable
Enables the calculation of the pulse count and consumption for the Pulse Meter object.

Back to Pulse Meter Commands.

Disable
Disables the calculation of the pulse count and consumption for the Pulse Meter object.

Back to Pulse Meter Commands.

Reset
Resets the Pulse Meter, including the Consumption attribute.

Back to Pulse Meter Commands.

Start Meter
Resumes metering.

Back to Pulse Meter Commands.

Stop Meter
Stops metering.

Back to Pulse Meter Commands.
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Schedule Object
The Schedule object works behind the scenes of the Scheduling feature. The Schedule object updates attribute
values of objects according to the time of day. These times can be specified for days of the week and as exceptions.

For more information on the Scheduling feature or the steps it takes to create one, see the Scheduling section.

For general information on Metasys system objects, see the Object Help section.

Schedule Object Attributes
The display of the Schedule object uses two tabs, the Schedule Object Schedule Tab and the Schedule Object
Focus/Configuration Tab. If you add extensions, see Extensions for information on the extension tabs.

Schedule Object Features
Table 325 shows the icon of the Schedule object. The key words are included in the table to help users who may
search the help system using a description of the icon to find this chapter.

Table 325: Schedule Object Icon
Key WordsIcon
Stopwatch, Pocket Watch, Clock

Display Frame Attributes
Figure 82: Schedule Object Display Frame Example

Label
The name or label that appears in the Navigation Tree.

Value
The Present Value or the Value indicates the current value of the Schedule object. This value is written to each of
the scheduled items.

Status
The status of the Schedule object. The possible statuses include:

• Normal
• Inactive - Today is not within the effective period
• Unreliable - Data in Schedule is not consistent. This is a rare occurrence.
• Disabled
• Out of Service

Schedule Object Schedule Tab
Operation and Display Attributes

Effective Period
The Effective Period attribute defines the range of dates within which the Schedule object is active. By default, these
dates are unspecified, causing the Schedule object to be active for all days. When the Schedule is not within the
Effective Period, the Schedule is considered Inactive and the Schedule’s status is set to Inactive. Wildcards may be
used in the date fields. For more information on using wildcards, see Wildcards.
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Schedule Output Type
The Schedule Output Type attribute indicates the value type of the Schedule object’s Present Value, Default Schedule
Command, and all scheduled events.

Table 326: Schedule Output Type Options
DescriptionOption
Select this option to set the schedule’s Value type to Binary (one of two states, such as Off
and On).

Binary

Select this option to set the schedule’s Value type to Analog (for example, 72.0).Analog

Select this option to set the schedule’s Value type to Multistate (one of a set of states, such
as Off, Low, Medium, and High).

Multistate

Select this option to set the schedule’s Value type to match the Value type of the attribute
scheduled for the Key Item. For example, all values are Boolean (True/False) if the Key
Item’s Enabled attribute is scheduled.

Derived from Key Item

This type is only set by the system - it cannot be manually selected. This type indicates that
the current schedule type matches preexisting values.

Derived from Value

Default Schedule Command
The Default Schedule Command attribute indicates the command of the Schedule object when no event is in effect,
due to no scheduled command or a conscious gap in the schedule. The Default Schedule Command is executed
every midnight unless another event is in place to begin at midnight.

The Default Schedule Command also supports the Release command. The Release command releases the Scheduling
function’s control of the scheduled objects. Setting the Default Schedule Command to Release is the only available
method to release the schedule’s control of scheduled objects through the Schedule object. Release should only
be used for the Schedule Default Command if the scheduled items support the Release command.

States Text
The States Text attribute indicates the displayed strings for the Present Value when the Schedule Output Type is
either binary or multistate. This attribute allows you to change what states the Schedule’s Present Value displays if
you want it to be different from the key item.

Display Units
The Display Units attribute indicates the displayed units of the Present Value when the Schedule Output Type is
analog. This attribute allows you to change the units displayed with the Schedule’s Present Value if you want them
to be different from the key item.

Display Mode
The Display Mode drop-down menu allows you to select what is displayed in the lower panel of the Schedule Tab.

See the Scheduling topic for more information on the Display Modes.

Today’s Schedule
Contains the schedule timeline for the current day. The timeline displays the projected schedule output that will be
written to the scheduled objects for the current day, combining the default Schedule Command with events from
both the Weekly Schedule and Exception Schedule. Today’s Schedule also displays a table of times and values,
which details the changes in the schedule’s output for the current day.

Note: Today’s Schedule does not display in the SCT. It also does not display for mapped third-party schedules.

Weekly Schedule
Contains a timeline of events for each day of the week - Monday, Tuesday, . . . Sunday. Each event has a time and
value that the Schedule writes to the scheduled objects. An event ends at midnight, but it can be ended earlier by
specifying an end time or by scheduling another event to start. Events in the Exception Schedule override times and
values in this Weekly Schedule. If the Weekly Schedule has no events defined on a particular day and time, and
there are also no exception events scheduled, the Default Schedule Command takes effect.

Note: Weekly Schedule does not display for third-party schedules that do not support a weekly schedule.
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Exception Schedule
Contains a list of exceptions to the weekly schedule. The times and values in the exception replace anything that is
in the weekly schedule. If more than one exception is scheduled on the same day, the highest priority (precedence)
exception takes effect. If all exceptions are of the same precedence, they are executed in time order. Exceptions
override the Weekly Schedule only when events are scheduled for the exception. Any time that an exception event
is not in effect, such as when an event is ended before midnight (or no exception events are defined), the Weekly
Schedule takes effect. If the Weekly Schedule also has no scheduled events at that time, the Default Schedule
Command takes effect.

Note: By default, exception schedules which have already occurred are deleted after 31 days. You can disable
automatic deletion of exception schedules or change the number of days until the exception schedules are
deleted to 7 days by configuring the JCI Exception Schedule attribute. For more information, see JCI Exception
Schedule in the Engine Device Object section.

Note: Exception Schedule does not display for third-party schedules that do not support exceptions.

Scheduled Items
Contains the list of items to be commanded by the schedule object. If empty, the Schedule does not directly command
objects but its Present Value can still be used as an input to other logic, such as an Interlock or Control System.
The online display also includes a Status Log that shows the status of the schedule’s attempts to control each of
the scheduled items. If no objects are scheduled, the Schedule Output Type determines what type of command may
be scheduled.

Schedule Object Focus/Configuration Tab
The online UI displays the Focus tab. The SCT displays the Configuration tab.

Object Attributes

Name
The Name attribute contains a freely definable user-friendly Name for the object that is independent of the Item
Reference or the location of the object in the physical network. The Name is used as the label in the All Items
navigation tree. The Name is shown in alarm reports, the event and audit viewers, and in summaries. The Name
does not need to be unique to the site.

The Name defaults to the object identifier you used during manual object creation, but can be edited later. For
integrated BACnet objects, the name defaults to the BACnet Object Name in the remote BACnet device. For integrated
N1 network objects, the name defaults to the System.Object Name in the NCM.

Example: ConferenceCenter-Room2-LightingSchedule

The Name attribute allows up to 400 characters, but 40 or less is best for the display layout.

Name is a common object attribute; for more information, see Common Object Attributes.

Description
The Description attribute contains a user-defined description of the object. The Description attribute allows up to 40
characters, but is not required. Description is a common object attribute; for more information, see Common Object
Attributes.

Object Type
The Object Type attribute indicates the type of object as displayed in the Metasys software and as exposed to a
BACnet network. The Object type of the Schedule object is Schedule. The Schedule object is a standard BACnet
schedule object and conforms to the BACnet protocol 135-2004 specification. Object Type is a common object
attribute; for more information, see Common Object Attributes.

Object Category
The Object Category attribute classifies the object by the category of system or equipment that it monitors to aid in
the determination of user access privileges and alarm routing.

Examples: HVAC, Fire, Security
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Status Attributes

Enabled
Setting the Enabled attribute to False stops the object from updating its Present Value and stops the object from
commanding the referenced attributes. Setting the Enabled attribute to False does not change the Out of Service
attribute.

Status Flags
The Status Flags indicate the general health of the object. This attribute does not appear in the SCT.

DescriptionStatus Flag
This flag is always False for the Schedule object.In Alarm

False means that the Reliability attribute is reliable, otherwise the flag is True.Fault

This flag is always False for the Schedule object.Overridden

True means that the Out of Service attribute is also True, otherwise the flag is False.Out of Service

Reliability
The Reliability attribute indicates the reliability of the object. If there are data type mismatches in the weekly schedule,
exception schedules, or Default Schedule Command, the object reports that it is unreliable. This attribute does not
appear in the SCT.

Out of Service
When True, the object no longer updates the Present Value itself. This attribute does not appear in the SCT.

Note: Disabling the object does not impact the ability to put the Schedule Out Of Service and write to its Present
Value and thus to its Outputs.

Error Status
The Error Status attribute indicates whether the Present Value was successfully written to the list of property values
in the Scheduled Items list. The Error Status displays Ok if the object was able to send its latest Present Value to
every object in the Scheduled Items list. Otherwise, the Error Status displays the error of the first failed command.
See the status log in the Scheduled Items view for the status for each attempted command. This attribute does not
appear in the SCT, and does not appear for mapped third-party schedules.

Alarm State
The Alarm State attribute indicates that the object transitioned into alarm or unreliable conditions. This attribute does
not appear in the SCT.

Engineering Values Attributes

Item Reference
The Item Reference attribute contains a unique reference name for the object that is the full path name of the object
through the All Items navigation tree using the unique identifier you specified when you manually created the object.
Item Reference is a common object attribute; for more information, see Common Object Attributes.

Version
The Version attribute displays the version number of the object software code. Version is a common object attribute;
for more information, see Common Object Attributes.

Execution Attributes

Execution Priority
The Execution Priority attribute indicates the relative importance of performing the function of the object within the
device.

Priority for Writing
The Priority for Writing attribute defines the priority at which the referenced attributes are commanded. Seven is the
highest priority and 16 is the lowest supported by the Schedule object, with the default of 15.

Note: We do not recommend using priorities 7 or 8 as they may interfere with the operator override functionality.
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Scheduled Commands
Disable
The Disable command stops all future scheduled events. Neither the Weekly Schedule nor the Exception Schedule
run again until the Schedule object is re-enabled. While disabled, the status log in the Scheduled Items view lists
the object as disabled. The schedule remains disabled until re-enabled.

Enable
The Enable command allows the Schedule object to resume normal scheduling operation. The Schedule object
starts the schedule as soon as it is enabled. When it is re-enabled, the Schedule object writes its current value to
the scheduled items.
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Signal Select Object
The Signal Select object can process values from multiple zones to adjust various setpoints and can function with
either analog or binary points.

For analog point types, the Signal Select object determines (one or more of) the low input, average input, and/or
high input values for use in updating an attribute value of another object.

For binary point types, the Signal Select object determines (one or more of) the average state, the logical Or state,
and/or the logical And state values for use in updating an attribute value of another object.

Computations take place at startup and at each time an input value experiences a change in value or reliability. The
results of these calculations are sent to specified output points as commands. For example, this object allows you
to average multiple zone temperatures and base a control, such as adjusting a setpoint, on that average.

For general information on Metasys system objects, see the Object Help section.

Signal Select Concepts
Average Output Computation
In the case of binary types of input references, if the majority of inputs are at State 1 or the inputs are evenly split
between State 1 and State 0, the Average output is commanded to State 1. If the majority of inputs are at State 0,
the Average output is commanded to State 0.

Logical OR Computation
If any input is at State 1, the OR output is commanded to State 1. If all inputs are at State 0, the OR output is
commanded to State 0.

Logical AND Computation
If all inputs are at State 1, the AND output is commanded to State 1. If any input is at State 0, the AND output is
commanded to State 0.

Signal Select Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 327: Signal Select Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NoneCNWAttribute referenceAverage Output

NormalCWOne state from a setExecution Priority

CWReal ValueFailsoft

NoneCNWAttribute referenceHigh OR

Minimum number of elements in the list =1,

Maximum number of elements in the list =
12

CWList of attribute
references

Input List

NoneCNWAttribute referenceLow AND

Analog or BinaryAnalogCWOne type from a setPoint Type

N = 3

0 = Calculated, 1 = Last Reliable, 2 = Fail
Soft

MasterCOne value from a
set

Present Value
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Table 327: Signal Select Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Reliable or Input UnreliableOne state from a setReliability

n = 2

0 = Last Reliable, 1 = Fail Soft

Last ReliableCOne state from a setSetup

1 C - Configurable, N - Value Not Required, W - Writable

Signal Select Attribute Details
Average Output
Specifies the object attribute whose value is updated using the calculated average of all of the inputs of the Signal
Select Object.

Back to Signal Select Attributes.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Back to Signal Select Attributes.

Failsoft
Routes to all the outputs if Setup is configured as Fail Soft. Fail Soft routes when the object becomes unreliable
and when the output transitions from Reliable to Unreliable.

Back to Signal Select Attributes.

High OR
Specifies the object attribute whose value is updated using the highest input of all the inputs in the Signal Select
object, for analog point types. For binary point types, the value is updated using a logical OR condition of all inputs
of the Signal Select object.

Back to Signal Select Attributes.

Input List
Contains the list of attribute references used in the Signal Select calculations. An analog type defined as a binary
input is converted to a binary value prior to each computation, and vice versa.

Back to Signal Select Attributes.

Low AND
Object attribute whose value is updated using the lowest input of all the inputs in the Signal Select object, for analog
point types. For binary point types, the value is updated using a logical AND condition of all inputs of the Signal
Select object.

Back to Signal Select Attributes.

Point Type
Specifies the type of input values monitored by the Signal Select object, the calculations it performs, and the outputs
it produces. Point type can be analog or binary.

Back to Signal Select Attributes.

Present Value
Represents the current value of the output.

Back to Signal Select Attributes.

Reliability
Indicates a value of Unreliable only if all of the configured inputs in question are unreliable.

Back to Signal Select Attributes.
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Setup
Defines whether the Failsoft or Last Reliable value needs to be the output if the object becomes unreliable.

Back to Signal Select Attributes.

Signal Select Commands
The table below lists the commands supported by the Signal Select Object.

Table 328: Signal Select Object Commands
ParametersCommand Name

Disable

Enable

Signal Select Command Details
Disable
Locks out all outputs and prevents the Signal Select functionality.

Back to Signal Select Commands.

Enable
Ensures object reacts to any changes it may have missed while it was disabled and returns it to normal operation.

Back to Signal Select Commands.

605Metasys System Online Help PDF



Site Object
The Site object defines the attributes that represent the characteristics of a site. If the Site object exists on a device,
that device is considered a Site Director.

Note: In SCT, it is possible for a site object to exist without a Site Director. In this case, you can open the edit
window and make changes to the custom object category; however, you cannot save any changes until you
add a Site Director.

Note: When promoting or demoting a Site Director offline in SCT, the custom categories are rebuilt using their
default settings.

Note: If you need to change the name of the Site object, make sure you first close all user views. This action ensures
that all object references throughout the site reflect the new site object name.

For general information on Metasys system objects, see the Object Help section.

Site Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 329: Site Object Attributes - Site View Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

FalseCWTrue or FalseAll Items Update in
Progress

0–255140CWNumberAnnotation Alarm
Priority Threshold

Maximum length = 400CWListAnnotation Exclude

Maximum length = 400CWListAnnotation Include

Uses Bacnet Encoding (Set 575).

0 = Unicode

1 = ASCII

2 = Japanese Shift JIS

Unicode (0)CWOne type from a setBACnet Encoding Type

False (0)CWTrue or FalseBACnet Site

FalseCWTrue or FalseBroadcast Disabled2

Uses Dictionary LanguageCWOne type from a setDefault Language2

0–65535

Units = minutes

20CWNumberDNS Refresh Period

0–255255CWNumberDefault ADS Priority
Threshold

Uses Connection Type (Set 147).

0 = LAN

1 = Dial

LANCWOne type from a setDefault ADS
Connection Type

12:15 AMCWDate/TimeDefault ADS Delivery
Time

0.0.0.0CWSet of valuesDefault ADSRepository

CWList of value setsDevice Time Servers
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Table 329: Site Object Attributes - Site View Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueTrue or FalseDynamic Broadcast
Management

CWSet of ValuesFile Name2

CWTextMulticast Group
Address

Units = Minutes5CWNumberMulticast Heartbeat
Interval

0–2551CWNumberMulticast TTL

0–65, 535123CWNumberMulticast UDP Port

Fast, Medium, SlowFastCWOne type from a setPoll Rate

Low (0), Medium (1), High (2)Medium (1)CWOne type from a setSecurity Level2

0–255140CWNumberSignature Alarm
Priority Threshold

Maximum length = 400CWListSignature Exclude

Maximum length = 400CWListSignature Include

0.0.0.0CWSet of valuesSite Director

CWList of value setsSite Time Servers

CWList of value setsThird Party BBMDs

CWOne method from a
set

Time Sync Method

CWNumberTime Sync Period

Uses Time Zone (Set 576).Central Time

(US and Canada)

CWOne zone from a setTime Zone

1 C - Configurable, W - Writable
2 This attribute appears only in the Snapshot Focus view.

Note: The changes made to labels on Object Categories in the Site Object are shown in the Security Administrator
screens. Refer to the Object Category Assignment section of the Security Administrator System Technical
Bulletin (LIT-1201528) for more information on changing Object Categories labels and how these changes
affect the UI.

Table 330: Site Object Attributes - Object Categories Tab
Initial TextObject Category

Standard Object Category1

HVACHVAC

FireFire

SecuritySecurity

ServicesServices

AdministrativeAdministrative

GeneralGeneral

LightingLighting

RefrigerationRefrigeration

Critical EnvironmentCritical Environment
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Table 330: Site Object Attributes - Object Categories Tab
Initial TextObject Category
Air QualityAir Quality

EnergyEnergy

SystemSystem

Custom Object Category2

Custom 1 - Custom 150 (default)Custom 1 - Custom 150
Note: Devices at a release earlier than 5.2 are limited to

12 categories.

1 Standard Object strings cannot be modified.
2 Display text can be modified.

Site Attribute Details
All Items Update in Progress
Indicates when the cache update completes after executing an Update All Items Cache command. Beginning with
Release 5.0, the All Items navigation tree in the Metasys UI depends on the data cached in the Site Director, called
the All Items cache. The All Items cache automatically updates for engines at Release 5.0 or later. The cache does
not automatically update for engines at a Release prior to 5.0 after making changes the UI logged directly into the
engine (that is, not through the Site Director), or when downloading an engine from the SCT (not via the Site Director).
For these scenarios, you must use the Update All Items Cache command to update the All Items cache on the Site
Director. This attribute appears only in the online UI.

Back to Site Attributes.

Annotation Alarm Priority Threshold
Specifies the value that represents the range of alarm priority thresholds. The default value is 140. This attribute is
checked when determining whether an event requires annotation on an ADX MVE installation. If the Event Priority
value is below the threshold, annotation is required. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).

Back to Site Attributes.

Annotation Exclude
Specifies a list of editable reference strings (fully qualified references) that allow wild card notation at any location
in the string. If an item reference appears in this attribute, an event for this item does not require an annotation on
an ADX MVE installation. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).

Back to Site Attributes.

Annotation Include
Specifies a list of editable reference strings (fully qualified references) that allow wild card notation at any location
in the string. If an item reference appears in this attribute, an event for this item requires an annotation on an ADX
MVE installation. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).

Back to Site Attributes.
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BACnet Encoding Type
Specifies the type of string encoding to use in BACnet messages. Unicode should be specified unless third-party
BACnet devices are employed on the site. In this case, specify the BACnet encoding type supported by the third-party
BACnet devices. This attribute is automatically distributed to the site devices.

For information on how to set up an NAE as a BACnet system integrator in a Metasys system network, see the
Related Documentation table in the Welcome section.

Back to Site Attributes.

BACnet Site
Specifies whether specific information from the BACnet device for each Metasys object is shown in the UI. When
true, BACnet information integrates into the UI for objects. When false, the information is omitted. Internally, the
BACnet protocol is used at a certain level regardless of this attribute. This attribute is distributed automatically to
site devices.

For information on how to set up an NAE as a BACnet system integrator in a Metasys system network, see the
Related Documentation table in the Welcome section.

Back to Site Attributes.

Broadcast Disabled
Specifies if broadcast messages are sent by the device. When false (default value) or no Broadcast Management
object exists, the device sends broadcast messages as defined by BACnet communication. When the Broadcast
Management object is configured and this attribute is true, the device does not send network broadcast messages.
This attribute appears only in the Snapshot Focus view.

Back to Site Attributes.

DNS Refresh Period
Specifies the time in minutes between DNS lookups to update the IP address of BACnet Broadcast Management
Device (BBMD)s referenced by host name. If an IP address is changed within a DNS server, the BBMD system
automatically obtains the new IP address upon the expiration of this period. A value of 0 is used to disable periodic
DNS lookups.

Back to Site Attributes.

Default ADS Connection Type
Specifies whether the ADS (identified in the Default ADS Repository attribute) is connected via a LAN or dial-up
connection. This attribute is distributed automatically to the site devices.

Back to Site Attributes.

Default ADS Delivery Time
Specifies the time of day when a connection should be established to the ADS (identified by the Default ADS
Repository attribute). A connection is attempted at least daily at the specified time to deliver audit, alarm, and trend
data to the ADS. This attribute is distributed automatically to the site devices.

Back to Site Attributes.

Default ADS Priority Threshold
Allows you to specify the priority of an event that triggers the Engine to connect (dial-up or LAN connection) to the
defined ADS/ADX and deliver the event messages from the Engine local event repository to that ADS/ADX’s event
repository. This attribute is used for Alarm and Event Management only.

For example, a value of 20 for this attribute means that any event having a priority of 20 or higher (1 is highest)
forces a connection to the ADS/ADX and forwards event messages from the Engine local event repository to the
ADS/ADX’s repository.

Back to Site Attributes.
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Default ADS Repository
Specifies the resolvable host name or IP address of an ADS. The ADS is the device to which local audit, alarm, and
trend data is delivered. Repository refers to the files in the ADS in which this data is stored. A host name may be
specified only if a DNS server is available to the device. This attribute is distributed automatically to the site devices.

The Default ADS Repository of the Site is intentionally left blank and must be updated by the user (online or offline).
If the user does not populate the Default ADS value and leaves the Default ADS Repository value for all devices at
0.0.0.0, the ADS does not receive any audit, alarm, or trend data. The SCT does not automatically populate the
Default ADS Repository value because of the many different possibilities that could exist during archive creation,
including multiple ADSs on a site or no ADS for a site. In these cases, it would not be immediately clear which ADS
should be the Default ADS under the Site object.

Back to Site Attributes.

Default Language
Specifies the site's default language. All devices on the site have a dictionary using this language. This attribute
appears only in the Snapshot Focus view.

Back to Site Attributes.

Device Time Servers
This attribute is used only for Windows time synchronization. Leave this attribute blank if you are not using
Windows time synchronization. Specifies a list of resolvable host names or IP addresses of Simple Network Time
Protocol (SNTP) server devices that the devices on the site (except the Site Director) use as their time server.
Periodically, each device on the site (except the Site Director) attempts to synch time from an SNTP server from
this list. Contact with an SNTP server is attempted one at a time in list order until one successful contact is made.
A host name may be specified only if a DNS server is available to the site server. If the site server is also an SNTP
time server, the site server may be specified in this attribute. This attribute is distributed automatically to the site
devices.

Note: The NxE/ADS/ADX designated as the Site Director is the device time server for the site and provides the
time management for all other engines/servers on the site.

Note: The Engine accepts BACnet Time Sync messages only if no SNTP server is defined for that Engine.

Refer to the NAE and ADS commissioning documents listed in the Related Documentation table in the Welcome
section for information on time management.

Back to Site Attributes.

Dynamic Broadcast Management
Configures the Metasys system with BBMDs automatically when a Metasys system includes more than one IP subnet
so that BACnet protocol broadcasts reach all Metasys system devices. The feature automatically determines the
number of IP subnets and ensures that each IP subnet has exactly one BBMD. The feature uses the Third Party
BBMDs List attribute when determining the list of devices to be BBMDs.

When True, the selection of broadcast management devices occurs automatically as devices are added or removed
from the site. When False, the selection of devices occurs only when the Update Broadcast Management command
is issued to the site.

Back to Site Attributes.

File Name
Specifies an XML file containing site organization data within the file system of the host computer. This attribute
appears only in the Snapshot Focus view.

Back to Site Attributes.

Multicast Group Address
Specifies the IP address used to multicast the SNTP message. The RFC-2030 defined standard address is 224.0.1.1.
The address is configurable to allow site-specific use.
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Back to Site Attributes.

Multicast Heartbeat Interval
Specifies the number of minutes between forcing a multicast time synchronization message.

Back to Site Attributes.

Multicast TTL
Specifies the Time-to-Live for a multicast message. The value indicates the number of router hops allowed before
the message is not sent. Routers must be configured to pass multicast messages to allow the time sync message
to pass.

Back to Site Attributes.

Multicast UDP Port
Specifies the UDP port on which multicast time synchronization polls and listens for messages. The RFC-2030
defined standard port is 123.

Back to Site Attributes.

Object Category
Allows the customization of text in the custom categories. The description entered in the Display Text field is limited
to 50 characters and can include any printable character. This description cannot be blank and cannot duplicate any
other description. For more information, see Common Object Attributes.

Back to Site Attributes.

Poll Rate
Specifies the frequency at which the Site Director checks its communication status with site devices. This setting
affects the detection time of offline NxEs, and the amount of network bandwidth needed to support this detection.
At the default setting Fast, the detection time is short, but the network bandwidth use is high. At a Slow setting, the
detection time is longer, but network bandwidth use is low. The calculated Detection Interval is shown in the NxE.
This setting only affects communications with devices at Release 5.2 or later.

Back to Site Attributes.

Security Level
Specifies the security level to be used by this device. This attribute is distributed to the site's devices automatically.
This attribute appears only in the Snapshot Focus view. Valid options include:
• Low [0]: Logon required.
• Medium [1]: Low plus authorization.
• High [2]: Medium plus signatures.

Back to Site Attributes.

Signature Alarm Priority Threshold
Specifies the value that represents the range of alarm priority thresholds. The default value is 140. This attribute is
checked when determining whether an event requires electronic signature on an ADX MVE installation. If the Event
Priority value is below the threshold, a signature is required. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).

Back to Site Attributes.

Signature Exclude
Specifies a list of editable reference strings (fully qualified references) that allow wild card notation at any location
in the string. If an item reference appears in this attribute, an event for this item does not require a signature on an
ADX MVE installation. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).
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Back to Site Attributes.

Signature Include
Specifies a list of editable reference strings (fully qualified references) that allow wild card notation at any location
in the string. If an item reference appears in this attribute, an event for this item requires a signature on an ADX
MVE installation. This attribute appears only when you have MVE installed.

For more information, refer to Configuring Annotation and Electronic Signature Requirements in the Site Object in
MVE and the Metasys for Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).

Back to Site Attributes.

Site Director
Specifies a resolvable host name or IP address of the Site Director. A host name may be specified only if a DNS
server or other means of name resolution is available to the device. A Site Director may have more than one host
name. The host name specified here must be resolvable to an IP address on the LAN or WAN on which the site’s
devices exist.

Back to Site Attributes.

Site Time Servers
Specifies a list of resolvable host names or IP addresses of SNTP server devices that the Site Director uses as its
time server. Periodically, the site director attempts to synch time from an SNTP server from this list. Contact with
an SNTP server is attempted one at a time in list order until one successful contact is made. A host name may be
specified only if a DNS server is available to the site server.

Note: The Site Director provides the time management for the site.

Note: On the NAE35/NAE45/NCE25, only the first listed address is used.

Note: An error message appears when you have configured one or more Site Time Servers and attempt to change
the time and date using the Set Time and Set Date commands.

Note: The Engine accepts BACnet Time Sync messages only if no SNTP server is defined for that Engine.

Note: The Site Time Servers attribute must be set to an SNTP server to facilitate synchronization when in Multicast
mode. Only the first Site Time Server is used if more than one is specified in Multicast mode.

Refer to the NAE and ADS commissioning documents listed in the Related Documentation table in the Welcome
section for information on time management.

Back to Site Attributes.

Third Party BBMDs
The Third Party BBMDs attribute is used by the Dynamic Broadcast Management feature to help determine the
placement of BBMDs.

BBMDs are used in the BACnet protocol to eliminate broadcast messages sent across multiple subnets on an IP
network. A single device on each subnet, referred to as the BBMD, receives messages from other BBMDs and
broadcasts them locally on its own subnet.

If one or more third-party BBMDs exist, this attribute should specify the complete list of IP addresses of third-party
BBMDs and Metasys system devices that should act as a BBMD. Each IP subnet should have exactly one BBMD,
either a third-party or Metasys system device. To function properly, each third-party BBMD must be configured with
the list of all other BBMDs within the system as well.

If the Metasys system does not include any third-party BBMDs, then this attribute typically should be left empty. A
possible exception would be if you want to designate a particular Metasys system device as a BBMD, then that
device could be added to the Third Party BBMD list. If no device is specified by this attribute for an IP subnet, the
Dynamic Broadcast Management feature automatically assigns a Metasys system device. Do not specify more than
one Metasys system device per IP subnet.

The devices are configured in the Third Party BBMD list in the following ways:
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Third-Party Devices
Table 331: Configuring Third-Party Devices in the Third Party BBMD List

DescriptionField
Use the BACnet UDP Port address. The default is 47808.Address-UDP Port

Use the IP address of the device.Address-IP

Use the BACnet Broadcast Mask as defined by BACnet standard 135-2004, section J.4.3.2. Specify
255.255.255.255 if messages should be directly sent to remote BBMDs using a unicast IP address
or broadcast messages are not allowed through the IP router to the remote subnet.

Otherwise, specify the subnet mask of the remote subnet if broadcast messages are allowed through
the IP router to a remote subnet.
Note: In most cases, IP routers do not allow broadcast messages to be passed to a remote subnet;

therefore, the mask should be set to 255.255.255.255. If the IT department knows that
broadcast messages are allowed to the remote subnet, then set the mask to the subnet
mask that the BBMD resides upon.

IP Broadcast Mask

Metasys System Devices
Table 332: Configuring Metasys System Devices in the Third Party BBMD List

DescriptionField
Use the BACnet UDP Port address. The default is 47808.Address-UDP Port

Use the IP address of the device.Address-IP

Use the Subnet Mask of the Metasys system device.

Important: This is not the broadcast mask for Metasys system devices. Metasys
system devices automatically use 255.255.255.255 for the broadcast
mask.

IP Broadcast Mask

For information on how to set up an NAE as a BACnet system integrator in a Metasys system network, see the
Related Documentation table in the Welcome section.

Back to Site Attributes.

Time Sync Method
Determines which mode is used to synchronize time. The available modes are Windows or Multicast. Windows
mode uses the Microsoft W32Time service. Multicast mode uses a specific implementation of the standard SNTP,
which includes periodic multicasting of system time to maintain better time synchronization across devices.

Time Sync Period
Specifies the interval at which the Site Director polls the defined Site Time Server (STS) (for example, the Atomic
clock) for the time. We recommend leaving the default value for this attribute. This attribute applies only to the Engine.
The time zone is set through the Windows operating system on ADS/ADX computers.

For more information on managing time in the Metasys system, see the NAE and ADS commissioning documents
listed in the Related Documentation table in the Welcome section.

Back to Site Attributes.

Time Zone
Specifies the site’s time zone. The Site object determines and updates the UTC offset from this value. Once set in
the Site object, the time zone is propagated to the other devices on the site.

Note: All Metasys devices that are part of the Site use the time zone of the Site Director, even if some of those
devices are physically located in a different time zone.

For more information on managing time in the Metasys system, refer to the the NAE and ADS commissioning
documents listed in the Related Documentation table in the Welcome section.

Back to Site Attributes.
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Site Commands
The following table lists the commands supported by the Site Object.

Table 333: Site Object Commands
ParametersCommand Name

Global Time Synchronization

Set Date

Set Time

Update All Items Cache

Update Broadcast Management

Site Command Details
Global Time Synchronization
Allows the user to send a broadcast time synchronization message. This command takes a single enumeration
parameter from the global time synchronization type enumeration to specify whether to send local time, UTC time,
or both.

Back to Site Commands.

Set Date
Sets the clock date in the site server. If any Site Time Servers are specified, this command fails and the date is not
modified. This command is only used when an engine is the Site Director. When the Site Director is an ADS or ADX,
the Set Date command is not needed.

Back to Site Commands.

Set Time
Sets the clock time in the site server. If any Site Time Servers are specified, this command fails and the time is not
modified. This command is only used when an engine is the Site Director. When the Site Director is an ADS or ADX,
the Set Time command is not needed.

Back to Site Commands.

Update All Items Cache
Updates the data cached in the Site Director for pre-Release 5.0 engines in the site. The All Items Update in Progress
attribute indicates when the update completes. This command has no behavioral effect when no pre-Release 5.0
engines exist on the site. Beginning with Release 5.0, the All Items navigation tree in the Metasys UI depends on
the data cached in the Site Director, called the All Items cache. The All Items cache automatically updates for engines
at Release 5.0 or later. The cache does not automatically update for engines at a Release prior to 5.0 after making
changes the UI logged directly into the engine (that is, not through the Site Director), or when downloading an engine
from the SCT (not via the Site Director). For these scenarios, you must use this command to update the All Items
cache on the Site Director.

Back to Site Commands.

Update Broadcast Management
Causes the selection of broadcast management devices to occur. This command, in combination with the Dynamic
Broadcast Management attribute, allows the device selection to be done on an as needed basis, instead of
automatically.

Back to Site Commands.
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Solar Clock Object
The solar clock object computes Present Value (Night/Day), Sun Position (Azimuth and Elevation), and Sunrise and
Sunset times based on the local position (Latitude and Longitude) and local time and time zone information. This
information is needed to control external motorized louvers as part of bioclimatic facades for buildings and may also
be used to position tracking photovoltaic solar arrays. The Sunrise/Sunset times can be used for external lighting
control.

This object runs on a periodic basis to compute its attributes. The equations to compute azimuth, elevation, sunrise,
and sunset attributes were obtained from the National Oceanic and Atmospheric Administration (NOAA) Web site
(http://www.noaa.gov/). The object obtains the Local Time, UTC Offset, DST Status, and DST Offset from the BACnet
Device object.

Latitude and Longitude for this object are provided in decimal degrees. Often, these values are provided as degrees,
minutes, and seconds. There are numerous Web sites that can convert the latitude and longitude values, if necessary.
In addition, you can obtain your current location on the planet from free tools such as Google® Earth. Google Earth
includes an option to provide your location in decimal degrees.

Note: For correct sunrise and sunset calculations, you must apply north/south and east/west rules. North latitudes
are preceded by a plus, South latitudes are preceded by a minus. West Longitudes are preceded by a minus,
East Longitudes are preceded by a plus. See Table 334.

Table 334: Latitude and Longitude Examples
LongitudeLatitudeLandmarkLocation
-87.90445643.037507Brengel Technology CenterMilwaukee, WI, USA

2.34764148.854212Notre Dame CathedralParis, France

18.411073-34.903488Green Point StadiumCape Town, South Africa

151.215176-33.857184Opera HouseSydney, Australia

116.39121339.06514Tiananmen SquareBeijing, China

For general information on Metasys system objects, see Common Object Attributes .

Solar Clock Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See the Object and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Note: For correct sunrise and sunset calculations, you must apply north/south and east/west rules. North latitudes
are preceded by a plus, South latitudes are preceded by a minus. West Longitudes are preceded by a minus,
East Longitudes are preceded by a plus. See Table 334.

Click the attribute name in the table for a description of the attribute.

Table 335: Solar Clock Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

1 = Day

0 = Night

EnumerationPresent Value

Units = Degrees Angular

Range = -90–90

WCAFloatLatitude

Units = Degrees Angular

Range = -180–180

WCAFloatLongitude

Units = Minute

Range = 2–60

5WCASigned16Periodic Update
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Table 335: Solar Clock Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Units = Degrees AngularFloatAzimuth

Units = Degrees AngularFloatElevation

Display = HH:MMTimeSunrise

Display = HH:MMTimeSolar Noon

Display = HH:MMTimeSunset

Units = Minutes

Range = -60–60

WASigned16Offset

Units = MinutesFloatEquation of Time

Units = DegreesFloatSolar Declination

1 A - Archive, C - Configurable, W - Writable

Solar Clock Object Attributes Details
Present Value
Represents an Enumeration value that is true when the current time is between the computed time of Sunrise and
Sunset, where 1 = Day and 0 = Night.

Back to Solar Clock Object Attributes.

Latitude
Defines the angular distance, in decimal degrees, of the current location north or south of the equator. Lines of
latitude are also known as parallels. The International standard defines north latitudes as positive values.

Back to Solar Clock Object Attributes.

Longitude
Defines the angular distance, in decimal degrees, of the current location east or west of the Prime Meridian. Lines
of longitude are also known as meridians. The International standard defines east longitude as positive values.

Back to Solar Clock Object Attributes.

Periodic Update
Determines how often sun position and Present Value attributes update during normal operation. The default value
is 5 minutes.

Back to Solar Clock Object Attributes.

Azimuth
Defines the angular measurement in a spherical coordinate system. The vector from an observer (origin) to a point
of interest (sun) is projected perpendicularly onto a reference plane; the angle between the projected vector and the
reference vector on the reference plane is called the azimuth. It is defined as the angle from due north in a clockwise
direction.

Back to Solar Clock Object Attributes.

Elevation
Defines the angle between the direction of the geometric center of the sun's apparent disk and the idealized horizon.

Back to Solar Clock Object Attributes.

Sunrise
Defines the time of apparent sunrise in hours and minutes. Sunrise may not occur in the same calendar day as
sunset. Due to changes in air pressure, relative humidity, and other factors, we cannot predict the exact effects of
atmospheric refraction on sunrise time. The error may increase with higher latitudes (closer to the poles).

Back to Solar Clock Object Attributes.
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Solar Noon
Defines the time when the sun crosses the meridian of the observer's location. At solar noon, a shadow cast by a
vertical pole points either directly north or directly south, depending on the observer's latitude and the time of year.

Back to Solar Clock Object Attributes.

Sunset
Defines the time of apparent sunset in hours and minutes. Sunset may not occur in the same calendar day as sunrise.
Due to changes in air pressure, relative humidity, and other factors, we cannot predict the exact effects of atmospheric
refraction on sunset time. The error may increase with higher latitudes (closer to the poles).

Back to Solar Clock Object Attributes.

Offset
Defines an offset to the computed Sunrise and Sunset times. The offset value is used to compute Present Value. A
positive value makes the day longer and a negative value makes the day shorter.

Back to Solar Clock Object Attributes.

Equation of Time
Represents an astronomical term accounting for changes in the time of solar noon for a given location over the
course of a year. Earth's elliptical orbit and Kepler's law of equal areas in equal times are the factors behind this
phenomenon.

Back to Solar Clock Object Attributes.

Solar Declination
Defines the declination of the Sun. The declination varies from 23.44° at the winter solstice in the northern hemisphere,
through 0° at the vernal equinox, to +23.44° at the summer solstice. The variation in the solar declination is the
astronomical description of the sun going south in the northern hemisphere for the winter. For a ground-based view
of the seasonal solar paths for different latitudes, use 0° for the Equator, 23°N for the Tropic of Cancer, 40°N for
Boulder, CO, 71°N for the Arctic Circle, and 90° for the North Pole.

Back to Solar Clock Object Attributes.

Solar Clock Object Commands
This object has no commands.

For managing outside lighting schedules, use the day / night present value status of this object with an Interlock
Object's definition to drive the Action Tables for the Actions of Conditions setup.
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Summary Definition Object
The Summary Definition object is an integral part of the Tailored Summary feature. This object allows you to view
and edit the columns and key data values used in a Tailored Summary based user view. Tailored summaries are
essentially summary views of Metasys system items where the rows and columns of the summary are tailored to
contain information of interest.

A summary definition contains the column rules and key data rules used to display a tailored summary. Each column
may contain a column heading, an item name or Fully Qualified Reference (FQR), and attribute to display in that
column. Each key data item may contain an item name to display in a tailored summary in a header section outside
of the data table. After defining the columns and key data items in the summary definition, you can associate that
definition with a user view folder using the user view editor.

For information on how this object interacts with the Tailored Summary and User View features, see Tailored
Summaries. For information on the User View feature, see User Views.

For general information on Metasys system objects, see the Object Help section.

Summary Definition Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in theCommonObject Attributes section. For information on the Tailored Summary feature, see Tailored Summaries.

Click the attribute name in the table for a description of the attribute.

Table 336: Summary Definition Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Limit of 4 key itemsCNWList of StringsKey Data

1 C - Configurable, N - Value Not Required, W - Writable

Table 337: Summary Definition Object Attributes - Summary Definition Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Column Heading, Child Item, AttributeCWList of StructuresColumn Definition

Label

Maximum: 50 characters

CNWTextRow Heading Column
Text

1 C - Configurable, N - Value Not Required, W - Writable

Summary Definition Attribute Details
Column Definition
Defines the columns displayed in a tailored summary. You can define up to seven columns (list of structures).

Each structure contains the following information:

• Column Heading - Defines the name of the column header.
• Child Item - Indicates item for which the column data is retrieved based on its name attribute, which must match

a user-specified pattern (such as ZN-* or ZN-T, Zone-T). To display an attribute of the row item, leave this field
blank. Otherwise, specify the name of the child item to display.

• Attribute - Defines the attribute information for the column. The attributes are grouped into categories for easy
selection. Select a category in the Attribute Filter section of the Select Column Attribute dialog, and then select
the desired attribute from the list.

Back to Summary Definition Attributes.

Key Data
Holds the item name or Fully Qualified Reference of a key item to display in a tailored summary. You can configure
up to four key items.

Back to Summary Definition Attributes.
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Row Heading Column Text
Defines the text to display as the label for the row headings column (that is, the first column) in a tailored summary.

Back to Summary Definition Attributes.
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User Navigation Tree
The user navigation tree object defines the attributes that represent the navigation tree.

For information on the Tree View and the User View feature, see User Views.

For general information on Metasys system objects, see the Object Help section.

User Navigation Tree Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. See the Object and Feature Tabs section for information on the attributes
that appear on the other tabs of this object (for example, the Hardware and Options tab appear on point objects).

See Tree View Tab in the User Views section for details on the buttons of the tab.
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VND Controller
The VND (Vendor) Controller object defines a physical vendor device on a bus of the NAE and is required for mapping
data from the controller into the system.

For general information on Metasys system objects, see the Object Help section.

VND Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 338: VND Controller Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseEnabled

Object Type = GraphicNullCNWObject ReferenceGraphic

Maximum 256 charactersCWTextGraphic Alias

TrueTrue or FalseOffline

Offline, Online, Pass Through, Comm
Disabled, Comm Enabled

DOne value from a setPresent Value

1 C - Configurable, D - Default Attribute for Display, W - Writable

Table 339: VND Controller Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberCount

0NumberErrors In

0NumberErrors Out

0NumberMessage Receives

0NumberMessage Transmits

DateReset Date

TimeReset Time

0NumberTransmits In

0NumberTransmits Out

1 C - Configurable, W - Writable

VND Controller Attribute Details
Count
Displays the number of point objects defined for the vendor device.

Back to VND Controller Attributes.

Enabled
If True, allows communication to the vendor device. If False, prevents communication to the vendor device.

Back to VND Controller Attributes.
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Errors In
Indicates the number of field communication errors (bad format, for example) received. The Clear Statistics command
resets this value.

Back to VND Controller Attributes.

Errors Out
Indicates the number of field communication attempts that failed. The Clear Statistics command resets this value.

Back to VND Controller Attributes.

Graphic
Indicates the graphic associated with the vendor device.

Back to VND Controller Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this vendor
device.

Back to VND Controller Attributes.

Message Receives
Indicates the number of messages received by the vendor device. This value resets to zero at midnight. The Latch
Statistics command updates this value.

Back to VND Controller Attributes.

Message Transmits
Indicates the number of messages sent to the vendor device. This value resets to zero at midnight. The Latch
Statistics command updates this value.

Back to VND Controller Attributes.

Offline
Displays the offline or online status of connected hardware.

Back to VND Controller Attributes.

Present Value
Represents the current communication state of the object.

Back to VND Controller Attributes.

Reset Date
Contains the date stamp of the last Clear Statistics command.

Back to VND Controller Attributes.

Reset Time
Contains the time stamp of the last Clear Statistics command.

Back to VND Controller Attributes.

Transmits In
Indicates the rate of transmissions received by the vendor device.

Back to VND Controller Attributes.

Transmits Out
Indicates the rate of transmissions sent by the vendor device.

Back to VND Controller Attributes.

VND Controller Commands
The table below lists the commands supported by the VND Controller.
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Table 340: VND Controller Object Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics

VND Controller Command Details
Clear Statistics
Resets the statistics for the vendor device.

For information on gathering this statistical information, see the Latch Statistics command.

Back to VND Controller Commands.

Disable
Disables the vendor device.

Back to VND Controller Commands.

Enable
Allows the vendor device to function normally.

Back to VND Controller Commands.

Latch Statistics
Updates the displayed statistics with the current values.

For information on clearing this statistical information, see the Clear Statistics command.

Back to VND Controller Commands.
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VND Integration Object
The VND (Vendor) Integration object defines a vendor integration for the NAE.

For general information on Metasys system objects, see the Object Help section.

VND Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute. Also, see Status.

Table 341: VND Integration Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseEnabled

TrueTrue or FalseOffline

1 C - Configurable, W - Writable

Table 342: VND Integration Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

0NumberCount

0NumberErrors In

0NumberErrors Out

0NumberFunction TimeExceeded

0NumberMessage Receives

0NumberMessage Transmits

0NumberPermanent Status Item
Count

Units = Seconds0NumberPriority 1 Poll Time

DateReset Date

TimeReset Time

0NumberTemporary Status Item
Count

0NumberTransmits In

0NumberTransmits Out

1 C - Configurable, W - Writable

VND Integration Attribute Details
Count
Displays the number of vendor device and point objects defined for the trunk. This count does not include extensions.

Back to VND Integration Attributes.

Enabled
If True, allows the use of the vendor integration. If False, prevents the use of the vendor integration.

Back to VND Integration Attributes.
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Errors In
Indicates the number of field communication errors (bad format, for example) received. The Clear Statistics command
resets this value.

Back to VND Integration Attributes.

Errors Out
Indicates the number of field communication attempts that failed. The Clear Statistics command resets this value.

Back to VND Integration Attributes.

Function Time Exceeded
Indicates the number of functions to the Vendor DLL that took longer than 100 milliseconds to execute. The Clear
Statistics command resets this value.

Back to VND Integration Attributes.

Message Receives
Indicates the number of messages received field devices. This value resets to zero at midnight. The Latch Statistics
command updates this value.

Back to VND Integration Attributes.

Message Transmits
Indicates the number of messages sent to field devices. This value resets to zero at midnight. The Latch Statistics
command updates this value.

Back to VND Integration Attributes.

Offline
Displays the offline or online status of connected hardware.

Back to VND Integration Attributes.

Permanent Status Item Count
Displays the number of items polled as a result of COV signups.

Back to VND Integration Attributes.

Priority 1 Poll Time
Indicates how often the items in the Priority 1 list are polled.

Back to VND Integration Attributes.

Reset Date
Contains the date stamp of the last Clear Statistics command.

Back to VND Integration Attributes.

Reset Time
Contains the time stamp of the last Clear Statistics command.

Back to VND Integration Attributes.

Temporary Status Item Count
Displays the number of items polled.

Back to VND Integration Attributes.

Transmits In
Indicates the rate of transmissions received by the integration.

Back to VND Integration Attributes.

Transmits Out
Indicates the rate of transmissions sent by the integration.
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Back to VND Integration Attributes.

VND Integration Commands
The table below lists the commands supported by the VND Integration Object.

Table 343: VND Integration Object Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics

VND Integration Command Details
Clear Statistics
Resets the statistics for the integrated vendor network.

For information on gathering this statistical information, see the Latch Statistics command.

Back to VND Integration Commands.

Disable
Disables the entire vendor network integration. No requests are made to the field trunk and no data broadcasts to
the network are processed.

Back to VND Integration Commands.

Enable
Allows the integration to function normally.

Back to VND Integration Commands.

Latch Statistics
Updates the displayed statistics with the current values.

For information on clearing this statistical information, see the Clear Statistics command.

Back to VND Integration Commands.
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Wireless Receiver Object
The Wireless Receiver object is the field device of the Wireless Sensor integration. The Wireless Receiver object
establishes communication with the wireless receiver hardware.

All integrated wireless field devices (Wireless Receiver objects) and field point objects (Wireless Sensor Object)
appear under the Wireless Receiver Supervisor Object in the Navigation Tree.

For general information on Metasys system objects, see the Object Help section.

Wireless Receiver Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 344: Wireless Receiver Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

CWObject referenceGraphic

Maximum 256 charactersCWTextGraphic Alias

TextHost Name

xxx.x.x.xxx0.0.0.0CWSet of valuesIP Address

True or FalseLow Battery

Range = 120–480 seconds150CWNumberMax Data Life

Range = 1–50CNumberNetwork Address

Uses Controller Status (Set 43).One value from a
set

Present Value

1 C - Configurable, W - Writable

Table 345: Wireless Receiver Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

mmyyNumberDate of Manufacture

NumberFirmware Version

NumberHardware Version

1 C - Configurable, W - Writable

Wireless Receiver Attribute Details
Date of Manufacture
Indicates the date the wireless receiver was manufactured.

Back to Wireless Receiver Attributes.

627Metasys System Online Help PDF



Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to Wireless Receiver Attributes.

Firmware Version
Indicates the firmware version of the wireless receiver.

Back to Wireless Receiver Attributes.

Graphic
Indicates the graphic associated with the object.

Back to Wireless Receiver Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to Wireless Receiver Attributes.

Hardware Version
Indicates the hardware version of the wireless receiver.

Back to Wireless Receiver Attributes.

Host Name
Indicates the host name of the wireless receiver. When a host name is given, the system attempts to resolve the
Host Name and IP Address using DNS/DHCP (assuming that the installer assigned a host name to the wireless
receiver and enabled DHCP). If the device can be located using the ping hostname command, the system can
resolve the host name to an IP address. After resolving the host name, the system updates the IP address.

Back to Wireless Receiver Attributes.

IP Address
Indicates the IP Address of the wireless receiver.

Back to Wireless Receiver Attributes.

Low Battery
Indicates if any wireless sensors defined as children of the Wireless Receiver object have a low battery. The Low
Battery status is an advanced warning that can occur many days before a wireless sensor ceases to function. You
can configure an alarm for this attribute to allow the building operator time to locate the sensor and change the
battery.

Back to Wireless Receiver Attributes.

Max Data Life
Indicates the maximum amount of time in seconds that the wireless receiver module waits for a transmission from
a wireless sensor before generating a report that tells the NAE that the Wireless Sensor Object is unreliable due to
Data Life Timeout.

Back to Wireless Receiver Attributes.

Network Address
Indicates the network address of the wireless receiver. You can define only up to 50 wireless receivers per Wireless
Receiver Supervisor Object.

Back to Wireless Receiver Attributes.
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Present Value
Indicates the online/offline state of the wireless receiver.

Back to Wireless Receiver Attributes.

Status
Indicates the following status of the object:

Offline Communication with the physical hardware has failed.

Back to Wireless Receiver Attributes.
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Wireless Sensor Object
There is a Wireless Sensor object is the field point object for each wireless temperature sensor mapped to the NAE.
The Wireless Sensor object receives communications from the wireless sensor.

All integrated wireless field points (Wireless Sensor objects) appear under the Wireless Receiver Objects (field
devices), which appear under the Wireless Receiver Supervisor Object in the Navigation Tree.

For general information on Metasys system objects, see the Object Help section.

Wireless Sensor Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Table 346: Wireless Sensor Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Reliability from the Reliability attribute.Object ReferenceLow Battery

Range = -10 to 100

Units from the Units attribute.

3.0CWReal valueMax Value

Range = -10 to 100

Units from the Units attribute.

-3.0Real valueMin Value

CWObject ReferenceOccupancy Request

Uses Unocc Occ (Set 106).One state from a setOccupancy Status

Range = 2–240 minutes2CWNumberOccupancy Time

CNWAttribute ReferenceOccupied Output

Range = +/- 3 degrees

Units from the Units attribute.

0CWReal valueOffset

Units from the Units attribute and
reliability from the Reliability attribute.

Real valuePresent Value

Range = 1–311CWNumberProperty Code

Uses Reliability Action (Set 14).NoneCWOne state from a setReliability Action

Units from the Units attribute and
reliability from the Reliability attribute.

Real valueSetpoint

CNWAttribute ReferenceSetpoint Output

Units = MinutesNumberTime Remaining

Range = 1–5110CWNumberTransmitter Id

Uses Unit Set (Set 869).Deg FCWOne type from a setUnits

CNWAttribute ReferenceZone Temp Output

1 C - Configurable, N - Value Not Required, W - Writable

Table 347: Wireless Sensor Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberMissed Transmissions

NumberRF Quality
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Table 347: Wireless Sensor Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberRx Data Life Errors

Units = PercentObject ReferenceSignal Strength

1 C - Configurable, N - Value Not Required, W - Writable

Wireless Sensor Attribute Details
Low Battery
Indicates if any wireless sensors defined as children of the Wireless Receiver Objects have a low battery. The Low
Battery status is an advanced warning that can occur many days before a wireless sensor ceases to function. You
can configure an alarm for this attribute to allow the building operator time to locate the sensor and change the
battery. The sensor sends a low battery signal when there is 30 days of battery life left.

Back to Wireless Sensor Attributes.

Max Value
Indicates the maximum value allowed for the Setpoint. This is the value of the Setpoint attribute when the Setpoint
adjust dial on the wireless sensor is in the fully clockwise position.

If the Min Value is greater than the Max Value, the Setpoint is forced to the Min Value. Otherwise, these attributes
are all used to compute the Setpoint with the following formula:

SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Back to Wireless Sensor Attributes.

Min Value
Indicates the minimum value allowed for the Setpoint. This is the value of the Setpoint attribute when the Setpoint
adjust dial on the wireless sensor is in the fully counterclockwise position.

If the Min Value is greater than the Max Value, the Setpoint is forced to the Min Value. Otherwise, these attributes
are all used to compute the Setpoint with the following formula:

SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Back to Wireless Sensor Attributes.

Missed Transmissions
Indicates the number of wireless sensor transmissions missed by the wireless receiver. The Wireless Receiver
Supervisor Object’s Clear Statistics command resets this attribute.

Back to Wireless Sensor Attributes.

Occupancy Request
Represents an object reference to the Binary Value object that represents the BV 0 Occupancy Request object of
the Zone Sensor device.

Back to Wireless Sensor Attributes.

Occupancy Status
Changes to Occupied after pushing the Temporary Occupied button on the Transmitter, if supported by that model.
The Occupied state is held for the minutes defined by the Occupancy Time attribute, or until cancelled by a release
command.

Back to Wireless Sensor Attributes.

Occupancy Time
Indicates the time in minutes that the Occupied Output (if defined) is overridden to the Occupied state after pushing
the Temporary Occupied button on the Transmitter.

Back to Wireless Sensor Attributes.
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Occupied Output
Provides an optional reference to a binary object located anywhere on the Metasys network. The binary object is
commanded to Occupied/Unoccupied when the Occupancy Status attribute changes states.

Note: The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes to the
output commands.
The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes the None
Data Type value to the release commands.

These operations assume that the referenced object is an output object that has a Present Value that can
be written to. Keep this in mind when mapping objects from controllers. You would normally map these points
as input points (AI, BI, MSI), but for proper operation you must map the points as output points (AO, BO,
MSO).

Back to Wireless Sensor Attributes.

Offset
Indicates the offset value that is added to the zone temperature reading before updating the Present Value, forcing
the Present Value to match a calibrated temperature measured at the wireless sensor.

Back to Wireless Sensor Attributes.

Present Value
Indicates the zone temperature reading at the wireless sensor.

Back to Wireless Sensor Attributes.

Property Code
Indicates the Property Code address of the wireless sensor. This setting must match the Property Code address
switch setting of the wireless temperature sensor.

Back to Wireless Sensor Attributes.

Reliability Action
Indicates the action taken on the three output references ( Zone Temp Output, Setpoint Output, and Occupied
Output) when the wireless sensor object goes Unreliable. The actions are No Action or Release commands.

Back to Wireless Sensor Attributes.

RF Quality
Indicates the signal quality level with respect to unwanted wireless noise or interference. This attribute displays a
number from 0 to 100. A number less than 50 indicates too much interference.

Back to Wireless Sensor Attributes.

Rx Data Life Errors
Indicates the diagnostic measure of the number of Data Life detected by the receiver module. Data Life errors occur
when a wireless sensor does not report its status to the wireless receiver before the Max Data Life timer expires.
The Wireless Receiver Supervisor Object’s Clear Statistics command resets this attribute.

Back to Wireless Sensor Attributes.

Setpoint
Indicates the Setpoint based on three variables: the Setpoint Adjustment reading (the setpoint adjust dial position)
at the wireless sensor, the Min Value, and the Max Value.

The wireless sensor model determines the Setpoint Adjustment. Options include:

• None
• Warmer/Cooler (Range = +/- 5 Deg F)
• Remote Setpoint (Range = 55 to 85 Deg F/13 to 29 Deg C)

632Metasys System Online Help PDF



If the Min Value is greater than the Max Value, the Setpoint is forced to the Min Value. Otherwise, these attributes
are all used to compute the Setpoint with the following formula:

SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Back to Wireless Sensor Attributes.

Setpoint Output
Provides an optional reference to a temperature Setpoint object located anywhere on the Metasys network. The
temperature Setpoint object is commanded when the wireless sensor reports an updated Setpoint value.

Note: The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes to the
output commands.
The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes the None
Data Type value to the release commands.

These operations assume that the referenced object is an output object that has a Present Value that can
be written to. Keep this in mind when mapping objects from controllers. You would normally map these points
as input points (AI, BI, MSI), but for proper operation you must map the points as output points (AO, BO,
MSO).

Back to Wireless Sensor Attributes.

Signal Strength
Indicates the wireless signal strength of the wireless sensor as recorded by the wireless receiver module.

Back to Wireless Sensor Attributes.

Time Remaining
Indicates the time remaining before the Occupied Output (if defined) is released from the Occupied state.

Back to Wireless Sensor Attributes.

Transmitter Id
Indicates the sensor transmitter Id address of the wireless sensor. This setting must match the transmitter Id address
switch setting of the wireless sensor.

Back to Wireless Sensor Attributes.

Units
Indicates the engineering units displayed on the user interface (Deg F or Deg C). All temperature and Setpoint values
convert to the proper units.

Back to Wireless Sensor Attributes.

Zone Temp Output
Provides an optional reference to a temperature input object located anywhere on the Metasys network. The
temperature input object is commanded when the wireless sensor reports an updated Present Value.

Note: The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes to the
output commands.
The Present Value attribute of the referenced object at the Priority Scheduling OST priority writes the None
Data Type value to the release commands.

These operations assume that the referenced object is an output object that has a Present Value that can
be written to. Keep this in mind when mapping objects from controllers. You would normally map these points
as input points (AI, BI, MSI), but for proper operation you must map the points as output points (AO, BO,
MSO).

Back to Wireless Sensor Attributes.
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Wireless Sensor Commands
The table below lists the commands supported by the Wireless Sensor Object.

Table 348: Wireless Sensor Object Commands
ParametersCommand Name
NoneRelease

Wireless Sensor Command Details
Release
Releases the effects of the Temporary Occupancy button pressed at the wireless sensor. This command resets the
Time Remaining and releases any defined outputs.

Back to Wireless Sensor Commands.

634Metasys System Online Help PDF



Wireless Receiver Supervisor Object
The Wireless Receiver Supervisor object is the root of the Wireless Sensor integration. The Wireless Sensor
integration allows the NAE to communicate with the wireless sensing system over the Ethernet network. The Wireless
sensing system consists of wireless receivers and wireless sensors.

All integrated wireless field devices (Wireless Receiver Objects) and field point objects (Wireless Sensor Objects)
appear under the Wireless Receiver Supervisor object in theNavigation Tree. Only one Wireless Receiver Supervisor
object can be configured in each NAE.

For general information on Metasys system objects, see the Object Help section.

Wireless Receiver Supervisor Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 349: Wireless Receiver Supervisor Object Attributes - Focus/Configuration Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

True or FalseLow Battery

Range = 250–2,500 ms1,750WNumberMessage Timeout

Range = 100–1,000 ms100WNumberPoll Delay

Uses Controller Status (Set 43).One value from a
set

Present Value

Range = 3–85WNumberRetries

Range = 1,024–32,7674,050CWNumberUDP Port

1 C - Configurable, W - Writable

Table 350: Wireless Receiver Supervisor Object Attributes - Diagnostic Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

NumberCOV-COS Count

NumberChecksum Errors

NumberCount

NumberNAK Errors

DateReset Date

TimeReset Time

NumberRetry Attempts

NumberTransmits Per Minute

1 C - Configurable, W - Writable

Wireless Receiver Supervisor Attribute Details
COV-COS Count
Indicates the number of reports processed from all mapped wireless sensor transmitters since the last Clear Statistics
command was issued.

Back to Wireless Receiver Supervisor Attributes.
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Checksum Errors
Indicates the number of checksum errors.

Back to Wireless Receiver Supervisor Attributes.

Count
Indicates the number of Wireless Sensor Objects defined for this object.

Back to Wireless Receiver Supervisor Attributes.

Low Battery
Indicates if any wireless sensors defined as children of the Wireless Receiver Objects have a low battery. The Low
Battery status is an advanced warning that can occur many days before a wireless sensor ceases to function. You
can configure an alarm for this attribute to allow the building operator time to locate the sensor and change the
battery.

Back to Wireless Receiver Supervisor Attributes.

Message Timeout
Indicates the maximum delay in milliseconds before retrying to send an online message to a receiver module.

Back to Wireless Receiver Supervisor Attributes.

NAK Errors
Indicates the number of negative acknowledge errors. An NAK is returned by a device to indicate that it received
and decoded a command correctly, but the command did not make sense or could not be carried out. An example
of an NAK is an attempt to read an Analog Input beyond the range of the device.

Back to Wireless Receiver Supervisor Attributes.

Poll Delay
Indicates the maximum delay in milliseconds before stopping attempts to send an offline poll message to a receiver
module.

Back to Wireless Receiver Supervisor Attributes.

Present Value
Indicates the online/offline state of the Wireless Receiver Supervisor integration.

Back to Wireless Receiver Supervisor Attributes.

Reset Date
Indicates the date of the last Clear Statistics command.

Back to Wireless Receiver Supervisor Attributes.

Reset Time
Indicates the time of the last Clear Statistics command.

Back to Wireless Receiver Supervisor Attributes.

Retries
Indicates the number of retries allowed before putting a wireless receiver offline.

Back to Wireless Receiver Supervisor Attributes.

Retry Attempts
Indicates the number of message retry attempts.

Back to Wireless Receiver Supervisor Attributes.

Status
Indicates the following status of the object:

Offline Communication with the physical hardware has failed.
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Back to Wireless Receiver Supervisor Attributes.

Transmits Per Minute
Indicates the number of messages sent to the wireless receivers in 1 minute. This number shows the overall health
of the communications network for the Wireless Sensor system.

Back to Wireless Receiver Supervisor Attributes.

UDP Port
Indicates the UDP Port on the NAE used to communicate to the Ethernet to RS-485 converter. The port must be
1024 or higher, but cannot be equal to the BACnet UDP Port, the N2 Trunk UDP Port, or 9999.

Back to Wireless Receiver Supervisor Attributes.

Wireless Receiver Supervisor Commands
The table below lists the commands supported by the Wireless Receiver Supervisor Object.

ParametersCommand Name
NoneClear Statistics

Wireless Receiver Supervisor Command Details
Clear Statistics
Resets all the attributes containing diagnostic statistics for this Wireless Receiver Supervisor and all its Wireless
Receiver Objects and Wireless Sensor Objects.

Back to Wireless Receiver Supervisor Commands.
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XAML Graphic Object
The Extensible Application Markup Language (XAML) Graphic object defines the attributes that represent a defined
Graphics+ file for a given set of objects. XAML Graphic objects are created exclusively with the Graphic Generation
Tool (GGT) and are saved on an ADS, ADX, SCT computer, or supervisory device as a file with an .xaml file extension.

Note: The Object Type for this object is labeled XAML Graphic in the software.

For detailed information on viewing XAML Graphic objects, refer to the Graphics+ Runtime Help (LIT-12011708).

For detailed information on the Graphic Generation Tool that is used to create and modify XAML Graphic objects,
refer to the Graphic Generation Tool Help (LIT-12011697).

This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section.
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XL5K Controller Object
The XL5K Controller object (Honeywell Excel 5000 [XL-5000]) maps a C-Bus field device to the Metasys system.
The object contains pertinent addressing information.

For general information on Metasys system objects, see the Object Help section.

XL5K Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 351: XL5K Controller Attributes - Focus/Configuration Tab
Values/Options/RangesInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseEnabled

CWObject referenceGraphic

Maximum 256 charactersCWTextGraphic Alias

True or FalseOffline

Uses Controller Status (Set 43).0 (Offline)One state from a setPresent Value

1 C - Configurable, W - Writable

Table 352: XL5K Controller Attributes - Diagnostic Tab
Values/Options/RangesInitial ValueNotes1Data TypeAttribute Name

NumberError Percent

NumberErrors Today

NumberPackets Today

NumberPoint Scan Time

NumberRetries Today

NumberTransmits Per Minute

1 C - Configurable, W - Writable

XL5K Controller Attribute Details
Enabled
If True, allows the controller to be integrated into the Metasys system extended architecture.

Back to XL5K Controller Attributes.

Error Percent
Indicates the computed error rate for communications to the device using the following equation: (Errors Today +
Retries Today) / Number of Packets Today.

Back to XL5K Controller Attributes.

Errors Today
Indicates the number of transmissions (packets) since midnight that had errors (for example, the data was returned,
but the data contained errors).

Back to XL5K Controller Attributes.
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Graphic
Indicates the graphic associated with the object.

Back to XL5K Controller Attributes.

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to XL5K Controller Attributes.

Offline
Indicates the offline/online state of the connected hardware.

Back to XL5K Controller Attributes.

Packets Today
Indicates the number of transmissions (packets) since midnight.

Back to XL5K Controller Attributes.

Point Scan Time
Indicates the total amount of time to scan for point data from this controller.

Back to XL5K Controller Attributes.

Present Value
Indicates the communication status of the device.

Back to XL5K Controller Attributes.

Retries Today
Indicates the number of transmissions (packets) since midnight where no response data was obtained, causing the
transmission to be retried.

Back to XL5K Controller Attributes.

Status
Indicates the following status of the object:

• Disabled: Enabled attribute is False.
• Offline: Communication with the physical hardware has failed.
• Normal: No abnormal condition for this object detected.

Back to XL5K Controller Attributes.

Transmits Per Minute
Indicates the calculated number of transmissions per minute.

Back to XL5K Controller Attributes.

XL5K Controller Commands
The table below lists the commands supported by the XL5K Controller Object.

Table 353: XL5K Controller Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics
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XLK5 Controller Command Details
Clear Statistics
Resets the statistics for the integrated XL-5000 network.

Back to XL5K Controller Commands.

Disable
Disables the XL-5000 controller integration. No requests are made to the field trunk for that controller and all packets
received from the Honeywell field device are ignored.

Back to XL5K Controller Commands.

Enable
Allows the integration to function normally.

Back to XL5K Controller Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to XL5K Controller Commands.
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XL5K Integration Object
The XL5K Integration object defines Honeywell Excel 5000 (XL-5000) network integration for the NIE. The object
contains pertinent communications attributes and statistics. Only one XL5K Integration object can be configured in
each NIE.

For general information on Metasys system objects, see the Object Help section.

XL5K Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes are described
in the Common Object Attributes section. This section includes attributes of the Focus/Configuration tab, the
Diagnostics tab (if applicable), and any other tab specific only to this object. See theObject and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).

Click the attribute name in the table for a description of the attribute.

Also, see Status.

Table 354: XL5K Integration Attributes - Focus/Configuration Tab
Values/Options RangesInitial ValueNotes1Data TypeAttribute Name

TrueCWTrue or FalseEnabled

FalseTrue or FalseOffline

1 C - Configurable, N - Value Not Required, W - Writable

Table 355: XL5K Integration Attributes - Diagnostic Tab
Values/Options RangesInitial ValueNotes1Data TypeAttribute Name

NumberCount

NumberPoint Scan Time

DateReset Date

TimeReset Time

NumberTransaction Timeouts

NumberTransmit Errors

NumberTransmits Per Minute

NumberTransmits Today

1 C - Configurable, N - Value Not Required, W - Writable

XL5K Integration Attribute Details
Count
Indicates the number of scannable points for all XL5K Controller objects defined for this object.

Back to XL5K Integration Attributes.

Enabled
If True, allows integration between the XL5K system and the Metasys system extended architecture.

Back to XL5K Integration Attributes.

Offline
Indicates the offline/online state of the connected hardware.

Back to XL5K Integration Attributes.

Point Scan Time
Indicates the total amount of time to scan for point data.
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Back to XL5K Integration Attributes.

Reset Date
Indicates the date of the last Clear Statistics command or due to automatic midnight rollover.

Back to XL5K Integration Attributes.

Reset Time
Indicates the time of the last Clear Statistics command or 12:00:00 if due to automatic midnight rollover.

Back to XL5K Integration Attributes.

Status
Indicates the following status of the object:

• Disabled: Enabled attribute is False.
• Offline: Communication with the physical hardware has failed.
• Normal: No abnormal condition for this object detected.

Back to XL5K Integration Attributes.

Transaction Timeouts
Indicates the number of transmissions (packets) since the last Clear Statistics command where no response data
was obtained and the transmission was retried.

Back to XL5K Integration Attributes.

Transmit Errors
Indicates the number of transmissions (packets) since the lastClear Statistics command that have errors (for example,
bad data was returned).

Back to XL5K Integration Attributes.

Transmits Per Minute
Indicates the calculated number of transmissions per minute.

Back to XL5K Integration Attributes.

Transmits Today
Indicates the number of transmissions (packets) since midnight.

Back to XL5K Integration Attributes.

XL5K Integration Commands
The table below lists the commands supported by the XL5K Integration Object.

Table 356: XL5K Integration Commands
ParametersCommand Name

Clear Statistics

Disable

Enable

Latch Statistics

XL5K Integration Command Details
Clear Statistics
Resets the statistics for the integrated XL-5000 network.

Back to XL5K Integration Commands.
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Disable
Disables the entire XL-5000 network integration. No requests are made to the field trunk and all packets received
from the Honeywell field device are ignored.

Back to XL5K Integration Commands.

Enable
Allows the integration to function normally.

Back to XL5K Integration Commands.

Latch Statistics
Updates the displayed statistics with the current values.

Back to XL5K Integration Commands.
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Object and Feature Tabs
This section describes the tabs of the display panel for the objects and features in the system. Each display panel
can contain different tabs depending on the item being viewed, and each tab shows different information.

Note: This section contains detailed information about the tabs used by multiple objects/features. When a tab only
appears for a specific object/feature, the details of that tab are defined in that object/feature section. However,
this section includes a brief description of such tabs and provides links to the detailed object/feature sections.

Action Tables Tab
The Action Tables tab appears on Interlock and Multiple Command objects. See the and sections for details.

Alarm Tab
The Alarm tab appears on an object that has an alarm extension. See in the section.

Associated Graphic Tab
The Associated Graphic tab appears when a graphic is referenced from the object using the Graphic attribute. See
the section for details on working with this tab.

Averaging Tab
The Averaging tab appears on an object that has an averaging extension. See in the section.

BACnet Alarm Tab
Attributes associated with the BACnet Intrinsic Alarming for an object are shown under the BACnet Alarm tab of the
display panel. This tab appears when the site is defined as a BACnet site and the object has intrinsic alarming
enabled (that is, Intrinsic Alarming Defined set to True).

Table 357: BACnet Alarm Tab
Values/Options/RangeInitial ValueBACnet

Notes
NotesData TypeAttribute Name

To Offnormal, To Fault, To Normal

Applies to all point objects and the
Accumulator.

True, True, TrueBSeries of True or
False states

Maximum 256 characters

Applies to all point objects and the
Accumulator.

CWCWText

Inactive, Active

States Text attribute identifies the value set
for this attribute.

Applies to BI, BV, MI, and MV objects.

For MI and MV objects, you can select
multiple values from a list, unlike the other
objects that are limited to one value.

ActiveWCWOne value from
a list (see
Values/
Options/Range
column)

Applies to AI, AO, and AV objects.0.0BWCWReal value

Applies to the BO object.One state from a
set

To Offnormal, To Fault, To Normal

Applies to all point objects and the
Accumulator.

True, True, TrueBWCWSeries of True or
False states

Normal, Fault (unreliable), High Limit, Low
Limit

Applies to all point objects and the
Accumulator.

NormalBOne state from a
set
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Table 357: BACnet Alarm Tab
Values/Options/RangeInitial ValueBACnet

Notes
NotesData TypeAttribute Name

BACnet formatted Time Stamps

Applies to all point objects and the
Accumulator.

BSet of values

Numbers: 0–65,535

States Text attribute identifies the value set
for this attribute.

The list of numbers come from a list of the
Alarm Values.

Applies to MI and MV objects.

WCWList of numbers
(see Values/
Options/Range
column)

Applies to BO and MO objects.WCWObject reference

Inactive, Active

States Text attribute identifies the value set
for this attribute.

Applies to BO and MO objects.

ActiveWCWOne value from
a set

Applies to all point objects and the
Accumulator.

CWCWObject reference

Maximum 256 characters

Applies to all point objects and the
Accumulator.

CWCWText

Applies to AI, AO, AV, and Accumulator
objects.

70.0BWCWReal value

Uses BAC LifSfty State (BACnet Lifesafety
State) (Set 186).

Applies only to Life Safety Zone and Life
Safety Point objects.

List of

Applies to AI, AO, AV, and Accumulator
objects.

True, TrueBWCWSeries of True or
False states

Applies to AI, AO, AV, and Accumulator
objects.

65.0BWCWReal value

0–4,294,967,295

This is the BACnet Object Identifier of the
Notification Class Object used for routing.

Applies to all point objects and the
Accumulator.

1BWCWNumber

Set to Notification Class: 1

Applies to all point objects and the
Accumulator.

1CWCWObject reference

Alarm, Event

Applies to all point objects and the
Accumulator.

AlarmBWCWOne type from a
set
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Table 357: BACnet Alarm Tab
Values/Options/RangeInitial ValueBACnet

Notes
NotesData TypeAttribute Name

Applies to the Accumulator object.0CWNumber

0–65,535

Units = seconds

Applies to all point objects and the
Accumulator.

0BWCWNumber

1 B - Exposed as Standard BACnet Property, C - Configurable, W - Writable

BACnet Alarm Tab Attribute Details
Acked Transitions
Displays three states that independently indicate the receipt of acknowledgements for To Offnormal, To Fault, and
To Normal events. Transitions to High Limit and Low Limit Event States are considered Offnormal events.

These states are set to False when the corresponding event occurs and an acknowledgement is expected as defined
in the Notification Class Object referenced by the Notification Class attribute of this object.

The states are set to True upon receipt of the corresponding acknowledgement.

Back to .

Alarm Message Text
Specifies the body of the alarm messages.

Back to .

Alarm Value (Alarm Values)
Specifies the value (or list of values for multistate objects) that Present Value must reach before an event generates.
If the object supports intrinsic reporting, this attribute is required.

A To Offnormal event generates under these conditions:

• The Present Value maintains the value(s) specified by Alarm Value(s) for a minimum period of time, specified
in the Time Delay attribute.

• The To Offnormal flag is enabled in the Event Enable attribute.
• Once equal to the Alarm Value(s), the Present Value must become not equal to Alarm Value(s) before a To

Normal event is generated under these conditions:
• The Present Value remains not equal to the Alarm Value(s) for a minimum period of time, specified by the Time

Delay attribute.
• The To Normal flag is enabled in the Event Enable attribute.

Back to .

BACnet Deadband
Defines the value by which the Present Value must change below the High Limit or above the Low Limit before the
object generates a To Normal event.

Back to .

Error Status
Indicates whether the Present Value was successfully written to the object defined by the Feedback Reference. The
Error Status displays Ok if the object was able to send its latest Present Value to the feedback object. Otherwise,
the Error Status displays the error of the first failed command.

Back to .
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Event Enable
Contains three states that independently enable To Offnormal, To Fault, and To Normal events. Transitions to High
Limit and Low Limit Event States are considered Offnormal events. An unreliable condition generates a Fault event.

Back to .

Event State
Indicates the active alarm state of the Intrinsic Alarming feature if enabled for the object. In BACnet terms, High Limit
and Low Limit states are Offnormal.

Back to .

Event Time Stamps
Indicates the times of occurrence of the last To Offnormal, To Fault, and To Normal event transitions. Time and Date
time stamps are shown as * if no transition of that type has been generated. Sequence time stamps are 0 if no
transition of that type has been generated. If intrinsic reporting is supported by the object, this attribute is required.

Back to .

Fault Values
Specifies any states the Present Value must equal before a To Fault event issues. If Present Value becomes equal
to any of the states in the Fault Values list, and no physical fault is detected for any inputs represented by the Present
Value attribute, then the Reliability attribute has the value Multistate Fault. If the object supports intrinsic reporting,
the Fault Values attribute is required.

Back to .

Feedback Reference
Indicates the object reference of the feedback object.

Back to .

Feedback Value
Indicates the status of a feedback value from which Present Value must differ before an event generates. The amount
Present Value differs from Feedback Value to generate an event is locally determined. This attribute is required if
the object supports intrinsic reporting.

A To Offnormal event generates under these conditions:

• The Present Value differs from the Feedback Value for a minimum period of time, specified in Time Delay.
• The Event Enable attribute enables the To Offnormal flag.

Once equal to the Feedback Value, the Present Value must become different from the Feedback Value before a To
Normal event generates under these conditions:

• The Present Value remains not equal to the Feedback Value for a minimum period of time, specified by Time
Delay.

• The Event Enable attribute enables the To Normal flag.

Back to .

Graphic
Indicates the graphic associated with the alarm extension.

Back to .

Graphic Alias
Indicates a portion of the graphic’s item reference, up to and including the name of the folder containing this object
or the controller containing this point.

Back to .

High Limit
Defines the high limit that the Present Value attribute must exceed before an event is generated.
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The object generates a To Offnormal event when the Present Value exceeds the High Limit for a minimum period
of time, defined in the Time Delay attribute; the High Limit Enable is True in the Limit Enable attribute; or the To
Offnormal is True in the Event Enable attribute.

The object generates a To Normal event when the Present Value falls below the High Limit minus the Deadband
for a minimum period of time, specified in the Time Delay attribute; the High Limit Enable flag is set in the Limit
Enable attribute; or the To Normal flag is set in the Event Enable attribute.

For the Accumulator object, this attribute indicates the upper limit of the range.

Back to .

Life Safety Alarm Values
Specifies any states that the Present Value must equal before the point generates a To Offnormal event and enters
the Life-Safety-Alarm event state.

Back to .

Limit Enable
Contains two flags that independently enable and disable reporting of High Limit and Low Limit events and their
return to Normal. This attribute is required if the object supports intrinsic reporting.

Back to .

Low Limit
Defines the low limit that the Present Value attribute must fall before an event generates.

The object generates a To Offnormal event when the Present Value falls below the Low Limit for a minimum period
of time, defined in the Time Delay attribute; the Low Limit Enable is True in the Limit Enable attribute; or the To
Offnormal is True in the Event Enable attribute.

The object generates a To Normal event when the Present Value exceeds the Low Limit plus the Deadband for a
minimum period of time, specified in the Time Delay attribute; the Low Limit Enable flag is set in the Limit Enable
attribute; or the To Normal flag is set in the Event Enable attribute.

For the Accumulator object, this attribute indicates the lower limit of the range.

Back to .

Notification Class
Defines the notification class for handling and generating event notifications for the object. This attribute implicitly
refers to the Notification Class Object that has a Notification Class attribute of the same value.

Back to .

Notification Object Reference
Allows selection of a Notification Class object. When the Notification Object Reference is written, the value of the
Notification Class attribute is updated to reflect the referenced object’s instance number. The value of the Notification
Object Reference attribute is restricted to Notification Class objects on the same device as the Alarming object.

Back to .

Notify Type
Defines whether the transitions generated by the object are Events or Alarms.

Back to .

Pulse Rate
Indicates the number of input pulses received during the most recently completed period specified by the Limit
Monitoring Interval. This value is monitored by the Intrinsic Alarming logic for this object. This attribute is writable
only when the object is out of service.

Back to .
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Time Delay
Defines the minimum number of seconds that the Present Value must remain outside the range defined by the High
Limit and Low Limit attributes before the object generates a To Offnormal event.

Also defines the minimum time the Present Value must remain within the range defined by the High Limit and Low
Limit attributes, including the Deadband attribute value, before the object generates a To Normal event.

When used with the Feedback Value, this value specifies the minimum number of seconds that the Present Value
must remain equal to the Feedback Value before a To Offnormal event generates or different from the Feedback
Value before a To Normal event generates.

For the Accumulator object, this value defines the minimum number of seconds that the must remain outside of
the range defined by the High Limit and Low Limit attributes before the object generates an event or alarm.

Back to .

Calendar Tab
The Calendar tab appears on Calendar objects, which are used behind the scenes by the Scheduling feature. See
the and the feature sections for details.

Communications Tab
The Communications tab appears on Engine Device objects. See the section for details.

Configuration Tab
The Configuration tab appears when you define an object in the SCT or in a Wizard. The Configuration tab shows
operation attributes available for the object type to which the object belongs. The attributes displayed on the
Configuration tab varies by object type. For example, the Analog Input object’s Configuration tab has different
attributes than the ADS object’s Configuration tab. See the specific object section for details on its Configuration
tab.

Note: This tab is called the Focus tab in the online Site Management Portal.

Diagnostic Tab
The Diagnostic tab only appears for objects containing diagnostic data. The attributes displayed on the Diagnostic
tab varies by object type. For example, the Diagnostic tab of the has different attributes than the . See the specific
object section for details on its Diagnostic tab. Also, see the section.

Email Tab
The Email tab appears on Engine or Server objects. The Email DDA Attributes appear on the Shared Configuration
section of the Email Tab. The Email DDA Destination Configuration Attributes appear when you edit a specific Email
destination on the Email tab.

Table 358: Email DDA Shared Configuration Attributes
DescriptionAttribute Name
Specifies either a host name or IP address of a SMTP server. A host name can be specified only if
a DNS is available to the device. This attribute is used in conjunction with Email DDA attribute. If no
Email DDA destinations are configured, this attribute is ignored.

SMTP Server Host

Signifies the TCP port on which Email DDA should connect to deliver an email message. By default,
this field is set to 25 (SMTP); however, some internal SMTP servers may be set up to non-standard
ports which require that this field be changed to match the listening port of the mail exchanger. If no
Email DDA attribute exists, this attribute is ignored.

SMTP Port

Specifies the type of authentication used to send and receive emails. Depending on the selection
you make, the fields on the Email tab become enabled or disabled to help you fill in only the fields
required for that authentication type. If you select SMTP, the SMTP User Name and SMTP Password
attributes become enabled. If you select POP-before-SMTP, the POP User Name and POP Password
attributes become enabled.

Authentication Type
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Table 358: Email DDA Shared Configuration Attributes
DescriptionAttribute Name
Specifies a user name for the SMTP server. This attribute is ignored if the SMTP Server Host is
empty. This attribute applies only when using SMTP authentication. If no Email DDA destinations
are configured, this attribute is ignored. See SMTP Password.

SMTP User Name

Specifies the password for the SMTP user name. This attribute is ignored if the SMTP Server Host
is empty. This attribute applies only when using SMTP authentication. If no Email DDA destinations
are configured, this attribute is ignored. See SMTP User Name.

SMTP Password

Specifies the hostname for the POP server. This attribute applies only when using POP authentication.
If no Email DDA destinations are configured, this attribute is ignored.

POP Server Hostname

Specifies a user name for the POP server. This attribute is ignored if the POP Server Hostname is
empty. This attribute applies only when using POP authentication. If no Email DDA destinations are
configured, this attribute is ignored.

POP User Name

Specifies the password for the POP user name. This attribute is ignored if the POP Server Hostname
is empty. This attribute applies only when using POP authentication. If no Email DDA destinations
are configured, this attribute is ignored.

POP Password

Specifies the e-mail address from which all e-mails are sent. The From Email Address is a required
field. If this attribute is not populated, the Email DDA does not attempt to send an e-mail message.

From Email Address

Displays diagnostic information regarding the communication between the Email DDA (SMTP Client)
and the SMTP Server. This attribute displays both successful and unsuccessful e-mail message
deliveries.

Email Diagnostics

Table 359: Email DDA Destination Configuration Attributes
DescriptionAttribute Name
Identifies the user-friendly destination name in the list of Email DDAs. Maximum characters: 80Label

Specifies the email address of one or more recipients. You must use valid email addresses set up
on an email server for the device to successfully send the email alarms. When entering more than
one email address, separate the addresses with a comma (for example,
Jonathan.Smith@jci.com,Jane.Smith@jci.com).

Click to select email addresses defined by the user accounts in the Security Administrator
system. See the Alarm and Event Management section for more information on the Email DDA and
selecting email addresses.

Maximum characters: 256

Email Address

Specifies the priority of the outbound email message. This attribute defines the X-Priority field within
the email’s MIME header. X-Priority is one of several ways to define the significance of an email.
Not all email clients interpret it the same way. Please refer to your email client’s documentation for
more information.

You can choose from the following values:
• High
• Normal
• Low
See the Hi Normal Low (Set 100).

Priority

Specifies the user-defined text that appears in the subject field of the e-mail message.

Maximum characters: 256

Subject

Specifies the number or attempts made to send a message if there is a failure before the system
discards it.

Range: 0–10

Retries

Defines whether or not the destination is enabled. When this attribute is False, the Engine or Server
does not deliver alarms to the configured recipients.

Enabled
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Table 359: Email DDA Destination Configuration Attributes
DescriptionAttribute Name
Specifies the rules to filter alarms. This attribute uses Alarm Value (Set 108).

See Filters for more information.

Filters

Defines the format of the message, indicating which fields are present in the received message.

The following fields are optional:
• Acknowledge Required (not an option for pager)
• Item Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Format

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Filters
Defines the rules used to filter alarms. This attribute appears on the Email, Pager, Printer, and SNMP tabs. See
Event Message Routing, Filtering, and Destinations in the Alarm and Event Management section for more information
on filtering.

Table 360: Filter Parameters
ValuesOperators AllowedFilters
True or False== or !=Acknowledge Required

Object Status Set== or !=Current Status

Day of the week.

Any value from Monday to Sunday

<, <=, >, >=, ==, or !=Start Day of Week

Time<, <=, >, >=, ==, or !=Start Time

Day of the week.

Any value from Monday to Sunday

<, <=, >, >=, ==, or !=End Day of Week

Time<, <=, >, >=, ==, or !=End Time

Object Type Set== or !=Item Type

Object Category Set== or !=Item Category

Object Status Set== or !=Previous Status

Number value<, <=, >, >=, ==, or !=Priority1

1 If you specify a filter with a value of >10, you receive only alarms with priorities between 11 and 255.

If you define multiple filters for a destination, the DDA combines all the criteria with an AND condition (all filter criteria
must be met).

Engineering Tab
The Engineering tab appears on integration objects in the system. This tab allows you to view and edit attributes of
items such as devices and points on an integration.

To use the Engineering tab to view and edit attributes:

1. Right-click the integration object on the Navigation tree and select View. The Integration object appears.
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2. Click the Engineering tab, and navigate to an item in the Integration Tree.

Note: You may need to click Relearn to discover the integrated devices and points on the network and populate
the Integration Tree with the data.

3. Double-click the selected item. The Details screen for the selected item appears.
4. Click the Edit button.
5. Make the desired changes and click Save.

Event Tab
The Event tab appears on Event Enrollment objects. See the Event Enrollment Object section.

Also, see the BACnet Event Enrollment Object Alarming and Event Enrollment Configuration Examples in the Alarm
and Event Management for Metasys Systems Integrated with BACnet Devices section.

Focus Tab
The Focus tab appears when you define an object in the online Site Management Portal. The Focus tab shows
operation attributes available for the object type to which the object belongs. The attributes displayed on the Focus
tab varies by object type. For example, the Analog Input object’s Focus tab has different attributes than the ADS
object’s Focus tab. See the specific object section for details on its Focus tab.

Note: This tab is called the Configuration tab in the SCT or in a Wizard.

Graphic Tab
The Graphic tab appears on a device object that has an associated Graphic defined. See the Graphic Object and
the User Graphics Tool (UGT) sections for details on this object and working with this tab.

Group Tab
The Group tab appears on Group objects. See the Group Object section for details.

Hardware Tab
The Hardware tab shows hardware-related attributes associated with the hardware source of an integration, device,
or a point (for example, when an object has a reference to a physical input or output).

Note: Each Hardware attribute table is organized and divided into sections of Integration Hardware attributes,
Device Hardware attributes, and Point Hardware attributes (calling out when attributes are shared between
these object types). These sections are indicated by headings that span across the table.

BACnet Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel. These attributes are not exposed to a BACnet network.

Note: Each Hardware attribute table is organized and divided into sections of Integration Hardware attributes,
Device Hardware attributes, and Point Hardware attributes (calling out when attributes are shared between
these object types). These sections are indicated by headings that span across the table.

Table 361: BACnet Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

BACnet Device Hardware Attributes

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

BACnet Device and Point Hardware Attributes

0–65,535NoneCNumberInstance Number
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Table 361: BACnet Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

BACnet device addressNoneSeries of
numbers

Remote Device Addr

NoneTextRemote Object Name

1 C - Configurable, W - Writable

BACnet Hardware Tab Attribute Details

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to BACnet Hardware Tab.

Instance Number
Contains the number of mapped BACnet objects that are being polled on a periodic basis or are part of the BACnet
Object Identifier (along with the Object Type). The BACnet Object Identifier is used to establish communication with
the object.

Back to BACnet Hardware Tab.

Remote Device Addr
Contains the BACnet address of the remote BACnet device where the integrated BACnet object resides.

Back to BACnet Hardware Tab.

Remote Object Name
Contains the BACnet Object Name of the integrated BACnet object as defined in the remote BACnet device.

Back to BACnet Hardware Tab.

LONWORKS Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel. These attributes are not exposed to a BACnet network.

Table 362: LONWORKS Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

LONWORKS Integration Hardware Attributes

Maximum Length = 12

Category = Default

Hex bytes of length 0,1,3, or 6

01CTextDomain ID

Maximum Length = 30

Category = Default

IpcdrvTextDriver Name

Maximum Length = 40

Category = Default

WTextFile Filter

Maximum Length = 30

Category = Default

CWTextLNS Database Name

Maximum Length = 3

Category = Default

ENUCWTextResource File
Language

Range = 0–10,000 milliseconds0CWNumberStatus Launch Interval
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Table 362: LONWORKS Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Range = 0–65,535 seconds

Immediate (0), Never (65,535)

60CWNumberTemporary Status Item
Expiration Time

LONWORKS Device Hardware Attributes

False

True

TrueCWTrue or FalseAlarm Event State

Maximum Length = 40

Category = Default

TextDevice Class

Maximum Length = 40

Category = Default

TextDevice Subclass

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

Maximum Length = 30

Category = Default

CTextDSN 1

Maximum Length = 30

Category = Default

CTextDSN 2

Maximum Length = 30

Category = Default

TextLocation Label

Maximum Length = 40

Category = Default

TextManufacturer

Range = 0–151CWNumberMessage Retry Count

0NumberModel

Number of Elements = 40

Category = Default

TextProgram ID

Maximum Length = 40

Category = Default

TextTransceiver

True or FalseXIF Present

LONWORKS Integration and Device Hardware Attributes

Fixed Length = 6

Category = Default

TextNeuron ID

LONWORKS Point Hardware Attributes

Applies to BI, BO, MI, and MO objects only.CWTextCommand Status
Mapping Table

Applies to AI and AO objects only.CWTextCustom Scale/Offset

Applies to AO, BO, and MO objects only.CWTrue or FalseEnable Polling

Uses Unit Set (Set 869).

This attribute is for AI and AO objects only.

DegFCWOne unit of
measure from a
set

Field Units

One from a set
or Number

Interface Value

Applies to AO, BO, and MO objects only.True or FalseManual Control
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Table 362: LONWORKS Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

True or FalseOffline

True or FalseOverridden

1–3NumberPriority

CTextTarget Reference

Applies to BI and BO objects.True or FalseTrouble

Units = Seconds

0–65,535

Applies to AO, BO, and MO objects only.

CWNumberUpdate Interval

1 C - Configurable, W - Writable

LONWORKS Hardware Tab Attribute Details

Alarm Event State
Specifies whether Node State changes will cause alarms. The value of True allows Node State alarms to be processed
by the NxE. The value of False masks Node State alarms from the NxE.

Back to LONWORKS Hardware Tab.

Command Status Mapping Table
Limits or modifies the mapping to the field states/commands used by the object. This string refers to one of the
conversion identifiers in the CommandStatusMap.xml file.

Back to LONWORKS Hardware Tab.

Custom Scale/Offset
Provides a customs scaling function for converting the field data to the defined units of the object. This attribute is
for AI and AO objects only.

Back to LONWORKS Hardware Tab.

Device Class
Indicates the class of a device. The LONWORKS network server is responsible for populating the Program ID (which
includes the Manufacturer, Device Class, Device Subclass, Transceiver, and Model). If no standard Program ID
exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Device Subclass
Indicates the device subclass usage of a device. The LONWORKS network server is responsible for populating the
Program ID (which includes the Manufacturer, Device Class, Device Subclass, Transceiver, and Model). If no
standard Program ID exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to LONWORKS Hardware Tab.

Domain ID
Defined by Metasys system Connectivity to LONWORKS network (MCL) software for the particular LONWORKS network
trunk. The validation code checks for proper format (zero, one, three, or six hexadecimal bytes).
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Back to LONWORKS Hardware Tab.

Driver Name
Displays to the name of the installed LONWORKS network driver.

Back to LONWORKS Hardware Tab.

DSN 1
Displays the native LONWORKS network address (in Domain-Subnet-Node format). DNSs must be unique on the
LONWORKS network. DSN 1 is required. Use the format xx/xx/xx.

Back to LONWORKS Hardware Tab.

DSN 2
Displays the native LONWORKS network address (in Domain-Subnet-Node format). DNSs must be unique on the
LONWORKS network. DSN 1 is required, but DSN 2 can be left blank. Use the format xx/xx/xx.

Back to LONWORKS Hardware Tab.

Enable Polling
Indicates whether polling is enabled or disabled when the Engine is in complete control of this item.

Back to LONWORKS Hardware Tab.

Field Units
Lists the engineering units that pertain to the LONWORKS network data. This attribute is for AI and AO objects only.

Back to LONWORKS Hardware Tab.

File Filter
Lists the types of files that can be used as file extensions to the LON Integration object. The list includes:

• eng
• enm
• enu
• fmt
• fpt
• typ
• xif

File Filter can be edited for alternate languages and must be in the xxx file format.

Back to LONWORKS Hardware Tab.

Interface Value
Indicates the current value from the hardware interface. The Interface Value updates when the hardware is read or
when the hardware’s current value changes.

Back to LONWORKS Hardware Tab.

Location Label
Describes the location of the controller.

Back to LONWORKS Hardware Tab.

LNS Database Name
Displays the name of the LONWORKS® Network Services (LNS) database used to build the LONWORKS network trunk.

Back to LONWORKS Hardware Tab.

Manual Control
Indicates that an Hands Off Auto (HOA) switch on the referenced item is set to Hand or Off.
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Back to LONWORKS Hardware Tab.

Manufacturer
Indicates the manufacturer of a device. The LONWORKS network server is responsible for populating the Program
ID (which includes the Manufacturer, Device Class, Device Subclass, Transceiver, and Model). If no standard
Program ID exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Message Retry Count
Indicates the number of retry attempts to use when communicating with this controller.

Back to LONWORKS Hardware Tab.

Model
Indicates the model number of a device. The LONWORKS network server is responsible for populating the Program
ID (which includes the Manufacturer, Device Class, Device Subclass, Transceiver, and Model). If no standard
Program ID exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Neuron ID
Displays the Neuron ID of the local LONWORKS network interface board or contains the Neuron ID of the remote
LONWORKS network controller. The Neuron ID must be unique to the LONWORKS network.

Back to LONWORKS Hardware Tab.

Offline
Indicates whether the connected LONWORKS network hardware is online or offline.

Back to LONWORKS Hardware Tab.

Overridden
Indicates if the hardware is overridden (if supported).

Back to LONWORKS Hardware Tab.

Priority
Indicates the Priority (1–3) at which to poll this item.

Back to LONWORKS Hardware Tab.

Program ID
Displays the Standard Program ID for the device in hex characters. The LONWORKS network server is responsible
for populating the Program ID (which includes the Manufacturer, Device Class, Device Subclass, Transceiver,
and Model). If no standard Program ID exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Resource File Language
Defines the language extracted from the resource file.

Back to LONWORKS Hardware Tab.

Status Launch Interval
Indicates how often the LON integration launches a status request to the field. A value of 0 means as often as
needed. This attribute limits the LON bandwidth usage for the LON integration.

Back to LONWORKS Hardware Tab.

Target Reference
Defines the path into a controller for the data being mapped by the object.

Back to LONWORKS Hardware Tab.
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Temporary Status Item Expiration Time
Indicates the time to poll the temporary objects in the status list.

Back to LONWORKS Hardware Tab.

Transceiver
Indicates the transceiver type for a device. The LONWORKS network server is responsible for populating the Program
ID (which includes the Manufacturer, Device Class, Device Subclass, Transceiver, and Model). If no standard
Program ID exists, the value is n/a.

Back to LONWORKS Hardware Tab.

Trouble
Indicates whether the hardware device is currently under a trouble condition. Applies to BI and BO objects.

Back to LONWORKS Hardware Tab.

Update Interval
Specifies how often (in seconds) to repeat the last command. This attribute provides a heartbeat for controllers
needing it. Use this attribute sparingly.

Back to LONWORKS Hardware Tab.

XIF Present
Indicates whether a XIF file matching this controller’s Program ID was found.

Back to LONWORKS Hardware Tab.

MS/TP Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel.

Table 363: MS/TP Hardware Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

MS/TP Integration Hardware Attributes

Uses MSTPDL Baud Rate (Set 300).

See the attribute description.

0CWOne state/type/
mode from a set

Baud Rate Selection

1–65,534

0 = Local network

65,535 = Reserved for broadcast

0C WNumberNetwork Address

NumberTrunk Number

MS/TP Device Hardware Attributes

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

NumberInstance Number

1–255CNumberMAC Address

MS/TP Point Hardware Attributes

TextDevice Type

NumberFC Bus MAC Address

True or FalseOffline

This attribute applies to AI, AO, BI, BO,
and Accumulator objects.

NumberSA Bus MAC Address
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Table 363: MS/TP Hardware Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

This attribute applies to AI, BI, and
Accumulator objects.

NumberSlot

This attribute applies to AO and BO
objects.

NumberSlot A

This attribute applies to PAO and BO
objects.

NumberSlot B

1 C - Configurable, W - Writable

MS/TP Hardware Tab Attribute Details

Baud Rate Selection
Indicates the baud rate of the NAE FC bus (Table 364).

Table 364: Baud Rate Options
DescriptionBaud Rate
Use baud rate of running network. This value is the recommended setting for everything on the FC bus except
the bus supervisor port. See Active Baud Rate.

Auto

Use 1200 baud only. This value is not recommended and may not be allowed on some devices.1200

Use 9600 baud only. This value is the lowest standard MS/TP baud rate.9600

Use 19200 baud only. This value is not recommended.19200

Use 38400 baud only. This value is the recommended baud rate for bus supervisor ports.38400

Use 76800 baud only.76800

Back to MS/TP Hardware Tab.

Device Type
Indicates the type of device. This value comes from CCT.

Back to MS/TP Hardware Tab.

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to MS/TP Hardware Tab.

FC Bus MAC Address
Displays the MAC address of the device on which the object exists (if the object physically resides on a device on
the FC bus) or the FEC/VMA field controller MAC Address that the point is connected to (if the object physically
resides on the SA bus).

Back to MS/TP Hardware Tab.

Instance Number
Displays the Instance Number of the object on the remote field device. The Instance number, along with the object
type, defines the remote object’s BACnet Object Identifier. The BACnet Object Identifier is used to establish
communication with the object.

Back to MS/TP Hardware Tab.

MAC Address
Indicates the MAC address of the device on the field bus.

Back to MS/TP Hardware Tab.
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Network Address
Contains the network number of the MS/TP bus used for BACnet message addressing. A value of 0 indicates a local
network (the device is not intended as a router). Do not change this number after you start device mapping or
discovery because it may invalidate the devices that have been found.

Back to MS/TP Hardware Tab.

Offline
Specifies whether or not the point is offline.

Back to MS/TP Hardware Tab.

Trunk Number
Displays the trunk number where the device (on which the point resides) is located.

Back to MS/TP Hardware Tab.

SA Bus MAC Address
Displays the MAC address of the device on which the object exists (if the object physically resides on a device on
the SA bus).

Back to MS/TP Hardware Tab.

Slot
Defines the physical location of a point data source on the device.

Back to MS/TP Hardware Tab.

Slot A
Defines the physical location of a point data source on the device.

Back to MS/TP Hardware Tab.

Slot B
Defines the physical location of a second data point source on the devices (if present). Only a PAO would have Slot
B defined.

Back to MS/TP Hardware Tab.

N1 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel. These attributes are not exposed to a BACnet network.

Table 365: N1 Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

N1 Point Hardware Attributes

One from a set or
Number

Interface Value

8 characters maximumNoneTextNCM Name

8 characters maximumNoneTextNetwork Name

FalseTrue or FalseOffline

FalseRTrue or FalseOverridden

<system>.<object>NoneTextReference

<system>.<object>

8 characters each maximum

NoneCWTextRemote Object Name

1 C - Configurable, R - Affected by Object Reliability, W - Writable
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N1 Hardware Tab Attribute Details

Interface Value
Indicates the current value from the hardware interface. The Interface Value updates when the hardware is read or
when the hardware’s current value changes.

Back to N1 Hardware Tab.

NCM Name
Contains the name of the NCM where the integrated N1 object resides, as defined in the N1 network. Read from
the NCM.

Back to N1 Hardware Tab.

Network Name
Contains the network name of the NCM where the integrated object resides as defined in the N1 network. The
network name is obtained at startup via the N1 Migration Object.

Back to N1 Hardware Tab.

Offline
Indicates whether the object is online or offline as determined by the communication status to the NCM.

Back to N1 Hardware Tab.

Overridden
Indicates if the point is overridden in the NCM.

Back to N1 Hardware Tab.

Reference
Contains the name of the hardware object in the format of system.object, that the N1 object is associated with in
the NCM.

Back to N1 Hardware Tab.

Remote Object Name
Contains the name of the integrated N1 object in the format of system.object, as defined in the N1 network. If this
name is changed in the N1 network, the object goes offline.

Back to N1 Hardware Tab.

N2 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel. These attributes are not exposed to a BACnet network.

Table 366: N2 Hardware Tab
Values/Options/RangeInitial ValueNotes1,2Data TypeAttribute Name

N2 Integration Hardware Attributes

See Table 367WOne type from a listError Log

250–3,000

Milliseconds

250WNumberMessage Timeout

0–65,535

Milliseconds

100WNumberPoll Delay

3–103WNumberRetries

0–65,535NumberTrunk Number

0WNumberUDP Port

N2 Device Hardware Attributes
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Table 366: N2 Hardware Tab
Values/Options/RangeInitial ValueNotes1,2Data TypeAttribute Name

AHU, VAV, UNT, PHX, VND, MIG, VMA,
DX, TC, XTM, LCP, ILC, IFC

COne type from a listController Type

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

TextHost Name

1–2540CNumberNet N2 Address

Range = 0–8

Units = Minutes

CWNumberOnline Point Delay

N2 Point Hardware Attributes

One from a set or
Number

Interface Value

One type from a setNet Point Addr

One type from a setNet Point Type

Offline (True), Online (False)True or FalseOffline

True or FalseOverridden

Applies to BI and BO objects.True or FalseTrouble

1 C - Configurable, W - Writable
2 The Writable attributes in the N2 Master Datalink object are writable only if the UDP Port attribute is not zero. If the UDP Port

attribute is zero and you attempt to write these attributes, an error message appears.

Table 367: N2 Errors
DescriptionError Number
Controller has reset and is waiting for the Identify Yourself command0

Undefined Command: command not understood by addressed controller1

Checksum Error detected by controller2

Input buffer overflow detected by controller3

Invalid ASCII character detected by controller4

Data field error: size of message not correct for command type5

Invalid Data: one of the fields contains a value that is out of the expected range6

Invalid command for data type: command not appropriate for this field or record7

Command not accepted due to problems with the controller, the command is ignored8

Device at address is the wrong type9

No additional records are available (end of search)10

Controller not ready11

Data not matching the item or function type12

Nonexistent item or function13

Temporarily impossible to access the item14

Not a programmable item15

Table programmed with illegal item16

Trend programmed with illegal item17

Invalid Function Module18
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Table 367: N2 Errors
DescriptionError Number
Exceeding Addressing Range19

Password Not Enabled20

I2C bus communication error (see I2CE)21

Hardware not available (see OPMO)22

Illegal item number23

Counters unreliable24

Power supply unreliable25

Checksum Error detected by NxE26

Block Checksum Error detected by NxE27

Controller type does not match NxE database28

Controller revision is less than C0329

Controller revision is less than B0330

Controller revision is less than A0331

Controller revision is less than C0532

VMA COV error33

VMA BAC error34

VMA FMT error35

Retry error not due to a NAK36

Unknown NAK error37

N2 Hardware Tab Attribute Details

Controller Type
Defines the N2 controller type assigned to this object.

Back to N2 Hardware Tab.

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to N2 Hardware Tab.

Error Log
Lists up to 100 error log entries. Each entry contains the N2 Controller Type, N2 Address, Error Description, and a
Timestamp (time error occurred). Logging stops once the 100th entry is added. This list is stored in memory only.
The Clear Statistics command clears the Error Log.

Back to N2 Hardware Tab.

Host Name
Indicates the host name of the Ethernet (or wireless) converter. When a host name is given, the system attempts
to resolve the Host Name and IP Address using DNS/DHCP (assuming that the installer assigned a host name to
the converter and enabled DHCP). If the device can be located using the ping hostname command, the system
can resolve the host name to an IP address. After resolving the host name, the system updates the IP address.

Back to N2 Hardware Tab.
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Interface Value
Indicates the current value from the hardware interface. The Interface Value updates when the hardware is read or
when the hardware’s current value changes.

Back to N2 Hardware Tab.

Message Timeout
Specifies the delay in milliseconds between the last character going out and the first character received. The timeout
for VMA devices is three times this value. The actual timeout can be extended dynamically when at least one
character of a response message is received before the timeout.

Note: The Message Timeout attribute is writable only if UDP Port is not zero. If UDP Port is zero and you attempt
to write Message Timeout, an error message appears.

Back to N2 Hardware Tab.

Net N2 Address
Defines the host controller Address (1–254) on the N2 bus.

Back to N2 Hardware Tab.

Net Point Addr
Defines the hardware address associated with the point.

Back to N2 Hardware Tab.

Net Point Type
Indicates the type of point (for example, AI or BI).

Back to N2 Hardware Tab.

Offline
Indicates whether the hardware device is currently communicating with the system (True = Offline; False = Online).

Back to N2 Hardware Tab.

Online Point Delay
Indicates the number of minutes that must elapse before bringing an N2 Controller online. This attribute allows
integration devices, such as the MIG or VND, to gather status from their many field points before being reported
online by the engine. With no delay, the N2 Controller reports unreliable and causes nuisance alarms. This timer is
ignored when the Controller Type is not MIG or VND.

Back to N2 Hardware Tab.

Overridden
Indicates whether the hardware device is currently overridden.

Back to N2 Hardware Tab.

Poll Delay
Specifies the time to wait in milliseconds for a response to an offline poll.

Note: The Poll Delay attribute is writable only if UDP Port is not zero. If UDP Port is zero and you attempt to write
Poll Delay, an error message appears.

Back to N2 Hardware Tab.

Retries
Specifies the number of message retries allowed when the device is online, including the initial attempt. Only one
retry is attempted to an offline device.

Note: The Retries attribute is writable only if UDP Port is not zero. If UDP Port is zero and you attempt to write
Retries, an error message appears.

Back to N2 Hardware Tab.
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Trouble
Indicates whether the hardware device is currently under a trouble condition. Applies to BI and BO objects.

Back to N2 Hardware Tab.

Trunk Number
Specifies the number of the trunk on which the object resides.

Back to N2 Hardware Tab.

UDP Port
Indicates the Ethernet UDP Port used for N2 communication over the IP network. The recommended UDP Port for
N2 Trunk 1 is 4096 and for N2 Trunk 2 is 4097. Only valid on NAE5512 and NAE5513 models.

Back to N2 Hardware Tab.

VND Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel.

Table 368: VND Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

VND Integration Hardware Attributes

FalseCWTrue or FalseDisable Automatic
Alarming

VendorDriverCTextProtocol Description

CTextProtocol Revision

CDateProtocol Revision Date

CTimeProtocol Revision Time

0–65,535

Units = Seconds

CWNumberTemporary Status Item
Expiration Time

VENDOR.DLLCWTextVendor DLL

Units = bytesNumberVendor Integration Size

CDateVendor Revision Date

CTimeVendor Revision Time

VND Integration, Device, and Point Hardware Attributes

Maximum characters = 80

Maximum entries = 128

CWListVendor Configuration
Data

CTextVendor Reference

VND Point Hardware Attributes

Applies to only AI, AO, BO, MI, and MO
objects.

TextField Value

Applies to only AI, AO, BO, MI, and MO
objects.

One from a setInterface Value

Applies to only AO objects.250.0 deg FCWReal valueMax Value

Applies to only AO objects.-50.0 deg FCWReal valueMin Value

Applies to only AI, AO, BI, BO, MI and MO
objects.

True or FalseOffline
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Table 368: VND Hardware Tab Attributes
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Applies to only AI, AO, BO, MI, and MO
objects.

True or FalseOverridden

Applies to only AI, AO, BO, MI, and MO
objects.

CWNumberPriority

Applies to only BI and BO objects.True or FalseTrouble

1 C - Configurable, W - Writable

VND Hardware Tab Attribute Details

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to VND Hardware Tab.

Field Value
Indicates the current value of the field point. Applies to only AI, AO, BO, MI, and MO objects.

Back to VND Hardware Tab.

Interface Value
Indicates the current value from the hardware interface. The Interface Value updates when the hardware is read or
when the hardware’s current value changes. Applies to only AI, AO, BO, MI, and MO objects.

Back to VND Hardware Tab.

Max Value
Defines the highest reliable value for the Present Value. Applies to only AO objects.

Back to VND Hardware Tab.

Min Value
Defines the lowest reliable value for the Present Value. Applies to only AO objects.

Back to VND Hardware Tab.

Offline
Specifies whether or not the point is offline. Applies to only AI, AO, BI, BO, MI and MO objects.

Back to VND Hardware Tab.

Overridden
Indicates whether the hardware device is currently overriden. Applies to only AI, AO, BI, BO, MI and AO objects.

Back to VND Hardware Tab.

Priority
Specifies the priority for polling the vendor point. Applies to only AI, AO, BI, BO, MI and MO objects.

Back to VND Hardware Tab.

Protocol Description
Indicates the protocol supplied by the Vendor DLL.

Back to VND Hardware Tab.

Protocol Revision
Indicates the revision of the protocol for reference purposes.
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Back to VND Hardware Tab.

Protocol Revision Date
Indicates the date the Vendor DLL protocol was compiled.

Back to VND Hardware Tab.

Protocol Revision Time
Indicates the time the Vendor DLL protocol was compiled.

Back to VND Hardware Tab.

Temporary Status Item Expiration Time
Indicates how long a point remains in the polling list.

Back to VND Hardware Tab.

Trouble
Indicates whether the hardware point is currently under a trouble condition. Applies to only BI and BO objects.

Back to VND Hardware Tab.

Vendor Configuration Data
Contains data for proper configuration of the integration.

Back to VND Hardware Tab.

Vendor DLL
Specifies the name of the vendor DLL to load at startup.

Back to VND Hardware Tab.

Vendor Integration Size
Indicates the size, in bytes, of the vendor integration.

Back to VND Hardware Tab.

Vendor Reference
Specifies the address of the vendor device.

Back to VND Hardware Tab.

Vendor Revision Date
Indicates the date of the Vendor integration revision.

Back to VND Hardware Tab.

Vendor Revision Time
Indicates the time of the Vendor integration revision.

Back to VND Hardware Tab.

XL5K Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab of the display
panel.

Table 369: XL5K Hardware Tab
Values/Options RangesInitial ValueNotes1Data TypeAttribute Name

XL5K Integration Hardware Attributes

9600CWNumberBaud Rate

Uses Databits (Set 122).8WOne value from a
set

Data Bits

XL5KdrvrTextDriver Name
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Table 369: XL5K Hardware Tab
Values/Options RangesInitial ValueNotes1Data TypeAttribute Name

Uses Parity (Set 123).EvenWOne type from a
set

Parity

TextProtocol Revision

Uses Stopbits (Set 124).1WOne value from a
set

Stop Bits

Range = 0–61WNumberTrunk Number

XL5K Device Hardware Attributes

True or FalseDevice Configured OK

True or FalseDevice Database OK

OK or FaultOne state from a
set

Device Health

Maximum Length = 18 charactersCTextDevice Type

False

True

FalseCWTrue or FalseDisable Automatic
Alarming

DateDownload Date

TimeDownload Time

TextFirmware Version

TextHardware Version

DateReset Date

TimeReset Time

XL5K Integration and Device Hardware Attributes

Range = 1–3030CWNumberDevice Number

XL5K Device and Point Hardware Attributes

Honeywell device nameCWTextRemote Name

XL5K Point Hardware Attributes

UndefinedCOne type from a
set

Remote Object Type

1 C - Configurable, N - Value Not Required, W - Writable

XL5K Hardware Tab Attribute Details

Baud Rate
Indicates the baud rate of the integrated Honeywell® XL-5000 field device. Baud rates typically encountered include:
4800, 9600, 19200, 38400, and 76800.

Back to XL5K Hardware Tab.

Data Bits
Indicates the data bits used by the XL-5000 equipment. The valid data bits/ Stop Bits value for Honeywell protocol
is 8/1.

Back to XL5K Hardware Tab.

Device Configured OK
Indicates if the Honeywell field device is fully configured, ready to run, operational, and if its database has objects.

Back to XL5K Hardware Tab.
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Device Database OK
Indicates if the Honeywell field device has a fully populated database containing no errors, corruptions, or missing
parts.

Back to XL5K Hardware Tab.

Device Health
Indicates if the Honeywell field device is fully operational, running, and has correct operations.

Back to XL5K Hardware Tab.

Device Number
Indicates the number assigned to the NIE (as a Honeywell field device on the C-bus).

Back to XL5K Hardware Tab.

Device Type
Indicates the type of Honeywell field device. For example, the XL-5000 family: XL-10, XL-20, XL-50, XL-80, XL-100,
XL-300, XL-500, XL-600, Zone Manager.

Back to XL5K Hardware Tab.

Disable Automatic Alarming
Specifies whether automatic online/offline device event reporting is disabled (True) or enabled (False). This attribute
only applies to the device and not to the device’s mapped objects. Devices with the Disable Automatic Alarming
attribute set to True suppress the alarm event but still indicate they are offline in the navigation tree with a red X.
Alarm extensions are not affected by this attribute.

Back to XL5K Hardware Tab.

Download Date
Displays the Date stamp returned from the Honeywell field device (if extractable, otherwise displays the date when
the object was defined).

Back to XL5K Hardware Tab.

Download Time
Displays the Time stamp returned from the Honeywell field device (if extractable, otherwise displays the time when
the object was defined).

Back to XL5K Hardware Tab.

Driver Name
Indicates the protocol DLL driver name for this integration (for example, XL5Kdrvr).

Back to XL5K Hardware Tab.

Firmware Version
Indicates the firmware version of the receiver module.

Back to XL5K Hardware Tab.

Hardware Version
Indicates the hardware version of the receiver module.

Back to XL5K Hardware Tab.

Parity
Indicates the parity used by the XL-5000 equipment. The valid parity for Honeywell protocol is Even.

Back to XL5K Hardware Tab.

Protocol Revision
Indicates the current version number of the XL5K Protocol Engine (PC104).
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Back to XL5K Hardware Tab.

Remote Name
Indicates the existing name of the Honeywell field device.

Back to XL5K Hardware Tab.

Remote Object Type
Indicates the type of remote object (for example, Analog Input, Digital Output, and Pulse Input).

Back to XL5K Hardware Tab.

Reset Date
Indicates the date of the last Clear Statistics command.

Back to XL5K Hardware Tab.

Reset Time
Indicates the time of the last Clear Statistics command.

Back to XL5K Hardware Tab.

Stop Bits
Indicates the stop bits used by the XL-5000 integration. The valid Data Bits value for Honeywell protocol is 8/1.

Back to XL5K Hardware Tab.

Trunk Number
Indicates the trunk number used for the integration. This number is typically 1.

Back to XL5K Hardware Tab.

Input Category Tab
The Input Category tab appears on GIO objects and includes the status, description, and value of the items in the
category. See the Generic Integration Object section for details.

Interlock Definition Tab
The Interlock Definition tab appears on Interlock objects. See the Interlock Object section for details.

Load Tab
The Load tab appears on an object that has a load extension. See Load Extensions in the Extensions section.

Load Summary Tab
The Load Summary tab appears on DLLR objects. See the Demand Limiting/Load Rolling (DLLR) Object section
for details.

Logic Tab
The Logic tab appears on Program (Control System) objects, which are used for the LCT feature. See the Program
(Control System) Object and the Logic Connector Tool (LCT) feature section for details.

Members Tab
The Members tab appears on Life Safety Point and Life Safety Zone point objects. See the Life Safety Point Object
and Life Safety Zone Object sections for details.

Network Tab
The Network tab appears on Engine Device objects. See the Engine Device Object section for details.

Options Tab
Attributes associated with the default state, control source, and restart options for an object are shown under the
Options tab of the display panel.
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Table 370: Options Tab
Values/Options/RangeInitial ValueNotes1Data TypeAttribute Name

Applies to AO, BO, and MO objects.TrueCWTrue or FalseAuto Restore

Applies to AO, BO, MC, and MO objects.TrueCWTrue or FalseIgnore Relinquish Default

Applies to AO, BO, and MO objects.TrueCWTrue or FalseLocal Control

Range = Min Value - Max Value

Applies to AO, BO, MC, MO, AV, BV, and
MV objects.

CWReal valueIgnore Relinquish Default

Uses Restore Priority (Set 357).

Applies to AO, BO, MC, MO, AV, BV, and
MV objects.

Operator OverrideCWSet of valuesRestore Command
Priority

1 C - Configurable, W - Writable

Options Tab Attribute Details
Auto Restore
When True, the point restores the last command on field device online/offline transition. Applies to AO, BO, MO,
AV, BV, and MV objects.

Back to Options Tab.

Ignore Relinquish Default
When True, the Relinquish Default attribute is not used and has no effect. Applies to AO, BO, MC, MO, AV, BV, and
MV objects.

Back to Options Tab.

Local Control
When True, the point is under local control and the Present Value can be commanded only with an operator override
command. Applies to AO, BO, MO, AV, BV, and MV objects.

Back to Options Tab.

Relinquish Default
Used as the default value for Present Value when all command values in Priority Array are Null. Applies to AO, BO,
MO, AV, BV, and MV objects.

Back to Options Tab.

Restore Command Priority
Allows you to select which commands (at a selected priority) persist through a supervisory device restart. When the
bit is set, the command (at the selected priority) is saved at shutdown and restored at startup. Applies to AO, BO,
MC, MO, AV, BV, and MV objects.

Back to Options Tab.

Output Category Tab
The Output Category tab appears on GIO objects and includes the status, description, and value of the items in the
category. See the Generic Integration Object section for details.

Pager Tab
The Pager tab appears on Engine or Server objects. The Pager DDA Attributes appear on the Shared Configuration
section of the Pager Tab. The Pager DDA Destination Configuration Attributes appear when you edit a specific Pager
destination on the Pager tab.
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Table 371: Pager DDA Shared Configuration Attributes
DescriptionInitial ValuesData TypeAttribute Name
See Modem Type (Set 564).Internal Modem (0)One from a list of

values
Connect Using

TextAccess Number1

Minimum Value = 0, Maximum Value = 32767

Range Check = Use Limits

3NumberRedial Attempts

See the Redial Delay (Set 565).1 Second (0)One from a list of
values

Time Between Redial
Attempts

See the Idle Time (Set 566).1 Minute (1)One from a list of
values

Idle time Before Hanging
Up

TrueTrue or FalseRedial if Line is Dropped

See the Pager Databits (Set 429).7One from a list of
values

Databits

See the Pager Parity (Set 430).EvenOne from a list of
types

Parity

See the Pager Stopbits (Set 431).1One from a list of
values

Stopbits

Supports alphanumeric and special ASCII characters.0000002TextPassword

Displays the communication between the Pager DDA,
modem, and customer's paging Service. It displays
both successful and unsuccessful attempts to send
a page.

TextPager Diagnostics

1 Be sure to check the Access Number and Password after an upgrade. In some cases, these values are not maintained after
upgrade.

2 000000 is the standard default password for the Telocator Alphanumeric Protocol used by the pager.

Table 372: Pager DDA Destination Configuration Attributes
DescriptionAttribute Name
Identifies the user-friendly name for a pager destination in the list of Pager DDAs.Label

Specifies the phone number for the user’s pager.Pager Phone Number

Specifies the maximum number of characters supported by the pager service provider.Max Characters

Specifies the number or attempts made to send a message if there is a failure before the
system discards it.

Range: 0–10

Retries

Defines whether or not the destination is enabled. When this attribute is False, the Engine or
Server does not deliver pager messages to the configured recipients.

Enabled
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Table 372: Pager DDA Destination Configuration Attributes
DescriptionAttribute Name
Specifies the rules to filter pager messages.

See Filters for more information.

Filters

Defines the format of the message, indicating which fields are present in the received message.

The following fields are optional:
• Acknowledge Required (not an option for pager)
• Item Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Format

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Parameter Category Tab
The Parameter Category tab appears on GIO objects and includes the status, description, and value of the items in
the category. See the Generic Integration Object section for details.

Printer Tab
The Printer tab appears on Server objects. The Printer DDA Destination Configuration Attributes appear when you
edit a specific Printer destination on the Printer tab.

Table 373: Printer DDA Destination Configuration Attributes
DescriptionAttribute Name
Specifies the name of the printer where reports are routed.

The Printer DDA can send alarms to one or multiple printers.
Note: If you are uncertain about the proper printer name to use, print a test page from the printer

and look for the Printer name line in the test printout. Copy the name and syntax exactly.

Printer

Specifies the font used by the printed report.Font Face

Specifies the font size used in the printed report.Font Size

Defines the orientation of the printed report (landscape or portrait).Orientation

Defines how many lines of data are required before the Printer DDA routes reports to the printer.
Setting this value to 0 enables tractor-feed/line printing. See the Printer topic in the Alarm and Event
Management section.

Range: 0–60

Line Out

Timer (in minutes) that begins when the first alarm is stored in the DDA line out buffer (Line Out).
Upon expiration, the contents of the line out buffer prints.

Timeout
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Table 373: Printer DDA Destination Configuration Attributes
DescriptionAttribute Name
Specifies the priority for printing alarm messages. You can print multiple alarms in a normal priority
range at once using the Line Out and Timeout attributes. You also can set the Printing Priority
Threshold to print the contents of the line out buffer immediately when a higher priority alarm (such
as a fire alarm) is detected. You can set the Printing Priority Threshold to a value from 0 to 255.
When an alarm is received that has a lower priority number than the Printing Priority Threshold (lower
priority numbers have a higher alarm priority), the contents of the line out buffer print immediately
when the higher priority alarm (such as a fire alarm) is detected, thus printing the high priority alarm
in addition to the contents of the line out buffer.

For example, if the Printing Priority Threshold is set to 20, alarms with a priority number of 20 or
greater are buffered using the Line Out and Timeout attributes. Receiving an alarm with a priority
number of 19 or less forces an immediate printout of the currently buffered alarms plus the new high
priority alarm.

This functionality applies when the Line Out attribute is set to 1 or greater. Also see the the Printer
topic in the Alarm and Event Management section.

See the Hi Normal Low (Set 100).

Printing Priority
Threshold

Specifies the number or attempts made to print a report if there is a failure before the system discards
it.

Range: 0–10

Retries

Defines whether or not the destination is enabled. When this attribute is False, the Server does not
deliver reports to the configured printer.

Enabled

Specifies the rules to filter messages.

See Filters for more information.

Filters

Defines the format of the message, indicating which fields are present in the received message.

The following fields are optional:
• Acknowledge Required (not an option for pager)
• Item Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Format

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Profile Tab
The Profile tab appears on DLLR objects. See the Demand Limiting/Load Rolling (DLLR) Object Object section for
details.

Recipient List Tab
The Recipient List tab appears on Notification Class objects. See the Notification Class Object section for details.

Resource Tab
The Resource tab appears on an object that has a resource file extension. See Resource File Extensions in the
Extensions section.

Schedule Tab
The Schedule tab appears on Schedule objects. See the Schedule Object and the Scheduling feature sections for
details.
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Site View Tab
The Site View tab appears on Site objects. See the Site Object section for details.

SNMP Tab
The SNMP tab appears on Engine or Server objects. The SNMP DDA Attributes appear on the Shared Configuration
section of the SNMP Tab. The SNMP DDA Destination Configuration Attributes appear when you edit a specific
SNMP destination on the SNMP tab.

Table 374: SNMP DDA Shared Configuration Attributes
DescriptionAttribute Name
Specifies whether the SNMP feature is enabled. Once this attribute is enabled, the
ability to send and receive messages (Traps and Gets) can be enabled or disabled on
an individual basis using the other SNMP DDA attributes.

SNMP Enabled

Specifies the version used to send SNMP traps. The versions are v1, v2c, and v3.SNMP Trap Version

Specifies an IP address or Host Name on which to filter Get requests. SNMP only
responds to requests from the device listed in this attribute. If this attribute is 0.0.0.0,
SNMP responds to all requests.

SNMP Management Device

Specifies the port on which SNMP communication occurs. Setting this attribute to 0
disables the Get feature of SNMP.

SNMP Request Port

Specifies the IT person who is responsible for managing SNMP communications.Contact Person

A case-sensitive string used to authenticate v1 and v2c Get and Get Next messages.
This attribute contains the community string used by the Network Management System
to edit data in objects maintained by managed devices.

Public Community Name

Defines the message format used for generating SNMP Traps, including the startup
Trap. The options are:
• String Based (default) - SNMP Traps are sent as a string of characters
• MIB Based - SNMP Traps are sent using the object identifier (OID) defined in the

Johnson Controls MIB (called, JCI MIB).

SNMP Trap Message Format

Table 375: SNMP DDA Destination Configuration Attributes
DescriptionAttribute Name
The name of this destination when it appears in the Destinations list.Label

A case-sensitive string used to authenticate v1 and v2c SNMP Traps. This attribute
contains the community string used by the Network Management System to edit data
in objects maintained by managed devices.

Trap Community Name

Specifies the IP address or host name of the system that receives the traps.IP Address

Specifies the port number from which the destination machine is expecting to receive
traps.

Destination Port Number

Specifies whether this SNMP destination is enabled or disabled.Enabled
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Table 375: SNMP DDA Destination Configuration Attributes
DescriptionAttribute Name
Specifies the rules to filter alarms. This attribute uses Alarm Value (Set 108).See Filters
for more information.

Filters

Allows you to select which attributes of a Metasys event are in the SNMP Trap.

The following fields are optional:
• Acknowledge Required (not an option for pager)
• Item Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Format

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

For detailed information on SNMP, refer to the SNMP Agent Protocol Implementation appendix located in the
following documents:

• Network and IT Considerations for the IT Professional Technical Bulletin (LIT-1201578)
• Network and IT Guidance for the BAS Professional Technical Bulletin (LIT-12011279)

Summary Tab
The Summary tab provides summary data for items in the navigation tree. For example, the Summary tab of the
MSTP Field Bus object shows summary data for the devices on the field bus. The Summary tab shows the status,
icon, item, value, and description information of the items. You can view and edit items on this tab using the right-click
menu options.

Note: Data appears in the Status column of the Summary tab when the status is not Normal (for example, High
Alarm).

Summary Definition Tab
The Summary Definition tab appears on Summary Definition objects used by the Tailored Summary feature. This
tab allows you to view and edit the Summary Definition object. See the Summary Definition Object and the Tailored
Summaries sections for more information on this object and feature.

Tailored Summary Tab
The Tailored Summary tab appears when you view the folder containing the Tailored Summary in the associated
User View. This tab allows you to view the Tailored Summary you defined using the User View and the Summary
Definition tab. See the Tailored Summaries section for more information on this feature.

Totalization Tab
The Totalization tab appears on an object that has a totalization extension. See Totalization Extensions in the
Extensions section.

Tree View Tab
The Tree View tab appears on User Navigation Tree objects, which are used by the User Views feature. See the
User Navigation Tree object and the User Views feature sections for details.

Trend Tab
The Trend tab appears on an object that has a trend extension. See Trend Extensions in the Extensions section.
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Trend Study Tab
The Trend Study tab appears on the Trend Study feature. See the Trend Studies feature section for details.
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Troubleshooting
Table 376: Troubleshooting

SolutionProblem
Date and/or time may be incorrect. Verify that all dates and
times are correct. For more information, refer to Appendix: Time
Zone, Date, and Time Management in the ADS/ADX
Commissioning Guide (LIT-1201645).

OR

Item name may be too long. See the HVAC PRO Name
Restrictions in Passthru Mode section in the SCT Technical
Bulletin (LIT-120534).

When you attempt to execute any N2 Passthru tool (for
example, HVAC PRO) from the ADS, ADX, or NAE user
interface, the following error appears:

The Supervisory Controller does not contain any
supported devices

The Site Director is offline. Log on and verify it is online.SCT does not log on to allow HVAC PRO to load despite
already being logged on to the NAE.

SCT (offline) allows you to log on and run HVAC PRO, but
you receive a ZSWHPROcrashwhen you try to do anything
over Passthru.

A user might be denied access to the ADS/ADX/SCT computer
over the network. From the Control Panel > Administrative Tools,
check the Local Security Policy properties on the ADS/ADX/SCT
computer and make sure that the user’s name is not listed under
the User Rights Assignment called Deny access to this
computer from the network.

OR

An Active Directory user is denied access to the SCT because
their user name has not been added to the MSEA-SSO user
group on the SCT computer. For details, refer to the Security
Administrator System Technical Bulletin (LIT-1201528).

OR

Verify the Java® Runtime Environment (JRE) proxy settings
are disabled. To verify proxy settings are disabled:

1. From the Start menu, select Settings > Control Panel.
2. Select the Java icon. The Java Control Panel appears.
3. Select the Proxies Tab.
4. Uncheck Use browser settings.
5. Click OK.

OR

SCT must be completely uninstalled. You may also have to
uninstall IIS 5.0 and the .NET Framework. Reinstalling SCT
should fix this problem. If there are error messages from the
Installer, there may also be an issue at runtime.

Logon responds with:

Unable to Login. Unexpected Error.

Error typically occurs if IIS 5.0 is installed after the .NET
Framework. Uninstall .NET, IIS, and SCT. Reinstall in the
following order: IIS, .NET, SCT.

SCT installer responds with:
XPPKInitConsole,exe crash

Only the second N2 Trunk is integrated. Integrate the first N2
Trunk, even if it has no controllers on it. You must integrate the
first N2 Trunk if N2 Trunk 2 is being used in HVAC PRO, even
if there are no devices on the first N2 trunk.

HVAC PRO gives the item reference of the NAE, but fails
to get any controllers and causes ZSWHPRO.EXE to crash.
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Table 376: Troubleshooting
SolutionProblem
The SCT is case sensitive for the names of the NxE devices.
Create a new Supervisory device in SCT and give it the exact
same name of the NAE. For example, the name nae is different
from NAE in SCT.

Downloading and uploading the database of an NxE in SCT
causes a Communication Error (521).

Two N2 Passthru Applications may not run at the same time
when used in Passthru mode. Close all of the N2 Passthru
applications and restart. Run one N2 Passthru application at a
time.

N2 applications respond with no information, or lock up.

This error occurs when the NxEs have domain names defined
for them, but the domain names are not defined in SCT. When
you define a new Site or a new Supervisory device in SCT, you
must include the domain name as part of the name (for example,
NAE.cg.jci.com instead of just NAE). It is also possible to use
the IP address of the device that the archive is being taken from.

Downloading/Uploading the database of an NxE in SCT
causes a Communication Error (521) or error (522).

Verify the name of the backup matches the name of the archive.
To verify the backup and archive names match, log onto the
Site Director. The name at the top of the tree is the archive
name. Rename the SCT backup database to match the archive
name, restore the database, and execute the archive upgrade
again.

SCT upgrade tool fails with the following archive upgrade
log error for a restored database:

In ConvertArchives: Error in reading archive
data for fixbuild1, Empty Archive

M-Tools may have been installed while running the N2 Passthru.
Shutdown all active N2 Tools and SCT. Reinstall SCT.

When you attempt to use one of the N2 Passthru tools, the
following error message appears:

Supervisory Device Offline

The GX9100 device is disabled at the GX9100. To enable the
GX9100 device, you must first command the DX9100 N2 Device
to Disable, then command the DX9100 device to Enable.

ADX9100 devicemay remain offline after exiting theGX9100
Commissioning tool. This occurs when the tool is run in
passthru mode from an ADS. In the NAE, the DX9100 N2
Device tab shows:

Offline = True and Enabled = True

The error typically occurs when you have a child NAE listed
above the Site Director. When the child NAE appears offline
(with a red or blue X), the N2DeviceLoader/LoaderUI crashes.

Right-click on the offline NAE and choose Remove from Site.

The N2DeviceLoader/LoaderUI (LoaderUIG3.exe) crashes
when you try to connect to the site.

A connection manager may be installed on the computer. If
present, uninstall the connection manager.

As a reference, refer to Microsoft Knowledge Base Article
KB910435 (http://support.microsoft.com/kb/910435).

The SCT installed without error, but the SCT UI window
freezes or stalls while Java software is loading.

This error occurs when you attempt to log onto the SCT and
you do not have proper permissions assigned. If you are an
Active Directory user, this occurs when attempting to start the
SCT.

Verify that System Configuration Tool is an assigned privilege
for the user in the System Access Permissions of the Security
Administrator System.

SCT responds with:

You do not have permission to use the System
Configuration Tool
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Table 376: Troubleshooting
SolutionProblem
If this problem occurs while performing downloads in the SCT,
wait a few minutes to allow the download to complete. Then,
refresh the SCT display. The updated status message appears
when the download completes.

Note: The amount of time it takes to download depends on
the size of the database, but is usually a few minutes.

Note: In addition, you can determine that the database
downloaded properly by waiting for the device to come
online after the download completes.

The SCT download freezes with the load status of
establishing communications. No error message appears.

This error may occur due to problems with network connectivity,
or the unavailability of the target devices.
Check the following:

• The device (ADS, ADX, NxE) to which you are downloading
is powered, operational, and has network connectivity to
the computer running SCT.

• In an ADX split configuration, both the ADX Web/ Application
Server and the ADX Database Server are powered and
operational, and the ADX Web/ Application Server has
network connectivity to the computer running SCT and to
the ADX Database Server.

When downloading a device or server, one of the following
messages appears:

Communication Lost after Reset Communication
error (521)

The synchronization failed. This problem may occur when the
SCT computer disconnects from the network before the
synchronization completes.
Under normal synchronization behavior, the SCT creates a copy
of your device database. For example, a database named
NAEname has a copy called sync_copy_NAEname. Then the
SCT creates a fresh copy of the database NAEname with which
to work. If a problem occurs with the synchronization while SCT
has control, the SCT deletes the fresh copy NAEname database
and renames the sync_copy_NAEname database to NAEname.
No data is lost.

When problems such as the SCT computer disconnecting from
the network before the synchronization completes, both copies
of the database appear in the SCT.

To resolve sync_copy device databases:

1. Delete both the device and its copy (for example, NAEname
and sync_copy_NAEname) from the SCT database.

2. Upload the device (NAEname) if you have only made
changes in the online Site Management Portal UI; otherwise,
restore the backup of the SCT database and download the
device.

Note: Make sure the SCT computer remains running and
online until the synchronization process completes to
prevent future failures.

In SCT, device names start with sync_copy after
synchronizing databases.

In general, if you can perform tasks with standard objects, do
so. Standard objects are less memory intensive and thus have
a smaller impact on system performance than complex LCT
logic.

You are uncertain whether to control your building with
standard objects or the LCT.
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Table 376: Troubleshooting
SolutionProblem
This problem occurs when the user graphic size is over 4 MB,
which is the default maximum allowed size for a IIS message
as defined by Microsoft Corporation.
The workaround is to increase the default size using the
<httpRuntime> element in the system.web section of the
web.config file. Change the values of the maxRequestLength
and executionTimeout attributes.

Note: maxRequestLength is defined as the number of KB
allowed, so the default is 4096 KB (4 MB);
executionTimeout is the number of seconds until the
request is killed.

For example, a maxRequestLength of 40 MB and
executionTimeout of 10 minutes appears as follows (see the
bold text in this sample web.config file snippet):

...

<configuration>

<appSettings>

<!-- The following settings are used by the
GenericItem Capability. -->

<add key="GenericItemDb.AssemblyName"
value="C:\inetpub\wwwroot\MetasysIII\Tool
\bin\Subsystems.Database.dll"/>

<add key="GenericItemDb.ClassName"
value="JohnsonControls.MetasysIII.Database.
GenericItemDbFactory"/>

...

</appSettings>

<system.web>

<httpRuntime executionTimeout="600"
maxRequestLength="40960"/>

</system.web>

</configuration>

In SCT, when trying to save a standard user graphic from
a restored database, the following error appears:

Failed to communicate to the server or device.

Manually run the application as an Administrator:

Right-click the application and select Properties > Run As
Administrator.

On the Windows 7 OS, and Windows Server 2008 OS,
applications (includingWindows Tools such as IISManager,
Windows Event Viewer, and so on) do not run with
Administrative privileges even though you are logged into
the computer as an Administrator.

Manually run the application as an Administrator:

Right-click the application and select Run As Administrator.

On the Windows 7 OS, or Windows Server 2008 OS, when
using Windows Authentication to access a SQL database
with SQLServer ExpressManagement Studio (or other user
driven application), you do not obtain sysadmin
permissions in the SQL database even though you are
logged into the computer as Built-in/ Administrators have
sysadmin permissions in the SQL database.

Due to changes in Administrator viewing behavior, log files may
not be visible. Manually run Windows Explorer as an
Administrator:

Right-click the Windows Explorer icon and select Run As
Administrator.

On the Windows 7 OS, and Windows Server 2008 OS, you
cannot view log files.
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Table 376: Troubleshooting
SolutionProblem
Manually run Windows Explorer as an Administrator:

Right-click the Windows Explorer icon and select Run As
Administrator.

On the Windows 7 OS, and Windows Server 2008 OS you
cannot access protected folders (such as Program Data)
even though you are logged into the computer as an
Administrator.

Add/Remove Programs is now called Programs and Features.
From the Control Panel, select Control Panel Home on the left
hand pane. Then in the right hand pane, select Programs >
Programs and Features.

On the Windows 7 OS, and Windows Server 2008 OS, you
cannot find the Add/Remove programs option in the Control
Panel.

From the Control Panel, select Appearance and Personalization
> Folder Options.

Note: This task is done on an individual user basis.

On the Windows 7 OS, and Windows Server 2008 OS you
cannot locate where to change the folder settings, such as
showing file extensions and showing system files.

This situation happens when you are logged in as the built-in
Administrator account. The built-in Administrator account
provides a full administrator access token, unlike other
administrative users who are logged in with only standard access
tokens that require elevation to perform administrative tasks. In
the Windows 7 OS, the built-in Administrator account is
disabled.

Windows 7OS, andWindowsServer 2008OS do not prompt
for Consent or Credentials.

A restriction exists if you are using a client computer with
Windows 7 OS to access the Site Management Portal UI of an
ADS/ADX or SCT installed on a computer running Windows 7
OS, or Windows Server 2008 OS. SSO is not supported with
these combinations. When configuring the Active Directory
feature of the Metasys system, disable SSO for the Metasys
site. Users still can use the Active Directory
username/password/domain function at the Metasys system
login screen.

Some OS combinations do not support SSO.

When running Metasys Release 3.0 or later, you cannot use
the global modify feature on devices at Release 2.2 or earlier.

For information on globally modifying items, see Performing a
Global Modify in the Modify Dialog section.

One of the following errors appears after attempting a global
modification:

Object does not exist.

One or more attribute modifications failed.

This problem occurs when an object is created through
third-party BACnet network and neither the Object Name
(BACnet property) nor the User Name (Johnson Controls
proprietary property) is initialized. As a result, the object appears
with no name in the navigation tree (that is, only the icon
appears) or the Focus/Configuration tab. The object functions
properly. An SCT download works and the Site Management
Portal UI displays the information as it was before the upload.

The UI forces you to enter a user name when you attempt to
edit any other fields of the object.

This problem does not occur if you specify an Object Name
either during the BACnet create or through a BACnet write after
object creation.

An object appears with no name in the navigation tree or
the Focus/Configuration tab.
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Table 376: Troubleshooting
SolutionProblem
This is a misuse of the Release All command. The Release All
command works exactly as designed. The proper command to
use is the Override Release command.

To recover the FEC controller from a Release All Command,
issue the command value determined by the application instead
of the relinquish default.

To release an override, use the Override Release command.
For other types of releases, make sure you use the release that
corresponds to the command to release.

If you use the Release All command from the Site
Management Portal UI to release overrides of the FEC
Outputs, the priority array that resides in the FEC controller
clears. The FEC controller outputs go to the Relinquish
Default values and are not commanded with the value
determined by the controller application because the
module outputs send on a COV basis.

You cannot discover BACnet Trend Logs on a Siemens device.
Add the Trend Log manually to show the trend log attributes in
the views and log data graph properly. The Siemens third-party
Trend Log object does not support the Logging Type attribute,
which is used in the BACnet discovery process.

The Metasys system cannot discover BACnet Trend Logs
on a Siemens device.

This is normal functionality. Manually type the path for the Target
Reference (path into the controller for the data being mapped
by the object) in the text box on the Select Data Source screen.

When adding a LONWORKS point manually, the Target
Reference appears blank.

Change the minimum and maximum range to include the values
used to ensure your features work properly.

You cannot command analog objects to values outside of
the minimum/maximum present value allowable range. If
you have objects with values outside of the allowable range
and upgrade to the next software release, the objects may
now appear unreliable.

This affects programmed features such as the LCT,
Scheduling, and the Multiple Command Object (MCO), as
well as manual commands.

Priority 6 (Minimum On Off) is reserved by the BACnet protocol
for minimum on/off control. You may need to edit interlocks,
multiple command objects, schedules, and LCT objects in
existing databases using this priority after converting them.

The Metasys system cannot command or write LONWORKS,
N1, N2, XL5000, and VND output points at priority 6
(Minimum On Off).

If you experience this issue:

1. In the Notification Class object, on the Focus\Configuration
tab, click Edit.

2. Find the Ack Required attribute.
3. Deselect To Normal.
4. Click Save.

When a point goes into alarm, Metasys software receives
the alarm message and a multitude of normal messages.
You must acknowledge all normal messages to get to the
alarm message. You are not using BACnet intrinsic
alarming.

Starting at Release 2.1.10, the NAE/NIE Update Tool placed
restrictions on the Host Name (Computer Name) values you
can use for NAE35, NAE45, and NCE25 models. Name values
must start with a letter, end with either a letter or a number, and
may contain dashes only in the interior of the name. The Host
Name must contain a letter other than or in addition to the letter
A. For example, A522446 is not valid, but either A522446B or
AB52446 are valid. Failure to follow the Host Name restrictions
results in the Computer Name value changing when an NAE35,
NAE45, or NCE25 is updated. Refer to the NAE/NIE Update
Tool Technical Bulletin (LIT-12011524) for more information on
Host Name restrictions.

Computer Name (Host Name) restrictions are unclear to
you.
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Table 376: Troubleshooting
SolutionProblem
For releases prior to Release 5.0, use the Update All Items
Cache command to update the All Items cache on the Site
Director.
See the Update All Items CacheUpdate All Items Cache
command and All Items Update in Progress All Items Update
in Progress attribute descriptions in the Site Object section for
details.

Note: The All Items cache automatically updates for engines
at Release 5.0 or later.

Changes made at an NxE do not appear in the UI of the Site
Director.

You cannot have mixed revisions when you want to edit the
LCT in the Engine from the ADS/ADX, if the ADS/ ADX is at
Release 3.0 or later. You cannot have devices at different
releases because the Scalable Vector Graphic (SVG) rendering
program was changed after Release 2.2.
This change in functionality is per design. As the system
progressed, we were unable to support newer features while
maintaining the ability to edit the processes created in the earlier
versions. To edit LCT processes or Program (Control System)
objects in a mixed system you need to log into the Engine
directly.

You cannot edit an LCT process on an NxE at version 2.1
or 2.2 from ADSs/ADXs at Release 3.0 or later.

The following error message appears when attempting to
edit LCT processes or Program (Control System) objects
from earlier versions:

This logic diagram is read-only for the current
version of Metasys. To edit the diagram you
must directly login to the device on which it
is located.

A similar error message appears if you try to edit a graphic
object at Release 2.2 or earlier from a Site Director at
Release 3.0 or greater.

This issue can occur at any Metasys release and is a result of
a problem with the ActionQ. With this issue, the load executes
successfully, but the UI does not show the status of the
download correctly. If you suspect the download is complete,
refresh the screen and verify that the status of the download is
complete.

The download seems to progress correctly, but the SCT UI
reports that the load still is establishing communications.
No errors appear.

This issue may be due to the following circumstances:
• older Java software components present on the computer
• the graphics card on your computer is not configured

properly
• To resolve this issue, remove any unused Java software

on your computer using Add/Remove Programs. Check the
product documentation from the graphic card manufacturer
to make sure the card is configured properly.

Some graphics appear jumbled when viewed in a single
pane. If you minimize the window and maximize it again,
the problem resolves for a few moments and then recurs.

Discarding or acknowledging an alarm at the ADS/ADX
acknowledges the alarm, but then the alarm reappears (with
the same date/time stamp) in the Alarms window and Event
Viewer of the ADS/ADX, but not the P2000 Event Viewer.

This is expected behavior at this time and occurs because the
ADS/ADX cannot confirm activity in the P2000 system.

You are using Metasys software with P2000 software and
alarm behavior is unexpected.

To resolve this issue, try resizing the UI window. The graphic
should appear at the usual speed.

Note: Keep in mind that graphic complexity, network traffic,
and other factors can impact the speed at which
graphics display. If a graphic displays consistently
slowly, one of the factors may be the cause.

A graphic takes an unusually long time to appear in the UI.
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SolutionProblem
This behavior may occur if the NavTreeCache database requires
maintenance. A stored procedure in the NavTreeCache
database called spu_DoDBMaintenance performs the required
maintenance. You can run this stored procedure manually or
on a schedule using either the SQL Server Agent or Windows
OS Task Scheduler. Refer to microsoft.com for details on stored
procedures and how to run them.

Nodes in the navigation tree are slow to open for Release
5.0 or later.

If you are using a private network, we recommend you turn off
the Internet Explorer SmartScreen Filter feature.

Failure to do so does not prevent Metasys software from
running, but may launch multiple UI windows unnecessarily.

When entering the IP address in the Internet Explorer
address bar to launch Metasys software, Multiple UI
windows open.

Due to changes made at Release 5.0, you may need to rebuild
the E-mail DDA.

E-mail is no longer being sent after upgrading fromRelease
4.0 to Release 5.0.

This occurs when the web service times out.
To workaround this you can extend the web service timeout.
To do this:

1. Navigate to c:\Inetpub\wwwroot\MetasysIII\WS
2. Open the web.config file in a text editor.
3. Go to the section that ends with </system.web>.
4. Insert a blank line above that entry.
5. In the inserted line, enter: <httpRuntime

executionTimeout="600"/>
6. Save the web.config file. This changes the default timeout

of 110 seconds to 10 minutes, allowing sufficient time for
the save to occur.

Note: Depending on your operating system and configuration,
this file may be listed as an XML configuration file
named web.

You are editing pager destinations and you lose some of
the definitions.

Problem occurs when the User Access Control (UAC) default
setting is set higher than Never Notify. Lower the UAC to Never
Notify and the resource file can then be downloaded into the
NAE.

Note: Windows 7 and server class Windows Operating
Systems may require changing the User Account
Control (UAC) settings to allow resource files (LON and
Vendor Integrations) to be added to the NxE/LCS
engines. The Metasys Site Portal does not inform the
user when a resource file fails to download. For details,
refer to the Refer to the Disabling User Access Control
section of the ADS, ADX, and SCT Installation and
Upgrade Wizard Content (LIT-12011331).

After a VND Integration is defined and a resource file
extension is added, the file associated with the resource
is not downloaded into the NAE45 (\N40 folder) and
therefore cannot be found or used for point auto-discovery.

If the navigation tree does not automatically update for defined
points after adding a field device using Auto Discovery (+ sign
appears next to device in tree) select Refresh All Tabs on the
Action Menu to update.

After adding a field device using the Insert Field Device
Wizard and using Auto Discovery, the navigation tree does
not automatically update for defined points (+ sign appears
next to device in tree).
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